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Get Started
Tableau Cloud is a secure, cloud-based solution for authoring, sharing, distributing and collaborating on content created in Tableau.

What’s New in Tableau Cloud
Tableau Online is now Tableau Cloud.
Use the visualisation below to explore new features in Tableau Cloud. Click on a feature to
bring up the tooltip with a link to detailed documentation for that feature. Explore the filters to
refine your search. Download the data to create a customised list.
You can also use the Search by Feature dashboard to see a list of new features for a
product or version, or explore when a feature was released. The dashboard currently
defaults to Tableau Cloud for the latest version of Tableau Cloud.
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Web authoring and interacting with views
For new features and enhancements related to web authoring and interacting with views,
see What's New in Tableau Desktop and Web Authoring. For more topics related to those
tasks, see Using Tableau on the Web.

Features Introduced in Previous Versions of Tableau Cloud
Browse summaries of features for previously released versions.
All Tableau Cloud Release Notes | All Known Issues

Added in previous versions

Added in June 2022
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MFA enforcement for site admins and all new sites

In compliance with Tableau Cloud's multi-factor authentication (MFA) requirements, beginning in June 2022, MFA is enabled for site admins on all existing Tableau Cloud sites and all
roles for new Tableau Cloud sites.
For more information about MFA, see one of the following:
l

For site admins, see Multi-Factor Authentication and Tableau Cloud

l

For users, see Register for multi-factor authentication

l

Salesforce's Multi-Factor Authentication (MFA) Enforcement Roadmap

Provision users and groups with Azure Active Directory

Site administrators can now automate user management, provision groups and assign
Tableau Cloud site roles through Azure Active Directory. For more information, see Configure SCIM with Azure Active Directory.
Authorise access to Tableau REST API using Tableau-connected apps

Using connected apps, you can programmatically authorise access to the REST API on
users’ behalf using JSON web tokens (JWTs).
For more information, see Access Scopes for Connected Apps.
Enable Explain Data by default per site

Site admins can enable Explain Data by default using site settings and the Explain Data permission. Authors no longer need to set the workbook option Allow Explain Data to be
used in this workbook when viewed online in the Explain Data Settings dialog box (the
workbook setting has been removed). Access to Explain Data in viewing mode is based on
site setting, site role and the Explain Data permission.
For more information, see Control Access to Explain Data.
Adjust the comparison and date range for metrics

You can now edit a metric's configuration to change the comparison, date range and status
indicator. Previously, you could only configure these options when you created a metric. For
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more information, see Edit a metric's configuration.
Add a Tableau Data Story to your dashboard

You can now create a Data Story in Tableau Cloud and in English only. Data Stories automatically generates narrative insights within your dashboard, saving time and surfacing relevant insights. As you interact with your dashboard, the stories written by Data Stories
adjust, allowing you to dive deeper into data and identify key insights faster. For more information, see Create a Tableau Data Story (English Only).
Edit published data sources

As of June, you can now edit more types of connections, including Amazon Athena, OData,
Databricks and SharePoint lists. For more information, see Edit a Published Data Source.
Suspend accelerated views automatically

You can now automatically suspend acceleration for views that are consuming unnecessary resources. Set a threshold for the number of times an acceleration task can fail per
day, week or month before the acceleration is automatically suspended. For more information, see View Acceleration.
Understand the ICU 68.2 upgrade

For improved security and better language support, we're upgrading to the current International Components for Unicode (ICU) library, 68.2. This update resolves issues with
ordering and better handles new Unicode characters. This update can impact dashboard
sorting, filtering and calculations. If you use string comparisons in calculated fields, confirm
that your calculations are still working as expected. For more information, see String Functions.
Tableau Catalog – part of Data Management

Ask Data Lenses appear in lineage – The lineage pane now contains lens information.
For more information, see Use Lineage for Impact Analysis.
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Virtual connections – part of Data Management

Virtual connections support revision history – Revision history lets you view the
changes to the connection, delete a revision or restore the connection to a previous version.
Enhanced filter features for data policy testing – In the virtual connection editor, when
you preview the data with your data policy applied, you can now see the values that are
allowed by the policy and the values that are filtered out.
Tableau Bridge support for OAuth

Tableau Bridge now supports OAuth as an authentication method for connections to: Snowflake, Google BigQuery, Google Drive, Salesforce and OneDrive. Using OAuth provides better security than basic username and password authentication and is easier to manage. For
more information, see Publish OAuth enabled private cloud-based data sources.

Added in May 2022
Admin Insights Job Performance data source

Get more visibility into your site with Admin Insights. You can now connect to the Job Performance data source to see events and runtime information for background jobs on the site.
Jobs include extract refreshes, Bridge refreshes and flow runs. For more information, see
Use Admin Insights to Create Custom Views.

Added in March 2022
IPv4 address support for Bridge pools

When mapping domains to Bridge pools, site admins can specify IPv4 addresses in the Private Network allowlist to refresh data sources and virtual connections that use IPv4
addresses in their connections. For more information, see IP addresses.
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Accelerate load time for your view

Workbook owners, site administrators and server administrators can now accelerate load
time for their views. View Acceleration pre-computes long-running queries, so accelerated
workbooks load faster. For more information, see View Acceleration.

Customise the View Data window

In a worksheet, you can customise the tabular display of your data in the View Data window. Remove columns from the default view, change the column order, sort columns or add
columns to provide deeper context. You can then download the customised view of the
underlying data as a CSV file to share with your team.

Note: When you customise the View Data window, the changes remain only while the
View Data window is open.

The new View Data window and customisation options are available in Tableau Cloud,
Tableau Server and Tableau Desktop. For more information, see View Underlying Data.
The View Data window and its options are accessible for keyboard navigation and screen
readers in Tableau Cloud, Tableau Server and Tableau Desktop. For more information,
see View Data Window in "Keyboard Accessibility for Tableau".
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Open the Sheet Description for a workbook on the web

Sheet Description is now available in Tableau Cloud and Tableau Server. While editing a
workbook on the web, in the Worksheet menu, select Sheet Description. Field descriptions are also available on the web. For more information, see Get Details About Fields and
Sheets in a Workbook.
Change to Search behaviour in Tableau

Beginning with the 2022 Spring release, the Search functionality on the Search Results
page in Tableau has changed. Prior to this release, content was indexed to allow “partial
token matching”. This meant that you could search for a partial string. For example, if you
searched for “super” the results could include content that contained the word “Superstore”
in the title, description or columns, even if the word “super” was not present by itself.
As of Spring 2022, indexing is done in a new way that supports both “full token matching”
and “fuzzy token matching.” This means that the results you see will be based on complete
strings, and will not do partial matches. Fuzzy matching provides partial matching on complete strings. To find "Superstore", you need to search for “superstore” or some variation of
that entire string, for example “supertor”, “sperstore” or “superstores”. Searching on just
“super” will not return that match. The goal and benefit of this approach is to reduce noise,
limiting the results to content that more closely matches your search string.
Recommendations for taking advantage of this change:
l

Use complete words in your query

l

Search for words that are present in the title or description of the content

Quick Search

The behaviour of Quick Search has not changed, so partial token matching is still supported,
but this means that the results in Quick Search will likely not be the same as the results in the
Search Results page.

Tableau Software

7

Tableau Cloud Help
Tableau Catalogue – part of the Data Management Add-on

Certifications and data quality warnings for virtual connections - You can now certify and set data quality warnings on virtual connections.
Virtual connections appear in lineage - The lineage pane now contains both virtual connection and virtual connection table information. For more information, see Use Lineage for
Impact Analysis.
Developer Resources

Virtual connections in the Metadata API - Virtual connections and virtual connection
tables are now addressable using the Metadata API, and can appear in output when using
it. For more information, see Understand the Metadata Model in the Tableau Metadata API
Reference.
Virtual connections – part of the Data Management Add-on

Salesforce connector supports virtual connections - You can connect Tableau to
your Salesforce data and create virtual connections and data policies that implement rowlevel security. See About Virtual Connections and Data Policies for details about virtual connections.
Virtual connections added to space usage view - Virtual connections are added as an
Object Type in the Stats for Space Usage view, so administrators can see how much disk
space virtual connections use.

Added in January 2022
Set up OAuth for Salesforce CDP

As a Tableau Cloud site admin, you can set up OAuth for Salesforce CDP. For more information, see Set Up OAuth for Salesforce CDP.
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Update Admin Insights data sources

As a Tableau Cloud site admin, you can now specify how often Admin Insights data sources
are updated on your site. For more information, see Manage Admin Insights.
Tableau Cloud sign-in updates

For users added to multiple Tableau Cloud sites, the sign-in process will now prompt users
to enter the site URI of the site they are attempting to access. For more information, see Sign
In to Tableau Cloud.
Get view load times with Admin Insights

Get more visibility into your Tableau Cloud site with a new Admin Insights data source. You
can now connect to Viz Load Times to see load time information for views published on your
site. For more information, see Use Admin Insights to Create Custom Views.

Added in December 2021
Reset MFA verification methods

Site admins can now reset MFA for users who lose all their usual MFA verification methods
and are locked out of the site. For more information, see Multi-Factor Authentication and
Tableau Cloud.
Support for IdP-initiated SLO

In addition to supporting service provider (SP)-initiated single log-out (SLO), Tableau Cloud
supports identity provider (IdP)-initiated SLO. For more information about SAML configuration and requirements, see SAML Requirements for Tableau Cloud.
Use Tableau-connected apps to enable SSO for embedded content

In early January 2022, as a site admin, you can use Tableau connected apps to create and
manage explicit trust relationships between your Tableau Cloud site and custom applications
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where Tableau content is embedded. With connected apps, you can restrict which content
can be embedded and where the content can be embedded, and provide users the ability to
access embedded content using single sign on (SSO) without having to integrate with an
identity provider (IdP). For more information, see Use Tableau Connected Apps for Application Integration.
Keep more data fresh across multiple private networks

Site admins can now configure multiple Bridge pools to load balance data freshness tasks.
Pools can be mapped to domains, giving you the ability to dedicate pools to keeping specific
data fresh and maintain security by restricting access to protected domains in your private
network. For more information, see Configure the Bridge Client Pool.
Schedule and manage refreshes for file-based data sources directly in Tableau Cloud

Beginning with Bridge version 2021.4.3, refreshes for file-based data sources using Bridge
will be integrated with Online schedules. Publishers can schedule and manage refresh
schedules for file-based data sources directly from Tableau Cloud. For more information,
see Set Up a Bridge Refresh Schedule.
Note: Your site admin must have at least one Bridge 2021.4.3 client in a pool mapped to the
domain where your file-based data sources are located.
Data freshness support for virtual connections

Keep new virtual connections that connect to private network data fresh using Bridge. The
Data Management Add-on must be enabled for your site to create and use virtual connections. For more information about virtual connections, see About Virtual Connections
and Data Policies.
Edit published data sources

In Tableau Cloud, you can now edit published data sources. Previously, only data sources
embedded in workbooks could be edited.
Whether you’re creating a new published data source or editing an existing published data
source, you can create joins and edit the schema from the Data Source page. Then use the
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Scratchpad to test your changes, create folders, organise hierarchies and rename fields and
aliases before publishing your data source – all without ever leaving Tableau. For more
information, see Edit a Published Data Source.

Copy and paste dashboard objects

You can now copy and paste objects either within the current dashboard, or from dashboards in other sheets and files. Note that you can't, however, copy sheets in a dashboard,
items that rely on a specific sheet (such as filters), or objects on a device layout. For the complete list of unsupported items and detailed instructions, see Copy objects.
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Replay animations in dashboards, stories and worksheets

You can now replay animations in dashboards, stories and worksheets wherever you use
Tableau. Click the Replay button to rewind and replay the most recent animation. You can
also choose the speed at which you want to replay the animation: actual speed, 2x speed or
1/2 speed. Animations help you see how your data is changing in context, so you can make
better conclusions about your data. For more information, see Format Animations.

Share Ask Data vizzes with Slack

If your Tableau administrator has configured Slack integration, you can quickly share Ask
Data vizzes with anyone who has access to a lens. In the upper right corner of the browser,
click on the Share icon, then enter specific usernames in the text box.

For more information, see Share Ask Data vizzes via email, Slack, or a link.
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Use terms previously reserved for analytical functions in Ask Data

Previously, analytical terms found in data source field names and values were ignored by
Ask Data. But now it treats terms like "average", "group", "filter", "limit", "sort" and "date" just
like any other form of data, letting you analyse data sources without needing to revise their
contents.
Query fields with table calculations in Ask Data

Ask Data now lets you query fields with table calculations. Be aware that you cannot include
filters, limits or "year over year difference" comparisons in your query expressions for these
calculations.
Add Ask Data lenses to Favourites

You can now add Ask Data lenses to your Favourites list for a site, helping you easily return
to them.
Provide feedback to Ask Data lens authors

If you have questions about the structure of a lens or how best to use it with Ask Data, you
can send feedback directly to the author.
To the left of the query box for Ask Data, click the "i" icon.

Then, at the bottom of the tips dialog, click Contact the Lens Author.
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This option is enabled by default, but lens authors can hide it by following the steps in Let
users email you questions about a lens.
Rename fields and tables when authoring Ask Data lenses

If field and table names in a data source don't reflect terms your users would recognise, lens
authors can now rename these items for each lens.
On the left, hover over individual tables or fields, and click on the pencil icon:

Then provide a more representative name by clicking on the pencil icon on the right.

For more information, see Create or configure a lens page on your Tableau site.
Identify outliers with Data Change Radar (limited preview)

Data Change Radar is available as a limited preview. If you’re a Tableau administrator who
would like your organisation to join the preview, sign up here.
Data Change Radar shows data that falls outside of expected ranges, revealing changes
you may want to explore further. An overview of the process appears here; for details about
which views are tracked and how you can interact with them, see Identify Notable Data
Changes in a Viz (Preview).
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In Tableau Cloud and Tableau Server, you'll see recommended data changes with this icon
on the Home page and the Recommendations page. Click on the thumbnail of a recommended view to open it and access Data Change Radar.

When the view appears, the Data Change Radar pane opens on the right showing a list of
unexpected changes. In the list, hover over each change to highlight the related mark in the
view.

Click a change in the list to see how the measure values have changed over time. When the
graph appears, you can drag over it to see specific values captured at each time point.
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Embed metrics into webpages

Include metrics on the webpages and apps where they are relevant by embedding them. To
embed a metric, copy the embed code provided on your Tableau site or write your own
embed code. An embedded metric follows the same sign-in and permission restrictions as
the site the metric is embedded from on Tableau Cloud or Tableau Server, so your metric's
data is secure. For more information, see Embed Metrics into Webpages.
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Configure new comparisons and statuses for metrics

When you create a metric, you can now adjust the date range, configure the historical comparison and set status indicators. The comparison and status you set are displayed on the
metric card, giving users an easy-to-understand indicator of how the metric is performing
compared to a prior point in time or a specific value you’ve defined. For more information,
see Create and Troubleshoot Metrics.

Salesforce Admin Insights and Nonprofit Cloud

After connecting to Salesforce, you can now publish additional workbooks and data sources
for Salesforce Admin Insights and Nonprofit Cloud. The content is customised for your organisation and allows you to explore your Salesforce data in Tableau Cloud. For more information, see Create Workbooks with Salesforce Data.
Add-ons
Virtual connections and data policies – part of the Data Management Add-on

Virtual connections and data policies are included in the separately licensed Data Management Add-on for Tableau Cloud. These new data management features enable you to
provide a single, centralised connection to a database for your users, as well as define rowlevel security on the tables in the connection using a data policy. For more information, see
About Virtual Connections and Data Policies.
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With virtual connections, you get Quick Help

As you create and test your new virtual connection, help is just a click away. Delivered in the
product, Quick Help shows relevant, just-in-time help content based on where you are or
what you're doing in the virtual connection editor. Simply click on the ‘?’ icon on the top right
of your screen to open the movable help window.

Tableau Catalogue – part of the Data Management Add-on

Custom SQL information on content lineage pages – Catalogue lineage pages show
information that helps users understand more about custom SQL in their content.
l
l
l

A banner on lineage pages identifies content that uses custom SQL.
You can review the custom SQL query.
A warning is shown for custom SQL queries that could result in incomplete lineage.

For more information, see Supported lineage in the Tableau Desktop and Web Authoring
Help.
Tableau Catalogue supports the T-SQL dialect in custom SQL queries – Support for
the T-SQL dialect means Tableau Catalogue can provide more complete lineage when
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custom SQL is used. For more information, see Supported queries in the Tableau Desktop
and Web Authoring Help.
Data quality warnings links in email automatically open the Data Details pane –
When you click on a data quality warning in a subscription email, the view opens with the
Data Details pane shown. Also, a new embed parameter, showDataDetails, is available to
open the view with the Data Details pane shown. For more information, see Parameters for
Embed Code in the Tableau Desktop and Web Authoring Help.
Inherited descriptions appear in the fields list on lineage pages – When a description
for a field exists upstream from the field, it now appears in the fields list on lineage pages with
information about where the description is inherited from. For more information, see How
field descriptions are inherited in the Tableau Desktop and Web Authoring Help.
Easily create Prep flows based on external assets – Now you can use databases and
tables as starting points for new flows in Prep web authoring. For more information, see
Start a new flow in the Tableau Prep Help.

Added in September 2021
Share, collaborate and keep up with your data in Slack

You can now see Tableau notifications in Slack with the Tableau for Slack app, which lets
Tableau Cloud site administrators connect with a Slack workspace. Once connected,
licensed Tableau users can receive notifications in Slack when they’re mentioned in a comment, when teammates share content with them or when data meets a specified threshold in
a data-driven alert. For more information, see Integrate Tableau with a Slack Workspace.
Save workbooks in Personal Space

Creators and Explorers can now edit and save content to Personal Space, a private location
for each web author on a Tableau site. Content saved to Personal Space is private to the
user and controlled by added resource governance. In Settings, you can enable Personal
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Space and set user storage limits. Administrators can continue to access and manage all
content, including Personal Space content. For more information, see Create and Edit Private Content in Personal Space.
Set your workbook data freshness policy

Strike a balance between performance and data freshness by using workbook data freshness policies. While cached data is great for the performance of live-connection workbooks,
seeing stale cached data in a viz can cause confusion and frustration for workbook users.
Now with data freshness policies, workbook owners or administrators can choose granular
data freshness policies, so the freshest data appears when your business needs it.
From the Workbook Details dialog in Tableau Cloud or Tableau Server, choose Edit Data
Freshness Policy. Then, choose one of the following:
l
l
l
l

Site default (12 hours in Tableau Cloud)
Always live (Tableau will always get the latest data.)
Ensure data is fresh every...then, set your interval, such as every 12 hours.
Ensure data is fresh at...then set your days and times, such as Monday, Wednesday and Friday at 09:00 AM Pacific time.

Data freshness policies allow you to optimise workbook performance on a schedule that
meets the needs of your business. For more information, see Set a Data Freshness Policy.
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Rename published data sources

In Tableau Cloud and Tableau Server, you can now rename a published data source for
which you have Save permissions. To rename a published data source, click the More
actions menu and choose Rename – just like renaming workbooks. You can also rename a
published data source using the Update Data Source REST API. When a published data
source is renamed, all workbooks that use that data source will use the new name after the
next data source refresh is complete. For more information, see Best Practices for Published
Data Sources.
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Use axes animations to see and understand changes in scale

Axes animations are now available in Tableau Desktop, Tableau Cloud and Tableau
Server. For example, when you filter your viz to include a new data group, you’ll see that the
scale of the axis changes because a new value was added. Axes animations allow you to
see changes of scale in context so you can make better conclusions about your data. For
more information, see Format Animations.

Use advanced filtering

From wherever you use Tableau, you can now use advanced filtering that was previously
available only in Tableau Desktop. Use Wildcard filtering to filter for strings that match your
filter criteria. Or, author Formulas that work with Conditions or Top N filters. For more
information, see Filter categorical data (dimensions).
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Set new permission capability for metrics

The Create/Refresh Metrics permission capability has been added for workbooks. For more
information, see Permission Capabilities and Templates in the Permissions topic.
Prior to 2021.3, the Create/Refresh Metrics capability was controlled by the Download Full
Data capability. On workbooks created prior to 2021.3, users who had the Download Full
Data capability will have the Create/Refresh Metrics capability.
This new capability provides finer-grained control over your data, allowing you to grant users
the ability to create metrics while denying the ability to view or download the full data for the
view.
Control access to Explain Data with new site setting and Run Explain Data permission capability

Tableau administrators can now control the availability of Explain Data in site settings. Prior
to 2021.3, the ability to enable or disable Explain Data was controlled at the server level only
using the tsm configuration set option ExplainDataEnabled.
Authors can now control the availability of Explain Data at the workbook level using the Run
Explain Data permission capability. For more information, see Explain Data in the Permissions topic.

Note: To make Explain Data available in viewing mode, a workbook author must also
select the option Allow Explain Data to be used in this workbook when viewed
online in the Explain Data Settings dialog box. For more information, see Control
Access to Explain Data.

Limit the number of tags per item

A new setting allows you to limit the number of tags that users can add to Tableau content,
such as workbooks and metrics, and external assets, such as databases and tables. This setting ensures that tags don’t pose resource consumption problems. When you lower the tag
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limit, it prevents new tags from being added above the limit, but it doesn’t remove existing
tags on items in excess of the limit. For more information, see Site Settings Reference.
Ensure JDBC or ODBC connection customisations are used by Bridge

If a Tableau Datasource Customisation (TDC) file is used to customise your generic JDBC
or ODBC connections, you can use the steps described in Use .tdc files for generic JDBC or
ODBC connections to ensure those customisations are used by Bridge as well.
Monitor Bridge refreshes using JSON logs

Create data sources and views to monitor refresh jobs by connecting to a Bridge client’s
JSON log files. For more information, see Configure the Bridge Client Pool.
Provide feedback to Ask Data lens authors

If you have questions about the structure of a lens or how best to use it with Ask Data, you
can send feedback directly to the author.
1. To the left of the query box for Ask Data, click the "i" icon.

3. At the bottom of the tips dialog, click Contact the Lens Author.
This option is enabled by default, but lens authors can hide it by following the steps in Let
users email you questions about a lens.
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Use terms previously reserved for analytical functions in Ask Data

Previously, analytical terms found in data source field names and values were ignored by
Ask Data. But now it treats terms like "average", "group", "filter", "limit", "sort" and "date" just
like any other form of data, letting you analyse data sources without needing to revise their
contents.
Access table calculations in Ask Data

If a published data source contains calculated fields with table calculations that aggregate or
sort, Ask Data now indexes and analyses those just like other fields. (Table calculations that
filter or limit data are not supported.)
Use longer field values in Ask Data

Ask Data now indexes field values with lengths of up to 200,000 characters, far above the
previous limit of 10,000.
Set up custom OAuth for Dremio

Beginning with version 2021.3, you can set up custom OAuth for Dremio. For more information, see OAuth Connections.
Add-ons
Tableau Catalogue – part of the Data Management Add-on

Inherited descriptions appear in web authoring – When a description for a field exists
upstream from the field, it now appears in web authoring with information about where the
description is inherited from. For more information, see Describe fields in a published data
source in the Tableau Desktop and Web Authoring Help.
Assets in personal spaces are indexed – Tableau Catalogue indexes assets in personal
spaces, but users who browse through the lineage tool see Permissions required instead
of information about workbooks in personal spaces.
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Data quality warnings appear in subscription emails – Subscription emails can
include data quality warnings for workbooks or views if their upstream assets have warnings. For more information, see Data quality warnings in subscriptions.

Added in August 2021
See colour-coded data types and simplified phrasing for limiting and sorting in Ask Data

As you create queries in Ask Data, you'll see helpful colour-coded icons that identify data
types such as numbers, text strings, tables and so on. Phrasing for limiting filters and sorting
has been simplified too, making Ask Data's interpretations of your queries clearer.

Identify elements used in interpretations for Ask Data

Ask Data has added visual feedback on how your inputs are used in interpretations. Ignored
words are greyed out; hovering over remaining words highlights how they're incorporated in
the interpretation above.

Edit field descriptions for Ask Data lenses

Lens authors can now customise the description that appears when users hover over a
field, better explaining its purpose to the audience of lens users. To change a Description
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entry, click the pencil icon to the right of a field name.

Added in June 2021
Tableau with MFA

As the security landscape evolves, and threats that can compromise user credentials grow
more common, it's important to implement strong security measures to protect your organisation and users. If your organisation doesn’t work directly with an single sign-on (SSO) identity provider (IdP), you can enable multi-factor authentication (MFA) with Tableau
authentication to better secure your user sign-in process.
For more information, see one of the following:
l

If you’re a site admin, see About multi-factor authentication and Tableau Cloud.

l

If you’re a user, see Register for multi-factor authentication.

Streamlined site settings for Ask Data

Streamlined site settings for Ask Data now disable or enable the feature site-wide for all data
sources. If it's enabled site-wide, indexing frequency remains customisable for each data
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source. For more information, see Disable or Enable Ask Data for a Site.
Organise items in a collection

Collections are like playlists that let users organise content in a way that is meaningful to
them. Viewers, Explorers and Creators can all create and share collections. For more
information, see Organise Items in a Collection.
Note that if you participated in the limited preview for collections, the site setting to control
public collections no longer exists. Now, permissions for collections are controlled in the
same way as other types of content. For more information, see Permissions for Collections.
Create workbooks with Salesforce data

You can now integrate Salesforce data into Tableau Cloud to create starter content for
users on your site. Once you connect to Salesforce, Tableau publishes ready-to-use workbooks and data sources to help jump start analysis into your Sales and Service Clouds. For
more information, see Create Workbooks with Salesforce Data.
Configure settings for extracts in web authoring

You can now configure settings for extracts that you create in Web Authoring. Optionally,
configure options to tell Tableau how to store, define filters for and limit the amount of data
in your extract. For more information, see Create Extracts on the Web.
Bring Einstein Discovery predictions into your Prep flows on the web

Beginning with version 2021.2, you can bring prediction models built in Einstein Discovery
directly into your Prep flows on the web.

Note: You must have a Salesforce licence and user account that is configured to
access Einstein Discovery to use this feature.

With the power of machine learning and artificial intelligence, you can bulk score your flow
data and generate new fields for predicted outcomes at the row level, as well as add top
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predictors and recommended improvement fields to include data about which fields contributed to the predicted outcome. Add a Prediction step to your flow, sign in to Einstein Discovery, choose from deployed models and apply them to your flow data. Then generate your
flow output and use the new data source to analyse the predicted outcomes in Tableau. This
feature was first introduced in Tableau Prep Builder in version 2021.1.3. For more information, see Add Einstein Discovery Predictions to your flow in the Tableau Prep help and
Create and Interact with Flows on the Web.
Multiple analytics extensions in a site

Beginning with version 2021.2, you can now create multiple analytics extensions connections for each site. This means that organisations with different language or connection
requirements can use analytics extensions on the same Tableau Server site, with different
workbooks using different connections. For more information on configuring analytics extensions for your site, see Configure Connections with Analytics Extensions. For details on
using analytics extensions, see Pass Expressions with Analytics Extensions (Tableau
Desktop and Web Authoring Help).
Note: As of 2021.2, Einstein Discovery analytics extensions are still limited to one per site.
Share explanations from Explain Data in published dashboards

Explain Data has a reimagined user interface optimised for a broader audience of business
users. Authors (Creators or Explorers with editing permissions) can now enable Explain
Data for viewers of dashboards and sheets in published workbooks. Viewers can select a
mark of interest in the view and run Explain Data to explore their data more deeply than
before.
Access to Explain Data in viewing mode is not enabled by default, so authors will need to
enable this option. For information on how to enable Explain Data in viewing mode, see Control Access to Explain Data.
For more information on Explain Data, see Discover Insights Faster with Explain Data, Get
Started with Explain Data and Requirements and Considerations for Using Explain Data.
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Configure custom OAuth

As a site admin, you can now configure custom OAuth clients for your site to override
default OAuth clients. For more information, see Configure custom OAuth.
Keep more data fresh using Bridge

Bridge adds support for the following connectors:

l

Alibaba AnalyticsDB for MySQL
Alibaba Data Lake Analytics
Databricks
Denodo
Impala

l

Kyvos

l
l
l
l

For more information about Bridge connectivity, see Connectivity with Bridge.
Explore new Admin Insights data sources

Get more visibility into your Tableau Cloud site with new Admin Insights data sources. You
can now connect to the Groups data source to identify the group membership of users or
the Site Content data source for governance information about content items on your site.
For more information, see Use Admin Insights to Create Custom Views.
Tableau Catalogue – part of the Data Management Add-on

Add Field Descriptions - You can add descriptions for fields in a published data source
that then display in the Description column on the data source page Lineage tab. You can
also see the description on the Data tab when you build a visualisation. For more information, see Describe fields in a published data source in the Tableau Desktop and Web
Authoring Help.
Data Quality Warning Updates
l

Formatted text support for warning messages - When you create or edit a data
quality warning message, you can format the text with bold, underline and italics and
include a link or an image. For more information, see Set a Data Quality Warning.
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l

Message required for warnings - When you create a data quality warning, you're
now required to enter a message to display to users. (This doesn't apply to warnings
generated when you set Tableau to monitor for extract refresh or flow failures.) For
more information, see Set a Data Quality Warning.

Inherited descriptions appear in Tableau Desktop - When a description for a field exists
upstream from the field, it now appears in Tableau Desktop with information about where the
description is inherited from. For more information, see Describe fields in a published data
source in the Tableau Desktop and Web Authoring Help.
Full table name appears - The table's full name has been added to the table page.
Filter by tags - You can now filter databases, files and tables by tags in the Connect To dialog box.
Filter by embedded or non-embedded - On the External Assets page, you can filter databases, files and tables by asset category: embedded or non-embedded.
Create parameter actions on the web

You can now create parameter actions in both Tableau Cloud and Tableau Server. When
you create a parameter action, you customise how data is displayed in your viz. And users
can change a parameter value by interacting directly with your viz. For more information, see
Parameter Actions.
Create set actions on the web

You can now create set actions in both Tableau Cloud and Tableau Server. Use sets to
define a subset of data, and then use set actions to control how members in a set compare to
other data in the view. For more information, see Set Actions.

Added in April 2021
Salesforce Authentication
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If your organisation uses Salesforce, you can enable Tableau Cloud to use Salesforce
accounts for single sign-on with OpenID Connect. When you enable Salesforce authentication, users are directed to the Salesforce sign-in page to enter their credentials, which
are stored and managed in Salesforce. Minimal configuration may be required. See Salesforce Authentication.

Added in March 2021
See new comment and share notifications in redesigned notification centre

Users can now see notifications for new comments and shares by selecting the bell icon in
the top right corner of their Tableau site. The redesigned notification centre also displays
updates for flows and extract jobs. With this update, old notifications will continue to be sent
by email, but will not appear in the notification centre. To continue receiving older notifications via email, navigate to site settings. Under Manage Notifications, select Email for
each notification type. For more information, see Tour Your Tableau Site. For settings
information, see Site Settings Reference.
Tableau Catalogue – part of the Data Management Add-on

Automated data quality warning – You can set Tableau to monitor for extract refresh failures and for flow run failures. When a failure occurs, Tableau generates a data quality warning that displays to users. For more information, see Set a Data Quality Warning.
Quick search results expanded – Quick search results now include tags on external
assets.
Add Einstein Discovery predictions to Tableau dashboards

With the new Einstein Discovery dashboard extension, as users select marks in a view, they
see dynamic updates to predictions and suggestions to improve predicted outcomes.
Authors can drag the Extension object onto the dashboard canvas, select Einstein Discovery from the extensions gallery and then configure the extension in Tableau Cloud. For
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more information, see Explore Predictions in Tableau with the Einstein Discovery dashboard
extension.
For information on required licences, access and permissions in Salesforce and Tableau,
see Requirements for access.
For an introduction to Einstein Discovery in Tableau, see the Einstein Discovery in Tableau
page and demo on tableau.com.
For details on configuration steps required in order to enable the Einstein Discovery dashboard extension, see Configure Einstein Discovery Integration.

Added in December 2020
Create extracts on the web

Now you can create extracts directly in web authoring, without using Tableau Desktop. For
more information, see Create Extracts on the Web. You can extract new workbooks in addition to existing workbooks. Optionally, the extract creation can run in the background and you
can be notified when it's completed. This will let you close your authoring session while the
extract is being created, which can be helpful with large extracts that might take a long time.
Create and interact with flows on the web

You can now create flows to clean and prepare your data using either Tableau Prep
Builder, Tableau Server or Tableau Cloud. Connect to your data, build a new flow or edit an
existing flow and your work is automatically saved every few seconds as you go. Create draft
flows that are only available to you or publish your flow to make it available for others. Run
your individual flows right from the web or run your flows automatically on a schedule using
Tableau Prep Conductor if you have the Data Management Add-on. For more information,
see Create and Interact with Flows on the Web.
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Organise items in a collection (limited preview)

Collections are like playlists that let you organise your Tableau content. Create a private collection for personal reference, or make a public collection that can be viewed by other users
on your site. For more information, see Organise Items in a Collection.
As a Tableau administrator, you can control whether users can set collections to public by
changing the site setting Allow public collections.
Collections are available as a limited preview for Tableau Cloud. You won’t see collections
unless your site is part of the preview. If you’re a Tableau administrator who would like to
join the preview, sign up here.
Tableau Catalogue updates – part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for
Tableau Server and Tableau Cloud. For more information, see About Tableau Catalogue.
The following features are included in this release:
Data Quality Warning History admin view - Site administrators can see how data quality warnings are being used on the site using the pre-built admin view, Data Quality Warning
History. For more information see Data Quality Warning History.
See quality warning details in Tableau Desktop - Tableau Desktop users can hover
over the warning icon on the Data tab to see details about the data quality warnings affecting the data in their workbook. For more information, see Set a Data Quality Warning.
Metrics appear in lineage and show data quality warnings - Data quality warnings
now appear on metrics affected by a warning. Metrics also appear in the Lineage tool,
enabling you to see how a metric might be affected by data changes when performing
impact analysis. For more information, see Create and Troubleshoot Metrics.
Tableau Prep Conductor updates - part of the Data Management Add-on

Now, the Data Management Add-on is only needed to schedule and monitor flows with
Tableau Prep Conductor. Other flow-related tasks no longer require you to licence the add-

34

Tableau Software

Tableau Cloud Help
on. For more information, see Tableau Prep Conductor.
Analytics extensions

Analytics extensions allow you to extend Tableau dynamic calculations in a workbook with
languages like R and python, and with other tools and platforms. These settings endpoints
enable you to configure analytics extensions on your site in Tableau Cloud. See Configure
Connections with Analytics Extensions.
Ask Data Usage and Adoption admin view

You can now see how users engage with Ask Data on a site, using the new Ask Data Usage
admin view. The dashboard highlights the top Ask Data users, data sources and data source
owners, along with headline value metrics. For more information, see Ask Data Usage.

Added in September and October 2020
Bridge (legacy) schedules have moved to a new location

For an extract data source that needs to use a Bridge (legacy) schedule to keep data fresh,
you can find and configure a Bridge (legacy) schedule from its new location in the actions
menu on the data source page. For more information, see Set Up a Bridge Refresh Schedule.
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Note: Recommended schedules have not changed location and continue to be integrated
with Online refresh schedules. However, Recommended schedules is no longer labelled as
"Recommended" to better reflect the integration. All the Bridge-related updates described
here have been made to support the new Online scheduling experience.
Custom Extract Refresh schedules

Extract refresh scheduling is now fully customisable and no longer need to be selected from
an pre-populated list of schedules. You now have the ability to create and manage customised hourly, daily, weekly and monthly schedules for the extract refreshes.
For more information, see Schedule Refreshes on Tableau Cloud.
Turn off Web Page objects

To prevent Web Page objects in dashboards from displaying target URLs, deselect Enable
Web Page Objects in the site settings.

Added in August 2020
Set the Site Time Zone for Extracts

The default time zone for extract-based data sources in a site is Coordinated Universal
Time (UTC). Site administrators can now choose to set a different time zone.
For more information, see Change Time Settings.
Automatically Suspend Extract Refreshes for Inactive Workbooks

To save resources, Tableau can automatically suspend extract refresh tasks for inactive
workbooks. This feature applies to full extract refreshes only, not to incremental extract
refreshes. This feature only applies to refresh schedules that run weekly or more often.
For more information, see Automatically Suspend Extract Refreshes for Inactive Workbooks.
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Manage Licences for User Groups with Grant Role on Sign-In

Administrators can set a minimum site role for user groups and choose Grant role on signin when creating or modifying that user group. Enabling Grant role on sign-in reduces
manual work to manage licences, since administrators can designate site role capabilities by
group, and provision licences when a user actually needs it. By waiting to grant licences until
users sign in, administrators can streamline licence provisioning, without granting licences to
inactive users. For more information, see Grant Licence on Sign-in.
Tag Stale Content for Archiving

The Stale Content Admin view that was introduced in 2020.2, now has an added functionality that allows you to tag content as stale. You can then choose to archive the tagged
content. For more information, see Stale Content.
Tableau Catalogue updates – part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for
Tableau Server and Tableau Cloud. For more information about Tableau Catalogue, see
About Tableau Catalogue.
The following features are included in this release:
See data quality warnings in Tableau Desktop – When you open a workbook in Tableau
Desktop that has a data quality warning, the warning icon (either a blue circle or a yellow triangle with an exclamation point) appears on the Data tab on the sheet page of the workbook. For more information, see Set a Data Quality Warning
'Sensitive data' warning type added – You can use this new warning type to set a data
quality warning for sensitive data in your organisation. For more information, see Set a Data
Quality Warning
Embedded assets are listed in External Assets – You can now see embedded assets listed in the External Assets page. For more information, see Use Lineage for Impact Analysis.
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Tag external assets – Add tags to databases, tables and columns, which enables you to,
among other things, tag tables and columns with personally identifiable information (PII).
For more information, see Tag Items in Tableau Desktop and Web Authoring Help.
Web authoring and interaction with views

New features and enhancements related to web authoring and interacting with views on the
web are listed in What's New in Tableau for Users and Web Authoring and Tableau
Desktop Feature Comparison. For topics related to web authoring and interacting with
views, see Using Tableau on the Web.

Added in June 2020
Tableau Bridge

No Bridge upgrade or installation required – for publishers
For publishers working exclusively with data sources that connect to on-premises relational
data, you no longer need to maintain your current client or upgrade to the latest. As long as
you migrate your refresh schedules using Recommended schedules (next bullet), and your
admin has installed and set up at least one Bridge 2020.2 client, you’re all set. For more
information, see Set Up a Bridge Refresh Schedule.
Integrated refresh schedules
Refresh schedules for Bridge are now integrated with Tableau Cloud refresh schedules.
For publishers, integrated refresh schedules, called Recommended schedules, mean:
l
l

You have more control and flexibility to manage your own data sources.
Your dependence on site admins is reduced for certain data source management
tasks like updating connections credentials.
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For more information, see Online schedules versus Bridge (legacy) schedules.
Keep private cloud data fresh
Use Bridge to keep cloud data, accessible only from inside a private network, fresh. For
more information, see Use Bridge for Private Cloud Data.
Pooling enabled for extract refreshes
Clients can pool extract refreshes, in addition to live queries, across all 2020.2 clients in the
network. For site admins, pooling of extract refreshes means:
l
l

You can focus on providing availability, throughput and latency.
You can optimise the composition of your client pool to match the characteristics of
your live query and extract refresh workloads.

For more information, see Configure the Bridge Client Pool.
Updated Settings page
For site admins, the simplified Bridge Settings page allows you to configure which clients to
include or exclude from the pool and displays a warning icon to make it easier to know which
clients need to be upgraded to the latest version. For more information, see Configure the
Bridge Client Pool.
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Note: The warning icon shows only when there is a newer client available for download.
The warning icon is not an indication that there are issues with the client or related Bridge
data sources.

Added in May 2020
Site Capacity Updates for Extract Refreshes

To improve site performance and ensure a consistent scheduling experience, sites are allocated daily and concurrent extract refresh capacity. For more information, see Tableau
Cloud Site Capacity.
Use relationships to combine data for multi-table analysis

Relationships are a new, flexible way to combine data for multi-table analysis in Tableau.
Data sources now support multi-table data models in a new logical layer. Tableau recognises the separate tables in your data source and performs aggregations at the native level
of detail for each table.
Creators can combine tables using relationships. Using relationships between logical tables
makes it easier to explore and analyse multi-table data at the right level of detail, without having to write specialised calculations to control aggregations like averages and totals.
You do not need to specify join types for relationships; during analysis Tableau automatically selects the appropriate join types based on the fields and context of analysis in the
worksheet.
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Note: Your workbook must use an embedded data source for you to be able to edit relationships in the Data Source page in web authoring in Tableau Server or Tableau
Cloud. You cannot edit the data model of a published data source.

In support of multi-table analysis, several parts of the Tableau interface have changed. The
Data Source page (canvas, data grid), View Data window and the Data pane in the worksheet have all been updated to support a multi-table analysis experience. For more information, see Changes to different parts of the interface.

Note: View Data column order has changed in Tableau 2020.2 and later. This change is
required to support relationships and logical tables. For details, see View Data column
order changes in Tableau 2020.2 and later.

For more information about relationships and changes to data sources, see these topics:
l
l
l
l
l
l
l

What's Changed with Data Sources and Analysis in 2020.2
Questions about Relationships, the Data Model and Data Sources in 2020.2
The Tableau Data Model
Relate Your Data and Optimise Relationships Using Performance Options
How Analysis Works for Multi-table Data Sources that Use Relationships
Troubleshoot Multi-table Analysis
Walkthrough: Don't Be Scared of Relationships

Also see this Tableau blog post: Relationships, part 1: Introducing new data modelling in
Tableau
Create metrics to track data

Metrics help users track changes to their data. Users can create metrics from a view and use
them to monitor key numbers like daily sales. For information on how users create metrics,
see Create and Troubleshoot Metrics.
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Tableau Cloud administrators can ensure that users are able to create metrics or disable
metrics for the site. For more information, see Set Up for Metrics.
Add a Set Control to let users quickly modify the members of a set

With a Set Control, your audience can select the members of a set without necessitating
edit mode. Users can simply add or remove set members by interacting directly with the
card in the view. Coupled with Set Actions, you have two powerful, complementary features
that make it easy to visualise the set you’re interested in.
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For more information, see Create Sets, or check out this blog post, Powerful analytics in a
user-friendly package with the set control.
Add or remove values from a set by interacting directly with the viz

Now, using Set Actions, you and your audience can use the viz itself to incrementally add values to or remove values from a set. Simply interact with the viz and choose which marks to
include or exclude. Coupled with the new Set Control feature, you have two powerful ways
to gain deeper insights into your data.
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For more information, see Set Actions.
Upload and open workbooks with a browser

Users can now upload a Tableau workbook to your Tableau site without publishing through
Tableau Desktop, the REST API or TabCmd. In a Tableau site, users with a Creator or
Explorer (can publish) site role can select New > Workbook Upload to upload a .twb or
.twbx file (up to 50 MB) to a project. For more information, see Upload Workbooks to a
Tableau Site.
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Access Dashboard Starters from Home in Tableau Cloud

Site Administrator Creators can now access Dashboard Starters from the Home page in
Tableau Cloud. Use these pre-designed dashboards to quickly visualise data from common
business applications like Salesforce or ServiceNow ITSM. For more information, see Use
Accelerators to Quickly Visualise Data.
Tableau Catalogue updates – part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for
Tableau Server and Tableau Cloud. For more information about Tableau Catalogue, see
About Tableau Catalogue.
The following features are included in this release:
Raise the visibility of important warnings - You can set a data quality warning to be
highly visible, so that users of a visualisation that's affected by the warning see a notification,
and the warning displays in a more prominent yellow colour elsewhere in Tableau. For more
information, see Set a Data Quality Warning and "Use Data Details to see visualisation
information" in Explore and Analyse Data in a View in the Tableau Desktop and Web Authoring Help..
Dashboards appear in the Lineage pane - When you select the Dashboards item in the
lineage, you can see a list of downstream dashboards. For more information, see Use
Lineage for Impact Analysis.
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Filter external assets on Certified and data quality warnings - In addition to using
search to narrow down your choices on External Assets, you can now filter databases, files
and tables by Certified and by data quality warnings.
More filters when connecting - When you connect to data, you can filter databases and
table on connection type.
More information on what's new

Other new features and enhancements related to web authoring and interacting with views
on the web are listed in What's New in Tableau for Users and Web Authoring and Tableau
Desktop Feature Comparison. For topics related to web authoring and interacting with
views, see Using Tableau on the Web.

Added in February 2020
Refresh parameters automatically with dynamic parameters

Now you can set a parameter’s current value to be the result of a single-value, view-independent calculation. In addition, you can refresh a parameter's list of values (or domain)
based on a data source column. This means that each time the workbook is opened and
Tableau connects to the data source referenced by the parameter, every place in the workbook that references the parameter will use the latest value or domain.
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For more information, see Create Parameters.
Automate user provisioning and group synchronisation through an external identity provider

You can automate adding or removing users from Tableau Cloud or adding or removing
members from groups using your identity provider (IdP). Tableau Cloud IdP user management uses the System for Cross-domain Identity Management (SCIM) standard, which
is an open standard for automating the exchange of user identity information. Currently we
support SCIM with the following IdPs:
l
l

Okta
OneLogin

SCIM is used to provision users in cloud applications such as Tableau Cloud. Cloud IdPs
centrally manage user identities, including assigning users to applications and groups. The
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IdP uses the SCIM standard to ensure that ‘downstream’ applications are kept in sync with
the provisioning assignments set up with the IdP. Managing users in this way improves
security, and can greatly reduce the amount of manual work that Tableau Cloud site administrators need to do to manage site users and group membership.
For more information, see Automate User Provisioning and Group Synchronisation through
an External Identity Provider.
Support for login-based licence management

Login-based licence management, helps you manage licensing for users with Creator roles
on Tableau Server and Tableau Cloud. Users with Explorer or Viewer roles cannot use this
feature. If you’re using Role Based Subscriptions with Tableau Server or Tableau Cloud,
you can simplify your licence management using login-based licence management to eliminate separate Tableau Desktop and Tableau Prep Builder product keys. You only need to
manage one or more product keys for on-premises Tableau Server, or in the case of
Tableau Cloud, you don’t need to manage any product keys at all.
For more information, see Activate Tableau using Login-based licence management.
Updates for Permission Dialog

Set permissions faster with the new permissions dialog. New permission templates and capability groupings match common user scenarios. Editing permission rules is easier than
ever with direct editing – double click to enter edit mode. Search for groups and users simultaneously without preselecting your choice. Copy a custom permission rule and paste it
for another group or user. And hand off project management to Project Leaders more intuitively with the new setting. For more information on permissions, see Permissions.
Lock nested projects

Regulating permissions is now more flexible. Project permissions can be locked independently for nested projects. Top-level projects can act as organisational containers for
projects with different permission models. Non-admins can create new locked projects. For
more information, see Lock content permissions.
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Run Now Setting
This new setting allows Administrators to configure whether to allow or block users from
manually running extract refreshes, flows runs and subscriptions. The Run Now settings are
on the General settings page, and by default, is selected to allow users to run jobs manually.
Tableau Catalogue updates – part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for
Tableau Server and Tableau Cloud. For more information about Tableau Catalogue, see
About Tableau Catalogue.
The following features are included in this release:
Added connectors - Connect to more data from external assets. We've added support for
the following connectors: Google Big Query, Google Drive, Google Sheets, Box, Dropbox
and OneDrive.
Create workbooks - Create a workbook from the External Assets page or from a database
or table page for Catalogue-supported connections. For more information, see "Tableau
Catalogue users create workbooks from external assets" in Creators: Get Started with Web
Authoring in the Tableau Desktop and Web Authoring Help.
Filter on Certified and data quality warnings - Filter data sources, databases, files, and
tables by Certified, filter data sources by connections and filter databases and tables by data
quality warnings. For more information, see "Open the Connect to Data page" in Creators:
Connect to Data on the Web, or "Connect from Tableau Desktop" in Connect to Data by
Using Tableau Server or Tableau Cloud in the Tableau Desktop and Web Authoring Help.
Enhanced Data Details pane l

See a sparkline with the number of times a sheet or dashboard was viewed over the

l

last 12 weeks.
Easily see that there are Warnings on a view.
Expand a field to see its metadata, such as a description or calculation.

l
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l

When a field in a workbook inherits its description, see where the description comes
from.

For more information, see "Use Data Details to see visualisation information" in
Explore and Analyse Data in a View in the Tableau Desktop and Web Authoring
Help.

Added in October 2019
Web authoring and interaction with views

For a comprehensive list of new features and enhancements related to web authoring and
interacting with views on the web, see the features listed under "Prepare, Author and View
Data on the Web" in What's New in Tableau for Users and Web Authoring and Tableau
Desktop Feature Comparison. For topics related to web authoring and interacting with
views, see Using Tableau on the Web.
Recommendations for views

Tableau Cloud now provides recommendations for views to help users discover relevant
content. To learn more about these recommendations, see Discover Recommended
Views.
You can control whether recommendations appear on your site, or whether user names
appear on recommendation tooltips, by adjusting the options under Recommendations
for Views on the Settings page.
Table visualisation enhancements

Authors can now create wide tables with up to 50 columns. Wide tables with discrete fields
can also now be scrolled horizontally. For more details, see Define Table Structure. Also,
see this post on 50-column tables from Tableau Public Ambassador Marc Reid on the datavis.blog.
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Create extracts on the web

Now you can create extracts in the browser, without using Tableau Desktop. For more
information, see Create Extracts on the Web. You can also use the new createextracts
and deleteextracts commands in tabcmd to create or delete extracts for a published
workbook or data source. For more information, see tabcmd Commands.
Get view load times with Admin Insights (beta)

Included with the latest version of Admin Insights, is the Viz Load Time Drilldown dashboard and the TS Web Requests data source. You can use both resources to help users
who are authoring views better understand the experience of the users who are consuming
those views. For more information, see Explore the pre-built workbook and Explore the data
sources.
The dashboard and data source are available to you as in-release beta features by request.
To join the beta or provide thoughts and ideas about the new Admin Insights content, sign in
to the Early Feedback site.
Disable email notifications when Tableau Bridge clients aren't running

If scheduled refreshes appear to be running outside of schedule or if you want to stop notifications you receive about clients not running, you can disable email notifications. For more
information, see Change the Bridge Client Settings.
Request access

Users can now request access to see a project, workbook or view when they don’t have viewing permission. When someone requests access to content, Tableau routes an email to the
person who controls permissions for that content with information about the request and
instructions on making access changes. For information on managing permissions, see Permissions.
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Limit visibility of user information

The User Visibility site setting lets administrators manage if users with Viewer and Explorer
site roles see other users and groups on the site, which can be important for sites used by
multiple clients. When User Visibility is set to Limited, Explorers and Viewers cannot see
information about other users, including aliases, project ownership, comments and more.
Creators and administrators (including Site Administrator Explorers) can still view user
information. By default, User Visibility is set to Full. For more information, see Manage Site
User Visibility.
Enable or disable Ask Data for a site

As a site administrator, you can control the availability of Ask Data in the General area of
site settings. For more information, see Disable or Enable Ask Data for a Site.
Manage Sandboxed Extensions

Tableau now supports Sandboxed extensions, which are a new type of dashboard extension that run in a protected environment hosted by Tableau. Like Network-enabled extensions, Sandboxed extensions are web applications that run in custom dashboard zones and
can interact with the rest of the dashboard using the Tableau Extensions API. While Network-enabled extensions have full access to the web, Sandboxed extensions can’t share
data or make network calls outside of Tableau. Sandboxed extensions provide a new level
of security for Tableau users and administrators.
To learn more about controlling extensions, see Manage Dashboard Extensions in Tableau
Cloud. To learn more about extension security and strategies for deployment, see Extension Security in Tableau Server Help.

Added in September 2019
Support for Italian added

Tableau has added support for Italian. You can now set Tableau to display the user interface in one of eleven languages:
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l
l
l
l
l
l
l
l
l
l
l

Chinese (Simplified)
Chinese (Traditional)
English (United Kingdom)
English (United States)
French
German
Italian
Japanese
Korean
Portuguese
Spanish

For more information, see Change language and locale in the Tableau User Help.
In addition to supporting Italian in all Tableau products, the Help is also available in these languages. To read the help in your preferred language, navigate to the bottom of the Tableau
Help page on the Tableau website, and select the language from the footer.

Tableau Data Management Add-on

The Data Management Add-on is a new licence that helps customers manage Tableau content and data assets in their Tableau Server or Tableau Cloud environment. Tableau Prep
Conductor and Tableau Catalogue are included in the Data Management Add-on. For more
information, see About Data Management.
Tableau Prep Conductor – part of the Data Management

Tableau Prep Conductor is included in the separately licensed Data Management Add-on
for Tableau Server and Tableau Cloud. Tableau Prep Conductor leverages the scheduling
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and tracking functionality of Tableau Cloud, so you can automate running flows to update
the flow output instead of logging in to Tableau Prep to manually run individual flows as your
data changes. For more information, see Tableau Prep Conductor.
Tableau Catalogue features – part of the Data Management

Tableau Catalog is included in the separately licensed Data Management Add-on for
Tableau Server and Tableau Cloud, making a variety of features available to you in the data
management space. You can use Tableau Catalogue to discover data, curate data assets,
communicate data quality, perform impact analysis and trace the lineage of data used in
Tableau content. For more information, see About Tableau Catalogue.
Tableau Metadata API

If you're a developer and interested in accessing metadata indexed by or surfaced through
Tableau Catalogue see the Tableau Metadata API Help.
Explore and inspect views with Explain Data

Inspect, uncover, and dig deeper into marks in a viz using Explain Data. Explain Data gives
you a new window into your data by proposing statistical explanations for a selected mark,
including potentially related data from the data source that isn't in the current view.
Creators and Explorers with editing permissions can use Explain Data when editing a view
in Desktop or editing a view on the web in Tableau Cloud or Tableau Server.
Explanations give you information and visualisations on the data points might be affecting
the mark value. You can then open visualisations for further exploration. For more information, see Inspect a View using Explain Data in Tableau User help.
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Ask Data improvements

Users can now embed Ask Data into HTML pages, adjust relative date filters and see top
and bottom outliers in context. For more information, see Automatically Build Views with Ask
Data in the Tableau User Help.

Data source owners and Tableau administrators can now add synonyms for field values, in
addition to field names. For more information, see Optimise Data for Ask Data in the Tableau
User Help.
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Job Management

Site administrators can now view, monitor and manage jobs. For more information, see
Managing Background Jobs in Tableau Cloud.

Added in May 2019
Select from ten different languages for Tableau

Tableau has added support for two new languages, Chinese (Traditional) and English
(United Kingdom). You can now set Tableau to display the user interface in one of ten
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languages:
l
l
l
l
l
l
l
l
l
l

Chinese (Simplified)
Chinese (Traditional)
English (United Kingdom)
English (United States)
French
German
Japanese
Korean
Portuguese
Spanish

For more information, see Change language and locale in the Tableau User Help.
In addition to supporting two new languages in all Tableau products, the Help is also available in these languages. To read the help in your preferred language, navigate to the bottom
of the Tableau Help page on the Tableau website, and select the language from the footer.
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Help Design

A blue Send feedback icon is displayed in the bottom right corner of every Help page to
make it easier for you to send feedback about the content in a topic. Click the icon to let us
know if a topic is helpful to you, and also to comment on what needs improvement.
Use Admin Insights to create custom admin views

Enable the Admin Insights project for your site to create custom admin views about Tableau
Cloud adoption, site traffic, licence allocation and more. For more information, see Use
Admin Insights to Create Custom Views.
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Configure email alerts for incomplete extract refreshes

As an extract data source owner whose scheduled refreshes are performed by Tableau
Bridge, you can configure Tableau Cloud to send you email alerts for incomplete refreshes.
For more information, see Change the Bridge Client Settings.
Tableau Bridge improvements

Here are some additional improvements made to the Tableau Bridge client and workflow.
l

Access Tableau Bridge-related admin views from the client menu.

l

Quickly identify whether live queries are supported directly from the client.

l

Receive email alerts when a scheduled refresh cannot start because the client is not
running.

Note: After Tableau Cloud's upgrade to 2019.2, some data source owners might see
an influx of notifications about Tableau Bridge clients not running. For more information, see Scheduled refreshes appear to be running outside of schedule:.
Ask Data improvements

For users, Ask Data now lets you ask questions in a conversational style, apply simple calculations and create multiple sheets. For more information, see Automatically Build Views
with Ask Data in the Tableau User Help.
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For data managers and site administrators:
l

Words like "year" and "date" are reserved for analytical functions and should be

l

avoided in field names.
The ability to add synonyms for field names is now limited to data source owners and

l

Tableau administrators, providing a more consistent experience for users.
A Usage Analytics dashboard reveals the most popular queries, top users and other
helpful information.

For more information, see Optimise Data for Ask Data in the Tableau User Help.
Home page and navigation improvements

For users and administrators, new navigation changes and pages make it easier to get started and locate relevant content:
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l

Use the new Home page to access recent views, find favourite content, and see what's
popular on the site. The welcome banner and actions are tailored by site role to help
users get started.

l

Dedicated Favourites and Recents pages give users access to all of their mostimportant content. Use the sort and filter options on the right side of each page to find

l

relevant content.
New left navigation panel lets users quickly jump between important pages on the site,
including the Explore page, where they can see all site content in one place. The
panel is responsive to screen sizes and can be collapsed.
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l

When users are viewing or creating a visualisation, the left navigation panel disappears to make more room for analysis. The compact header makes it easy to navigate through project hierarchy, search the site and access favourites as needed.

To learn more, see Tour Your Tableau Site in the Tableau User Help.
Alert side panel

When users select Alerts in any view, a new panel shows alerts that already exist for the
viz. To create an alert that is visible for others, select Make visible to others when creating
the alert. Alerts created prior to 2019.2 are not visible to others, but can be updated to be.
To learn more, see Send Data-Driven Alerts from Tableau Cloud or Tableau Server in the
Tableau User Help.
Custom views supported for Viewer role

Previously, creating custom views required a Creator or Explorer licence, but now Viewers
can create them too. For more information, see Use Custom Views in the Tableau User
Help.
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Set a default site start page

Administrators can set a default start page for everyone on a site. When a site user signs in
to Tableau Cloud, they will land on the start page set by an administrator. For more information, see Set the Default Start Page for All Users.
Web authoring improvements
l
l

Add a stored procedure with parameters when creating a data source.
See the status bar in web authoring to find information about your view, including selected marks compared to total marks, rows and columns and aggregations. For more

l

information on the status bar, see Status Bar Information in the Tableau User Help.
Change aggregation of a field using the drop field menu. Right-click+drag (on macOS,
left-click+Option+drag) a field on any card or shelf and select an aggregation type.

l

This drops the field onto the card or shelf with the aggregation selected.
Create, edit and remove parameters.

Added in February 2019
Improved content browsing

You have a new way to browse shared content. When you open a project, you will be able to
see all the content that project contains – workbooks, views, data sources, flows and nested
projects – in a single grid or list. Locating content is easier, because you no longer need to
navigate separate pages for different content types. For more information, see Tour Your
Tableau Site.
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Ask Data to automatically create a viz

Ask Data introduces an entirely new way to interact with your data, letting you type a question and instantly get a response in Tableau. Answers come in the form of automatic data
visualisations, with no need to manually drag and drop fields or understand the nuances of
your data’s structure.
Ask Data lets you ask sophisticated questions naturally, with support for key analytical concepts like time series and spatial analysis, and an understanding of conversational phrases
like “last year”, “earliest” and “most popular”.
Ask Data is available for all user roles with direct access to data sources: Creators,
Explorers and Interactors.
For more information, see Automatically Build Views with Ask Data in Tableau User Help.

64

Tableau Software

Tableau Cloud Help

Vector tile background maps

Maps created on or published to Tableau Cloud or Tableau Public now use vector tiles for
quicker geographic data exploring. Maps now appear sharper and smoother when you pan
and zoom, and labels and icons dynamically resize or reshape to fit your view. The new vector tile maps replace the underlying technology that powers Tableau background maps for a
smoother and crisper experience. The background cartography for Tableau maps has also
been updated.
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New cloud connectors for web authoring

Use the Box, Dropbox, Google Drive, Google BigQuery and OneDrive connectors to connect Tableau Cloud or Tableau Server to your data. For more information, see Creators:
Connect to Data on the Web.
Project card images

Project card images will no longer appear on the project card unless they are added as the
last item in the project description and encapsulated with ! (exclamation marks). For more
information, see Add a Project Image.
Suspended subscription notifications

When you subscribe to a view or a workbook, you receive an email snapshot of that content
at regular intervals. Now, you'll receive an email notification if something caused your subscription to fail, with links to resume or delete the failing alert. For more information, see
Create a Subscription to a View or Workbook.
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See new demographic data in Tableau Cloud and Tableau Public

Tableau Cloud and Tableau Public have a new, different source of demographic data than
Tableau Desktop. If your map uses a demographic data layer in Tableau Desktop, you may
notice some slight differences when that map is published to Tableau Cloud or Tableau
Public, including the time period and value breaks in a legend. In addition, maps that use the
“Block Group” Data Layer option in Tableau Desktop will be automatically updated to
“Census Tract” when published to Tableau Cloud or Tableau Public. Six demographic data
layers that appear in Tableau Desktop will be absent when maps are published to Tableau
Cloud or Tableau Public:
l
l
l
l
l
l

Population growth projections
Household growth projections
Housing units growth projections
Effective Buying Income (median)
Year structure built (median)
Length of Residence (average in years)

Publishing maps from Tableau Desktop to Tableau Server will not result in any discrepancies.
Filter improvements

Use Ctrl-click (control-click on a Mac) to select multiple values in a multi-value filter in the
view. The selected values can be non-contiguous and are indicated with a grey highlight.
When the values are selected, you can then click any one of their tick boxes to clear or
choose the values at the same time.
Web authoring enhancements
l

New cloud connectors for web authoring: Use the Box, Dropbox, Google Drive,
Google BigQuery and OneDrive connectors to connect Tableau Cloud or Tableau
Server to your data.

l

Data improvements: Authors connecting to a new data source in Tableau Cloud or
Tableau Server can now Run Initial SQL, connect to a custom SQL query and add a
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join calculation to resolve mismatches between fields in a join.
l

To better distinguish between dashboard items, you can now rename them using the
Item hierarchy area of the Layout pane or the drop-down menu for each object on
the canvas.

l

After publishing to the web, click Preview device layouts in the browser to see how
your designs look on desktop computers, tablets and phones.

For related information on new features, also see What's New in Tableau Desktop and
Web Authoring Help.

Review and monitor Tableau Bridge extract refresh tasks using admin views

Review and monitor extract refresh tasks performed by Tableau Bridge using admin views.
For more information, see Bridge Extracts.
Configure a timeout limit for extract refreshes in Tableau Bridge

To ensure that long running refresh tasks don't prevent other extracts from refreshing, you
can enforce a timeout limit for refresh tasks performed by a Tableau Bridge client. For more
information, see Configure a timeout limit for refreshes.
Find the Tableau Bridge client version number on Tableau Cloud

As a site admin, you can check Tableau Cloud for the version numbers of the Tableau
Bridge clients associated with your site.
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Note: If the version number for a client is missing, log on to the computer where the client is
installed and sign in to Tableau Cloud from the client. If the version number doesn't display
after that, consider upgrading to the latest client.
Help Design

Updates have been made to help you navigate our content, including a new right-hand menu
to quickly scan and select different topics on a page.

Added in October 2018
Web authoring enhancements
l

Build density maps and charts. Use the density mark to create maps and charts that
can help you identify "hot spots" in your data.

l

Add image objects to your dashboards. Easily adjust your image, add a target URL,
and add alt-text to improve the accessibility of your dashboard.

l

Add navigation buttons to dashboards. Buttons can help users navigate to another
dashboard, a sheet or a story. Optionally customise the button with an image of your
own, or add guiding tooltip text.

l

Make worksheets transparent by setting the worksheet background colour to None.

l

Select Duplicate as Crosstab to insert a new worksheet into your workbook and populate the sheet with a cross-tab view of the data from the original worksheet.

l

Create, move and resize point, mark and area annotations.

For related information on new features, also see What's New in Tableau Desktop and
Web Authoring Help.
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Product help search, navigation and layout improvements

Search results within the product help have been expanded to include results for all Tableau
products and help articles. Help layout and navigation, such as table of contents placement
and breadcrumbs, have been updated to create a more consistent cross-product help experience.
Secure extract data at the row level

Secure your extract data at the row level using existing approaches for implementing rowlevel security in Tableau. For more information, see Restrict Access at the Data Row Level
in the Tableau User Help.

Added in July 2018
Tableau Cloud migrated to Linux servers. For more information, see Tableau Cloud Pod
Migrations on the Tableau website.
Changes to Tableau Help

Search results within the product help have been expanded to include results for all Tableau
products and help articles. Help layout and navigation, such as table of contents placement
and breadcrumbs, have been updated to create a more consistent cross-product help experience.
Install Tableau Bridge separately from Tableau Desktop

Beginning with the 2018.2 release, you can install Tableau Bridge separately from Tableau
Desktop. For more information about Tableau Bridge requirements, compatibility with previous version of Tableau Desktop, and Tableau Bridge client installation, see Install Tableau
Bridge.
No auto-restart for Tableau Bridge

The standalone Tableau Bridge client does not use an auto-restart interval to restart itself
automatically. For more information about the auto-restart interval required by previous ver-
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sions of Tableau Bridge, see Tableau Bridge Frequently Asked Questions in the Tableau
Knowledge Base.
Note: If you upgrade from Tableau Bridge 2018.1 and earlier to Tableau Bridge 2018.2, the
auto-restart interval that remains in the configuration file is ignored.
Font support in Tableau Cloud

Tableau Cloud includes the following "web safe" fonts: Arial, Courier New, Georgia,
Tableau, Times New Roman, Trebuchet MS and Verdana.
If a visualisation uses a font that is not available on Tableau Cloud, Tableau Cloud displays
the visualisation using a default system font instead. For more information, see Fonts Not Displaying as Expected After Publishing knowledge base article on the Tableau website.
Validate live connections in Tableau Bridge using Application mode

You can now quickly validate live connections in Tableau Bridge using Application mode.
This means you can also choose to run live queries only when you are logged on to Windows
if the site administrator has enabled the option. For more information, see How Tableau
Bridge Works.
Manage dashboard extensions in Tableau Cloud

Dashboard extensions are web applications that provide users new ways to interact with
data from other applications directly in Tableau. You can control the dashboard extensions
that you allow to run in Tableau and can manage the extension's access to data. To learn
more about controlling extensions, see Manage Dashboard Extensions in Tableau Cloud.
Include colleagues on data conversations with @mentions

To engage people in a conversation about compelling data you find in a view, @mention
them in comments. As you begin to type a name, matching people with Tableau accounts at
your organisation appear in a list you can choose from. For more information, see Comment
on Views in Tableau User Help.

Tableau Software

71

Tableau Cloud Help

Site administrators can disable @mentions in the General section of site settings.
Web authoring enhancements
l

Enhance dashboard functionality by connecting to external applications with dashboard extensions. See Use Dashboard Extensions in Tableau User Help.

l

Align dashboard items with a visual grid. See Size and Lay Out Your Dashboard in
Tableau User Help.

l

Use keyboard shortcuts to quickly create and edit views on the web. See Keyboard
Shortcuts in Tableau User Help.

l

Create multi-connection data sources and join data from different databases (crossdatabase joins). See Join Your Data in Tableau User Help.

l
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Union data from the same data connection on the web. See Union Your Data in
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Tableau User Help.
l

When working with file-based data sources, you can pivot data from crosstab format
into columnar format. See Pivot Data from Columns to Rows in Tableau User Help.

l

Copy selected values in your data grid by pressing Ctrl+C (Windows) or (Command+C) (macOS). Alternatively, to copy selected values in the metadata grid, rightclick, and select Copy.

l

Find fields in the Data pane using schema search.

l

Better control over sorting. Use nested sort to sort dimension values within the context
of each pane. You no longer need to create calculated fields or combine dimensions.
For more information, see Sort Data in a Visualisation in Tableau User Help.
Also, you can now access the Sort dialog box by right-clicking a dimension field on the
Rows or Columns shelves in a view.

l

If you've changed a view (for example, by adjusting filters), you can now create data
alerts without first saving a custom view.

l

You now have two ways to open the Edit Axis dialog box. Hover near the top of the
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axis (vertical axis) or to the right (horizontal axis) and click the drop-down arrow that
appears. Or, double-click the axis.

l

When you select Logarithmic scale for an axis, you now have the option to specify
Symmetric to display data that contains 0 or negative values on a log scale axis. For
details, see Edit Axes in Tableau User Help.
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l

Create and delete annotations by right-clicking the view (in a worksheet or dashboard), and then selecting point or mark annotation. Right-click the annotation again
to edit or remove the annotation.

Tableau Software

75

Tableau Cloud Help
Materialise calculations in extracts already published to Tableau Cloud

If you need to retroactively materialise calculations in extracts that have already been published to Tableau Cloud, you can use tabcmd to refresh the published extract with the -addcalculations option. For more information about materialising calculations in
extracts, see Materialise Calculations in Your Extracts in the Tableau User Help. For more
information about the tabcmd option, see refreshextracts workbook-name or datasourcename.

Added in April 2018
New user-based term licences are now available

Tableau now offers different types of user-based term licences that grant a range of web
authoring and other capabilities at various price points. This gives organisations more flexibility to fit licences to the data analysis and visualisation needs of different users. To learn
more, see User-based licences, or to see the capabilities of each licence, see Tableau Pricing.
Quickly analyse cloud-based data with Dashboard Starters

Dashboard Starters help you quickly author and analyse data from cloud-based systems
like Salesforce, ServiceNow, Oracle Eloqua and Marketo. Simply create a new workbook
and choose from several beautiful, informative designs that are tailor-made for key business
metrics. For more information, see Use Accelerators to Quickly Visualise Data
Configure additional Tableau Bridge clients to load balance live connections

Site administrators can configure additional Tableau Bridge clients on different computers
to load balance live queries. For more information, see Allow Publishers to Maintain Live
Connections to On-Premises Data.
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Cancel a scheduled extract refresh that's in progress using Tableau Bridge

There may be situations where you need to cancel an in-progress extract refresh. You can
cancel an in-progress extract refresh if you have configured the extract to refresh on a schedule using Tableau Bridge. For more information, see Create a Schedule for a Tableau
Bridge Data Source.

Connect to data on the web

With a Creator user licence, you can connect to data directly in your browser. Upload Excel
or text-based data sources, connect to data housed in a cloud database or on a server in
your enterprise, or connect to published data saved to your site. For more information, see
Creators: Connect to data on the web.
Prepare your data on the web

With a Creator user licence, use the Data Sources tab to prepare your data for analysis.
Create joins, add new data sources, clean your data using the Data Interpreter and more.
For more information, see Creators: Prepare Data on the Web.
Add an accessible toolbar to an embedded view

Authors can enable an accessible toolbar so that all users can add comments, download the
view or share it with others. For more information, see Publish and embed the view in Author
Views for Accessibility.
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Download your workbook in an earlier version of Tableau

You may need to download your workbook to a different version of Tableau, for example, if
the workbook needs to be opened in an earlier version of Tableau Desktop. You have the
option of downloading your workbook in its current version, or downgrading it to an earlier
version. For more information about version compatibility, see Make Workbooks Compatible Between Versions.
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Web Authoring Enhancements
l

When editing a view on the web, you can resize the width of row headers and the
height of column headers.

l

Show Me is now available for dashboards.

l

Double-click an annotation to edit its text.

l

Hide or show a Viz in Tooltip worksheet. In the target worksheet that is the Viz in Tooltip, click Hide. To show the Viz in Tooltip worksheet again, in the source worksheet,
click Unhide All Sheets.

l

Filter hierarchical data in views by using the All Values in Hierarchy filter option.

l

Change the Line mark type to a step line or a jump line by clicking the Path property in
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the Marks card.
l

Double-click an axis to edit axis settings.

Added in February 2018
Streamline discussion threads by deleting comments

If a comment is unnecessary or inaccurate, you can quickly delete it. Just click the X in the
upper-right corner. For more information, see Comment on Views in Tableau User Help.

Added in January 2018
Tableau Cloud servers were upgraded to version 10.5.
Recommended data sources

Recommended data sources show Tableau Desktop users relevant data sources published
to Tableau Server and Tableau Cloud. These recommendations are based on published
data sources used by other users in your organisation with similar usage behaviour as the
current user.
To keep the recommendations accurate and up to date, the server checks for the following
each day:
l

New content – for example, new or updated data sources.

l

New usage information – for example, Laura Rodriquez used the Food Catering data
source and Henry Wilson used the Monthly Sales data source.

For information on recommended data sources, see Use Certified and Recommended
Data Sources and Tables in Tableau User Help.
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Nested projects

You can now create project hierarchies when you want to segment content into sub-sections
within a larger area. For example, you might create a project for each department. In each of
those top-level projects, you can separate content based on how the audience uses it, such
as connecting to certified data versus in-progress collaboration. For more information, see
the following articles:
l

Use Projects to Manage Content Access

l

Navigate projects in the article Navigate Tableau on the Web

Extracts use the new .hyper format

When you create an extract, it uses the new .hyper format. Extracts in this new format take
advantage of the improved data engine, which supports the same analytical and query performance as the data engine before it, but for even larger extracts. Similarly, when you perform an extract task on a .tde extract, the extract is upgraded to a .hyper extract. For more
information, see Extract Upgrade to .hyper Format.
Changes to the way values are computed

To improve data source efficiency and scalability, and produce results that are consistent
with commercial databases, values in your data source can be computed differently in version 10.5. In some cases, these changes can cause differences with the values and marks in
your view between version 10.4 (and earlier) and version 10.5 (and later). This applies to
extract data sources, and can apply to multi-connection data sources, data sources that use
live connections to file-based data, data sources that connect to Google Sheets data, cloudbased data sources, extract-only data sources and WDC data sources. For more information, see Changes to values and marks in the view in the Tableau User Help.
Desktop operating system requirements (64-bit replaces 32-bit)

Starting with version 10.5, Tableau Desktop, Tableau Reader and Tableau Public (desktop)
run only on 64-bit operating systems. Version 10.4 is the last version of Tableau Desktop,
Tableau Reader and Tableau Public to support 32-bit Windows operating systems.
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New in Web Authoring
l

Add text objects to dashboards and edit them.

l

Edit worksheet and dashboard titles. Double-click the title to open the Edit Title dialog box.

l

Edit trend lines and view a description of the trend model. To view the trend model,
hover over any part of the trend line. To edit a trend line on the web, click a trend line
and hold the cursor in place, then click the Edit menu.

l

Trend lines now include a Power option.

l

Create hierarchies by dragging one dimension onto another in the Data pane.

l

Set the default colour property for a field.

l

For quantitative colour legends, advanced settings are available (dates not included).

l

Edit axes on the web. To open the Edit Axis dialog box on the web, double-click an
axis in the view. Options available from the Edit Axis dialog box include Synchronise
dual axes, clearing the axis range (Reset) and editing tick marks. You can also
enable or disable Dual axis in a field context menu (right-click a measure field on
Rows or Columns shelf).

Filtered search hidden by default

Filtered search options are now located on the right side of pages, and are hidden by
default. The toggle is a dark icon (

) when the Filters pane is open and a light icon (

) when the Filters pane is closed. For details on searching, see Search Content.
To use filtered search, click

82

.

Tableau Software

Tableau Cloud Help

Added in 2017
Added in September 2017
Tableau Cloud servers were upgraded to version 10.4.
Data-driven alerts

When data reaches important thresholds for your business, data-driven alerts automatically
send email notifications to key people that users specify. For information on how to create
and manage these alerts, see Send Data-Driven Alerts in Tableau User Help.
Data source certification

Certification offers a way to promote data sources through curation. Site administrators and
project leaders can certify data sources that meet your organisation’s security and com-
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pliance standards, or any other standards you define. For more information, see User Certification to Help Users Find Trusted Data.
Tableau Bridge support for live connections

Live query functionality in Tableau Bridge can now be enabled by site administrators
without requesting access from Tableau. Use Tableau Bridge to maintain live connections
to on-premises relational data, and to perform scheduled extract refreshes. For more information, see Use Tableau Bridge to Expand Data Freshness Options.
Enhanced commenting on views

Commenting has been completely redesigned to inspire conversations about data discoveries. The new Comments pane appears to the right of views, rather than at the bottom,
so you can see the discussion and the data at the same time. Profile images automatically
appear too, helping you quickly identify other users. To share filtered views with them, add
interactive snapshots along with your comments to highlight the data you're describing.
Any comments you add in a desktop browser also appear in Tableau Mobile, and vice
versa, so you can easily communicate with colleagues on the go. Comments remain with a
view even if you revise the containing workbook (as long as the view name remains the
same). For more information, see Comment on Views.
Learn who has seen a view

If you own a view, you can quickly find out who at your organisation has seen it. At the top of
a main site page, click Views. Then hover over the specific view you're interested in, and
select Who Has Seen This View? from the menu at upper-right.
WCAG-conformant drop-down filters in embedded views

Single Value (drop-down) and Multiple Values (drop-down) filters are now WCAG-conformant when accessed in embedded views. For more information, see Build Data Views
for Accessibility and Author Views for Accessibility.
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New to Web Authoring
Precise dashboard spacing, with border and background colour controls

If you previously used blank objects to refine dashboard layouts, you'll really appreciate the
new spacing controls. Padding lets you precisely position items on dashboard, while borders
and background colours let you visually highlight them. For more details, see Add padding,
borders and background colours around items.
Turn on the View Toolbar on the web

In prior releases, when authoring on the web, you could only see and use the View Toolbar
when working with map views. Now you can turn on the View Toolbar for any view or dashboard in your workbook in web authoring. From the top menu, select Worksheet > Show
View Toolbar and select an option.
Edit groups

Starting with Tableau version 10.4, you can edit groups. To edit a group, in the Data pane,
right-click a group field and select Edit Group. In the Edit Group dialog box that opens, you
can add or remove members from an existing group, as well as create new groups in the
group field. You can also choose to Include an Other group. For more information, see
Group Your Data.
Create aliases

Starting with Tableau version 10.4, you can create aliases for members in a dimension so
that their labels appear differently in the view. To create aliases for a field, in the Data pane,
right-click a dimension and select Aliases. In the Edit Aliases dialog box, under Value
(Alias), select a member and enter a new name. For more information, see Create Aliases
to Rename Members in the View.
Format lines

When you are authoring on the web, you can quickly change all the lines in your workbook.
Select Format > Workbook, then expand the Lines section on the Format Workbook and
make your selections. For more information, see Format at the Workbook Level.
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Added in July 2017
User-specific time zones for subscription schedules

Subscription schedules were previously limited to one time zone, but now users can choose
any time zone. At the top of the browser window, click your name, and select My Account
Settings. Then, under Subscription time zone, select the time zone for schedules you
create.

Added in June 2017
Default task priority for all extract refreshes

To ensure fair distribution of processing for all Tableau Cloud customers, we're removing
the ability for site administrators to set task priority for scheduled extract refreshes. All previously set priorities will return to the default value.

Added in May 2017
Tableau Cloud servers were upgraded to version 10.3.
Tableau Cloud sync client evolves into Tableau Bridge

Limited release, by request. The Tableau Online sync client has gained some new functionality and a new name to go with it. Use Tableau Bridge to maintain live connections to
on-premises relational data. Bridge also takes on all of the functionality that was provided in
the sync client for scheduling extract refreshes. Your existing schedules will continue to run
as previously defined in the sync client.
Live query functionality is currently available to site administrators by request only. For more
information, see Use Tableau Bridge to Expand Data Freshness Options.
Encrypted SAML assertions from Identity Providers

Tableau Cloud now supports encrypted SAML assertions from Identity Providers. To learn
more about configuring SAML single-sign-on, see Enable SAML Authentication on a Site.
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Site access for support users

Tableau Cloud administrators can allow approved Tableau support technicians to access
their Tableau Cloud site to help troubleshoot a customer support case. To learn more, see
Enable Support Access.
Help Redesign

Starting with version 10.3, Tableau Desktop Help is now known as Tableau Help. Tableau
Help contains all help topics related to analysing and consuming data in Tableau Desktop,
Tableau Server and Tableau Cloud. This help is for people who create workbooks or data
sources and publish them, and for people who want to see, interact with and share views in
Tableau.
We welcome your feedback on this change, as well as any feedback or ideas you might have
on how to make our content better. Please use the feedback bar on the top of any page
("Was this page helpful?") to open the comment field and submit your feedback.
Using Tableau on the Web provides links to the topics that used to be located in Tableau
Server and Tableau Cloud help.
New to Web Authoring

Web authoring topics for Tableau Server and Tableau Cloud are now located in Tableau
Help, starting with version 10.3.
Save data source

You now have the option to save a data source that is embedded with a published workbook,
as a separate, published data source on Tableau Server and Tableau Cloud that other users
can connect to. When you save the data source, you can choose to update the workbook to
connect to the newly saved data source.
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Edit quantitative colour legends

You can now edit the colour palette for continuous colour legends in web authoring. You
can open the Edit Colours dialog box from the Marks card or by clicking the drop-down
arrow on the legend.
Marks card:
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Legend:
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You can also set a custom colour for the start and end colours by entering the Hex value.

Edit colours on separated legends

When you create separate colour legends for measures in your view, you are no longer
restricted to using only the default colour palette or the colour palette assigned to each colour
legend when the view was published from Tableau Desktop.
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In web authoring mode, you can now select different colour palettes for each legend. Click
the drop-down arrow on the legend to open the Edit Colours dialog box and then select the
colour palette. You can also set custom start and end colours using Hex values.

Customise how people interact with your map

In web authoring mode, you can now customise how your audience interacts with your map
view in the following ways using the Map Options dialog box:
l
l
l
l

Show a map scale
Hide map search
Hide the view toolbar
Turn off pan and zoom

For more information, see Customise How People Interact with your Map.
Format numbers on the web

You can now specify basic number formatting for measures in the view on Tableau Server
and Tableau Cloud. For more information, see Format Numbers and Null Values on
Tableau Server or Tableau Cloud.
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Create stories

In web authoring, you can now create a story to tell a data narrative, provide context, demonstrate how decisions relate to outcomes or to simply make a compelling case. See Create a
Story for details.
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Create and edit bins

Create bins from continuous measures and edit them in Tableau Server and Tableau
Cloud, similar to how you do it in Tableau Desktop. For details, see Create Bins from a
Continuous Measure.
Drag fields to Show Me in the view

Select and drag dimensions and measures of interest to the view area. A "Show Me" view is
automatically created. You can then click other Show Me options to try different view types.
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Drill up and down a continuous hierarchy in the view

In a view with a continuous hierarchy, hover near the headers on a continuous axis to display
the + and - controls. Click to drill down or up.
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Added in March 2017
Google authentication

Google authentication gives you the convenience of using your Google ID and password
with Tableau Cloud, thus reducing the number of sign-in prompts when accessing Tableau
Cloud. Your site administrator can manage these credentials in a central location so that
you no longer need to reset multiple passwords. For more information about Google authentication, see Authentication.
Custom schedules for subscriptions

Subscription schedules used to be limited to a set of standard options, but now you can
receive emails on whatever schedule works best for you. To learn more, see Subscribe to
Views.
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Added in February 2017
Tableau Cloud servers were upgraded to version 10.2.
The following items in What’s New in Tableau Server also apply to Tableau Cloud.
l

Support for accessibility compliance
The functionality referred to in this item is for Tableau Desktop authors who want to
create accessible views that they publish to Tableau Cloud or Tableau Server.

l

Web authoring enhancements

Added in 2016
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Added in November 2016
Tableau Cloud servers were upgraded to version 10.1.
Web authoring enhancements
l

Show or hide headers in a view.

l

View read-only device layouts for dashboards.

Full-screen views

To expand a view, click Full Screen at the far right of the toolbar. To return to the view to its
previous size, press Esc.

Send subscriptions for high-priority alerts

If you’ve configured a view to contain data only when high-priority information exists, select
the new subscription option, Don’t send if view is empty. For more information, see Subscribe to Views and Manage Your Subscription Settings.
New location for downloading tabcmd

The tabcmd installer is now available from the Tableau Server Releases page on the
Tableau website. In this location, you can always find the latest version of tabcmd.
The tabcmd download is on the release notes, under the version number.
The link from the Tableau Cloud Help has changed, too. If you bookmark this link, you can
update it at Install tabcmd.

Sign In to Tableau Cloud
You can sign in to Tableau Cloud from a Tableau client. Examples of clients include a web
browser, Tableau Desktop, Tableau Bridge, and Tableau Mobile. You can sign in to your
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site directly, or from a Tableau view embedded in a web page.

Sign-in options and steps
Depending on how your site admin set up your Tableau Cloud site, you will use one of the following ways to sign in (these are also referred to as authentication types):
l

Single sign-on
Single sign-on (SSO) means that your admin has set up the Tableau Cloud site so that
you can use the same username and password (credentials) you use for other applications in your company.
When you use SSO, your credentials are managed outside of Tableau Cloud by a
third-party identity provider (IdP). When you enter your credentials to sign in to
Tableau Cloud, it's the IdP that lets Tableau Cloud know you are an approved user.

l

Tableau with MFA
When multi-factor authentication (MFA) is enabled with Tableau authentication, you
use a combination of your TableauID credentials and a verification method to access
Tableau Cloud.
TableauID credentials are made up of an email address and password that you use
for accessing your Tableau Cloud site. These credentials also give you access to other
content on the Tableau website, such as on-demand training videos and white papers.
You can choose a verification method after you register for MFA. For more information, see Register for multi-factor authentication.

How to know which type of credentials your site uses
If your site is set up for single sign-on (SSO) credentials, generally your site admin will notify
you, and you use the same username and password you use for signing in to other programs
in your organisation.
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If your site admin has set up the site to use Tableau authentication, you receive an email
invitation to the site. When you click the link in the email, you can create your password.
That email address and password become your TableauID. In addition, if MFA is enabled,
you are prompted to register at least one verification method to use to confirm your identity
each time your sign in.
If you are not sure how the site is set up or which credentials to use, check with your
Tableau Cloud site admin.

To sign in (includes Tableau Cloud URL)
Do one of the following, depending on where you're signing in:
When signing in

Do this:

from:
A web browser

Enter the Tableau Cloud URL into the address bar:

https://online.tableau.com
Tableau Desktop, to

Select Server > Sign In, and enter the Tableau

publish or access con-

Cloud URL: http://online.tableau.com

tent
Tableau Desktop, to

Select Server > Start Tableau Bridge Client.

sign in to Tableau
Bridge
Tableau Mobile app

Tap Sign In, and then tap Connect to Tableau

Cloud.
For sites with SSO

1. On the Tableau Cloud sign-in page, enter your email address and click Sign In.
You are directed to the sign-in form for the identity provider if you've been added to
only one site. Enter your username again and your password. The third party will
authenticate you and direct you back to Tableau Cloud.
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2. If you’ve been added to multiple sites with SSO, enter the site Uniform Resource Identifier (URI) for the site you want to access, and then click Continue.
As of January 2022, the site URI is required to maintain site privacy. The site URI is
the unique identifier for your Tableau Cloud site and appears in the site URL after
authenticating. For example, a site name "Company X" may appear in the URL as
https://us-east-1.online.tableau.com/#/site/companyx. To avoid
remembering your site URI, you can bookmark site URLs in your browser to quickly
redirect and authenticate to that Tableau Cloud site.

Note: If you don’t remember the site URI, click Forgot Site and follow instructions to verify your email address. Only one verification code is sent within 15
minutes, so be sure to check your spam folder if you don't see an email from
Tableau. After verification, you're redirected to a list of sites associated with your
username. You won't need to verify your email address again for 30 days on this
client.

Tableau Software

99

Tableau Cloud Help
For sites with Tableau authentication

1. On the Tableau Cloud sign-in page, enter your email address and password, and
then click Sign In.
If multi-factor authentication (MFA) is enabled with Tableau authentication, you are
prompted to verify your identity using the verification you selected during the
MFA registration process. Note: If you are signing in to Tableau Cloud or registering
for MFA for the first time, see Register for multi-factor authentication below.
2. If your admin has added you to multiple Tableau Cloud sites, you are prompted to
select a site.

To sign out
To sign out, select your display name in the upper-right corner of any page, and then select
Sign Out.

If your site uses single sign-on, and you do not see a Sign Out link, close the browser tab or
window. The Sign Out link does not appear if your site and the identity provider that manages your company's user information are not configured to support single log-out.

Remember your sign-in credentials
If you want Tableau Cloud to remember your username, select Remember me on the signin page. The next time you sign in, Tableau enters your username. You still need to type
your password.
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For sites with SSO authentication, Tableau remembers your username and sets a default
site as well. The next time you sign in, Tableau enters your user name and redirects you to
the IdP for authentication without prompting for the site's URI.
In both scenarios, the default site will be replaced if:
l

You sign in to a different Tableau Cloud site and select Remember me again.

l

You use deep links, URLs that point to specific sites, to access Tableau Cloud and
select Remember me when signing in to that site.

To make Tableau forget your user information, remove cookies using your web browser.

Connected clients
Your site admin has the option to allow direct sign-in from approved Tableau clients. For
examples of clients, see this topic's introduction.
After you sign in successfully from a recognised client, Tableau stores your credentials in a
secure token that remembers your connection with Tableau Cloud. When this token is in
place, you can access your Tableau Cloud site directly, without having to sign in.

Clearing saved sign-ins
l

If you want to disconnect from your site, you can explicitly sign out from the connected
client. For example, in Tableau Desktop, select Server > Sign Out.

l

To remove all existing server connections from Tableau Desktop, select Help > Settings and performance > Clear saved server sign-ins.

Note: Site admins can disallow secure tokens that store users' connections to the site.
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Sign in to an embedded view in Internet Explorer
When you browse to a web page that has an embedded view, you see a sign-in button in
the frame where the view will appear. If you use Internet Explorer (IE), and after entering
your credentials, the sign-in button is not replaced with the view, the browser security settings might be blocking access to the view.
IE uses security zones to determine access levels to websites. To display Tableau embedded views in IE, you can add the website you visit and Tableau Cloud addresses to the correct security zone.

Add web addresses to IE security zones
1. In Internet Explorer, browse to the website that contains the Tableau view.
2. Click the Tools button, and then select Internet Options.
3. On the Security tab, add the website to the appropriate security zone as follows:
l

If the site that contains the Tableau view is internal to your organisation, select
Local intranet, click Sites, and click Advanced. If the site is not already
there, add it to the Websites list.

l

If the site is external to your organisation, select Trusted sites, click Sites,
and add it to the Websites list.

4. Add Tableau Cloud:
Select Trusted sites, and in the Add this website to the zone box, enter *.online.tableau.com.
5. Click Add, and then click Close.
These steps were taken from the Microsoft Windows page Security zones: adding or removing websites.
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Note: The link provided will take you away from the Tableau website. Although we
make every effort to ensure these links to external websites are accurate, up-to-date,
and relevant, Tableau cannot take responsibility for the accuracy or freshness of pages
maintained by external providers. Contact the external site for answers to questions
regarding its content.

Register for multi-factor authentication
To help ensure account security, your site admin might enable multi-factor authentication
(MFA) with Tableau authentication. If MFA is enabled, you must register at least one verification method to use to confirm your identity each time you sign in to Tableau Cloud. Note:
If you're using Tableau Desktop or Tableau Bridge in conjunction with Tableau Cloud, you
must be running version 2021.1 and later.
MFA is a secure account authentication method that requires you to prove your identity by
providing two or more pieces of verification information, also known as “factors”, when you
sign in to Tableau Cloud. The first factor is the username and password you use to sign in to
Tableau Cloud (i.e. your TableauID credentials). The additional factor is a code generated
by an authenticator app, such as Salesforce Authenticator or a third-party time-based onetime passcode (TOTP) app.
To compare supported verification methods and review usage requirements, see Verification Methods for Multi-Factor Authentication topic in Salesforce Help.
Important: In most cases, verification methods for Tableau Cloud are mobile authenticator
apps that you need to install on a mobile phone.
1. Sign in to Tableau Cloud with your username and password. You are prompted to
register for MFA.
2. Select a verification method.
For example, click Salesforce Authenticator.
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3. Follow the steps in the Tableau Cloud dialog to associate the selected verification
method with your Tableau Cloud account.
For example, if you selected the Salesforce Authenticator app in step 2, you are
prompted to do the following:
1. On an iOS or Android mobile device, download and install the free Salesforce
Authenticator app from the App Store or Google Play.
2. On the mobile device, after the app installation completes, open the app and
tap Add an Account.
3. In Tableau Cloud, enter the two-word phase from the app in the dialog and click

Connect.
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4. To complete the sign-in process, Tableau Cloud prompts you to approve the sign-in
request through the authenticator app on the mobile phone. By accepting the request,
you are verifying your identity. You are then redirected to your site.
For example, if using the Salesforce Authenticator verification method, do the following:
1. When Tableau Cloud shows you the following prompt, respond to the push notification.
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2. In Salesforce Authenticator, verify that the request details are correct.
3. Tap Approve. You are redirected to your site.

Manage verification methods
After you start using MFA, you can manage verification methods by clicking the Manage
MFA Verification Methods link in your My Account Settings page in Tableau Cloud. On
this page, you can add or remove additional verification methods. For example, if you get a
new mobile phone, delete any verification methods on the old mobile phone. If you're
unable to copy your authenticator app configuration by restoring it from a backup to your
new mobile phone, you must install and register an authenticator app again. For more
information, see Manage Your Account Settings.
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About recovery codes - use in emergency scenarios only
To help reduce the risk of a locked-out scenario, we recommend you add Recovery Codes
as backup after registering for MFA. Recovery codes, to be used in emergency scenarios
only, allow you to sign in to Tableau Cloud if you don't have access to your usual MFA verification methods. If you add Recovery Codes option, a list of ten one-time use codes are generated for you that you can use to sign in to Tableau Cloud.
Important:
l

Because the list of recovery codes are not accessible after you've added the Recover
Codes option, immediately copy and store these codes in a safe and secure location

l

so that you can use them in emergency situations.
Recovery codes should not be used as your primary verification method. Instead,
recovery codes should be used in emergency scenarios only when you don’t have
access to your usual MFA verification methods.
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Regain site access after being locked out
Important: We strongly recommend that you add the Recovery Codes option to help avoid
being locked out of your site. Recovery codes should be used in emergency scenarios only.
If you lose all your usual MFA verification methods, you must contact your Tableau Cloud
site admin and request that your MFA verification methods be reset. After your
MFA verification methods have been reset, follow the procedure in Register for multi-factor
authentication to register for MFA again.

Understanding Licence Models
This topic describes the different licensing models and the product keys or subscriptions
that may be associated with them. A useful visual of how product keys and subscriptions are
represented in Tableau Cloud can be found in the Tableau Customer Portal.
When viewing product keys using the Tableau Customer Portal (Tableau Desktop and
Tableau Prep Builder), note the product-specific prefixes.
Product

Description

Key Prefix
TC

Tableau Creator product key, can be used to activate or deactivate Tableau
Desktop and Tableau Prep Builder.

TD

Tableau Desktop product key, can be used to activate or deactivate Tableau
Desktop only. This is a legacy product key that is no longer sold or provided.

Term licensing models
Tableau’s term “licence model” is defined by the metric that permits use of Tableau Cloud.
Term licenses are also called subscription licences. Tableau currently sells access to
Tableau Cloud with subscription licences. In the subscription licence model, customers pay
a yearly subscription fee. If the subscription expires, the software will stop working.
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Subscription licences are either role-based or core-based subscriptions. A single license key
can be purchased with all roles and features and this license is called an Updatable Subscription License (USL). Only one key needs to be activated on Tableau Cloud to represent
the entire purchase.
l

A role-based licence allows you to add users based on the available licences of each
role type.

l

An Embedded Analytics usage-based licence imposes no constraints on the number
of Viewer user accounts in Tableau Cloud. Instead, the licence is per usage, more specifically analytical impressions.

Role-based licence model
Tableau offers role-based term licences that grant a range of capabilities at various price
points. Four types of role-based term licences are available: Display, Viewer, Explorer and
Creator.
l

l

l

l

Display licenses let users share and display Tableau content with a broad, internal
audience of users who consume dashboards via shared displays with no interaction.
There is no separate site role for Display licences; when using a Display licence, administrators create a dedicated login account for each licensed Display location, which is
not the same as an individual user’s login account, and assign the maximum site role
of Viewer.
Viewer licences let users view and interact with workbooks in Tableau Cloud. Viewer
licences also let users access Tableau Mobile, add comments to workbooks, export
visuals in various formats, download workbook summary data, create subscriptions for
themselves and receive data-driven alerts.
Explorer licenses are similar to the user-based licences available in previous Tableau
Cloud releases, and include the capabilities provided with Viewer licences and additional capabilities. An Explorer licence allows access to workbook authoring capabilities using a web browser, as well as a full set of collaboration features.
Creator licences permit a wide range of capabilities when using Tableau Cloud, and
also grant use of Tableau Desktop and Tableau Prep Builder. A Creator licence allows
all the capabilities available under the Explorer licence, as well as the following capabilities when using Tableau Cloud:
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l
l
l
l

Create and publish new workbooks from a new data source.
Edit embedded data sources in the Data pane.
Create and publish new data connections.
Use login-based licence management activation on Tableau Desktop and
Tableau Prep Builder.

Embedded Analytics
Tableau’s Embedded Analytics offering is a limited-use licence for Tableau Cloud that’s
made available to customers who wish to embed Tableau Cloud analytics into an externalfacing solution to provide Tableau content and insights to clients outside of their organisation.

Note: Embedded Analytics licences cannot be used in the same environment as fulluse licences.

For example, consider an organisation that runs a service where they analyse consumer
data and generate reports on behavioural patterns regarding different consumer demographics. In this scenario, Tableau Cloud acts in support of a specific proprietary application
titled ‘Demographics Analyser’ and connects with exported TXT files and an SQL database.
The organisation makes visualisations available to its clients in a secure portal, where clients log in to manage their account and view the results. End users are uniquely identified
by the account they use to access the portal.
To verify the licence contact Customer Success.

Embedded Analytics usage-based licence model
In the Embedding Analytics usage-based licensing model, while Creator and Explorer are
still defined per user, External Viewers are licensed per usage measured in analytical
impressions.
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An analytical impression is when an external viewer (viewer outside your organisation)
accesses one or more embedded analytics within (or related to) your external-facing application. For example, when a Viewer is performing these following actions:
l

Loading a dashboard.

l

Loading a worksheet.

l

Loading a Tableau metric.

l

Downloading or exporting a visualisation (dashboard or worksheet) such as an image,
PDF, PowerPoint or Tableau workbook via API or the UI.

l

Receiving a subscription.

l

Receiving a data-driven alert.

Site Admins will receive monthly overview emails updating them on Analytical Impressions
consumption so they can track their usage and manage their budget. You can also request
usage metrics at any time from your account managers to monitor usage.

Feature licences
Feature licences are sold differently than other licences. Features with independent licences
must be licensed for every user in the deployment.
These features are licensed annually, and in the context of licensing, the availability of these
features to the user base are “all or none”.
l
l
l

Data Management
Advanced Management
Login-based Licence Management

Note: Updatable subscription licences include both features and roles in one licence.
You no longer need to activate multiple licences and product key(s) for different features
and their associated roles.
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Data Management
The Data Management licence includes Tableau Catalogue and Tableau Prep Conductor.
For more information, see About Data Management.

Advanced Management
Tableau Cloud Advanced Management is licensed on a per-deployment basis. For more
information on Advanced Management and the features included, see About Tableau
Advanced Management on Tableau Cloud.

Login-based Licence Management
Login-based licence management (LBLM) simplifies licensing for Tableau Desktop and
Tableau Prep Builder. Instead of end users needing to activate product keys, Cloud Creators can activate and use Tableau Desktop and Tableau Prep Builder by signing in to the
Cloud site (LBLM).
For more information, see Activate Tableau using Login-based Licence Management.

Activate Tableau using Login-based Licence
Management
Login-based licence management is the preferred licence management and activation
option for Creator roles within Tableau Cloud, and is enabled by default on your site. Loginbased licence management allows authorised users to activate and unlock Tableau
Desktop and/or Tableau Prep Builder by signing in to Tableau Cloud. Login-based licence
management eliminates the need to distribute and manage product keys for Tableau
Desktop and Tableau Prep Builder.
You only need one Tableau Cloud site to authorise an individual Tableau Desktop or
Tableau Prep Builder. You can assign Creator roles to users who use Tableau Desktop,
and Tableau Prep Builder for licence activation and centralised licence management. In
addition, login-based licence management gives you more visibility into licence usage.
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You can use administrative views on Tableau Cloud to see the assignment and use of
Creator seats in one place. Administrative views provide information about who is using your
Creator licences, and shows the most recent licence lease and version of both Tableau
Desktop and Tableau Prep Builder, which helps you to monitor your Tableau deployments.
The following Tableau products support login-based licence management:
l

Tableau Cloud

l

Tableau Server 2020.1+

l

Tableau Desktop 2020.1+

l

Tableau Prep Builder 2020.1.3+

How login-based licence management works
When login-based licence management is in use, Tableau Desktop or Tableau Prep Builder
periodically contacts Tableau Cloud in order to verify that the user is a Creator and to obtain
an authorisation to run. Tableau Cloud contacts the Tableau-hosted authorisation-to-run
(ATR) service to verify that the Tableau Desktop client is allowed activation. The ATR service verifies and manages the licence and the length of the authorisation window. The diagrams below show the communication process between the client, Tableau Cloud, and the
licensing service.
Tableau uses common ports (80 and 443) to make internet requests. In most cases, the computer where Tableau Desktop or Tableau Prep Builder is installed and the network it is running on are already configured to allow the necessary access. For more information about
the ports used by Tableau, see Internet Access Requirements.
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Login-based licence management with Tableau Cloud

1. You install Tableau Desktop or Tableau Prep Builder and select Activate with your
credentials. You sign in to your Tableau Cloud site.
2. Tableau Cloud verifies that you are a Creator. If not, you get an error. If yes, Tableau
Cloud communicates with the ATR service.
3. The ATR service returns an ATR lease to Tableau Cloud.
4. Tableau Cloud provides an ATR lease to Tableau Desktop or Tableau Prep Builder
to finalise activation.

Use login-based licence management
To use login-based licence management, you need to install Tableau Desktop and use it
with Tableau Cloud.

Step 1: Enable login-based licence management
Login-based licence management is enabled by default for Tableau Cloud and Tableau
Desktop starting with version 2020.1. To use login-based licence management, you need to
install Tableau Desktop and use it with Tableau Cloud. If you're using Tableau Desktop version 2020.1 and later, skip to Step 3: Activate Tableau Desktop.
Versions before 2021.1 do not support login-based licence management.
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Change login-based licence management settings on
Tableau Desktop or Tableau Prep Builder at install
To change login-based licence management settings at the command line, you can run the
installer .exe file from your computer's command line as an administrator. If you need to
extract the .msi files, follow the instructions to Extract and run the Windows (MSI) installer.
To use a duration length other than the default of 14 days/1209600 seconds, include the
ATRREQUESTEDDURATIONSECONDS switch. For example:
tableauDesktop-64bit-2020-1-0.exe /quiet /norestart ACCEPTEULA=1
ATRREQUESTEDDURATIONSECONDS=43200
You must run the command from the directory where the .exe file is located or specify a full
path to the location of the .exe file on the computer. Do not run the setup program from a
shared directory on your network. Instead, download the .exe file to a directory on the computer where you're installing.
The following example shows the Windows installer command that disables login-based
licence management:
tableauDesktop-64bit-2020-1-0.exe /quiet /norestart ACCEPTEULA=1
LBLM=disabled
or
tableauPrepBuilder-64bit-2020-1-0.exe /quiet /norestart
ACCEPTEULA=1 LBLM=disabled
To set the default URL for the Tableau Server you want users to use for activation when
using login-based licence management, add the ACTIVATIONSERVER or
WorkGroupServer option.
To update the exe:
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tableauDesktop-64bit-2021-4-0.exe /quiet /norestart
ACCEPTEULA=1 ACTIVATIONSERVER=http://<tableau_online_site_url>
To update the registry:
reg.exe add HKEY_LOCAL_MACHINE\SOFTWARE\Tableau\Tableau
2021.4\Settings /f /v WorkGroupServer /d https://<tableau_
server_url>

Note: The ACTIVATIONSERVER option is only intended for first time activation. If you
have previously signed in to this version of Tableau, you use the WorkGroupServer
(Windows) or WorkgroupServer (macOS) option. For example, if you are using
Tableau Desktop version 2021.1 on Windows and have previously signed in successfully, you would use the WorkGroupServer option to specify an activation
server. On Tableau Desktop on macOS, you would use the WorkgroupServer
option. On macOS, this option is case sensitive and uses a lowercase "g".

Change login-based licence management settings on
Tableau Desktop by editing the registry
If Tableau Desktop is already installed, you can change login-based licence management
settings by editing the Windows registry.
To turn off login-based licence management:
reg.exe add HKEY_LOCAL_MACHINE\SOFTWARE\Tableau\ATR /f /v LBLM
/d disabled
To make login-based licence management the only login option:
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reg.exe add HKEY_LOCAL_MACHINE\SOFTWARE\Tableau\ATR /f /v LBLM
/d required
Or, you can enable, disable or require login-based licence management by editing the
registry directly:
1. As an administrator on the computer running Tableau Desktop, make a backup of the
registry file before you make any changes to it.
2. Edit the registry, and in HKEY_LOCAL_MACHINE\SOFTWARE\Tableau, find the
hive named ATR and modify the LBLM value to reflect the desired setting:
a. Name: LBLM.
b. Data: enabled, disabled or required.
3. Restart Tableau so the changes take effect.

Change login-based licence management settings on
Tableau Desktop on macOS
To change login-based licence management settings on macOS, run the following commands in a terminal window to update the preferences file, and then install or restart Tableau
Desktop.
To turn off login-based licence management:
sudo defaults write /Library/Preferences/com.tableau.ATR LBLM
"disabled"
To make login-based licence management the only login option:
sudo defaults write /Library/Preferences/com.tableau.ATR LBLM
"required"
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To set the default URL for the Tableau Server you want the user to use for activation when
using login-based licence management on macOS.
First-time activation:
sudo defaults write /Library/Preferences/com.tableau.ATR LBLM
"required"
Subsequent activations:
sudo defaults write /Library/Preferences/com.tableau.Tableau<version> Settings.WorkgroupServer "https://<tableau_server_
url>"

Note: On Tableau Desktop on macOS, you would use the WorkgroupServer option.
On macOS, this option is case sensitive and uses a lowercase "g".

Login-based licence management settings

You use the following settings to change login-based licence management, set the ATR duration, and set the activation server URL.
Setting

Value

Description

LBLM

enabled, dis-

Set to enabled (the default),

abled or

the licensing screens will present

required

the two options for activation
(product key, or credentials).
Set to disabled, login-based
licence management will not
appear on the licensing screens.
Set to required, login-based
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licence management is the only
way to activate the Tableau
Desktop (when the licensing
screen appears, it will offer only
the credentials option for activation).

Note: When LBLM is set to
enabled or required, reporting is also enabled.

ATRREQUESTEDDURATIONSECO- 1209600

Sets the authorisation to run

NDS

(ATR) duration (in seconds),
which is the length of time that an
instance of Tableau Desktop and
Tableau Prep Builder is authorised to run. The default is
1209600 seconds (14 days). Do
not use commas as separators in
the value.

ACTIVATIONSERVER

http://<t-

For first-time activation, sets the

ableau_

default URL for the Tableau

online_site_
url>

Cloud site you want users to use
for activation.

WorkGroupServer (Windows)

http://<t-

For updates to the Windows

WorkgroupServer (macOS)

ableau_

registry or macOS plist, sets the

server_url>

default URL for the Tableau
Server you want users to use for
activation.
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Note: On Tableau Desktop
on macOS, you would use
the WorkgroupServer
option. On macOS, this
option is case sensitive and
uses a lowercase "g".

REPORTINGFREQUENCYSECOND- 3600

Sets the default (in seconds) for

S

how often the login-based
licence management report is
sent to Tableau Server or
Tableau Cloud. The minimum
setting is 60 seconds, and the
default is 3600 seconds (one
hour). Change this setting to
reduce the load on Tableau
Server or to reduce network
traffic. No matter what the authorisation-to-run (ATR) lease duration is set to,

REPORTINGFREQUENCYSECONDS sets the time interval that
the Tableau Desktop or Tableau
Prep Builder client report loginbased licence management activations back to Tableau Server or
Tableau Cloud.

Additional configuration for virtual deployments
Tableau Desktop and Tableau Prep Builder periodically contact Tableau Cloud or Tableau
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Server to verify that Tableau is authorised to run, based on its licence. Tableau Cloud or
Tableau Server then contacts the ATR service to verify the licence and the length of the
authorisation window.
When configuring a virtual (non-persistent) deployment of Tableau Desktop or Tableau Prep
Builder, the duration time should be set to one of the lower values such as 4 or 8 hours in
order to avoid an over-use activation error message. After the virtual machine (VM) is
returned, the ATR service will handle the activation monitoring.
The following flags should be used on a source image prior to publishing Tableau Desktop to
end users. Each end user will be activating the software by logging into Tableau Server or
Tableau Cloud with each new VM delivered. No product keys need to be entered if the end
user is a Tableau Creator on Tableau Server or Tableau Cloud.
If you are using login-based licence management for Tableau Desktop or Tableau Prep
Builder on a VM, you may get an error message that your licence information has changed
whenever you launch a new VM for Tableau Desktop or Tableau Prep Builder. This error
forces a restart, which then asks you to register Tableau Desktop again. This error occurs
because the ATR service sends a new token that doesn’t match the licence cache.
To prevent this from occurring, you can use the SYNCHRONOUSLICENSECHECK and
SILENTLYREGISTERUSER options with the Windows installer. For example:
tableau-setup-std-tableau-2020 SYNCHRONOUSLICENSECHECK="true"
SILENTLYREGISTERUSER="true" ATRREQUESTEDDURATIONSECONDS=14400
or
tableauDesktop-64bit-2020-1-0.exe /quiet /norestart ACCEPTEULA=1
ATRREQUESTEDDURATIONSECONDS=14400 ACTIVATIONSERVERR=http://<tableau_online_site_url> SYNCHRONOUSLICENSECHECKK="true" SILENTYLYREGISTERUSER="true"
If Tableau Prep Builder and Tableau Desktop are being delivered on one Virtual Desktop,
ATRREQUESTEDDURATIONSECONDS only needs to be set during Tableau Desktop
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installation. However, if you plan to install Tableau Prep Builder as a stand-alone, you'll
need to set ATRREQUESTEDDURATIONSECONDS during Tableau Prep Builder installation.
Or, you can edit the following registry keys on the source image:
Reg key path: HKLM\SOFTWARE\Tableau\<Tableau version>\Settings\
Reg key (String value, need to set to true to make that feature
enabled)
SynchronousLicenseCheck
SilentlyRegisterUser

(Optional) Step 2: Change the authorisation to run (ATR) duration
The login-based licence management default settings for the authorisation to run (ATR) duration are appropriate for most environments, but you can change these default settings if
needed. Login-based licence management uses the default authorisation to run (ATR) duration of 1209600 seconds (14 days), which is the length of time that an instance of Tableau
Desktop and Tableau Prep Builder is authorised to run. This means that after the initial
authorisation, you could use Tableau without any network connection for 14 days before the
activation expired.
The default duration value for login-based licence management is not appropriate for delivering a non-persistent VM delivery solution to end users. The ATR duration should be
lowered to 4 or 12 hours depending on VM use. When a new VM is delivered to an end
user, a new authority to run token will be created. When the VM is returned, this token is
also returned and is able to be used on the new VM authorisation to run request.
Note: Login-based licence management uses the following hierarchy when determining
ATR duration.
1. ATR Service – Establishes the minimum (4 hours/14400 seconds) and maximum
(90 days/7776000 seconds) ATR durations applicable to all users/installations. It
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specifies the default ATR duration (14 days/1209600 seconds) if nothing is specified
by Tableau Server or Tableau Desktop.

2. Tableau Desktop – Can optionally specify the ATR duration
(ATRREQUESTEDDURATIONSECONDS) for the computer on which it is installed. If
necessary, you can change the default ATR duration (14 days/1209600 seconds) to a
setting within the ATR Service minimum (4 hours/14400 seconds) and maximum (90
days/7776000 seconds). This local ATR duration overrides any durations set by the
ATR Service or Tableau Server. However, this default ATR duration cannot be more
than the maximum ATR duration set on Tableau Server.

Change the ATR duration on Tableau Desktop by editing the
registry
To use a duration length other than the default of 14 days/1209600 seconds, update the
ATRRequestedDurationSeconds registry setting. For example:
1. As an administrator on the computer running Tableau Desktop, make a backup of the
registry file before you make any changes to it.
2. Edit the registry, and in HKEY_LOCAL_MACHINE\SOFTWARE\Tableau\ATR,
update the ATRRequestedDurationSeconds as follows (0 uses the default setting):

a. Name: Find the string value named ATRRequestedDurationSeconds.
b. Data: Update the number of seconds the duration should last. For example, add
43200 to set a duration of 12 hours.
3. Restart Tableau so that the changes take effect.

Change the ATR duration on Tableau Desktop on macOS
To use a duration length other than the default of 14 days/1209600 seconds, include the
ATRRequestedDurationSeconds preferences setting. For example:
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sudo defaults write /Library/Preferences/com.tableau.ATR
ATRRequestedDurationSeconds -string "43200"

Step 3: Activate Tableau Desktop
The 2020.1 and later versions of both Tableau Desktop for Windows or macOS support
login-based licence management.
1. Run Tableau Desktop setup.
2. The Activate Tableau screen will include the Activate by signing in to a server
option.
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3. Click Activate by signing in to a server and then click the Tableau Cloud link.
When prompted, enter valid credentials to sign in to a Tableau Cloud site as a user
with a Creator role subscription, and then click OK.

View login-based licence usage
You can view login-based licence usage for Tableau Cloud or Tableau Server. The report
shows users, hosts, user role, product, version, activations, Creator seats in use, Creator
seats not in use and when a Creator seat was last used. You can view data for the past 30
days up to a maximum of 183 days.
To view the Login-based licence management Licence Usage administrative view:
1. In Tableau Cloud or Tableau Server, in the navigation pane, click Site Status.

2. On the Site Status page, click Login-based Licence Usage.
3. Optional. On the report screen, you can change the time window to show when seats
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were last used, filter on actions, filter on user name and sort by columns.

Troubleshooting
You may encounter one of the following error messages while using login-based licence
management. Use the information below to resolve the issue.
If login-based licence management is available as an activation option on Tableau Desktop,
but not enabled on your Tableau Cloud site, the following error message may be displayed:
Login-based licence management is not enabled on the server you connected to. Select a
different server to connect to, use a product key to activate your licence or start a trial to
begin working immediately.
Contact your administrator and/or Tableau account manager to ensure that your Tableau
Cloud site is enabled for login-based licence management.
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Login-based licence management is not enabled on Tableau Desktop
If login-based licence management is not enabled on Tableau Desktop, you will not have the
option to activate Tableau using your credentials. Prior to version 2020.1, the ability to use
login-based licence management on Tableau Desktop is not turned on as a default. Check
the Tableau Desktop version to ensure the correct version is being used.
If the login-based licence management option has been turned off during installation or with
an update, see Step 1: Enable login-based licence management.

Product key expiry date doesn't change after purchasing a year subscription
After purchasing a renewal of Tableau Cloud, it might appear that your Tableau Desktop
licence is going to expire. This is not the case. In Manage Product Keys, the expiration date
for new Tableau Cloud subscriptions is not updated until two weeks before the previous Site
expiration date.

You do not have a Creator licence
When attempting to activate from Tableau Desktop, the following error message may be displayed:
You do not have a Creator licence. Contact your administrator to obtain one.
This error is displayed if you have not been assigned a Creator role. If you belong to multiple
sites on Tableau Cloud or Tableau Server, you need to sign in to the site where you have the
Creator role when using login-based licence management. Otherwise you'll get this error.
To verify that the product key you have activated on the server includes Creator licences,
open the TSM web UI and click Configuration, and then click Licensing.
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You have activated the maximum number of computers
When attempting to activate from Tableau Desktop, the following error message may be displayed:
You have activated Tableau the maximum number of times allowed under your account.
You must wait for the licence activation on another computer to expire before you can activate Tableau again.
This error is displayed when you activated Tableau from multiple computers with the same
Creator user credentials and exceeded the maximum number of activations. You must wait
until the authorisation-to-run (ATR) token expires on one of the existing computers before
attempting to activate a new computer. If you are using non-persistent virtual machines
(VMs), you can shorten the ATR duration to prevent this error from occurring again.
To shorten the ATR token duration for maximum activation

If you encounter this maximum use error when using a non-persistent virtual deployment, it
is possible to shorten the ATR duration to 4 hours (14400) seconds to avoid the error in the
future.
The following steps shorten the lease on a computer previously activated with login-based
licence management that will no longer be used, in order to free up a seat to be activated on
a new computer:
1. Open a Command Prompt as an administrator on a Tableau Desktop computer that
will no longer be used.
2. Navigate to the Tableau binaries (\bin) directory, using the following command.
Windows: cd Program Files\Tableau\Tableau <version>\bin
Mac: cd /Applications/Tableau\ Desktop\ <version>.app/Contents/MacOS
3. Run the following command to set the duration to 4 hours, in seconds (e.g. 14400).
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Windows: atrdiag.exe -setDuration 14400
Mac: sudo ./atrdiag -setDuration 14400
4. Delete the previous ATR token using the following command:
Windows: atrdiag.exe -deleteAllATRs
Mac: ./atrdiag -deleteAllATRs
5. Next, overwrite the existing ATR token. Open Tableau Desktop. Tableau displays the
“Licence has Changed” message. Click Exit to automatically close and reopen
Tableau Desktop.
6. In the registration dialog box, click Activate, and then reactivate Tableau Desktop
through Tableau Server using login-based licence management, which will overwrite
the existing token.
7. Close Tableau Desktop and wait for the ATR duration to elapse (e.g. 4 hours) so that
the ATR token expires and frees-up a user seat. Do not open Tableau Desktop before
the ATR duration has elapsed. Check to make sure the ATR duration has elapsed.
The ATR token TTL End should show a date and time in the future (e.g. 4 hours from
now).
Windows: atrdiag.exe
Mac: ./atrdiag
8. After the ATR token expires and you can successfully sign in to Tableau Server on a
new computer.
To return your computer to an unlicensed state

1. Open a Command Prompt as an administrator.
2. Navigate to the Tableau binaries (\bin) directory, using the following command:
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cd Program Files\Tableau\Tableau <version>\bin
3. Run the following command:
Windows: atrdiag.exe –deleteAllATRs
Mac: ./atrdiag.exe –deleteAllATRs

Note: This removes only the ATR token from the computer. It does not free-up any of
the user seats. The user seat is only freed-up after the deleted ATR token expires.

Your Tableau credentials are invalid
When attempting to activate from Tableau Desktop, the following error message may be displayed:
Your Tableau credentials are invalid. Contact your administrator to reset your account.
This error is displayed when your Tableau licence is not recognised. Contact your administrator.

Your computer’s clock is not synchronised to the current time
When attempting to activate from Tableau Desktop, the following error message may be displayed:
Your computer’s clock is not synchronised to the current time. Synchronise your computer’s
clock to the current time and then try to activate Tableau.
This error is displayed when your computer's clock is not synchronised with the current
time. Synchronise your computer’s clock with a time server on the internet or enable automatic time synchronisation.
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Create Workbooks with Salesforce Data
You can quickly author and analyse Salesforce data in Tableau. Sign in to Salesforce directly
from your Tableau Cloud site and select the clouds you want to explore. Tableau integrates
your Salesforce data to create a project with ready-to-use starter workbooks and data
sources – choose to explore them on your own or share them with other users on your site.

What’s included with the Salesforce project
The Salesforce project includes starter workbooks and data sources, all built using your
Salesforce data. Use the starter workbooks to quickly answer questions about your Nonprofit, Sales and Service Clouds, or connect to Salesforce Admin Insights to see usage
trends in your organisation.

Nonprofit Cloud
Connect to Nonprofit Cloud to analyse your organisation's programmes and drive impact.
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Includes starter workbooks for: Nonprofit Case Management - Service Delivery and Staff
Capacity, Nonprofit Case Management Assessments, Nonprofit Case Management Enrollment, Nonprofit Case Management Intake, and Nonprofit Fundraising Overview.

Sales Cloud
Connect to Sales Cloud to visualise your sales funnel and better support your sales team.
Includes starter workbooks for: Account Tracking, Open Pipeline, Opportunity Overview,
Opportunity Tracking, Quarterly Sales Results, Top Accounts and Marketing Leads.

Salesforce Admin Insights
Connect to Salesforce Admin Insights to visualise usage trends and engagement with your
organisation.
Includes starter workbooks for: Salesforce Admin Insights.

Service Cloud
Connect to Service Cloud to analyse and explore your critical service metrics and cases.
Includes starter workbooks for: Service Overview and Case Tracking.

Connect to Salesforce
Connecting to your Salesforce data is simple. Once you sign in and select the Clouds to
explore, Tableau creates a new project and publishes workbooks and data sources on your
site. When the publishing process is complete, you can edit the resulting workbooks just like
any other, quickly customising them for your needs.
To connect to Salesforce, you must be an administrator with the Site Administrator Creator
site role and have API access to your Salesforce instance. API access requires Salesforce
Professional Edition or higher. For more information, see Set Users’ Site Roles.
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1. Sign in to your Tableau Cloud site as an administrator, and select Settings > Integrations.
2. On the Integrations tab, click Connect to Salesforce Data and complete prompts to
authorise access to Salesforce.
3. In the Connect to Salesforce dialog window, select the Clouds you want to explore.
4. Specify a name and initial permissions for the project. You can set permissions for
Only administrators or choose to Inherit permissions from the Default project.
For more information, see Permissions.
5. Review your selections and click Publish.
At this point, you’ve created a new project and published starter workbooks. While Tableau
prepares extracts of your Salesforce data, sample data appears in the workbooks so you can
explore the layout. You’ll receive an email when your Salesforce data is refreshed and added
to the workbooks.

Note: Depending on the size of your data source, it may take some time to create
extracts. You can view the status of your Salesforce extracts on the Background Tasks
for Extracts administrative view.

To see your project and other content you have access to, from the navigation menu, click
Explore.
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Use existing Salesforce credentials
If you've already connected to Salesforce, you can use existing credentials to create additional starter workbooks.
From the Integrations tab, click Connect to Salesforce Data, and select the Salesforce
credentials you want to use from the drop-down menu. Tableau creates a new project every
time workbooks publish on your site.

Note: Workbooks will publish on the site with your Salesforce credentials embedded.
All users with permission to view the workbook will be able to see data based on these
credentials.
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Schedule refreshes to keep data fresh
To make sure you see the latest information when viewing workbooks or connecting to data
sources, you’ll need to schedule refreshes. By default, the Salesforce data extracts created
when publishing starter workbooks will not refresh automatically. For more information about
refresh schedules, see Schedule Refreshes on Tableau Cloud.
Follow the steps below to schedule extract refreshes:
1. In Tableau Cloud, navigate to the project containing your Salesforce content.
2. Select the data source you want to refresh, click Actions and choose Refresh
Extracts...
3. In the Create Extract Refresh dialog window, select the Refresh Type and Refresh
Frequency, and click Create.

Subscriptions
You’re automatically subscribed to Salesforce workbooks and will receive notification emails
every time the data is refreshed. If you want to update your subscription preferences, see
Create a Subscription to a View or Workbook.
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Change permissions for projects, workbooks and data
sources
After connecting to your Salesforce data, you can choose how users interact with the Salesforce project, workbooks and data sources published on your site. Permissions are a great
way to make sure the right users have access to the starter content and enable them to
build workbooks of their own. For more information about configuring permissions on your
site, see Permissions.

Create workbooks in Tableau Cloud
With your Salesforce data sources, you can create new workbooks through web authoring
in Tableau Cloud or use Ask Data to query and create visualisations automatically.
l

Web Authoring: Connect to your data directly in Tableau Cloud to explore and create custom data visualisations of your own. For more information, see Creators: Get
Started with Web Authoring in Tableau Desktop help.

l

Ask Data: Interact with your data by simply typing a question and see automatic data
visualisations in response. For more information, see Automatically Build Views with
Ask Data in Tableau Desktop help.

Fix greyed-out views by replacing field names
If your organisation has customised the data structure of your Salesforce data, you may
need to match those changes in the starter workbooks after your data loads in them. For
example, if your organisation has renamed the Salesforce “Account” field to “Customer”,
you'll need to make a corresponding change in workbooks to avoid greyed-out views like
this:
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To fix greyed-out views:
1. Above the dashboard, click Edit.
2. Navigate directly to the greyed-out sheet.
3. In the Data pane at the left, look for red exclamation marks (!) next to field names,
which indicate that your organisation uses different names.
4. Right-click each of those fields, and choose Replace References. Then select the
correct field name from the list.
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About Tableau Help
Addressing implicit bias in technical language
In an effort to align with one of our core company values, equality, we have changed terminology to be more inclusive where possible. Because changing terms in certain places
can cause a breaking change, we maintain existing terminology in the following places:
l
l
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Tableau APIs: methods, parameters and variables
Tableau CLIs: commands and options
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l

Tableau Resource Monitoring Tool installers, installation directories and terms in con-

l

figuration files
Third-party systems documentation

For more information about our ongoing effort to address implicit bias, see Salesforce
Updates Technical Language in Ongoing Effort to Address Implicit Bias on the Salesforce
website.
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Site Administrator Role and Tasks
This topic describes the typical role of the Tableau Cloud site administrator and how it differs from the related data manager role. It then lists the core tasks that the site administrator
completes to set up your Tableau Cloud site. Additional topics in this section provide more
information about each of the steps.

How we define the site administrator role
We define the site administrator as the person who is in charge of creating and maintaining
the framework that enables Tableau Desktop users in your organisation to publish, share,
manage, and connect to data sources and workbooks. For example, a site manager works
with site users and their permissions, in contrast to working directly with content that is published to the site.
The Tableau Cloud site administrator is typically part of the IT team at your organisation. If
your organisation doesn’t have a formal IT team, the site administrator might be a savvy
Tableau Desktop user who takes on this role (the accidental admin, so to speak).

Tasks that are typically outside the site administrator’s realm
In this documentation, we make a distinction between the roles of site administrator and
data manager, which is the role for the person who creates and publishes data sources to
Tableau Cloud. Even so, in your organisation, the same person might cover both roles. In
practice, you’ll divide these responsibilities in the way that works best in your environment.
To learn more about the data manager’s realm, see Publish Data Sources and Workbooks.

Steps for setting up your site
The table below shows a loose sequence of steps for setting up a site. You can complete
the steps in any order that makes sense for you. At the bottom of this topic you’ll find a list of
links to more resources for each of the steps.
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Before you configure the site, we recommend getting acquainted with the site authentication
options, users’ site roles, projects, and permissions. Create and document a plan for your
projects, groups, and overall permissions strategy. Setting up a test project to experiment
with different settings is a good way to iron out these issues. You can change many site settings after your users are working with the site, but try to go in with the intention of minimising
post-production changes.
Upload your

This simple first step helps you get familiar with the envir-

logo

onment while you incorporate your organisation's branding into
your site. Sign in, go to the Settings page, and upload your
logo where indicated.

Configure

If your organisation uses single sign-on, you can configure your

site access

site to use Google or SAML authentication. Otherwise, you can
use the default Tableau ID authentication, where each user
signs in using an email address and password that is unique to
Tableau Cloud.
In addition to the authentication type, you can determine
whether to allow users to sign in directly from Tableau clients
after signing in the first time. This is enabled by default.

Create pro-

Projects help you manage users’ access (permissions) to data

jects

sources and workbooks that are published to your site. You can
set default groups and permissions for all content on the
Default project, lock the project, and then use it as a template
for additional projects you create.
Projects can also serve as staging environments.

Set up the

In Tableau, permissions work with site roles to make up a

permissions

user’s access to the site and its content.

structure
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Upload your

This simple first step helps you get familiar with the envir-

logo

onment while you incorporate your organisation's branding into
your site. Sign in, go to the Settings page, and upload your
logo where indicated.

Add users

Each user who accesses Tableau Cloud must sign in.
Determine the users you want to be able to sign in to the site. If
you enabled Google or SAML authentication, determine which
of those users will sign in with their single sign-on credentials,
and which will use TableauID credentials.
Add or import multiple users at a time based on their authentication type.

Get your

We recommend that you designate a Tableau Desktop user

data to

who will publish vetted data sources to the site (that is, who will

Tableau

serve in the data manager role mentioned earlier). These will

Cloud

be the shared data sources that other Tableau users can connect to.
As the site administrator, you can centrally manage data
source permissions. Other attributes that either you or the data
manager can maintain centrally are connection information (credentials, access tokens) and refresh schedules for cloud data
sources. For more information, see Keep Data Fresh.
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Analyse site

You can monitor usage of published data sources and work-

usage and

books, the success of extract refresh tasks, user activity, and so

performance

on.
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Navigate the Admin Areas of the Tableau Web
Environment
As an administrator on Tableau Server or Tableau Cloud, you can access admin settings
that aren’t available to other users to configure sites, users and projects and to do other content-related tasks.

Access based on site role and number of sites
The menus you get when you sign in to Tableau Server or Tableau Cloud depend on the following conditions:
l

Whether you’re a site or server administrator.
Site administrator access is available on Tableau Cloud and Tableau Server. Server
administrator access is only on Tableau Server.

l

Whether you have access to only one site or to multiple sites.
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Server administrator
On a single-site server, the site selector
does not appear, and all other menus are
the same.

In a multi-site environment, menus along
the left enable you to modify a specific site
or all sites, and to configure users, groups,
schedules, tasks and server settings.
To access server administrator settings
that affect all sites, open the site menu by
clicking the arrow next to the current site
name, and then select Manage all sites.
The Content and Group tabs go away,
and the site menu text changes to All
Sites to let you know you are managing
server-wide settings, and options like
Server Status reflect the server-wide
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view.
To return to the site administration menus,
select All Sites, and the select the site you
want to manage.
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Site administrator
If you are a site administrator for Tableau
Cloud or Tableau Server, and you have
access to multiple sites, you’ll get menus
for selecting which site to manage, for managing that site’s content, users, groups,
schedules and tasks and for monitoring its
status.
The site selector displays the name of the
current site. To go to another site, select
the site menu, and then select the site
name.
If you have access to only one site, the site
selector does not appear, but all other
menus are the same.

Server administrator tasks
Server administrators (available with Tableau Server Enterprise only) can do the following:
l

Monitor server status and activity.

l

Generate log files.

l

Add sites and edit site settings. Only server administrators can add sites to the server.

l

Add users to the server, and assign users to sites.

l

Add and manage site groups.

To manage settings only for a specific site, you must first navigate to the site. Within each
site, you can do the following:
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l

Administer content: Create projects, move content from one project to another, assign
permissions, change ownership of a content resource and so on.

l

Manage schedules for extract refreshes and subscriptions.

l

Monitor site activity and record workbook performance metrics.

l

Manage storage space limits for content published by users.

l

Allow web authoring.

l

Enable revision history.

l

Allow site administrators to add and remove users.

l

Set the maximum number of licences that site can consume for each licence type
(Creator, Explorer, Viewer).

l

Allow users to subscribe to workbooks and views, and allow content owners to subscribe others to workbooks and views.

l

Enable offline snapshots for favourites (iOS only).

Site administrator tasks
A site administrator on Tableau Cloud or Tableau Server can do the following tasks:
l

Administer content: Create projects, move content from one project to another, assign
permissions, change ownership of a content resource and so on.

l

View, manage, and manually run schedules for extract refreshes and subscriptions.

l

Add and manage site users.

l

Add and manage site groups.

l

Monitor site activity.
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Customise the Site and Content Settings
Site Settings Reference
As a Tableau administrator, you can customise a site for your organisation using the settings below. The settings available to you depend on your site configuration and whether
you use Tableau Cloud or Tableau Server. To view and edit site settings, you must be a Site
Administrator on Tableau Cloud or Server Administrator on Tableau Server.

Note: To find a specific setting below, press Ctrl+F (Windows) or Command+F
(macOS). Tableau Cloud and Tableau Server present these settings in a different
order.

Accessing site settings
l

(Tableau Cloud) From the Home page, expand the side panel and click Settings at
bottom.
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l

(Tableau Server) If you're editing an existing site, select it on the Sites page, and then
select Edit Settings. Or, in a single-site deployment, click Settings at the bottom of
the side pane.

General section
Setting

Description

Site Name and ID

Specifies the site name seen in the user interface and the ID seen

(Tableau Server

in the site URL. (If you are editing the Default site, you cannot

Administrators

change the ID.)

only)

You can't change the “#/site” portion of the URL (for example,
http://localhost/#/site/sales). In multi-site server environments,
these segments appear in the URL for sites other than the Default
site.
Storage (Tableau

Select either Server Limit or GB, and for the latter, enter the num-

Server Admin-

ber of gigabytes you want as a limit for storage space for published

istrators only)

workbooks, extracts and other data sources.

If you set a server limit and the site exceeds it, publishers will be pre-
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vented from uploading new content until the site is under the limit
again. Server administrators can track where the site is relative to
its limit using the Max Storage and Storage Used columns on the
Sites page.
Revision History

Specifies the number of previous versions of workbooks, flows and

(Tableau Server

data sources that are stored on the server.

Administrators
only)
Tableau Prep Con-

Controls whether users with appropriate permissions can schedule

ductor

and monitor flows. Tableau Prep Conductor is part of Data Management. For more information, see Tableau Prep Conductor.

Web Authoring

Controls whether browser-based authoring is enabled for the site.
When web authoring for workbooks is disabled, users can't create
or edit published workbooks from the server web environment but
instead must use Tableau Desktop to republish the workbook.
When web authoring for flows is disabled, users can't create or edit
published flows from the server web environment but instead must
use Tableau Prep Builder to re-publish the flow.

For more information, see Set a Site’s Web Authoring Access and
Functions in Tableau Cloud Help.
Managing Users

Determines whether only server administrators can add and

(Tableau Server

remove users and change their site roles, or whether site admin-

Administrators

istrators can too.

only)

If you allow site administrators to manage users, specify how many
users they can add to the site by selecting one of the following:
l

Server Limit adds the number of available server seat
licences. For a server with core-based licensing, there is no

l

limit.
Site Limit lets site administrators add users up to a limit you
specify.
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l

Site Role Limit lets site administrators add users of each site
role up to the licence limit you specify for the site.

For more information, see View Server Licences.
Guest Access

Lets people who lack a Tableau Server account see views that
have guest access permissions.

Note: If you use Tableau Server, your administrator can disable Guest Access.

Tableau Cata-

Turns off Catalog capabilities when Tableau Server or a Tableau

logue

Cloud site is licensed with Data Management. For more information, see Disable Catalogue.

Workbook Per-

Pre-computes recently viewed workbooks with scheduled

formance after a

refreshes to open them faster. For more information, see Con-

Scheduled

figure Workbook Performance after a Scheduled Refresh.

Refresh (Tableau
Server Administrators only)
Workbook Per-

Lets site users collect metrics on how workbooks perform, such as

formance Metrics

how quickly they load To initiate recording, users must add a para-

(Tableau Server

meter to the workbook's URL. For more information, see Create a

Administrators

Performance Recording.

only)
Managed Key-

Lets site administrators manage saved credential keychains for

chain Clean-Up

OAuth connections on the site. For more information, see OAuth

(Tableau Server

Connections.

Administrators
only)
Automatically Sus-
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pend Extract

refresh tasks for inactive workbooks. This feature applies only to

Refresh Tasks

refresh schedules that run weekly or more often. For more information, see Automatically Suspend Extract Refreshes for Inactive

Workbooks in Tableau Cloud Help.
Linked Tasks

Lets Server administrators enable users to schedule flow tasks to
run one after the other. They can also enable users to trigger the

(Tableau Server

scheduled flow tasks to run using Run Now.

and Site Administrators only)

This setting can be applied at the server level to include all sites on
Tableau Server. The setting can be disabled at the site level to
include only specific sites.
If the setting is turned off after linked tasks are scheduled, any
tasks that are running will complete and the scheduled linked tasks
are hidden and no longer show on the Scheduled Tasks tab.
For more information, see Schedule Linked Tasks.

Email Settings

Specifies the From address and message footer seen in automatic

(Tableau Server

emails for alerts and subscriptions.

Administrators
only)
Site Invite Noti-

For sites with single-sign-on authentication, sends an invite email

fication (Tableau

when new users are added to the site.

Cloud only)
Site Logo

Specifies the image that appears with the site name.

Start Page

Controls which site page appears when users sign in. By default,
the Home page appears, but you can instead open All Projects, All
Workbooks, or other pages. For more information, see Set the

Default Start Page in Tableau Cloud Help.
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Note: If you use Tableau Server, your administrator can override this site setting.

User Visibility

Controls what user and group names are visible to other users. For
more information, see Manage User Visibility in Tableau Cloud
Help.

Availability of Ask

Controls whether Ask Data lenses are enabled or disabled for data

Data

sources. Ask Data lets users query data using conversational language and automatically see visualisations. For more information,
see Automatically Build Views with Ask Data in Tableau user Help.

Availability of

Controls whether site users with the appropriate permissions can

Explain Data

run Explain Data and authors can access Explain Data Settings.
For more information, see Control Access to Explain Data. To
learn more about Explain Data, see Discover Insights Faster with

Explain Data.
Automatic Access

Automatically grants users certain capabilities to external assets

to Metadata about

using derived permissions. For more information, see Turn off

Databases and

derived permissions in Tableau Cloud Help.

Tables
Sensitive Lineage

Specifies whether sensitive lineage data should be obfuscated or

Data

filtered when users don’t have the appropriate permissions to
related metadata. For more information, see Sensitive lineage

data.
Cross-Database

Determines where the join process happens when joining data

Joins

from multiple sources. For more information, see Combine Tables

from Different Databases in Tableau user Help.
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Extract Encryption

Lets you encrypt .hyper extracts while they are stored on Tableau

at Rest (Tableau

Server. Server administrators can enforce encryption of all extracts

Server Admin-

on their site or allow users to encrypt all extracts associated with
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istrators only)

particular published workbooks or data sources. For more information, see Extract Encryption at Rest.

Tableau Mobile -

Controls whether offline previews are generated for display when

Enable offline pre-

users access the site on Tableau Mobile. For more information,

views

see Manage Tableau Mobile Data on Devices in the Tableau
Mobile Deployment Guide.

Tableau Mobile -

Requires a biometric method or device passcode for users to open

Enable app lock

the site on Tableau Mobile. For more information, see Enable App

(Appears under

Lock for Added Security in the Tableau Mobile Deployment Guide.

Authentication tab
for Tableau Cloud)
Tableau Support

Allows Tableau Support technicians access to the site to help

Access (Tableau

troubleshoot support cases. By default, this feature is disabled. For

Cloud only)

more information, see Enable Support Access.

Sharing

Allows users to share items directly with other users. When an item
is shared, the recipients get a notification and the item is added to
their Shared with Me page. If this is not enabled, users can only
copy a link to share. For more information, see Share Web Content
in Tableau user Help.

Comments

Controls whether users can add remarks in a Comments side pane
for each view and @mention other Tableau users to notify them via
email. For more information, see Comment on Views in Tableau
user Help.

Data-Driven Alerts

Lets users automatically receive emails when data reaches key
thresholds. For more information, see Send Data-Driven Alerts in
Tableau user Help.

Subscriptions

Lets site users subscribe to views and receive regular emails of
them. On Tableau Server, these options are available only if you
first configure subscription settings.
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Data Quality Warn-

Controls whether subscriptions include relevant upstream data

ings in Sub-

quality warnings in the email. On Tableau Server, these options are

scriptions

available only if you first turn on and configure subscriptions. For
more information on data quality warnings, see Set a Data Quality

Warning.

Note: Data quality warnings are a feature of Tableau Catalog,
which is part of Data Management.

Tagging

Specifies the number of tags that users can add to items. The
default limit is 50 tags, and the maximum is 200. For more information, see Use Tags.

Recommendations

Controls whether recommendations show on the site and whether

for Views

the names of users who have looked at recommended items show
on recommendation tooltips.

Note: If you use Tableau Server, your administrator can disable Recommendations.

Request Access

Lets users send access requests to content or project owners. For
more information, see Let Site Users Request Access to Content
in Tableau Cloud Help.

Metrics Content

Controls whether metrics are available on the site. When you turn

Type

metrics on, users can create metrics from views and metrics
appear as a content type. When turned off, metrics won't appear on
the site or continue to sync. If you turn on metrics again, pre-existing metrics will reappear and resume refreshing. For more information, see "Set Up for Metrics" in Tableau Cloud Help or Tableau

Server Help.
Web Page Objects
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Controls whether these Web Page and Image objects can display
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and Web Images

target URLs. For more information, see Security for Web Page

objects in Tableau user Help.
Personal Space

Allows Creator and Explorer site users to create and save content
to a private Personal Space. When Personal Space is turned on,
you can set user storage limits. For more information, see Create

and Edit Private Content in Personal Space.
Collections

Controls whether collections are available on the site. When you
turn on collections, users can create collections to organise content
and browse collections made available by other users. For more
information, see Organise Items in a Collection.

Site Time Zone for

The default time zone for extract-based data sources in a site is

Extracts

Coordinated Universal Time (UTC). Site administrators can set a
different time zone. For more information, see Set the Site Time

Zone for Extracts in Tableau Server Help or Set the Site Time Zone
for Extracts in Tableau Cloud Help.
Extract Quota Limit

Sends email alerts to all site administrators when extract refresh

Notifications

jobs are canceled because of extract job capacity issues.

Flow Parameters

Enables users to schedule and run flows that include parameters.

(Tableau Server

Administrators can also enable flow parameters to accept any

and Site Admin-

value. If this option is enabled, any flow user can enter any value in

istrators only)

a parameter, potentially exposing data that the user should not
have access to.
Parameters can be entered in an input step for file name and path,
table name or when using custom SQL queries, in an output step
for file name and path and table name, and in any step type for filters or calculated values.
Flow parameter settings can be applied at the server level to
include all sites on Tableau Server. The settings can be disabled at
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the site level to include only specific sites.
For more information about using parameters, see Create and Use
Parameters in Flows in the Tableau Prep help.
Run Now

Controls who can run jobs manually using the Run Now option from
the web, Rest API and Tabcmd. By default, this option is selected to
allow users to run jobs manually. Untick the box if only administrators should be allowed to run jobs manually.

Note: If you use Tableau Server, your administrator can disable this site setting.

Manage Noti-

Controls how site users can receive notifications for events such as

fications

extract jobs, flow runs or when another user shares content with
them or mentions them in a comment. Notifications can be seen in
their Tableau site via the notification centre, sent by email or sent to
a Slack workspace. When a notification is enabled, users can configure their notification preferences on their Account Settings page.

Note: If you use Tableau Server, your server administrator
can disable this site setting.

Flow Subscriptions

Controls whether flow owners can schedule and send emails with
flow output data to themselves and others. When you allow flow
subscriptions, you can control whether flow output data is included
in the subscription email and whether flow output files are attached
to the email. For more information, see Notify Users of Successful

Flow Runs
OAuth Clients

For a subset of connectors, you can register a custom OAuth client

Registry

to override pre-configured OAuth client settings. By registering a
custom OAuth client, you enable new and existing connections to
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use the custom OAuth client instead of the default OAuth client. For
more information, see Configure Custom OAuth.
View Acceleration

Controls whether Creator and Explorer site users can accelerate
the views in their workbooks for faster loading times. When you
allow view acceleration, you can set a maximum number of views to
be accelerated, and you can choose to automatically suspend
acceleration for views that repeatedly fail the acceleration task. For
more information, see View Acceleration.

Authentication section (Tableau Cloud)
Setting

Description

Authentication

Specifies how users can sign in to the site, and how they access it after

Types

signing in the first time. Authentication verifies a user’s identity. For
more information, see Authentication.

Default

Specifies how users can sign in to embedded views. By default,

Authentication

Tableau authentication is selected.

Type for Embedded Views
Manage Users

Lets you add new users to the site or change the site role and authentication method for existing users.

Automatic Pro-

Allows you to manage users on the site through a third-party identity

visioning and

provider (IdP). When enabled, the Base URL and Secret boxes are pop-

Group Syn-

ulated with values to use in the IdP SCIM configuration. For more

chronisation

information, see Automate User Provisioning and Group Syn-

(SCIM)

chronisation through an External Identity Provider.

Connected Cli-

Allows Tableau clients such as Tableau Mobile, Tableau Bridge and

ents

others to stay authenticated to the server after a user provides sign-in
credentials the first time. When turned off, users are required to sign in
explicitly each time they visit Tableau Cloud. For more information, see

Access Sites from Connected Clients.
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App Lock for

Requires a biometric method or device passcode for users to open this

Tableau Mobile

site on Tableau Mobile. For more information, see Enable App Lock for

Added Security in the Tableau Mobile Deployment Guide.

Bridge section (Tableau Cloud)
Setting

Description

Client Not Run- Sends email alerts to data source owners when a client appears to be
ning Noti-

disconnected from the site.

fications
Pooling

Distributes live queries and refresh jobs across all clients in Bridge
pools. For more information, see Configure and Manage the Bridge Cli-

ent Pool.
Private Net-

Add and manage domains that enable dedicated Bridge pool access to

work Allowlist

private network data on behalf of Tableau Cloud.

Extensions section
Setting

Description

Dashboard

Manage and control dashboard extensions. Dashboard extensions are

Extensions

web applications that run in custom dashboard zones and can interact with
the rest of the dashboard. For more information, see "Manage Dashboard
Extensions" in Tableau Cloud Help or Tableau Server Help.

Analytics

Enables a set of functions that your users can use to pass expressions to

Extensions

analytics extensions for integration with R and Python. For more information, see "Configure Connection with Analytics Extensions" in Tableau

Cloud Help or Tableau Server Help.
Tableau

When authoring flows on the web, enable users to apply Einstein Dis-

Prep Exten- covery-powered models to their flows to bulk score predictions for their
sion
data.
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For more information, see Configure Einstein Discovery Integration in the
Tableau Server help.

Integrations section
Setting

Description

Slack Connectivity

Displays connections between a Slack workspace and
the Tableau site. When connected, Tableau site users
can see their Tableau notifications in the connected Slack
workspace.
In Tableau Cloud, you can request that the Slack workspace administrator install the Tableau for Slack app,
then finalise the connection once installed. For more
information, see Integrate Tableau with a Slack Workspace.

Analytics Extensions

Enables a set of functions that your users can use to pass
expressions to analytics extensions for integration with R
and Python. For more information, see "Configure Connection with Analytics Extensions" in Tableau Cloud Help
or Tableau Server Help.

Publish to Salesforce

Allows site users to publish views to a Salesforce app.

(limited preview on Tableau

When a view is published to Salesforce, anyone with

Cloud)

access to the selected app can see that the content exists.
However, only those signed in with existing Tableau permissions can see the view. For more information, see Publish Views to Salesforce (Limited Preview).
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Connected Apps section
Setting

Description

Connected Apps

Create and manage Tableau connected apps or explicit
direct trust relationships or OAuth 2.0 trust between your
Tableau Cloud site and custom applications, and programmatically authorise access to the Tableau
REST API on users' behalf using JSON web tokens
(JWTs). For more information, see Use Tableau Connected Apps for Application Integration in the Tableau
Cloud Help.

Upload a Custom Logo for your Site
To incorporate brand identity into your site header, you can change the Tableau logo to your
own logo.
1. Sign in to Tableau Cloud as a site administrator.
2. On the site you want to show your logo, click Settings.
3. In the Site Logo section, do either of the following:
l

Drag the image file from your computer to the area indicated on the Settings
page.
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l

Click Select File to open a dialog box where you can browse to and select the
image file.

The preview area updates to show how your image will look in the space provided in
the header.
4. (Optional) If your logo doesn’t fit quite right in the available space, and you want to
make adjustments outside of Tableau before uploading it, you can do either of the following:
l

Click Reset to Default to show the original Tableau logo.

l

Click Revert to go back to the last saved settings. This is useful if you already
have a custom logo in place but want to try a different one.

5. Click Save.
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Image file tips
l

The recommended image size is 48 x 48 pixels, up to 160 x 160 pixels (the maximum).

l

Images that have a transparent background and light colours work best against the
near-black background of the Tableau Cloud site.

Dashboard-based Custom Portals
Note: This overview was inspired by the work of Tableau Zen Master Mark Jackson.
For more details about the process, check out Mark's blog.

The standard Tableau Cloud or Tableau Server interface works great for many organisations, but if you want to create a company-branded experience and don't have API
developer skills, consider creating a custom portal based on a Tableau dashboard. A custom portal lets you organise content around specific departments or job roles, and you can
even incorporate training that helps people interact with data more fully. As the volume of
Tableau content grows, a custom portal guides your users directly to the data they need,
while providing ready access to related views and Tableau Cloud search so they can easily
explore further.

Sketch out a portal design
Begin outside of Tableau, on paper or in a wireframing application. Consider the structure
of your organisation and the number of Tableau views that apply to each group of users. Do
you simply need one level of navigation that points immediately to content? Or might you
need to start with a main page that provides navigational links for separate groups of users
or report types, followed by a second level with related dashboards and views?
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After you get buy-in on your design from key stakeholders and data consumers, you're ready
to move on to the next phase.

Gather images for logos and navigation elements
Start thinking about images while refining your initial mockup, and then gather them from libraries of clip-art or approved brand graphics, or create them from scratch in an application
like Photoshop or SnagIt. PowerPoint can also be a good source if you plan to create navigation thumbnails of common chart types.

Lay out text, images and selected sheets on a dashboard
Create a workbook with a dashboard for the portal, using a tiled layout for more predictable
positioning and scaling of elements on different devices. Then start adding Text and Image
objects, as well as any sheets for data views you want to highlight right up front in your portal.
To refine spacing between these dashboard elements, insert Blank objects and adjust their
size. For more information, see Create a Dashboard.
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Link dashboard elements to content
If you have a second level of navigation in your portal, use filter actions to point to a secondary dashboard from the main one. To create links that directly open data views, rightclick Image objects and choose Set URL. (In our example below, each coloured arrow and
accompanying text is an image that links to a view URL.) You can even point to empty views
with preloaded data sources, encouraging users to create new Tableau content in the webauthoring workspace.

Tip: To add hyperlinks to text objects, include the full URL (for example,
http://www.tableau.com).
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Publish, test, and refine your portal
Publish the workbook to your server and distribute the dashboard URL to your users. Portal
design, like data analysis itself, is a cyclical process. Now that your portal is out in the wild,
start gathering user feedback so you can continuously improve the experience

Tableau Software

167

Tableau Cloud Help
Tip: As a finishing touch, hide the Tableau toolbar to give your portal a custom feel.
After the question mark at the end of the dashboard URL, add :embedd=y&amp;:toolbar=n

Set the Default Start Page for All Users
In a new site, when users sign in to the Tableau Cloud web authoring environment, they are
taken to the Home screen, which displays a role-based welcome banner. Home also displays recent views, favourites and the site's most-viewed content. As the administrator, you
can change users’ default landing page at the site level. For example, you can show all workbooks, and when the user signs in, they see the workbooks they have access to.
To set the default start page for all users

1. Display the page or filtered view you want to be the default page users see when they
sign in to the site.
2. Select your profile icon in the upper right area of the page.
3. To set the start page for all users on a site, click Set as Start Page and For Users
on this Site.

User-set start pages and hierarchy
Users can set their own start pages from their profile icon, and can reset their start pages in
their account settings (for information, search for “Access Your Profile and Account Settings” in the online Tableau Server Help for your operating system).
If a user sets their own start page, it will override any start page set for the site. The next
time that user signs in to Tableau Cloud, they will land on the start page that they've set. If
neither a user or an administrator has set a start page, users will default to Home.
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Change Time Settings
There are a couple of time-related configurations that you might make when working with
Tableau Cloud.

Set the site time zone for extracts
The default time zone for extract-based data sources in a site is Coordinated Universal Time
(UTC). Site administrators can set a different time zone.
To set the site time zone for extracts:
1. Sign in to Tableau as an administrator.
2. On the site you want to configure, click Settings.
3. In the Site Time Zone for Extracts section, select a time zone and then click
Save.
In calculated fields, functions such as NOW() or TODAY() look at the time zone. For more
information about Extracts, see Extract Your Data in the Tableau Desktop help.
The timezone setting, in addition to being used for extract-based data sources, also affects
internal extracts. For example, when Tableau connects to file-based data sources like text
files, an extract is automatically created internally. Similarly, this happens where Tableau
uses an internal extract to integrate data from different sources.

Synchronise your computer clock with UTC
Timestamps displayed across your Tableau Cloud site are in Coordinated Universal Time
(UTC) of the pod that your site is deployed to. To ensure the time on your computer matches
the time used by your site, you can synchronise your computer's system clock with UTC
using one of the following suggestions:
l

If your computer is deployed on Amazon Web Services (AWS), you can synchronise
your computer's system clock using Network Time Protocol (NTP) sources as
described in the Keeping Time With Amazon Time Sync Service blog post on the
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AWS website.
l

If your computer is deployed outside of AWS, you can synchronise your computer's
system clock using one of the National Institute of Standards and Technology (NIST)
time servers as described in Set your computer clock via the Internet using tools built
into the operating system page on the NIST website.

Security in the Cloud
Tableau understands that data is among the most strategic and important assets an organisation has. We put the highest priority on maintaining the security and privacy of our customers’ data. Tableau enterprise-level security features manage operational security, user
security, application security, network security, and data security.
To learn more, see the following resources on Tableau's website
(https://www.tableau.com):
l

Tableau Cloud Security in the Cloud white paper.

l

Tableau Cloud tips: A security checklist for publishing data to the cloud

If you sign in to Tableau Cloud using TableauID credentials, you can also use them to sign
in to the Tableau website.

Operational Security
The Tableau Cloud infrastructure is hosted in a SAS-70 compliant data center that provides
numerous controls and safeguards over customer data.
Your data is your own, even when stored in Tableau Cloud. Only your authorised users
have access to data or workbooks stored in Tableau Cloud –Tableau employees and other
Tableau customers do not.
Tableau does have access to and may monitor metrics that have to do with system utilisation, account status, and performance.
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User Security
The only people who have access to your site and content are the users that your site’s
administrators have explicitly added to your site. If a user is no longer authorised in your system, simply remove that person’s user account to revoke access to Tableau Cloud and your
content stored there.
Tableau Cloud enforces an idle session timeout of 2 hours. This means that users will need
to re-authenticate after not using Tableau Cloud for a period of 2 hours. The idle session
timeout value is a system setting that cannot be modified.

Tableau Account
Your Tableau Account provides secure, unified authentication to Tableau’s website and services.
Some of the security features of Tableau Accounts are:
l

User sign-in is secured by HTTPS.

l

Accounts are locked for a period of time after repeated unsuccessful sign-in attempts.

l

Accounts are validated by user email to prove identity.

l

Passwords are stored using cryptographic protection. Tableau employees and contractor do not have access to plain-text passwords.

l

Multi-factor authentication (MFA) can be enabled for accounts that use Tableau
authentication (TableauID).

Tableau Cloud site administrators have the option of using your organisation’s identity provider for the added control and convenience of users. For more information, see Authentication.
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Roles and Permissions
A role is a set of permissions that is applied to a project, workbook, view, or data source to
manage user interaction. A wide range of specific permissions is available for each asset:
view, create, edit, modify, delete, and more.

Network Security
All communication between users and Tableau Cloud is encrypted using SSL for secure
transmission of data. Tableau Cloud supports TLS 1.2 and higher. For more information
about TLS support, see the Tableau Knowledge Base. A variety of encryption techniques
ensure security from browser to server tier to repository and back. In addition, Tableau has
many built-in security mechanisms to help prevent spoofing, hijacking, and SQL injection
attacks, and it actively tests and responds to new threats with monthly updates.

Application Security
The Tableau Cloud environment is hosted in a multi-tenant configuration providing separation of users, data, and metadata across customers.

Data Security
Tableau Cloud eliminates the need to implement VPNs or tunnels into your corporate environment. Many data sources can be captured as extracts and then refreshed on a regular
basis. To use automatic refreshes, you need to embed credentials in the connection information for the data source. For Google and Salesforce.com data sources, you can embed credentials in the form of OAuth 2.0 access tokens.
You can define additional security in your workbooks and data sources by adding user and
data source filters. Tableau also provides a User Filter capability that can enable row-level
data security using the username, group or full name of the current user. User filters allow
you to set a filter on your data based on the identity of the person viewing the data. For
example, the Western Sales Director could see results for sales in the West but not for other
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regions. You set user filters when you publish workbooks and data sources from Tableau
Desktop.
For information on the alternatives you can use to implement row-level security in Tableau,
see an Overview of Row-Level Security Options in Tableau.

Data Location
Tableau Cloud is hosted on Amazon Web Services (AWS) and is structured so that you can
choose the region where your site, and its data, is stored. As a new customer, you can select
one of the following regions during the site setup process:
Territory
Asia

Europe

North America

Region
Asia Pacific

Australia

Asia Pacific

Japan

EU West

Ireland

Europe West

UK

Canada

Quebec

US-East

Virginia

US-West

Oregon

If needed, you can migrate your existing site to a different region through the site migration
process. Contact your Tableau Sales Account Manager to request this change. For more
information, see Tableau Cloud Environment Migrations Using the Content Migration Tool in
the Knowledge Base.
Your site is backed up in the selected region on a regular basis. You can verify your site location by signing in to Tableau Cloud, noting the host name at the beginning of the URL and
then comparing it to the Site Location column in Tableau Cloud IP addresses for data provider authorisation. For example, URLs that begin with 10ax, 10ay, 10az, us-west-2b cor-
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respond to the US West - Oregon region. Data corresponding to a site in the US-West Oregon region is stored and backed up in Oregon.
l

To request a new site, fill out this web form.

l

For more information about the Tableau Cloud maintenance schedule, see Tableau

Cloud System Maintenance.

See also
Keep Data Fresh
OAuth Connections
Permissions
How SAML Authentication Works
User Filtering (Tableau Help)

Tableau Cloud Site Capacity
Your Tableau Cloud site comes with capacity to support all your users’ analytic needs. A
site’s capacity includes capacity for storage and tasks that need to be performed on the site
for extracts, metrics, subscriptions and flows.

Summary
The following table summarises the capacity allowances for your site by feature. You can
find more capacity information by the features listed below.

Storage

Capacity Type

Capacity Allowance

Site

100 GB
1 TB with an Advanced Management licence.
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Capacity Type

Capacity Allowance
For more information, see Advanced Management capacity.

Individual workbook,

15 GB

published data
source or flow size

25 GB with an Advanced Management licence.
See Advanced Management capacity.

Extract
refreshes

Daily refreshes

Up to 8 backgrounder hours per Creator licence

Concurrent

Up to 10 jobs

refreshes

Up to 25 jobs with an Advanced Management
licence. See Advanced Management capacity.
Individual refresh

2 hours

runtime

Metrics

Daily refreshes

Up to 8 backgrounder hours per Creator licence

Concurrent

Up to 10 jobs

refreshes
Individual runtime

Subscriptions Concurrent subscriptions
Individual sub-

2 hours

Up to 10 jobs

2 hours

scription runtime
Individual email size
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Flows

Capacity Type

Capacity Allowance

Concurrent flows

1 per Resource Block

Individual flow

See Job runtime capacity.

runtime
Flow memory usage

7.5 GB

size

Visualisations Load time

View Accel-

Up to 5 minutes

Query usage size

20 GB

Accelerated views

Minimum 30 accelerated views per site with an
additional 20 views per Creator Licence. Max-

eration

imum 750 accelerated views.
Accelerated view

Up to 12 jobs per day per view

refreshes
Memory usage size

20 GB

Individual accel-

Up to 30 minutes

eration runtime

Storage capacity
A Tableau Cloud site comes with site and individual content storage capacities.
l

Site storage: A site comes with 100 GB of storage capacity. Workbooks, published
data sources and flows count toward this storage capacity.

l
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Individual workbook, published data source and flow size: An individual
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workbook, data source (live or extract) or flow published to your site can have a maximum size of 15 GB.
Note: If your extract data source exceeds 10 GB in size, we recommend that you consider either using live connection to the database or aggregate the data in the extract
to reduce its size. Frequently republishing or refreshing large extracts can be time
intensive and usually indicates that more efficient data freshness strategies should be
considered.

Visualisation capacity
Each site comes with designated capacity to load and query individual visualisations, also
known as views. You can find more information about each capacity type below.
l

Load time: A site has capacity to spend up to 5 minutes to load a view.

l

Query usage size: A site has capacity to use no more than 20 GB of memory to
query a view that uses an extract data source. The amount of memory needed to
query a view can vary depending on the complexity of the data manipulations that
Tableau needs to perform to generate the marks in the view.
Note: Only queries against extract data sources count toward query usage capacity.
Queries against data sources that use live connections to the underlying data do not.
However, queries against data sources that use live connections might be subject to
other query usage capacity enforced by underlying databases.

Views that exceed one or both capacity types might be canceled to ensure enough system
resources are available so that other views on the site can load.
Tips for optimising visualisation capacity

Views that exceed visualisation capacity can indicate the queries that Tableau must run in
order to generate the view might be too complex. In such cases, you can use the following
tips to help optimise queries thereby minimising the time it takes to load views on Tableau
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Cloud. Most tips require that you edit the data source or workbook and republish to Tableau
Cloud for changes to take effect.
For more tips, see the Workbook Performance topic in the Tableau Help.
l

Use data source filters: When you add a filter on a data source, you reduce the
amount of data that needs to be generated in the view. Reducing the amount of data
can help minimise load times of views. For more information, see Filter Data from
Data Sources in the Tableau Help.

l

Use context filters: Similar to data source filters, context filters reduce the data in
the data source but at the sheet level. Context filters work independently of other filters and can significantly reduce the amount of data that needs to be generated in the
view. Reducing the amount of data can help minimise load times of views. For more
information, see Improve View Performance with Context Filters in the Tableau Help.

l

Decrease date ranges: As a rule, dates require more computing power than other
types of data like numbers and Booleans. If the view contains date filters, you can
reduce the date ranges or the number of dates that need to be generated to help minimise the load times of views.

l

Reduce marks: Because Tableau must calculate the marks in order to generate the
view, the number of marks can impact how quickly the view can load. There are several ways you can reduce marks, including using some of the filters listed above or
using sets to filter, custom SQL to aggregate data, and more. For more information,
see Reduce the number of marks in the view.

View Acceleration capacity
Each Tableau site has the following View Acceleration capacity:
l

Accelerated views: The default number of accelerated views per site is 30. For
each additional Creator Licence, 20 more views can be accelerated. The maximum
number of accelerated views is 750.
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l

Accelerated refreshes: Accelerated views are regenerated in alignment with the following four data update events:
l

l
l
l

Data freshness policy: The acceleration timestamp is out of sync with the data
freshness policy.
Extract refreshes: An extract refresh completes, signalling fresher data.
Accelerated view update: An accelerated view is updated by the owner.
View opted-in: A view is originally opted in for acceleration.

Each unique event triggers a pre-computation job to be queued. Backgrounder jobs
then pick up and complete the pre-computation and then store query results as a
materialised view. Views that belong to the same workbook are refreshed in one job.
To limit resource consumption, the maximum number of pre-computation jobs that can
be run is limited to 12 jobs per day. For more information, see Set a Data Freshness
Policy.
l

Acceleration memory usage size: A site has capacity to use no more than 20 GB of
memory for pre-computing and fetching the workbook's data in a backgrounder job.
The amount of memory needed varies depending on the complexity of the query(ies)
that are associated with the view that is being accelerated.

Job runtime capacity
Job runtime capacity is the period of time that a job, or an instance of a task type, is allowed
to run before it's cancelled to help protect available system resources. Each site comes with
job runtime capacities for the following job types:
l
l
l
l
l

Extract refreshes
Subscriptions
Flows
Metrics
View Acceleration

Each extract refresh, subscription or metrics job type has a maximum runtime of two hours
(120 minutes or 7,200 seconds). View Acceleration has a maximum runtime of 30 minutes
(1,800 seconds).
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Note about flows: For sites that don’t have Data Management, the maximum runtime for
flow jobs for a site is 60 minutes multiplied by the number of creator licences up to a maximum of 24 hours. If your site has large flows workloads, consider purchasing Data Managementto get more capacity. For sites with Data Management, you can run flows for up to
24 hours per day per Resource Block. If you exceed the time limit, no new jobs can be started until the next day. Additional capacity for concurrent flow jobs can be purchased. For
more information, see Resource Blocks.
Note about extract refreshes: If a refresh job reaches its maximum runtime, you see a
timeout error. For more information about the error and ways you can modify extracts to
keep refresh jobs within the runtime capacity, see Time limit for extract refreshes.

Concurrent jobs capacity
Concurrent jobs capacity is the number of jobs, or instances of a task type that can run at
the same time. Each site comes with concurrent capacities for the following job types:
l
l
l
l

Extract refreshes
Subscriptions
Flows
Metrics

You can find more information about the concurrent jobs capacity for each job type below.
l

Extract refreshes: A site has the capacity to refresh up to 10 extracts concurrently.
Depending on available system resources, refresh jobs can run sequentially or in parallel. Jobs that count toward concurrent refresh capacity include scheduled
refreshes, manual refreshes, extract creation and command line or API calls that trigger refreshes, including appending data incrementally.

l

Subscriptions: A site has the capacity to run up to 10 subscriptions concurrently.
Jobs that count towards concurrent subscriptions capacity include generating emails
from subscriptions created through Tableau Cloud directly or API calls that generate
the email subscriptions.

l
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Flows: If licensed with Data Management, a site has a default capacity of 1
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concurrent flow job per Resource Block. Resource Blocks support flow jobs. If not
licensed with Data Management, a site has a default capacity of 1 concurrent flow job,
which is the equivalent of having one resource block. If there are no resource blocks
available when a flow job starts, the job goes into a queue to wait for a resource block
to be available. Additional capacity for concurrent flow jobs can be purchased. For
more information, see Resource Blocks. Each user can have a maximum of 4 active
flow web editing sessions at one time. If more sessions are opened, the oldest session
will be closed.
l

Metrics: Each site has the capacity to refresh up to 10 metrics concurrently. For more
information about how metrics refresh, see Create and Troubleshoot Metrics.

Note: If a site exhausts its concurrent capacity for a job, other jobs that are in the queue
remain in a pending state until one or more jobs have completed.

Daily jobs capacity
Daily jobs capacity is the number of shared hours each site can spend per Creator licence a
day to perform all jobs on the site. A server process, called backgrounder, initiates and performs these jobs. A site with more Creator licences gets more daily jobs (backgrounder)
capacity to meet the needs of a larger site population.
Each site comes with daily jobs (backgrounder) capacity to perform both extract refresh and
metric refresh jobs.
For example:
If your site has...

multiplied by the default time

Daily jobs capacity

10 Creator licences

8 hours

Up to 80 hours/day

50 Creator licences

8 hours

Up to 400 hours/day

Daily jobs capacity resets each day at 24:00:00 UTC (coordinated universal time).
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About extract refreshes
Refresh jobs that count towards daily jobs capacity include full and incremental refreshes
and extract creation, which can be initiated by scheduled refreshes, manual refreshes and
certain command line or API calls.
Notes:
l

As long as your site has time remaining in its daily refresh capacity, a refresh job will

l

run regardless of the time it takes for that refresh job to complete.
Site admins receive email notifications when a site reaches 70%, 90% and 100% of its

l

daily refresh capacity.
If a site exhausts its daily refresh capacity, any future extract refreshes are cancelled
and email notifications are sent to content owners alerting them of the refresh cancellation.

Tips for optimising extract refreshes capacity

If you're managing an extract-heavy environment, Tableau recommends following some
best practices to make the most efficient use of your site capacity.
l

Stop refreshing unused extracts. One of the best ways to reclaim capacity for
your site is to stop automatic refreshes, either through schedules on Tableau Cloud
or through scripts of extracts that aren’t being used. For more information about deleting a refresh schedule, see Manage Refresh Tasks.

l

Reduce the frequency of refreshes. Another method of reclaiming capacity for
your site is to reduce the frequency of extract refreshes. For example, instead of
refreshing an extract hourly, consider refreshing an extract daily or only during business hours when fresh data is most useful. For more information about changing a
refresh schedule, see Manage Refresh Tasks.

l

Use incremental refreshes instead of full refreshes. To decrease the amount of
time an extract takes to refresh, consider performing an incremental refresh of the
extract instead a full refresh. For more information, see Schedule Refreshes on
Tableau Cloud.
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Note: Changing from a full to an incremental refresh can be done from Tableau Cloud
only if the extract was configured for incremental refresh in Tableau Desktop before
the extract was published. For more information about incremental refreshes, see
Configure an incremental extract refresh in the Tableau User Help.
l

Use live connections instead of extract connections. For views, dashboards
and workbooks whose data needs to be updated frequently, consider setting up the
data source to use a live connection instead of an extract connection.

l

Optimise the data in the extract. Improving the performance of an extract can also
help reduce the amount of time an extract takes to refresh. There are a number of
changes you can make to the extract's data to help its overall performance, such as
removing unused fields, using filters to remove unused rows, changing date ranges,
etc.

About metric refreshes
Metrics that rely on extract data sources refresh when their extract counterparts refresh and
therefore count towards daily job capacity.
Note: Metrics that rely on live data sources refresh every 60 minutes and don't count
towards daily job capacity.

Jobs initiated by command line and API calls
In addition to the daily jobs capacity described above, a site comes with a designated jobs
capacity for command line and API calls.
l

Initiate extract refresh jobs: A site comes with designated capacity for tabcmd
(refreshextracts), REST API (Run Extract Refresh Task), and Tableau Client
(Python) library calls to initiate extract refresh jobs. A site allows 20 total calls per onehour period.

l

Query or cancel jobs: A site comes with a designated capacity for REST API
(Query Job and Cancel Job), and Tableau Client (Python) library calls that query
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status information for asynchronous jobs, or cancel pending and in-progress jobs. A
site allows 20000 calls per 24-hour period.
l

Initiate publish, update or refresh jobs: A site comes with designated capacity
for tabcmd (publish), REST API (Publish Workbook, Publish Data Source, Update
Workbook, Update Data Source, Update Data Source Now), and Tableau Client
(Python) library calls that initiate publish, update or refresh jobs for workbooks and
data sources. A site allows 4000 calls per 24-hour period.

Note: If the number of calls exceed the command line or API calls capacity described
above, you see one of the following errors: Unknown 429 or ApiCallError: 429000: Too
Many Requests – Too many requests for <job type> ‘api.rest.refresh_extracts’. Please retry
after 146 second(s).

Monitor capacity
There are a few tools you can use to help you monitor your site’s capacity: Jobs page and
Admin views.

Jobs page
The Jobs page gives you detail about the unique instances of backgrounder tasks, called
jobs, within the past 24 hours. You can use the jobs page to monitor extract refreshes, subscriptions and flow jobs.
1. Sign in to Tableau Cloud using your site admin credentials.
2. In the left navigation pane, click Jobs.
3. From the filter drop-down menu, under Task Type, select the job type you want to
monitor.
For more information on the Jobs page, see Managing Background Jobs in Tableau Cloud
topic.
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Admin views
Admin views help you monitor different types activity on your site. You can find more capacity
usage information, using admin views, for the features listed below.
l

Storage: You can monitor your site’s storage capacity and check which workbooks,
data sources and flows take up the most space on your site using the “Stats for Space
Usage” admin view. Select Site Status > Stats for Space Usage.
l

Next to How Is Space Used on This Site, see the total storage capacity used
on your site.

l

Below What Workbooks, Data Sources and Flows Use the Most Space,
see a list of your site's content and their sizes.

For more information on this admin view, see Stats for Space Usage topic.
l

Flows: You can monitor the performance of flow runs. Select Site Status > Flow Performance History. Using the dashboard, under Flow History, click on a mark to see
details about the flows job.
For more information about this admin view, see Performance of Flow Runs in the
Tableau Prep Help.

l

Metrics: You can monitor your site’s metrics jobs by using the ‘Background Tasks for
Non Extracts’ admin view. Select Site Status > Background Tasks for Non
Extracts and then, from the Tasks filter drop-down, select Update all metrics on a
view tick box.
For more information about this admin view, see Background Tasks for Non Extracts.

Advanced Management capacity
With Advanced Management, you get the following capacity increases for your site:
l
l

Storage of 1 terabyte
Maximum file size of 25 gigabytes
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l

Up to 25 concurrent extract refreshes

For more information about Advanced Management, see About Tableau Advanced Management.

Tableau Cloud System Maintenance
Tableau Cloud undergoes periodic maintenance to sustain the infrastructure supporting
Tableau Cloud services and deliver enhanced features and functionality. As a Tableau
Cloud administrator, you don't have to worry about managing updates to your site. But we
recommend reviewing the reserved maintenance schedule to plan for scheduled downtime
and to avoid service interruptions.
For more information about quarterly releases, see Tableau Cloud quarterly releases.

Maintenance communication
Tableau communicates system maintenance through the Tableau Trust page and notification emails to site administrators.

Tableau Trust notifications
Tableau Trust is where all Tableau Cloud status updates are posted. Status updates
include system maintenance, as well as reported incidents that may affect the use of
Tableau Cloud. You can quickly check the status of your Tableau Cloud instance by visiting
the Tableau Trust page, or by subscribing to Trust to stay informed.
To subscribe to Trust, simply go to https://trust.tableau.com, and click Subscribe to
updates. You can receive updates by email, SMS message or RSS notifications whenever
Tableau creates, updates, or resolves an incident.
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Site Administrator emails
Tableau Cloud users with the Site Administrator role will automatically receive notification
emails about their site. Emails include system maintenance and reported incidents that may
affect the use of Tableau Cloud.
Notification emails will include the date and time, name of the Tableau Cloud instance, type
of maintenance scheduled, impact to users and estimated time to completion.

Reserved system maintenance schedule
Tableau has reserved system maintenance windows for sustaining the security, availability
and performance of the infrastructure supporting Tableau Cloud services. The reserved
maintenance schedule will help you plan for scheduled downtime and avoid service interruptions to your Tableau Cloud site. While there is a pre-defined window in which maintenance can occur, there may be months when maintenance is not required.
When maintenance is scheduled, we publish the dates and times of the maintenance windows on the Tableau Trust site. For maintenances that impact an entire Tableau Cloud
instance, Trust notifications are sent to subscribers and site administrators via email. Notifications are sent when the maintenance schedule is posted to Trust and 14-days before the
maintenance will occur. Trust notifications will also be sent at the start and end of each maintenance and 48 hours prior as a reminder.
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In the event that we need to reschedule maintenance, the maintenance record will be
updated on the Trust site, and an email will be sent to Trust subscribers.

Note: If priority maintenance is required, Trust subscribers and Tableau Cloud site
administrators may be notified less than one week in advance.

Whenever possible, and only as maintenance is necessary, Tableau will schedule system
maintenance the first and third weekends of the calendar month during the windows
listed in the table below. Plan the maintenance activities for your organisation (software
upgrades, integration changes, etc.) outside of the Tableau system maintenance windows
for your instance(s). In extreme circumstances, there may be times when system maintenance is scheduled outside of these windows to maintain system availability, performance
and security of the Tableau Cloud infrastructure.
Reserved System Maintenance Windows
Region

Instance

Interval

Local Time

UTC

weekend

Saturday, 08:00 -

Saturday,

3rd monthly

14:00 PST

16:00 – 22:00

weekend

Sunday, 11:00 -

Sunday, 16:00

3rd monthly

17:00 EST

– 22:00

weekend

Saturday, 02:00 -

Saturday,

3rd monthly

08:00 CET

01:00 – 07:00

1st monthly
United States -

10ay, 10az,

West

us-west-2b

weekend
prod-us-eastUnited States -

a, prod-us-

East

east-b, useast-1

1st monthly

weekend
1st monthly

dub01, euEurope - West

west-1a, produk-a

weekend
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1st monthly
Asia Pacific -

prod-apnorth-

Japan

east-a

weekend

Sunday, 01:00 -

Saturday,

3rd monthly

07:00 JST

16:00 – 22:00

weekend

Sunday, 03:00 -

Saturday,

3rd monthly

09:00 AEST

16:00 – 22:00

weekend
1st monthly
Asia Pacific –

prod-apsouth-

Australia

east-a

weekend

Note: Local maintenance windows use Standard Time. The local time may change +/- 1
hour seasonally during Daylight Savings.

Tableau Cloud quarterly releases
To ensure our products continue to help people use data to solve problems every day,
Tableau is constantly innovating. We ship new features and functionality four times a year,
once per quarter.

Release communication
Quarterly releases are communicated through in-product notifications to let you know when
your site is scheduled to be upgraded, and then again once the upgrade is complete. Sites
can be accessed during the upgrade, meaning that all features and functionality are available
to users. There is no downtime associated with quarterly release upgrades.

Quarterly release schedule
Major releases are rolled out across Tableau Cloud’s worldwide infrastructure over several
weeks before upgrading our on-premises software. Because our quarterly releases are
rolled out worldwide in sequence, exact dates and times are not pre-announced. Instead, in-
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product notifications are there to inform users and administrators when releases are upcoming.
You will see an in-product notification approximately two weeks before your site is scheduled to upgrade.

Learn about new features
For more information about the new features on your site, see Coming Soon. The Coming
Soon page offers information about upcoming and in-progress Tableau releases. As a
Tableau Cloud customer, you may already have access to the features listed on this page.
Broader website updates happen once customers across all of our products can upgrade
and take advantage of the new features.

Authentication
Authentication refers to the options for how users can sign in to their Tableau Cloud site,
and how they access it after signing in for the first time. Authentication verifies a user’s identity.

190

Tableau Software

Tableau Cloud Help
Tableau Cloud supports multiple authentication types, which you can configure on the
Authentication page.
In addition to the authentication type you configure for your site, multi-factor authentication
(MFA) through your SSO identity provider (IdP) is a Tableau Cloud requirement beginning
1st February 2022. If your organisation doesn’t work directly with an SSO IdP, you can use
Tableau with MFA authentication to meet the MFA requirement. For more information, see
About multi-factor authentication and Tableau Cloud below.
l

Tableau: This is the built-in and default authentication type, requiring no additional
configuration steps before you add users. Tableau credentials (also called TableauID)
are made up of username and password, which are stored with Tableau Cloud. Users
enter their credentials directly on the Tableau Cloud sign-in page. Beginning 1st February 2022, site admins or other users who authenticate using TableauID must have
Tableau with MFA configured. If Tableau with MFA is not configured, users will be
prompted to use Tableau with MFA when attempting to sign in based on the MultiFactor Authentication (MFA) Enforcement Roadmap.
l

Tableau with MFA: This authentication type uses a combination of 1)
TableauID credentials that are comprised of a username and password, which
are stored with Tableau Cloud and 2) after a successful TableauID authentication, the user is prompted to respond to an additional verification method
before accessing the site. For more information, see Multi-Factor Authentication and Tableau Cloud.

l

Google: If your organisation uses Google applications, you can enable Tableau Cloud
to use Google accounts for single sign-on (SSO) with MFA using OpenID Connect.
When you enable Google authentication, users are directed to the Google sign-in
page to enter their credentials, which are stored by Google.

l

Salesforce: If your organisation uses Salesforce, you can enable Tableau Cloud to
use Salesforce accounts for single sign-on (SSO) with MFA using OpenID Connect.
When you enable Salesforce authentication, users are directed to the Salesforce sign-
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in page to enter their credentials, which are stored and managed in Salesforce. Minimal configuration may be required. For more information, see Salesforce Authentication.
l

SAML: Another way to use SSO is through SAML. To do this, use a third-party identity provider (IdP) with MFA, and configure the site to establish a trust relationship
with the IdP. When you enable SAML, users are directed to the IdP’s sign-in page,
where they enter their SSO credentials, already stored with the IdP.

About multi-factor authentication and Tableau Cloud
In order to get ahead of the rise and constantly evolving threats that can cripple an organisation, MFA authentication will be a Tableau Cloud requirement beginning 1st February
2022. MFA is an effective tool for enhancing sign-in security and protecting your organisation and its data against security threats. For more information, see the Salesforce MultiFactor Authentication FAQs and Multi-Factor Authentication (MFA) Enforcement Roadmap
in the Salesforce Help.
Multi-factor authentication (MFA) is an authentication method to use in conjunction with one
of the other authentication methods described above to enhance account security. MFA can
be implemented in one of two ways:
l

SSO and MFA (primary method): To satisfy the MFA requirement, enable MFA
with your SSO identity provider (IdP).

l

Tableau with MFA (alternative method): If you don’t work directly with an
SSO IdP, you can instead enable a combination of 1) TableauID credentials, which
are stored with Tableau Cloud, and an additional verification method before you and
your users can access the site. For more information, see Multi-Factor Authentication
and Tableau Cloud.
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About Google, Salesforce or SAML
If you enable Google or SAML authentication on your site, you can select which users you
want to sign in using external credentials, and which to use Tableau credentials. You can
allow TableauID and one external provider on a site, but each user must be set to use one or
the other type. You can configure user authentication options on the Users page.
Important: In addition to these authentication requirements described above, we recommend that you dedicate a site administrator account that is configured for Tableau with
MFA authentication. In the event of an issue with SAML or the IdP, a dedicated Tableau
with MFA account helps ensure that you have access to your site.

Allow direct access from Tableau connected clients
By default, after users provide their credentials to sign in to a site, they can subsequently
access the Tableau Cloud site directly from a connected Tableau client. To learn more, see
Access Sites from Connected Clients.
Note: Optionally, you might need to add *.salesforce.com if MFA with Tableau authentication is enabled for your site and your environment is using proxies that prevent clients
from accessing other necessary services.

Salesforce Authentication
If your organisation uses Salesforce, you can enable Tableau Cloud to use Salesforce
accounts for single sign-on (SSO) with OpenID Connect. As of Spring 2021, Tableau Cloud
supports Salesforce authentication as a new authentication type. When you enable Salesforce authentication, users are directed to the Salesforce sign-in page to enter their credentials, which are stored and managed by Salesforce. This scenario also supports
scenarios where Salesforce federates authentication with another IdP.

Username requirement
The username that is used within your Salesforce Org must match the username field in
Tableau Cloud. Both of these usernames are in email format, though they may not be used
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as email addresses. Verify that these attributes match. If they do not, configure the Salesforce authentication type, and then see the section below, Mismatched usernames.

Change and configure authentication type
If your organisation already uses Salesforce, setting the authentication type to Salesforce in
Tableau Cloud is a three-step process:
1. Install the Tableau Cloud connected app package in Salesforce. To allow users to
sign in to Tableau Cloud from your organisation, manage access to your connected
app by assigning the appropriate profiles or permission sets. Additionally, set the connected app to Admin pre-approved. See Manage Other Access Settings for a Connected App.
2. Change to Salesforce authentication in Tableau Cloud:

l

Sign in to your Tableau Cloud site as a site administrator, and select Settings
> Authentication.
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l

On the Authentication tab, select Enable an additional authentication

l

method, and then select Salesforce.
If you have configured your Salesforce organisation to use a custom domain
for user sign-in, you will need to configure Tableau Cloud to redirect users to
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the sign in page. Click Edit My Domain... to enter your Salesforce My Domain.
Tableau Cloud will verify the domain and then add it as a sign-in URL.

3. Add new users (or update any previous users) to use Salesforce as their configured
authentication type.

Troubleshooting
Mismatched usernames

If existing users in Tableau Cloud are using usernames that do not match their corresponding usernames in Salesforce, follow this procedure:
1. Change the existing Tableau Cloud user to an Unlicensed site role to prevent licence
consumption.
2. Add the new Tableau Cloud user for Salesforce authentication, ensuring the username matches the username in your Salesforce organisation.
3. If necessary, migrate previous content owned by the old username in Tableau Cloud
to the new user.
Unsuccessful login with OAUTH_APP_BLOCKED in return URL

This issue is surfaced when a user who is configured with Salesforce authentication
attempts to sign in and is not redirected. Tableau Cloud will display a message:
The sign-in was unsuccessful. Try again.
If you continue to get this message, capture the status information below and send it to Customer Support.
Additionally, the return URL in the user's browser includes the following string:
/public/oidc/login?error=OAUTH_APP_BLOCKED&error_description=this+app+is+blocked+by+admin&state=...
This indicates that the connected application within Salesforce is being blocked by your
organisation. Some security-conscious Salesforce customers block all connected applications and implement API allowlist functionality that will prevent the connected application
from working.
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To fix this, ensure that the Tableau Cloud - Salesforce User Login via OIDC connected
application is installed and has the appropriate user profiles and permission sets applied.
For more information, see:
l
l

Manage Access to a Connected App
Manage Other Access Settings for a Connected App

Multi-Factor Authentication and Tableau Cloud
As part of the broader Salesforce ecosystem, we require you, site owners, to configure
account security mechanisms for you and your users. The way you can enable account
security depends on which technologies are available to you in your organisation, such as
multi-factor authentication (MFA). MFA authentication will be a Tableau Cloud requirement
beginning 1st February 2022. MFA is an effective tool for enhancing sign-in security and protecting your organisation and its data against security threats. For more information, see the
Salesforce Multi-Factor Authentication FAQs and Multi-Factor Authentication (MFA)
Enforcement Roadmap in the Salesforce Help.
When you enable MFA, we require you do this through your single sign-on (SSO) identity
provider (IdP). If you don’t work directly with an IdP, you can enable MFA with Tableau
authentication using the Tableau with MFA capability.
Important: If you decide to use Tableau with MFA, review this topic in its entirety, especially Regain site access after being locked out.

User accounts and multi-factor authentication
Multi-factor authentication (MFA) is a secure account authentication method that requires
users to prove their identity by providing two or more pieces of information, also known as
“factors”, when they sign in to Tableau Cloud. The first factor is unique information your
users know – their usernames and passwords. Additional factors are verification methods
that users have in their possession, such as an authenticator app.
By enforcing multiple factors when users sign in to Tableau Cloud, MFA makes it more difficult for common threats like phishing attacks and account takeovers to succeed. MFA is an
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effective tool for enhancing sign-in security and protecting your organisation and its data
against security threats.
Primary method - SSO with MFA: If you are currently using your organisation’s SSO IdP to enhance your security with MFA, you should continue to do
so. If not, to satisfy the MFA requirement, configure your site to use SSO and
enable MFA with your SSO IdP. You can configure your site users to authenticate with Google, Salesforce or SAML provider.
Alternative method - Tableau with MFA: If you don’t work directly with an
SSO IdP, or if your site admins or other users use TableauID, you can satisfy
the MFA requirement by enabling MFA with Tableau authentication to secure
your user sign-in process until you’re able to transition to a more centralised
IdP. This capability enables you and your users to continue signing in to
Tableau Cloud with your TableauID credentials, with an additional step of using
a verification method before being successfully authenticated to the site.
Tableau with MFA supports the following verification methods:

l

Salesforce Authenticator app
Time-based one-time passcode (TOTP) authenticator apps, including

l

Google Authenticator, Microsoft Authenticator and Authy
Security keys that support WebAuthn or U2F, such as Yubico YubiKey or

l

l
l

Google Titan Security Key
Built-in authenticators, including Touch ID, Face ID and Windows Hello
Recovery code

To compare supported verification methods and review usage requirements,
see Verification Methods for Multi-Factor Authentication topic in Salesforce
Help.

Enable MFA with Tableau authentication
If your organisation does not work directly with an SSO IdP, you can satisfy the MFA requirement with the default Tableau authentication. For more information, see About multi-factor
authentication and Tableau Cloud.
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1. Sign in to Tableau Cloud using your site admin credentials and go to the Users page.
2. Next to the first user listed, do the following:
1. Click on the Actions menu, select Authentication and then select Tableau with
MFA.

2. Click Update to save changes.
3. Repeat step 2 for each user listed, including site admins.
After users sign in to Tableau Cloud with their Tableau user name and password, they are
prompted to choose a supported verification method – Salesforce Authenticator or other
time-based, one-time passcode (TOTP) authenticator apps. For more information about
the user process for registering and managing a verification method, see Register for multifactor authentication.
Best practices for site admin accounts

When enabling MFA for your users, we recommended the following best practices for your
site admin accounts:
l

Register a minimum of two verification methods: For each site admin account,
register at least two verification methods to reduce the risk of being locked out of the
site. For example, after you have registered a primary verification method, we recommend you add the Recovery Codes option to generate a set of recovery codes as
backup.

l

198

Designate at least two site admin accounts to manage users and MFA:

Tableau Software

Tableau Cloud Help
Designate at least two site admin-level accounts (Site Administrator Creator or Site
Administrator Explorer) that have permissions to manage users and MFA settings.
This can help prevent admin access delays if another admin is locked out of the site.
Manage verification methods

You (and your users) can manage verification methods from your My Account Settings
page. On this page, you can add or remove additional verification methods.
About recovery codes - use in emergency situations only

To help reduce the risk of a locked-out scenario, we recommend you (and your users) add
the Recovery Codes option as backup after registering for MFA. Recovery codes, to be
used in emergency scenarios only, allow you to sign in to Tableau Cloud if you don't have
access to your usual MFA verification methods. If you add the Recovery Codes option, a list
of ten one-time use codes are generated for you that you can use to sign in to Tableau
Cloud.
Important:
l

Because the list of codes is not accessible after you've added the Recover Codes
option, immediately copy and store these codes in a safe and secure location so that

l

you can use them in emergency situations.
Recovery codes should not be used as your primary verification method. Instead,
recovery codes should be used in emergency scenarios only when you don’t have
access to your usual MFA verification methods.

Regain site access after being locked out

Important: We strongly recommend that you (and your users) register the Recovery Codes
option to help avoid being locked out of your site. Recovery codes should be used in emergency scenarios only.
If you lose all your usual verification methods, contact another site admin to help you regain
site access by using the procedure described below. You can use this procedure to enable
site access for your users as well.
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Reset MFA

To enable site access, reset the MFA verification methods from the user's profile page in
Tableau Cloud.
1. Sign in to Tableau Cloud as a site admin.
2. Navigate to the Users page and select the user who needs to regain access to the
site.
3. On the user's profile page, click the Settings tab and then click the Reset
MFA Verifiers button.
Note: To see the Reset MFA Verifiers button, the user's authentication method
must be set to Tableau with MFA.

After the MFA verification methods have been reset, contact the user and request that they
follow the procedure described in Register for multi-factor authentication to register for MFA
again.
Reset MFA as the only site admin

If you're the only site admin and you lose all your usual verification methods, you must contact your account manager. In order to regain access to Tableau Cloud, Tableau must
manually confirm your identity and then reset the methods of verification. To help ensure a
smooth account recovery process, keep the following in mind:
l

Tableau might use information from your TableauID profile (on Tableau.com) to validate who you are. Therefore, it’s important to keep your profile information, such as
phone number, up to date. For more information about editing your TableauID profile, see the Changing your Name, Title or Email Address in the Tableau Community
on the Tableau Community site.

l

If you have Premium Support and require assistance on a weekend, you can file a
Tableau Support case. For more information, see Submitting a Case from the Web-

form in the Tableau knowledge base.
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Access Sites from Connected Clients
By default, Tableau Cloud allows users to access their sites directly from a Tableau client. It
allows this access after the user provides credentials the first time they sign in from the client.
A client in this case is a Tableau application or service that can exchange information with
Tableau Cloud. Examples of Tableau clients include Tableau Desktop, Tableau Bridge and
Tableau Mobile.
Tableau Cloud establishes a connected client by creating a secure access token that
uniquely identifies a user when the user signs in from the client.
Connected client requirement for Tableau Bridge

The default connected client option must remain enabled for the site to allow Tableau Bridge
clients to run unattended and, if enabled, support multi-factor authentication with Tableau
authentication. If connected clients are disabled for the site, Bridge can only support Tableau
username and password authentication.
Note: If multi-factor authentication (MFA) is enabled with Tableau authentication, Bridge clients must be running Tableau Bridge version 2021.1 and later. For more information about
Tableau with MFA, see About multi-factor authentication and Tableau Cloud.

Opt out of allowing connected clients
Site admins can turn off this functionality, to require users to sign in explicitly each time they
visit Tableau Cloud.
Opting out is recommended if SAML is enabled on your site, and you want to ensure that
users do not have access to Tableau Cloud when they are removed from the IdP’s SAML directory.
1. Sign in to Tableau Cloud with your site admin credentials.
2. Select Settings, and then select the Authentication tab.
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3. Under Connected clients, clear the Let clients automatically connect to this
Tableau Cloud site tick box.
If you opt out of connected clients, keep the following points in mind:
l

Some clients provide a Remember Me tick box, which users can select to remember
their username. Users always need to provide their password.

l

For sites configured for single sign-on using SAML authentication, users have direct
access to the site after they sign in the first time. They can do this if they do not sign
out explicitly by selecting the Sign Out link.

Remove a user’s connected clients
Site administrators can remove clients (access tokens) associated with a particular user, for
example, if the user is no longer a member of the site or is seeing a message about exceeding the maximum number of clients in their account.
1. Select Users, and on the Site Users page, select the link on the user's display name.
2. On the user's page, select the Settings tab.
3. In the Connected clients section, remove the appropriate clients.
Users also can go to their own account settings page to remove specific clients.

See also
Sign In to Tableau Cloud
OAuth Connections

Automate User Provisioning and Group Synchronisation
through an External Identity Provider
You can automate adding or removing users from Tableau Cloud or adding or removing
members from groups using your Identity Provider (IdP).
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Tableau Cloud IdP user management uses the System for Cross-domain Identity Management (SCIM) standard, an open standard for automating the exchange of user identity
information. SCIM allows IdPs to centrally manage user identities, including assigning users
to applications and groups. The IdP uses SCIM to ensure that “downstream” applications
are kept in sync with the provisioning assignments set up with the IdP. Managing users in this
way improves security and can significantly reduce the manual work that site administrators
must do to manage site users and group membership.

In the diagram above, the IdP pushes updates to Tableau Cloud and controls how often
Tableau Cloud’s SCIM endpoints are called to ensure users and groups are appropriately
mirrored.

IdP-specific configuration
The steps later in this topic provide general information that you can use with your IdP’s documentation to configure SCIM for your Tableau Cloud site. You can get IdP-specific configuration steps for the following IdPs we support:
l

Configure SCIM with Azure Active Directory

l

Configure SCIM with Okta

l

Configure SCIM with OneLogin

We intend to support additional IdPs as the functionality evolves. If you have questions about
future plans, email our SCIM pre-release team.
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Prerequisites
To enable SCIM integration with your Tableau Cloud site, you’ll need the appropriate levels
of access:
l

Site administrator access to the Tableau Cloud site

l

Ability to modify your IdPs configuration settings for Tableau Cloud

Additionally, the SCIM functionality requires that you configure your site to support SAML
single sign-on. If you haven’t done this, see Enable SAML Authentication on a Site, and
then follow your IdP’s documentation to add Tableau Cloud as an application.

Enable SCIM support with your IdP
Use the following steps to enable SCIM support. To complete this process, you’ll also need
the documentation your IdP provides. Look for topics that refer to configuring or enabling a
service provider for SCIM provisioning.

Note: After enabling SCIM, users and their attributes should be managed through the
IdP. Changes made within Tableau Cloud directly may result in unexpected behaviour
and overwritten values.

1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication page in Tableau Cloud, under Automatic Provisioning
and Group Synchronisation (SCIM), tick the Enable SCIM box.
This populates the Base URL and Secret boxes with values you will use in the IdP’s
SCIM configuration.
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Important: The secret token is displayed only immediately after it is generated. If
you lose it before you can apply it to your IdP, you can select Generate New
Secret. In addition, the secret token is tied to the Tableau Cloud user account of
the site administrator who enables SCIM support. If that user’s site role changes
or the user is removed from the site, the secret token becomes invalid and
another site administrator must generate a new secret token and apply it to your
IdP.

3. Copy the secret token value, and then navigate to your IdP settings. Paste the
Tableau Cloud SCIM secret token in the appropriate field.
4. Copy and paste the Base URL shown in the Tableau Cloud SCIM settings to the
appropriate field in your IdP.
5. Follow your IdP’s documentation to provision users and groups after enabling SCIM
support.

Replace a SCIM secret token
When you need to replace your SCIM (system for cross-domain identity management)
secret token, follow the steps below:
1. In Tableau Cloud, navigate to Settings > Authorisation.
2. Under Automatic Provisioning and Group Synchronisation (SCIM), click Generate
New Secret.
3. Reconfigure SCIM to use the new secret token.
An administrator can also revoke a secret token that belongs to another user by deleting that
user from Tableau Cloud and then adding them back to the site.
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Configure SCIM with Azure Active Directory
You can configure user management through Azure Active Directory, provision groups and
assign Tableau Cloud site roles.
While you complete the following steps, it will help to have the Microsoft documentation at
hand. See the tutorial, Configure Tableau Cloud for automatic user provisioning.

Note: If you have already enabled provisioning for your application and would like to
update to use the Tableau SCIM 2.0 endpoint, see the Microsoft article Update a
Tableau Cloud application. If you are setting up provisioning for a new instance of the
Tableau Cloud application, follow the steps below.

Enable SCIM support

Use the following steps to enable SCIM support with Azure Active Directory.
1. The SCIM functionality requires that you configure your site to support SAML single
sign-on. If you have not done this, complete the section Add Tableau Cloud to your
Azure AD applications in Configure SAML with Azure Active Directory.
2. After adding Tableau Cloud from the Azure Marketplace, remain signed in to both the
Azure portal and Tableau Cloud, with the following pages displayed:
l

In Tableau Cloud, the Settings > Authentication page.

l

In the Azure portal, the Tableau Cloud application > Provisioning page.

3. On the Authentication page in Tableau Cloud, under Automatic Provisioning
and Group Synchronisation (SCIM), tick the Enable SCIM box.
This populates the Base URL and Secret boxes with values you will use in the IdP’s
SCIM configuration.
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Important: The secret token is displayed only immediately after it is generated. If
you lose it before you can apply it to your IdP, you can select Generate New
Secret. In addition, the secret token is tied to the Tableau Cloud user account of
the site administrator who enables SCIM support. If that user’s site role changes
or the user is removed from the site, the secret token becomes invalid and
another site administrator must generate a new secret token and apply it to your
IdP.

4. Copy the secret token value, and on the Provisioning page in your Azure portal, do
the following:
l

For Provisioning Mode, select Automatic.

l

For Authentication Method, select Bearer Authentication.

l

For Secret Token, paste the Tableau Cloud SCIM secret token you copied
earlier.

l

For Tenant URL, copy and paste the Base URL shown in the Tableau Cloud
SCIM settings.
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5. Click Test Connection to verify the credentials are working as expected, and then
click Save.
6. In the Mappings section, verify that Provision Azure Active Directory Groups
and Provision Azure Active Directory Users are enabled.

7. Select Provision Azure Active Directory Groups, and on the Attribute Mappings page, review the attributes synchronised from Azure to Tableau Cloud. To
save any changes, click Save.
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8. Select Provision Azure Active Directory Users, and on the Attribute Mapping
page, review the attributes synchronised from Azure to Tableau Cloud. To save any
changes, click Save.

Assign users and groups to the Tableau Cloud application

Use the following steps to assign individual users and groups to the Tableau Cloud application in Azure.
1. From the application page, select Enterprise Apps > Users and groups.
2. Click Add user/group.
3. On the Add Assignment page, select a user or group and assign one of the following
site roles: Creator, SiteAdministratorCreator, Explorer, SiteAdministratorExplorer,
ExplorerCanPublish, Viewer or Unlicensed.
You will receive an error if you select a role that is not in the above list. For more information about site roles, see Set Users’ Site Roles.
4. Click Assign.

Tableau Software

209

Tableau Cloud Help
Create groups for site roles

A user can be a member of multiple groups in Azure, but they will only receive the most permissive site role in Tableau Cloud. For example, if a user is a member of two groups with
site roles Viewer and Creator, Tableau will assign the Creator site role.
To keep track of role assignments, we recommend creating role-specific groups in Azure,
such as “Tableau - Creator”, “Tableau - Explorer”, etc. You can then use the groups to
quickly provision new users for the correct role in Tableau Cloud.
Site roles are listed below in order from most permissive to least permissive:
l

Site Administrator Creator

l

Site Administrator Explorer

l

Creator

l

Explorer (Can Publish)

l

Explorer

l

Viewer

Note: Users and their attributes should be managed through Azure. Changes made
within Tableau Cloud directly may result in unexpected behaviour and overwritten values.

Provision users and groups

After you have enabled SCIM support and assigned users and groups to the Tableau Cloud
application in Azure, the next step is to provision users to your Tableau site.
1. On the Provisioning page, expand the Settings section and define the users or
groups you want to provision to Tableau Cloud in Scope.
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2. Toggle Provisioning Status to On.
3. Click Save.
Saving starts the initial synchronisation of the users or groups defined in Scope. Synchronisation occurs approximately every 40 minutes as long as the Azure AD provisioning
service runs. To manually provision users outside of the schedule, select Provision on
demand. For more information about on-demand provisioning, see the Microsoft article Ondemand provisioning in Azure Active Directory.
After provisioning is complete, you should see the users or groups from Azure AD on the
Site Users page in Tableau Cloud.
Change user authentication in Tableau Cloud

Provisioned users are assigned the SAML authentication type by default. To change the
authentication type for users, use the steps below.
1. In Tableau Cloud, select Users.
2. On the Site Users page, tick the boxes next to the users to whom you want to assign
an authentication type.
3. On the Actions menu, select Authentication.
4. In the Authentication dialog, select the preferred authentication type for the user.
For more information about the different authentication types in Tableau Cloud, see
Authentication.
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Configure SCIM with Okta
You can configure user management through Okta, provision groups and assign Tableau
Cloud site roles. If you’re not yet familiar with Tableau site roles and the capabilities each
allows, see Set Users’ Site Roles.
As you complete the following steps, it might also help to have the Okta documentation at
hand.
Enable SCIM support

Use the following steps to enable SCIM support with your IdP. See also Notes and known
limitations for SCIM support with Okta.
1. The SCIM functionality requires that you configure your site to support SAML single
sign-on. If you have not done this, complete the following sections in Configure SAML
with Okta:
l

Open the Tableau Cloud SAML settings

l

Add Tableau Cloud to your Okta applications

After you finish the steps in these two sections, remain signed in to both the Okta console and Tableau Cloud, with the following pages displayed:
l

In Tableau Cloud, the Settings > Authentication page.

l

In the Okta Developer Console, Applications > Tableau Cloud > Provisioning.

2. On the Authentication page in Tableau Cloud, under Automatic Provisioning
and Group Synchronisation (SCIM), tick the Enable SCIM box.
This populates the Base URL and Secret boxes with values you will use in the IdP’s
SCIM configuration.
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Important: The secret token is displayed only immediately after it is generated. If
you lose it before you can apply it to your IdP, you can select Generate New
Secret. In addition, the secret token is tied to the Tableau Cloud user account of
the site administrator who enables SCIM support. If that user’s site role changes
or the user is removed from the site, the secret token becomes invalid and
another site administrator must generate a new secret token and apply it to your
IdP.

3. Copy the secret token value, and then on the Provisioning page in your Okta administrator console, select API Integration in the Settings column.
4. Select Edit, and then do the following:
l

Select the Enable API integration check box.

l

For API Token, paste the Tableau Cloud SCIM secret token you copied in the
previous step.

l

For Base URL, copy and paste the Base URL shown in the Tableau Cloud
SCIM settings.
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Enable group provisioning

Okta allows you to push existing groups to Tableau Cloud to assign user attributes, such as
group or site roles. Once a group is pushed, you can manage group membership in Okta to
automatically update the corresponding group in Tableau Cloud.

Note: After enabling SCIM, users and their attributes should be managed through the
IdP. Changes made within Tableau Cloud directly may result in unexpected behaviour
and overwritten values.

The following steps continue where you left off in the previous section, and they assume you
are signed in to the Okta administrator console.
1. On the Application tab, select the Tableau Cloud application.
2. Select the Push Groups tab.
3. Click Push Groups and select one of the options from the drop-down menu:
l

Find groups by name: Select this option to search groups by name.

l

Find groups by rule: Select this option to create a search rule that pushes
any groups that match the rule.

You can deactivate group push, unlink pushed groups or push group membership immediately by clicking Active or Inactive in the Push Status column. To delete, deactivate or
activate multiple groups, click Bulk Edit.
For more information, see Enable Group Push in the Okta documentation.
Notes and known limitations for SCIM support with Okta
l

In the Okta user assignment settings, the values for User Name and Primary email
must be identical.
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l

You must add a separate Tableau Cloud Okta app for each site you want to manage
using SCIM.

l

If you want to migrate a site, you will need to re-configure SCIM provisioning for the
new site.

l

When provisioning new users, first name and last name attributes in Okta are not
synced to Tableau Cloud. New users must set those fields when they sign in to
Tableau Cloud for the first time.

l

You can set a user’s site role (such as Creator, Explorer or Viewer) in Okta at either
the user or the group level. We recommend assigning the site role at the group level. If
the user is assigned a site role directly, it will override any group settings.

l

A user can be a member of many groups. Groups can have different site roles. If a
user is assigned groups with different site roles, the user will receive the most permissive site role in Tableau Cloud. For example, if you choose Viewer and Creator,
Tableau will assign the Creator site role.
Site roles are listed below in order from most permissive to least permissive:
l

Site Administrator Creator

l

Site Administrator Explorer

l

Creator

Tableau Software

215

Tableau Cloud Help

l

l

Explorer (Can Publish)

l

Explorer

l

Viewer

You can update the site role attribute for a user in Okta and this change will propagate to Tableau Cloud. Other attributes, such as Username and Primary email, cannot
be updated. To change these attributes, remove the user, change the attribute and
then add the user again.

l

Use of SCIM with Grant Licence on Sign-in is unsupported and may result in incorrectly provisioned site roles for users or groups.

Configure SCIM with OneLogin
You can configure user management through OneLogin and provision groups, and assign
Tableau Cloud site roles. If you’re not yet familiar with Tableau site roles and the capabilities
each allows, see Set Users’ Site Roles.
As you complete the following steps, it might help also to have the OneLogin documentation
at hand. Start with Introduction to User Provisioning.
Enable SCIM support

Use the following steps to enable SCIM support with your IdP.

Note: Remember to click Save in the upper right corner of the OneLogin portal after
making configuration changes.

1. The SCIM functionality requires that you configure your site to support SAML single
sign-on. If you have not done this yet, complete the following sections in Configure
SAML with OneLogin:
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l

Step 1: Open the Tableau Cloud SAML Settings

l

Step 2: Add Tableau Cloud to your OneLogin applications

After you finish the steps in these two sections, remain signed in to both the OneLogin
portal and Tableau Cloud, with the following pages displayed:
l

In Tableau Cloud, the Settings > Authentication page.

l

In the OneLogin portal, the Configuration page.

2. On the Authentication page in Tableau Cloud, under Automatic Provisioning and
Group Synchronisation (SCIM), tick the Enable SCIM box.
This populates the Base URL and Secret boxes with values you will use in the IdP’s
SCIM configuration.

Important: The secret token is displayed only immediately after it is generated. If
you lose it before you can apply it to your IdP, you can select Generate New
Secret. In addition, the secret token is tied to the Tableau Cloud user account of
the site administrator who enables SCIM support. If that user’s site role changes
or the user is removed from the site, the secret token becomes invalid and
another site administrator must generate a new secret token and apply it to your
IdP.

3. Copy the secret token value, and then on the Configuration page in your OneLogin
portal, do the following:
l

For API Status, click Enable.

l

For SCIM Bearer Token, paste the Tableau Cloud SCIM secret token you
copied earlier.

l

For SCIM Base URL, copy and paste the Base URL shown in the Tableau
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Cloud SCIM settings.

4. On the Provisioning page:
l

Select Enable provisioning.

l

Select Suspend for When users are deleted in OneLogin, or the user's
app access is removed, and perform the below action.

5. Click Save.
6. (Optional) On the Parameters page, map SCIM Username to the Email attribute. If
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you don’t map SCIM Username to an attribute in email address format, you’ll have to
manually populate this field for each user as part of the provisioning process.
An error is displayed when provisioning users if the mapped value doesn’t contain the
user email address.
If you want to complete the steps for provisioning users and groups, stay signed in to the
OneLogin portal and proceed to the next section.
Provision users and groups

OneLogin gives you a number of ways by which you can assign user attributes such as
groups or site roles. You can apply them at the Tableau Cloud app level, create mapping
rules or apply them manually to individual users.
Before you begin, it's important to note the OneLogin concept of groups operates differently
from that of the Tableau concept of groups. In OneLogin, groups function as security boundaries to apply specific security policies to users. Because of this, users can only belong to one
group at a time.
Additionally, OneLogin uses roles as a container for applications that different user cohorts
can access. Once you assign users a role, you grant them access to all the applications
included in the role. This is similar to the Tableau concept of groups. Users can have multiple
roles in OneLogin, which can be mapped to a target application group, such as Tableau
Cloud.

Note: The following steps assume that you are signed in to the OneLogin portal and
Tableau Cloud app. These steps provide some Tableau-specific information that you
can use with the OneLogin documentation for mapping group and site role attributes to
users.
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Provision a user

Use the following steps to provision individual users to Tableau Cloud through the OneLogin portal.
1. Go to the Users tab and select the user you want to provision. This opens the user
settings page.
2. From the left navigation menu, select Applications.
3. On the Applications page, click the plus (+) icon to provision the user for your
Tableau Cloud application, and then click Continue.
4. Enter the appropriate Tableau Cloud site role for the user in the Site Role field. For
more information about site roles, see Set Users’ Site Roles.
5. Click Save.
Provision multiple users with OneLogin roles

You can provision multiple users to Tableau Cloud by assigning roles in OneLogin. Users
can be added to roles manually or automatically using mappings.
To add users to a role:
1. Go to Users > Roles, and select an existing role or create a New Role. For more
information, see the OneLogin article Roles.
The following example shows the role “Sales” that we’ll use as a group in Tableau
Cloud later on.
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2. On the Applications page, assign the role access to the Tableau Cloud application.
This should provision the associated users to the application automatically.
3. On the Users page, you can add users to a role manually by entering their first and
last name, or add a mapping to automatically add users to a role based on specific
attributes – such as their Active Directory group, for example.

4. After adding users to roles, we recommend you create rules within the application to
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assign the appropriate Tableau Cloud site role based on the OneLogin role. For more
information, see the OneLogin article Configure Apps.
In the screenshot below, users with the “Sales” role will be assigned the Creator site
role in Tableau Cloud. Likewise, users with the “Marketing” role will be assigned the
Viewer site role.

Add users to existing Tableau Cloud groups

Import Tableau Cloud groups into OneLogin and specify the groups you want to be selected
by default in the user provisioning dialog.
1. On the Parameters page, click Groups, and select the Include in User Provisioning check box.
2. Go to the Provisioning page, and in the Entitlements section, click Refresh.
This imports the groups from Tableau Cloud.
3. Go back to the Parameters page, and then select the groups that you want to show
as selected values in the user provisioning dialog.
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4. To change group membership, go to the Users page, select a user, and in the
Groups section, modify the available and selected values.
You can also create mappings that put users into groups automatically, based on conditions
you define. For more information, see the OneLogin article Mappings.
Create groups in Tableau Cloud from OneLogin

Use the following steps to create Tableau Cloud groups based on attributes in OneLogin
mappings. For example, creating a group in Tableau Cloud based on user roles.
1. Go to Applications, select the Tableau Cloud application and then Rules.
2. On the Rules page, click Add Rule to open the edit mapping window.
3. Under Actions, select Set Groups from the drop-down menu, and then select Map
from OneLogin.
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The conditions field with value that matches uses regular expressions. If you want
to create a group in Tableau Cloud that matches the role name in OneLogin, type .*
in the text field.

Assign Tableau site roles

By default, users are assigned the Viewer site role, which occupies a Viewer licence type.
Whatever method you use in OneLogin to assign site roles, at some point you need to enter
the site role name into a text box. For the allowed values you can type, see Valid Tableau
site role values below.
Here are some of the ways you can assign site roles
For individual users:
1. On the Users page, select the user and then navigate to the Applications tab.
Select the corresponding Tableau Cloud application.
2. In the user settings, type the site role name in the Site Role text box.
For a set of users:
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1. On the Parameters page, click Site Role, and then, for Value, select one of the
options for assigning the site role attribute
For example:
o

If all users have the same site role, select Macro and enter the site role name.

o

If the OneLogin user directory contains the site role, select the corresponding
attribute.

2. On the Rules page, create a rule that maps a role to a particular role in Tableau Cloud.
When you’re done assigning the site role, click Save.
Valid Tableau site role values

On the Provisioning page in your OneLogin portal, the Site Role values you can enter are
based on current or legacy licence roles.
l

Current licence roles include the following site role values:
Creator, Explorer, ExplorerCanPublish, ReadOnly, ServerAdministrator, SiteAdministratorExplorer, SiteAdministratorCreator, Unlicensed or Viewer.

l

Legacy (pre-v2018.1) licence types come with the following site roles:
Interactor, Publisher, ServerAdministrator, SiteAdministrator, Unlicensed, UnlicensedWithPublish, Viewer or ViewerWithPublish

See also

To learn the effects of changing user attributes, or how to reset individual user attributes you
changed manually, see the OneLogin article Provisioning Attributes: the Effect of Defaults,
Rules and Manual Entry.

Tableau Software

225

Tableau Cloud Help

SAML
SAML (Security Assertion Markup Language) is an XML standard that allows secure web
domains to exchange user authentication and authorisation data. You can configure
Tableau Cloud to use an external identity provider (IdP) to authenticate users over SAML
2.0. No user credentials are stored with Tableau Cloud, and using SAML enables you to
add Tableau to your organisation’s single sign-on environment.
If you want to use site-specific SAML, you must configure server-wide SAML before you
configure individual sites. Server-side SAML does not need to be enabled for site-specific
SAML to function, but it must be configured.
User authentication through SAML does not apply to permissions and authorisation for
Tableau Cloud content, such as data sources and workbooks. It also does not control
access to underlying data that workbooks and data sources connect to.

Note: Tableau Cloud supports both service provider initiated and IdP initiated SAML in
browsers and in the Tableau Mobile app. SAML connections from Tableau Desktop
must be service provider initiated.

The following image shows the steps to authenticate a user with single sign-on in a typical
service provider initiated flow:

226

Tableau Software

Tableau Cloud Help

1. User navigates to the Tableau Cloud sign-in page or clicks a published workbook
URL.
2. Tableau Cloud starts the authentication process by redirecting the client to the configured IdP.
3. The IdP requests the user’s username and password from the user. After the user submits valid credentials, the IdP authenticates the user.
4. The IdP returns the successful authentication in the form of a SAML Response to the
client. The client passes the SAML Response to Tableau Cloud.
5. Tableau Cloud verifies that the username in the SAML Response matches a licensed
user stored in the Tableau Server Repository. If a match is verified, then Tableau
Cloud responds to the client with the requested content.

SAML Requirements for Tableau Cloud
Before you configure SAML for Tableau Cloud, obtain what you need to meet the requirements.
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Identity provider (IdP) requirements for Tableau configuration
SAML compatibility notes and requirements
Using SAML SSO in Tableau client applications
Effects of changing authentication type on Tableau Bridge
XML data requirements

Identity provider (IdP) requirements for Tableau configuration
To configure Tableau Cloud for SAML, you need the following:
l

Administrator access to your Tableau Cloud site. You must have administrator
access to the Tableau Cloud site on which you want to enable SAML.

l

List of users who will use SSO to access Tableau Cloud. You should gather
the email addresses for the users you want to allow single-sign-on access to Tableau
Cloud.

l

IdP account that supports SAML 2.0. You need an account with an external identity provider. Some examples are PingFederate, SiteMinder and Open AM. The IdP
must support SAML 2.0. You must have administrator access to that account.

l

SHA256 is used as signing algorithm. As of May 2020, Tableau Cloud blocks IdP
assertions and certificates that are signed with the SHA-1 algorithm.

l

IdP provider that supports import and export of XML metadata. Although a
manually created metadata file might work, Tableau Technical Support cannot assist
with generating the file or troubleshooting it.

l

IdP provider that enforces a maximum token age of 24 days or less (2073600
seconds). If the IdP allows a maximum age of tokens that is a greater length of time
than the maximum age setting on Tableau Cloud (2073600 seconds), Tableau Cloud
will not recognise the token as valid. In this scenario, users will receive error
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messages (The sign-in was unsuccessful. Try again.) when attempting to log in to
Tableau Cloud.

Important: In addition to these requirements, we recommend that you dedicate a site
administrator account that is always configured for TableauID authentication. In the
event of an issue with SAML or the IdP, a dedicated TableauID account ensures that
you always have access to your site.

SAML compatibility notes and requirements
l

SP or IdP initiated: Tableau Cloud supports SAML authentication that begins at the
identity provider (IdP) or service provider (SP).

l

Single Log Out (SLO): Tableau Cloud supports both service provider (SP)-initiated
SLO and identity provider (IdP)-initiated SLO.

l

tabcmd and REST API: To use tabcmd or the REST API, users must sign in to
Tableau Cloud using a TableauID account.

l

Cleartext assertions: Tableau Cloud does not support encrypted assertions.

l

Tableau Bridge reconfiguration required: Tableau Bridge supports SAML authentication, but an authentication change requires reconfiguring the Bridge client. For
information, see Effects of changing authentication type on Tableau Bridge.

l

Required signature algorithm: For all new SAML certificates, Tableau Cloud
requires the SHA256 (or greater) signature algorithm.

l

l

RSA key and ECDSA curve sizes: The IdP certificate must have either an RSA key
strength of 2048 or ECDSA curve size of 256.
NameID attribute: Tableau Cloud requires the NameID attribute in the SAML
response.
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Using SAML SSO in Tableau client applications
Tableau Cloud users with SAML credentials can also sign in to their site from Tableau
Desktop or the Tableau Mobile app. For best compatibility, we recommend that the Tableau
client application version matches that of Tableau Cloud.
Connecting to Tableau Cloud from Tableau Desktop or Tableau Mobile uses a service-provider-initiated connection.
Redirecting authenticated users back to Tableau clients

When a user signs in to Tableau Cloud, Tableau Cloud sends a SAML request (AuthnRequest) to the IdP, which includes the Tableau application’s RelayState value. If the
user has signed in to Tableau Cloud from a Tableau client such as Tableau Desktop or
Tableau Mobile, it’s important that the RelayState value is returned within the IdP’s
SAML response back to Tableau.
When the RelayState value is not returned properly in this scenario, the user is taken to
their Tableau Cloud home page in the web browser, rather than being redirected back to
the application they signed in from.
Work with your Identity Provider and internal IT team to confirm that this value will be
included as part of the IdP’s SAML response.
Effects of changing authentication type on Tableau Bridge

When you change the site’s authentication type, publishers who use Tableau Bridge for
scheduled extract refreshes will need to unlink their Bridge client and re-authenticate using
the new method.
Unlinking the Bridge client removes all data sources, so users will also need to set up all of
their refresh schedules again. The change in authentication type does not affect Bridge live
queries or refreshes that run directly from the Tableau Cloud site (such as for underlying
data in the cloud).
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We recommend that you alert Bridge users to changes in their site authentication before you
make it. Otherwise, they will become aware through authentication errors they get from the
Bridge client, or when the client opens with a blank data source area.

XML data requirements
You configure SAML using XML metadata documents that are generated by Tableau Cloud
and by the IdP. During the authentication process, the IdP and Tableau Cloud exchange
authentication information using these XML documents. If the XML does not meet the
requirements, errors can occur when you configure SAML or when users try to sign in.
Tableau Cloud only supports HTTP POST requests for SAML communications. HTTP Redirect is not supported. In the SAML metadata XML document that is exported by the IdP, the
Binding attribute must be set to HTTP-POST.

Enable SAML Authentication on a Site
This topic explains how to enable SAML on the site and select single sign-on users. It also
provides steps for switching from SAML to the default TableauID authentication. Before you
enable SAML, we recommend that you review the SAML Requirements for Tableau Cloud,
including Effects of changing authentication type on Tableau Bridge.
This topic assumes you are familiar with the information in Authentication and How SAML
Authentication Works.

IdP-specific configuration information
The steps in the sections later in this topic provide basic steps that you can use with your
IdP’s documentation to configure SAML for your Tableau Cloud site. You can get IdP-specific configuration steps for the following IdPs:
l

Configure SAML with Azure Active Directory

l

Configure SAML with OneLogin

l

Configure SAML with PingOne
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l

Configure SAML with Okta

l

Configure SAML with Salesforce

Enable SAML
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
select SAML and then select Edit connection.

SAML configuration steps
This section takes you through the configuration steps that appear on the Authentication
page in the Tableau Cloud web UI. In a self-hosted Tableau Server installation, this page
appears only when support for site-specific SAML is enabled at the server level. It is
enabled by default in Tableau Cloud.
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Note: To complete this process, you will also need the documentation your IDP
provides. Look for topics that refer to configuring or defining a service provider for a
SAML connection, or adding an application.

Step 1: Export metadata from Tableau
To create the SAML connection between Tableau Cloud and your IdP, you need to
exchange required metadata between the two services. To get metadata from Tableau
Cloud, do either of the following steps. See the IdP’s SAML configuration documentation to
confirm the correct option.
l

Select Export metadata to download an XML file that contains the Tableau Cloud
SAML entity ID, Assertion Consumer Service (ACS) URL and X.509 certificate.

l

Select Download signing and encryption certificate if your IdP expects the
required information in a different way. For example, if it wants you to enter the
Tableau Cloud entity ID, ACS URL and X.509 certificate in separate locations.
The following image has been edited to show that these settings are the same in
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Tableau Cloud and Tableau Server.

Steps 2 and 3: External steps
For Step 2, to import the metadata you exported in step 1, sign in to your IdP account, and
use the instructions provided by the IdP’s documentation to submit the Tableau Cloud
metadata.
For Step 3, the IdP’s documentation will guide you also in how to provide metadata to a service provider. It will instruct you to download a metadata file, or it will display XML code. If it
displays XML code, copy and paste the code into a new text file, and save the file with a .xml
extension.

Step 4: Import IdP metadata to the Tableau site
On the Authentication page in Tableau Cloud, import the metadata file that you downloaded from the IdP or configured manually from XML it provided.

Step 5: Match attributes
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Attributes contain authentication, authorisation and other information about a user. In the
Identity Provider (IdP) Assertion Name column, provide the attributes that contain the
information Tableau Cloud requires.

Note: Tableau Cloud requires the NameID attribute in the SAML response. You can
provide other attributes to map usernames in Tableau Cloud, but the response message
must include the NameID attribute.

l

Email: (Required) Enter the name of the attribute that stores users’ email addresses.

l

Display name: (Optional but recommended) Some IDPs use separate attributes for
first and last names, and others store the full name in one attribute.
Select the button that corresponds to the way your IdP stores the names. For
example, if the IdP combines first and last name in one attribute, select Display
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name, and then enter the attribute name.

Step 6: Embedding options
Select the method by which users sign in to embedded views. The options are to open a separate pop-up window that displays the IdP’s sign-in form, or to use an inline frame (iframe).

236

Tableau Software

Tableau Cloud Help
Caution: Because iframes can be vulnerable to clickjacking attacks, not all IDPs support signing in through an iframe. With clickjacking, the attacker tries to lure users into
clicking or entering content. They do this by displaying the page to attack in a transparent layer over an unrelated page. For Tableau Cloud, an attacker might try to capture
user credentials or to get an authenticated user to change settings. For more information, see Clickjacking on the Open Web Application Security Project website.

If your IdP doesn’t support signing in through an iframe, select Authenticate in a separate
pop-up window.
See also Default authentication type for embedded views

Step 7: Troubleshooting
Start with the troubleshooting steps suggested on the Authentication page. If those steps do
not resolve the issues, see Troubleshoot SAML.

Manage users
Select existing Tableau Cloud users, or add new users you want to approve for single signon.
When you add or import users, you also specify their authentication type. On the Users page,
you can change users’ authentication type any time after adding them.

Default authentication type for embedded views
Part of enabling SAML on your site is to specify how users access views embedded in web
pages.
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l

Allow users to choose their authentication type
When you select this, two sign-in options appear where a view is embedded: a signin button that uses single sign-on authentication and a link to use TableauID as an
alternative.

Tip: With this option, users need to know which alternative to choose. As part of
notification you send your users after you add them to the single sign-on site, let
them know which type of authentication to use for a variety of sign-in scenarios.
For example, embedded views, Tableau Desktop, Tableau Bridge, Tableau
Mobile, and so on.

l

Tableau
This option requires users to sign in using a TableauID even if SAML is enabled on
the site. Generally it’s reserved for administrators for troubleshooting issues with
embedded views and SAML.

l

SAML
With this option, the way SAML users can sign in to embedded views is determined
by the setting you select in step 6 above.

Use TableauID authentication
If a site is configured for SAML, you can change the site settings to require some or all users
to sign in using TableauID credentials.
l

If you no longer want an identity provider to handle authentication for a site, or require
all users to sign in with their TableauID credentials, you can change authentication
type at the site level.

l
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If you want to keep SAML enabled for some users, but require others to use
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TableauID, you can change authentication type at the user level.
For more information, see Set the User Authentication Type.
Change the site’s authentication type

1. Sign in to Tableau Cloud as a site administrator and select the site.
2. Select Settings > Authentication.
3. For Authentication Type, select TableauID.
After you make the SAML configuration inactive, the metadata and IdP information are preserved, so that if you want to enable it again, you do not need to set up the SAML connection
with the IdP again.

See also
Access Sites from Connected Clients

Configure SAML with Azure Active Directory
If you’ve configured Microsoft Azure Active Directory (Azure AD) as your SAML identity provider (IdP), use the information in this topic alongside the Azure AD documentation to add
Tableau Cloud to your single sign-on applications. Completing the steps in this topic requires
Azure AD Premium edition.

Note: These steps reflect a third-party application and are subject to change without our
knowledge. If the steps described here do not match the screens you see in your IdP
account, you can use the general SAML configuration steps, along with the IdP’s documentation.
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Open the Tableau Online SAML settings
To use Azure AD with Tableau Cloud, you configure a custom application in the Azure
AD management portal. For this taskyou’llneed to use information from the Tableau Cloud
SAML settings.
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
select SAML and then select Edit connection.

Add Tableau Cloud to your Azure AD applications
Taking information from the Tableau Cloud SAML settings page, review and complete the
steps in the following Microsoft Azure articles:
l
l
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Configure SAML with AD FS
You can configure Active Directory Federation Services (AD FS) as a SAML identity provider, and add Tableau Cloud to your supported single sign-on applications. When you integrate AD FS with SAML and Tableau Cloud, your users can sign in to Tableau Cloud using
their standard network credentials.

Note: These steps reflect a third-party application and are subject to change without our
knowledge. If the steps described here do not match the screens you see in your IdP
account, you can use the general SAML configuration steps, along with the IdP’s documentation.

Prerequisites
Before you can configure Tableau Cloud and SAML with AD FS, your environment must
have the following:
l

A server running Microsoft Windows Server 2008 R2 (or later) with AD FS 2.0 (or
later) and IIS installed.

l

We recommend that you secure your AD FS server (for example, using a reverse
proxy). When your AD FS server is accessible from outside your firewall, Tableau
Cloud can redirect users to the sign in page hosted by AD FS.

l

A site administrator account that uses TableauID authentication. If SAML single signon fails, you can still sign in to Tableau Cloud as a site administrator.

Step 1: Export metadata from Tableau Cloud
1. Sign in to Tableau Cloud as a site administrator.
If you have more than one site for Tableau Cloud, select the site for which you want to
enable SAML in drop-down of the site.
2. Select Settings > Authentication.
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3. On the Authentication tab, select Enable an additional authentication method,
select SAML, and then click Edit Connection.

4. Under step 1, Export metadata from Tableau Cloud, click Export metadata to
download an XML file that contains the Tableau Cloud SAML entity ID, Assertion
Consumer Service (ACS) URL and X.509 certificate.

Step 2: Configure AD FS to accept sign-in requests from Tableau Cloud
Configuring AD FS to accept Tableau Cloud sign-in requests is a multi-step process, starting with importing the Tableau Cloud XML metadata file to AD FS.
1. Do one of the following to open the Add Relying Party Trust Wizard:
Windows Server 2008 R2:
a. Select Start menu> to Administrative Tools> AD FS 2.0.
b. In AD FS 2.0, under Trust Relationships, right-click the Relying Party
Trusts folder, and then click Add Relying Party Trust.
Windows Server 2012 R2:
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a. Open Server Manager, and then on the Tools menu, click AD FS Management.
b. In AD FS Managment, on the Action menu, click Add Relying Party Trust.
2. In the Add Relying Party Trust Wizard, click Start.
3. On the Select Data Source page, select Import data about the relying party
from a file, and then click Browse to locate your Tableau Cloud XML metadata file.
By default, this file is named samlspmetadata.xml.
4. Click Next, and on the Specify Display Name page, type a name and description for
the relying party trust in the Display name and Notes boxes.
5. Click Next to skip the Configure Multi-factor Authentication Now page.
6. Click Next to skip the Choose Issuance Authorisation Rules page.
7. Click Next to skip the Ready to Add Trust page.
8. On the Finish page, tick the Open the Edit Claim Rules dialog for this relying
party trust when the wizard closes box and then click Close.
Next, you’ll work in the Edit Claim Rules dialog, to add a rule that makes sure the assertions sent by AD FS match the assertions Tableau Cloud expects. At a minimum, Tableau
Cloud needs an email address. However, including first and last names in addition to email
will ensure the user names displayed in Tableau Cloud are the same as those in your AD
account.
1. In the Edit Claim Rules dialog box, click Add Rule.
2. On the Choose Rule Type page, for Claim rule template, select Send LDAP
Attributes as Claims, and then click Next.
3. On the Configure Claim Rule page, for Claim rule name, enter a name for the rule
that makes sense to you.
4. For Attribute store, select Active Directory, complete the mapping as shown
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below, and then click Finish.
The mapping is case sensitive and requires exact spelling, so double-check your
entries. The table here shows common attributes and claim mappings. Verify attributes with your specific Active Directory configuration.

Note: Tableau Cloud requires the NameID attribute in the SAML response. You
can provide other attributes to map usernames in Tableau Cloud, but the
response message must include the NameID attribute.

LDAP Attribute

Outgoing Claim Type

User-Principal-Name

email

Given-Name

firstName

Surname

lastName

If you are running AD FS 2016 or later, then you must add a rule to pass through all claim
values. If you are running an older version of AD FS, skip to the next procedure to export
AD FS metadata.
1.
2.
3.
4.

Click Add Rule.
Under Claim rule template, choose Pass Through or Filter an Incoming Claim.
Under Claim rule name, enter Windows.
On the Edit Rule - Windows pop-up:
l

Under Incoming claim type, select Windows account name.

l

Select Pass through all claim values.

l

Click OK.

Now you will export AD FS metadata that you’ll import to Tableau Cloud later. You will also
make sure the metadata is configured and encoded properly for Tableau Cloud, and verify
other AD FS requirements for your SAML configuration.
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1. Export AD FS Federation metadata to an XML file, and then download the file from
https://<adfs server name>/FederationMetadata/2007-06/FederationMetadata.xml.
2. Open the metadata file in a text editor like Sublime Text or Notepad++, and verify that
it is correctly encoded as UTF-8 without BOM.
If the file shows some other encoding type, save it from the text editor with the correct
encoding.
3. Verify that AD FS uses forms-based authentication. Sign-ins are performed in a
browser window, so you need AD FS to default to this type of authentication.
Edit c:\inetpub\adfs\ls\web.config, search for the tag and move the line so it
appears first in the list. Save the file so that IIS can automatically reload it.

Note: If you don't see the c:\inetpub\adfs\ls\web.config file, IIS is not installed
and configured on your AD FS server.

4. Configure an additional AD FS relying party identifier. This allows your system to work
around any AD FS issues with SAML logout.
Do one of the following:
Windows Server 2008 R2:
a. In AD FS 2.0, right-click on the relying party you created for Tableau Cloud
earlier, and click Properties.
b. On the Identifiers tab, in the Relying party identifier box, enter https://<tableauservername>/public/sp/metadata and then click Add.
Windows Server 2012 R2:
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a. In AD FS Management, in the Relying Party Trusts list, right-click on the
relying party you created for Tableau Cloud earlier, and click Properties.
b. On the Identifiers tab, in the Relying party identifier box, enter https://<tableauservername/public/sp/metadata and then click Add.

Note: AD FS can be used with Tableau Server for a single relying party to the
same instance. AD FS cannot be used for multiple relying parties to the same
instance, for example, multiple site-SAML sites or server-wide and site SAML
configurations.

Step 3: Import the AD FS metadata to Tableau Cloud
1. In Tableau Cloud, go back to the Settings > Authentication page.
2. Under 4 Import metadata file into Tableau Cloud, in the IdP metadata file box,
specify the name of the file you exported from AD FS (FederationMetadata.xml).
3. Skip 5. Match attributes.
You’ve already created a claim rule in AD FS to match the attribute names to what
Tableau Cloud expects.
4. Under 6. Manage users, do one of the following:
l

If you haven’t added Tableau Cloud users yet, click Add users.
You can then add users manually using the form, or import a CSV file that contains user information.

l
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Select the check box next to the users you want to allow to use SAML sign-in,
and then on the Actions menu select Authentication. Change the authentication method to SAML.

5. (Optional) Test SAML sign in, using the following steps:
a. Open a private window or session in your web browser.
For example, in Google Chrome, in the top right corner of the window click Customise and control Google Chrome > New incognito window, and then
navigate to https://online.tableau.com.
b. Enter the email address of the user. Tableau Cloud will remove the password
field if the user’s account is correctly set up for SAML authentication.
c. Click Sign in, and on the AD FS sign-in page, enter your AD credentials.
After you’re authenticated AD FS redirects you to Tableau Cloud.
Your Tableau Cloud site is now ready for users to sign in using AD FS and SAML. They still
navigate to https://online.tableau.com, but after entering their email address, the page
redirects to the AD FS sign-in page (as in the optional test step above), and prompts users
for their AD credentials.
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Note: If you get errors testing SAML sign-in, in step 7. Troubleshooting single signon (SSO) of the Tableau Cloud SAML configuration steps, click Download log file,
and use the information there to troubleshoot the error.

Additional requirements and tips
l

After you set up SAML integration between AD FS and Tableau Cloud, you must
update Tableau Cloud to reflect particular user changes you make in Active Directory. For example, adding or removing users.
You can add users automatically or manually:
o

To add users automatically: Create a script (using PowerShell, Python, or
batch file) to push AD changes to Tableau Cloud. The script can use tabcmd or
the REST API to interact with Tableau Cloud.

o

To add users manually: Sign in to the Tableau Cloud web UI, go to the
Users page, click Add Users, and enter users’ email addresses or upload a
CSV file that contains their information.

Note: If you want to remove a user but keep content assets they own, change
the owner of the content before you remove the user. Deleting a user also
deletes content they own.

l

In Tableau Cloud, a user’s email address is their unique identifier. As described in the
steps for configuring AD FS to accept sign-in requests from Tableau Cloud, users’
Tableau Cloud email addresses must match the email address stored in AD.

l

In Step 2: Configure AD FS to accept sign-in requests from Tableau Cloud, you
added a claim rule in AD FS to match the first name, last name and email address
attributes between AD FS and Tableau Cloud. Alternatively, you can use step 5.
Match attributes in Tableau Cloud to do the same.
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Configure SAML with OneLogin
If you use OneLogin as your SAML identity provider (IdP), you can use the information in this
topic to set up SAML authentication for your Tableau Cloud site.
These steps assume that you have permissions for modifying your organisation’s OneLogin
portal, and you are comfortable reading XML and pasting values into attributes.

Note: These steps reflect a third-party application and are subject to change without our
knowledge. If the steps described here do not match the screens you see in your IdP
account, you can use the general SAML configuration steps, along with the IdP’s documentation.

Step 1: Open the Tableau Cloud SAML Settings
1. Sign in to your Tableau Cloud site as a site admin, and select Settings > Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
select SAML and then select Edit connection.
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Step 2: Add Tableau Cloud to your OneLogin applications
1. Open a new browser tab or window, and sign in to your OneLogin admin portal and
do the following:
a. On the Applications page, select Add Apps. Search for Tableau, and in the
results, select Tableau Cloud SSO. In this area you configure the SAML connection.
Note: The Tableau Cloud SSO option for OneLogin does not work with
Tableau Server.
b. On the Info page, set up your portal preferences. If you have more than one
Tableau Cloud site, include the site name in the Display Name field to help
users know which site to select.

2. On the Configuration page in the OneLogin admin portal, you will use information
from 1 Export metadata from Tableau Cloud in the Tableau Cloud Authentication.
a. For Consumer URL, on Tableau Cloud's Authentication page, select and
copy the Assertion Consumer Service URL (ACS).
Return to OneLogin and paste the URL into the Consumer URL field.
b. For Audience, copy and paste the Tableau Cloud Entity ID from Tableau
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Cloud's Authentication page.

3. On the SSO page in the OneLogin admin portal, select SHA-256 for the SAML Signature Algorithm.
4. On the Parameters page in the OneLogin admin portal, make sure the values appear
as follows:
Tableau Cloud field

Value

Email

Email

Email (attribute)

Email

First Name

First Name
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Tableau Cloud field

Value

Last Name

Last Name

Step 3: Configure OneLogin metadata for Tableau Cloud
For the following steps, you'll find and configure OneLogin information for Tableau Cloud to
complete the SAML configuration.
1. While still in the OneLogin admin portal, on the SSO page, select and copy the URI
shown in the SLO Endpoint (HTTP) field.
Note: Although the label indicates HTTP, the URI provided is an https address,
because the SLO (single logout) endpoint uses SSL/TLS encryption.
2. On the same page, select More Actions > SAML Metadata, and save the file to
your computer.
You will import this file to Tableau Cloud in the next section.

Step 4: Complete the SAML configuration
1. On Tableau Cloud's Authentication page, do the following:
a. For 4 Import metadata file into Tableau Cloud, import the OneLogin
metadata file you saved in the previous section.
Important: If you encounter any issues with uploading the OneLogin
metadata file, consider using a non-default certificate with OneLogin. To create
a new certificate, from the OneLogin admin portal, select Security > Certificates. If you create a new certificate, ensure the Tableau Cloud application
in OneLogin uses this new certificate.
b. For 5 Match attributes, set the values in the IdP Assertion Name column
as follows:
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l
l
l
l

Email: Email
Select the First name, Last name radio button.
First name: FirstName
Last name: LastName

c. For 6 Embedding options, select the experience you want to enable when
users access embedded content. For more information, see the (Optional)
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Enable iFrame embedding section below
d. Skip 7 Troubleshooting single sign-on (SSO) for now.
2. Finally, add SAML users to your site and test the connection.

(Optional) Enable iFrame embedding
When you enable SAML on your site, you need to specify how users sign in to access views
embedded in web pages. These steps configure OneLogin to allow your OneLogin dashboard to be embedded into an inline frame (iFrame) on another site. Inline frame embedding may provide a more seamless user experience when signing-on to view embedded
visualisations. For example, if a user is already authenticated with your identity provider and
iFrame embedding is enabled, the user would seamlessly authenticate with Tableau Cloud
when browsing to pages that contain embedded visualisations.

Caution: Inline frames can be vulnerable to a clickjack attack. Clickjacking is a type of
attack against web pages in which the attacker tries to lure users into clicking or entering content by displaying the page to attack in a transparent layer over an unrelated
page. In the context of Tableau Cloud, an attacker might try to use a clickjack attack to
capture user credentials or to get an authenticated user to change settings. For more
information about clickjack attacks, see Clickjacking on the Open Web Application
Security Project website.

1. Open a new browser tab or window, and sign in to your OneLogin admin portal.
2. On the Settings menu, click Account Settings.
3. On the Basic page, in Framing Protection, tick the Disable Framing Protection
(X-Frame-Options) box.
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Configure SAML with PingOne
If you use PingOne as your SAML identity provider (IdP), you can use the information in this
topic to set up SAML authentication for your Tableau Cloud site.

Note: These steps reflect a third-party application and are subject to change without our
knowledge. If the steps described here do not match the screens you see in your IdP
account, you can use the general SAML configuration steps, along with the IdP’s documentation.

Get the Tableau Cloud metadata
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method >
SAML.

3. In Step 1, click Export metadata and save the metadata file to your computer.
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Configure the PingOne connection
1. Sign in to your PingOne account, and click the Applications tab.
2. In the Application Catalog search for Tableau Cloud.
3. On the Tableau Cloud item, click the arrow to expand the item, and then click Setup.

4. On the 1. SSO Instructions page, click Continue to Next Step.
5. On the 2. Configure your connection page, for Upload Metadata, click Select
File, and upload the metadata file you saved from Tableau Cloud. Click Continue to
Next Step.
6. In the table on the 3. Attribute Mapping page, map attributes as follows:
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Application Attribute

Identity Bridge Attribute

email

Email

firstName

First Name

lastName

Last Name

You can ignore the other settings in the table.

Click Continue to Next Step.
7. On 4. PingOne App Customisation, consider adding your Tableau Cloud site name
in the Name field. This is not required.
Click Save & Publish.
8. On 5. Review Setup, after reviewing the information you provided, click the Download link next to SAML Metadata, and save the metadata file to your computer.
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Support for single logout
When you import the Tableau Cloud metadata as part of the PingOne SAML configuration,
the certificate embedded in the metadata is not applied to the IdP application definition. This
can cause the following error when people sign out of the SAML site:
It looks like the signing certificate has not been configured.
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Configure the certificate for the IdP

To resolve the sign-out error, you can download the certificate from Tableau Cloud, convert
it from DER encoded to Base-64 encoded, and then upload it to PingOne.
These steps for converting the certificate are specific to Windows.
1. Return to the Settings > Authentication page in your Tableau Cloud site, and make
sure the Single sign-on with SAML box is ticked.
2. In Step 1, Export metadata file, click Download signing and encryption certificate
and save the .cer file to your computer.

3. Double-click the file you downloaded, click Open.
4. In the Certificate dialog box, select the Details tab and click Copy to File.
5. In the Certificate Export Wizard, do the following:
a. Click Next on the opening screen, and then select Base-64 encoded X.590
(.CER).
b. Click Next, and specify the name and location of the file you are exporting.
c. Click Next, review the summary information, and then click Finish.
6. In your PingOne account, return to the application setup pages for Tableau Cloud.
7. In Step 2. Configure your connection, for Verification Certificate, click Choose
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File, and upload the new .cer file you created.

Complete the Tableau Cloud site configuration
Complete the following steps after you configure your PingOne account and download the
SAML metadata file from PingOne, as described in Configure the PingOne connection
earlier in this topic.
1. Return to the Settings > Authentication page in your Tableau Cloud site.
2. For SAML configuration step 4, for IdP metadata file, click Browse and import the
metadata file you downloaded from your PingOne account.
3. Continue to Step 5: Match attributes, and complete the remaining steps as described.

Configure SAML with Okta
If you use Okta as your SAML identity provider (IdP), you can use the information in this
topic to set up SAML authentication for your Tableau Cloud site.
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Note: These steps reflect a third-party application and are subject to change without our
knowledge. If the steps described here do not match the screens you see in your IdP
account, you can use the general SAML configuration steps, along with the IdP’s documentation.

Open the Tableau Cloud SAML settings
To configure the Okta application, you will need to use information in the Tableau Cloud
SAML settings.
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
select SAML and then select Edit connection.

Add Tableau Cloud to your Okta applications
1. Open a new browser tab or window, and sign in to your Okta administrator console.
2. On the Applications tab, click the Add Application button. Search for Tableau, and
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then add the Tableau Cloud application.
This opens the General Settings tab.
3. (Optional) If you have more than one Tableau Cloud site, include the site name in the
Application label field, to help users know which site to select when they sign in.
4. Click Done to open the Assignments tab.
5. Click Assign > Assign to People and click the Assign button beside each user you
want to approve for single sign-on access to Tableau Cloud.
6. Click Done. Make sure users’ email addresses appear in the Username field.
7. Select the Sign On tab. In the Settings section, click Edit.
8. Switch to the tab or window where you opened the Tableau Cloud SAML configuration settings, and in Step 1 of those settings, select and copy the Tableau
Cloud entity ID.

Note: The Tableau Cloud SAML configuration settings appear in a different
order than on the Okta settings page. To prevent SAML authentication issues,
make sure that the Tableau Cloud entity ID and Assertion Consumer Service (ACS) URL are entered into the correct fields in Okta.

9. Return to the Okta admin console general settings, and paste the URL into the corresponding field.
10. Repeat the previous two steps for the Assertion Consumer Service (ACS) URL.
Click Save.
11. Right-click Identity Provider Metadata and click Save link as to download the
metadata XML file.
12. Click View Setup Instructions and complete the steps to import the IdP metadata,
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provide the IdP entity ID and SSO service URL, and match email and display name
attributes. Switch to the tab or window where you opened the Tableau Cloud SAML
configuration settings. Note: When importing the Okta metadata file into Tableau
Cloud, it might be necessary to refresh the page after clicking Apply to see the
changes.

(Optional) Enable iFrame embedding
When you enable SAML on your site, you need to specify how users sign in to access views
embedded in web pages. These steps configure Okta to allow authentication using an inline
frame (iFrame) for embedded views. Inline frame embedding may provide a more seamless
user experience when signing-on to view embedded visualisations. For example, if a user is
already authenticated with your identity provider and iFrame embedding is enabled, the user
would seamlessly authenticate with Tableau Server when browsing to pages that contain an
embedded visualisations.

Caution: Inline frames can be vulnerable to a clickjack attack. Clickjacking is a type of
attack against web pages in which the attacker tries to lure users into clicking or entering
content by displaying the page to attack in a transparent layer over an unrelated page. In
the context of Tableau Cloud, an attacker might try to use a clickjack attack to capture
user credentials or to get an authenticated user to change settings. For more information about clickjack attacks, see Clickjacking on the Open Web Application Security Project website.

1. Open a new browser tab or window, and sign in to your Okta administrator console.
2. On the Home page, click Admin to open the Administrator Dashboard.
3. On the Settings menu, click Customisation.
4. Under iFrame Embedding, select Allow iFrame embedding.
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Add users to the SAML-enabled Tableau site
1. After you complete the Okta configuration steps, return to your Tableau Cloud site.
2. Complete the SAML connection by adding the users you assigned in the Okta admin
console to Tableau Cloud.

Configure SAML with Salesforce
If you’ve configured Salesforce as your SAML identity provider (IdP), use the information in
this topic alongside the Salesforce documentation to add Tableau Cloud to your single signon applications.

Open the Tableau Cloud SAML settings
To configure the Salesforce application, you will need to use information in the Tableau
Cloud SAML settings.
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
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select SAML and then select Edit connection.

Configure SSO from Salesforce to Tableau Cloud
See the Salesforce documentation, Configure SSO from Salesforce to Tableau Cloud.

Add users to the SAML-enabled Tableau site
1. After you complete the Salesforce configuration steps, return to your Tableau Cloud
site.
2. Complete the SAML connection by adding the users you assigned in the Salesforce
Application Profile Assignment page to Tableau Cloud. On the Authentication page,
scroll down to Manage users to add or select users.

Configure SAML for Tableau Viz Lightning Web Component
Tableau provides a Lightning Web Component (LWC) for embedding a Tableau visualisation within a Salesforce Lightning page.
This topic describes how to enable a SSO experience for embedded Tableau visualisations
in a Salesforce Lightning page. SSO for the Tableau Viz LWC scenario requires SAML con-
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figuration. The SAML IdP used for Tableau authentication must be either the Salesforce
IdP or same IdP that is used for your Salesforce instance.
In this scenario, Salesforce administrators can drag-and-drop Tableau Viz LWC into the
Lightning page to embed a visualisation. Any view that is available to them on Tableau
Cloud can be displayed in the dashboard by entering the embedded URL to the view.
When single sign-on (SSO) is configured for Tableau Viz LWC on Tableau Cloud, the user
experience is seamless: after the user signs in to Salesforce, embedded Tableau views will
work without further authentication to Tableau Cloud.
When SSO is not configured, users will need to re-authenticate with Tableau Cloud to view
embedded visualisations from Tableau Cloud.

Note: Users configured with Salesforce Authentication will need to reauthenticate with
Tableau Cloud to view embedded visualisations in Tableau Cloud.

Requirements
l

The SAML IdP used for Tableau authentication must be either the Salesforce IdP or
same IdP that is used for your Salesforce instance.

l

SAML must be configured on Tableau Cloud. See Enable SAML Authentication on a

l

Site.
SAML must be configured for Salesforce.

l

Install the Tableau Viz Lightening Web Component. See Embed Tableau Views into

Salesforce.

Configuring the authentication workflow
You may need to make additional configurations to optimise the sign-in experience for users
who access Lightning with embedded Tableau views.
If a seamless authentication user experience is important, then you will need to make some
additional configurations. In this context, “seamless” means that users who access the
Salesforce Lightning page where Tableau Viz LWC SSO has been enabled, will not be
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required to perform any action to view the embedded Tableau view. In the seamless scenario, if the user is logged into Salesforce, then embedded Tableau views will be displayed
with no additional user action. This scenario is enabled by in-frame authentication.
For a seamless user experience, you will need to enable in-frame authentication on Tableau
Cloud and at your IdP. The sections below describe how to configure in-frame authentication.
On the other hand, there are scenarios where users are interacting with the Lightning page
that will require them to click a “Sign in” button to view the embedded Tableau view. This
scenario, where a user must take another action to view the embedded Tableau view, is
called pop-up authentication.

Pop-up authentication is the default user experience if you do not enable in-frame authentication.

Enable in-frame authentication on Tableau Cloud
Before you enable in-frame authentication on Tableau Cloud, you must have already configured and enabled SAML.
1. Sign in to your Tableau Cloud site as a site administrator, and select Settings >
Authentication.
2. On the Authentication tab, select Enable an additional authentication method,
select SAML and then select Edit connection.
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3. Scroll down to Embedding options and select Authenticate using an inline
frame.

Caution: Inline frames can be vulnerable to a clickjack attack. Clickjacking is a type of
attack against web pages in which the attacker tries to lure users into clicking or entering content by displaying the page to attack in a transparent layer over an unrelated
page. In the context of Tableau Cloud, an attacker might try to use a clickjack attack to
capture user credentials or to get an authenticated user to change settings. For more
information about clickjack attacks, see Clickjacking on the Open Web Application
Security Project website.

Enable in-frame authentication with your SAML IdP
As described above, a seamless authentication user experience with Salesforce Mobile
requires IdP support for in-frame authentication. This functionality may also be referred to
as “iframe embedding” or “framing protection” at IdPs.
Salesforce safelist domains

In some cases, IdPs only allow enabling in-frame authentication by domain. In those cases,
set the following Salesforce wildcard domains when you enable in-frame authentication:
*.force
*.visualforce
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Salesforce IdP

Salesforce IdP supports in-frame authentication by default. You do not need to enable or configure in-frame authentication in the Salesforce configuration. However, you must configure
Tableau Cloud for in-frame authentication as described above.
Okta IdP

See Embed Okta in an iframe, in the Okta Help Centre topic, General customisation options.
Ping IdP

See the Ping support topic, How to Disable the "X-Frame-Options=SAMEORIGIN" Header
in PingFederate.
OneLogin IdP

See Framing protection, in the OneLogin Knowledge Base article, Account Settings for
Account Owners.
ADFS and Azure AD IdP

Microsoft has blocked all in-frame authentication and it cannot be enabled. Instead, Microsoft
only supports pop-up authentication in a second window. As a result, pop up behaviour can
be blocked by some browsers, which will require users to accept pop ups for the force.com and visualforce.com sites.

Salesforce Mobile App
If your users primarily interact with Lightning on the Salesforce Mobile App, then you should
be aware of the following scenarios:
l

The Salesforce Mobile App requires that you configure SSO/SAML to view embedded

l

Tableau.
The Salesforce Mobile App requires in-frame authentication. Pop-up authentication
does not work. Instead, users on the Salesforce Mobile App will see the Tableau sign-

l

in button but will not be able to sign to Tableau.
Mobile App will not work on ADFS and Azure AD IdP.
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l

Users with Android devices will be required to sign-in to view the embedded Tableau
visualisation the first time, then SSO will work as expected.

Troubleshoot SAML
This topic provides information about resolving issues that can occur when you configure
SAML authentication.

Required assertions and metadata do not map correctly
Most issues occur because metadata that you import from the IdP, or assertion names that
you enter, do not match the corresponding IdP attributes. To troubleshoot SAML issues,
start by making sure the information shown in Steps 1 to 5 of the Authentication page
matches the IdP SAML configuration settings.
Tableau Cloud requires the IdP assertion that contains user email address. In addition to
checking Steps 1 to 5, make sure that users' email addresses match between Tableau
Cloud and the IdP.

Identity provider does not display sign-in page
A user provides his or her user name on the Tableau Cloud sign-in page, Tableau Cloud
redirects the request to the identity provider (IdP), but the IdP does not return its SAML
sign-in page. The IdP can fail to return the sign-in page for any of the following reasons:
l

SSO service URL is not valid.
When you import the IdP metadata, make sure the SSO Service URL field shows the
correct URL.

l

The IdP does not recognise the authentication request received.
For example, the Tableau Cloud entity ID may be incorrect. This can occur if
SAML configuration settings on the Authentication page have become corrupted or
inadvertently changed.

To resolve the issue, repeat Steps 3 to 4 of the SAML configuration:
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1. Sign in to your IdP account and export the IdP metadata
2. Sign in to Tableau Cloud, display the Authentication page, and in Step 4, re-import
the metadata.

Nothing happens after IdP sign-in
If a user provides incorrect credentials on the IdP sign-in page, or if the user is not authorised
to use SAML, some IdPs will not return control to Tableau Cloud when authentication fails.
In Tableau Cloud, on the Users page, you can see whether a user is authorised for SAML
authentication.

Full Name field shows users’ email addresses
For a SAML site, the Full Name field is populated with the email address if the assertions for
first and last name or full name are not provided in Step 5 of the Authentication page.

Unable to authenticate users when using single sign-on
SAML authentication takes place outside Tableau Cloud, so troubleshooting authentication
issues can be difficult. However, login attempts are logged by Tableau Cloud. You can create a snapshot of log files and use them to troubleshoot problems.
If a user is having trouble being authenticated on Tableau Cloud, you should examine the log
file to ensure that email attribute values returned by the IdP match the email addresses of
users.
To download the log file:
1. Sign in to Tableau Cloud.
2. Display the Authentication page, and then under Step 7, click Download log file.
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Signing In through Command Line Utilities
SAML is not used for authentication when you sign in to Tableau Cloud using tabcmd or the
Tableau Data Extract command line utility (provided with Tableau Desktop), even if
Tableau Cloud is configured to use SAML. These tools require TableauID authentication
configured when Tableau Cloud was originally provisioned.

Personal Access Tokens
Personal access tokens (PATs) provide Tableau Cloud users the ability to create long-lived
authentication tokens. The tokens allow users to run automation with Tableau REST APIs
without requiring hard-coded credentials or interactive sign-in. More information about
using personal access tokens with Tableau REST APIs can be found at Signing In and Out
(Authentication).
Personal access tokens are not used for generic client access to Tableau Cloud. To use personal access tokens with tabcmd, install the new version of tabcmd from https://tableau.github.io/tabcmd/.
Note: You must use a PAT, instead of username and password, to make a REST API signin request to Tableau Cloud with multi-factor authentication (MFA) enabled with Tableau
authentication.
We recommend creating personal access tokens for automated scripts and tasks that are
created with Tableau REST API:
l

Improve security: Personal access tokens reduce risk in the event that credentials
are compromised. In the case where Tableau Server uses Active Directory as an
identity store, you can reduce the scope of credential compromise by using a personal access token for automated tasks. In this case, using an application-specific
token doesn't expose the broader system in the event that automation or script files
are compromised. If a token gets compromised or is used in automation that is failing
or posing a risk, you can just revoke the token. You do not need to rotate or revoke
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the user's credentials.
l

Manage automation: A token can be created for each script or task that is run. This
allows you to silo and review automation tasks across your organization. Additionally,
by using tokens, password resets or metadata changes (username, email, etc.) on
user accounts will not disrupt automation as it would when credentials are hard-coded
into the scripts.

Understand personal access tokens
When a token is created, it is hashed then stored in the repository. After the token is hashed
and stored, the original token is deleted. Users are instructed to copy the token to a safe
place and to handle it as they would a password. When the token is used at run time,
Tableau Cloud hashes the token presented by the user and compares it to the hashed value
stored in the repository. If a match is made, then an authenticated session is started.

Note: One personal access token is required per concurrent request. Signing in again
with the same access token, whether at the same site or a different site, will terminate
the previous session and result in an authentication error.

In the context of authorisation, Tableau Cloud handles the authenticated session with same
permissions and rights that the user has as an interactive user.

Create tokens
Users with accounts on Tableau Cloud can create, manage and revoke personal access
tokens on the My Account Settings page. For more information, see Manage Your
Account Settings in the Tableau Help.
Users must create their own personal access tokens. Site admins can't create tokens on
behalf of their users.
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Token expiry
Personal access tokens will expire if they are not used after 15 consecutive days. If they are
used more frequently than every 15 days, an access token will expire after 1 year. After a
year, you must create a new token. These expiry values are not configurable. Expired personal access tokens will not display on the My Account Settings page.

Revoke users' tokens
Users are able to revoke their own tokens on the My Account Settings page. As an administrator, you can also revoke personal access tokens.
1. Sign in to Tableau Cloud using your site admin credentials and navigate to the Users
page.
2. Locate the user whose token you want to revoke. For more information about navigating Server Admin pages and locating users, see View, Manage or Remove

Users.
3. Click the user's name to open their profile page.
4. On the user's profile page, click the Settings tab.
5. In the Personal Access Tokens section, identify the token that you want to revoke
and then click Revoke.

6. On the verification pop-up, click Delete.

Use Tableau Connected Apps for Application Integration
Beginning in early January 2022, Tableau connected apps enable a seamless and secure
authentication experience by facilitating an explicit trust relationship between your Tableau
Cloud site and external applications where Tableau content is embedded. In June 2022,
Tableau connected apps extended their capabilities to support REST API authorisation.
There are two types of connected apps you can configure: direct trust or OAuth 2.0 trust.
Using direct trust, you can:
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l

Restrict access to which content can be embedded and where that content can be
embedded

l

Provide users with the ability to access embedded content using single sign-on (SSO)
without having to integrate with an identity provider (IdP)

l

Provide users with the ability to authenticate directly from your external application

l

Programmatically authorise access to Tableau REST API on users' behalf using
JSON Web Token (JWT)

l

Scope Tableau REST API capabilities users or applications can perform
For more information about this connected app type, see Configure Connected Apps
with Direct Trust.

(Coming soon) Using OAuth 2.0 trust, you can:
l

Restrict access to which content can be embedded and where that content can be
embedded

l

Provide users the ability to access embedded content using single sign-on (SSO)
through your identity provider (IdP)

l

Provide access using standard OAuth 2.0 standard protocol

l

Programmatically authorise access to Tableau REST API on users' behalf

l

Scope Tableau REST API capabilities users or applications can perform
For more information about this connected app type, see Configure Connected Apps
with OAuth 2.0 Trust.

Note: Tableau-connected apps and Salesforce-connected apps are different and offer different functionality. Today, Tableau-connected apps are optimised for embedding Tableau
views and metrics in external applications and used to authorise access to the Tableau
REST API.
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Configure Connected Apps with Direct Trust
beginning in early January 2022, Tableau connected apps enable a seamless and secure
authentication experience by facilitating an explicit trust relationship between your Tableau
Cloud site and external applications to:
l

Restrict access to which content can be embedded and where that content can be

l

embedded
Provide users with the ability to access embedded content using single sign-on (SSO)

l
l

without having to integrate with an identity provider (IdP)
Provide users with the ability to authenticate directly from your external application
Programmatically authorise access to the Tableau REST API on users' behalf using a
JSON Web Token (JWT)

How connected apps work

The trust relationship between your Tableau Cloud site and external application is established and verified through an authentication token in the JSON Web Token (JWT) standard, which uses a shared secret provided by the Tableau-connected app and signed by
your external application.
Key components of a connected app

The following components of the connected work together with the JWT in your external
application to authenticate users and display embedded content.
l

l

l
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Secrets: Secrets are keys shared by Tableau and your external application. They
are used in signatures that form the JWT. A secret is required when using connected
apps for embedding authentication or REST API authorisation. Secrets can be created in a connected app, do not expire and remain valid until deleted.
Domain allowlist (embedding workflows only): You can specify a list of allowed
domains in each connected app. Tableau content embedded through a connected
app is only allowed under the specified domains. This helps ensure that content is
exposed under the domains that are secured and approved by your business.
Access level (embedding workflows only): You can specify what content can be
embedded through a connected app by associating a connected app with one project
or all projects. If you specify one project, only the content in the selected project can
be embedded through the connected app.
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Note: If your connected app is running in a container, such as an EC2 instance, both the container and the host clocks must be set to UTC in order for the session token to be valid. If
either clock uses a different standard, the connected app will not be trusted.
Connected app workflow

Embedding workflows
The diagram below illustrates how authentication works between your external application
(web server and web page) and connected app.

1. User visits the web page: When a user visits the embedded content on a web page,
the web page sends a GET request to your external application to retrieve the HTML
on that web page.
2. external application constructs an authentication token: The external application constructs a JWT, which contains a secret from the connected app (see Step 3
below for additional JWT requirements) and the scope of user access for the embedded content. The secret is signed by external application and is used for verification of
the trust relationship in a later step.
3. external application responds with authentication token: The external application responds to the page with the JWT in the embedded content’s URL called by the
web page.
4. Webpage requests content from Tableau: With the attempt to load the embedded
content, the webpage calls the embedded content’s URL, which sends a GET request
to Tableau.
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5. Tableau validates the token: Tableau receives the JWT and verifies the trust relationship with the external application by identifying the connected app and shared
secret used in the JWT. Then Tableau creates a session for the user. The session not
only respects the embedding scopes defined in the JWT, but also the restrictions specified in the connected app, including the allowed domains and allowed projects.
6. Tableau returns the content based on the restricted embedding context: The
embedded content only loads when the page is under an allowed domain and the content is published to an allowed project (if applicable). The authenticated user can only
interact with the embedded content by the scope defined in the JWT.
Create a connected app
Step 1: Create a connected app

Create a connected app from Tableau Cloud’s Settings page.
1. As a site admin, sign in Tableau Cloud.
2. From the left pane, select Settings > Connected Apps.
3. Click the New Connected App button drop-down arrow and select Direct Trust.
4. In the Create Connected App dialog box, do one of following:
a. For REST API authorisation workflows, in the Connected app name text box,
enter a name for the connected app and click the Create button.
Note: You can ignore Access level and Domain allowlist when configuring
a connected app for REST API authorisation.
b. For embedding workflows, do the following:
i. In the Connected app name text box, enter a name for the connected
app.
ii. From the Applies to drop-down menu, select All project or Only one
project to control which views or metrics can be embedded. If you
select the "Only one project" option, select the specific project to scope
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to.
iii. In the Domain allowlist, specify the domains using the rules described in
Domain formatting below to control where views or metrics can be
embedded.
iv. When finished, click the Create button.

5. Next to the connected app's name, click on the actions menu and select Enable. For
security purposes, a connected app is set to disabled by default when created.

6. Make note of the connected app’s ID, also known as the client ID, to use in Step 3
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below.

Step 2: Generate a secret

You can generate a total of two secrets for each connected app. The second secret can be
used for secret rotation purposes to help protect against issues if a secret is compromised.
1. On the detail page of the connected app you created in Step 1, click the Generate
New Secret button.
2. Make note of the secret ID and secret value to use in Step 3 below.

Step 3: Configure the JWT

After you’ve generated a secret, you want to enable your external application to send a valid
JWT. JWT is a standard used to securely transfer information between two parties. The
JWT is signed by your external application to securely send information to Tableau Cloud.
The JWT references the connected app, the user that the session is being generated for
and the level of access the user should have.
A valid JWT includes the following information:
l

Connected app ID, also known as the client ID, from Step 1

l

Secret ID and secret value generated in Step 2

l

Registered claims and header:
Claim
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"kid"

Required (in header). The connected app's secret key iden-

(Secret ID)

tifier.

"iss"

Required (in header). Unique issuer URI that identifies the

(Issuer)

trusted connect app and its signing key.

"alg"

Required (in header). JWT signing algorithm. Only HS256 is

(Algorithm) supported.
"sub" (Sub- Username (email address) of the authenticated Tableau
ject)

Cloud user.

"aud"

Value must be: "tableau"

(Audience)
"exp"

A valid JWT must not have expired. The expiry time (in UTC)

(Expiry

of the JWT must be within the maximum validity period,

Time)

which is 10 minutes.

"jti"

Required as a claim. The JWT ID claim provides a unique

(JWT ID)

identifier for the JWT and is case sensitive.

"scp"

For embedding workflows, supported values include:

(Scope)

"tableau:views:embed"
"tableau:views:embed_authoring"
"tableau:metrics:embed"
Notes:
l

Values must be passed as a list type.

l

For tableau:views:embed and tableau-

:views:embed_authoring, the scope respects
users’ permissions already configured in Tableau
Cloud and allows users to interact with the tools in the
l

embedded view if available in the original view.
We recommend that the embed code excludes the toolbar parameter. For more information see Known
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issues (embedding workflows only) below.
For REST API authorisation workflows, see REST API methods that support JWT authorisation.

Example JWTs
Here are example JWTs in both Java and Python languages. The Java and Python
examples use the nimbus-jose-jwt library and the PyJWT library, respectively.
Java
import com.nimbusds.jose.*;
import com.nimbusds.jose.crypto.*;
import com.nimbusds.jwt.*;
import java.util.*;
...
String secret = "secretvalue";
String kid = "connectedAppSecretId";
String clientId = "connectedAppClientId";
List<String> scopes = new
ArrayList<>(Arrays.asList("tableau:views:embed"));
String username = "user@domain.com";
JWSSigner signer = new MACSigner(secret);
JWSHeader header = new
JWSHeader.Builder(JWSAlgorithm.HS256).keyID(kid).customParam
("iss", clientId).build();
JWTClaimsSet claimsSet = new JWTClaimsSet.Builder()
.issuer(clientId)
.expirationTime(new Date(new Date().getTime() + 60 * 1000))
//expires in 1 minute
.jwtID(UUID.randomUUID().toString())
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.audience("tableau")
.subject("username")
.claim("scp", scopes)
.build();
SignedJWT signedJWT = new SignedJWT(header, claimsSet);
signedJWT.sign(signer);
model.addAttribute("token", signedJWT.serialize());
Python
import jwt
token = jwt.encode(
{
"iss": connectedAppClientId,
"exp": datetime.datetime.utcnow() + datetime.timedelta
(minutes=5),
"jti": str(uuid.uuid4()),
"aud": "tableau",
"sub": user,
"scp": ["tableau:views:embed", "tableau:metrics:embed"]
},
connectedAppSecretKey,
algorithm = "HS256",
headers = {
'kid': connectedAppSecretId,
'iss': connectedAppClientId
}
)
After you’ve configured the JWT, when the code is run by your external application, it will generate a token.
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Step 4: Next steps

For embedding workflows
After the JWT has been configured, you must add embed code to your external application.
Ensure that you include the valid JWT you configured in Step 3 above in the web component that your external application calls.
For more information about embedding Tableau content, see one or both of the following:
l

Embed metrics, see Embed Metrics into Webpages topic in the Tableau Help.

l

Embed Tableau views and metrics using the Tableau Embedding API v3.

Note: For users to successfully authenticate when they access embedded content,
browsers must be configured to allow third-party cookies.

For REST API authorisation workflows
After the JWT has been configured, you must add the valid JWT to the REST API Sign In
request for authorised access. For more information, see Access Scopes for Connected
Apps.
Manage a connected app

The Connected Apps page is where you can manage all the connected apps for your site.
You can perform tasks such creating, deleting and disabling connected apps, and revoking
or generating new secrets if existing secrets have been compromised.
1. As a site admin, sign in to Tableau Cloud.
2. From the left pane, select Settings > Connected Apps.
3. Tick the box next to the connected app you want to manage and do one or more of
the following:
l

Generate a new secret according to the rotation timeline specified by your
organisation’s security policies. To generate an additional secret, click on the
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name of the connected app and then click the Generate New Secret button. A
connected app can have a maximum of two secrets. Both secrets can be active
at the same time, do not expire and remain valid until deleted.
l

Review the connected app details by clicking the name of the connected app
to see when the connected app was created, its ID, project and domain scopes,
and its secrets.

l

Change the project scope or domain by selecting Edit in the Actions menu.
Make your changes and click Update.
Note: If you change the project or domain scopes and the embedded content
doesn’t exist in either the new project or new domain, the embedded view or
metric is unable to display and users will see an error when accessing the
embedded content.

l

Delete a secret by clicking the connected app's name. On the connected app’s
page, click Actions next to the secret and select Delete. In the confirmation dialog box, select Delete again.
Note: If the connected app’s secret is being used by an external application, the
embedded view or metric is unable to be displayed after the secret is deleted.
For more information, see Effects of disabling or deleting a connected app, or
deleting a secret below.

l

Disable a connected app by selecting Disable in the Actions menu. If the connected app is being used by an external application, the embedded view or metric is unable to be displayed after the connected app is disabled. For more
information, see Effects of disabling or deleting a connected app, or deleting a
secret below.
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Effects of disabling or deleting a connected app, or deleting a secret

To display embedded content to your user or enable REST API access through a connected app, the connected app must be enabled and its secret generated. If the connect
app is being used in your external application and is either disabled or deleted, or its secret
deleted or replaced, users will get a 403 error.
To avoid this issue, ensure the connected app is enabled and the JWT is using the correct
secret ID and value.
Domain allowlist rules (embedding workflows only)

The connected app’s domain allowlist enables you to restrict access to embedded Tableau
content to all domains or some domains, or to exclude some domains or block all domains.
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Domain options
You can select one of two options when configuring a connected app’s domain allowlist:
l

l

All domains: As the default option, this option enables unrestricted access to embedded content.
Only specific domains: This option gives you the ability to scope down access to
embedded content. If you use this option, follow the formatting rules specified in the following section, Domain formatting.

Domain formatting
In the domain allowlist text box, you can enter one domain, multiple domains or no domains
at all. The domain allowlist respects any formatting allowed by the CSP (Content Security
Policy) framework’s frame-ancestors header.
Note: Domain formatting rules also apply when using the Connect App methods in the
Tableau REST API.
Here are some formatting examples based on common scenarios:
To specify...

Example

Embedding access

Range of

*.myco.com

Embedded content is accessible from all

domains

subdomains under myco.com.

Multiple discrete myco.com

Embedded content is accessible from all

domains

events.myco.com three domains.
ops.myco.com

No domains

[no domains]

Access to embedded content is blocked.

Known issues (embedding workflows only)

There are a couple of known issues when using connected apps that will be addressed in a
future release.
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l

Toolbar features: When embedded content has the toolbar parameter defined, not
all toolbar features will work. To work around this issue, we recommend you hide the
toolbar parameter like in the example below.
<tableau-viz id='tab-viz' src='https://online.tableau.com/t/<your_site>/...'
toolbar='hidden'>
</tableau-viz>

l

l

Published data sources: Published data sources set to Prompt User for database
credentials will not display. To work around this issue, if possible, we recommend
data source owners embed their database credentials instead.

Ask Data objects in embedded dashboards: Ask Data objects in embedded
dashboards will not load.

l

Metrics and domain allowlists: Embedded metrics views will be displayed despite
access restrictions that might be specified in the connected apps' domain allowlists.
Note: Metrics data accessed from toolbars of embedded views will work as expected.

Configure Connected Apps with OAuth 2.0 Trust
(Coming soon) As a Tableau Cloud site admin, you can register an external authorisation
server (EAS) to establish a trust relationship between your Tableau Cloud site and the EAS
using the OAuth 2.0 standard protocol. By establishing a trust relationship, you’re able to:
l

Provide your users with a single sign-on (SSO) experience to Tableau content embedded in your external applications through the identity provider (IdP) you’ve already

l

configured for your Tableau Cloud site
Programmatically authorise access to the Tableau REST API on users' behalf using a
JSON Web Token (JWT)

When embedded Tableau content is loaded in your external application, a standard OAuth
flow is used. After users successfully sign in to the IdP, they are then automatically signed in
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to Tableau Cloud. Follow the steps described below to register your EAS with your Tableau
Cloud site.
Important:
l

Some of the procedures in this topic require configuration with third-party software and
services. We’ve made a best effort to verify the procedures to enable the EAS feature
on Tableau Server. However, third-party software and services might change or your
organisation might differ. If you encounter issues, refer to your third-party doc-

l

umentation for authoritative configuration details and support.
If your connected app is running in a container, such as an EC2 instance, both the container and the host clocks must be set to UTC in order for the session token to be valid.
If either clock uses a different standard, the connected app will not be trusted.

Step 1: Before you begin

To register an EAS with your Tableau Cloud site, you must have an EAS already configured.
In addition, the EAS must send a valid JSON Web Token (JWT) that contains the registered
claims and header listed in the table below.
Claim

Description or required value

"kid" (Key Required (in header). A unique key identifier from the identity proID)

vider.

"iss"

Required (in header or as a claim). Unique issuer URI, in HTTPS,

(Issuer)

that identifies the trusted connect app and its signing key.

"alg"

Required (in header). JWT signing algorithm. Supported algorithm

(Algorithm) names are listed in the Class JWSAlgorithm page in the javadoc.io
documentation.
"sub" (Sub- Username (email address) of the authenticated Tableau Cloud
ject)

user.

"aud"

Value must be: "tableau:<site_luid>"

(Audience)

To obtain the site LUID, you can use the Tableau REST API's Sign
In method or follow the steps below to copy the site LUID. Note:
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You must register an EAS using the procedure described here
before you can copy the site LUID.
1. Select Settings > Connected Apps and then select the
External Authorisation Server connected app.
2. Click the Copy Site LUID button.

"exp"

A valid JWT must not have expired. The expiry time (in UTC) of the

(Expiry

JWT must be within the maximum validity period, which is 10

Time)

minutes.

"jti"

The JWT ID claim provides a unique identifier for the JWT and is

(JWT ID)

case sensitive.

"scp"

For embedding workflows, supported values include:

(Scope)

"tableau:views:embed"
"tableau:views:embed_authoring"
"tableau:metrics:embed"
Notes:
l

Values must be passed as a list type.

l

For tableau:views:embed, the scope respects users’
permissions already configured in Tableau Cloud and allows
users to interact with the tools in the embedded view if avail-

l

able in the original view.
We recommend that the embed code excludes the toolbar
parameter. For more information see Known issues (embed-

ding workflows only) below.
For REST API authorisation workflows, see REST API methods
that support JWT authorisation.
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Note: The JWT claims above are documented in the Registered Claim Names section in the
documentation distributed by the Internet Engineering Task Force (IETF) organisation.
Step 2: Register your EAS with Tableau Cloud

By registering your EAS with Tableau Cloud, you establish a trust relationship between the
EAS and your Tableau Cloud site. This means when users access Tableau content embedded in your external application, they are redirected to authenticate with the IdP. The EAS
generates the authentication token, which is passed to Tableau Server for verification. After
the trust relationship is verified, access to the embedded content is granted to users.
Note: Some EASs support the option to display a consent dialog that asks for users’
approval for the application to access Tableau content. To ensure the best experience for
your users, we recommend you configure your EAS to automatically consent to the external
application’s request on users’ behalf.
1. As a site admin, sign in to Tableau Cloud.
2. From the left pane, select Settings > Connected Apps.
3. Click the New Connected App button drop-down arrow and select OAuth 2.0 Trust.
4. In the Create Connected App dialog box, do one of the following:
a. In the Issuer URL text box, paste the issuer URL of the EAS.
b. Select the Enable connected app. For security purposes, a connected app is
set to disabled by default when created.
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c. When finished, click the Create button.

5. Make note of the connected app’s ID, also known as the client ID, to use in Step 3
below.

Step 3: Next steps

For embedding workflows
After configuring your Tableau Cloud site to use your EAS, you must add embed code to
your external application. Ensure that you include the valid JWT generated by your EAS, as
described in Step 1, in the web component that your external application calls.
For more information about embedding Tableau content, see one or both of the following:
l

Embed metrics, see Embed Metrics into Webpages topic in the Tableau Help.

l

Embed Tableau views and metrics using the Tableau Embedding API v3.

Note: For users to successfully authenticate when they access embedded content,
browsers must be configured to allow third-party cookies.
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For REST API authorisation workflows
After the JWT has been configured, you must add the valid JWT to the REST API Sign In
request for authorised access. For more information, see Access Scopes for Connected
Apps.
Known issues (embedding workflows only)

There are a couple of known issues when using connected apps that will be addressed in a
future release.
l

Toolbar features: When embedded content has the toolbar parameter defined, not
all toolbar features will work. To work around this issue, we recommend you hide the
toolbar parameter like in the example below.
<tableau-viz id='tab-viz' src='https://online.tableau.com/t/<your_site>/...'
toolbar='hidden'>
</tableau-viz>

l

Published data sources: Published data sources set to Prompt User for database
credentials will not display. To work around this issue, if possible, we recommend data
source owners embed their database credentials instead.

Troubleshoot

When embedded content fails to be displayed in your external application or Tableau
REST API authorisation fails, you can use a browser’s developer tools to inspect and identify
error codes that might be associated with the EAS feature enabled on your Tableau Cloud
site.
Refer to the table below to review the description of the error code and potential resolution.
Error

Summary

Description

code
5

Potential resolution or explanation

SYSTEM_USER_

Tableau user

NOT_FOUND

could not be

Tableau Software
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found

the 'sub' (Subject) claim value in
the JWT is the username (email
address) of the authenticated
Tableau Cloud user. This value is
case sensitive.

16

LOGIN_FAILED

Login failed

This error is typically caused by
one of the following claim issues
in the JWT:
l

The 'exp' (Expiry Time)
exceeds the default maximum validity period. To
resolve this issue, review

l

142

EXTERNAL_

EAS not found

AUTHORIZATION_

registered claims required
for a valid JWT and ensure
the correct value does not
exceed 10 minutes.
The 'sub' (Subject) is calling an unknown user. To
resolve this issue, verify
that the 'sub' value is the
username (email address)
of the authenticated
Tableau Cloud user.

To resolve this issue, verify that
the correct issuer is being called.

SERVER_NOT_
FOUND
143

144
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EXTERNAL_

EAS limit

The site has reached the max-

AUTHORIZATION_ exceeded

imum allowable number (1) of

SERVER_LIMIT_

registered external authorisation

EXCEEDED

servers (EAS).

INVALID_ISSUER_

Invalid issuer

The issuer URL is not valid or the

URL

URL

"iss" (Issuer) attribute is missing
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from the JWT.
10081 COULD_NOT_

Missing

To resolve this issue, verify the

RETRIEVE_IDP_

EAS metadata EAS is configured correctly and

METADATA

endpoint

10082 AUTHORISATION_ Missing issuer
SERVER_ISSUER_

the correct issuer is being called.
To resolve this issue, verify that
the correct issuer is being called.

NOT_SPECIFIED
10083 BAD_JWT

JWT header

This error is typically caused by

contains

one of the following issues with

issues

the JWT header:
l

The 'secret key' (Kid) or 'clientId' (Issuer) claims are
missing from the JWT
header. To resolve this
issue, ensure this inform-

l

ation is included.
The JWT is unsigned or
encrypted. Tableau does
not support unsigned or
encrypted JWTs.

10084 JWT_PARSE_
ERROR

JWT contains

To resolve this issue, verify the fol-

issues

lowing:
l

The 'aud' (Audience) value
referenced in the JWT uses
the "tableau" value. This

l

value is case sensitive.
The 'aud' (Audience) and
'sub' (Subject) are included
in the JWT.

10085 COULD_NOT_
FETCH_JWT_
KEYS

Tableau Software

JWT could not

Could not find the secret.

find keys

To resolve this issue, verify that
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the correct issuer is being called.
10087 BLOCKLISTED_

Issue with the

To resolve the issue, you can

JWS_

JWT signing

remove the signing algorithm.

ALGORITHM_

algorithm

USED_TO_SIGN
10088 RSA_KEY_SIZE_
INVALID

Issue with

To resolve this issue, verify with

JWT signing

the EAS or IdP that the JWT is

requirements

being signed with an RSA key size
of 2048.

10091 JTI_ALREADY_
USED

Unique

The JWT has already been used

JWT required

in the authentication process. To
resolve this issue, the EAS or
IdP must generate a new JWT.

10094 MISSING_
REQUIRED_JTI
10095 EXTERNAL_

Missing

To resolve this issue, verify the 'jti'

JWT ID

(JWT ID) is included in the JWT.

EAS disabled

The connected app for the EAS

AUTHZ_SERVER_

registered to the site is disabled.

DISABLED

Access Scopes for Connected Apps
beginning in June 2022, using Tableau-connected apps, you can programmatically call and
access the Tableau REST API through your custom application on behalf of Tableau Cloud
users. Access to the REST API is enabled by a JSON Web Token (JWT) defined as part of
the initial Sign In request. The JWT must contain scopes that define the REST API methods
that are available to your custom application and its users through the connected app.
Authorise access to the REST API using connected apps to:
l

Enhance efficiency – using a JWT as a bearer token enables a simplified imper-

l

sonation with one request to the Sign In endpoint instead of two requests
Extend and automate complex Tableau integrations and backend queries – such as
dynamic content retrieval and advanced filtering
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Scope types
Connected apps use scopes that grant access to actions on content or administrative tasks
through the REST API methods that support JWT authorisation (below). A scope is a colonseparated string that starts with the namespace tableau, followed by the Tableau
resource that access is being granted to, such as datasources, and ends with the action
that is allowed on the resource, such as update.
The actions a scope can take include:
l
l
l
l
l
l

create
read
run
update
download
delete

For example, a scope that allows your custom application to call the Update Data Source
method looks like:
tableau:datasources:update
Summary of how to authorise REST API access

The following list summarises the steps to request access to the REST API through a JWT:
1. Create a connected app using one of the following methods:
l Configure Connected Apps with Direct Trust
l
Configure Connected Apps with OAuth 2.0 Trust
2. Generate a valid JWT – at runtime your custom application will generate a valid JWT,
configured with the scopes you have included
3. Make a Sign In request – your custom application will make a Sign In request using
the JWT to return a Tableau access token and site ID (LUID)
4. Use the Tableau access token in subsequent requests – in subsequent
REST API calls, use 1) the Tableau access token as the X-Tableau-Auth header
value and 2) the site ID (LUID) in the request URI
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Example

For example, suppose you create a connected app using direct trust. Using direct trust, your
custom application that calls the REST API generates a valid JWT using the client ID and client secret generated by the connected app.
Scopes in the JWT
To successfully authorise access to the REST API, the JWT must also contain the scopes
that define the REST API capabilities. For example, to enable various data source-related
methods, you might include the following scopes in the JWT:
"tableau:content:read","tableau:datasources:create","tableau:datasources:update","tableau:datasources:download","tableau:tasks:run"
Note: Scope values must be passed as a list type.
Sign In Request URI
To make a call to the REST API, your custom application must first make a Sign In request
to generate a Tableau access token.
POST https://us-west-2b.online.tableau.com/api/3.16/auth/signin
Request body
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To authorise REST API access using a JWT, the Sign In request body must contain the valid
JWT like the example below.
<tsRequest>
<credentials jwt="eyJpc3MiOiI4ZTFiNzE3Mi0zOWMzLTRhMzItODg3ZS1mYzJiNDExOWY1NmQiLCJhbGciOiJIUzI1NiIsImtpZCI6ImIwMTE1YmY5LTNhNGItNGM5MS1iMDA5LWNmMGMxNzBiMWE1NiJ9.eyJhdWQiOiJ0YWJsZWF1Iiwic3ViIjoicm1vaGFuQHRhYmxlYXUuY29tIiwic2NwIjpbInRhYmxlYXU6c2l0ZXM6cmVhZCJdLCJpc3MiOiI4ZTFiNzE3Mi0zOWMzLTRhMzItODg3ZS1mYzJiNDExOWY1NmQiLCJleHAiOjE2NDg2Njg0MzksImp0aSI6IjY1ZWFmMmYxLTNmZTgtNDc5Ny1hZmRiLTMyODMzZDVmZGJkYSJ9.mUv2o4gtBTrMVLEXY5XTpzDQTGvfE2LGi-3O2vdGfT8">
<site contentUrl="mycodotcom"/>
</credentials>
</tsRequest>
Response body
The Sign In request produces the following response body, which includes the Tableau
access token.
<tsResponse>
<credentials token="12ab34cd56ef78ab90cd12ef34ab56cd">
<site id="9a8b7c6d5-e4f3-a2b1-c0d9-e8f7a6b5c4d" contentUrl=""/>
<user id="9f9e9d9c-8b8a-8f8e-7d7c-7b7a6f6d6e6d" />
</credentials>
</tsResponse>
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After the Tableau access token is generated, add the Tableau access token to the header of
all subsequent REST API requests.
Header
X-Tableau-Auth:12ab34cd56ef78ab90cd12ef34ab56cd
All subsequent REST API requests using the Tableau access token are then bounded by
the scopes in the JWT.
REST API methods that support JWT authorisation

The following scopes can be associated with the connected app to define access and methods your custom application can have to the REST API on users' behalf.
Notes:
l

For other REST API capabilities not listed in the table below, you can use other authorisation mechanisms to access the methods. For more information, see Authentication

l

Methods in the Tableau REST API Help.
For scopes supported by the Embedding API v3, see one of the following:
l
l

Configure Connected Apps with Direct Trust
Configure Connected Apps with OAuth 2.0 Trust

Method
No scope

Scope
(No scope)

Description
When no scopes are
defined in the JWT,
access to the
REST API is denied

Data
sources
Publish data tableau:datasources:create

Publish a data source

source

to a site or append
data to an existing published data source

Query data
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tableau:content:read

Get information about

Tableau Software

Tableau Cloud Help
Method

Scope

source

Description
a published data
source

Query data

tableau:content:read

Get information about
all published data

sources

sources on a site
Query data

tableau:content:read

Get server address,

source con-

port, username or

nections

password information
about a published data
source

Update data tableau:datasources:update

Update owner, project

source

or certification status of
the data source

Update data tableau:datasources:update

Update server

source con-

address, port, user-

nection

name or password of
the data source connection

Update data tableau:tasks:run

Run extract refresh

source now
Flows
Publish flow

tableau:flows:create

Publish a flow

Get metric

tableau:content:read

Get a metric

Delete met-

tableau:metrics:delete

Delete a metric

tableau:content:read

Get list of metrics for a

Metrics

ric
List metrics

site
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Method
Query met-

Scope
tableau:metrics:download

rics data

Description
Get underlying data of
a metric in comma-separated value (.csv)
format

Update met- tableau:metrics:update

Update owner, project,

ric

suspend status and
name of the metric

Views
Get view

tableau:content:read

Get details about a
view

Get view by

tableau:content:read

path

Get details for all views
on a site using the specified name

Query view

tableau:views:download

data

Get a view rendered in
comma-separated
value (.csv) format

Query view

tableau:views:download

PDF
Query view

Get a view as a PDF
(.pdf) file

tableau:views:download

Get a view as an image

image

(.png) file

Query views tableau:content:read

Get all views for a site

for site
Query view

tableau:views:download

Get the thumbnail

preview

image (.png) of the

image

view

Workbooks
Publish
workbook
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tableau:workbooks:create

Publish a workbook
(.twb or .twbx)
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Method

Scope

Description

Query work- tableau:content:read

Get a specified work-

book

book and its details

Query work- tableau:content:read

Get a list of workbooks

book for site

published to a site

Query work- tableau:workbooks:download

Get the thumbnail

book pre-

image (.png) of the

view image

workbook

Update

tableau:workbooks:update

workbook
Update

Modify an existing
workbook

tableau:workbooks:update

workbook

Update the connection
information

connection
Update

tableau:tasks:run

Initiate a workbook

workbook

refresh outside of a

now

scheduled task

Publish
Append to

tableau:file_uploads:create

file upload

Upload a block of data
and append it to the
data that is already
uploaded – to be used
after an upload has
been initiated using the
"initiate file upload"
method

Initiate file
upload

tableau:file_uploads:create

Initiate the upload process of a file

Download
Download
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Method

Scope

data source
Download

Description
source (.tdsx)

tableau:views:download

Download an Excel

view

(.xlsx) file containing

crosstab

crosstab data from the

Excel

view

Download

tableau:workbooks:download

workbook
Download

Download a workbook
(.twb or .twbx)

tableau:workbooks:download

Download a specific

workbook

version of the work-

revision

book (.twb or .twbx)

Download

tableau:views:download

Download a PDF (.pdf)

workbook

file containing images

PDF

of the sheets in the
workbook

Download

tableau:views:download

Download a Power-

workbook

Point (.pptx) file con-

PowerPoint

taining slides of the
sheets in the workbook

Users
Add user to

tableau:groups:update

Add a user to a group

tableau:users:create

Add a user and assign

group
Add user to
site
Get users in

the user to a site

tableau:groups:read

group
Get users

Get a list of users in a
group

tableau:users:read

Get all users on a site

tableau:users:read

Get a user on a site

on site
Query user
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Method

Scope

Description

on site
Remove

tableau:groups:update

users from

Remove a user from a
group

group
Remove

tableau:users:delete

user from

Remove the user from
a site

site
Update user tableau:users:update

Update information
about a user

Groups
Create

tableau:groups:create

Create a group

tableau:groups:delete

Delete a group

tableau:users:read

Get a list of groups that

group
Delete
group
Get groups
for user
Query

a user belongs to

tableau:groups:read

groups
Update

Get a list of groups on
a site

tableau:groups:update

Update a group

tableau:projects:create

Create a project

tableau:projects:delete

Delete a project

tableau:content:read

Get a list of projects

group
Projects
Create project
Delete project
Query project
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Method
Update pro-

Scope
tableau:projects:update

ject

Description
Update the name,
description or project
hierarchy of the project

Permissions
Add data

tableau:permissions:update

Add permissions to a

source per-

data source for a

missions

Tableau Server user or
group

Add default

tableau:permissions:update

permissions

Add default permission
capabilities to a user or
group, for metric, flow,
workbook, data
source, data role or
lens resources in a project

Add project

tableau:permissions:update

permissions

Add permissions to a
project for a user or
group

Add view

tableau:permissions:update

permissions

Add permissions to a
view for a user or
group

Add work-

tableau:permissions:update

Add permissions to a

book per-

specified workbook for

missions

a user or group

Delete data

tableau:permissions:delete

Delete default per-

source per-

mission capabilities of

missions

a user or group, for
metric, flow, workbook,
data source, data role
or lens resources in a
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Method

Scope

Description
project

Delete

tableau:permissions:delete

Delete default per-

default per-

mission capabilities of

missions

a user or group, for
metric, flow, workbook,
data source, data role
or lens resources in a
project

Delete pro-

tableau:permissions:delete

Delete the project per-

ject per-

mission for a user or

missions

group

Delete view

tableau:permissions:delete

permissions

Delete the view permission for a user or
group

Delete work- tableau:permissions:delete

Delete the workbook

book per-

permission for a user

missions

or group

Query data

tableau:permissions:read

Get a list of per-

source per-

missions for the data

missions

source

Query

tableau:permissions:read

Get default permission

default per-

capabilities of users

missions

and groups for metric,
flow, workbook, data
source, data role or
lens resources in a project

Query project per-

tableau:permissions:read

Get a list of permissions for the project

missions
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Method
Query view

Scope

Description

tableau:permissions:read

Get a list of per-

permissions

missions for the view

Query work- tableau:permissions:read

Get a list of per-

book per-

missions for the work-

missions

book

Site
Get recently tableau:content:read

Get views and work-

viewed site

books details on the
most recently created,
updated or accessed
by the signed-in user

Query site

tableau:content:read

Get information about
a site

Query views tableau:content:read

List all views on a site

for site
Update site

tableau:sites:update

Update a site

Troubleshoot Connected Apps
When embedded content fails to display in your custom application or Tableau
REST API authorisation fails, you can use a browser’s developer tools to inspect and
identify error codes that might be associated with the Tableau-connected app that’s used to
display the embedded content.
Refer to the table below to review the description of the error code and potential resolution.
Error

Summary

Description

code
5
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Potential resolution or explanation

SYSTEM_

Tableau user

To resolve this issue, verify that the

USER_NOT_

could not be

'sub' (Subject) claim value in the JWT

FOUND

found
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is the username (email address) of
the authenticated Tableau Cloud
user. This value is case sensitive.
16

LOGIN_

Login failed

FAILED

This error is typically caused by one
of the following claim issues in the
JWT:
l

The 'exp' (Expiry Time)
exceeds the default maximum
validity period. To resolve this
issue, review registered claims
required for a valid JWT and
ensure the correct value does

l

not exceed 10 minutes.
The 'sub' (Subject) is calling an
unknown user. To resolve this
issue, verify that the 'sub' value
is the username (email
address) of the authenticated
Tableau Cloud user.

126

127

128

CONNECTED_ The con-

To resolve this issue, verify that the

APP_NOT_

nected app

connected app is enabled and the cor-

FOUND

could not be

rect client ID (also known as the con-

found

nect app ID) is referenced in the JWT.

CONNECTED_ The con-

To resolve this issue, verify that the

APP_

nected app's

correct connected app's secret ID

SECRET_

secret could

and secret value are referenced in

NOT_FOUND

not be found

the JWT.

CONNECTED_ Maximum

A maximum of two secrets are

APP_

limit for

allowed for a connected app. This

SECRET_

secrets has

error can occur when there's an

LIMIT_

been reached

attempt to create a third secret.

EXCEEDED

To resolve this issue, delete a secret
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from the connected app before creating a new one.
133

INVALID_

Domain allowl- This error can occur when the domain

CONNECTED_ ist contains

allowlist contains one or more invalid

APP_

one or more

characters.

DOMAIN_

invalid char-

SAFELIST

acters

10083 BAD_JWT

JWT header

This error is typically caused by one

contains

of the following issues with the JWT

issues

header:
l

The 'secret key' (Kid) or 'clientId' (Issuer) claims are missing from the JWT header. To
resolve this issue, ensure this

l

information is included.
The JWT is unsigned or encrypted. Tableau does not support
unsigned or encrypted JWTs.

10084 JWT_PARSE_
ERROR

JWT contains

To resolve this issue, verify the fol-

issues

lowing:
l

The 'aud' (Audience) value referenced in the JWT uses the
"tableau" value. This value is

l

case sensitive.
The 'aud' (Audience) and 'sub'
(Subject) are included in the
JWT.

10085 COULD_NOT_
FETCH_JWT_
KEYS

JWT could not Could not find the secret.
find keys

To resolve this issue, verify the correct keyId (Kid) is used in the JWT
header.
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10089 CONNECTED_ Could not find

To resolve this issue, ensure the

APP_NOT_

connected

issuer is calling the correct connected

FOUND

app

app ID (also known as the client ID).

10090 CONNECTED_ Connected

The connected app used to verify

APP_

app is dis-

trust is disabled. To resolve this issue,

DISABLED

abled

enable the connected app.

Unique

The JWT has already been used in

10091 JTI_
ALREADY_

JWT required. the authentication process. To

USED

resolve this issue, a new JWT must
be generated.

10094 MISSING_
REQUIRED_

Missing

To resolve this issue, verify the 'jti'

JWT ID

(JWT ID) is included in the JWT.

JTI

Monitor Site Activity
Find Admin Views
The Site Status page contains an embedded Tableau workbook with various admin views.
These views help you to monitor different types of site activity.
l

Allows you to access the Admin Insights project, which you can use to build custom
admin views about your site.

l

Shows you general site activity for Tableau Cloud.

l

Shows you general Tableau Bridge activity.

Navigate to admin views
To see the Admin Insights project or admin views, click Site Status. Site administrators can
see administrative views for their site.
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Use Admin Insights to Create Custom Views
You can get more visibility into your Tableau Cloud deployment by using Admin Insights.
Admin Insights is a Tableau Cloud-only project that is pre-populated with carefully curated
data sources and a pre-built workbook of your site's data. Using the resources available to
you through the Admin Insights project, you can create custom views to help answer a
range of common questions you might have about your site.
For example:
l

What's my Tableau Cloud adoption rate in my organisation?

l

What are common trends around the site’s deployment?

l

What content is popular?

l

What are my users doing?

l

How should licences be allocated?

Connect to Admin Insights data
If you're a site admin or someone who has been granted access to the Admin Insights project, you can access the Admin Insights data sources directly from Tableau Cloud using
Web Authoring or through Tableau Desktop.
From Tableau Cloud
1. Sign in to Tableau Cloud and navigate to the Admin Insights project.
2. Select Create > Workbook and select one of the data sources to get started.
From Tableau Desktop
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1. Open Tableau Desktop, under Connect, select Tableau Server.

Note: If you're not already signed in to Tableau Cloud, in the Tableau Server Sign
In dialog box, click the Tableau Cloud hyperlink. Enter your Tableau Cloud credentials and then click Sign In.

2. In the search box, type the name of the data source you're looking for.
3. Select a data source and click Connect to get started with your analysis.

Start creating custom views
As you think about how you want to approach the analysis of your site and user metrics, consider some of the following questions that organisations commonly ask:
l

What are the most popular views or data sources?

l

Who are the most active users (i.e., who are the power users)?

l

What are the most common tasks performed on the site?

l

How many licences are being used?

l

Who hasn't signed in to the site in more than 90 days?

Explore the pre-built workbook

To help you answer the above questions (and more), go to the pre-built workbook, Admin
Insights Starter, to see what kind of insights it can offer. The pre-built workbook is intended to
serve as a template on which to build more detailed dashboards and workbooks that go
more in depth and address questions you have that are unique to your site deployment or
organisation.
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User Role Drilldown
Focus: Site activity
Data source: TS Users
Use this dashboard to explore high-level site activity by user role.
This dashboard shows you some of the ways you can analyse your site’s log and activity
metrics. Although Admin Insights captures up to 90 days of data (365 days with an
Advanced Management licence), the “Last Publish” and “Last Access” dates can go back to
as early as the date the site was created.
Do more with this dashboard:
l

Change the "Inactivity threshold" (yellow by default) using the parameter control in
the upper-right corner.

l

Create URL actions that can email users based on their activity type. For example,
email users when they haven’t signed in to the site, accessed content or published
content in the last 90 days.

l

Create additional views for this dashboard that compares the last 90 days (default) of
activity (sign in, access or publish) to the last 30 days, 60 days and all days.
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Login Activity Drilldown
Focus: Sign-in activity
Connects to: TS Events (primary), TS Users (secondary)
Use this dashboard to explore trends in sign-in activity.
Using the “Select Events or Distinct Actors” selector on the left, you can see your site’s
weekly, daily and hourly sign-in-related activity. Because there are two data sources behind
this dashboard, you can see sign-ins by all users, not just users with recent sign-in activity.
Do more with this dashboard: Duplicate the dashboard and keep only the “Login user
breakdown”. Then change the filter on the “Last Login Date” to null to see a list of users who
have never signed in to the site. You can also email them depending on what kind of action
you want users to take.

Traffic and Adoption Drilldown & Publish Event Drilldown
Focus: Content access and usage
Connects to: TS Events
The information in the dashboards show you the following type of information:
l

View access activity: When a view has been accessed and by whom.

l

Data source access activity: When 1) a published data source has been connected to
through Web Authoring or Tableau Desktop or 2) a user has viewed or published a
workbook that uses the published data source.

l

Workbook publish activity: When a workbook has been published and by whom.

l

Data source publish activity: When a published data source has been published and
by whom.

Do more with this dashboard: Using the “Project Name” selector in the upper-right
corner, select a project on your site to filter on.
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Note: This filter affects all sheets in the Admin Insights Starter.

Explore the data sources

Alternatively, you can connect to the Admin Insights data directly. Explore the data on your
own by hovering over each field (both dimensions and measures) to read a description of
the data that's being captured.

TS Events
TS Events functions as a primary audit data source. It contains data about the various
events happening on your site, including sign-ins, publishes and accessed views.
Example: What are the most popular views?
1. Connect to the TS Events data source using one of the procedures listed in Connect
to Admin Insights data.
2. From the Data pane, drag "Item Name" to the Rows shelf and "Number of Events" to
the Columns shelf.
3. From the Data pane, drag "Item Type" to the Filters shelf, and tick the View box.
Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
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l

Join TS Events to TS Users on "Actor User ID = User ID"

l

Join TS Events to Site Content on "Item ID = Item ID" and "Item Type = Item Type"
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For more information, see Aggregate, Join or Union Data in Tableau Prep Help.

TS Users
TS Users contains data about your users such as remaining licences, site roles and workbooks and views owned by a user.
Example: How many licences are being used?
1. Connect to the TS Users data source using one of the procedures listed in Connect to
Admin Insights data.
2. From the Data pane, drag "Measure Names" to the Rows shelf and "Measure Values"
to the Columns shelf.
3. Right-click on the Measure Names field in the Rows shelf and select Show Filter.
4. Click the Measure Names filter drop-down menu, and select Customise > Show
Apply Button.
5. In the filter, select "Total Allowed Licences" and "Total Occupied Licences" tick boxes,
and then click Apply.
Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
l

Join TS Users to Groups on “User LUID = User LUID”

l

Join TS Users to TS Events on “User ID = Actor User ID”

l

Join TS Users to Site Content on “User Email = Owner Email” or “User Email = Item
Parent Project Owner Email”

For more information, see Aggregate, Join or Union Data in Tableau Prep Help.
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Groups
Groups identifies the group membership of users. There is one row of data for each unique
combination of group and user pairing. Groups without members, and users not in a group,
will be included as a row of data with null values represented as "NULL".
Example: Which users are in a given group?
1. Connect to the Groups data source using one of the procedures listed in Connect to
Admin Insights data.
2. From the Data pane, drag "Group Name" to the Rows shelf.
3. (Optional) In the view, select the groups you want to explore, and then select Keep
Only.
4. From the Data pane, drag "User Email" to the Rows shelf, placing it to the right of the
Group Name field.
Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
l

Join Groups to TS Users on "User LUID = User LUID"

For more information, see Join Your Data in Tableau Desktop Help.

Site Content
Site Content provides essential governance information about the projects, data sources,
flows, workbooks and views on a site. The data provided about a content item may be
unique to its item type. Item types with unique fields are in folders with titles that correspond
to their Item Type.
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Note: Users that connect to the Site Content data source will see data about all content
items on the site, regardless of the permissions set for each item. Keep this in mind if you
plan to distribute to non-administrative users.

Example: What percentage of the site's published data sources are certified?
1. Connect to the Site Content data source using one of the procedures listed in Connect
to Admin Insights data.
2. From the Data pane, drag "Migrated Data (Count)" to the Columns shelf.
3. From the Data pane, drag "Data Source Content Type" to the Filters shelf, remove the
selection next to the All tick box and select the Published tick box.
4. From the Data pane, drag "Data Source Certified" to Colour on the Marks card.
5. Right-click on the "CNT (Migrated Data)" field in the Columns shelf and select Quick
Table Calculation > Percentage of Total.
Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
l

Join Site Content to TS Events on “Item ID = Item ID” and “Item Type = Item Type”

l

Join Site Content to TS Users on “Owner Email = User Email” or “Owner Email = Item
Parent Project Owner Email"

For more information, see Aggregate, Join or Union Data in Tableau Prep Help.

Viz Load Times
Viz Load Times contains the load time information for views on your site to help content
authors better understand the user experience when loading views.
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Example: Which views take the longest to load?
1. Connect to the Site Content data source using one of the procedures listed in Connect to Admin Insights data.
2. From the Data pane, drag "Item Name" to the Rows shelf and "Duration" to the
Columns shelf.
3. From the Data pane, drag "Status Code Type" to the Filters shelf and select the Success tick box.
4. In the Columns shelf, right-click on "Dimensions" and select Measure (Count) >
Median.
Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
l

Join Viz Load Times to TS Events and Site Content on “Item Repository URL = Item
Repository URL”

l

Join Viz Load Times to TS Events and Site Content on “Item Type = Item Type”

For more information, see Aggregate, Join or Union Data in Tableau Prep Help.

Job Performance
Job Performance contains events and runtime information for background jobs on the site.
Jobs include extract refreshes, Bridge refreshes and flow runs.
Example: How many extract refreshes and flow runs occur on the site?
1. Connect to the Job Performance data source using one of the procedures listed in
Connect to Admin Insights data.
2. From the Data pane, drag "Item Name", "Item Type", "Owner Email" and "Job Type"
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to the Rows shelf.
3. In the Rows shelf, right-click on "Item Name" and select Sort.
4. In the Sort window, select Sort By > Field and Field Name > Job ID. Close the window.
5. From the Data pane, drag "Started At (local)" to the Columns shelf.
6. In the Columns shelf, right-click on "Started At (local)" and select Exact Date. This
converts the dimension to a measure.
7. From the Data pane, drag "Job Result" to Colour and "Job Execution Duration" (Days)
to Size on the Marks card.
Example: What is the average job queued duration?
1. Connect to the Job Performance data source using one of the procedures listed in
Connect to Admin Insights data.
2. From the Data pane, drag "Started At" to the Columns shelf and "Started At (local)" to
the Rows shelf.
3. In the Columns shelf, right-click on "Started At" and select Day from the second set of
values (i.e. 11 May 2022). This converts the field to a measure.
4. In the Rows shelf, right-click on "Started At" (local) and select More > Hour from the
first set of values (i.e. 9).
5. On the Marks card, select Square from the Shape drop-down menu.
6. From the Data pane, drag "Job Queued Duration" to Colour on the Marks card. Rightclick in the field and select Measure > Average.
7. From the Data pane, drag "Job ID" to Size on the Marks card. Right-click in the field
and select Measure > Count (Distinct).
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Do more with this data source: Using Tableau Prep, you can join Admin Insights data
sources on the following fields to get more visibility into your site. If you're analysing data
from multiple Tableau Cloud sites, you must also join on "Site LUID = Site LUID".
Join Job Performance to Site Content on "Item ID = Item ID"

l

For more information, see Aggregate, Join or Union Data in Tableau Prep Help.

Manage Admin Insights
Admin Insights is a Tableau Cloud-only project that is pre-populated with carefully curated
data sources and a pre-built workbook of your site's data. Using the resources available to
you through the Admin Insights project, you can create custom views to help answer a
range of common questions you might have about your site.
Admin Insights versus Admin views

The Admin Insights project and the pre-built admin views (accessible from Tableau Cloud’s
Status page) are both valuable tools for monitoring the health and activity of your Tableau
Cloud site. One tool does not replace the other.
To determine which tool to use, consider the following:
Admin Insights
l

Site traffic, adoption

Admin Views
l

and reach
l

User roles and sign-in

l

activity
Publishing-related

General site activity, site performance and disk
space usage

l
l
l

Extract performance
Tableau Bridge traffic and extract-related activity
Troubleshooting

activity
What's included with the Admin Insights project

The Admin Insights project is comprised of the following:
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l

Admin Insights data sources – TS Events, TS Users, Groups, Site Content, Viz
Load Times and Job Performance. You can use these data sources on which to create new data sources if you need to enrich the data with custom calculations or other
data from your organisation. For more information about the data sources, see
Explore the data sources.

l

Admin Insights Starter – a pre-built workbook that contains dashboards based on
the Admin Insights data sources. These dashboards are intended to serve as templates on which to build more dashboards and views that can go more in depth and
answer questions that are unique to your site's deployment or organisation. For more
information about the dashboards, see Explore the pre-built workbook.

l

Tableau System Account – data sources in the Admin Insights project are updated
by the Tableau System Account. While events conducted by this account are not visible in the data sources, the Tableau System Account is listed as the owner of Admin
Insights content by default. This account exists to provide Admin Insights data to your
Admin Insights project.

About data freshness

The Admin Insights data sources contain up to 90 days of data about your site by default or
365 days with Advanced Management. For more information, see About Tableau Advanced
Management on Tableau Cloud. The data sources can be updated daily or weekly. To specify the update frequency for Admin Insights data sources, go to Settings, and on the General tab, scroll to Admin Insights Update Frequency.
Because the Admin Insights Starter is based on these data sources, dashboards in the workbook always show up-to-date information. Periodically, Tableau updates the workbook itself.
For more information, see Get updates to the Admin Insights Starter later in this topic.
Share access to Admin Insights

The Admin Insights content is initially visible to site admins only. Consider extending access
to other site users in your organisation to enable them to build, curate and gain insight unique
to their needs and workflows and ultimately help them manage their content more effectively.
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For more information about extending project permissions to non-site admins, see Permissions.
Move or rename the Admin Insights Starter

Tableau strongly recommends that you move the pre-built workbook, Admin Insights
Starter, to a different project or simply rename it. Doing so helps ensure that your changes
are preserved and do not get overwritten by periodic updates Tableau makes to the prebuilt workbook.
For more information, see the Get updates to the Admin Insights Starter below.
Get updates to the Admin Insights Starter

Periodically, Tableau makes updates to the Admin Insights Starter. The updates are automatically applied to the Admin Insights Starter workbook in the Admin Insights project.
The updates are summarised in the Release Notes workbook that is also available in the
Admin Insights project. Updates can include new fields or field descriptions, new views,
updates to existing views and more.
To make sure you get the latest updates to the Admin Insights Starter, and none of the
changes you make to the workbook are overwritten, follow the steps described below.
Step 1: Prepare for updates
In order to preserve the changes you make to your workbook and avoid these changes from
being overwritten by Tableau, Tableau recommends that you do one of the following tasks:
l
l

Move the workbook to a different project
Rename the workbook

To maintain both your changes and Tableau's latest workbook improvements, you'll need to
repeat one of the above tasks after each update that Tableau makes.
Step 2: Check for updates
As part of its update process, Tableau recreates and then adds the Admin Insights Starter
to your Admin Insights project.
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If you've moved or renamed the workbook, a new "Admin Insights Starter" is added to your
Admin Insights project. You can verify the new workbook by its modified date or by its publish
date in revision history.
Step 3: Use Revision History to undo changes (optional)
If you were unable to move or rename the workbook before Tableau replaced the Admin
Insights Starter, or you don't care for the update, you can use revision history to revert the
changes. For more information about revision history, see Work with Content Revisions in
the Tableau User Help.
Step 4: Manually make or move your changes to the latest Admin Insights Starter
To ensure that your changes are reflected in the same workbook as the changes made by
Tableau, you'll need to follow the procedure below.
1. In the latest version of the Admin Insights Starter workbook, you do can do one or both
of the following:
l

Manually make the changes that you made in your version of the workbook to

l

the latest version of the workbook.
Export the sheet from your version of the workbook and save it to the latest version of workbook. For more information about exporting sheets, see Export and

import sheets between workbooks in the Tableau User Help.
2. Move or rename the latest workbook again, so that any new updates Tableau makes
to the Admin Insights Starter does not overwrite your changes.
Tips for managing Admin Insights

Although the Admin Insights project functions just like any other project on your site, Tableau
recommends you consider the following while managing the project:
l

Move the Admin Insights Starter to a different location. If you plan to make
updates to Admin Insights Starter, Tableau recommends that you either 1) move the
workbook to a different project or 2) rename the workbook. Doing one of these tasks
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ensures that your changes are preserved and do not get overwritten by periodic
updates that Tableau automatically makes to the workbook. For more information,
see Get updates to the Admin Insights Starter.
l

Use caution when moving data sources. If you move any of the Admin Insights
data sources outside of the Admin Insights project, Tableau will be unable to refresh
them. The data sources are also periodically updated by Tableau. To ensure the data
sources are refreshed and your changes are preserved, keep the TS Events, TS
Users, Groups, Site Content, Viz Load Times and Job Performance data sources in
the Admin Insights project.

l

Designate other users, including users who are not site admins, to access
and create content for the project. For example, allow a user to create new views
based on the TS Events, TS Users, Groups, Site Content, Viz Load Times and Job
Performance data sources. For more information about changing project permissions, see Set permissions.

Traffic to Bridge Connected Data Sources
The Traffic to Bridge Connected Data Sources admin view gives the site admin the ability to see usage of data sources with live connections. This view can help you determine
which data sources are most heavily used and those that are used less often. You can filter
the information you see by selecting the Bridge client name, data source and the time
range.
This view gives you a snapshot of Tableau Cloud activity over the past 30 days.
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The top of the view shows you how data sources are being used over the Time Range you
specify (the default is the last 7 days):
l

l

What is the Data Source Usage by Project – this shows total data source usage
by project, based on the filters you set. Hover over a mark to see the number of times a
data source was used. Select the mark to update the other sections of the view based
on your selection.
What is the Total Data Source Usage by Day – this shows total data source usage
by day, based on the filters you set. Hover over a point on the line to see the count.
Select the point to update the other sections of the view based on your selection.

Two bar graphs at the bottom of the view show results that are filtered by Min Interactions.
These show you which data sources are most used, and who uses data sources most often.
Only those data sources and users with interaction counts greater than or equal to the minimum interactions value are displayed:
l

l

What Data Sources are Used Most – this is a list of the most used data sources.
Like the other sections of the view, the information is limited by filters and any selection
you make.
Who Uses Data Sources Most Often – this shows the users who most often use the
data sources. This is impacted by filters and any selection you make.
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Background Tasks for Extracts
The Background Tasks for Extracts view displays extract-specific tasks that run on the
server. This view gives you a snapshot of Tableau Cloud activity over the past 30 days.

Understand this view
To better understand this pre-built admin view, make note of the following:
l

The table, "What Extracts Ran on this Server", lists the extracts that ran in the time
period specified in Timeline.

l

You can click Success or Error to filter the table based on status.
You can also click a specific task to update the "How Much Time did Extracts Take"

l

graph for the selected task.
The table, "How Many Extracts Succeeded or Failed", updates for the status (success

l

or failure) of the task, but the count of extracts that succeeded or failed does not
change.
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Status

Tasks can have a status of success or error.
Icon

Description
Error – Server was unable to complete the task.
Success – Server completed the task.

See details about a task

For details on about the task, use your mouse to hover over the success or error icon.

Errors in task details

If a refresh task reaches the timeout limit, you might see one of the following errors in the task
details:
l
l
l

The query time resource limit (7200 seconds) was exceeded.
com.tableau.nativeapi.dll.TableauCancelException: Operation cancelled.
The query time resource limit (8100 seconds) was exceeded.

For more information about the timeout limit for refresh tasks and suggestions for resolving
these errors, see Time limit for extract refreshes.
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Bridge Extracts
The Bridge Extracts admin view captures the last 30-days' worth of refresh activity by
Tableau Bridge.

This pre-built admin view can help answer the following questions the site admin might have
about refreshes performed by one or all of the Bridge clients registered to the site:
l

l
l
l

Error rate: How often are refreshes succeeding and failing? If refreshes are failing,
why?
Requests made: How many refreshes are scheduled?
Time-elapsed: How long are refreshes taking?
Saturation: How busy is each client?

You can filter the view by the client name, when the extract data source was created, the
extract data source name and the duration of the refresh.
Notes about this view
l

If you don't see any data in the admin view, verify that you have a Bridge client associated with your site. Alternatively, change the value for the "Extract created" filter in
the upper-right corner of the view.
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l

If you don't see the duration-based data that you expect in the view, clear the "Avg. Dur-

l

ation of refresh (seconds)" filter by clicking the Show All Values ( ) icon.
In the "Common extract refresh failures" table, hover over each bar to see the error
and the error details. If there's more than one data source associated with the error, an
asterisk (*) shows instead.

Background Tasks for Non Extracts
The Background Tasks for Non Extracts view displays tasks that the server runs that are not
related to standard Online extract refreshes. For example, Bridge Refresh jobs, edited
OAuth connections, subscription notifications, and so on. This view gives you a snapshot of
Tableau Cloud activity over the past 30 days.
A table lists the tasks that ran in the time range specified. Click Success or Error to filter the
table based on status. Select a specific task in the How Many Tasks Succeeded or Failed
on this Site table to update the What Background Tasks Ran on this Site graph for the
selected task.
Tasks can have a status of success or error. For details about the task, use your mouse to
hover over the success or error icon.
Icon

Description
Error – Server was unable to complete the task.
Success – Server completed the task.

Details that you can see about the task are its ID, status and priority and when it was created,
started and completed. You can also see its runtime: the total runtime of the background job,
which includes the runtime of the job plus background job overhead such as initialisation and
cleanup. You can also see which backgrounder the job is running on.

Stats for Space Usage
The Stats for Space Usage view can help you identify which Tableau content uses the most
disk space on the server. Disk space usage displays by user, by project and by the size of the
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Tableau content (workbook, data source, flow output or virtual connection) and is rounded
down to the nearest number.
Note that virtual connections require Data Management. See About Data Management for
details.
To open this view, click Site Status on the left nav, then under Dashboard, click Stats for
Space Usage.

Use the Min Size filter to control which Tableau content displays, based on the amount of
space they use.
Three bar graphs give you information about space usage on your Tableau Cloud:
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l

Which Users Use the Most Space – This shows the users who own data sources
and workbooks that use the most space. Click a username to filter the next two graphs
for that user. Click the data source bar or the workbook bar for a user to filter the next
two graphs for that type of object for that user. Click the selected user or bar to clear
the selection.

l

Which Projects Use the Most Space – This shows the projects with the data
sources and workbooks that use the most space. If a user or object type is selected in
the Which Users Use the Most Space graph, this displays information specific to the
selection.

l

Which Workbooks, Data Sources, Flows and Virtual Connections Use the
Most Space – This shows which Tableau content uses the most space. The bars are
colour-coded based on the length of time since the last refresh.

Move your cursor over any bar to display usage details:

Click on a bar to select it and update the other areas of the view based on that selection.

Login-based Licence Usage
Note: This view is only available to site administrators and server administrators.
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The Login-based Licence Usage view lets server administrators view login-based licence
activation usage for Tableau Cloud or Tableau Server. The Login-based Licence Usage
view can help you manage licences efficiently and determine if you need more or fewer
licences. This view can help you answer the following questions:
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l

Who is using a Tableau Desktop or Tableau Prep Builder licence in my enterprise?

l

Has a Creator role been shared or transferred?

l

Has any activation activity occurred on a computer where it should not be?

l

On which host is the activation being used?

l

Which role is assigned to the user?

l

On which Tableau product is the licence in use?

l

On which Tableau version is the licence in use?

l

Did the Creator role activate through Tableau Desktop or Tableau Prep Builder?

l

Has the Creator seat been activated?

l

How many Creator seats are in use?

l

How many Creator seats are not in use?

l

When was a Creator seat was last used?
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In addition to using the login-based licence usage administrative view, you can also access
login-based licence usage data (identity_ based_activation_reporting, identity_based_activation_user_role_change, and identity_based_activation_admin_view) in the "workgroup" PostgresSQL database of the Tableau Server
repository. Before you can access this data, you must enable access to the Tableau Server
repository.
Filters

On the report screen, you can change the time window to show when seats were last used,
filter on actions, filter on user name and sort by columns.
l

Time Window in Days. Enter the number of days for which to view login-based
licence management activated client usage data. You can view data for the past 30
days up to a maximum of 183 days.

l

(All). Apply all filters to the view.
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l

Activated. Show Creator users that have activated using login-based licence management.

l

in use. Show Creator users who activated using login-based licence management
whose seats are in use.

l

last used. Show when the login-based licence management client was last used.

l

unassigned. Show which login-based licence management activated Creator seats
are currently unassigned.

l

user name. Show login-based licence management activations in use by the specified user.

When you hover over the filter card, a drop-down icon appears. Click the icon to specify
whether the view should include data that matches the filter (the default) or exclude data
that matches the filter:

Which creator seats are in use in the last <nn> days?
This area of the dashboard shows a list of three types licences (activated, in use and unassigned). Hovering over an activated, in use or unassigned mark gives you information including the registered user of the copy of Tableau. Click a column head to sort the list.

Which creator seats have not been used in the last <nn> days
This area of the dashboard shows a list of licences that have not been used during the specified time period. A timeline shows the last use date. Hovering over a last use mark gives
you information including the registered user of the copy of Tableau.
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Stale Content
The Stale Content view can be used to identify content that hasn’t been used or accessed in
the specified time period (displayed as Stale Access Threshold). You can set that time period
in days. The minimum value for the time period is 1 day and the maximum is 120 days.
This view also provides the information about the disk space used by stale and active content.
In previous versions of Tableau Server, admin views were all displayed in the same workbook, in separate tabs. However, the two new admin views are displayed as separate workbooks and not part of the existing admin view workbook. You can navigate to the new admin
views from the Server or Site Status page:
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Summary and Filters

A - At the top of the view, you will see a statement that summarises the amount of space
that is used by stale content compared to the total space used. The total space used is
defined as the sum total of disk space used by active and stale content.
B - This summary is followed by a chart that gives you a further breakdown of the types of
stale content and content that is considered active – meaning content that has been
accessed in the time period below the stale threshold. You can click on the bar chart and
apply it to filter the data displayed in the view.
C - You can see and apply additional filter options by clicking the filter icon. This filter pane
includes:
• Stale Threshold
• Site
• Project
• Content Owner
• Size
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• Content type

These filters are applied to the entire view.

Details
The Stale Content view has three sections as described below that provides details:
1. The top left section shows you the total space used for the selected content. The xaxis shows the number of days that have passed since the content was last opened,
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and the y-axis shows you the size. The graph also shows the stale threshold.
Set your desired staleness threshold, then use this view to identify content that is the
most stale. Click the Stale Workbooks or Stale Datasources in the bar at the top to
filter to the content of interest. Select the marks to the right of the Stale Access
Threshold to see more details about content. The details are displayed in the bottom
left section.

2. The top right section shows you the amount of space that is used by each selected
content. For example, if you select Stale workbooks, the space used by each stale
workbook is displayed. You can use this section to find out which content is the most
stale, or is taking the most space.
This section helps you identify content that hasn’t been used in a long time. Click the
Stale Workbooks or Stale Data Sources on the bar at the top. Select the oldest
set of unused content (marks further to the right) to see more details. The details are
displayed in the bottom left section. This can be your next set of content to consider
for archiving or deleting as these are contents that nobody has been using, regardless of size.
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3. The section at the bottom shows detailed information about the selected content as
shown below:

Archive or Delete Stale Content
Starting in 2020.3, the Stale Content admin view includes a feature that allows you to select
and tag content as stale. You can select content from either the section at the bottom or the
top right section. When you make a selection, you will see the number of objects and the type
of content that are selected, as seen in the screen shot below. Click the Tag Objects button
to tag the selected content.
In the screen shot shown below, content that has not been opened in the last 160 days or
more are selected to be tagged as stale content.
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To find all the tagged content, on Tableau Server web interface, navigate to Explore.
Select the Stale Content filter to see all the content that have the stale content tag. You
can now select the content and either move it to a project that you use for archiving or delete
the content.
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Ask Data Usage
The Ask Data Usage view is a pre-built dashboard that allows site or server admins to see
and understand the usage patterns and value of Ask Data for a site. Admins can see the
growth of engagement with Ask Data and monitor the results of internal training or roll-outs.
The dashboard highlights the top Ask Data users, data sources, and data source owners,
along with some headline value metrics.
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To enable Ask Data, see Disable or Enable Ask Data for a Site.

Explore the dashboard
The Ask Data Usage view provides information about Ask Data across the entire site. You
can use the following metrics to understand user engagement and help drive self-service
analytics adoption in your organisation.

At the top of the dashboard, three headline metrics provide an overview of Ask Data usage
on the site.
l

Number of Users on Ask Data - This shows the total number of Ask Data users on
the site.

l

Number of Queries on Ask Data - This shows the total number of Ask Data queries issued on the site.

l

Number of Data Sources Used with Ask Data - This shows the total number of
data sources used with Ask Data.

In the middle of the dashboard, two line charts show you how Ask Data is used over time.
l

Distinct Users Over Time - This shows the distinct number of Ask Data users over
time.

l

Distinct Data Source Owners Over Time - This shows the distinct number of data
source owners over time.
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At the bottom of the dashboard, three bar charts list the top Ask Data users, data sources,
and data source owners.
l

Top Ask Data Users - This lists the top Ask Data users and the total number of queries issued by each user.

l

Top Ask Data Data Sources - This lists the top Ask Data data sources and the total
number of queries issued for each data source.

l

Top Ask Data Data Source Owners - This lists the top Ask Data data source owners and the total number of data sources owned by each user.

Data Quality Warning History
When Tableau Catalogue is enabled in your environment, site administrators can see how
data quality warnings are being used on the site using the pre-built admin view, Data Quality
Warning History.
For more information about Tableau Catalogue, part of Data Management, see "About
Tableau Catalog" in the Tableau Server or Tableau Cloud Help.
From the Site Status page, select the Data Quality Warning History dashboard:
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The dashboard shows how many data quality warnings are active over a period of time. It
also shows how many warnings have been changed (created, updated and deleted) over
that same time period.

See warning details
Under the line charts are the details about the data quality warnings, including:
l
l

l
l
l
l

l

l
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Date and Time - When the warning was created or last changed.
Content Type - The type of asset the warning is set on, such as a database, table or
data source.
Content Name - Name of the asset the warning is set on.
Changed By - Name of the person who created or last changed the warning.
Status - If the warning is active or inactive.
Type - Warning type can be Stale data, Warning, Deprecated, Sensitive data or
Under maintenance.
Visibility - The warning can be configured to have normal (the default) or high visibility.
Message - The message the warning creator wrote to display to users when they see
the details of the warning.
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Filter warning history
When you review data quality warning history, you can click on a mark on the view to filter the
details shown below the view.

The numbers on the Day axis represent the date within the time range. For example, if today
is 18th November, and you filter for the last 7 days, the Day axis shows 12–18.
More filters are available when you click on the filter icon in the upper-right corner: filter by
time range and by content type.
Filter by time range

The maximum time range you can configure is the last 30 days.
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Filter by content type

You can see all the data quality warnings on your site, or you can filter to see warnings for
specific types of assets, like data source or table:

Who can do this
To set a data quality warning, you must be a server or site administrator.

Administrative Views for Flows
Administrative views can be used to monitor the activities related to flows, performance history and the disk space used. The Status page contains an embedded Tableau workbook
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with various administrative views that can be used to monitor different types of server or site
activity.

Who can do this?
Tableau Site administrators can view and work with Administrative Views.

Action by all users
Use this view to gather insight into how flows are being used. This includes actions like publish, download and flow runs. You can filter the view by actions, by site and by time range.
The Total Users count shows the number of users who have performed an action. This value
is not affected by any filtering. The Active user count shows the number of users who have
been active during the selected time period and performed one of the selected actions.

Action by Specific User
Use this view to gather insights about how an individual user is working with flows. You can
filter the view by username, the type of action and by time range.
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Action by Recent Users
This view shows you which users have been active on Tableau Cloud over the past 24
hours.
This can be useful if you need to do some maintenance activity on the server and want to
know which users and how many this will affect, and what they're doing.
The view shows Active, Recently Active and Idle users that are currently signed in to
Tableau Cloud.
For this view, an active user is one who took an action in the last 5 minutes, a recently active
user is one who last took an action within 30 minutes, and an idle user is one who last took
an action more than 30 minutes ago.
Select a user to see only the actions that user performed recently. Hover over an action to
see details of the action.
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Backgrounder Task Delays
This view shows the delay for extract refresh tasks, subscription and flow tasks – that is, the
amount of time between when they are scheduled to run and when they actually run. You
can use the view to help identify places you can improve server performance by distributing
your task schedules and optimising tasks.

Possible reasons for the delays and ways to reduce the delays include the following:
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l

Many tasks are scheduled for the same time.
In the example view, tasks that show long delays are clustered at the same time
every day, which creates spikes in the wait time. You can set the Timeline filter to a
single day to view task delays by hour and identify the hours of the day when many
tasks are scheduled at the same time. One solution is to distribute the tasks to offpeak hours to reduce load on the server.

Background Tasks for Non Extracts
Background Tasks are created to run flows (scheduled and ad hoc). You can use this view
to see how many flow tasks succeeded or failed on this site. For details on a task, hover
over its icon.

Performance of Flow Runs
Use this view to see the performance history for all the flows on a site. You can filter by Flow
Name, Output Step Name, Flow Owner, Run Type (Scheduled or Ad Hoc) and the time the
flow runs were started.
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Questions you can answer using this view include:
l

What flow tasks are currently scheduled? - To do this, use the Start Time filter
and select the time frame you want to look at. For example, to see flow tasks that are
scheduled in the next 3 hours, select Hours -> Next -> and enter 3.

l

What is the duration of flow tasks? - To answer this, click on a mark in the view to
see details, including the task duration.

l

How many flows were run ad hoc, and how many were scheduled runs? - To
answer this, use the Run Type filter and select Ad hoc or Scheduled.

This view can also show you the following information:
l

Flows with the highest run frequency have the most marks.

l

To see flows that are currently running at the same time, hover over a mark that shows
“In Progress” or “Pending” and select “Keep Only” to filter all flow runs that are currently running.

l

To see flows that are running at the same time during a specific time range, select a
range for the Start Time filter. For example, select “Next three hours” to see which
flows will be running in the next three hours.

Stats for Space Usage
Use this view to identify which flow outputs are taking up the most disk space on the server.
Disk space usage is displayed by user, project and the size of flow output, and is rounded
down to the nearest number.
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Use the Min Size filter to control which flow outputs are displayed, based on the amount of
space they take up. Use the object type filter for flows.
l

What Users Use the Most Space – This section shows the users who own flows
(when filtered for flows) that are taking up the most space. Click a username to filter
the next two graphs for that user.

l

What Projects Use the Most Space – This section shows the projects with flows
(when filtered for flows) that are using the most space.

l

What Workbooks, Data Source and Flows Use the Most Space – This section
shows the flows (when filtered for flows) that take up the most space.

Who can do this
l

l

Tableau Site Administrators:
l Set up email notifications at the site level
l View errors
l Resume suspended tasks
l View alerts
Flow owners, project leaders and any user who is granted permissions to
view the flow:
l View errors
l Resume suspended tasks
l View alerts (Flow owners)
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Notify Owners When Extract Refreshes Fail
A scheduled extract refresh can fail to complete for a variety of reasons, such as outdated
embedded credentials or file path. For scheduled refreshes that run directly from Tableau
Cloud, after a refresh has failed five consecutive times, Tableau Cloud suspends the schedule until a site admin or the data source owner takes an action to address the cause.
A site admin can enable Tableau Cloud to send email to the owner of a data source when its
scheduled extract refresh does not complete successfully. The data source owner can then
opt out individually in their account settings.
The email contains the following information:
l

Extract or workbook name.

l

The date and time of the last successful refresh. Or, if the last refresh was longer than
14 days ago, the email shows “not in the last N days”.

l

The number of consecutive times the refresh has failed.

l

A suggested action to take to address the cause of the failure, such as updating
embedded credentials or a file path, and a link to Tableau Cloud to take the action.

When receiving email about data sources refreshed by Tableau Bridge, there will be some
differences. For more information, see Differences for Tableau Bridge refresheslater in this
topic.

Enable refresh failure emails
As a site admin, you have the ability to enable (or disable) refresh failure emails for your site
using the procedure below. If you opt in, each user can potentially opt out from receiving
refresh failure emails from his or her individual account.
1. Sign in to Tableau Cloud as a site admin and click Settings.
2. Under Manage Notifications, select or clear the tick boxes to allow or disable
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notifications for all your site users.

Differences for Tableau Bridge refreshes
For data sources that are refreshed through Tableau Bridge, notifications will vary. For
more information, see Manage Email Alerts for Bridge.

Manage Users and Groups
You can add users to your Tableau Cloud site and set their site roles, which determines
each user's level of access. To make it easier to manage multiple users, you can organise
users into groups.

Add Users to a Site
Everyone who needs to access Tableau Cloud – whether to browse, publish, edit content or
administer the site – must be added as a user. Administrators have the following options for
adding users:
l

Enter users’ email addresses individually.

l

Import Users via a CSV file that you create using the CSV Import File Guidelines.

Add users

1. When you’re signed in to the Tableau Cloud site, select Users.
2. On the Users page, click Add Users, and then click Enter Email Addresses.
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3. If Google or SAML authentication is not enabled on this site, skip to the next step.
If Google or SAML authentication is enabled on this site, you can select the authentication type for the new users.
l

Select Add users for [Google/SAML] authentication if you enabled your
site for Google or SAML authentication and want the imported users to sign in to
the site through an external identity provider.

l

Select Add users for Tableau authentication if you want these users to
have the default email address and password authentication.
You can go to the Users page to change users’ authentication type any time
after you add them.

Note: To work with Tableau Cloud by way of tabcmd, the Tableau Data
Extract Utility, or the Tableau APIs, users must authenticate with a
TableauID account.

4. In the Enter email addresses box, enter the users’ email addresses. If you add more
than one user, separate each address with a semicolon.
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For example, tdavis@example.com; jjohnson@example.com; hwilson@example.com
5. Select a site role from the drop-down list, to assign that site role to all users you’re
adding.
For site role definitions, see Set Users’ Site Roles.
6. Click Add Users.
If a new user’s email address is already associated with an account on tableau.com, the
user is prompted to sign in using the existing email address and password for that account.
If a new user’s email address is not already associated with an account on tableau.com, the
user is prompted to provide a first and last name and password.
Until the user provides these values, their entry in the Tableau Cloud user list shows the
email address preceded by a period. For example:
.snguyen@example.com
After the user signs in, the entry is updated to show the full name. For example:
Susan Nguyen

Set Users’ Site Roles
When you add users to a site on Tableau Cloud, independent of their licence type, you must
apply a site role to them. The site role signifies the maximum level of access a user can have
on the site. Along with content permissions, the site role determines who can publish, interact with or only view published content, or who can manage the site’s users and administer
the site itself.

How user licences, site roles and content permissions work together
The intersection of a user’s licence type, site role and content permissions determines the
level of access a user has on the Tableau site.

358

Tableau Software

Tableau Cloud Help
1. The licence type is associated with the user. The site role you want to assign to the
user determines the licence type they require.
If a user is a member of multiple Tableau Cloud sites, they must have a licence for
every site they belong to.
2. The site role is also set at the user level. If a user is a member of multiple Tableau
Cloud sites, they will have independent site roles. For example, the same user can
have the Site Administrator Creator site role on one site and the Viewer site role on
another site.
The site role defines the maximum capabilities the user can have.
3. Whether the site role’s maximum capabilities are available to the user depends on the
permissions set on the content resources (projects, data sources, workbooks).
For example, let's say that a user has the following access on a site:
l
l
l

Creator licence
Explorer site role
Save permission capability on a project

In this scenario, the licence allows connecting to and creating new data sources in the web
editing environment or Tableau Desktop, and a permission rule allows them to save in a project. However, their site role prevents them from being able to save, so their effective permissions don’t include the save capability. Therefore, the user can’t publish content to the
site.
Even if a user has a creator licence and a creator site role, if they don’t have the save capability on at least one project, they can’t publish anything to the site.
For more information, see Permissions.
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Change a user’s site role
1. Sign in to the site as a site administrator, and go to the Users area.
2. Select the users, and then select Actions > Site Role.

3. Select the new site role, and then click Change Site Role.
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You can hover the pointer over the information icon to display a matrix that shows the
maximum level of general capabilities each site role allows. For more information, continue to General capabilities allowed with each site role.

General capabilities allowed with each site role
Note: This information focuses on site roles and is more generalised. For a list of common specific tasks available per licence role, see the matrix on the For Teams & Organisations tab on the Tableau pricing page.

Tableau site roles

Site role name

Maximum capabilities this site role allows

Site roles that use a Creator licence
– Users with these site roles have access to Tableau clients such as Tableau Prep,
Tableau Desktop, Tableau Bridge and Tableau Mobile.
Site Administrator Creator

This is the highest level of access for Tableau Cloud.
Unrestricted access to content as described above, but
at the site level. Connect to Tableau or external data in
the browser, Tableau Desktop or Tableau Prep; create
new data sources; build and publish content.
On Tableau Server, server administrators can determine
whether or not to allow site administrators to manage
users and assign site roles and site membership. By
default, on Tableau Server, and always on Tableau
Cloud, site administrators are allowed these capabilities.

Creator

This is similar to the former Publisher site role, but allows
new features. This site role offers non-administrators the
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Site role name

Maximum capabilities this site role allows
maximum level of content access.
Connect to Tableau or external data in the browser, build
and publish flows, data sources and workbooks, have
access to Dashboard Starters and use interactive features on published views. Can also connect to data from
Tableau Prep or Tableau Desktop, and publish
(upload/save) and download flows, workbooks and data
sources.

Site roles that use an Explorer licence
– Users with these site roles can access the server from the browser or Tableau Mobile.
Site Administrator Explorer

Same access to site and user configuration as Site
Administrator Creator, but can’t connect to external data
or virtual connections from the web editing environment.
Can connect to Tableau published data sources to create
new workbooks, and edit and save existing workbooks.
Can't publish Tableau Prep flows.

Explorer (can publish)

Can publish workbooks from the web using existing data
sources, browse and interact with published views and
use all interaction features.
In the web editing environment, can edit and save existing workbooks. Can't save new stand-alone data
sources from data connections embedded in workbooks,
and can’t connect to external data or virtual connections,
or create new data sources. Can't publish Tableau Prep
flows.

Explorer
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Can browse and interact with published views. Can sub-
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Site role name

Maximum capabilities this site role allows
scribe to content, create data driven alerts, connect to
Tableau published data sources and open workbooks in
the web authoring environment for ad-hoc queries, but
they can’t save their work. Can’t connect to a virtual connection. Can't publish Tableau Prep flows.

Site roles that use a Viewer licence
Viewer

Can see published views others have created and use
most interaction features. Can subscribe to views and
download as images or summary data. Can’t connect to
data, create, edit or publish content or set data alerts.
For a list of specific capabilities, see the Viewer column
in the matrix on the Tableau pricing page.
Note: Although the Viewer site role existed in previous
versions, the new Viewer site role has additional capabilities.

Other site roles
Unlicensed

Unlicensed users can’t sign in to Tableau Server or
Tableau Cloud. Users are assigned the Unlicensed role
in the following circumstances:
l

You import users from a CSV file and their licence
level is set to unlicensed.

l

The number of available licences is reached at the
time you add or import users.

l

You remove a user who owns content on the site.
The user will still own the content but not be able to
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Site role name

Maximum capabilities this site role allows
do anything with it.

Who can publish content
The following site roles allow the specified level of publishing access.
l

Site Administrator Creator; and Creator allow full connecting and publishing
access.
This includes connecting to data and publishing new flows, new workbooks and new
data sources from Tableau Desktop and the web editing environment. The site roles
also allow editing and saving existing published workbooks, or publishing updates to
existing data sources.

l

Explorer (Can Publish) and Site Administrator Explorer have limited publishing
capabilities, as described in General capabilities allowed with each site role.

l

Explorer, Viewer, Read Only and Unlicensed don’t allow publishing.

View, Manage or Remove Users
Administrators can manage a site’s users such as adding and removing users, setting the
groups they’re members of, setting their site roles, and so on.

View and manage users on a site
Sign in to a site as an administrator, and then select Users. On this page you can do any of
the following to manage users:
l

Set group membership, set site role, or remove the user from the site. If you’ve configured the site for SAML single sign-on, you can set the selected users’ authentication type.

364

Tableau Software

Tableau Cloud Help

l

Select a user name to see details about them, such as content they own, views they
subscribe to, and their account settings.

Search for users
To search for a specific user
Use the filter toggle in the upper right to display the search box and site role filter. Then use
the search box or filters to find the users you want.
The search operation checks the display name and user name attributes.
You can use the asterisk (*) character as a search wildcard. For example, searching for
John* will return all user names that start with John.
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Remove users from a site
You can remove a user only if the user does not own any content (projects, workbooks,
views or data sources). If you attempt to remove a user who owns content, the user site role
will be set to Unlicensed, but the user will not be removed.
If the default All Users group has enabled Grant site role on sign-in, that user's content must
be reassigned to another user or removed before they can be unlicensed or removed. For
more information on Grant role on sign-in, see Removing users affected by Grant role on
sign-in. For more information on changing content ownership, see Manage Content Ownership

Note: On Tableau Server, when an administrator removes a user from a site (and the
user belongs only to that one site), the user is also deleted from the server.

1. Sign in to a site as an administrator, and go to the Users area. Select one or more
users to remove, and then select Actions > Remove.

2. Click Remove in the confirmation dialog.
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Set the User Authentication Type
On a Google or SAML-enabled site, administrators can specify users’ authentication type.
For example, which users can access Tableau Cloud using their single sign-on credentials.
You can assign authentication type at the time you add users to Tableau Cloud, as well as
any time afterward.
1. When you’re signed in to the Tableau Cloud site, select Users.
2. On the Site Users page, tick the boxes next to the users you want to assign an authentication type.
3. On the Actions menu, select Authentication.

4. In the Authentication dialog box, select Google or Tableau with MFA.

Notes
l

If you change users’ authentication from Tableau with MFA to Google, the next time
they sign in, they will be directed to your identity provider’s site to provide their credentials.

l

If users were signing in using their external Identity Provider credentials, and you
change their authentication type to Tableau, if they do not have existing Tableau credentials, they will receive email from Tableau with instructions for creating new
Tableau credentials.

l

Tableau recommends that you dedicate a site administrator account that is always
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configured for Tableau with MFA authentication. In the event of an issue with your
Identity Provider, a dedicated Tableau account ensures that you always have access
to your site.
l

See Multi-Factor Authentication and Tableau Cloud for more information about the
Tableau with MFA authentication option.

Import Users
To automate the process of adding users to a site, you can create a CSV file that contains
user information, and then import the file. When you import the CSV file, you also specify
the users’ authentication type.
Site administrators can import users to a particular site; server administrators (Tableau
Server only) can import users at the server level, to later add them to multiple sites.

Note: This topic contains the steps for importing, assuming that you have already created the CSV file. If you have not created the file yet, see CSV Import File Guidelines
for a list of file format requirements and import options.

Add users from a CSV file
1. When you’re signed in to the Tableau Cloud site, select Users.
2. Click Add Users, and then click Import From File.
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The options you have in the Import Users dialog box depend on how users sign in to
the site.
3. If Google or SAML authentication is not enabled on the site, skip to the next step.
If Google or SAML authentication is enabled on the site, you can select the authentication type for the new users.
l

Select Add users for Google authentication if you enabled your site for
Google or SAML authentication and want the imported users to sign in to
Tableau Cloud through an external Identity Provider.

l

Select Add users for Tableau authentication if you want these users to
have the default email address and password authentication.

4. For File name, click Browse, navigate to the CSV file, and click Open.
5. To see account-specific information, select View Details.
To continue, click Import Users, and then click Exit in the final dialog box.
If a user already exists in the Tableau Cloud site, and the import file defines a different
site role for them, they will get the new site role as defined in the CSV file, even if it is
more restrictive than their current site role. This includes existing site administrators.
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CSV Import File Guidelines
You can automate adding users by creating a comma-separated values (CSV) file with user
information and then importing the file. You can include attributes in the CSV file, such as
licence level and the publishing access, to apply to the users at the same time you import
them.
To import users, you can use the site administration page or the tabcmd utility. Using tabcmd provides an option for assigning a site role to all users in the CSV file. For information,
see Import Users or createsiteusers filename.csv.

CSV file format requirements
When you create the CSV file for importing users, make sure that the file meets the following formatting requirements:
l

The file does not include column headings. Tableau Cloud assumes that every line in
the file represents a user.

l

The file is in UTF-8 format, and includes the byte-order mark (BOM).

l

Character encodings such as BIG-5 have been converted to UTF-8. You can do this
by opening the file in a text editor and using the Save As command.

l

If a user name includes an @ character that represents anything other than a domain
separator, you need to refer to the symbol using the hexadecimal format: \0x40
For example, user@fremont@mycompany.com should be user\0x40fremont@mycompany.com

Required columns in the CSV file
The following value is required for each user:
l
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User name: The user’s email address.
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Additional CSV column options
For each user, the CSV file can contain the following fields. Where indicated, Tableau Cloud
does not use the field, but it must be accounted for in the file.
l

User name. The user’s email address. This is the only required column.

l

Password. Tableau Cloud does not use this field, but you need to delimit it in each row
to position the subsequent fields correctly.

l

Display name. Tableau Cloud does not use this field, but you need to delimit it in each
row to position the subsequent fields correctly.

l

Licence level. This can be Creator, Explorer, Viewer or Unlicensed.

l

Administrator level. This can be Site or None.

l

Publishing capability. Acceptable values are Yes/True/1 or No/False/0.

CSV file sample entries

The following example shows a user who will be granted the Explorer site role, will not be a
site administrator, and will be able to publish to projects on which they have the appropriate
content permissions.
user1@domain.com,,,Explorer,None,true
By changing the administrator-level column, you can import the following user as a site
administrator with the Site Administrator Explorer site role.
adminuser@domain.com,,,Explorer,Site,true
Notes
l

If the CSV file contains only user name values (email addresses), the users will
receive an email invitation to the site. Users can join the site to create their accounts,
but the accounts remain unlicensed until an administrator configures the accounts
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(display name, licence level, and so on).
l

The password (second value) and display name (third value) fields are not used by
Tableau Cloud. Values you do specify for those fields are ignored.
However, if you want to set the licence and publish access for the users, your file still
needs to include delimiters for these fields, as shown in the example earlier.

l

New users must select a password and a display name when they first sign in to
Tableau Cloud. If users already have a Tableau account, such as for the Tableau
Community forums, they already have passwords.

l

The CSV file does not include a field for setting authentication type (Tableau, Google,
or SAML). You specify this inTableau Cloud when you import the file. The setting
applies to all imported users, and you can change authentication type for individual
users afterward.

Note: Alternatively, you can use tabcmd to import users and set the authentication type and site role that applies to all users in the CSV file. For information,
see createsiteusers filename.csv.

CSV settings and site roles
The licence level, administrator, and publishing settings for a user determine how the user's
site role is set during the import process. The following table shows how the settings are converted to site roles.
CSV settings

Site role

Licence level=(any)

Server Administrator. This setting applies to
Tableau Server only, and it is valid only if you are

Administrator=System
Publisher=true
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CSV settings

Site role

Licence level=Creator or

Site Administrator Creator or Site Administrator

Explorer

Explorer. This setting is valid only if you are importing users while signed in to a specific site.

Administrator=Site
Publisher=true
Licence level=Creator

Creator

Administrator=None
Publisher=true
Licence level=Explorer

Explorer (Can Publish)

Administrator=None
Publisher=true
Licence level=Explorer

Explorer

Administrator=None
Publisher=false
Licence level=Viewer

Viewer

Administrator=None
Publisher=false
Licence level=Unlicensed

Unlicensed

Administrator=None
Publisher=false
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Manage Site User Visibility
By default, all site users can see aliases, project ownership and comments by other users
when permissions allow. The User Visibility setting lets administrators manage if users with
Viewer and Explorer site roles see other users and groups on the site, which can be important for sites that are used by multiple clients. To learn more about site roles, see Set Users’
Site Roles.

Limit user visibility
Setting User Visibility to Limited impacts certain collaboration tools and hides user information in Tableau Cloud and Tableau Server. Limited User Visibility either disables the feature for Viewers and Explorers (excluding Site Administrator Explorers), or removes user
information from other areas. Note that Creators and administrators will still see user information when User Visibility is set to Limited.
To limit user visibility for Explorers and Viewers (excluding Site Administrator Explorers):
l

Navigate to the site's Settings page

l

Select Limited in the User Visibility setting

The following is a list of site areas impacted when User Visibility is set to Limited. Unless
noted that the feature is disabled for all users, only non-administrator Explorers or Viewers
are impacted.
Area

Impact

Search

User information not displayed

Content owners

User information not displayed (Explorers and Viewers can't
see themselves, but can see their content in My Content)
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Profile pictures

User information not displayed

Subscriptions

User information not displayed
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Recommendations

Similar users not displayed (all users)

Add/Edit Tags

Explorers and Viewers can see tags but cannot delete or modify
them

"Who has seen this

Disabled

view?"
Ask Data usage ana-

Disabled

lytics
Permissions dialogs

Disabled

Named sharing

Disabled (all users)

Alerts

Disabled (all users)
Existing alerts paused

Comments

Disabled (all users)

Public Custom Views

Disabled (all users)
Existing public custom views appear as private

Request Access

Disabled (all users)

Tableau Desktop

Publishing workbooks disabled from Desktop
User information not displayed on user filters

Tableau Catalog (with

User information not displayed

Data Management)

When User Visibility is set to Limited, Tableau Server REST API and Metdata API calls
behave as described in the table above.
Users on a site can interact with views and modify them, such as applying filters. If that user
shares their modified view with others, or if the user creates something from that modified
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view (like a metric or a private custom view), then that user's name appears in the URL.
Make sure that the URL for this modified view is only distributed to users who are permitted
to see that person's name.

Note: If a user is a member of multiple sites, entering an email on the sign-in page for
Tableau Cloud will return the names of all sites that the user is a member of.

Best practices for limiting user visibility

Administrators can also check that user and group information is not visible in these ways:
l

Configure permissions to only provide content to appropriate parties. For more information, see Permissions.
l Limited User Visibility hides user identification information from search, but
might return content that the user published, including when searching by
l

l
l
l

owner name, if the person searching has viewing permission to that content.
A user publishing a workbook with a duplicate title in the same project might

see a warning that a workbook with that title already exists.
Apply row-level security when necessary.
Check that metadata within dashboards does not contain user information.
Check that calculations accessible to users don't contain user metadata (e.g. user filters).

Restore Full User Visibility
When administrators set User Visibility back to Full, features disabled for all users by Limited User Visibility (such as comments and alerts) remain off. Administrators can re-enable
these features through the site's Settings page.
Any previous feature settings are not retained when User Visibility is set to Full, and
affected features are not automatically turned on.
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Enable Support Access
Tableau Cloud administrators can allow approved Tableau Support technicians to access
their Tableau Cloud site to help troubleshoot a customer support case. By default, this feature is disabled for all sites. Enable the feature to allow support access.
1. In a web browser, sign in to Tableau Cloud as a site administrator and go to the site in
which you want to enable support access.
2. From the navigation panel, click Settings.
3. Under Tableau Support Access, select Let Tableau Support access your site.
4. Click Save.
When enabled, Tableau Support technicians are assigned the Support User role and granted administrator-level access to your site and its content. Tableau Support technicians use
this access to gather information to diagnose and reproduce issues. Tableau Support technicians do not make changes to your site unless you authorise them to do so.
Only Tableau Support technicians can be assigned the Support User role. You cannot add
this role to new or existing site users. Users assigned the Support User role do not count
against the site's user limit. To view users who have the Support User role on the site, click
the Users tab.

Disable Support Access
When you disable support access, users with the Support User role who are signed on to the
site are automatically signed out. If you do not disable support access, users with the Support User role will be automatically deleted after 16 days. Any content owned by the Support
User will be reassigned to the longest-tenured site administrator.

Create a Group and Add Users to It
You can organise Tableau Cloud users into groups to make it easier to manage multiple
users.
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Create a group
1. In a site, click Groups, and then click New Group.
2. Type a name for the group.

Optionally, select Grant role on sign-in and select a minimum site role for the
group. For more information, see Grant Licence on Sign-in.
3. Click Create.

Note: The All Users group exists in every site by default. Every user added to the
server becomes a member of the All Users group automatically. You cannot delete this
group, but you can set permissions for it.

Add users to a group (Users page)
1. In a site, click Users.
2. Select the users you want to add to the group, and then select Actions > Group
Membership.
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3. Select the groups and then click Save.

Add users to a group (Groups page)
1. Click Groups, and then click the name of the group.
2. In the group's page, click Add Users.

Tableau Software

379

Tableau Cloud Help
3. Select the users to be added, and then click Add Users.

Grant Licence on Sign-in
Grant licence on sign in (Grant role on sign in) lets unlicensed users in specific groups
become licensed when they sign into a Tableau site. This streamlines license provisioning
for administrators and removes the user’s need to request a licence before using Tableau.
For more information about site role capabilities and minimum site roles, see Set Users’ Site
Roles.
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For example, imagine that your company has 100 people in the Marketing group, but only 25
members need to access Tableau Cloud. The Tableau Cloud administrator isn't sure which
25 need Tableau. That administrator can create a Marketing user group with an Explorer minimum site role, select Grant role on sign in, and add all 100 Marketing members to the
group. Instead of provisioning licences to the entire group, the 25 Tableau users in Marketing
are provisioned Explorer licences when they sign in to their Tableau Cloud site. Those who
don't need Tableau Cloud remain unlicensed unless they sign in.

Note: For more information about benefits and best practices, see Grant Role on Sign
In in Tableau Blueprint, Tableau's planning tool for data-driven organisations.

Activate Grant role on sign in
You can enable Grant role on sign in on new or existing groups. The following steps walk
through how to use Grant role on sign in to add new users that are eligible for a licence but
may not consume one. This may be the case when your company has a lot of eligible users,
but limited Tableau licences.
1. In a site, add a new group:
l

Click Groups, and then click New Group.

l

Add a group name.
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l

Select Grant role on sign in and select a minimum site role for the group.
This setting means licences and site roles will only be provisioned to group
users who sign into this Tableau Cloud site.

l

Click Create.

2. Add users to a site, either by entering users’ email addresses individually, or Import
Users via a CSV file that you create using the CSV Import File Guidelines.

l

Enter email addresses if adding individually. For information on using Google
or SAML authentication when adding users, see Add Users to a Site.
If you add more than one user, separate each address with a semicolon.
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For example, tdavis@example.com; jjohnson@example.com;
hwilson@example.com
l

Set the site role for those users to Unlicensed.

l

Click Add Users.

3. Add those new unlicensed users to the new group.
l

Click Groups, and then click the name of the group.

l

In the group's page, click Add Users.

l

Select the users to be added, and then click Add Users.

For more information, see Create a Group and Add Users to It.

Modifying user roles with Grant role on sign-in
If a user is part of a group using Grant role on sign-in, then that user role can't be set to unlicensed or downgraded to a role lower than the minimum site role set for the group, whether
or not they sign in. Administrators can upgrade a user’s site role manually, however.
To downgrade a user’s site role, or unlicense the user from the site, remove the user from
the group(s) that have Grant role on sign-in enabled.
In accordance with the terms of the End User Licence Agreement, licences granted on an
Authorised User basis may be permanently reassigned to new users. Users may only be
downgraded to a lower site role (including Unlicensed) when they will permanently discontinue access to Server Software at the higher role.
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Removing users affected by Grant role on sign-in
You can remove a user from a site only if the user does not own content. If you attempt to
remove a user who owns content, the user site role will be set to Unlicensed and removed
from all groups, but the user will not be removed from the site. To remove content owners,
remove owners from group with Grant site role enabled, or reassign content ownership to
another user. For more information, see Remove users from a site in the View, Manage or
Remove Users help topic.
If the default All Users group has Grant site role enabled, users who own content can't be
removed from the site or unlicensed. To remove or unlicense these users, reassign content
ownership to another user, then remove or unlicense the user.
REST API can be used to reassign content ownership of a workbook. For more information, see Update Workbook in the REST API documentation. REST API can also be used
to remove users from the site and transfer content ownership to another user. For more
information, see Remove User from Site in the REST API documentation.
For more information on reassigning content ownership in Tableau Cloud, see Manage
Content Ownership.

Buy More Licences
You can scale your Tableau Cloud deployment at any time by purchasing additional
licences through the Tableau Webstore.

What accounts are eligible?
To buy more licences through the Webstore, you must meet the following requirements:
l

Customer Portal account administrator.

l

Not a Government or Non-Profit account.

If you are not currently eligible, contact our sales team to complete a transaction.
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Access the Tableau Webstore
Complete the following steps to redirect and buy more licences through the Tableau Webstore:
1. Sign in to the Tableau Cloud site as a site administrator and go to the Users page.
2. On the Users page, click Buy More Licences, and then click Go to Webstore. The
Webstore will open in a separate browser tab.

3. Sign in to the Webstore using your Tableau account. You may not be prompted to sign
in if you previously authenticated to the Customer Portal.
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4. Select the number of Creator, Explorer and Viewer licences to add using the dropdown menus.

5. Click Add to Current Deployment and continue to the Contact & Billing and
Summary & Payment sections of the Webstore.
You should receive order confirmation and information about your new licences within 10
minutes. The new licences will appear in your Tableau Cloud site shortly after payment.
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Manage Content Access
You can manage who can access content on your site and set the permissions that govern
content ownership.

Set Web Edit, Save, and Download Access on Content
If you’re enabling web authoring functionality on your site, you can configure more precisely
which users on the site have access to this functionality. Using site roles and permissions
rules at the content level, you can grant or deny Web edit, Save, or Download capabilities
on projects, workbooks, and data sources.

Note: This document strives to use the phrase Web edit to specify the name of the capability in permissions rules, and web authoring to refer to the general functionality of creating and modifying workbooks on the server. However, you might otherwise see these
two phrases used interchangeably.

Why allow users to work on the site directly
As an administrator, your initial thought about allowing people to populate a site with content,
seemingly indiscriminately, might be one of scepticism. However, with a few controls, you
can limit where this is done, while providing important benefits that centralised content management offers both you and your users.
Web authoring pros and cons

For publishers and business users, some benefits of web authoring include the following:
l

It provides analyst teams who work collaboratively with a central location in which to

l

provide input.
It enables people who do not have Tableau Desktop to connect to data sources and
create workbooks.
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l

It enables people to access content when they are away from their Tableau Desktop

l

computer or VPN, whether on a computer or a hand-held device.
It can provide a framework for enabling consistency across Tableau reports.(By making template workbooks available on the site, analysts can download or create new
workbooks with data connections, branding and formatting already in place.

For administrators, benefits can include the following:
l
l
l
l

Fewer Tableau Desktop deployments to manage and support.
Fewer computers that need to have database drivers installed.
Capacity to govern content.
More accurate monitoring of what people are doing with Tableau.

Some disadvantages to web editing include the following:
l

For analysts, web editing functionality is not as extensive as in Tableau Desktop

l

(although it continues to evolve toward that parity).
For administrators, more people working on the server might mean upgrading sys-

l

tems.
Without publishing guidelines, content proliferation on the site is expected.
This can confuse the people who rely on published Tableau dashboards and data
sources, degrade server performance and data quality, and potentially affect data
security.

Managing permissions to help users avoid content proliferation
To help users to avoid content proliferation on the site, many Tableau administrators use
projects to allow varying levels of access to content. For example, one project can be configured to allow all users to edit and save workbooks; another can allow only approved publishers to save new content.
To get a better idea how this works, see the following resources:
l
l
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Configure Projects, Groups and Permissions for Managed Self-Service
Governed Self-Service at Scale, a Tableau White Paper by Rupali Jain.
To view the PDF, you might need to provide your Tableau website credentials. These
are the same ones you use for the community forums or to submit support cases.
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Coordinate edit and save capabilities with site roles for the appropriate
level of access
To edit, save, and download workbooks, users must have a site role that allows those
actions, along with the capabilities – defined in permissions rules – that grant or deny editingrelated access.
Site role access
l

When the appropriate permissions are set at the content level, the Creator or

Explorer (can publish) site role allows both Save (overwrite) and Save As/Download.
Note that File > Save is only available to the workbook owner. When the Save permission capability has been granted at the project and workbook level, a non-owner
user can overwrite the existing workbook in web authoring by selecting File > Save
As and using the same workbook name. This overwrites the existing content and they
become the owner and gain full access to the content.
l

The Explorer site role can be granted the Web Edit and Save As/Download capabilities, but they will not be able to save (neither overwriting existing nor saving
changes to a new workbook).

For more information, see Web Editing and Web Authoring.

Configure Projects, Groups and Permissions for Managed
Self-Service
Publishing to Tableau Cloud and Tableau Server is easy. For some organisations, it might
be a little too easy. There is value in creating a controlled framework before letting creators
publish their own content.
To keep things tidy and to make sure people can find and access the right content, it may be
useful to configure your site for managed self-service. This means having guidelines and settings in place to ensure content is organised, discoverable and secure without having bottlenecks in the publishing process.
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This article lays out a possible path for you as a site administrator to set up your site for managed self-service:
1. Identify the types of groups and projects you’ll need
2. Create groups
3. Remove permissions that will cause ambiguities and establish default permission patterns
4. Create projects
5. Lock project permissions

Note: The information provided here is adapted and simplified from practices of
Tableau Visionaries and customers who have shared their experiences.

Plan your strategy
Permissions in Tableau consist of rules that are applied to content (projects, workbooks,
etc.) for a group or user. These permission rules are built by allowing or denying specific capabilities.

Having a comprehensive plan for your projects, groups and permission rules is useful
whether you’re starting anew or making changes. The details are up to you, but there are
two important practices that we recommend for all environments:
l
l

Manage permissions on projects, not individual pieces of content.
Assign permissions for groups, not individual users.

Setting permissions at the individual user level and on individual content assets becomes
unmanageable quickly.
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Use a closed permissions model

General models for setting permissions are open or closed. In an open model, users get a
high level of access, and you explicitly deny capabilities. In a closed model, users get only the
access they need to do their jobs. This is the model security professionals advocate. The
examples in this topic follow a closed model.
For more information on how Tableau permissions are evaluated, see Effective permissions.

Identify the types of projects and groups you’ll need
Designing a structure to accommodate content (in projects) and categories of users (as
groups) can be the most challenging part of setting up a site, but it makes ongoing management much easier.
Projects: Projects function both as a unit for managing permissions and as an organisational and navigational framework. Try to create a project structure that balances how
people expect to find content and allows for logical permissioning.
Groups: Before you create groups, it can be useful to find common themes in how people
interact with content. Try to identify patterns you can use to create groups and avoid one-off
permissions for individual users.

Example: Project and group structure
For example, let’s imagine an environment where there is company-wide content that everyone should be able to access, as well as some HR content that needs to be restricted.
Projects include:
l

Acme Corp Conference. This will include data sources and workbooks for ticket
sales, dashboards for content strategy and project plans for the company conference.

l

Employee Success. This will include anonymised data sources and workbooks for
the internal employee survey
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l

Human Resources. This will include HR data sources and workbooks that should
only be available to members of the HR team.

Then, groups should match what people need to do:
l

Core Content Creators. This group is for users who can publish to top-level projects and have broad access to data sources, but who don’t need to be able to move
or otherwise manage content.

l

HR Content Creators. This group is for users who have access to HR data sources
and can publish to the HR project.

l

Business Users. This group is for users who should be able to access the content created by the Core Content Creators, but shouldn’t even know the HR content exists.

l

HR Users. This group is for users who should be able to access content in the HR
project but don’t have rights to create or publish content.

l

Core Project Leaders. This group is for users who should be given project leader
status on the projects that aren’t HR.

Consider site roles

Remember that permissions are tied to content, not groups or users. This means that you
can’t give a group Explore permissions in a vacuum. Rather, the group can be given
Explore permissions for a project and its content. Site roles, however, are given to specific
users and may define or limit the permissions they can have. For more information on how
licences, site roles and permissions tie together, see Permissions, Site Roles and Licences.

Create the groups
While it might be tempting to create the groups and projects as soon as you identify what
you need, it’s important to do things in a certain order.
Projects: Projects shouldn’t be created until after the Default project has been properly configured (see the next section). This is because top-level projects use the Default project as a
template for their permission rules.
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Groups: Groups need to be created before they can be used to build permission rules.
Users do not need to be added to the groups yet, but they can be. For more information on
creating groups, see Manage Users Using Groups.
For more information on adding users to groups, see Add Users to a Group.
Tip: Creating multiple groups and projects and setting permissions manually can get a little
tedious. To automate these processes and make them repeatable for future updates, you
can perform these tasks using REST API commands. You can use tabcmd commands for
tasks such as adding or deleting a single project or group and adding users, but not for setting permissions.
Membership in multiple groups

It’s possible to include the users in the HR Content Creators and HR Users groups in the
Business Users group. This would make it easy to assign permissions to Core Content
Users versus Business Users for the majority of content. However, in that scenario, the Business Users group couldn’t be denied any capabilities in the Human Resources folder without
denying the HR users as well. Instead, the Business Users group would have to be left as
unspecified, and the specific HR Content Creators and HR Users groups would be given
their applicable capabilities.
This is because Tableau permissions are restrictive. If the Business Users group was denied
certain capabilities, that Deny would override the Allow of another permission rule for users
in both groups.
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When deciding how group membership should be assigned, it’s important to understand
how permission rules are evaluated. For more information, see Effective Permissions.

Remove permissions that will cause ambiguities and establish default
permission patterns
Every site has an All Users group and a Default project .
All Users group: Any user added to the site becomes a member of the All Users group
automatically. To avoid any confusion with permission rules set on multiple groups, it’s best
to remove the permissions from the All Users group.
Default project: The Default project works as a template for new projects in the site. All
new top-level projects will take their permission rules from the Default project. Establishing
baseline permission patterns on the Default project means you will have a predictable starting point for new projects. (Note that nested projects inherit the permission rules from their
parent project, not the Default project. )
Remove the permission rule for the All Users group on the Default project
1. Select Explore to see the top-level projects on the site.
2. On the Default project’s Action (…) menu, select Permissions.
3. Next to the All Users group name, select …, and then select Delete Rule….
This lets you establish permission rules for the groups that you have full control over without
any conflicting permissions assigned to All Users. For more information on how multiple
rules are evaluated to determine effective permissions, see Effective Permissions.
Create permission rules

Now you can set up the basic permission patterns for the Default project that all new toplevel projects will inherit. You may choose to keep the Default project’s permission rules
empty and build permissions for each new top-level project individually. However, if there
are any permission rules that should apply to the majority of projects, it can be helpful to set
them on the Default project.
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Remember that the permissions dialog for a project contains tabs for each type of content.
You must set permissions for each type of content at the project level, or users will
be denied access to that content type. (A capability is only granted to a user if they are
expressly allowed it. Leaving a capability as Unspecified will result in it being denied. For
more information, see Effective Permissions.)
Tip: Every time you create a permission rule at the project level, make sure you look through
all the content-type tabs.
Create permission rules as desired:
1. Click + Add Group/User Rule and start typing to search for a group name.
2. For each tab, choose an existing template from the drop-down or create a custom rule
by clicking the capabilities.

3. When finished, click Save.
For more information on setting permissions, see Set Permissions.

Example: Project level permissions for each content type
For our example, the majority of projects should be available to most people. For the default
project, we’ll use the permission rules templates to give the core content creators publishing
rights and everyone else the ability to interact with workbooks and not much else.
Group

Core Content Creat-

Projects

Workbooks

Data

(Other con-

Sources

tent)

Publish

Publish

Publish

View

View

Explore

View

None

ors
HR Content Creators
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Business Users

View

Explore

View

None

HR Users

View

Explore

View

None

Set as project

N/A

N/A

N/A

Core Project Leaders

leader

This pattern follows a closed model and limits permissions to basic usage for most content
for most users. As new top-level projects are created, these rules are what will be inherited
by default, but the permission rules can be modified per project as needed. Remember that
the Human Resources project should have these permissions removed and its own pattern established.

Create projects and adjust permissions
After the Default project is set with your custom permissions templates, you can create the
rest of your projects. For each project, you can adjust the default permissions as appropriate.
To create a project
1. Select Explore to see the top-level projects on the site.
2. From the New drop-down, select Project.
3. Name the project and, if desired, give it a description.
It can be useful to establish a naming convention. For example, a basic structure might be
<DepartmentPrefix><Team> - <ContentUse>; such as DevOps - Monitoring.
The description appears when you hover over a project thumbnail and on the Project
details page. A good description can help users know they’re in the right place.
4. Adjust permissions as necessary.
a. Open the new project.
b. From the Action menu (...), select Permissions
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c. Modify any permission rules as desired. Remember to check all the content
tabs.

Lock content permissions
In addition to permission rules, projects have a content permission setting. This setting can
be configured in two ways, either Locked (recommended) or Customisable.
Locking a project is a way of maintaining consistency and ensuring that all content in the project has uniform permissions (per content type). A customisable project permits authorised
users to set individual permission rules on pieces of content. For more information, see Lock
content permissions.
Regardless of the content permission setting, permissions are always enforced on content.

Possible project structures
Some organisations find it useful to have projects that serve specific purposes. Here are
some example projects and their intended uses. Note that these are example templates and
you should always test the configuration in your environment.
For information about what capabilities are included with each content type’s permission rule
templates, see Permission capabilities.

Examples: permission settings for specific purposes
Workbooks shared for open collaboration on the server

Anyone in the department can publish to the open-collaboration project while their content is
in development. Colleagues can collaborate using web editing on the server. Some people
call this a sandbox, some call it staging, and so on. On this project you can allow web editing,
saving, downloading, and so on.
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Here you want not only to enable collaboration, but also to enable people who don’t have
Tableau Desktop to contribute and provide feedback.
Group

Projects

Workbooks

Data Sources

(Other content)

Data Stewards

Publish

Publish

Publish

TBD

Analysts

Publish

Publish

Explore

TBD

Business Users

Publish

Publish

Explore

TBD

Remember that some capabilities in the Publish template (such as Overwrite) may be prevented by a user’s site role even if they are allowed that capability.

Note: "TBD" indicates these permission rules aren't easily determined by the scenario
and can be set however makes sense for a given environment.

Shared reports that cannot be edited

This could be a project that people who create workbooks and data sources (Analysts and
Data Stewards) could publish to when they want to make content available to business
users for viewing, with confidence that their work cannot be “borrowed” or modified.
For this type of project, you would deny all capabilities that allow editing or getting the data
off of the server for reuse. You would allow viewing capabilities.
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Projects

Workbooks

Data Sources

(Other content)

Data Stewards

Publish

TBD

Publish

TBD

Analysts

Publish

Publish

View

TBD

Business Users

View

View

None

None
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Vetted data sources for Analysts to connect to

This would be where Data Stewards publish the data sources that meet all your data requirements and become the “source of truth” for your organisation. Project leaders on this project
can certify these data sources, so that they rank higher in search results and are included in
recommended data sources.
You would allow authorised Analysts to connect their workbooks to data sources in this project, but not download or edit them. You would deny the view capability to the Business
Users group for this project, so those users would not even see this project.
Group

Projects

Workbooks

Data Sources

(Other content)

Data Stewards

Publish

TBD

Publish

TBD

Analysts

View

None

View

None

Business Users

None

None

None

None

Inactive content

Another possibility is to segregate workbooks and data sources that the site’s administrative
views show haven’t been used for a period of time. You could give content owners a time
limit before their content is removed from the server.
Whether you do this or delete directly from the working projects is up to your organisation. In
an active environment, don’t be afraid to be intentional about removing content that is not
being used.
Group

Projects

Workbooks

Data Sources

(Other content)

Data Stewards

None

None

None

None

Analysts

View

View

TBD

TBD
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Business Users

None

None

None

None

Source for workbook templates

This is a project that people can download from but not publish or save to, where authorised
publishers or project leaders make template workbooks available. Templates that have your
organisation’s approved fonts, colours, images and even data connections built in can save
authors a lot of time and keep your reports looking consistent.
Group

Authorised

Projects

Workbooks

Data

(Other

Sources

content)

Publish

Publish

Publish

TBD

None

None

None

None

View

Template: Explore

View

None

None

None

Author
Data Stewards
Analysts

+
Capability: Download Workbook/Save a Copy
Business

None

None

Users

Next steps
Besides projects, groups and permissions, other data governance themes include:
User education
Help all of your Tableau users become good data stewards. The most successful Tableau
organisations create Tableau user groups, have regular training sessions, and so on.
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For a common approach to orienting users to the site, see Dashboard-based Custom
Portals.
For publishing and data certification tips, see the following topics:
l

Use Certification to Help Users Find Trusted Data

l

Prepare for Publishing a Workbook (links to Tableau Help)

l

Best Practices for Published Data Sources (links to Tableau Help)

Optimise extract refresh and subscription activity
If you use Tableau Server, create policies for extract refresh and subscription schedules, to
avoid them dominating the site’s resources. The TC customer presentations by Wells Fargo
and Sprint address this subject in detail. In addition, see the topics under Performance Tuning.
If you use Tableau Cloud, see the following topics to become familiar with the ways people
can refresh extracts:
l

Keep Data Fresh

l

Use Tableau Bridge to Expand Data Freshness Options

Monitoring
Use administrative views to keep an eye on the site’s performance and content use.
Administrative Views

Use Projects to Manage Content Access
When Tableau Desktop users publish content to a site on Tableau Cloud, they can select a
project to publish it to.
Projects can be used for navigation, organisation and access management for content like
workbooks, data sources, Ask Data lenses and nested projects.
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The following image shows content within the top-level Operations project in the web authoring environment. The Operations project contains a few nested projects (highlighted) and
published workbooks. A project can also contain other content types, such as data sources
and flows.

Why use projects
Projects help you to create a scalable process for managing access to the content published
to Tableau Cloud. Advantages they have include:
l

They enable administrators to delegate content management to project leaders who
work with the content more closely, without having to give them administrator access
to site or server settings.
l Project leaders can create nested projects under their top-level project,
enabling them to maintain their team’s content within a single hierarchy.
l
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Note: Project owners can delete top-level projects they own. Project leaders
cannot delete top-level projects.
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l

They can make the site easier to navigate for self-service users.
l They segment the Tableau Cloud site into areas that give users access based
on how they use the data published to those areas, or on the Tableau user
l

group they work with.
You can hide projects from groups who don’t need to use them, create a distinguishable project-naming scheme, and take advantage of project descrip-

l

tions to clarify how to use the project.
They enable you to track permissions effectively.
l You can create groups based on the level of content access users in the group
need, and set default permissions on projects. This enables you to know exactly
which capabilities new users get by default, and likewise which capabilities all
users get when a new project is created.

When to create project hierarchies (example)

Many organisations have several or more distinct groups of Tableau users, each with its own
priorities and leaders. These groups might share some organisation-wide content (or even
draw from an org-wide pool of data sources), but primarily they use data and reports that are
specific to their team. In this or similar scenario, an example for using project hierarchies
might look as follows:
1. You, as a site or server administrator, can create top-level projects for each of your distinct Tableau teams.
2. On each top-level project, you assign the Project Leader status to team leads, and
change project ownership. Project leaders effectively are the content administrators,
so it’s important that they understand how permissions work in Tableau, along with
Tableau content management best practices.
3. Each project leader can manage their project, creating the structure within the project
that works for their team. That is, they can create child projects they need, based on
how their team members collaborate and share data and reports.
The benefit to you as the site administrator is that you can focus on system health. The benefit to your Tableau users is that people who know the best practices for working with Tableau
and data can manage these things for their teams, without having to submit IT requests to
change permissions or add projects.
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Project-level administration
For more information about administering projects, see Manage Permissions with Projects.

Add Projects and Move Content Into Them
Tableau content (such as workbooks, data sources or metrics) must be in a project. Starting
in Tableau Server 2022.3 and Tableau Cloud October 2022, external assets (databases
and tables) can also be in projects. Server and site administrators can add or remove toplevel projects on a site, and move published content from one project to another. Project
leaders with appropriate site roles can add or remove child projects and move content
between projects on which they have Project Leader access.
This article contains the steps for creating and moving projects. We recommend becoming
familiar with the following related content as well:
l

To learn about projects and when or why to use them, see Use Projects to Manage
Content Access.

l

Before you create project hierarchies, become familiar with Permissions.

l

To see the specific site roles that allow full Project Leader access, see Project-level
administration.

Add a top-level or child (nested) project

1. While you’re signed in to Tableau Cloud as an administrator or project leader, select
Explore and then do one of the following:
l

Select New > Project to create a new top-level project (only administrators
can do this).

l

Navigate to and open the project in which you want to create a sub-project,
and then select New > Project. If you’re not sure where to find the child pro-
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ject, select All Projects from the drop-down menu next to Explore or use the filters in the upper right.
2. Enter a name and description for the project, and then click Create.

You can include formatting and hyperlinks in the project description. Select Show
formatting hints for syntax.
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Note: To edit a project description later, select it to open it, select the information
icon next to its name, and then click Edit.

Move an asset to another project

1. In the Explore section, find the asset you want to move. You can use the filters in the
upper right to search, or you can navigate through the project hierarchy.
2. On the workbook’s Actions(…) menu, select Move.
3. Select the new project for the workbook, and then click Move Content.

Moving a project involves moving everything in it, including child projects and their
assets.
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How moving projects affect permissions

When you move a project, Project Leader permissions adapt to the new project environment.
l

When the target project hierarchy is Locked, previous Project Leader permissions are
removed, and new Project Leader permissions are granted according to those set at
the top-level of the target hierarchy.

l

When the target project hierarchy is Customisable, previous implicitly granted Project Leader permissions are removed, explicitly set Project Leader permissions are
retained and new Project Leader permissions are granted according to those set at
the top-level of the target hierarchy.

When you move a project and assets, permissions may be impacted. For more information,
see Permissions.
Delete a project

When you delete a project, all the Tableau content in the project is also deleted. If you want
to delete a project but not its content, move the content to another project, and then delete
the project.
External assets, such as databases and tables, will not be deleted but will be removed from
the project. You can still find them in External Assets.
Important
l

You cannot undo deleting a project.

l

Deleting a project deletes all content in it, including child projects and their content.

l

You cannot delete the Default project.

To delete a project:
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1. In the Explore section, find the project you want to remove. If you’re not sure where
to find the project, select All Projects from the drop-down menu next to Explore or
use the filters in the upper right.
2. On the project’s Actions (…) menu, select Delete.
3. Confirm that you want to delete the project.
Requirements for moving assets

Moving an asset is effectively like removing it from one project and publishing it to another.
For non-administrators, the permissions needed on the source project are different from
those needed on the destination project.
Required site role

To move assets, users must have one of the following site roles:
l

Server Administrator (Tableau Server only)

l

Site Administrator Creator or Site Administrator Explorer

l

Creator or Explorer (can publish)

Users with a Server Administrator or Site Administrator site role do not need any additional
capabilities.
Required permissions for the project that users move content to

Non-administrators must have the Publish permission capability for the destination project.
Required permissions for the project that users move content from

Non-administrator users must
l

Be the project owner, project leader or content owner for the original project
OR

l
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Have the Move permission capability for the content (or, for data sources, be the data
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source owner). When moving a database with its tables, the user must have the Move
capability for both the database and its tables.
For more information on moving assets, see Move content.

Add a Project Image
To help distinguish projects you manage on Tableau Cloud (and help your users find them),
you can add an image that appears in the thumbnail. Your image must meet the following
requirements:
l

The image must be accessible using HTTPS protocol. Shared network directory and
related protocols (UNC, SMB, AFP, NFS, etc) are not supported. HTTP protocol for pro-

l

ject images is not supported by Google Chrome.
All users who access the project must have, at a minimum, "read-only" permission on

l

the target image.
The image must be common internet format: .jpg, png, or gif.
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Set a project image

1. Sign in to a site on Tableau Cloud. In the list of Top-level Projects you have access
to, select or navigate to the project you want to update. In this example, we'll add an
image to the Statistics project folder.
If you're not sure where to find a child project, use the Explore drop-down list and
select All Projects.
2. Click the Details icon (i), to open the Project details dialog box, and then click Edit.

3. In the About field, you can enter a description for your project (optional), for example
"Global and US statistics". At the end of the project description, add the URL for your
image using the following syntax:
!http://www.example.com/image.png!
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Select Show formatting hints to see how you can format description text.

Note: Images embedded in project descriptions cannot be resized or positioned.
Recommended size is (300 x 184 pixels). Images that are not 300 x 184 pixels
may be stretched, shrunk or cropped to fit the width of the thumbnail. In addition,
they must be added at the end of the project description and be enclosed in !
(exclamation marks), otherwise they will not be displayed as the thumbnail.

4. Click Save.
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Let Site Users Request Access to Content
Permissions determine if a user has viewing access to workbook, view, or content inside a
project. If an existing site user clicks on content or a project they don’t have access to, they
can select Request Access to send a request to the owner controlling permissions for that
piece of content.

When someone requests access, the owner who controls permissions for that content
(either at the project or workbook level) receives an email with the name and email of the
requester, the content or project requested, and a link to the project or content controlling
permissions on the requested item.
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For example, if a user requests access to a workbook and content permissions are locked to
the project, then the project owner receives the request. Likewise, if a user requests access
to a workbook and project permissions are managed by the workbook owner, then the workbook owner receives the request.
Once permission is granted, the owner can email the requester to let them know they have
view capability to the project or workbook.

Default settings
The Request Access setting is enabled by default on a new site. To enable the setting if it's
been disabled:
1. Go to the General tab of the Settings page for your site.
2. On the General tab, scroll down to Request Access and select Let users request
access to projects, workbooks and views.
3. Click Save.

Configure project permissions
You can control who will receive the access request by adjusting the project’s content permissions. If content permissions are:
l
l

Locked to the project: the project owner receives the request.
Managed by the owner: The workbook owner receives the request.

To manage content access using projects, see Use Projects to Manage Content Access and
Permissions.
For more information about how permission rules are evaluated, see Permissions: Evaluate
permission rules.

Change project permissions
For administrators and project leaders
Permissions can be set at the project level for both the project itself and for any content in the
project. For example, if workbook permissions are configured at the project level, all
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workbooks published into that project inherit those default permissions. However, the
Creator can choose to change the permissions during publishing, or certain users can
change the permissions on published content. To enforce the permissions established at
the project level, Content Permissions can be locked to the project. For more information,
see Lock asset permissions.
To set permissions at the project level:
1. Navigate to the project
2. Open the Actions menu (...) and click Permissions. The permissions dialog box
opens.
This dialog box has two main areas: permission rules at the top and the effective permissions grid below. Use the tabs to navigate between types of content.
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With a row selected at the top, the effective permissions grid populates. Use this to
verify permissions. Hovering over a capability indicator provides information about
why the capability is allowed or denied for that specific user.
3. To modify an existing permission rule, select the rule and click the capability boxes to
toggle through allowed/denied/unspecified.
4. To create a new rule,
a. Select + Add Group/User Rule.
b. Select a group or user from the drop-down box. This creates a row where you
can configure the permission rule.
5. In the row for the permission rule
a. choose an existing permission role template from the drop-down box for each
content type tab.

b. Or create a custom rule by navigating to a content type tab and clicking the capabilities. One click sets the capability to Allowed, two clicks sets it to Denied
and a third click clears the selection (Unspecified).

6. When finished, click Save.

Change content permissions
For administrators, project leaders and content owners
If project permissions are not locked, permissions for individual pieces of content can be modified.
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Warning: Tableau recommends managing permissions at the project level within the
Tableau site. These steps are relevant only for content in projects where permissions are
managed by the owner.
Set permissions on content

1. Navigate to the content (workbook, data source, flow, data role)
2. Open the Actions menu (...) and click Permissions. The permissions dialog box
opens.
This dialog box has two main areas: permission rules at the top and the effective permissions grid below.

With a row selected at the top, the effective permissions grid populates. Use this to
verify permissions. Hovering over a capability square provides information about why
the capability is allowed or denied for that specific user.
3. To modify an existing permission rule, open the Actions menu (...) for that row and
click Edit.
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4. To create a new rule,
a. Select + Add a user or group rule.
b. If necessary, use the drop-down box on the right to change between groups and
users.
c. Select a group or user from the drop-down box. This creates a row where you
can configure the permission rule.
5. In the row for the permission rule, choose an existing permissions role template from
the drop-down box or create a custom rule by clicking the capabilities.
One click sets the capability to Allowed, two clicks sets it to Denied and a third click
clears the selection (Unspecified).
6. When finished, click Save.
Set permissions on a view

In some situations, it may be valuable to specify permissions on a view independently from
the workbook that contains it. To set permissions on a published view, navigate to the view
within a published workbook and follow the steps above.
Warning: While it is possible to set view-level permissions within a workbook, we strongly
recommend managing permissions at the project (or workbook) level as much as possible.
For views to inherit permissions, the project must be locked or the workbook must be published with Show Sheets as Tabs. See Let Site Users Request Access to Content for more
information.

Permissions
Permissions determine how users can interact with content such as workbooks and data
sources. Permissions are set in the permission dialog or via the REST API. At the top of the
dialog, permission rules configure capabilities for groups or users. Below, the permissions
grid displays the effective permissions for users.
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There are several interrelated topics that discuss how to think about, set and manage permissions. The main topics are:
l

This topic, which covers the fundamentals, how to set permission rules for projects
and other content and permission considerations for specific scenarios.

l

l

l

l

Permission Capabilities and Templates, which covers in detail the various capabilities
that are used to build permission rules.
Manage Permissions with Projects, which covers using projects to manage permissions and how nested and locked projects impact permissions.
Effective permissions, which covers how permission rules are evaluated and how
final permissions are determined.
Permissions, Site Roles and Licences, which covers how permissions interact with
site roles and licences to determine what a user can do on a site.

Additionally, if Data Management is licensed, permissions for external assets have additional considerations. For more information, see Manage Permissions for External Assets.
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Permissions fundamentals
Projects and groups
Tableau sites use projects to organise content and groups to organise users. Managing permissions is easier when permission rules are:
l
l

Set at the project level instead of on individual pieces of content.
Established for groups instead of individuals.

Permissions can only be established for users, groups, projects or assets that already exist.
For more information about creating users and groups, creating projects and publishing content, see Manage Users and Groups, Use Projects to Manage Content Access, and Publish
Data Sources and Workbooks.
Capabilities and permission rules
Permissions are made up of capabilities – the ability to perform actions like view content,
web edit, download data sources or delete content. Permission rules establish which capabilities are allowed or denied for a user or group on an asset.
For more information about capabilities and permission rule templates, see Permission Capabilities and Templates.

Note: When talking about permissions in general, it’s common to see a phrase like "a
user must have the delete permission". This is easy to understand in a broad context.
However, when working with permissions at a technical level like in this article, it’s more
accurate to say "the delete capability". In this topic we’ll use the more precise term capability, but you should be aware that you might see permission in other places.
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For a breakdown of the capability icons and their meanings, see Permission Capabilities
and Templates.
The interplay between licence level, site role and potentially multiple permission rules factor
into the final determination of what a user can or can’t do. For each user, this becomes their
effective permissions. For more information, see Effective permissions.
Some tasks such as creating new workbooks from a browser (web authoring) or moving
content might require specific configurations of several capabilities rather than being captured in a single capability. For more information, see Permission settings for specific scenarios.

Set permissions
Permission rules are set differently at the project level, at the content level or when publishing content from Tableau Desktop.

Note: The phrase "project permissions" can have two meanings. There are the permission capabilities for a project itself – View and Publish – that control how a user can
interact with a project. There is also the concept of project-level permission rules for
other content types. In this article “project-level permissions” means permission rules
for workbooks, data sources and the other assets that are configured in the permission
dialog for a project. This is in contrast to “content-level” permission rules that can be set
on a specific workbook, data source, etc.

Project-level permissions
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For administrators, project owners and project leaders
To set permissions at the project level:
1. Navigate to the project
2. Open the Actions menu (...) and click Permissions.

The permissions dialog opens. This dialog has two main areas: permission rules at the
top and the effective permissions grid below. Each content type has a tab. The image
below shows the Workbook tab.
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With a row selected at the top, the effective permissions grid populates. Use this to
verify permissions. Hovering provides information about why the capability is allowed
or denied for that specific user.
3. To modify an existing permission rule, select the appropriate tab for that content type
and click a capability.
4. To create a rule, click + Add Group/User Rule and start typing to search for a group
or user. For each tab, choose an existing template from the drop-down box or create
a custom rule by clicking the capabilities.
One click sets the capability to Allowed, two clicks sets it to Denied and a third click
clears the selection (Unspecified).
5. When finished, click Save.

422

Tableau Software

Tableau Cloud Help
Set project permissions for all content types

Remember that the permissions dialog for a project contains tabs for each type of content.
You must set permissions for each type of content at the project level, or users
will be denied access to that content type. A capability is only granted to a user if they’re
expressly allowed it. Leaving a capability as Unspecified will result in it being denied.
Tip: Every time you create a permission rule at the project level, make sure you look through
all the content-type tabs.
Configure the asset permissions setting

Permission rules set at the project level act as a default for content saved in that project and
any nested projects it contains. Whether those project-level default rules are kept uniform or
are able to be edited depends on the Asset permissions setting. This setting can be configured in two ways, either Locked or Customisable. For more information, see Lock asset
permissions.

Content-level permissions
For administrators, project leaders and content owners
If project Asset permissions are Customisable, permissions for individual assets can be
modified. The information below isn’t relevant to assets in locked projects. For more information, see Lock asset permissions.
Tip: While it is possible to set permissions on individual assets in Customisable projects, we
recommend managing permissions at the project level.
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Set permissions on assets

1. Navigate to the asset (such as a workbook, data source or flow)
2. Open the Actions menu (...) and click Permissions.

The permissions dialog opens. This dialog has two main areas: permission rules at
the top and the effective permissions grid below. (Note the lack of tabs across the top
– an asset-level permissions dialog has no tabs.)
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With a row selected at the top, the effective permissions grid populates. Use this to
verify permissions. Hovering over a capability square provides information about why
the capability is allowed or denied for that specific user.
3. To modify an existing permission rule, click a capability.
4. To create a rule, click + Add Group/User Rule and start typing to search for a group
or user. Choose an existing template from the drop-down or create a custom rule by
clicking the capabilities.
One click sets the capability to Allowed, two clicks sets it to Denied and a third click
clears the selection (Unspecified).
5. When finished, click Save.
Set permissions on a view

Tip: While it’s possible to set view-level permissions within a workbook, we strongly recommend managing permissions at the project (or, if necessary, workbook) level.
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If a workbook is published with Show Sheets as Tabs ticked, the views in that workbook
will inherit all permissions set for the workbook. The permission dialog for a view will be
read-only.
In some situations, it may be valuable to specify permissions on a view independently from
the workbook that contains it. If the workbook is published with Show Sheets as Tabs
unticked (sheet tabs hidden), the views will start with the workbook permissions but will be
independent thereafter and can be set independently. Note that this means if the permission rules are modified for the workbook, those changes won’t be applied to the views –
each view’s permissions will need to be managed individually.
See Show or Hide Sheet Tabs for more information.

Set permissions at publish
For content publishers
If project Asset permissions are Customisable, permissions for individual assets can be
set when publishing from Tableau Desktop. The information below isn’t relevant for content
in locked projects. For more information, see Lock asset permissions.
Tip: While it’s possible to set permissions on individual assets in Customisable projects,
we recommend managing permissions at the project level.
1. From the publishing dialog, click the Edit link for Permissions.
If the Edit link is unavailable, permissions are locked to the project and can’t be modified except by the project owner, project leader or an administrator.
2. The Add/Edit Permissions dialog shows any existing permission rules. Click Add to
add a permission rule or Edit to modify an existing permission rule
a. Select the group or user from the left pane. You can expand a group to see
which users it contains.
b. Use the selector at the top of the right pane to choose an existing template, or
use the radio buttons to create a custom rule.
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Note that effective permissions can’t be inspected from the publishing dialog.
3. When finished, click OK and resume publishing.

Note: Permissions can’t be set while publishing flows from Tableau Prep Builder. To set
permissions on a flow, refer to the steps for Project-level permissions or Content-level
permissions.

Clean up the All Users group

By default, all users are added to an "All Users" group that has basic permissions for content.
To start with a clean slate when building your own permission rules, we recommend that you
delete the rule entirely or edit the rule for All Users to remove any permissions (set the permission role template to None). This helps prevent any ambiguity down the road by reducing
the number of rules that applies to any given user and therefore making effective permissions easier to understand.
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Permission settings for specific scenarios
Certain actions require combinations of permission capabilities and possibly site roles. The
following are some common scenarios and their necessary permission configurations
Saving, publishing and overwriting

In the context of permissions, saving is essentially publishing. As such, the Overwrite and
Save a Copy capabilities can only be given to users with a site role that allows
publishing: Administrator, Creator or Explorer (can publish). Explorer or Viewer site roles
can’t publish, overwrite or save a copy.
l

The Publish capability for a project allows a user to publish content into that project.

l

The Overwrite capability allows a user to save over an existing piece of content. By
saving over the content, the user becomes the owner of that content. The Overwrite
capability also allows users to edit minor aspects of existing pieces of content, such as
the description for a metric or the synonyms for a data role. Editing the existing content in this way doesn't change the owner of the content.

l

The Save a Copy capability allows a user to save a new copy of the content. This is
usually done in conjunction with web authoring and means the user can save their
modifications.

It’s important to note that users aren’t able to Save or Save As a piece of content unless
they have the Publish capability for at least one project, because all content must be published into a project. Without the Publish capability at the project level, the content can’t be
published.
In web editing, the Save option in the File menu only appears to the content owner. If a user
who isn’t the owner has the Overwrite capability (allowing them to save the content), they
must use File > Save As and name the workbook the exact same name. This prompts a
warning that they’re about to overwrite the existing content, which they can do. Conversely,
a user with only the Save a Copy capability trying to use the same name gets an error stating they don’t have permission to overwrite the existing content.
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If a user who isn’t the content owner overwrites content, they become the owner, with all the
permissions that entails. The original owner’s access to the content is then determined by
their permissions as a user rather than the owner.

Note: Download Workbook/Save a Copy is a joint capability for workbooks.
Explorers can be given this capability, but they’re only able to download the workbook,
not save a copy. Giving the capability to Explorer (can publish), Creator or Administrator
site roles gives them both the ability to download workbooks and save a copy.

Web Editing and Web Authoring

Web editing and web authoring allows users to edit or create workbooks directly in the
browser.
The permission capability is called Web Edit and the site setting is called Web Authoring.
This section refers to any web-based editing or publishing action as web authoring.
To enable this functionality, there are several requirements.
l

l

User site role: The user must have the appropriate site role.
l Viewers can never web edit.
l Explorers can be given the web edit capability but can’t publish. Essentially, they
can use web editing to answer deeper questions based on existing content on
the fly, but can’t save their edits.
l Explorers (can publish) or Site Administrator Explorers can publish, but they can
only use data that is already published to the site.
l Creators, Site Administrator Creators and Server Administrators can publish
and create data sources.
Permission capabilities: The user must have the necessary permission capabilities
based on the desired functionality.

Required Permission Capability Settings
Desired

Minimum

functionality

Site Role
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Optional
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content

Optional indicates this capability isn’t involved in the desired functionality
Data access for published Tableau data sources

Data sources published to a Tableau site can have native authentication as well as permissions within the Tableau environment.
When the data source is published to the Tableau site, the publisher can choose how to Set
Credentials for Accessing Your Published Data, which addresses how data source credentials are handled (such as requiring users to log in to a database or enter their credentials for Google Sheets). This authentication is controlled by whatever technology holds
the data. This can be embedded when the data source is published, or the data source pub-
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lisher can choose to prompt the user for their credentials to the data source. For more information, see Publish a Data Source.
There are also data source capabilities that allow or deny users the ability to see (View) and
connect to the published data source (Connect) in the context of Tableau. These capabilities are set like any other permissions in Tableau.
When a workbook that uses a published data source is published, the author can control how
the Tableau authentication behaves for someone consuming the workbook. The author sets
the workbook’s access to the published data source, either as Embed password (using the
author’s Connect access to the data source) or Prompt users (using the Connect access of
the person viewing the workbook), which may require data source authentication as well.
l

When the workbook is set to Embed password, anyone who looks at the workbook
sees the data based on the author’s access to the data source.

l

If the workbook is set to Prompt users, the Tableau-controlled access is checked for
the data source. The person consuming the workbook must have the Connect capability for the published data source to see the data. If the published data source is also
set to Prompt user, the viewer must also enter their credentials for the data source
itself.

Workbook

Data source

How data access is evaluated for someone con-

authentication to

authentication

suming the workbook

the data source

to the data

Embed pass-

Embed pass-

User sees the data as if they were the workbook

word

word

author

Embed pass-

Prompt user

User sees the data as if they were the workbook

word

author. (The author is prompted for data source
authentication, not the user.)

Prompt user

Prompt user

Embed pass-

User must have their own Connect capability to the

word

published data source

Prompt user

User must have their own Connect capability to the
published data source and are prompted for their cre-
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dentials to the underlying data

Note that this applies to consuming a workbook, not web editing. To web edit, the user must
have their own Connect capability.
For information on embedding passwords when you publish Tableau content such as a
data source or workbook that uses a virtual connection, see Virtual connections in the
Tableau Server help.
Move content

To move an item, open its Action menu (...) and click Move. Select the new project for the
item, then click Move Assets. If Move is unavailable or there are no available destination
projects, verify that the appropriate conditions are met:
l
l

l

Administrators can always move assets and projects to any location.
Project leaders and project owners can move assets and nested projects among their
projects.
l Note that non-administrators can’t move projects to become top-level projects
Other users can move assets only if all three of the following requirements are met:
l Creator or Explorer (Can Publish) site role.
l

Publishing rights (View and Publish capabilities) for the destination project

l

Owner of the content, or – for workbooks and flows – having the Move capability.

When moving a database with its tables, the user must have the Move capability for both
the database and its tables.
For information about how permissions are handled when moving content and projects, see
Move projects and content.
Metrics

Metrics are created from views in published workbooks. Users can create metrics if they:
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l

Are a Creator or Explorer (can publish) site role

l

Have the Publish capability on a project

l

Have the Create/Refresh Metric capability for the relevant workbook
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For more information, see Create and Troubleshoot Metrics and Set Up for Metrics.

Note: Prior to 2021.3, the ability to create a metric on a view was controlled by the
Download Full Data capability.

Because metrics are independent assets, it’s important to note that the permissions for metrics are managed independently from the view they were created from. (This is unlike datadriven alerts and subscriptions, where the content of the alert or subscription can only be
seen if the user has the correct permissions for the view itself.)
Although the capabilities for metrics are straightforward, the View capability should be considered carefully. It may be possible for a workbook with restricted permissions to be the
basis for a metric with more open permissions. To protect sensitive data, you might want to
deny metric creation for specific workbooks.
Metrics display data from their owner’s perspective

When you create a metric, you capture your perspective of the data from that view. This
means that any users who can access your metric will see the data as it appears to you. If the
data in the view is filtered based on your credentials, the data you see might be different from
what other users see when they access the same view. Limit the View capability for your metric if you're concerned about exposing your perspective of the data.
Show or Hide Sheet Tabs

In the context of published content, sheet tabs (also referred to as tabbed views) is a distinct
concept from sheet tabs in Tableau Desktop. Showing and hiding sheet tabs in Tableau
Desktop refers to hiding sheets in the authoring environment. For more information, see Manage Sheets in Dashboards and Stories.
Showing and hiding sheet tabs (turning tabbed views on or off) for published content refers
to navigation in a published workbook. When sheet tabs are shown, published content has
navigational sheet tabs along the top of each view.

Tableau Software

433

Tableau Cloud Help

This setting also impacts how permissions function and may have security implications (see
note).

Note: It’s possible to have the View capability for a view without the View capability for
the workbook or project that contains it. Normally if a user lacks the View capability for a
project and workbook, they wouldn’t know those assets exist. If they have the View capability for a view, however, a user may be able to see the project and workbook name
when looking at the view, such as in the navigational breadcrumb. This is expected and
accepted behaviour.

Turn off tabbed views to allow independent view permissions

Although it isn’t recommended as a general practice, there are times when it can be useful
to set permissions on views independently of the workbook that contains them. To do so,
three conditions must be met:
1. The workbook must be published – there’s no way to set view permissions during publishing.
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2. The workbook must be in a customisable project.
3. The workbook can’t show sheets as tabs (tabbed views must be hidden).
When a workbook shows sheets as tabs, all views inherit the workbook permissions and any
changes to the workbook permissions affect all of its views. When a workbook in a customisable project doesn’t show tabbed views, all views assume the workbook permissions upon publication, but any subsequent changes to the workbook’s
permission rules won’t be inherited by the views.
Changing the configuration of sheets as tabs on a published workbooks will also impact the
permission model. Show Tabs overrides any existing view-level permissions and reinstates
the workbook-level permissions for all views. Hide Tabs breaks the relationship between the
workbook and its views.
l

To configure sheets as tabs on a published workbook, open the Actions menu (...) for
the workbook and select Tabbed Views. Choose Show Tabs or Hide Tabs as desired.

l

To configure sheets as tabs during publishing, refer to Show sheets as tabs.

l

To set view-level permissions, see Set permissions on assets.

Important: In a customisable project, any modifications to the workbook-level permissions
won’t be applied if navigational sheet tabs are hidden (aka tabbed views are off). Changes to
permissions must be made on individual views.
Collections

Unlike projects, which contain content, a collection can be thought of as a list of links to content. Project permissions can be inherited by the content in the project, but permissions for a
collection have no effect on the content added to the collection. This means that different
users might see different numbers of items in a collection, depending on which items they
have permission to view. To make sure that users can see all items in a collection, adjust the
permissions for those items individually.
Permissions for a collection can be changed either by using the permissions dialog or by
granting access upon sharing a collection, if you’re an administrator or the collection owner.
For more information, see Manage Collection Permissions.
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Private collections

When a collection is created, it’s private by default. A private collection appears on the
owner’s My Collections page, but it doesn't appear in the list of all collections on a site. Private collections are simply collections with no permission rules added. Unlike other types of
content, collections don't have the “All Users” group added by default. When you add permission rules to a collection, it’s no longer flagged as private. To return a collection to a
private state, remove the permission rules.
Private collections can be viewed by the collection owner as well as by administrators,
whose site role gives them effective permissions to view all collections.
Explain Data

When Explain Data is available, a user can select a mark in a view and click Run Explain
Data in the mark’s Tooltip menu. A combination of settings must be enabled to make
Explain Data available in editing mode and viewing mode.
Requirements for authors to run Explain Data or edit Explain Data settings in editing mode:

l

Site setting: Availability of Explain Data set to Enable. Enabled by default.
Site role: Creator, Explorer (can publish)

l

Permissions: Run Explain Data capability set to Allowed. Unspecified by default. If

l

you open a workbook (Tableau version 2022.1 or earlier) that used this permission in
Tableau version 2022.2 or later, you must reset the Run Explain Data capability to
Allowed.

Note: The Download Full Data capability for a Creator or Explorer (can publish) controls whether they see the View Full Data option in Extreme Values explanations. Viewers are always denied the Download Full Data capability. However, all users can see
record-level details when the Extreme Values explanation type is enabled in Explain
Data settings.

Requirements for all users to run Explain Data in viewing mode:
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l

Site setting: Availability of Explain Data set to Enable. Enabled by default.
Site role: Creator, Explorer or Viewer

l

Permissions: Run Explain Data capability set to Allowed. Unspecified by default. If

l

you open a workbook (Tableau version 2022.1 or earlier) that used this permission in
Tableau version 2022.2 or later, you’ll need to reset the Run Explain Data capability to
Allowed.
Ask Data Lenses

By default, users with a site role of Explorer (can publish) and Creator have the Overwrite
capability for lenses. This means that any user with the appropriate role can edit the name,
description, fields, synonyms and suggested questions for a lens.
To limit who can edit a lens, deny the Overwrite capability for specific users or entire groups.
To limit all lenses in a project, deny the Overwrite capability for lenses at the project level.

Permission Capabilities and Templates
Permissions are made up of capabilities, or the ability to perform a given action on a piece of
content, such as view, filter, download or delete. Each row in the Permission Rules area of
the dialog is a permission rule. Permission rules are the setting for each capability (allowed,
denied or unspecified) for the group or user in that row. Permission rules have templates
available that make it easier to assign capabilities quickly. Permission rules can also be
copied and pasted.

Note: In the permission dialog for projects, there are tabs for each content type: Projects, Workbooks, Data Sources, Data Roles, Flows, Ask Data Lenses, Metrics
and – if you have the Data Management – Virtual Connections, Databases and
Tables. (Virtual connections were added in Tableau Server 2021.4 and Tableau Cloud
December 2021. Databases and tables were added in Tableau Server 2022.3 and
Tableau Cloud October 2022.) When a permission rule is added, the default for all capabilities across all content types is Unspecified. To allow or deny capabilities for each
content type, you must go to each tab in turn. In the permission dialog for a specific piece
of content, there are no tabs and the permission rules only apply to that piece of content.

Tableau Software

437

Tableau Cloud Help
Templates

Templates group sets of capabilities that are often assigned together based on common
user scenarios, View, Explore, Publish and Administer. When you assign a template, its
included capabilities are set to Allowed, with the rest left as Unspecified. The templates
are cumulative, so the Explore template includes everything from the View template plus
additional capabilities. All content also has a template for None (which sets all capabilities to
unspecified) and Denied (which sets all capabilities to denied).
Templates are meant to be a starting point and can be adjusted after they are applied. Capabilities can also be granted or denied without using a template at all. In both cases, the template column then shows Custom.
Copy and paste permissions

If there is a permission rule that needs to be assigned to multiple groups or users, you can
copy and paste from one rule to another. You can’t copy from or paste onto a rule that
involves Project Leader status.
1. Open the action menu (...) for the existing rule you want to copy from and select Copy
Permissions. This is available only when the rule is not in edit mode.
2. Select an existing rule you want to paste over. You can also create a new rule by clicking + Add Group/User Rule and selecting a group or user.

3. Open the action menu (...) and select Paste Permissions.
Capabilities

Each content type has specific capabilities:
Projects

Projects have only two capabilities and two templates. For more information about project
leaders and how to assign them, see Project administration.
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View template
View lets a user see the project. If a user hasn’t been granted the view capability, the project won’t be visible to them. Granting the view capability for a project does not mean a user
can see any content in the project, just the existence of the project itself.

Publish template
Publish lets a user publish content to the project from Tableau Desktop or Tableau Prep
Builder. The publish capability is also required to move content into the project or save content to the project from web authoring.
Workbooks

View template
View lets a user see the workbook or view. If a user hasn’t been granted the view capability, the workbook won’t be visible to them.
Filter lets a user interact with filters in the view, including keep-only and exclude filters.
Users lacking this capability won’t see filter controls in the view.
View Comments lets a user view the comments associated with the views in a workbook.
Add Comments lets a user add comments to views in a workbook.
Download Image/PDF lets a user download each view as a PNG, PDF or PowerPoint.
Download Summary Data lets a user view the aggregated data in a view, or in the
marks they’ve selected, and download that data (as a CSV).
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Explore template
Share Customised lets users add their custom views to the list of “Other Views” visible
on a workbook.
l

When this capability is denied, users won’t see the “Make visible to others” option
when they create a custom view. For more information, see Use Custom Views. This
capability doesn’t impact the ability to share a custom view with the share dialog or by
copying the link.

Download Full Data lets a user view the underlying data in a view, or in the marks
they’ve selected, and download that data (as a CSV).
Web Edit lets a user edit the view in a browser-based authoring environment.
l

Note that creating new content in the browser or saving views from the web edit interface requires a specific combination of capabilities. For more information, see Web

l

Editing and Web Authoring.
The Web Editing feature must also be enabled for the entire site or even users with
this capability allowed won’t be able to web edit. For more information, see Set a

Site's Web Authoring Access.

Run Explain Data lets a user run Explain Data on marks in editing and viewing mode.
l

Note that for Explain Data to be displayed as an option when a user selects a mark in
a workbook, the feature must also be enabled as a site setting. To make Explain Data
available in viewing mode, the feature must also be allowed by the author from within
a workbook in Explain Data settings. For more information, see Control Access to

Explain Data.

Publish template
Download Workbook/Save a Copy lets a user download a packaged workbook (as a
TWBX). Lets a user save (publish) a copy from the web edit interface as a new workbook.
Overwrite lets a user overwrite (save) the content or asset on the server.
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l

When allowed, the user can re-publish a workbook, data source or flow, or save a workbook or flow in web authoring, thereby becoming the owner and gaining access to all
permissions. After this change in ownership, the original owner’s access to the workbook is determined by their permissions just like any other user.

Create/Refresh Metrics lets a user create metrics on the views in a workbook and lets
any metrics that a user creates from those views refresh. For more information, see Create
and Troubleshoot Metrics.

Administer template
Move lets a user move workbooks between projects. For more information, see Move
content.
Delete lets a user delete the workbook.

Set Permissions lets a user create permission rules for the workbook.
Views

In a workbook that is not in a locked project and does not show sheets as tabs for navigation,
views (sheets, dashboards, stories) inherit the workbook permissions at publication, but any
changes to permission rules must be made on individual views. View capabilities are the
same as those for workbooks, except for Overwrite, Download Workbook/Save a Copy
and Move which are only available at the workbook level.
We recommend showing navigational sheet tabs whenever possible so views continue to
inherit their permissions from the workbook.
Data Sources

View template
View lets a user see the data source on the server.
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Connect lets a user connect to a data source in Tableau Desktop, Tableau Prep
Builder, Ask Data or web editing.
l

If a workbook author embeds their credentials to a published data source in a published workbook, they are essentially embedding their Connect capability. Therefore, users can see the data in the workbook regardless of their own Connect
capability for that data source. If the workbook author doesn’t embed their credentials
to the published data source, the user needs their own Connect capability to the data
source to consume the workbook. For more information, see Data access for pub-

l

lished Tableau data sources.
A user must have the Connect capability for a data source to use Ask Data and to create Ask Data lenses. For more information, see Enable Ask Data for Sites and Data

Sources.

Explore template
Download Data Source lets a user download the data source from the server (as a
TDSX).

Publish template
Overwrite lets a user publish a data source to the server and overwrite the data source
on the server.

Administer template
Delete lets a user delete the data source.

Set Permissions lets a user create and edit permission rules for the data source.

Other types of assets
View template
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Flows

View lets a
user view the
flow.

Download
flow lets a user
download the
flow (as a
TFLX).

Run lets a

Move lets a

user run the

user move

flow.

assets between
projects. For

Overwrite

more inform-

lets a user pub-

ation, see Move

lish a flow and

content.

overwrite the
published flow.
Data Roles

View lets a

n/a

Delete lets a
user delete the

Overwrite

user view data

lets a user pub-

roles.

lish data roles,
overwrite pub-

asset.
Set Per-

lished data

missions lets a

roles and edit

user create per-

published data

mission rules for

roles' syn-

the asset.

onyms.
Metrics

View lets a

n/a

Overwrite

user view met-

lets a user over-

rics.

write a metric
and edit a metric's details.

Ask Data
Lenses

Virtual Connections
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lens.

the lens.

View lets a

n/a
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nection.

Connect*
lets a user connect to data
using a virtual
connection.
Databases

View lets a

n/a

Overwrite

user see the

lets a user edit

database.

the metadata
for the database.

Tables

View lets a

n/a

Overwrite

user see the

lets a user edit

table.

the metadata
for the table.

Collections

View lets a

n/a

n/a

n/a

user view collections.

*By default, virtual connections have a Custom template that sets the View capability to
Allowed but not the Connect capability. Be sure to set the Connect capability to Allowed so
that users can connect using the virtual connection.

Manage Permissions with Projects
Using projects can simplify permission management through features such as nested project hierarchies, hiding projects from certain users or groups, authorising project leaders
and locking permissions.
Tip: How permissions are set at the project level is very important, especially for the Default
project. When a new top-level project is created, it inherits its default permission rules (for all
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content types) from the Default project. When a new project is created nested inside another
project, the child project inherits its default permission rules from the parent project.
Project administration

Projects are containers used to organise and manage access to content. By giving nonadministrators privileges to manage projects, certain content administration tasks can be
handled at the project level.
Project Leaders: Projects can have project leaders, users who have been set as a
project leader. This setting automatically grants a user their maximum capabilities –
depending on their site role – for that project and all content in that project. Project leaders
with site role of Explorer (can publish) and above will therefore have all capabilities. Project
leaders are essentially local admins for the project without access to site or server settings.
Hierarchy: Only administrators can create top-level projects. Project owners and project
leaders can create nested projects inside their projects. Project owners and leaders have full
administrative access to the project and its content, as well as any nested projects it contains.
In a hierarchy, project leaders are implicitly given project leader access to all child content. To
remove project leader access, you must do so at the level in the hierarchy where the role was
explicitly assigned.
Ownership: A project can have multiple project leaders, but each project has exactly one
owner. By default, a project is owned by the user who created it. A project’s owner can be
changed (by the existing owner or an administrator, but not a project leader) to any user with
a site role of Explorer (can publish) or Creator, or an administrator site role. Project ownership can be changed regardless of whether the project permissions are locked. Note that
this refers to project ownership. Content ownership can be changed by project owners, project leaders and administrators.
Deleting: Content can only exist inside a project. (External assets can exist outside of projects, however. See External assets that are not in projects for information.) Only administrators can create and delete top-level projects, but project leaders can create or delete
nested projects. Deleting projects also deletes all the Tableau content and nested projects
they contain. External assets that were in the project are not deleted, but are removed from
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the project and continue to appear in External Assets. To delete a project without losing its
content, move the content to another project first. Deleting projects can’t be undone.
For a deeper dive into project administration, see Use Projects to Manage Content Access
and Add Projects and Move Content Into Them.
Set a project leader

Project leaders are users who have administrator-like access for a specific project or project
hierarchy.
To assign project leader status to a group or user
1. Open the permission dialog for the appropriate project.
2. Select an existing permission rule, or click + Add Group/User Rule and chose the
desired group or user.
3. Open the action menu (...) for that permission rule and select Set Project Leader....

Note: If the action menu includes an option for Enable “Set Project Leader”, this will
need to be selected before the group or user can be set as a project leader. This option
only appears when that group or user was denied the Project Leader capability (prior to
2020.1). That denied capability needs to be removed before they can be set as a project leader.

Once a permission rule establishes a group or user as a project leader, the templates and
capabilities are no longer editable because all capabilities are allowed for project leaders. If
a project leader is established on a project that contains nested projects, they will have inherited project leader status on all nested projects and their content.
Project leader status is always applied downward through the entire project hierarchy and
can only be removed from the level where it was set. To remove project leader status, follow
the same steps as above but select Remove as Project Leader from the action menu.
Once a group or user has been removed as project leader, that permission rule will have all
capabilities set to Unspecified. This may mean their access to and capabilities for that
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project will be removed if there is no other permission rule giving them permissions to the content. To keep their access to the project and its content, they will need to have capabilities set
like any other group or user.
Lock asset permissions

Permission rules set at the project level act as a default for content saved in that project and
any nested projects it contains. Whether those project-level default rules are enforced or only
preliminary depends on the Asset permissions setting. This setting can be configured in
two ways, either Locked (recommended) or Customisable. Locking a project removes the
ability for content owners to modify the permission rules on their content. Locking permissions can be applied to nested projects or just to the parent project itself.
l

When Asset permissions is Locked (including nested projects), permission rules
set at the project level are enforced for all assets in the project and all nested projects.

l

When Asset permissions is Locked (not including nested projects), permission
rules set at the project level are enforced for assets in the project, but nested projects
can be configured independently with their own permission rules and as locked or customisable.

l

When Asset permissions is Customisable, permission rules set at the project level
are applied to all assets in the project by default. However, permission rules can be
modified for individual assets during or after publishing.

Note: Whether permission rules are locked or customisable, the permissions on content
are always applied. Locked and customisable refer only to how project-level permissions are inherited by content in the project and who can change them. Even in a project with customisable permissions, only specific users can modify permissions (content
or project owner, project leader, admins or those with the Set Permission capability).

In a locked project:
l
l
l

The project permission rules per content type are applied to all assets.
Only administrators, project owners and project leaders can modify permissions.
Content owners lose the Set Permission capability but retain all other capabilities on
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l

their content.
Permissions are predictable for all content in the project.

In a customisable project:
l

The project permission rules are applied by default when content is published into the
project or nested projects are created, but permissions can be modified during pub-

l

l
l

lication or after the content is created.
Any user with the Set Permissions capability can modify permission rules for that content.
Content owners have all capabilities on their content.
Permissions can be different across content in the project.

Set asset permissions (lock a project)

New top-level projects inherit all initial permission rules from the Default project but not the
Asset permissions setting, which is set to Customisable. This can be changed to
Locked if desired.
To configure Asset permissions:
1. You must be logged into the site as an administrator, project owner or project leader
2. Open the permissions dialog for a project
3. Next to Asset permissions in the upper left, click the Edit link and select the desired
option in the Asset permissions dialog
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Note: If the upper left corner doesn’t show an Edit link in step 3 above, you may be on
the permissions dialog for (a) a nested project or a piece of content in a locked project, in
which case the link should bring you to the managing project, (b) a piece of content in a
customisable project, which won’t show anything or (c) a view, which will indicate how
the view permissions are tied to the workbook. For more information on the interplay of
permissions for views and workbooks, see Show or Hide Sheet Tabs.

Change asset permissions

When the Asset permissions setting for a project is changed, the outcome depends on the
new setting. Changes to permission rules in a locked hierarchy must be done at the level of
the managing project.
Changing

Changing to

Outcome

Locked

Doesn’t modify existing permission rules.

from
Locked (including nested pro-

Any nested projects become customisable.

jects)
Customisable

Doesn’t modify existing permission rules, though
they become customisable.
Any nested projects become customisable.

Locked

Locked (includ-

Overwrites existing custom permission rules for all

ing nested pro-

nested projects and their content. This can’t be

jects)
Customisable

undone.
Doesn’t modify existing permission rules, though
they become customisable.
Any nested projects retain their content permission
settings and permission rules.
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Customisable

Locked (includ-

Overwrites existing custom permission rules for con-

ing nested pro-

tent in the project, as well as all nested projects and

jects)

their content. This can’t be undone.

Locked

Overwrites existing custom permission rules for content in the project. This can’t be undone.
Any nested projects retain their permission rules
and remain customisable.

Move projects and content

Move Tableau content and external assets
When Tableau content or external assets are moved between projects with different permission settings, Asset permissions settings determine the logic of how permissions are
applied.
l

Moving assets into a locked project will override the existing permission rules and

l

enforce the destination’s permissions.
Moving assets into a customisable project will maintain the existing permission rules
on the asset.

Note: Prior to Tableau Server 2022.3 and Tableau Cloud June 2022, external assets
could not be in projects, and permissions on tables were managed through the Table
permissions setting of the parent database. Beginning with Tableau Server 2022.3
and Tableau Cloud June 2022, external assets can be in projects. If a database or a
table is moved into a project, older settings to control table permissions through the
database are ignored, and the database or table permissions follow the logic of other
assets above.
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Move projects
When a project is moved into another project, the permissions settings on the item being
moved are maintained unless the destination project is scoped to include nested projects.
(Project permissions in this case mean the View and Publish capabilities for the project
itself.)
l

If the destination project is set to locked (including nested projects), the permissions for the project being moved and its content are overwritten.

l

If the destination project is set to locked (not including nested projects), the permissions for the project being moved are not overwritten. Whether or not the moved
project is locked or customisable is preserved from its original setting.

l

If the destination project is set to customisable, the permissions for the project being
moved are not overwritten but they are now editable.

If the project being moved was previously nested under a parent that was locked
(including nested projects), when moved, the project takes on the setting of locked
(including nested projects) and becomes the managing project for any projects it contains. Note: This is the same outcome if a project is moved to become a top-level project.

Effective permissions
A permission rule establishes who is impacted (a group or user) and what Capabilities they
are Allowed, Denied or Unspecified. While it seems straightforward to simply set a permission rule and have that be the whole story, whether a user has a capability may be
unclear because of membership in multiple groups and the interplay of site roles and ownership with permission rules.
Multiple factors are evaluated in a specific order, yielding effective permissions on a piece of
content.
Tip: To help keep things as straightforward as possible, we recommend (1) setting permission rules for groups instead of users, (2) managing permissions locked at the project
level instead of setting permissions on individual content and (3) deleting the All User group’s
permission rule or setting all capabilities to None.
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A capability is allowed for a user if and only if the following three conditions are all met:
l
l

The capability is within the scope of their site role.
They have that capability:
l based on a specific user scenario (such as being the content owner or a project
leader, or they’re an administrator site role),

l

l

OR
because they have been allowed the capability as a user,

l

OR
because they are both in a group that has been allowed the capability and no

rules deny them the capability as a user or member of another group.
There is no conflicting permissions settings at another content level that takes precedence.

Any other situation denies the user the capability.
Hovering over a capability brings up a tooltip that explains the effective permission. Here
are some common examples of why effective permissions – what the user can or can’t do in
actuality – might appear different than what a given permission rule states:
l

A user might have a capability they are denied in a permission rule because their site

l

role includes it (administrators).
A user might have a capability they are denied in a permission rule because their user

l

scenario allows it (because they own the content or are a project owner or leader).
A user might lack a capability they are allowed in a permission rule because their site

l

role doesn’t allow it.
A user might lack a capability they are allowed in a permission rule because a conflicting group or user rule denied it.

l

A user might lack a capability they are allowed in a permission rule at one level of content (such as a workbook) because another level of content denied it (such as a view).

Evaluate permission rules

Permissions in Tableau are restrictive. Unless a capability is granted to a user, they are
denied permission. The following logic evaluates if a capability is allowed or denied for an
individual:
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1. Site role: If a site role doesn’t permit a capability, the user is denied. If the user's site
role does permit the capability, then specific user scenarios are evaluated.
l

For example, a Viewer site role can’t web edit. See General capabilities allowed

with each site role for more information on what each site role can do.
2. Specific user scenarios:
l If the user is an admin they have all capabilities on all content.
l If the user is a project owner or project leader, they have all capabilities on all
content in their projects.
l If the user is the content owner, they have all capabilities* on their content.
l If these scenarios do not apply to the user, then user rules are evaluated.
*Exception: Content owners won’t have the Set Permissions capability in projects
where permissions are locked. Only administrators, project owners and project leaders can set permission rules in locked projects.
3. User rules: If the user is denied a capability, it is denied. If they are allowed a capability, it is allowed. If a capability is unspecified, then group rules are evaluated.
4. Group rules: If the user is in any group that is denied a capability, it is denied. If the
user is in a group that is allowed a capability (and not in any groups that are denied that
capability), it is allowed.
l That is to say, if a user is a member in two groups, and one is allowed a capability and one is denied the same capability, the denial takes precedence for
that user and they are denied.
5. If none of the above conditions apply, the user is denied that capability. In effect, this
means that capabilities left as unspecified will result in denied.
A final effective permission of Allowed therefore occurs in three circumstances:
l

Allowed by site role (Server Administrator, Site Administrator Creator, Site Administrator Explorer)
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l
l

Allowed because the user is the content owner, project owner or project leader
Allowed by a group or user rule (and not denied by a rule of higher precedence)

Denied occurs in three circumstances:
l
l
l

Denied by site role
Denied by a rule (and not allowed by a rule of higher precedence)
Not granted by any rule

Evaluate permissions set at multiple levels

If Asset permissions are set to Customisable, it’s possible to configure permission rules
in multiple places. There are specific rules that determine what permissions are applied on
the content.
l

If there are nested projects, permissions set at the child level take precedence over

l
l

permissions set at the parent level.
Changes to permissions at the project level are not enforced for existing content.
If there are permissions set on content (workbook, data source or flow) during or after

l

publication, these take precedence over rules set at the project level.
If a workbook doesn’t show navigational sheet tabs, any changes to the workbooklevel permissions won’t be inherited by the views and any changes to permissions

l

must be done on the view.
Configuring the workbook to show navigational sheet tabs will override existing viewlevel permissions and sync them with the workbook-level permissions. See Show or

Hide Sheet Tabs.

454

Tableau Software

Tableau Cloud Help

This image shows how capabilities are evaluated through multiple levels of content.
Permissions on views

In a workbook that is not in a locked project and does not show sheets as tabs for navigation,
views (sheets, dashboards, stories) inherit the workbook permissions at publication, but any
changes to permission rules must be made on individual views. View capabilities are the
same as those for workbooks, except for Overwrite, Download Workbook/Save a Copy
and Move which are only available at the workbook level.
We recommend showing navigational sheet tabs whenever possible so views continue to
inherit their permissions from the workbook. For more information, see Show or Hide Sheet
Tabs.
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Permissions, Site Roles and Licences
Adding a user to Tableau Cloud requires an available licence. (Users can also be added as
unlicensed and configured so they will consume a license only when they first sign in. For
more information, see Grant Licence on Sign-in.) For each site the user belongs to they
have exactly one site role, restricted by their licence. A user has permissions for content on
the site, restricted by what their site role allows.
Licences and site roles apply to users. Permission capabilities apply to content.
Licences are assigned to a user when they are created (or sign in for the first time) on
the Tableau Server or Tableau Cloud site. Users are licensed as a Creator, Explorer or
Viewer.
l

Licence levels are consumed based on the maximum site role a user can have on that
server.
l Site Administrator Creator and Creator site roles use a Creator licence.
l Site Administrator Explorer, Explorer (can publish) and Explorer site roles use
l
l

l

at least an Explorer licence.
Viewer site role uses at least a Viewer licence.
An unlicensed user can exist on the site, but they cannot sign in unless they

were added with grant site role on sign-in.
For Tableau Cloud, a user consumes a licence per site and has only one site role.

Site roles are assigned to a user for each site they are a member of.
l

Site roles determine the maximum capabilities a user can have in that site. (For
example, a user with a site role of Viewer will never be able to download a data source

l

even if that capability is explicitly granted to them on a specific data source.)
Site roles do not inherently grant any capabilities in and of themselves – with the
exception of the administrator site roles. Administrators always have all capabilities
applicable to their licence level.

Permissions consist of capabilities, like the ability to save to a project, web edit a workbook, connect to a data source, etc. They apply to group or user on a specific piece of content (project, data source, workbook, view or flow).
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l

Permission capabilities are not given to a group or user in a vacuum but rather in the

l

context of content. A user can have different capabilities for different content assets.
Permissions are evaluated based on the interplay of a user’s site role and the per-

l

mission rules for that user or any groups they are members of.
Some actions such as web authoring might require combinations of capabilities. For
more information, see Permission settings for specific scenarios.

Site roles and their maximum capabilities

These tables indicate what capabilities are available for a site role. There may be other ways
for a user with a site role to perform a similar action. For example, although Viewers can’t be
given the Share Customised capability to make their custom views visible to others on the
workbook, they can share custom views by copying the view URL. See General capabilities
allowed with each site role for more information on what each site role can do.
Projects
Capability

Creator

Explorer (can

Explorer

Viewer

Explorer

Viewer

publish)
View
Publish

Workbooks
Capability

Creator

Explorer (can
publish)

View
Filter
View Comments
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Add Comments
Download
Image/PDF
Download
Summary Data
Run
Explain Data †
Share Customised
Download
Full Data
Web Edit
Download
Workbook/Save
a Copy
Overwrite
Create/Refresh Metrics ‡
Move

*

Delete
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Set Permissions

† Explain Data can be controlled in site settings and in a workbook using the Run Explain
Data capability. The availability of Explain Data in viewing mode is controlled in a workbook
in the Explain Data Settings dialog box.
‡ Prior to Tableau 2021.3, the Create/Refresh Metrics capability was controlled by the Download Full Data capability.
Data Sources
Capability

Creator

Explorer (can

Explorer

Viewer

Explorer

Viewer

publish)
View
Connect
Download
Data Source
Overwrite
Delete
Set Permissions
Data Roles
Capability

Creator

Explorer (can
publish)

View
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Overwrite
Move

*

Delete
Set Permissions
Flows

To run flows on a schedule, you must have the Data Management. For information about
configuring flow settings, see Create and Interact with Flows on the Web.
Capability

Creator

Explorer (can

Explorer

Viewer

publish)
View
Download
Flow
Web Edit
Run Flow
Overwrite
Move

*

Delete
Set Permissions
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Ask Data Lenses
Capability

Creator

Explorer (can

Explorer

Viewer

publish)
View
Overwrite
Move

*

Delete
Set Permissions
Metrics
Capability

Creator

Explorer (can

Explorer

Viewer

publish)
View
Overwrite
Move

*

Delete
Set Permissions
Collections
Capability
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Viewer
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publish)
View

Virtual Connections

Virtual connections require a Data Management licence. See About Data Management for
details.
Capability

Creator

Explorer (can

Explorer

Viewer

publish)
View
Connect
Overwrite
Move

*

Delete
Set Permissions

* Although the Explorer role can be given the Move capability, they can’t have the Publish
capability on a project, and therefore there is no place for them to move content to. The
Move capability should therefore be considered not possible for Explorer site roles.

Quick Start: Permissions
A permission rule is a set of capabilities that defines what access a group or user has to a
piece of content, such as a workbook, project or data source.
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The most efficient way to manage permissions is to remove permissions from the All Users
group before you create new groups for your environment. Then create permission rules for
groups at the project level.
1 Add users to groups

A common way to manage permissions is to create groups for users who should have the
same permissions.
1. Within a site, select Groups.
2. Select a group name, and then select Add Users.

A maximum of ten results will be returned.
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2 Open a project’s permissions settings

The site’s Content page shows the top-level projects. Navigate to the project you want to
update, select its Actions (…) menu, and then select Permissions.

If you’re not sure where to find a child project, display filters, and select Show all projects.
3 Create a permissions rule

Click Add a user or group rule, select Group and then find and select the group.
Select a permissions role template to apply an initial set of capabilities for the group. Click a
capability to set it to Allowed or Denied, or leave it Unspecified. Click Save when you
have finished.
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Whether a user can set permissions is based on their site role and how their Set Permissions capability is set.
4 View a user’s effective permissions

After you save the permissions rule for the group, you can view the effective permissions for
that content.
Click a group name to see the group's users and their permissions. Hover over a capability
box to see a tooltip with details on whether a capability is allowed or denied.
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Custom indicates a user’s capabilities have been changed from the initial settings for their
site role or content role.
For more information, see Permissions.
Site roles

A user’s site role determines the maximum permissions allowed for that user.
l

Server and site administrators can access all site content and take actions on it.

l

Owners always get full access to the content they’ve published. When the parent project permissions are not locked, owners can change permissions for their published
content.

For more information, see Set Users’ Site Roles and Use Projects to Manage Content
Access.
Permissions evaluation
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l

Denied takes precedence over Allowed.

l

Unspecified results in Denied if no other permissions are specified.
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l

Specific user permissions on content take precedence over group permissions on content. In other words, user permissions trump group permissions.

For best-practice steps describing how to implement permissions, see Configure Projects,
Groups and Permissions for Managed Self-Service.
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Manage Content Ownership
When you publish a data source or workbook on Tableau Cloud or when you create a project, you become its owner. A content owner, a project leader with an appropriate site role, or
an administrator can change ownership of a content asset. After ownership is reassigned,
the original owner has no special connection to the content item, and their ability to access it
is determined by their permissions on the project or that specific item.
Who can change or be given ownership, by content type

Whether you can change or be given ownership depends on your permissions and your relationship to the content asset, as described in the following table.

Note: Full project leader access is available only with some site roles. For information,
see Project-level administration.

Content asset type

Who can change own-

Who can be given ownership

ership
Top-level projects

Server administrator1

Server administrator

Site administrator

Site administrator (Creator and
Explorer)
Creator
Explorer (can publish)

Child

Server administrator

(nested) projects

Any administrator or owner,
excluding Explorer and Viewer.

Site administrator
Project owner
Workbooks and data
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sources

Site administrator

Site administrator

Workbook or data

Creator

source owner
Explorer
Project leader or owner
of the project that con-

Viewer

tains the item
Metrics

Server administrator

Any administrator or user of the
site, excluding Explorer and

Site administrator

Viewer.

Metric owner
Project leader or owner
of the project that contains the item
Ask Data lenses

Server administrator

Any administrator or user of the
site, excluding Explorer and

Site administrator

Viewer.

Lens owner
Project leader or owner
of the project that contains the item
Flows

Server administrator

Server and site administrators can
only change the owner to them-

Site administrator
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Data Roles

Server administrator

Any administrator or user of the
site, excluding Explorer and

Site administrator

Viewer.

Data role owner
Project leader or owner
of the project that contains the item
Collections

Server administrator

Server administrator

Site administrator

Site administrator

Collection owner

Creator
Explorer
Viewer

Virtual Connections2

Server administrator

Server administrator

Site administrator

Site administrator

Virtual connection owner

Creator

1 The Server Administrator site role applies to Tableau Server only; not Tableau Cloud.
2 Virtual connections require Data Management. See About Data Management for details.

Note that to edit a virtual connection, you must have the database credentials.
Considerations for changing content ownership
l

Before you remove a user from Tableau Cloud, make sure they do not own any content assets.
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If the user does own content, you must first reassign ownership of those assets
before you can delete the user. Otherwise, their site role is set to Unlicensed, but
they are not deleted, and only an administrator can take certain actions on that content.
l

If you change the ownership of a workbook or data source that includes embedded
credentials to connect to underlying data, the embedded credentials will be deleted.
For flows, embedded credentials are preserved when changing ownership. Connections to published data sources are authenticated using the flow owner and
authorised based on their permissions.
You can update the embedded credentials by editing the connection information on
Tableau Cloud. For more information, see Edit Connections on Tableau Cloud.
Alternatively, the new owner can download the flow, workbook or data source and
open the item in Tableau Desktop to update the embedded credentials and then republish the content.

l

If you do not lock permissions to projects, make sure users you give content ownership to know your permissions guidelines, or you account for permissions as you
change ownership. In unlocked projects, by default, content owners can set permissions on their content. For more information, see Permissions.

l

While it is possible to change the owner of a metric to a user with a site role of Viewer
or Explorer, it is not recommended, because doing so will cause the metric refresh to
be suspended. A site role of Creator or Explorer (can publish) is required to refresh,
overwrite or delete a metric.

Change the owner of a content resource

1. Sign in to the Tableau Cloud web environment, and from the navigation menu, select
Explore.
2. Navigate to the content you want to assign to someone else.
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l

If you want to reassign multiple of the same type of content, for example, multiple workbooks, select the content type from the drop-down menu.

l

If you want to reassign multiple items within the same project, navigate to the
project.
If you’re not sure where to find a child project, display filters, and select Show
all projects.

l

If you want to reassign multiple content items with the same owner, find the user
on the Users page.

3. Select the items you want to reassign, and then select Actions > Change Owner.
The other menu commands you see will depend on the content type.

4. Type the name of a user or select a user from the list.
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5. Click Change Owner.

Manage Permissions for External Assets
Tableau Cloud and Tableau Server provide a space for accessing and managing published
content. When Tableau Cloud or Tableau Server is licensed with Data Management, you
have access to Tableau Catalogue. Tableau Catalogue adds a complementary space and a
set of features across your site to track and manage metadata and lineage of external
assets used by the content published to your site.
Tableau Catalogue indexes content and assets

Catalog discovers, tracks and stores metadata from the content that you publish to Tableau
Cloud or Tableau Server.
Catalogue indexes metadata for the following:
l

Tableau content: Workbooks, data sources, flows, projects, metrics, virtual connections, virtual connection tables, users and sites

l

External assets: databases and tables associated with Tableau content
Catalogue classifies the metadata of any data that comes from outside the Tableau
environment as external assets. The data that comes from outside the Tableau envir-
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onment is stored in many different formats, such as a database server or a local .json
file.
Catalogue tracks only the metadata of the external data and does not track the underlying data in any form (raw or aggregated).
Catalogue metadata includes the following:
l

Lineage information or the relationship between items. For example, the Sales table
has a relationship with both the Superstore data source and the Superstore Sample
workbook.

l

Schema information. Some examples include:
l

Table names, column names, and column types. For example, Table A contains

l

Columns A, B and C, which are types INT, VARCHAR and VARCHAR.
Database name and server location. For example, Database_1 is a SQL Server

l

database at http://example.net.
Data source name, and the names and types of the fields the data source contains. For example, Superstore data source has fields AA, BB and CC. Field CC
is a calculated field that refers back to both field AA and field BB.

l

User curated, added, or managed information. For example, item descriptions, certifications, user contacts, data quality warnings and more.

How does Tableau Catalogue work?

Tableau Catalog indexes all content published to Tableau Cloud or Tableau Server to track
lineage and schema metadata. For example, the metadata comes from workbooks, packaged workbooks, data sources and the Tableau Server or Tableau Cloud repository.
As part of the indexing process, lineage and schema metadata about external assets (databases and tables) used by the published content are also indexed.
Note: In addition to accessing Catalog from Tableau Cloud or Tableau Server, indexed
metadata can also be accessed from the Tableau Metadata API and Tableau Server
REST API. For more information about the Tableau Metadata API or metadata methods in
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the REST API, see Tableau Metadata API and Metadata Methods in the Tableau Server
REST API, respectively.
Permissions on metadata

Permissions control who is allowed to see and manage external assets and what metadata
is shown through lineage.
Note: If Tableau Cloud or Tableau Server is not licensed with Data Management, then by
default, only admins can see database and table metadata through the Tableau Metadata
API. This default can be changed to use "derived permissions", as described below.
Access metadata

The permissions used to access metadata through Catalog (or Metadata API) work similarly to permissions for accessing content through Tableau Cloud or Tableau Server, with
some additional considerations for sensitive data that can be exposed through lineage and
the capabilities granted on external assets.

Permissions on Tableau content
Catalogue follows the view and manage capabilities that are already in place on existing
Tableau content to control the metadata that you can see and manage on Tableau content.
For more general information on these capabilities, see Permissions.

Permissions on external assets using derived permissions
When Tableau Cloud or Tableau Server is licensed with Data Management, by default
Catalogue uses derived permissions to automatically grant you capabilities to external
assets in the following scenarios:
For View capability:
l

If you are the owner of a workbook, data source or flow, you can see the database
and table metadata used directly by that workbook, data source or flow. See
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Additional notes about lineage.
l

If you are a project owner or project leader, you can see all the database and table
metadata used by the content published to your project.

l

Embedded files use the permissions of the source content (such as the workbook,
data source or flow), rather than the derived permissions of the external asset (the
database or table). For example, if you can see a workbook with an embedded file,
you can see the embedded file and its metadata used by that workbook.

For both Overwrite and Set Permissions capabilities:
l

If you are the owner of a flow, you can edit and manage permissions for the database
and table metadata used by the flow output.

Note: In the case of flows, the capabilities mentioned above apply only after the flow has
been run successfully at least once under the current owner of the flow.
Check permissions
As an admin or someone who has been given the capability to set permissions for an asset,
you can validate who has derived permissions by following the steps below.
1. Sign in to Tableau Cloud or Tableau Server.
2. From the left navigation pane, click External Assets.
3. From the drop-down menu, select Databases and Files or Tables.
Note: Local files, like .json or .csv files are grouped as external assets under Databases.
4. Tick the box next to the database or table whose permissions you want to modify, and
then select Actions > Permissions.
5. In the Permissions dialog box, click + Add Group/User Rule and start typing to
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search for a group or user.
6. Validate the permissions by clicking a group name or username in the permission
rules to see the effective permissions below.

Order of precedence for derived permissions on external assets
When derived permissions are configured for your Tableau Cloud site or Tableau Server,
each user's level of access to external assets depends on the associated Tableau content
and the order of precedence of rules that Tableau uses for its content.
Tableau follows the rules below, continuing on to the next rule, only if the current rule evaluates to "denied". If any rule evaluates to "allowed", the capability is allowed and Tableau
stops evaluating. This rules list is based on the Permissions.
For View capability:
1. Admin role
2. Licence
3. Project leader (Tableau content)
4. Project owner (Tableau content)
5. Content owner (Tableau content)
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6. Derived permissions (applies only to external assets and the View capability)
a. Admin role
b. Licence
c. Project leader (external assets)
d. Project owner (external assets)
e. Content owner (external assets)
7. Explicit permissions
For Overwrite and Set Permissions capabilities:
1. Admin role
2. Licence
3. Project leader (Tableau content)
4. Project owner (Tableau content)
5. Content owner (Tableau content)
6. Explicit permissions (Tableau content)
7. Derived permissions (applies only to external assets and the Overwrite and Set Permissions capabilities for flow outputs)

a. Admin role
b. Licence
c. Project leader (external assets)
d. Project owner (external assets)
e. Content owner (external assets)
Turn off derived permissions
As an admin, you can turn off the derived permissions default setting for a site in favour of
manually granting explicit permissions to databases and tables.
1. Sign in to Tableau Cloud or Tableau Server as an admin.
2. From the left navigation pane, click Settings.
3. On the General tab, under Automatic Access to Metadata about Databases and
Tables, clear the Automatically grant authorised users access to metadata

about databases and tables tick box.
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Note: Data quality warning messages on databases and tables that are visible to
users though derived permissions remain visible to those users even when the box is
not ticked.
Set permissions on individual external assets

In order to grant additional users permissions to view, edit (overwrite) and manage external
assets, an admin can grant those capabilities explicitly on individual databases or tables for
users or groups.
Starting with Tableau Server 2022.3 and Tableau Cloud September 2022, you can organise external assets in projects. Permissions inheritance for external assets works the same
way as it does for Tableau content other assets, as described in the Permissions topic, and
can simplify permissions management.
Summary of permissions capabilities
The following table shows the capabilities you can set for external assets (databases and
tables):
Capability

Description

Template

View

See the database or table asset.

View

Overwrite

Add or edit data quality warnings and descrip-

Publish

tions of the database or table asset. Prior to version 2020.1, the Overwrite capability was called
Save.
Move

Set Per-

Move the database or table asset.

Administer

Grant or deny permissions for the database or

Administer

table asset.
missions
Set permissions on a database or table
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To set permissions on databases or tables, use the following procedure.
1. Sign in to Tableau Cloud or Tableau Server as an admin or someone who has been
granted the "Set Permissions" capability.

2. Find the database or table. You can do this through Explore (starting with Tableau
Server 2022.3 and Tableau Cloud September 2022) if you know the current location
of the database or table, or through External Assets to see a list of all databases,
tables and files.
l

Explore - From the left navigation pane, click Explore and locate the project
the database or table is in.

l

External Assets - From the left navigation pane, click External Assets. From
the drop-down menu, select Databases and Files or Tables (Note: Local files,
like .json or .csv files are grouped as external assets under Databases.)

3. Tick the box next to the database or table whose permissions you want to modify, and
then select Actions > Permissions.
4. In the Permissions dialog box, click + Add Group/User Rule and start typing to
search for a group or user.
5. Select a permission role template to apply an initial set of capability for the group or
user, and then click Save. Available templates are: View, Publish, Administer, None
and Denied.
6. To further customise the rule, click a capability in the rule to set it to Allowed or Denied,
or leave it unspecified. Click save when you are done.
7. Configure any additional rules you want for other groups or users.
8. Validate the permissions by clicking a group name or username in the permission
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rules to see the effective permissions below.

External assets that are not in projects
There are some scenarios in which an external asset is not in a project:
l

External assets could not be put into projects until Tableau Server 2022.3 and
Tableau Cloud June 2022. Assets that predate these versions will not be in a project
unless they’ve been put into one since the capability was released.

l

When Catalogue first ingests an external asset, it is not put into a project.

l

If a project was deleted, and that project contained external assets, those external
assets will no longer be in any project, but they can still be found in External Assets.

If an external asset is not in a project, permissions for external assets work as they did in
Tableau Server 2022.1 and Tableau Cloud June 2022 and earlier. That is, database and
table permissions are controlled independently of content in projects, and table permissions
can be managed through database permissions. When permissions are set at the database
level in this way, those permissions can serve as a template for any newly discovered and
indexed child tables of that database. Furthermore, database permissions can also be
locked so that the child tables will always use the permissions set at the database level.
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Note: You cannot lock (or unlock) permissions to a database if the database is in a project.

To lock (or unlock) permissions to the database, use the following procedure:
1. Sign in to Tableau Cloud or Tableau Server as an admin or someone who has been
granted the "Set Permissions" capability.

2. From the left navigation pane, click External Assets. By default, the External Assets
page shows a list of databases and files.
3. Tick the box next to the database whose permissions you want to lock, select Actions
> Permissions, and then click the Table Permissions Edit link.
4. In the Table Permissions in Database dialog box, select Locked and click Save.
5. To unlock permissions, click Edit again, and select Customised.
Access lineage information

Catalogue (and the Metadata API) can expose relationship and dependencies metadata,
also referred to as lineage, among the Tableau content and external assets on Tableau
Cloud or Tableau Server. Lineage shows three primary things:

l

How items relate to each other, either directly or indirectly
How many of those items relate to each other

l

With the appropriate permissions, shows sensitive data about items in the lineage

l

Sensitive lineage data
In some cases, lineage can contain sensitive data, such as data quality warning messages,
content or asset names or related items and metadata.
By default, complete lineage information displays for all users while its sensitive data is
blocked from specific users who don’t have the appropriate View capabilities. The concept of
blocking sensitive data is called obfuscation.
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Obfuscation allows all metadata in the lineage to be visible while keeping its sensitive data
blocked from specific users who don’t have the appropriate View capabilities. This default
enables workflows that rely on a complete impact analysis.
If obfuscating sensitive data in the lineage is not enough for your organisation, certain parts
of the lineage, including its sensitive data, can be filtered.
Filtering omits certain parts of the lineage (and lineage-related areas like data details) for
specific users who don't have the appropriate View capabilities for its sensitive data.
Because filtering omits parts of lineage, it prevents workflows that rely on a complete impact
analysis.
To change how sensitive data is handled, do the following:
1. Sign in to Tableau Cloud or Tableau Server as an admin.
2. From the left navigation pane, click Settings.
3. On the General tab, under Sensitive Lineage Information, select the radio button
that best handles lineage information for all users on your Tableau Cloud site or
Tableau Server.
Additional notes about lineage
l

If you have the View capability on related assets, you can see when and what
assets and content are related to each other, and their sensitive metadata.
For example, you can see 1) the names, data quality warnings and total number of
related upstream databases and tables and 2) the combined number of sheets (visible and hidden) in the lineage of the downstream workbook of the asset you are evaluating.

l

If you don't have the View capability on related assets, you can always see
when assets relate to each other.
For example, you can see 1) whether related upstream databases and tables exist in
the lineage and 2) the total number of databases or total number of tables that are
related to the asset you are evaluating.
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However, you can't see the metadata associated with those assets when you don't
have the view capability for them. When metadata is blocked because of limited permissions, or the asset is in a Personal Space, you see Permissions Required.

l

If you don't have the View capability on related assets, you can always see
whether the assets are certified.
However, if you don't have View capability, you can't see sensitive information related
to the certification, like the names of the related databases and tables. When
metadata is blocked because of limited permissions, or the asset is in a Personal
Space, you see Permissions Required.
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For more information about lineage see Use Lineage for Impact Analysis.
Additional notes about tags discoverable through lineage data
In addition to Tableau content, external assets can also be tagged. Although tags are
always visible, tagged items that you see through lineage data can either be obfuscated
(default) or filtered as described earlier in this topic.
When tagged items are obfuscated:
l

If you have the View capability for tagged items, you can see the tagged items
and related tagged items, and all metadata.

l

If you don’t have the View capability for tagged items:
l

You can see the type of tagged and related tagged items but you can't see
sensitive metadata about the items. For example, suppose you use a tag filter
to see items with the tag “Noteworthy”. Although you can see that there are
database items tagged with "Noteworthy", you can’t see the names of the
tagged databases.
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l

You can see how many related tagged items there are. For example, suppose
you do a tag query on “Noteworthy”. Your query returns five tagged databases.

When tagged items are filtered, the tagged and related tagged items you see are limited to
only the items that you have the View capability for.
For more information about tags, see Tagged Items in the Tableau User Help.
Potential mismatch between asset results and content results
When Catalogue shows lineage information, it provides information about Tableau content
and external assets. Catalogue lineage always shows the true count or result of associated
items. However, in other areas of the site, you might see fewer items. This could be because
of your View capabilities. Outside of Catalogue, you see only the content that your permissions allow.
For example, suppose you're looking at the Superstore data source. The lineage for the
Superstore data source shows how many upstream underlying tables the data source connects to and how many downstream workbooks rely on the data source. However, because
you might not have permissions to see all of those downstream workbooks, the number of
related workbooks in the Catalogue lineage (actual total) might be greater than the number
of workbooks in the Connected Workbooks tab (what you have permission to see).
There might be other reasons, unrelated to permissions, why you might see a mismatch
between asset counts and content counts. For more information, see Use Lineage for
Impact Analysis.
Who can do this

The following information summarises the types of users who can do the tasks described in
this topic.

Tableau Cloud site or Tableau Server admin
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Data Man-

Capability

Requirements

See assets and their metadata

None

agement
Licensed
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Data Man-

Capability

Requirements

Edit assets and their metadata

None

Change permission on assets and their

None

agement

metadata
Grant users ability to see assets and their

Default: When “derived

metadata

permissions” is on, your
users can see metadata on
external assets for the content that they own, or for
the content that is published to a project that they
are a project leader or project owner of.
Ad-hoc: You can configure explicit View permissions on a specified
external asset.

Grant users ability to edit assets and their

You can configure explicit

metadata

"write" or Overwrite permissions on a specified
external asset (if not automatically granted because
the user is a flow owner) .

Grant users ability to change permissions

You can configure explicit

on assets and their metadata

"edit" or Set Permissions
on a specified external
asset (if not automatically
granted because the user
is a flow owner) .
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Data Man-

Capability

Requirements

See all assets and their metadata

Applies to Metadata API

agement
Not licensed

only
Edit assets and their metadata

Requires the Data Management

Change permission on assets and their

Requires the Data Man-

metadata

agement

Grant users ability to see assets and their

Applies to Metadata

metadata

API only:
You can turn on derived
permissions as described
above. If “derived permissions” is on, your users
can see metadata on
external assets for the content that they own, or for
the content that is published to a project that they
are a project leader or project owner of.

Grant users ability to edit assets and their

Requires the Data Man-

metadata

agement

Grant users ability to change permissions

Requires the Data Man-

on assets and their metadata

agement

User with Creator or Explorer licence
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Data Man-

Capability

Requirements

See assets and their metadata

Default: When "derived per-

agement
Licensed

missions" is enabled by your
Tableau Cloud site admin or
Tableau Server admin, you
can see metadata on
external assets for the content that you own, or for the
content that is published to a
project that you are a project
leader or project owner of.
Ad-hoc: You can see
metadata on external assets
that you have been granted
explicit View permissions to.
Edit assets and their metadata

You can edit metadata on
an external asset that you
have been granted explicit
"write" or Overwrite permissions to(if not automatically granted because
the user is a flow owner).

Change permissions on assets and their

You can change per-

metadata

missions on an external
asset that you have been
granted explicit "edit" or Set

Permissions to ((if not automatically granted because
the user is a flow owner).
Grant other users permissions to see
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Data Man-

Capability

Requirements

assets and their metadata

missions on an external

agement

asset that you have been
granted explicit "edit" or Set

Permissions to ((if not automatically granted because
the user is a flow owner).
Not licensed

See assets and their metadata

Applies to Metadata API
only:
If “derived permissions” is
enabled by your Tableau
Cloud site admin or Tableau
Server admin, you can see
metadata on external assets
for the content that you own,
or for the content that is published to a project that you
are a project leader or project owner of.

Edit assets and their metadata
Change permissions on assets and their
metadata

Requires the Data Management

Grant other users permissions to see
assets and their metadata

Enable Tableau Catalogue
Tableau Catalog discovers and indexes all of the content on your Tableau Cloud site or
Tableau Server, including workbooks, data sources, sheets, metrics and flows. Indexing is
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used to gather information about the content, or metadata, about the schema and lineage of
the content. Then from the metadata, Catalog identifies all of the databases, files and tables
used by the content on your Tableau Cloud site or Tableau Server.
Catalog is available with the Data Management licence. For more information, see About
Data Management.
In addition to Catalogue, metadata about your content can also be accessed from both the
Tableau Metadata API and the Tableau REST API using Metadata Methods.

Catalog on Tableau Cloud
Catalog is automatically enabled when Tableau Cloud is licensed with the Data Management.
After your Tableau Cloud site has been licensed with the Data Management, the content that
already exists on your Tableau Cloud site is immediately indexed. The time it takes to index
the content depends on the amount of content you have. After the content is initially indexed,
Catalogue monitors newly published content and other changes to assets and continues to
index in the background.

Troubleshoot Catalogue
You or your users might encounter one of the following issues when using Catalogue.
Timeout limit and node limit exceeded messages

To ensure that Catalogue tasks that have to return a large number of results don’t take up all
system resources, Catalogue implements both timeout and node limits.
l

Timeout limit
When tasks in Catalogue reach the timeout limit, you and your users see the following
message:
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“Showing partial results, Request time limit exceeded. Try again later.” or TIME_
LIMIT_EXCEEDED
l

Node limit
When tasks in Catalogue reach the node limit, you and your users see the following
message:
NODE_LIMIT_EXCEEDED

Disable Catalogue
As a Tableau Cloud site admin, you can disable Catalog by turning off its capabilities.
Turn off Catalogue capabilities

(Requires Data Management)
You can turn off Catalogue capabilities at any time. When Catalogue capabilities are turned
off, the features of Catalogue, such as adding data quality warnings or the ability to explicitly
manage permissions to database and table assets, are not accessible through
Tableau Online. However, Catalogue continues to index published content and the
metadata is accessible from the Tableau Metadata API and metadata methods in the
Tableau REST API.
1. Sign in to Tableau Cloud using your site admin credentials.
2. From the left navigation pane, click Settings.
3. On the General tab, under Tableau Catalogue, clear the Turn on Tableau Catalogue tick box.
Stop indexing metadata

Indexing cannot be stopped for a Tableau Cloud site.
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Use Certification to Help Users Find Trusted
Data
In a self-service environment with multiple publishers, it’s common for a project on Tableau
Cloud to contain a variety of content that is named similarly, or is based on the same or similar underlying data, or is published without any descriptive information about it. When this is
the case, analysts might lack confidence about the data they should use.
To help your users find the data that’s trusted and recommended for their type of analysis,
you can certify the data that complies with your organisation’s data standards.
In addition to certifying published data sources, if you have a Data Management licence for
Tableau Server or Tableau Cloud:
l

Starting in Tableau 2019.3, if Tableau Catalogue is enabled, you can certify databases
and tables that are associated with your Tableau content. (For more information about
Tableau Catalogue, see "About Tableau Catalog" in the Tableau Server or Tableau

l

Cloud Help.)
Starting in Tableau 2022.1, you can certify virtual connections and virtual connection
tables.

How certification helps users find trusted data
When you certify an asset, users see a green badge or green tick, depending on where the
asset is being viewed.
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Certified data sources rank higher in search results and are added to recommended data
sources.
In addition, you can provide notes about the certification status, which appear when users
click on the badge or in a tooltip when they hover over the data source icon in web authoring
or Tableau Desktop. The information also shows who certified the data source.

For more information, see the How to certify data steps below.

Create guidelines for selecting data to certify
As with most Tableau functionality, certification is flexible. You can define for your organisation the criteria you use to determine when to certify a data source (or database or table).
As you do this, you might want to document and share your guidelines. As new data
sources are published, the guidelines can help you and other administrators or project leaders to be consistent with your certification choices. They can also help users understand
what certification means.
Whether you use the same certification criteria across all projects, or define unique criteria
for each project, the important thing is to be clear about what certification means in your
environment.
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Who can certify data
To certify a data source, you must
l

be a Server or Site Administrator, or

l

have a site role of Explorer (Can Publish) or Creator and be the project owner or have
the Project Leader capability for the project containing the data you want to certify.

To certify virtual connections and virtual connection tables, you must have a Data Management licence in your environment, and you must
l

be a Server or Site Administrator, or

l

have a site role of Explorer (Can Publish) or Creator and be the project owner or have
the Project Leader capability for the project containing the data you want to certify.

To certify databases or tables, you must have Tableau Catalogue enabled in your environment, and you must
l
l

be a Server or Site Administrator, or
have the Set permissions capability on the database to certify that database or any
tables within that database.

How to certify data
The data you can certify depends on whether you have a Data Management licence and, if
you do, whether you have Tableau Catalogue enabled in your environment.
l

All users with the right permissions can certify data sources.

l

If you have a Data Management licence, users with the right permissions can also cer-

l

tify virtual connections and virtual connection tables.
If Tableau Catalogue is enabled, users with the right permissions can also certify databases, tables and files.

Take the following steps to certify the data.
1. Sign in to Tableau Cloud.
2. This step depends on the type of asset you want to certify:
l Data source or virtual connection – on the Explore page, select All Data
Sources or All Virtual Connections.
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l

Virtual connection table – on the Explore page, select All Virtual Con-

nections, and select the virtual connection that contains the virtual connection
table you want to certify. Then select the virtual connection table.
l

Database or table – on the External Assets page, select Databases and

Files or Tables.
3. On the page, select the More actions menu (...) next to the asset name you want to
certify.
4. Select Edit Certification and then do the following:
l Tick the This data is certified box.
l Add a note that gives users context for the certification status, intended use for
the data, or other helpful information, and then click Save.

Information you add to the Note section appears in the certification badge or
tooltip, mentioned earlier in How certification helps users find trusted data.

Use Lineage for Impact Analysis
Knowing where your data comes from is key to trusting the data, and knowing who else
uses it means you can analyse the impact of changes to data in your environment. The lineage feature in Tableau Catalogue helps you do both these things.
Lineage requires Data Management. Starting in 2019.3, Tableau Catalogue is available as
part of the Data Management offering for Tableau Server and Tableau Cloud. When
Tableau Catalogue is enabled in your environment, you have access to lineage information
for your content. For more information about Tableau Catalogue, see "About Tableau Catalog" in the Tableau Server or Tableau Cloud Help.
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Navigate lineage
How you navigate to the Lineage pane depends on what kind of asset you're working with.
To see the lineage for Tableau content such as workbooks, data sources, virtual connections, lenses or flows, from Explore, navigate to and open the content asset, and then
select the Lineage tab.

Note: Lineage data for flows won't appear if the flow includes parameter values. For
more information about using parameters in flows see Create and Use Parameters in
Flows in the Tableau Prep help.

To see lineage for external assets, such as databases and tables, from External Assets,
navigate to and select an asset from the list. When you select a table, for example, a page
opens with information about that table, for example, the name, type, full name, description,
columns and details about each column. To the right of the table information is the Lineage
pane, which shows the lineage for that table.
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Lineage shows dependencies in relationship to the lineage anchor, which is the asset selected. A lineage anchor can be a database, table, workbook, published data source, virtual
connection, virtual connection table, lens, metric or flow. (In the first example, the anchor is
the Batters data source and in the second example, it's the Batters table). All the assets
below the anchor depend, either directly or indirectly, on the anchor and are called outputs
or downstream assets. The assets above the anchor are the assets the anchor is either directly or indirectly dependent on and are called inputs or upstream assets.
When you select a field in a data source or a column in a table, the lineage is filtered to show
only downstream assets that depend on the field (or column) or upstream inputs to the field
(or column) as in this 'Superstore' workbook example that shows the lineage filtered for the
Commission (Variable) field:
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You can select an upstream or downstream asset in the Lineage pane to see its details. For
example, when you select Metrics, the list of metrics depending on this workbook appears to
the left of the Lineage pane.
From the Lineage pane, you can navigate to any asset related to your initial choice, in this
case the workbook, by following the links that interest you.

Embedded asset appears in External Assets
Tableau Catalogue treats an external asset as ‘embedded’ if the Include external files box
is ticked when a data source or workbook is published. When an external asset (database,
table or file) is embedded in published Tableau content (workbooks, data sources and
flows), the external asset is used by the content, but is not shareable with other users. That
embedded external asset appears in the lineage upstream from its Tableau content and is listed in External Assets.
To see if an external asset is embedded, go to the external asset’s detail page and see if
‘Embedded Asset’ is listed under Category.
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For information about embedded data, see Publishing data separately or embedded in
workbooks in Tableau Desktop and Web Authoring Help.

Lineage and custom SQL connections
When you view the lineage of a connection that uses custom SQL, keep in mind the following:

l

Lineage might not be complete.
Catalogue doesn't support showing column information for tables that it only knows

l

about through custom SQL.
Field details cards might not contain links to connected columns, or might not show

l

any connected columns at all.
Column details cards might not contain links to fields that use the column, or might not

l

show any fields at all.

For more information, see Tableau Catalogue support for custom SQL in the Tableau
Desktop and Web Authoring Help.

Catalogue doesn't support cubes
Cube data sources (also known as multidimensional or OLAP data sources) are not supported by Tableau Catalogue. Tableau content (such as a data source, view or workbook)
that relies on cube data does not display any cube metadata or cube lineage in Catalogue.
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Mismatch between lineage count and tab count
You might notice a mismatch in the count of assets between the Tableau Catalog Lineage
tool and the tabs in Tableau Server or Tableau Cloud.
The count mismatch is explained by the fact that each – lineage count vs tab count – counts
assets a different way. For example, at any given point in time, Catalog can count only assets
that are indexed, whereas Tableau Server or Tableau Cloud counts any assets that are published. Other reasons for count differences include whether:
l
l
l
l
l

You have ‘View’ permissions for the asset.
An asset is hidden.
Any fields are used in a workbook.
An asset is directly or indirectly connected to.
An asset is in a Personal Space.

Workbook count mismatch example
As an example, here's how the tab count vs. the lineage count is determined for workbooks.

Connected Workbooks tab counts workbooks that meet both these criteria:
l

Connects to the data source (whether or not any fields are actually used in the work-

l

book).
The user has permissions to view (whether it's a worksheet, dashboard or story).
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Tableau Catalogue Lineage counts workbooks that meet all these criteria:
l
l
l

Has been indexed by Tableau Catalogue.
Connects to the data source and uses at least one field in the data source.
Contains worksheets, including dashboards or stories that contain a worksheet, that
use at least one field in the data source.

When metadata is blocked because of limited permissions, or the asset is in a Personal
Space, Catalogue still counts the workbook. But instead of seeing some of the sensitive
metadata, you see Permissions required. For more information, see Access lineage
information.

Use email to contact owners
At the end of the lineage is Owners. The list of owners includes anyone assigned as the
owner or contact for any content downstream from the lineage anchor.
You can email owners to let them know about changes to the data. (To email owners, you
must have the 'Overwrite' (Save) capability on the lineage anchor content.)
1. Select Owners to see the list of people who are impacted by the data in this lineage.
2. Select the owners you want to send a message to.
3. Click Send Email to open the email message box.
4. Enter the Subject and your message in the text box, and click Send.

Set a Data Quality Warning
Data quality warnings are a feature of Tableau Catalogue. Starting in 2019.3, Tableau Catalogue is available as part of the Data Management offering for Tableau Server and Tableau
Cloud. When Tableau Catalogue is enabled in your environment, you can set data quality
warnings. For more information, see "About Tableau Catalog" in the Tableau Server or
Tableau Cloud Help.
You can set a warning message on a data asset so that users of that data are aware of
issues. For example, you might want to let users know that a data source has been deprec-
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ated, or that a refresh has failed for an extract data source, or that a table contains sensitive
data.
You can set data quality warnings on data sources, databases and tables starting in Tableau
Server 2019.3 and Tableau Online 2019.3.
Starting in Tableau Server 2022.1 and Tableau Online March 2022, you can also set data
quality warnings on virtual connections and virtual connection tables.
Starting in Tableau Server 2022.3 and Tableau Cloud October 2022, you can also set data
quality warnings on columns.

About data quality warnings
There are two kinds of data quality warnings you can set. The first kind is visible to users until
you remove it. The second kind is generated by Tableau when you set Tableau to monitor for
refresh failures of extract data sources or flow run failures.
For extracts and flows, you can set one data quality warning of each kind per asset.

For databases, tables, columns, virtual connections, virtual connection tables and live data
sources, you can set only one quality warning.
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When you set the first kind, it's visible to users until you remove it using the data quality dialog box. You can also use the dialog box to make any updates to the quality warning you set.
When you set Tableau to monitor for extract data source refresh failures or flow run failures,
if a warning is generated, it’s visible to users until the extract refresh or flow run is successful. You can update or remove a warning by opening and editing the contents in the dialog box.

Note: You can set both kinds of data quality warnings and enable high visibility using
REST API. For more information, see Add Data Quality Warning in the Tableau
REST API Help.

Who can see the data quality warning
In Tableau Server and Tableau Cloud, when you set a warning on a data source, database,
table, column, virtual connection or virtual connection table, the warning is visible to users of
the asset and any assets downstream from it. For example, a warning set on a table is visible to users looking at a dashboard with an upstream dependency on that table – users see
a warning icon on the dashboard's Data Details tab and can open the pane to see the
details. Warnings are visible elsewhere in Tableau as described in Set high visibility for a
data quality warning.
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In Tableau Desktop, users see a warning icon (either a blue circle or a yellow triangle with an
exclamation mark) on the Data tab in a workbook sheet when either
l
l

a warning is set on a data source used in the workbook, or
there is a warning upstream from the data source used in the workbook

Note: Data quality warnings do not appear for virtual connections used in Tableau Desktop.
To see the details of the warning, hover over the warning icon with the cursor.
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Data quality warnings in subscriptions
Administrators can turn on data quality warnings in email subscriptions so that when users
subscribe to a view, for example, the email they get includes any data quality warnings associated with that view. Emails with data quality warnings contain:
l
l

Links to relevant views or workbooks with their Data Details pane open.
Links to relevant upstream assets, such as data sources, tables or databases.

Administrators can turn on data quality warnings in email subscriptions by selecting the
Data Quality Warnings in Subscriptions option on the Tableau Server or Tableau
Cloud site settings page. For more information, see Data Quality Warnings in Subscriptions
in the Site Settings Reference.

How to set a quality warning
There are several types of data quality warnings you can set on an asset:
l
l
l
l
l

Warning
Deprecated
Stale data
Under maintenance
Sensitive data

In addition to showing the type of data quality warning, you can include an optional message
with more details about the warning.
To set a data quality warning:
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1. Open the Data Quality Warning dialog for the asset you want to create a warning for.
How you do this depends on the type of asset.

2.
3.
4.
5.

l

For all asset types except columns: Select the More actions menu (. . .) next to

l

the asset, and then select Quality Warning.
For columns: On the table page, tick the box next to the column. Click the

Actions menu and select Quality Warning.
Tick the Enable warning box.
Select the Warning type from the drop-down list.
(Optional) Select the Enable high visibility tick box.
Enter a message to display to users. You can format the text in a message with bold,
underline and italics, and include a link or an image. To see text formatting tips, click on
the information (i) icon above the Save button.

6. Click Save.
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How to set a monitoring quality warning
You can set Tableau to monitor for two events: extract data source refresh failure and flow
run failure. When the event occurs, Tableau generates a quality warning that appears in the
same places that a manual quality warning appears.
To set Tableau to monitor for either event:
1. Select the More actions menu (. . .) next to the extract data source or flow you want to
create a warning for, and then select the appropriate option:
Quality Warning > Extract Refresh Monitoring
l Quality Warning > Flow Run Monitoring
2. In the dialog box, tick the monitoring box.
l

3. (Optional) Select the Enable high visibility tick box.
4. (Optional) Enter a message to display to users. You can format the text in a message
with bold, underline and italics, and include a link or an image. To see text formatting
tips, click on the information (i) icon above the Save button.

5. Click Save.
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Set high visibility for a data quality warning
There are times when you want to make sure that users of a visualisation know important
information about the data they're viewing, whether it be that the data is stale, that the source
has been deprecated or that the flow run has failed. You can do this by selecting the Enable
high visibility tick box in the Data Quality Warning dialog box, as described in step 4 of How
to set a data quality warning.
When enabled, a notification appears when anyone opens a published view affected by this
warning.

High visibility warnings are identified with a yellow warning symbol, which makes them more
visible elsewhere in Tableau, as in these examples:
On the External Assets page:

On a database page:

On the Data Details pane:
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On metrics. Warnings appear when you open a metric in Tableau Mobile, and in Tableau
Server and Tableau Cloud when you hover over a metric in grid view and on the metric
details page, as shown below:
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You can change a high visibility warning to normal visibility by clearing the Enable high visibility tick box in the Data Quality Warning dialog box.

Remove a data quality warning
When a warning no longer applies, you can remove it by navigating to the data asset with the
warning.
1. Open the Data Quality Warning dialog for the asset. How you do this depends on the
type of asset.
l

For all asset types except columns: Select the More actions menu (. . .) next to

l

the data asset and select Quality Warning.
For columns: On the table page, tick the box next to the column. Click the

Actions menu and select Quality Warning.
2. Untick the Enable warning box to remove the warning.
3. Click Save.
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Who can do this
To set a data quality warning, you must either
l
l

be a server or site administrator, or
have the Overwrite capability for the asset.

Manage Dashboard Extensions in Tableau
Cloud
Dashboard extensions are web applications that run in custom dashboard zones and can
interact with the rest of the dashboard using the Tableau Extensions API. Dashboard extensions give users the ability to interact with data from other applications directly in Tableau.

Note: You must be a site administrator to add extensions to the safe list and to control
the type of data the extensions can access. The site administrator can also configure
whether users on the site will see prompts when they add or view extensions in a dashboard. For information about extension security and recommended deployment
options, see Extension Security - Best Practices for Deployment.

For information about using dashboard extensions in Tableau, see Use Dashboard Extensions.

Looking for Tableau Server? See Manage Dashboard Extensions in Tableau Server.

Before you run extensions on Tableau Cloud
Tableau supports two types of dashboard extensions: Network-enabled extensions, which
can be hosted on web servers located inside or outside of your local network and have full
access to the web and Sandboxed extensions, which run in a protected environment
without access to any other resource or service on the web.
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Note: Beginning in March 2021.1 Tableau supports integration with Einstein Discovery
through the Einstein Discovery Dashboard extension. This is a special extension that
has access to data in Salesforce.com and is allowed by default. It is not considered a
Network-enabled extension or a Sandboxed extension. For more information on Einstein Discovery integration, see Configure Einstein Discovery Integration.

Sandboxed extensions are hosted by Tableau and employ W3C standards, such as Content
Security Policy (CSP), to ensure the extension can’t make network calls outside of the hosting Tableau Server. A Sandboxed extension can query data in the dashboard, but it can’t
send that data anywhere outside of the sandbox. Sandboxed Extensions are supported in
Tableau 2019.4 and later. By default, Sandboxed extensions are allowed to run if extensions
are enabled for the site.
Network-enabled dashboard extensions are web applications and could be running on any
computer set up as a web server. This includes local computers, computers in your domain
and third-party web sites. Because Network-enabled extensions could be hosted on thirdparty sites and could have access to the data in the dashboard, you want to only allow the
extensions you trust. See Test Network-enabled extensions for security.
For security, you can use the settings for dashboard extensions on Tableau Cloud to control
and limit the dashboard extensions that are allowed to run.
l

By default, Sandboxed extensions are allowed to run if extensions are enabled for the
site.

l

By default, no Network-enabled extensions are allowed unless they have been explicitly added to the safe list.

l

By default, only extensions that use the HTTPS protocol are allowed, which guarantees an encrypted channel for sending and receiving data (the only exception is for
http://localhost).

l

If the Network-enabled extension requires full data (access to the underlying data) the
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extension will not be able to run on Tableau Cloud unless you explicitly add the extension to the safe list and grant the extension access to full data.

Control dashboard extensions and access to data
Site administrators can control whether to enable extensions for the site and whether to
allow Sandboxed extensions on the site. The default site settings allow Sandboxed extensions to run on the site, provided the extension is not specifically blocked on the server. The
default site settings allow Network-enabled extensions to run that appear on the safe list for
the site. Individual Sandboxed extensions can also be added to the safe list, if Sandboxed
extensions are not allowed by default.
1. To change these settings for the site, go to Settings > Extensions.
2. Under Dashboard Extensions, configure these options:
l
l

Let users run extensions on this site
Let Sandboxed extensions run unless they are specifically blocked by
a server administrator

Site administrators can add or remove Network-enabled and Sandboxed extensions from
the safe list for a site. When you add an extension to the safe list, you can control whether to
allow the extension to have access to full data. See Add extensions to the safe list and configure user prompts.

Identifying an extension
As a web application, an extension is associated with a URL. You use this URL to test and
verify the extension. You also use the URL to add the extension to the safe list to allow full
data access, or to the block list to prohibit any access.
If you have the extension manifest file (.trex), an XML file that defines properties for the
extension, you can find the URL from the <source-location> element.
<source-location>
<url>https://www.example.com/myExtension.html</url>
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</source-location>

If you have added the extension to the dashboard, you can find the URL from the extension
properties. From the More Options menu, click About.

The About dialog box lists the name of the extension, the author of the extension, the web
site of the author, along with the URL of the extension.

Add extensions to the safe list and configure user prompts
To ensure that users can use Network-enabled extensions that are trusted, you can add
them to the safe list for the site. You can also add Sandboxed extensions to the safe list, if
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Sandboxed extensions aren't enabled by default on the site.
On the safe list, you can control whether to grant the extension full data access. By default,
when you add an extension to the safe list, the extension only has access to the summary
(or aggregated) data. You can also control whether users will see a prompt asking them to
allow the extension access to data. You might want to add an extension to the safe list (for
example, a Sandboxed extension) so that you can configure whether or not users see the
prompts. When you hide the prompt from users, the extension can run immediately.
1. Go to Settings > Extensions.
2. Under Enable Specific Extensions, add the URL of the extension. See Identifying
an extension.
3. Choose to Allow or Deny the extension Full Data Access.
Full data access is access to the underlying data in the view, not just the summary or
aggregated data. Full data access also includes information about the data sources,
such as the names of the connection, fields and tables. In most cases, if you are
adding an extension to the safe list so that it can run, you will also want to allow the
extension to have access to full data, if the extension requires it. Before adding extensions to the safe list, be sure to Test Network-enabled extensions for security.
4. Choose to Show or Hide the User Prompts.
Users see the prompts by default when they are adding an extension to a dashboard,
or when they are interacting with a view that has an extension. The prompt tells users
details about the extension and whether the extension has access to full data. The
prompt gives users the ability to allow or deny the extension from running. You can
hide this prompt from users, allowing the extension to run immediately.

Test Network-enabled extensions for security
Dashboard extensions are web applications that interact with data in Tableau using the
Extensions API. Network-enabled dashboard extensions could be hosted on web servers
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inside or outside of your domain, and can make network calls and have access to resources
on the Internet. Because of this and the potential vulnerabilities, such as cross-site scripting,
you should test and vet Network-enabled dashboard extensions before users use them in
dashboards on Tableau Desktop, and before you allow the extensions on Tableau Cloud.

Examine the source files
Dashboard extensions are web applications and include various HTML, CSS and JavaScript
files, and an XML manifest file (*.trex) that defines the properties in the extension. In many
cases, the code for a dashboard extension is publicly available on GitHub and can be
examined there or downloaded. In the manifest file (*.trex), you can find the source location, or URL indicated where the extension is hosted, the name of the author and the web
site of the author or company to contact for support. The <source-location> element
specifies in the URL, the <author> element, specifies the name of the organisation and the
website to contact for support (website="SUPPORT_URL"). The website is the Get Support link user see in the About dialog box for the extension.
Many dashboard extensions reference external JavaScript libraries, such as the jQuery library or API libraries for third parties. Validate that the URL for external libraries points to a
trusted location for the library. For example, if the connector references the jQuery library,
make sure that the library is on a site that is considered standard and safe.
All extensions are required to use HTTPS protocol (https://) for hosting their extensions.
You should examine the source files for the extension to ensure that any reference to
external libraries is also using HTTPS or is hosted on the same website as the extension.
The one exception to the requirement of HTTPS is if the extension is hosted on the same
computer as Tableau (http://localhost).
To the extent possible, make sure you understand what the code is doing. In particular, try to
understand how the code is constructing requests to external sites, and what information is
being sent in the request. In particular, check if any user-supplied data is validated to prevent
cross-site scripting.
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Understand data access
The Tableau Extensions API provides methods that can access the names of the active
tables and fields in the data source, the summary descriptions of the data source connections and the underlying data in a dashboard. If an extension uses any of these methods
in a view, the extension developer must declare that the extension requires full data permission in the manifest file (.trex). The declaration looks like the following.
<permissions>
<permission>full data</permission>
</permissions>
Tableau uses this declaration to provide a prompt to users at run time that gives them the
option of allowing this access or not. If the extension uses any one of these four methods,
without declaring full-data permission in the manifest file, the extension will load but the
method calls will fail.
For information about how an extension accesses data from the dashboard, and the
JavaScript methods used, see Accessing Underlying Data in the Tableau Extensions API.
To get a better understanding about what the extension can find out about the data, you can
use the DataSources sample dashboard extension (available from the Tableau Extensions
API GitHub repository) to see what data is exposed when the getDataSourcesAsync
() method is called.

Test the extension in an isolated environment
If possible, test the dashboard extension in an environment that is isolated from your production environment and from user computers. For example, add a dashboard extensions
to a safe list on a test computer or virtual machine that's running a version of Tableau Cloud
that is not used for production.

Monitor traffic created by the dashboard extension
When you test a Network-enabled dashboard extension, use a tool like Fiddler, Charles
HTTP proxy or Wireshark to examine the requests and responses that the extension
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makes. Make sure that you understand what content the extension is requesting. Examine
the traffic to be sure that the extension is not reading data or code that is not directly related
to the purpose of the extension.

Configure Connections with Analytics Extensions
Analytics extensions allow you to extend Tableau dynamic calculations in a workbook with
languages like R and Python, with Einstein Discovery, and with other tools and platforms.
These settings endpoints enable you to configure analytics extensions on your site in
Tableau Cloud. For more information, see Analytics Extensions API.
For more information about user scenarios and configuring analytics connections in Tableau
Desktop or for web authoring, see Pass Expressions with Analytics Extensions, in the
Tableau Desktop and Web Authoring Help.

Note: Beginning in June 2021, you can create multiple analytics extensions connections
for a site, including multiple connection for the same type of extension (you are presently
limited to a single Einstein Discovery analytics extension for each site). For details, see
What’s New in Tableau Cloud.

This topic describes how to configure sites on Tableau Cloud with analytics extensions.

Security requirements and configuration
For increased security, Tableau Cloud requires an encrypted channel and authenticated
access to the external services used for analytics extensions.
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Certificate
The server running the external service for analytics extensions must be configured with a
valid TLS/SSL certificate from a trusted 3rd party certificate authority (CA). Tableau Cloud
will not establish a connection with external servers that are configured with a self-signed
certificate, a certificate from a private PKI or a certificate that is not trusted by an established
third-party CA.

Allowlist firewall configuration
Many organisations deploy a firewall that requires allowlist exceptions for known hosts outside the network. In this scenario, you will need to specify two Tableau Cloud IP addresses
as exceptions. The Tableau Cloud IP addresses used for connections to analytics extensions servers are 44.224.205.196 and 44.230.200.109.

Configure analytics extensions settings
1. Sign in to Tableau Cloud as a site administrator.
2. Click Settings.
3. On the Settings page, click the Extensions tab and then scroll to Analytics Extensions.
4. Select Enable analytics extensions for site.
5. Click Create new connection.
6. In the New Connection dialog, click the connection type you want to add, then enter
the configuration settings for your analytics service:
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3. The options you need to configure depend on the connection type you choose:
l
l

For an Einstein Discovery connection, click Enable.
For TabPy, RServer and Analytics Extensions API connections, enter the following information:
l

l

Connection Name: (Required) Specify the server type you are connecting to. RSERVE supports connections to R using the RServe package. TABPY supports connections to Python using TabPy, or to other
analytics extensions.
Require SSL (Recommended): Select this option to encrypt the connection to the analytics service. If you specify a HTTPS URL in the Host-

l
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name field, then you must select this option.
Hostname: (Required) Specify the computer name or URL where the
analytics service is running. This field is case sensitive.
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l
l

Port: (Required) Specify the port for the service.
Sign in with a username and password(Recommended): Select this
option to specify username and password that is used to authenticate to
the analytics service.

7. Click Save.

Edit or delete an analytics extension connection
To edit or delete a configuration, navigate to Analytics Extensions on the Extensions tab
of your site.

Click the Edit or Delete icon and follow the prompts to change the configuration.

Script errors
Tableau cannot verify that workbooks that use an analytics extension will render properly on
Tableau Cloud. There might be scenarios where a required statistical library is available on
a user’s computer but not on the analytics extension instance that Tableau Cloud is using.
A warning will be displayed when you publish a workbook if it contains views that use an
analytics extension.

This worksheet contains external service scripts, which cannot be viewed on the target platform until the administrator configures an external service connection.
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Table Extensions
Table Extensions allow you to create new data tables with an analytics extensions script.
You can write a custom TabPy or Rserve script and optionally add one or more input tables.
Table extensions are supported by Tableau Cloud, Tableau Server and Tableau Desktop.
This document focuses on Tableau Server.

Note: The data refreshes every time you open up a workbook or refresh a data source.

Benefits
Table Extensions have the following benefits for both new and experienced users.
l
l
l
l
l

Faster data processing
Low code editor
Integrates with Ask Data and Explain Data
Integrates with TabPy and Rserve
Results can be used to construct dashboards or visualisations.

Prerequisites
Before you can use table extensions, you must complete the following list.
l

Configure an analytics extension
o

l

For steps to configure analytics extension connections, see Configure Con-

nections with Analytics Extensions.
Publish your workbook.

Create a Table Extension
To create a new table extension, complete the steps below.
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1. Open a published workbook.

Note: The workbook must be published before you can add a table extension.

2. Under Sheets, choose New Table Extension.

3. (Optional) Drag sheets into the table extension pane.
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4. Under Choose a Connection, select an analytics extension.

5. In Script, enter your script.
6. Select Apply.
7. Choose Update Now and the results will appear in the Output Table tab.

8. In the Name field, enter a unique name for your new table extension.
9. Go to the sheet tab and publish the workbook to save it.

Note: If you edit the input table, you have to press Apply again before you can see or
use the updated output table data.

Troubleshooting tip: If your table extension is hitting an error, try using the circular
Refresh Data Source button, located next to the Save button.
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Table Extensions vs Analytics Extensions
Tableau has a few different features with "extension" in the name. While some of these
products aren't related, table extensions and analytics extensions are. The table extensions
feature relies on a connection with analytics extensions to work. Let's break down each feature.
Table Extensions

The table extensions feature lets you create workbook calculations that send data and a processing script to your analytics extension. The returned results are displayed as a table on
the Data Source tab and as measures and dimensions in the workbook.
Analytics Extensions

The analytics extensions feature allows you to extend Tableau dynamic calculations with
programming languages like Python, external tools and external platforms. After you create
a connection to an analytics extension, you can communicate with your external server
through calculated fields. For more information, see Configure Connections with Analytics
Extensions.

Configure Einstein Discovery Integration
Beginning March, 2021, Tableau Cloud supports integration with Einstein Discovery, making Einstein Discovery predictions available to authors and viewers of dashboards. Starting
in version 2021.2.0, Einstein Discovery predictions is also now available when authoring
flows on the web.
Einstein Discovery in Tableau is powered by salesforce.com. Consult your agreement with
salesforce.com for applicable terms.
For details on how to use Einstein Discovery predictions in Tableau, including licensing and
permission requirements, see Integrate Einstein Discovery Predictions in Tableau in the
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Tableau Desktop and Web Authoring Help. For information about adding predictions in
flows, see Add Einstein Discovery Predictions to your flow.

Einstein Discovery dashboard extension
The Einstein Discovery dashboard extension allows workbook authors to surface real-time
predictions in Tableau. The dashboard extension delivers predictions interactively, ondemand, using source data in a Tableau workbook and an Einstein Discovery-powered
model deployed in Salesforce.
By default, Tableau Cloud site configuration allows saved OAuth access tokens, so the only
step necessary is to configure Cross-Origin Resource Sharing (CORS) in the Salesforce org
that hosts Einstein Discovery. This requires permissions in the Salesforce org. For details on
necessary licenses and permissions, see Requirements for access - Einstein Discovery. For
details on configuring CORS in Salesforce, see Configure CORS in Salesforce.com for Einstein Discover Integration in Tableau Cloud.

Einstein Discovery analytics extension
The Einstein Discovery analytics extension gives your users the ability to embed predictions
directly in Tableau calculated fields. A table calc script requests predictions from a model
deployed in Salesforce by passing its associated prediction ID and input data that the model
requires. Use Model Manager in Salesforce to auto-generate a Tableau table calculation
script, and then paste that script into a calculated field for use in a Tableau workbook.
By default, Tableau Cloud site configuration allows saved OAuth access tokens, so the only
step necessary is to configure Cross-Origin Resource Sharing (CORS) in the Salesforce org
that hosts Einstein Discovery. This requires administrator permissions in the Salesforce org.
For details, see Configure CORS in Salesforce.com for Einstein Discover Integration in
Tableau Cloud.

Einstein Discovery Tableau Prep extension
Supported in Tableau Server and Tableau Cloud, starting in version 2021.2.0
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The Einstein Discovery Tableau Prep extension enables users to embed Einstein predictions directly in their flows when authoring flows on the web.
By default, Tableau Cloud site configuration allows saved OAuth access tokens, so the only
necessary step is to enable Tableau Prep Extensions for the server. This requires administrator permissions in the Salesforce org. For details, see Enable Tableau Prep
Extensions.

Configure CORS in Salesforce.com for Einstein Discover
Integration in Tableau Cloud
In version 2021.1.0 the ability to integrate Einstein Discovery predictions into Tableau Dashboards was added. You can do this using the Einstein Discovery dashboard extension. A
prerequisite for this is configuring Cross-Origin Resource Sharing (CORS) in the Salesforce org that hosts Tableau CRM and includes the model and predictions that are going to
be used.
This procedure explains how an administrator in a Salesforce.com organisation would do
this configuration. You can find more information about CORS in the Salesforce documentation, Set Up Cross-Origin Resource Sharing (CORS).

Configure CORS for Einstein Discovery.
Note: This procedure documents the process in Salesforce Lightning. If you are using
the traditional interface, the navigation may be different but the configuration is the
same.

1. Sign in to your Salesforce.com developer account, click your username in the upperright, and then select Setup.

530

Tableau Software

Tableau Cloud Help

2. In the left navigation column, search for "cors" and select CORS .

3. In CORS, in the Allowed Origins List section, click New.

4. In CORS Allowed Origin List Edit, enter the URL of Tableau Cloud, beginning with
"https://".
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For more information about the URL pattern, see the Salesforce developer documentation: https://developer.salesforce.com/docs/atlas.en-gb.chatterapi.meta/chatterapi/extend_code_cors.htm
5. Click Save.

Integrate Tableau with a Slack Workspace
Beginning with version 2021.3, Tableau Server and Tableau Cloud support integration with
Slack, making Tableau notifications available to licensed Tableau users in their Slack workspace.
The Tableau for Slack integration lets you connect your Tableau site with a Slack workspace. After it’s enabled, Tableau users can see notifications in Slack when teammates
share content with them, when they're mentioned in a comment or when data meets a specified threshold in a data-driven alert. If a site administrator in Tableau Cloud or a server
administrator in Tableau Server enables notifications on a site, users can control which notifications they receive in Slack by configuring their Account Settings. For more information,
see See Tableau Notifications in Slack.
Some notifications preferences might not be available if the features are turned off for your
site. For example, if the User Visibility setting is set to Limited, notifications are turned off.
For more information, see Site Settings Reference and Manage Site User Visibility.
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To integrate Slack with your Tableau site, there are a few necessary configuration steps,
including some in your Tableau site and some in the Slack workspace you want to connect.
This overview outlines these steps for both Tableau site administrators on Tableau Cloud or
a Tableau Server Administrator on Tableau Server and Slack workspace administrators.
Requirements
Enabling Tableau in Slack requires both a Slack workspace administrator and either a
Tableau site administrator in Tableau Cloud or a Tableau server administrator in Tableau
Server.

Connect a Tableau Cloud site to a Slack workspace
Tableau Cloud site administrators can connect one or more Tableau Cloud sites to a Slack
workspace. Connecting consists of these tasks:
l

Tableau site administrator: Request permission to the Slack workspace through
Tableau's site settings.

l

l

Slack workspace administrator: Add the Tableau app to a Slack workspace by
approving a request from the Tableau administrator for permission to access the Slack
workspace.
Tableau site administrator: Connect your Tableau site to Slack.

Step 1: Request permission to the Slack workspace
Tableau site administrator
1. Sign in to the site you’d like to connect to Slack. On the Settings page of your site,
select the Integrations tab.

2. Under Slack Connectivity, select Connect to Slack.
Follow the prompt to sign in to your Slack workspace.
3. Request to install the Tableau app in Slack. This request goes to the Slack workspace
administrator. You can add a message to the workspace administrator if needed.
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4. Select Submit.
The Slack administrator will receive a notification for the request. For more information about this process, see An Admin's Guide to Slack Management in Slack's documentation.
Slackbot (Slack’s notification centre) will notify you when your request is approved.

Step 2: Add the Tableau app to the Slack workspace
Slack workspace administrator
Approve the request from the Tableau site administrator in Manage Apps to add the
Tableau app to the Slack workspace.
For more information, see An Admin's Guide to Slack Management in Slack's documentation.

Step 3: Connect your Tableau site to Slack
Tableau site administrator
After the Slack workspace administrator approves the Tableau application, a Tableau
administrator can finalise the app's connection to a Tableau site.
1. On the Settings page of your site, select the Integrations tab.

2. Under Slack Connectivity, select Connect to Slack.
3. Follow the prompt to sign in to your Slack workspace.
4. Select Allow to give your Tableau site access to the Slack workspace.
The Tableau site and Slack workspace are now connected.
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Disconnect a Tableau Server site from Slack
You can disconnect a Tableau site from a Slack workspace by selecting Disconnect from
Slack in the Integrations tab of site settings. Users will continue to receive notifications for
some time. The OAuth client information you added in Step 2 is retained and can be used to
connect to a new workspace if needed.

Update your Tableau Slack application
When a new version of the Tableau Slack application is available, Tableau recommends reinstalling the application to maintain app performance and use new features.
To reinstall the Tableau for Slack app, select Disconnect from Slack in the Integrations tab
of your site settings, then go through the connection steps in Connect a Tableau Cloud site to
a Slack workspace.

Automate Tasks Using tabcmd
tabcmd
Note: The tabcmd command-line utility version 2.0 is available at Tableau tabcmd (new
window). This new version allows you to run tabcmd commands on MacOS and Linux,
and to authenticate using personal access tokens, which allows you to be multi-factor
authentication compliant. Version 2.0 is built on public endpoints available in the Pythonbased Tableau Server Client (TSC). This latest version works with Tableau Cloud and
has limited support for Tableau Server.

Tableau provides the tabcmd command-line utility that you can use to automate site administration tasks on your Tableau Cloud site. For example, creating or deleting users, projects
and groups.
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Important: tabcmd 1.0 does not support multi-factor authentication (MFA). To use tabcmd with Tableau Cloud, use Tableau tabcmd 2.0 (new window). For more information
about Tableau Cloud and MFA, see Multi-Factor Authentication and Tableau Cloud.

Install tabcmd
Note: These instructions are for installing the tabcmd 1.0 command-line utility. To
install the tabcmd 2.0 command-line utility, go to Tableau tabcmd (new window).

When Tableau Server or Tableau Cloud is upgraded to a new version, if an updated version
of tabcmd is required, you can download it from the Tableau Server Releases page on the
Tableau website.
For Tableau Server, we recommend you download the version that matches your server
version. For Tableau Cloud, we recommend you always download the latest version to
avoid issues caused by version incompatibilities. In either case, using an out of date version
of tabcmd can cause errors and unpredictable results.
1. Open a web browser and go to the Tableau Server Releases page. Go to this page
even if you use Tableau Online.
2. If you're using:
l
l

Tableau Cloud, use Tableau tabcmd 2.0 (new window).
Tableau Server (Windows or Linux): select the release that matches your
server version.

In either case, if the expanded information shows maintenance releases, select the
latest maintenance release or the one that matches your server version.
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This takes you to the release notes page, called Resolved Issues, where you can read
about security improvements and resolved issues.
3. Scroll to the Download Files section under the resolved issues, select the tabcmd
download link that is compatible with the computer on which you’ll run the tabcmd
commands.

The remaining steps refer to this computer as “the tabcmd computer.”
4. Save the installer to the tabcmd computer, or a location accessible from that
computer .
5. Complete the installation steps as appropriate for the operating system of the tabcmd
computer:
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l

Windows
By default tabcmd is installed to C:\Program Files\Tableau\Tableau
Server\<version>\extras\Command Line Utility. You can
change this during installation and recommend that you install tabcmd to a
folder named tabcmd at the root of the C:\ drive (C:\tabcmd). This can
make it easier to locate and run, and will accommodate some limitations with
the Windows operating system if you add the tabcmd directory to the Windows
PATH.

Note The tabcmd Setup program does not add the tabcmd directory to the
Windows PATH variable. You can add it manually, or you can include the
full path to tabcmd each time you call it.

You can install tabcmd in two ways on Windows:
l

Double-click the installer to follow the steps in the UI:
a. Accept the licence agreement.
b. If you want to install to a non-default location, click Customise
and type or browse to the location you want to install tabcmd to.
c. Click Install.
If you are prompted by Windows Defender Firewall or User
Account Control, click Allow access.

l

Run the installer from a command prompt:
a. Open a command prompt as administrator on the tabcmd computer.
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b. Navigate to the directory where you copied the tabcmd installer.
c. Install tabcmd:
tableau-setup-tabcmd-tableau-<version_code>x64.exe /quiet ACCEPTEULA=1
To install to a non-default location:
tableau-setup-tabcmd-tableau-<version_code>x64.exe /quiet ACCEPTEULA=1 INSTALLDIRR="<path\to\install\directory>"
For example:
tableau-setup-tabcmd-tableau-<version_code>x64.exe /quiet ACCEPTEULA=1 INSTALLDIRR="C:\tabcmd"
For a complete list of command line options you can use with the
tabcmd installer, run the installer with a /?. For more information on
tabcmd installer command line options, see Install Switches and
Properties for tabcmd (Windows).
The tabcmd Setup program creates logs in C:\Users\<user>\AppData\Local\Temp you can use if you have problems
installing tabcmd. The logs use the naming convention Tableau_Server_
Command_Line_Utility_(<version_code>)_##############.log.

l

Linux
Note: To run tabcmd on a Linux computer, you must have Java 11
installed. On RHEL-like systems, this will be installed as a dependency
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when you install tabcmd. On Ubuntu systems, you need to install Java
11 separately if it is not already installed.
As of July 2022, Debian distributions are no longer supported. For more
information, see this Tableau Community post.

a. Log on as a user with sudo access to the tabcmd computer.
b. Navigate to the directory where you copied the .rpm or .deb package
that you downloaded.
l

On RHEL-like distributions, including CentOS, run the following
command:
sudo yum install tableau-tabcmd-<version>.noarch.rpm

l

On Ubuntu, run the following command:
sudo apt-get install ./tableau-tabcmd-<version>_all.deb

To uninstall tabcmd from a Linux computer, see the documentation for the Linux variety you are running.
6. (Optional) Add the fully qualified location where tabcmd is installed to your system
path to allow you to run tabcmd commands without changing to that location, or specifying the location with each command. Steps to do this depend on the type and version of your operating system. For more information, see PATH_(variable).

How to use tabcmd
The basic steps for using tabcmd are as follows:
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1. Open the Command Prompt as an administrator.

Note: Do not use PowerShell to run tabcmd commands on Windows. Using
PowerShell can cause unexpected behaviour.

2. On a Windows computer, if you installed tabcmd on a computer other than the initial
node, change to the directory where you installed tabcmd.
On a Linux computer, you do not need to change to the install directory.
3. Run the tabcmd command.
When you use tabcmd, you must establish an authenticated server session. The session
identifies the server or Tableau Cloud site and the user running the session. You can start a
session first, and then specify your command next, or you can start a session and execute a
command all at once.

Important: If you are using tabcmd to perform more than one task, you must run tasks
one after another (serially), rather than at the same time (in parallel).

Commands (such as login) and the options (such as -s, -u, etc.) are not case sensitive,
but the values you provide (such as User@Example.com) are case sensitive.

Examples
The following command demonstrates starting a session:
tabcmd login -s https://online.tableau.com -t mysite -u authority@email.com -p password
Here’s how to start a session and delete a workbook with one command – that you do not
need login here:
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tabcmd delete "Sales_Workbook" -s https://online.tableau.com -t
campaign -u admin@email.com -p password
The options -s, -t, -u, and -p are among the tabcmd global variables, which can be used
with any command.
For more information, see tabcmd Commands.

tabcmd Commands
Note: The tabcmd command-line utility version 2.0 is available at Tableau tabcmd
(new window). This new version allows you to run tabcmd commands on MacOS and
Linux, and to authenticate using personal access tokens, which allows you to be multifactor authentication compliant. Version 2.0 is built on public endpoints available in the
Python-based Tableau Server Client (TSC). This latest version works with Tableau
Cloud and has limited support for Tableau Server.

You can use the following commands with the tabcmd command line tool in Tableau Cloud:
login
logout
get url
addusers (to group)
creategroup
deletegroup
export
createproject
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deleteproject
publish
createextracts
refreshextracts
deleteextracts
runschedule
delete workbook-name or datasource-name
createsiteusers
deletesiteusers
removeusers
version

addusers group-name
Adds users to the specified group.
Example
tabcmd addusers "Development" --users "users.csv"
Options

--users
Add the users in the given .csv file to the specified group. The file should be a simple
list with one user name per line. User names are not case sensitive. The users should
already be created on Tableau Cloud.
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For more information, see CSV Import File Guidelines.

--[no-]complete
When set to complete this option requires that all rows be valid for any change to succeed. If not specified, --complete is used.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
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for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1
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createextracts
Creates extracts for a published workbook or data source.
Options

-d, --datasource
The name of the target data source for extract creation.

--embedded-datasources
A space-separated list of embedded data source names within the target workbook.
Enclose data source names with double quotes if they contain spaces. Only available
when creating extracts for a workbook.

--encrypt
Create encrypted extract.

--include-all
Include all embedded data sources within target workbook. Only available when creating extracts for workbook.

--parent-project-path
Path of the project that is the parent of the project that contains the target resource.
Must specify the project name with --project.

--project
The name of the project that contains the target resource. Only necessary if --workbook or --datasource is specified. If unspecified, the default project 'Default' is used.

-u, -url
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The canonical name for the resource as it appears in the URL.

-w, -workbook
The name of the target workbook for extract creation.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
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for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1
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creategroup group-name
Creates a group. Use addusers to add users after the group has been created.
Example
tabcmd creategroup "Development"

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
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Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
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tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

createproject project-name
Creates a project.
Example
tabcmd createproject -n "Quarterly_Reports" -d "Workbooks showing quarterly sales reports."
Options

-n, --name
Specifies the name of the project that you want to create.

--parent-project-path
Specifies the name of the parent project for the nested project as specified with the -n
option. For example, to specify a project called "Nested" that exists in a "Main" project,
use the following syntax: --parent-project-path "Main" -n "Nested".

-d, --description
Specifies a description for the project.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.
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-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.
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--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

createsiteusers filename.csv
Adds users to a site, based on information supplied in a comma-separated values (CSV) file.
If the user is not already created on the server, the command creates the user before adding
that user to the site.
The CSV file must contain one or more user names and can also include (for each user) a
password, full name, licence type, administrator level, publisher (yes/no) and email address.
For information about the format of the CSV file, see CSV Import File Guidelines.
As an alternative to including administrator level and publisher permissions in the CSV file,
you can pass access level information by including the --role option and specifying the site
role you want to assign users listed in the CSV file.
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By default, users are added to the site that you are logged in to. To add users to a different
site, include the global --site option and specify that site. (You must have permissions to
create users on the site you specify.)
Example
tabcmd createsiteusers "users.csv" --role "Explorer"
Options

--admin-type
Deprecated. Use the --role option instead.

--auth-type
Sets the authentication type (TableauID or SAML) for all users in the .csv file. If
unspecified, the default is TableauID.

Note: To use SAML authentication, the site itself must be SAML-enabled as well. For
information, see Enable SAML Authentication on a Site.

--[no-]complete
Deprecated. Default error behaviour: if there are more than 3 errors within a ten-row
span, then the command will fail.

--no-publisher
Deprecated. Use the --role option instead.

--nowait
Do not wait for asynchronous jobs to complete.

--publisher
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Deprecated. Use the --role option instead.

--role
Specifies a site role for all users in the .csv file. When you want to assign site roles
using the --role option, create a separate CSV file for each site role.
Valid values are: ServerAdministrator, SiteAdministratorCreator, SiteAdministratorExplorer, SiteAdministrator, Creator, ExplorerCanPublish,
Publisher, Explorer, Interactor, Viewer, and Unlicensed.
The default is Unlicensed for new users and unchanged for existing users. Users are
added as unlicensed also if you have a user-based server installation, and if the createsiteusers command creates a new user, but you have already reached the limit
on the number of licences for your users.

Note: On a multi-site Tableau Server, if you want to assign the ServerAdministrator site role using the --role option, use the createusers command instead of createsiteusers.

--silent-progress
Do not display progress messages for the command.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Tableau Software

555

Tableau Cloud Help
Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
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need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

delete workbook-name or datasource-name
Deletes the specified workbook or data source from the server.
This command takes the name of the workbook or data source as it is on the server, not the
file name when it was published.
Example
tabcmd delete "Sales_Analysis"
Options

-r, --project
The name of the project containing the workbook or data source you want to delete. If
not specified, the “Default” project is assumed.
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--parent-project-path
Specifies the name of the parent project for the nested project as specified with the -r
option. For example, to specify a project called "Nested" that exists in a "Main" project, use the following syntax: --parent-project-path "Main" -r "Nested".

--workbook
The name of the workbook you want to delete.

--datasource
The name of the data source you want to delete.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.
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-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to

Tableau Software

559

Tableau Cloud Help
tabcmd that anything that follows -- should not be interpreted as an option setting
and can instead be interpreted as a value for the command. This is useful if you need
to specify a value in the command that includes a hyphen. The following example
shows how you might use -- in a tabcmd command, where -430105/Sheet1 is a
required value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

deleteextracts
Deletes extracts for a published workbook or data source.
Options

-d, --datasource
The name of the target data source for extract deletion.

--embedded-datasources
A space-separated list of embedded data source names within the target workbook.
Enclose data source names with double quotes if they contain spaces. Only available
when deleting extracts for a workbook.

--encrypt
Create encrypted extract.

--include-all
Include all embedded data sources within target workbook.

--parent-project-path
Path of the project that is the parent of the project that contains the target resource.
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Must specify the project name with --project.

--project
The name of the project that contains the target resource. Only necessary if --workbook or --datasource is specified. If unspecified, the default project 'Default' is used.

-u, -url
The canonical name for the resource as it appears in the URL.

-w, -workbook
The name of the target workbook for extract deletion.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.
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-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to
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tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

deletegroup group-name
Deletes the specified group from the server.
Example
tabcmd deletegroup "Development"

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.
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-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the
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command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

deleteproject project-name
Deletes the specified project from the server.
Using tabcmd, you can specify only a top-level project in a project hierarchy. To automate
tasks you want to perform on a project within a parent project, use the equivalent Tableau
REST API call.
Example
tabcmd deleteproject "Designs"
Option

--parent-project-path
Specifies the name of the parent project for the nested project as specified with the
command. For example, to specify a project called "Designs" that exists in a "Main" project, use the following syntax: --parent-project-path "Main" "Designs".

Global options

The following options are used by all tabcmd commands. The --server, --user and --
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password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
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When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

deletesiteusers filename.csv
Removes users from the site that you are logged in to. The users to be removed are specified in a file that contains a simple list with one user name, per line. (No additional information is required beyond the user name.)
By default, if the server has only one site, or if the user belongs to only one site, the user is
also removed from the server. On a Tableau Server Enterprise installation, if the server contains multiple sites, users who are assigned the site role of Server Administrator are
removed from the site but are not removed from the server.
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If the user owns content, the user's role is change to Unlicensed, but the user is not
removed from the server or the site. The content is still owned by that user. To remove the
user completely, you must change the owner of the content and then try removing the user
again.
Example
tabcmd deletesiteusers "users.csv"

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.
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--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
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might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

export
Exports a view or workbook from Tableau Cloud and saves it to a file. This command can
also export just the data used for a view. View data is exported at the summary level. To
export detail-level data, you must use the Tableau Server UI. For details, see Download
Views and Workbooks.
Note the following when you use this command:
l

Permissions: To export, you must have the Export Image permission. By default,
this permission is Allowed or Inherited for all roles, although permissions can be set
per workbook or view.

l

Exporting data: To export just the data for a view, use the --csv option. This
exports the summary data used in a view to a .csv file.

l

Specifying the view, workbook, or data to export:
l

Use part of the URL to identify what to export, specifically the "workbook/view" string as it appears in the URL for the workbook or view. Do not
use the “friendly name,” and exclude the :iid=<n> session ID at the end of
the URL.
For example, the Tableau sample view Global Temperatures in the
Regionalworkbook has a URL similar to this: <server_
name>/#/views/Regional/GlobalTemperatures?:iid=3
To export the Global Temperatures view, use the string Regional/GlobalTemperatures.
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Do not use Regional/Global Temperatures, or Regional/GlobalTemperatures?:iid=3.
l

If the server is running multiple sites and the view or workbook is on a site other
than Default, Use -t <site_id>.

l

To export a workbook, get the URL string by opening a view in the workbook,
and include the view in the string you use.
In the above example, to export the Regional workbook, use the string Regional/GlobalTemperatures.

l

To export a workbook, it must have been published with Show Sheets as
Tabs selected in the Tableau Desktop Publish dialog box.
Note: The Tableau workbook that contains the admin views cannot be exported.

l

To filter the data you download, add a parameter filter using this format:
?<filter_name>=value
or, if filtering on a parameter and that parameter has a display name that
matches the name of a measure or dimension:
?Parameters.<filter_name>=value

l

The saved file's format: Your format options depend on what's being exported. A
workbook can only be exported as a PDF using the --fullpdf argument. A view
can be exported as a PDF (--pdf) or a PNG (--png).

l

The saved file's name and location (optional): If you don't provide a name, it will be
derived from the view or workbook name. If you don't provide a location, the file will be
saved to your current working directory. Otherwise, you can specify a full path or one
that's relative to your current working directory.
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Note: You must include a file name extension such as .csv or .pdf. The command does not automatically add an extension to the file name that you provide.

l

Dashboard web page objects not included in PDF exports: A dashboard can
optionally include a web page object. If you are performing an export to PDF of a
dashboard that includes a web page object, the web page object won't be included in
the PDF.

l

Non-ASCII and non-standard ASCII characters and PDF exports: If you are
exporting a view or workbook with a name that includes a character outside the
ASCII character set, or a non-standard ASCII character set, you need to
URL encode (percent-encode) the character.
For example if your command includes the city Zürich, you will need to URL
encode it as Z%C3%BCrich:
tabcmd export "/Cities/Sheet1?locationCity=Z%C3%BCrich" fullpdf

Clearing the Cache to Use Real-Time Data
You can choose to add the URL parameter ?:refresh=yes to force a fresh data query
instead of pulling the results from the cache. If you are using tabcmd with your own scripting
and the refresh URL parameter is being used a great deal, this can have a negative
impact on performance. It is recommended that you use refresh only when real-time data
is required – for example, on a single dashboard instead of on an entire workbook.
Examples
Views
tabcmd export "Q1Sales/Sales_Report" --csv -f "WeeklyReport.csv"
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tabcmd export -t Sales "Sales/Sales_Analysis" --pdf -f "C:\Tableau_Workbooks\Weekly-Reports.pdf"
tabcmd export "Finance/InvestmentGrowth" --png
tabcmd export "Finance/InvestmentGrowth?:refresh=yes" --png
Workbooks
tabcmd export "Q1Sales/Sales_Report" --fullpdf
tabcmd export "Sales/Sales_Analysis" --fullpdf --pagesize
tabloid -f "C:\Tableau_Workbooks\Weekly-Reports.pdf"
Options

-f, --filename
Saves the file with the given filename and extension.

--csv
View only. Export the view data (summary data) in .csv format.

--pdf
View only. Export as a PDF.

--png
View only. Export as an image in .png format.

--fullpdf
Workbook only. Export as a PDF. The workbook must have been published with Show

Sheets as Tabs enabled.
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--pagelayout
Sets the page orientation (landscape or portrait) of the exported PDF. If not specified, its Tableau Desktop setting will be used.

--pagesize
Sets the page size of the exported PDF as one of the following: unspecified, letter, legal, note folio, tabloid, ledger, statement, executive, a3, a4, a5, b4,
b5, or quarto. Default is letter.

--width
Sets the width in pixels. Default is 800 px.

--height
Sets the height in pixels. Default is 600 px.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

574

Tableau Software

Tableau Cloud Help
-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the
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command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

get url
Gets the resource from Tableau Cloud that is represented by the specified (partial) URL.
The result is returned as a file.
Note the following when you use this command:
l

Permissions: To get a file, you must have the Download/Web Save As permission. By default, this permission is allowed or inherited for all roles, although permissions can be set per workbook or view.

l

Specifying a view or workbook to get: You specify a view to get using the
"/views/<workbookname>/<viewname>.<extension>" string, and specify
a workbook to get using the
"/workbooks/<workbookname>.<extension>" string. Replace
<workbookname> and <viewname> with the names of the workbook and view as
they appear in the URL when you open the view in a browser and replace
<extension> with the type of file you want to save. Do not use the session ID at the
end of the URL (?:iid=<n>) or the "friendly" name of the workbook or view.
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For example, when you open a view Regional Totals in a workbook named Metrics
Summary, the URL will look similar to this:
/views/MetricsSummary_1/RegionalTotals?:iid=1
Use the string /views/MetricsSummary_1/RegionalTotals.<extension> to get the view.
Use the string /workbooks/MetricsSummary_1.<extension> to get the workbook.
When downloading workbooks and views from Tableau Cloud, the content of the .twb
or .twbx file is stored in plain text. All data, including filter values that may give
semantic clues to the data, will be readable by anyone who opens the file.
l

File extension: The URL must include a file extension. The extension determines
what is returned. A view can be returned in PDF, PNG, or CSV (summary data only)
format. A Tableau workbook is returned as a TWB if it connects to a published data
source or uses a live connection, or a TWBX if it connects to a data extract.

Note: If you are downloading a view to a PDF or PNG file, and if you include a -filename parameter that includes the .pdf or .png extension, you do not have to
include a .pdf or .png extension in the URL.

l

The saved file's name and location (optional): The name you use for --filename should include the file extension. If you don't provide a name and file extension,
both will be derived from the URL string. If you don't provide a location, the file is saved
to your current working directory. Otherwise, you can specify a full path or one that's
relative to your current working directory.

l

PNG size (optional): If the saved file is a PNG, you can specify the size, in pixels, in
the URL.

Clearing the cache to use real-time data
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You can choose to add the URL parameter ?:refresh=yes to force a fresh data query
instead of pulling the results from the cache. If you are using tabcmd with your own scripting, using the refresh parameter a great deal can have a negative impact on performance. It is recommended that you use refresh only when real-time data is required –
for example, on a single dashboard instead of on an entire workbook.
Examples
Views
tabcmd get "/views/Sales_Analysis/Sales_Report.png" --filename
"Weekly-Report.png"
tabcmd get "/views/Finance/InvestmentGrowth.pdf" -f
"Q1Growth.pdf"
tabcmd get "/views/Finance/InvestmentGrowth" -f "Q1Growth.pdf"
tabcmd get "/views/Finance/InvestmentGrowth.csv"
tabcmd get "/views/Finance/InvestmentGrowth.png?:size=640,480"
-f growth.png
tabcmd get "/views/Finance/InvestmentGrowth.png?:refresh=yes" f growth.png
Workbooks
tabcmd get "/workbooks/Sales_Analysis.twb" -f "C:\Tableau_Workbooks\Weekly-Reports.twb"

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
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is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
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When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

login
Logs in a Tableau Cloud user.
Use the --server, --site, --username, --password global options to create a session.

Note: When you use the tabcmd login command, you cannot use SAML single signon (SSO), even if your site is configured to use SAML. To log in, you must pass the user
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name and password of a user who has been created in your site. You will have the permissions of the Tableau Server user that you're signed in as.

If you want to log in using the same information you've already used to create a session, just
specify the --password option. The server and user name stored in the cookie will be
used.
If the server is using a port other than 80 (the default), you will need to specify the port.
You need the --site (-t) option only if the server is running multiple sites and you are logging in to a site other than the Default site. If you do not provide a password, you will be
prompted for one. If the --no-prompt option is specified and no password is provided, the
command will fail.
Once you have logged in, the session will continue until it expires on the server or the
logout command is run.
Example
Log in to the Tableau Cloud site with the specified site ID:
tabcmd login -s https://online.tableau.com -t siteID -u user@email.com -p password
Options

-s, --server
If you are running the command from a Tableau Server computer that is on your network, you can use http://localhost. Otherwise, specify the computer's URL, such
as http://bigbox.myco.com or http://bigbox.
If the server is using SSL, you will need to specify https:// in the computer's URL.
For Tableau Cloud, specify the URL https://online.tableau.com.
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-t, --site
Include this option if the server has multiple sites, and you are logging in to a site other
than the default site.
The site ID is used in the URL to uniquely identify the site. For example, a site named
West Coast Sales might have a site ID of west-coast-sales.

-u, --username
The username of the user logging in. For Tableau Cloud, the username is the user's
email address.

-p, --password
Password for the user specified for --username. If you do not provide a password,
you will be prompted for one.

--password-file
Allows the password to be stored in the given filename.txt file rather than the command line, for increased security.

-x, --proxy
Use to specify the HTTP proxy server and port (Host:Port) for the tabcmd request.

--no-prompt
Do not prompt for a password. If no password is specified, the login command will
fail.

--cookie
Saves the session ID on login. Subsequent commands will not require a login. This
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value is the default for the command.

--no-cookie
Do not save the session ID information after a successful login. Subsequent commands will require a login.

--timeout SECONDS
The number of seconds the server should wait before processing the login command. Default: 30 seconds.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
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The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and

584

Tableau Software

Tableau Cloud Help
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

logout
Logs out of the server.
Example
tabcmd logout

publish filename.twb(x), filename.tds(x), or filename.hyper
Publishes the specified workbook (.twb(x)), data source (.tds(x)), or extract (.hyper) to
Tableau Cloud.
If you are publishing a workbook, by default, all sheets in the workbook are published without
database user names or passwords.
The permissions initially assigned to the workbook or data source are copied from the project
that the file is published to. Permissions for the published resource can be changed after the
file has been published.
If the workbook contains user filters, one of the thumbnail options must be specified.
Example
tabcmd publish "analysis_sfdc.hyper" -n "Sales Analysis"
--oauth-username "user-name" --save-oauth
If the file is not in the same directory as tabcmd, include the full path to the file.
Example
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tabcmd publish "\\computer\volume\Tableau Workbooks\analysis_
sfdc.hyper" -n "Sales Analysis" --oauth-username "username" -save-oauth
Options

-n, --name
Name of the workbook or data source on the server. If omitted, the workbook, data
source, or data extract will be named after filename.

-o, --overwrite
Overwrites the workbook, data source, or data extract if it already exists on the
server.

-r, --project
Publishes the workbook, data source, or data extract into the specified project. Publishes to the “Default” project if not specified.

--parent-project-path
Specifies the name of the parent project for the nested project as specified with the -r
option. For example, to specify a project called "Nested" that exists in a "Main" project, use the following syntax: --parent-project-path "Main" -r "Nested".

--db-username
Use this option to publish a database user name with the workbook, data source, or
data extract.
If you connect to the data through a protected OAuth connection and access token,
us the --oauth-username option instead.

--db-password
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Use this option to publish a database password with the workbook, data source, or
extract.

--save-db-password
Stores the provided database password on the server.

--oauth-username
The email address of the user account. Connects the user through a preconfigured
OAuth connection, if the user already has a saved access token for the cloud data
source specified in --name. Access tokens are managed in user preferences.
For existing OAuth connections to the data source, use this option instead of --dbusername and --db-password.

--save-oauth
Saves the credential specified by --oauth-username as an embedded credential with
the published workbook or data source.
Subsequently, when the publisher or server administrator signs in to the server and
edits the connection for that workbook or data source, the connection settings will
show this OAuth credential as embedded in the content.
If you want to schedule extract refreshes after publishing, you must include this option
with --oauth-username. This is analogous to using --save-db-password with a traditional database connection.

--thumbnail-username
If the workbook contains user filters, the thumbnails will be generated based on what
the specified user can see. Cannot be specified when --thumbnail-group option is
set.

--thumbnail-group
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If the workbook contains user filters, the thumbnails will be generated based on what
the specified group can see. Cannot be specified when --thumbnailusernameoption is set.

--tabbed
When a workbook with tabbed views is published, each sheet becomes a tab that
viewers can use to navigate through the workbook. Note that this setting will override
any sheet-level security.

--append
Append the extract file to the existing data source.

--replace
Use the extract file to replace the existing data source.

--disable-uploader
Disable the incremental file uploader.

--restart
Restart the file upload.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.
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-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.
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--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

refreshextracts workbook-name or datasource-name
Performs a full or incremental refresh of extracts belonging to the specified workbook or
data source.
This command takes the name of the workbook or data source as it appears on the server,
not the file name when it was published. Only an administrator or the owner of the workbook
or data source is allowed to perform this operation.
Notes:
l

This method will fail and result in an error if your Server Administrator has disabled
the RunNow setting for the site. For more information, see Tableau Server Settings.
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l

You can use tabcmd to refresh supported data sources that are hosted in the cloud.
For example, SQL Server, MySQL, PostgreSQL on a cloud platform; Google Analytics;

l

and so on.
To refresh on-premises data with tabcmd, the data source must be a type that can be
configured for Tableau Bridge Recommended schedules. For all other data sources
that connect to on-premises data, you can use Bridge or the command-line data
extract utility. Learn more at Use Bridge to Keep Data Fresh and Automate Extract

Refresh Tasks from the Command Line.
Examples
tabcmd refreshextracts --datasource sales_ds
tabcmd refreshextracts --project "Sales External" --datasource
sales_ds
tabcmd refreshextracts --project "Sales External" --parent-project-path "Main" --project "Sales External" --datasource sales_
ds
tabcmd refreshextracts --workbook "My Workbook"
tabcmd refreshextracts --url SalesAnalysis
tabcmd refreshextracts --workbook "My Workbook" --addcalculations
tabcmd refreshextracts --datasource sales_ds --removecalculations
Options

--incremental
Runs the incremental refresh operation.

--synchronous
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Adds the full refresh operation to the queue used by the Backgrounder process, to be
run as soon as a Backgrounder process is available. If a Backgrounder process is
available, the operation is run immediately. The refresh operation appears on the
Background Tasks report.
During a synchronous refresh, tabcmd maintains a live connection to the server while
the refresh operation is underway, polling every second until the background job is
done.

--workbook
The name of the workbook containing extracts to refresh. If the workbook has spaces
in its name, enclose it in quotes.

--datasource
The name of the data source containing extracts to refresh.

--project
Use with --workbook or --datasource to identify a workbook or data source in a
project other than Default. If not specified, the Default project is assumed.

--parent-project-path
Specifies the name of the parent project for the nested project as specified with the -project option.
For example:
l

To specify a project called "Nested" that exists in a "Main" project, use the following syntax:
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--parent-project-path "Main" --project "Nested"

l

To specify a project called "Nested2" that is nested within the "Nested" project:
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l

--parent-project-path "Main/Nested" --project "Nested2"

--url
The name of the workbook as it appears in the URL. A workbook published as “Sales
Analysis” has a URL name of “SalesAnalysis”.

--addcalculations
Use with --workbook to materialise calculations in the embedded extract of the workbook or --datasource to materialise calculations in the extract data source. Adds the
operation to the queue used by the Backgrounder process. If a Backgrounder process
is available, the operation runs immediately. This operation appears on the Back-

ground Tasks for Extracts administrative view.

--removecalculations
Use with --workbook or --datasource to remove calculations that were previously
materialised. Adds the operation to the queue used by the Backgrounder process. If a
Backgrounder process is available, the operation runs immediately. This operation
appears on the Background Tasks for Extracts administrative view.

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token is
stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.
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-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.
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--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

removeusers group-name
Removes users from the specified group.
Example
tabcmd removeusers "Development" --users "users.csv"
Options

--users
Remove the users in the given .csv file from the specified group. The file should be a
simple list with one user name per line.

--[no-]complete
Requires that all rows be valid for any change to succeed. If not specified --complete
is used.
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Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.

-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
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surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and can
instead be interpreted as a value for the command. This is useful if you need to specify
a value in the command that includes a hyphen. The following example shows how you
might use -- in a tabcmd command, where -430105/Sheet1 is a required value for
the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

runschedule schedule-name
Runs the tasks in the specified schedule for the site that you are currently logged in to. You
cannot run this for all sites using tabcmd. To run the tasks in the schedule for all sites, log in to
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the web interface, and from the Schedules page, select All Sites and then do a Run Now
on the schedule.
This command takes the name of the schedule as specified on the server.
This command is not available for Tableau Cloud.

Note: This method will fail and result in an error if your Server Administrator has disabled the RunNow setting for the site. For more information, see Tableau Server Settings.

Example
tabcmd runschedule "5AM Sales Refresh"

Global options

The following options are used by all tabcmd commands. The --server, --user and -password options are required at least once to begin a session. An authentication token
is stored so subsequent commands can be run without including these options. This token
remains valid for five minutes after the last command that used it.

-h, --help
Displays the help for the command.

Note: Some commands listed may not apply when using tabcmd with Tableau Cloud.

-s, --server
The Tableau Cloud URL, which is required at least once to begin session.
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-u, --user
The Tableau Cloud username, which is required at least once to begin session.

-p, --password
The Tableau Cloud password, which is required at least once to begin session.

--password-file
Allows the password to be stored in the given .txt file rather than the command line
for increased security.

-t, --site
Indicates that the command applies to the site specified by the Tableau Cloud site ID,
surrounded by single quotes or double quotes. Use this option if the user specified is
associated with more than one site. Site ID is case-sensitive when using a cached
authentication token. If you do not match the case, you may be prompted for a password, even if the token is still valid.

--no-prompt
When specified, the command will not prompt for a password. If no valid password is
provided the command will fail.

--[no-]cookie
When specified, the session ID is saved on login so subsequent commands will not
need to log in. Use the no- prefix to not save the session ID. By default, the session is
saved.

--timeout
Waits the specified number of seconds for the server to complete processing the
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command. By default, the process will wait until the server responds.

-Specifies the end of options on the command line. You can use -- to indicate to tabcmd that anything that follows -- should not be interpreted as an option setting and
can instead be interpreted as a value for the command. This is useful if you need to
specify a value in the command that includes a hyphen. The following example shows
how you might use -- in a tabcmd command, where -430105/Sheet1 is a required
value for the export command.
tabcmd export --csv -f "D:\export10.csv" -- -430105/Sheet1

Tip: For Tabcmd 1.0 commands available for Tableau Server, see tabcmd commands.

Install Switches and Properties for tabcmd (Windows)
Note: The tabcmd command-line utility version 2.0 is available at Tableau tabcmd
(new window). This new version allows you to run tabcmd commands on MacOS and
Linux, and to authenticate using personal access tokens, which allows you to be multifactor authentication compliant. Version 2.0 is built on public endpoints available in the
Python-based Tableau Server Client (TSC). This latest version works with Tableau
Cloud and has limited support for Tableau Server.

You can use the following switches when installing the Tableau Server Command Line Utility (tabcmd) version 2019.4.0 or later from the command line on Windows.

Note: There are no equivalent switches for the Linux version of the tabcmd installer.

Switch
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/install |

Run Setup

Default is to install, displaying UI and all prompts. If no

/repair |

to either

directory is specified on a fresh install, C:\Program

/uninstall |

install, repair

Files\Tableau\Tableau Server-

/layout "

or uninstall

<directory>
"

tabcmd, or

\<version>\extras\Command Line Utility is assumed.

with /layout, create
a complete
local copy of
the installation bundle
in the directory specified.

/passive

Run Setup
with minimal
UI and no
prompts.

/quiet | /si- Run Setup
lent
in unat-

Note: Use either /silent or /quiet, not both.

tended, fully
silent mode.
No UI or
prompts are
displayed.
/norestart

Run Setup
without

Note: In certain rare cases, a restart cannot be

restarting

suppressed, even when this option is used. This is

Windows,
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even if a
restart is

most likely when an earlier system restart was

necessary.

skipped, for example, during installation of other
software.

/log "<log-

Log inform-

If no file location is specified, the log file is written to the

file>"

ation to the

user's TEMP folder (C:\User-

specified file

s\<username>\AppData\Local\Temp). Check

and path.

this log file for errors after installation.

By default

Example: <Setup file> /silent /log

log files are

"C:\Tableau\Logs\tabcmd-Install"

created in

ACCEPTEULA=1

the user's
%TEMP%
folder with a
naming convention of
Tableau_
Server_
Command_
Line_
utility_
<version_
code>.log
.

Properties

Descrip-

Comments

tion
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ACCEPTEULA=1|0

Accept

If not included when

the End

using /passive, /si-

User
Licence
Agreement
(EULA).
Require-

lent or /quiet,
Setup fails silently.
If included but set to 0,
Setup fails.

d for
quiet,
silent
and
passive
install. 1
= accept
the
EULA, 0
= do not
accept
the
EULA.

INSTALLDIR-

Install

Specifies the location to

="<path\to\i-

tabcmd

install tabcmd. If not

installation\directory>"

to the
specified
non-

used, tabcmd is installed
to C:\Program
Files\T-

default

ableau\Tableau

install

Server\<version_

location.

code>\extras\Command Line
Utility
Example: <Setup
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file> /silent
INSTALLDIRR="C:\tabcmd"

Managing Background Jobs in Tableau Cloud
In Tableau Cloud, users can schedule extract refreshes, subscriptions or flows to run periodically. These scheduled items are referred to as Tasks. The Backgrounder process initiates unique instances of these tasks to run them at the scheduled time. The unique
instances of the tasks that are initiated as a result are referred to as Jobs. Jobs are also created for runs that are initiated manually, by clicking the Run Now option in the web interface, programmatically through REST API, or tabcmd commands.
For example, an extract refresh task is created to run daily at 9 AM. This is an extract
refresh task, and every day at 9 AM, a job will be created for the Backgrounder to run.
Running all these jobs can mean that Backgrounder uses a lot of resources at various times
during the day. Using the Job Management feature, Site administrators can get more
details on these jobs that happen in their Site, and take action on those jobs to better manage resource usage. .
The Run Now settings on the General settings page also allows you to manage your
resources by either allowing or blocking users from running jobs manually. By default, this
option is selected to allow users to run jobs manually. Untick the box to prevent users from
running jobs manually.
The Jobs page which contains the information about jobs can be accessed by navigating to
the Existing Tasks menu of the left navigation menu.
Note: Information about jobs can only be viewed by site administrators.
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Overview
This topic describes how to view and understand the information displayed in the Jobs page.
Your Tableau Cloud site comes with capacity to support all your users’ analytic needs. A
site’s capacity includes capacity for storage and tasks that need to be performed on the site
for extracts, metrics, subscriptions and flows. The jobs page allows you to monitor the tasks
for your Tableau Cloudsite. For more information on site capacity, see Tableau Cloud Site
Capacity.
At the top of the page, there are high-level statistics for the number of Failed, Completed
and Cancelled jobs within the past 24 hours. Applying filters do not change these values.

For each job generated, there is a Job ID, the status of that job, the priority, the type of task
that the job was generated from, the current run time – if the job is in-progress, current queue
time – if queued, as well as the average run time and average queue time.
Tableau records historical run times and queue times to compute the average run times and
average queue times. Both average run times and average queue times are calculated as
weighted averages using the following formula: ((current run time or queue time average x 4)
+ most recent run time or queue time)/5.
The Job ID can be useful when viewing jobs on Admin views . When you click on the Job
ID, you will see more detailed information about the job, such as the Job LUID, the project
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name, the schedule, the content name, content owner, job creator and the last time the job
ran successfully.

Note: Doing a Refresh Now from the Data Sources page will only show the LUID information in the Job Details dialog box.

Task Types
There are several types of tasks:
l

Bridge Refresh: Includes full and incremental extract refreshes that use Cloud schedules. For more information, see About Bridge Refresh jobs.

l

Extracts: This includes extract creation, incremental extract refreshes and full extract
refreshes. .

l

Subscriptions: Includes subscriptions for workbooks and views. For more information, see Create a Subscription to a View or Workbook.

l

Flow: This includes scheduled flows and manual flow runs.

l

Encryption: Includes the following:
l
l
l
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Extract encryption and decryption
Flow encryption and decryption
Re-key extracts and flows
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Filters
You can filter to see only certain jobs. The available filters are by Job Status type, Task Type
and Time Range. For the Time Range filter, you can choose from past one to 24 hours, in
four hour increments.

Cancelling Jobs
Extract refreshes, subscriptions and flow run jobs can be cancelled. You can only cancel one
job at a time, and selecting multiple jobs at one time for cancellation is not supported.
When you cancel a job, an email with the time the job was cancelled, the affected content
and the time the job ran before being cancelled is sent to the recipients that you select in the
Cancel Job dialog box . In addition, you can add your customised notes to be included in the
email.
If you do not select any recipients, the job will be cancelled, but no email will be sent.
To cancel a job, click on the ellipses next to the Job ID and use the dialog to cancel the job:

Status
There are seven types of status that jobs can be in, and hovering over each status will display
more relevant information.
l

Completed: This job shows as Completed successfully and you can see the time
when the job completed in the tooltip that is displayed when you hover over the status.
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l

In Progress: This job shows as In Progress. A time for how long the job has been
running for is displayed in the tooltip when you hover over the status.

l

In Progress: This job is In Progress, but is running late. Tableau keeps track of
the average run times for the same job, and if the current run time is longer than the
average run time, then it is considered running late. Times for how much longer than
average the job has been running and its average run time is provided in the tooltip
that is displayed when you hover over the status.

l

Pending: This job is currently Pending, waiting to be run when there is available
Backgrounder capacity. A time for how long the job has been in the queue for is
provided in the tooltip that is displayed when you hover over the status.
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l

Pending: This job is currently Pending, but is running late. Tableau keeps track of
the average queue times for the same job, and if the current queue time is longer than
the average queue time then it is considered running late. Times for how much longer
than average the job has been queued is provided in the tooltip that is displayed when
you hover over the status.

l

Cancelled: This job was Cancelled by a Site administrator. The time the job was cancelled and how long it ran for before cancellation is provided in the tooltip that is displayed when you hover over the status.

l

Failed: This job is showing as Failed. The time when the job failed, how long it ran for
before it failed, and why the job has failed is provided in the tooltip that is displayed
when you hover over the status.
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l

Suspended: This job is showing as Failed with a pause icon. If the job fails 5 times
consecutively, the job will be suspended. Suspended tasks are still available but Backgrounder will not create jobs for these tasks until they are resumed by the user.

About Bridge Refresh jobs
Although Bridge Refresh jobs can generate the same statuses as other job types, Bridge
Refresh jobs differ in the following ways:
l

Cancelling jobs: Bridge Refresh jobs can't be cancelled from the Jobs page.
Instead, ensure that Bridge clients are configured with the appropriate timeout limit to
prevent any misuse of refreshes. For more information, see Configure a timeout limit
for refreshes

l

"Sent to Bridge" job status: A "Sent to Bridge" status indicates a completed
Bridge Refresh job. A completed Bridge Refresh job means that the refresh job was
successfully sent to a Bridge client in the pool. A completed Bridge Refresh job does
not indicate whether the refresh itself completed successfully. If a refresh fails for
whatever reason, the publisher (data source owner) is notified through both an
account alert and a failure email alert. These alerts provide the publisher troubleshooting steps to help resolve the issue.
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l

Subscription and Bridge Refresh jobs: Subscription jobs can't be initiated by completed Bridge Refresh jobs. This is because a completed Bridge Refresh job only indicates whether the refresh job was successfully sent to a Bridge client in the pool and not
whether the refresh job was completed successfully.

Notes:
l

Refresh jobs that originate from Bridge (legacy) schedules are not captured on the
Jobs page. To monitor refresh jobs for Bridge (legacy) schedules, you can refer to the
Bridge Extracts admin view. For more information, see Bridge Extracts.

l

For troubleshooting Bridge errors you see on the Jobs page, see Troubleshoot

pooling.
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Manage Data
After you’ve configured your Tableau Cloud site with your logo and authentication options,
you can start organising the content framework for the way you and your users want to
share Tableau data. To populate your Tableau Cloud site with content (data, reports, and
so on), you or the data professionals in your organisation publish that content. Depending
on the type of licence, users can connect to and publish content from Tableau Desktop, or
from the Tableau Cloud web editing environment.
Types of content you can publish include standalone data sources that users can share
among multiple workbooks, and workbooks that contain embedded data connections with
visualisations based on that data. Each of these types has pros and cons, which are
explained in the Publishing resources below.

Determine your organisation’s publishing
needs
As the site administrator, before you open the site for publishing, evaluate how much preparation you think is appropriate for your level of Tableau Cloud use:
l

If you don’t have strict requirements around data access – for example, you have just
a few users who all share the same data – you might dive in to the Publishing
resources, starting with publishing steps, and adjust your publishing and content management practices as you go.

l

If people use Tableau across distinct areas of your organisation, or if you have a large
Tableau user population, we recommend using the Publishing resources to create a
test environment, and working out access and discoverability wrinkles. You can still
adjust practices as you go, but it’s not as easy to do this after you open up the site to a
large group of active users.
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Examples of additional factors you might need to consider are authorisation (permissions for who gets access to what), data security and compliance requirements,
minimising users’ need to contact you for help if they can’t work out where to publish or
find their data, and so on. For more information, see Configure Projects, Groups and
Permissions for Managed Self-Service.

Summary of the publishing process
In Tableau Desktop, you open the workbook or data connection you want to upload to
Tableau Cloud, and go to the Server menu to publish it.
During the publishing steps, you sign in to Tableau Cloud, entering the Tableau Cloud
address (https://online.tableau.com) and your credentials.
The publishing steps require you to make decisions related to how you and others in your
organisation will access your data source or workbook. In some cases, this can involve a few
layers of complexity, and it helps for you to understand how these layers fit together. Use the
topics in the following lists to determine the level of complexity you need and to help establish
appropriate publishing guidelines.

Publishing resources
These resources are part of the Tableau User Help and open in a new browser window.
l

Publishing concepts
Prepare for Publishing a Workbook
Publish Data Sources and Workbooks
Best Practices for Published Data Sources

l

Basic publishing steps for informal collaboration
Simple Steps to Share a Workbook

l

Comprehensive data source planning and publishing steps for meeting
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compliance and security standards, creating a data “source of truth,” and
using best practices
Plan the Data Source
Publish a Data Source
Publish a Workbook

Tableau Cloud storage limit
A site has a 100 GB storage limit for workbooks and extracts. The storage limit is not configurable. For additional technical specifications for Tableau Cloud, see Technical Specifications on the Tableau website.

Tableau Cloud data connection support
You can publish data sources and workbooks using direct (live) or extract connections to
your underlying database. You can also publish multi-connection data sources that use
either or both types of connection. The database connections defined in the workbook or
data source determines how you can publish and keep the data fresh on Tableau Cloud.
If you’re familiar with connection types and want a more specific list of data types and their
supported connections, see Keep Data Fresh. Otherwise, read on.

Connector types that support direct (live) connections to
Tableau Cloud
When you use live connections, published workbooks and data sources always reflect what
is current in the underlying database.
Tableau Cloud supports live connections to:
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l

Google BigQuery, Amazon Redshift data, or SQL-based data hosted on a cloud platform; for example, Amazon RDS, Microsoft SQL Azure, or similar service.
For direct connections to cloud data, you usually need to add Tableau Cloud to your
data provider’s authorised list.

l

On-premises relational data, such as SQL Server or Oracle, when you use Tableau
Bridge to maintain the connection.
To learn more about Tableau Bridge, see Use Tableau Bridge to Keep Data Fresh.

You can embed database credentials in live connections so all users who have access to the
published content can see the underlying data. Or you can require users to provide their own
database credentials. In that case, even if they can open the published content on the server,
they need to sign in to the underlying database to see it.

Connector types that support extract connections
For any type of data that Tableau can connect to, users can publish extracts with embedded
database credentials, and set up recurring refresh schedules.
You can create an extract in Tableau Desktop, before you initiate the publishing process, to
have finer control over the connection definition. You might do this if you want to publish a
sampling of the data, or to set up the ability to refresh incrementally. Otherwise, Tableau creates the extract during publishing, and you can do full refreshes only.
After Tableau completes the publishing step, it guides you through the steps for setting up a
schedule for refreshing your data. If your Tableau data source or workbook connects to
underlying data in the cloud, refreshes are run from Tableau Cloud directly. If the underlying
data is on your local network, you use Tableau Bridge.
To learn more about Tableau Bridge, see Use Tableau Bridge to Keep Data Fresh.
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Creators: Connect to Data on the Web
Before you can create a new workbook and build a view on the web to analyse your data on
the web, you need to connect to your data. Tableau supports connecting to data sources on
the web published through Tableau Desktop, or, connecting to data directly through
Tableau Online, Tableau Server or Tableau Public.
Starting in 2019.3, Tableau Catalogue is available as part of the Data Management offering
for Tableau Server and Tableau Online. When Tableau Catalogue is enabled in your environment, in addition to navigating and connecting to data from Explore, you can navigate
and connect to more kinds of data, like databases and tables. From Tableau Catalogue For
more information about Tableau Catalogue, see "About Tableau Catalogue" in the Tableau
Server or Tableau Online Help. Starting in 2021.4, Data Management includes virtual connections, a central access point to data. For more information, see "About Virtual Connections and Data Policies" in the Tableau Server or Tableau Online help.

Open the Connect to Data page
On the web, you use the Connect to Data page to access data to connect to. After you sign
in to Tableau Server or Tableau Cloud, you can open this page two ways:
l
l

Home > New > Workbook
Explore > New > Workbook

If you’re on Tableau Public, you can open this page from your author profile:
l
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My Profile > Create a Viz
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Select the filter icon to filter by Connection Type and by Certified.

In addition to connecting to data sources, when you have Data Management, you can connect to data with a virtual connection. When Tableau Catalogue is enabled, you can also connect to databases, files and tables.
l

You can select from Data Sources, Virtual Connections, Databases and Files, or

Tables to search for data.

Tableau Software

617

Tableau Cloud Help

l

When you select Databases and Files or Tables, you can filter assets by Data Quality Warning: All assets, Assets without warnings and Assets with warnings.

On the Connect to Data page, the tabs you see depend on the product you have.

Tableau Server
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On Tableau Server, select from the following tabs to connect to data: On this site, Files and
Connectors.

Connect to data On this site
1. Select On this site to browse to or search for published data sources.
2. Select the data source under Name and click the Connect button.

Note: In addition to connecting to data sources, when you have Data Management, you
can use On this site to connect to data using a virtual connection. When Tableau Catalogue is enabled, you can also connect to databases, files and tables.

Connect to files
Tableau supports uploading Excel, text-based data sources (.xlsx, .csv, .tsv), and spatial file
formats that only require one file (.kml, .geojson, .topojson, .json and Esri shapefiles and Esri
File Geodatabases packaged in a .zip) directly in your browser. In the Files tab of the Connect to Data window, connect to a file by dragging and dropping it into the field or clicking
Upload from Computer. The maximum file size you can upload is 1 GB.

Use connectors
From the Connectors tab, you can connect to data housed in a cloud database or on a
server in your enterprise. You need to supply connection information for each data connection that you make. For example, for most data connections, you need to supply a server
name and your sign-in information.
Supported Connectors contains information on how to connect Tableau to each of these connector types to set up your data source. If the connector you need doesn't appear in the Connectors tab, you can connect to data through Tableau Desktop and publish your data source
to Tableau Cloud or Tableau Server for web authoring. Learn more about how to Publish a
Data Source in Tableau Desktop.
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When Tableau successfully connects to your data, the Data Source page opens so that you
can prepare the data for analysis and begin building your view. To learn more, see Creators: Prepare Data on the Web.
Tableau Server connectors

Actian Matrix*

Google Drive‡

OData

Alibaba AnalyticDB for

Impala‡

OneDrive

Kognito*

Oracle‡

Kyvos

Pivotal Greenplum Database‡

Hortonworks Hadoop Hive

PostgreSQL‡

IBM BigInsights

Progress OpenEdge*

IBM DB2

Presto‡

MySQL‡

IBM PDA (Netezza)*

Qubole Presto

Amazon Redshift‡

MapR Hadoop Hive

SAP HANA (for virtual con-

Apache Drill

MariaDB‡

Aster Database*

MarkLogic*

Azure Data Lake Stor-

Microsoft Azure SQL Data-

age Gen2‡

base‡

Salesforce

Box‡

Microsoft Azure Synapse

SharePoint Lists

MySQL‡
Alibaba Data Lake Analytics‡
Alibaba MaxCompute‡
Amazon Athena‡
Amazon Aurora for

Cloudera Hadoop
Databricks
Denodo‡
Dropbox‡
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nections only)‡
SAP Sybase ASE*
SAP Sybase IQ*

Analytics‡
SingleStore (formerly
Microsoft SQL Server‡

MemSQL)‡

MonetDB*

Snowflake‡

MongoDB BI Connector‡

Spark SQL
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Exasol‡

MySQL‡

Google BigQuery**‡

Teradata***‡
Vertica‡

Google Cloud SQL‡
*Not available on Linux servers.
**Google BigQuery requires OAuth when creating data sources from the web. Learn more
about how server administrators can Set up OAuth for Google.
***Teradata web authoring currently does not support query banding functionality. See
Teradata for details.
‡Supports virtual connections if you have Data Management. See About Virtual Connections and Data Policies in the Tableau Server help for details.
Tableau Catalogue Supported Connectors

Tableau Catalogue supports making a connection with a subset of the data connectors that
Tableau Server supports. If a data source, database, file or table is greyed out, you can't connect from Tableau Server. You can, however, connect from the Tableau Desktop Connect
pane, if you have the correct permissions.

Tableau Cloud
On Tableau Cloud, select from the following tabs to connect to data: On this site, Files, Connectors and Dashboard Starters.

Connect to data On this site
1. Select On this site to browse to or search for published data sources.
2. Select the data source under Name and click the Connect button
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Note: In addition to connecting to data sources, when you have Data Management,
you can use On this site to connect to data using a virtual connection. When Tableau
Catalogue is enabled, you can also connect to databases, files and tables.

Connect to files
Tableau supports uploading Excel or text-based data sources (.xlsx, .csv, .tsv) directly in
your browser. In the Files tab of the Connect to Data window, connect to an Excel or text
file by dragging and dropping it into the field or clicking Upload from Computer. The maximum file size you can upload is 1 GB.

Use connectors
From the Connectors tab, you can connect to data housed in a cloud database or on a
server in your enterprise. You need to supply connection information for each data connection that you make. For example, for most data connections, you need to supply a server
name and your sign-in information.
Supported Connectors has information on how to connect Tableau to your data using connectors. If the connector you need doesn't appear in the Connectors tab, you can connect to
data through Tableau Desktop and publish your data source to Tableau Cloud or Tableau
Server for web authoring. Learn more about how to Publish a Data Source in Tableau
Desktop.

Note: If you’re unable to connect to your data from Tableau Cloud, check to see if the
database is publicly accessible. Tableau Cloud can only connect to data that's accessible from the public internet. If your data is behind a private network, you can connect
using Tableau Bridge. To learn more, see Publishers: Use Tableau Bridge to Keep
Tableau Cloud Data Fresh.
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Tableau Cloud Connectors

Alibaba AnalyticsDB for

Exasol‡

OData

Google BigQuery*‡

OneDrive*

Google Cloud SQL

Oracle‡

MySQL‡
Alibaba Data Lake Analytics‡
Amazon Athena‡

(MySQL compatible)‡§
PostgreSQL‡

Amazon Aurora for MySQL‡

Google Drive‡
Presto‡

Amazon EMR Hadoop Hive

Hortonworks Hadoop
Hive

Amazon Redshift‡

SAP HANA (for virtual
connections only)‡

Impala‡
Azure Data Lake Storage
Gen2‡

SharePoint Lists
MapR Hadoop Hive
SingleStore (formerly

Azure Synapse Analytics (SQL

Microsoft Azure

Server compatible)

SQL Database‡

MemSQL)‡
Snowflake‡

Box‡

Microsoft Azure Synapse
Analytics‡

Spark SQL

Cloudera Hadoop
Microsoft SQL Server‡

Teradata**‡

Databricks
MongoDB BI Connector‡

Vertica‡

Denodo‡
MySQL‡
Dropbox*‡
*For more information about using OAuth 2.0 standard for Google BigQuery, OneDrive and
Dropbox connections in Tableau Cloud, see OAuth Connections.
**Teradata web authoring currently does not support query banding functionality. See
Teradata for details.

Tableau Software

623

Tableau Cloud Help
‡Supports virtual connections if you have Data Management. See About Virtual Connections and Data Policies in the Tableau Cloud help for details.
§Tableau Cloud doesn't support SSL using Google Cloud SQL.
Tableau Catalogue Supported Connectors

Tableau Catalog supports making a connection with a subset of data connectors that
Tableau Cloud supports. If a data source, database, file or table is greyed out, you can't connect from Tableau Cloud. You can, however, connect from the Tableau Desktop Connect
pane, if you have the correct permissions.

Use Dashboard Starters
On Tableau Cloud, you can author and analyse data from LinkedIn Sales Navigator, Oracle
Eloqua, Salesforce, ServiceNow ITSM and QuickBooks Online using Dashboard Starters.
On the Dashboard Starter tab, from the list of pre-built designs, select an option and click
Use Dashboard. See Dashboard Starters for Cloud-based Data Sources for details.

Tableau Public
On Tableau Public, you can connect to data by uploading a supported file.

Connect to files
Tableau supports uploading Excel or text-based data sources (.xlsx, .csv, .tsv) directly in
your browser. In the Files tab of the Connect to Data window, connect to an Excel or text
file by dragging and dropping it into the field or clicking Upload from Computer. The maximum file size you can upload is 1 GB.
If you don’t have a data set, check out the free sample data sets on the Tableau Public website.
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Use connectors
From the Connectors tab, you can connect to data housed in a cloud database. You need
to supply connection information for each data connection that you make. For example, for
most data connections, you need to supply your sign-in information.
Supported Connectors has information on how to connect Tableau to your data using connectors. If the connector you need doesn't appear in the Connectors tab, you can connect to
data through Tableau Desktop and create an extract.

Note: If you’re unable to connect to your data from Tableau Public, check to see if the
database is publicly accessible. Tableau Public can only connect to data that's accessible from the public internet.

Tableau Public Connectors

Google Drive
OData

After you connect
When Tableau connects to your data, the Data Source page opens so that you can prepare
the data for analysis and begin building your view. To learn more, see Creators: Prepare
Data on the Web.

Keep data fresh in web authoring
Update uploaded files in Tableau Cloud or Tableau Server: If you manually upload a
file (Excel or text) for web authoring, Tableau can’t refresh the file automatically. To update
your data, select “Edit Connection” to upload a new version of the file.
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In Tableau Public, go to your viz and click Request Update. You can also keep your data
fresh automatically by selecting “Keep this data in sync” in Tableau Desktop Public Edition.
Update file-based published data sources in Tableau Cloud: If you have a published
data source in Tableau Cloud (published through Tableau Desktop) that uses file-based
data, you can keep it fresh using Tableau Bridge. For more information, see Expand Data
Freshness Options by Using Tableau Bridge.

Run Initial SQL
Note: Tableau Prep Builder version 2019.2.2 and later supports using Initial SQL, but
doesn't yet support all of the same options supported by Tableau Desktop . For information
about using Initial SQL with Tableau Prep Builder, see Use Initial SQL to query your connections in the Tableau Prep Builder online help.
When connecting to some databases, you can specify an initial SQL command that will run
when a connection is made to the database, for example, when you open the workbook,
refresh an extract, sign in to Tableau Server, or publish to Tableau Server. Initial SQL is not
run when your refresh your view. Note that this initial SQL is different from a custom SQL
connection. A custom SQL connection defines a relation (or table) to issue queries against.
For more information, see Connect to a Custom SQL Query.
You can use this command to:
l

Set up temporary tables to use during the session.

l

Set up a custom data environment.

You have the option to add an initial SQL command in the Server Connection dialog box or
on the Data Source page.
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Note: If your data source supports running an initial SQL statement, an Initial SQL link
will appear in the lower left corner of the Server Connection dialog box. For information
about your data source, see Supported Connectors.

To use initial SQL
1. In the Server Connection dialog box, click Initial SQL. Or, on the Data Source page,
select Data > Initial SQL or Data > Query Banding and Initial SQL depending on
the database you are connecting to.
2. Enter the SQL command into the Initial SQL dialog box. You can use the Insert dropdown menu to pass parameters to your data source.

Note: Tableau does not examine the statement for errors. This SQL statement is simply
sent to the database when you connect.

Your software licence may restrict you from using initial SQL with your connection. If you publish to Tableau Server, the server must be configured to allow Initial SQL statements. By
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default, the server software is configured to allow these statements to run when the workbook is loaded in a web browser.
Administrators can configure server to ignore initial SQL statements by using the tsm configuration set command:
tsm configuration set -k vizqlserver.initialsql.disabled -v
true
If the server doesn't allow initial SQL statements, the workbook will open, but the initial SQL
commands will not be sent.
For more information about the tsm configuration set command, see the Tableau
Server Help.

Parameters in an initial SQL statement
You can pass parameters to your data source in an initial SQL statement. There are several
reasons why this is useful:
l

You can configure impersonation using the TableauServerUser or TableauServerUserFull parameters.

l

If your data source supports it, you can set up row-level security (for example, for
Oracle VPD or SAP Sybase ASE) to make sure that users see only the data that they
are authorised to see.

l

You can provide more details in logging, for example, the Tableau version or the workbook name.

The following parameters are supported in an initial SQL statement:
Parameter

Description

Example of
returned value

TableauServerUser

The user name of the current server

jsmith

user. Use when setting up imper-
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sonation on the server. Returns an
empty string if the user is not signed in to
Tableau Server.

TableauServerUserFull

The user name and domain of the cur-

domain.lan\jsmith

rent server user. Use when setting up
impersonation on the server. Returns an
empty string if the user is not signed in to
Tableau Server.

TableauApp

The name of the Tableau application.

Tableau Desktop
Professional
Tableau Server

TableauVersion

The version of the Tableau application.

9.3

WorkbookName

The name of the Tableau workbook. Use

Financial-Ana-

only in workbooks with an embedded

lysis

data source.

Examples
The following examples show different ways you can use parameters in an initial
SQL statement.
l

This example sets the security context on Microsoft SQL Server:

EXECUTE AS USER = [TableauServerUser] WITH NO REVERT;
l

This example shows how, on a DataStax data source, you can use parameters to add
detail to logging or to set up a session variable to keep track of the data:
SET TABLEAUVERSION [TableauVersion];

l

This example can be used to help set up row-level security for Oracle VPD:
begin
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DBMS_SESSION.SET_IDENTIFIER([TableauServerUser]);
end;
Note: Oracle PL/SQL blocks require a trailing semicolon to terminate the block. Consult Oracle documentation for the proper syntax.

Defer execution to the server
You can defer an initial SQL statement so that it is executed only on the server. One reason
to defer execution to the server is if you don’t have permission to execute the commands
that set up impersonation. Use <ServerOnly></ServerOnly> tags to enclose the commands to be executed only on the server.
Example:
CREATE TEMP TABLE TempTable(x varchar(25));
INSERT INTO TempTable VALUES (1);
<ServerOnly>INSERT INTO TempTable Values(2);</ServerOnly>

Security and impersonation
If you use the TableauServerUser or TableauServerUserFull parameter in an initial
SQL statement, you will create a dedicated connection that can’t be shared with other
users. This will also restrict cache sharing, which can enhance security, but may also slow
performance.

Troubleshoot 'create table' for MySQL and Oracle connections
For MySQL connections, tables are not listed after using initial SQL to create table

When you connect to MySQL, if you run an initial SQL statement like the following, tables
might not show because of the way Tableau constructs the query:
CREATE TABLE TestV1.testtable77(testID int);
To resolve this issue, add IF NOT EXISTS to the SQL statement:
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CREATE TABLE IF NOT EXISTS TestV1.TestTable(testID int);
For Oracle connections, using initial SQL to create table causes Tableau to stall

When you connect to Oracle and run an initial SQL statement like the following, Tableau is
stalled with a spinning wheel because of the way Tableau constructs the query:
CREATE TABLE TEST_TABLE (TESTid int)
To resolve this issue, use the following SQL statement:
BEGIN
EXECUTE IMMEDIATE 'create table test_table(testID int)';
EXCEPTION
WHEN OTHERS THEN NULL;
END;

Extract Upgrade to .hyper Format
Beginning in version 10.5, new extracts use the .hyper format instead of the .tde format.
Extracts in the .hyper format take advantage of an improved data engine, which supports the
same fast analytical and query performance as the data engine before it, but for even larger
extracts.
Although there are many benefits of using .hyper extracts, the primary benefits include the following:
l

Create larger extracts: Extracts in the .hyper format can contain billions of rows of
data. Because .hyper extracts can support more data, you can use version Tableau
Desktop Current to consolidate .tde extracts that you previously had to create separately.

l

Faster extract creation and refreshes: While Tableau has always optimised
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performance for creating and refreshing extracts, this release supports faster extract
creation and refreshes for even larger data sets.
l

Better performance when interacting with views that use larger extract data
sources: Views that use extract data sources perform better than they did previously. Although smaller extracts continue to perform efficiently, larger extracts perform more efficiently.

What causes an extract upgrade?
Although you can continue to open and interact with .tde extracts in version Current, when
you perform an extract task on a .tde extract, the .tde extract is upgraded to a .hyper extract.
After the extract is upgraded, you should be aware of the following backward limitations:
l

You can't convert the upgraded extract back to a .tde extract.

l

You can't open the upgraded extract in an earlier version of Tableau Desktop.

l

You can't use the Export as Version in Tableau Desktop to downgrade a workbook
that contains a .hyper extract.

l

You can't open a workbook in Tableau Desktop 10.4 and earlier that is downloaded
from Tableau Cloud using the Download Tableau Workbook option if the workbook contains a .hyper extract.

Tasks that cause an extract upgrade
There are three distinct ways a .tde extract can get upgraded to a .hyper extract: 1.) during
an extract refresh (full or incremental), 2.) when appending data to an extract and 3.) when
an extract is upgraded manually using Tableau Desktop Current. After an extract has been
upgraded, the original .tde extract is automatically removed from Tableau Cloud if it's not
being reference by other workbooks.
The followings tasks will upgrade a .tde extract to a .hyper extract on Tableau Cloud:
l
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l

Incremental extract refresh using Tableau Bridge
Note: A full refresh of a .tde extract using Tableau Bridge 10.4 and earlier does not
upgrade the extract.

l

A scheduled full or incremental extract refresh

l

A scheduled incremental extract refresh using Tableau Bridge
Note: A full refresh of a .tde extract using Tableau Bridge 10.4 and earlier does not
upgrade the extract.

l

Automated refresh tasks that are performed through the Extract Command-Line Utility

l

Automated append data to an extract using tabcmd

l

Automated append data to an extract using the Extract Command-Line Utility

Impact of extract upgrade
In general, Tableau recommends that you upgrade to Tableau Desktop Current to match the
latest version of Tableau Cloud. By using the latest version Tableau Desktop, you can avoid
certain extract compatibility issues when working with extracts that were created using
earlier versions of Tableau Desktop.
If you cannot upgrade to the latest version of Tableau Desktop, review a detailed explanation
of the extract compatibility scenarios on the Tableau Support page or a summary explanation below to better understand when extract upgrades can occur and potential compatibility issues you or others might experience.
Note: In the tables below, "10.4" represents Tableau 10.4 and earlier and "10.5" represents
Tableau 10.5 and later.

Tableau Software

633

Tableau Cloud Help

Performing tasks on Tableau Cloud
When working with extracts created in an earlier version of Tableau Desktop, you should be
aware of the following extract-related compatibility scenarios around tasks performed on
Tableau Cloud.
10.4 workbook

10.5 workbook

.tde extract

Task

.tde extract

.hyper
extract

Publish from

√

Not possible

Tableau

Not possible

Desktop 10.4
Publish from

√

√

√

Refresh or

Workbook version

Workbook version

√

scheduled

remains unchanged,

remains unchanged,

Tableau
Desktop 10.5

refresh

but extract upgrades
to .hyper format

Edit/save in

Workbook version

web author-

changes to 10.5, but

ing

extract remains in

but extract upgrades
to .hyper format
√

√

√

.tde format
Edit/save in

Workbook version

Workbook version

web author-

changes to 10.5, and

remains unchanged,

extract upgrades to

but extract upgrades

.hyper format

to .hyper format

ing then
refresh or
append
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Refreshing extracts using Tableau Bridge
When working with extracts created in earlier versions of Tableau, you should be aware of
the following extract-related compatibility scenarios around refreshing extracts using
Tableau Bridge.
10.4 workbook

10.5 workbook

.tde extract

Task

.tde extract

.hyper
extract

Full refresh
Incremental
refresh or
append

Full refresh

from
Tableau
Bridge
10.4

from

√

√

√

Workbook ver-

Workbook ver-

√

sion remains

sion remains

unchanged, but

unchanged, but

extract upgrades

extract upgrades

to .hyper format

to .hyper format

Workbook ver-

Workbook ver-

Tableau sion remains

sion remains

Bridge

unchanged, but

unchanged, but

10.5

extract upgrades

extract upgrades

to .hyper format

to .hyper format

Incremental

Workbook ver-

Workbook ver-

refresh and

sion remains

sion remains

append

unchanged, but

unchanged, but

extract upgrades

extract upgrades

to .hyper format

to .hyper format

√

√

Downloading from Tableau Cloud
When working with extracts created in earlier versions of Tableau, you should be aware of
the following extract-related compatibility scenarios when downloading from Tableau Cloud.
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10.4 work-

10.5 workbook

book
Task
.tde

.tde extract

.hyper

extract
Download in
and open

√

extract
Can't open work-

Can't open

Tableau

book; you see a

workbook; you

Desktop

"this workbook

see a “this file

10.4

uses a .hyper

was created

extract and is not

by a newer ver-

compatible with

sion; upgrade

this version; open

Tableau” error

the workbook in

message

version 10.5 or
later" error message, and then
asked to locate
the extract
in

√

√

√

√

√

Option is

Tableau
Desktop
10.5

Export

from

As Ver-

Tableau

sion

Desktop

greyed out

10.5

Automating extract refresh and append tasks
When working with extracts created in earlier versions of Tableau, you should be aware of
the following extract-related compatibility scenarios around automating refresh and append
tasks from tabcmd and the Tableau Command-Line Utility.
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10.4 workbook

10.5 workbook

.tde extract

Task

.tde extract

.hyper
extract

Refresh using 10.4

Workbook ver-

Workbook ver-

or

sion remains

sion remains

tabcmd

append

unchanged, but
extract upgrades

√

unchanged, but
extract upgrades
to .hyper format

to .hyper format
using 10.5

Workbook ver-

Workbook ver-

tabcmd

sion remains

sion remains

unchanged, but
extract upgrades

√

unchanged, but
extract upgrades
to .hyper format

to .hyper format
Publish

using 10.4

extract

tabcmd
using 10.5

√

√

Not possible

Not possible

Not possible

√

√

Not possible

Not pos-

tabcmd
Refresh using 10.4
or

Tableau

append

Command-

sible

Line Utility
using 10.5

Workbook ver-

Workbook ver-

Tableau

sion remains

sion remains

Command- unchanged, but

unchanged, but

Line Utility

extract upgrades

extract upgrades

to .hyper format

to .hyper format
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Why keep an extract in .tde format?
If you cannot upgrade to the latest version of Tableau Desktop or Tableau Bridge, you'll
need to keep your extract in .tde format.

How to keep an extract in .tde format
To keep an extract in the .tde format, you'll need to avoid upgrading the extract. To avoid
upgrading the extract, do not perform any of the tasks listed above in the Tasks that cause
an extract upgrade section to a .tde extract.
Then, consider the following suggestions if you need to maintain a .tde version of an extract:
l

Perform extracts tasks using Tableau Cloud, but maintain an earlier version of
Tableau Desktop and the ability to connect to the original data to recreate .tde
extracts.

l

Use an earlier version of Tableau Desktop to perform extract tasks, such as extract
refresh or append data.

l

Disable existing extract refresh schedules on Tableau Cloud or Tableau Bridge until
you can identify which extracts should and shouldn't be upgraded.
Note: To access an extract's refresh schedule, you must be a data source owner,
site administrator or Project Leader. For more information about which site roles
allow full Project Leader capabilities, see Project-level administration.

What to expect after an extract upgrade
After your extract has been upgraded, there are some additional changes you can expect
when working with extracts in version Current. For more information, see After an extract
upgrade section in Tableau Help.
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Create Extracts on the Web
You can extract your data sources in the web (without using Tableau Desktop) to improve
data source performance and support additional analytical functions. When you extract your
data source, Tableau will copy the data from your remote data store to Tableau Server or
Tableau Cloud. To learn more about the benefits of extracting your data, see Extract Your
Data. In the web, you can extract while in Web Authoring or while in Content Server.

Create extracts in Web Authoring
You can create extracts directly in web authoring with default extract settings.

Extract an Embedded Data Source in Web Authoring

To create an extract in web authoring:
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Tip: It is recommended to finalise your data model before you create the extract. Extract creation may take a long time and any changes to your data model, such as adding new logical
tables, will invalidate the extract.
1. Click on the Data Source tab in the bottom-left corner of the web authoring pane. For
new workbooks, you will start in the Data Source tab.

2. In the top-right corner, change the connection type from Live to Extract.
3. Click Create Extract. You will see the Creating Extract dialog box.
Extract creation might take a long time and you can close your authoring session while the
extract is being created. To ensure your extract creation is not lost, in the dialog box, click
Notify Me When Complete to specify a location for the extracted workbook to be saved. If
your extract succeeds, your workbook will be saved to the specified location and you will be
notified that you can continue your web authoring session. If your extract creation fails, you
will be notified that the extract could not be created and you can restore your unsaved
changes by reopening the original workbook in web authoring.
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Define your Extract Settings

Optionally, configure one or more of the following options to tell Tableau how to store, define
filters for, and limit the amount of data in your extract:
l

Decide how the extract data should be stored
You can choose to have Tableau store the data in your extract using one of two structures (schemas): logical tables (denormalised schema) or physical tables (normalised
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schema). For more information about logical and physical tables, see The Tableau
Data Model.
The option you choose depends on what you need.
l

Logical Tables
Stores data using one extract table for each logical table in the data source.
Physical tables that define a logical table are merged and stored with that
logical table. For example, if a data source was made of a single logical table,
the data would be stored in a single table. If a data source was made of three
logical tables (each containing multiple physical tables), the extract data would
be stored in three tables – one for each logical table.
Select Logical Tables when you want to limit the amount of data in your
extract with additional extract properties like extract filters, aggregation, Top N
or other features that require denormalised data. Also use when your data
uses pass-through functions (RAWSQL). This is the default structure Tableau
uses to store extract data. If you use this option when your extract contains
joins, the joins are applied when the extract is created.

l

Physical Tables
Stores data using one extract table for each physical table in the data source.
Select Physical Tables if your extract is comprised of tables combined with
one or more equality joins and meets the conditions for using the Physical
Tables option listed below. If you use this option, joins are performed at query
time.
This option can potentially improve performance and help reduce the size of
the extract file. For more information about how Tableau recommends you use
the Physical Tables option, see Tips for using the Physical Tables option in the
Tableau Desktop help. In some cases, you can also use this option as a
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workaround for row-level security. For more information about row-level security using Tableau, see Restrict Access at the Data Row Level in the Tableau
Desktop help.

Conditions for using the Physical Tables option
To store your extract using the Physical Tables option, the data in your extract
must meet all of the conditions listed below.
l
l
l
l
l
l

All joins between physical tables are equality (=) joins
Data types of the columns used for relationships or joins are identical
No pass-through functions (RAWSQL) used
No incremental refresh configured
No extract filters configured
No Top N or sampling configured

When the extract is stored as physical tables, you cannot append data to it. For
logical tables, you can't append data to extracts that have more than one logical
table.
Note: Both the Logical Tables and Physical Tables options only affect how the data in
your extract is stored. The options do not affect how tables in your extract are displayed on the Data Source page.
l

Determine how much data to extract
Click Add to define one or more filters to limit how much data gets extracted based on
fields and their values.

l

Aggregate the data in the extract
Select Aggregate data for visible dimensions to aggregate the measures using
their default aggregation. Aggregating the data consolidates rows, can minimise the
size of the extract file, and increase performance.
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When you choose to aggregate the data, you can also select Roll up dates to a specified date level such as Year, Month, etc. The examples below show how the data
will be extracted for each aggregation option you can choose.
Original data

Each record is shown as a separate row. There are seven
rows in your data.

Aggregate

Records with the same date and region have been aggreg-

data for visible

ated into a single row. There are five rows in the extract.

dimensions
(no roll up)

Aggregate

Dates have been rolled up to the Month level and records with

data for visible

the same region have been aggregated into a single row.

dimensions

There are three rows in the extract.

(roll up dates to
Month)

l

Choose the rows to extract
Select the number of rows you want to extract.
You can extract All rows or the Top N rows. Tableau first applies any filters and
aggregation and then extracts the number of rows from the filtered and aggregated
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results. The number of rows options depend on the type of data source you are extracting from.
Notes:
l

Not all data sources support sampling. Therefore, you might not see the Sampling option in the Extract Data dialog box.

l

Any fields that you hide first in the Data Source page or on the sheet tab will be
excluded from the extract.

Limitations
l

You can't create extracts for embedded data sources that reference published data
sources. As a workaround, create the extract directly on the published data source.
For more information, see Extract a Published Data Source on Content Server.

l

You can't create extracts for file-based data sources. File-based data sources already
have special performance features, and adding extraction will have no performance
benefit.

l

This feature does not apply to bridge-based data sources in Tableau Cloud.

Create extracts in Content Server
Extract a Published Data Source on Content Server
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To extract a published data source:
1. Sign in as an administrator or as the owner of the data source.
2. On the Content tab, select Explore > Data sources.
3. Select a data source by clicking on the Data Source name.
4. At the top of the screen, under the Data Source name, select the drop-down menu
that says Live.

5. Change the connection type from Live to Extract. If the extract encryption at rest feature is enabled on the site, select either Encrypted or Unencrypted.

6. If you see an error message about embedded credentials, embed your credentials in
the data source. To do this, click Edit Connection. Select "Embedded password in
connection” and then click Save.

Extract an Embedded Data Source on Content Server

To extract one or more data sources that are embedded in a published workbook:
1. Sign in as an administrator or as the owner of the data source.
2. Navigate to the published workbook.
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3. Navigate to the Data Sources tab
4. Select one or more of the data sources.
5. Click the Action button.
6. Click Extract. If the extract encryption at rest feature is enabled on the site, select
either Encrypted or Unencrypted.

Limitations
l

Your connection credentials must be embedded in the data source.

l

In the web, you can't specify extract settings like incremental refresh and extract filters.

l

You can't create extracts for embedded data sources that reference published data
sources. As a workaround, create the extract directly on the published data source.

l

You can't create extracts for file-based data sources. File-based data sources already
have special performance features, and adding extraction will have no performance
benefit.

l

This feature does not apply to bridge-based data sources in Tableau Cloud.

Keep Extracted Data Fresh
After data is extracted, you can optionally set up an extract refresh schedule to keep the data
fresh. For more information, see Schedule Refreshes on Tableau Cloud.

Monitor and Manage Extracts
Server administrators can monitor extract creation on the Background Tasks for Extracts
admin view. For more information, see Background Tasks for Extracts.
Server administrators can manage extracts on the Jobs page. For more information, see
Managing Background Jobs in Tableau Cloud.

Keep Data Fresh
After you publish workbooks and data sources to Tableau Cloud, you can decide how you
want to keep the data current. Options for keeping published data fresh depend on the
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characteristics of your data sources.

Data freshness options by data source
The following table lists data freshness options (and exceptions) that are available depending on the data source.
Exceptions
l

Tableau Cloud does not support connections to any cube-based data source.

l

Tableau Cloud does not support published connections that use Kerberos authentication.

l

Although you can publish extracts of SAP BW data to Tableau Cloud, refreshes are
not supported. The best way to update SAP BW data sources is to republish them.

Options

Source

Publish

Freshness options

Authentication

options
On-premises data (accessible only from a private network)

File-based

Extract

data

only

Use Tableau Bridge (recommended)

n/a

Manual refresh from Tableau Desktop
(Excel, .csv,
Automated command-line scripts

.txt)
Statistical file

Extract

Use Tableau Bridge (recommended)

n/a

only

(SAS (*.sas7b-

Manual refresh from Tableau Desktop

dat))
Automated command-line scripts
Data hosted

Live con-

Use Tableau Bridge (recommended)

on a cloud plat- nection or
form
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Source

Publish

Freshness options

Authentication

options
(For example,

extract,

Oracle on

depending

Amazon RDS)

on data-

Automated command-line scripts

settings

Use Tableau Bridge (recommended)

Embedded cre-

base
Relational

Live con-

database

nection or
extract,

(Relational
databases that
Tableau

depending

dentials in
Manual refresh from Tableau Desktop
Automated command-line scripts

Tableau Bridge
settings

on database

Desktop connects to. For
example, SQL
Server,
Oracle,
IBM DB2)
Cloud data (accessible from the public internet)

Data hosted

Live con-

on cloud plat-

nection or

forms

extract

Extracts:

Embedded credentials + IP

Schedule directly on Tableau Cloud

safe list

(See the list of

Edit Con-

supported plat-

nections on

forms in

Tableau Cloud

Allow Direct
Connections
to Data Hosted on a Cloud
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Source

Publish

Freshness options

Authentication

options
Platform
Salesforce,

Extract

Google Ana-

only

Schedule directly on Tableau Cloud

OAuth Connections

Refresh Data Using Saved Cre-

lytics

dentials
Google

Live con-

BigQuery,

nection or
extract

Extracts:

OAuth Connections

Schedule directly on Tableau Cloud

Google
Refresh Data Using Saved Cre-

Sheets

dentials
Cloud (Box,

Live con-

Dropbox,

nection or

OneDrive,

extract

Extracts:

OAuth Connections

Schedule directly on Tableau Cloud

Google Drive)

Refresh Data Using Saved Cre-

file-based data

dentials

(Excel, .csv,
.txt, .tab, .tsv,
.json)
Anaplan

Extract

Schedule directly on Tableau Cloud

only
Oracle Eloqua

dentials
Refresh Data Using Saved Credentials

ServiceNow

Tableau Cloud
Extract
only
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Marketo

Embedded cre-

Schedule directly on Tableau Cloud
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Source

Publish

Freshness options

Authentication

options
Web Data

Extract

For basic user name and password

Tableau Bridge:

Connectors

only

credentials, use Tableau Bridge.

Embedded credentials

For custom (non-basic) username and
password credentials, use the

Other: n/a

Tableau Desktop Refresh From
Source command, or run a manual
refresh from Tableau Desktop. For
more information, see the WDC
Authentication topic in the Tableau
Web Data Connector API Help.

Tableau Cloud IP addresses for data provider authorisation
As a security measure, cloud data providers might require you to supply a list of authorised
IP addresses from which external applications request access to your data. A request from
an IP address that is not explicitly approved could be rejected. To make sure live connections
you publish to Tableau Cloud remain uninterrupted, add Tableau Cloud to your data provider’s allowlist (safe list).
The table lists IP address ranges that Tableau Cloud uses, depending on your site location.
You can see its location in the URL that appears after you sign in to Tableau Cloud.
Host Name (Instance)

Site Location

IP Address or
Range

10ax.online.tableau.com

US West - Oregon

34.208.207.197
52.39.159.250

10ay.online.tableau.com

US West - Oregon

34.218.129.202
52.40.235.24
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Host Name (Instance)

Site Location

IP Address or
Range

10az.online.tableau.com

US West - Oregon

34.218.83.207
52.37.252.60

us-west-2b.online.tableau.com

US West - Oregon

34.214.85.34
34.214.85.244

us-east-1.online.tableau.com

US East - Virginia

50.17.26.34
52.206.162.101

prod-useast-a.online.tableau.com

US East - Virginia

3.219.176.16/28

prod-useast-b.online.tableau.com

US East - Virginia

3.219.176.16/28

dub01.online.tableau.com

EU West - Ireland

34.246.74.86
52.215.158.213

eu-west-1a.online.tableau.com

EU West - Ireland

34.246.62.141
34.246.62.203

prod-apnortheast-a.on-

Asia Pacific - Japan

18.176.203.96/28

prod-apsoutheast-a.on-

Asia Pacific – Aus-

3.25.37.32/28

line.tableau.com

tralia

prod-uk-a.online.tableau.com

EU West - UK

18.134.84.240/28

prod-ca-a.online.tableau.com

Canada - Quebec

3.98.24.208/28

line.tableau.com

These addresses are dedicated to and controlled by Tableau.
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Note: In addition to enabling communication over the Tableau Cloud IP range, you
might need to enable access over the appropriate database port (for example, 80 or
443) depending on the communication type (HTTP or HTTPS).

Find authorisation steps for your data provider
The following links take you to the steps on common data providers’ websites for authorising
external applications on their platforms.
Amazon:
l

Redshift

l

RDS

l

EC2

Microsoft Azure
Google Cloud Platform

Disclaimer: The links in the list above take you outside of Tableau.com. Although we
make every effort to ensure links to external websites are accurate, up to date and relevant, Tableau cannot take responsibility for the accuracy or freshness of pages maintained by external providers. Contact the external site for answers to questions
regarding its content.

Tableau Bridge connections to Tableau Cloud
To facilitate connections between on-premises data and Tableau Cloud, Tableau Bridge
uses common port 443 to make outbound requests to Tableau Cloud. For more information,
see Network access section in the Install Tableau Bridge topic.
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See also
l

Manage Data

l

Best Practices for Published Data Sources (Tableau Help)

l

Notify Owners When Extract Refreshes Fail

l

Edit Connections on Tableau Cloud

Allow Direct Connections to Data Hosted on a
Cloud Platform
If you maintain SQL-based data on a cloud platform, you can use direct connections to that
data when you publish workbooks and data sources to Tableau Cloud. When you use a direct connection, you don't need to publish a static extract of the data. Depending on the
underlying data type, you can determine how to keep the data current through a live connection or refreshing an extract on a schedule. You can also require users to provide credentials for accessing the data when they open views that connect to content.

Note: Tableau Cloud only supports connections to data hosted on a public cloud platform.

Enable encrypted connections
Encrypting connections using SSL is an option for underlying data sources. You can enable
SSL encryption for connections to your hosted SQL data when you create the connection in
Tableau Desktop. Complete the following steps to enable encrypted connections.
Tip: Make sure that Tableau Cloud is on your data provider's authorised list (safe list).
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1. In Tableau Desktop, connect to the data.
2. In the Server Connection dialog box, select the Require SSL tick box.
3. For PostgreSQL, SQL Server-compatible connections and other connections that
don't have an option to embed certificates in the data source, click OK to finish.
For some compatible connections, linked text appears under the Require SSL tick
box. This indicates that you can specify an alternative certificate file to use, such as a
self-signed certificate.
4. (Optional) Use a self-signed or other custom certificate to connect to this data over
SSL.
a. Select the link text that appears.

b. In the Configure and Use SSL Certificate dialog, specify the certificate’s
.pem file.
For example, for MySQL connections to data hosted on Amazon RDS, you can
point to Amazon’s self-signed certificate file at this address.

Untrusted certificates
If you are using certificates that aren't trusted by Tableau Cloud, such as self-signed certificates or certificates signed by your company's internal CA, you may have problems connecting from Tableau Cloud. Try one of the following solutions.
l

If your connector allows embedding custom certificates, then use that. This is the solu-

l

tion described above.
Get new certificates for your database that are signed by a trusted public CA.
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l

Use Tableau Bridge, which is Tableau’s connection proxy. You can configure your certificates to be trusted on the machine running Bridge, either by using TDC files, properties files or by installing your certificates in the Windows System Trust Store.

Supported connectors
Refer to the "Tableau Cloud" tab in the Creators: Connect to Data on the Web topic for the
list of supported connectors.
For more information about supported features by connector, refer to the specific connector
topic in the Supported Connectors section of the Tableau User Help.

Note: Not all connectors in this list are supported by Tableau Prep Conductor. To see
the supported list of connectors, open Tableau Prep Builder and expand the Connect
pane.

See also
l

Connector Examples in the Tableau Help

Overview of Row-Level Security Options in
Tableau
Sometimes, you want to filter data based on the user that is requesting it. For example:
l
l
l

You want regional salespeople to see sales figures only for their region.
You want sales managers to see statistics only for salespeople that report to them.
You want students to see visualisations based only on their own test scores.

An approach to filtering data this way is called row-level security (RLS). There are multiple
methods to accomplish row-level security both inside and outside of Tableau, each with its
own pros and cons.
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Create a user filter and map users to values manually
The simplest way to achieve row-level security in Tableau is through a user filter where you
manually map users to values. For example, you could manually map a user named “Alice”
to the value “East” so that she only sees rows in the data source where the “Region” column
is “East”.
This method is convenient but high maintenance, and attention must be paid to security. It
must be done per-workbook, and you must update the filter and republish the data source as
your user base changes. When you publish an asset with this type of user filter, you need to
set permissions so that users cannot save or download it and remove the filter, thereby gaining access to all of the data.
For more information, see Create a user filter and map users to values manually in the
Tableau Desktop and Web Authoring help.

Create a dynamic user filter using a security field in the data
Using this method, you create a calculated field that automates the process of mapping
users to data values. This method requires that the underlying data include the security
information you want to use for filtering. For example, using a calculated field, the
USERNAME() function and a “Manager” column in the data source, you could determine if
the user requesting the view is a manager and adjust the data in the view accordingly.
Because filtering is defined at the data level and automated by the calculated field, this
method is less error prone than mapping users to data values manually. When you publish
an asset with this type of user filter, you need to set permissions so that users cannot save or
download it and remove the filter, thereby gaining access to all of the data.
For more information, see Create a dynamic filter using a security field in the data in the
Tableau Desktop and Web Authoring help.
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Use a data policy
Starting in Tableau 2021.4, when Data Management is enabled in Tableau Server or
Tableau Cloud, users with a Creator licence can implement row-level security through data
policies on virtual connections. Because virtual connections are centralised and reusable,
you can manage row-level security for each connection in one place, safely and securely,
across all content that uses that connection.
Unlike the above solutions for row-level security in Tableau, this method doesn't carry the
same risk of exposing information if an author neglects to properly secure permissions on
the workbook or data source, because the policy is enforced on the server for every query.
Row-level security through virtual connection data policies was developed to address shortcomings of other row-level security solutions. We recommend this solution in most situations where it's an option.
For more information on row-level security using data policies on virtual connections, see
About Virtual Connections and Data Policies.

Use existing RLS in the database
Many data sources have mechanisms for RLS built in. If your organisation has already put
effort into building row-level security in a data source, you may be able to take advantage of
your existing RLS.
It is not necessarily easier or better to implement a built-in RLS model vs building it with
Tableau in mind; these techniques are generally leveraged when an organisation has
already invested in these technologies and they want to take advantage of that investment,
or when they need to apply the same security policies to other database clients in addition to
Tableau.
The main benefit of using built-in RLS is that administrators can implement and control their
data security policy in one place: their databases.
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Configure Connections with Analytics Extensions
Analytics extensions allow you to extend Tableau dynamic calculations in a workbook with
languages like R and Python, with Einstein Discovery, and with other tools and platforms.
These settings endpoints enable you to configure analytics extensions on your site in
Tableau Cloud. For more information, see Analytics Extensions API.
For more information about user scenarios and configuring analytics connections in
Tableau Desktop or for web authoring, see Pass Expressions with Analytics Extensions, in
the Tableau Desktop and Web Authoring Help.
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Note: Beginning in June 2021, you can create multiple analytics extensions connections
for a site, including multiple connection for the same type of extension (you are presently
limited to a single Einstein Discovery analytics extension for each site). For details, see
What’s New in Tableau Cloud.

This topic describes how to configure sites on Tableau Cloud with analytics extensions.

Security requirements and configuration
For increased security, Tableau Cloud requires an encrypted channel and authenticated
access to the external services used for analytics extensions.

Certificate
The server running the external service for analytics extensions must be configured with a
valid TLS/SSL certificate from a trusted 3rd party certificate authority (CA). Tableau Cloud
will not establish a connection with external servers that are configured with a self-signed certificate, a certificate from a private PKI or a certificate that is not trusted by an established
third-party CA.

Allowlist firewall configuration
Many organisations deploy a firewall that requires allowlist exceptions for known hosts outside the network. In this scenario, you will need to specify two Tableau Cloud IP addresses
as exceptions. The Tableau Cloud IP addresses used for connections to analytics extensions servers are 44.224.205.196 and 44.230.200.109.

Configure analytics extensions settings
1. Sign in to Tableau Cloud as a site administrator.
2. Click Settings.
3. On the Settings page, click the Extensions tab and then scroll to Analytics Extensions.
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4. Select Enable analytics extensions for site.
5. Click Create new connection.
6. In the New Connection dialog, click the connection type you want to add, then enter
the configuration settings for your analytics service:

3. The options you need to configure depend on the connection type you choose:
l
l

For an Einstein Discovery connection, click Enable.
For TabPy, RServer and Analytics Extensions API connections, enter the following information:
l
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Connection Name: (Required) Specify the server type you are connecting to. RSERVE supports connections to R using the RServe package. TABPY supports connections to Python using TabPy, or to other
analytics extensions.
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l

Require SSL (Recommended): Select this option to encrypt the connection to the analytics service. If you specify a HTTPS URL in the Host-

l

l
l

name field, then you must select this option.
Hostname: (Required) Specify the computer name or URL where the
analytics service is running. This field is case sensitive.
Port: (Required) Specify the port for the service.
Sign in with a username and password(Recommended): Select this
option to specify username and password that is used to authenticate to
the analytics service.

7. Click Save.

Edit or delete an analytics extension connection
To edit or delete a configuration, navigate to Analytics Extensions on the Extensions tab
of your site.

Click the Edit or Delete icon and follow the prompts to change the configuration.

Script errors
Tableau cannot verify that workbooks that use an analytics extension will render properly on
Tableau Cloud. There might be scenarios where a required statistical library is available on a
user’s computer but not on the analytics extension instance that Tableau Cloud is using.
A warning will be displayed when you publish a workbook if it contains views that use an analytics extension.
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This worksheet contains external service scripts, which cannot be viewed on the target platform until the administrator configures an external service connection.

Table Extensions
Table Extensions allow you to create new data tables with an analytics extensions script.
You can write a custom TabPy or Rserve script and optionally add one or more input tables.
Table extensions are supported by Tableau Cloud, Tableau Server and Tableau Desktop.
This document focuses on Tableau Cloud.

Note: The data refreshes every time you open up a workbook or refresh a data source.

Benefits
Table Extensions have the following benefits for both new and experienced users.
l
l
l
l
l

Faster data processing
Low code editor
Integrates with Ask Data and Explain Data
Integrates with TabPy and Rserve
Results can be used to construct dashboards or visualisations.

Prerequisites
Before you can use table extensions, you must complete the following list.
l

Configure an analytics extension
o

l

For steps to configure analytics extension connections, see Configure Con-

nections with Analytics Extensions.
Publish your workbook.

Create a Table Extension
To create a new table extension, complete the steps below.
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1. Open a published workbook.

Note: The workbook must be published before you can add a table extension.

2. Under Sheets, choose New Table Extension.

3. (Optional) Drag sheets into the table extension pane.
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4. Under Choose a Connection, select an analytics extension.

5. In Script, enter your script.
6. Select Apply.
7. Choose Update Now and the results will appear in the Output Table tab.

8. In the Name field, enter a unique name for your new table extension.
9. Go to the sheet tab and publish the workbook to save it.

Note: If you edit the input table, you have to press Apply again before you can see or
use the updated output table data.

Troubleshooting tip: If your table extension is hitting an error, try using the circular
Refresh Data Source button, located next to the Save button.
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Table Extensions vs Analytics Extensions
Tableau has a few different features with "extension" in the name. While some of these
products aren't related, table extensions and analytics extensions are. The table extensions
feature relies on a connection with analytics extensions to work. Let's break down each feature.
Table Extensions

The table extensions feature lets you create workbook calculations that send data and a processing script to your analytics extension. The returned results are displayed as a table on
the Data Source tab and as measures and dimensions in the workbook.
Analytics Extensions

The analytics extensions feature allows you to extend Tableau dynamic calculations with programming languages like Python, external tools and external platforms. After you create a
connection to an analytics extension, you can communicate with your external server
through calculated fields. For more information, see Configure Connections with Analytics
Extensions.

Use Certification to Help Users Find Trusted
Data
In a self-service environment with multiple publishers, it’s common for a project on Tableau
Cloud to contain a variety of content that is named similarly, or is based on the same or similar underlying data, or is published without any descriptive information about it. When this is
the case, analysts might lack confidence about the data they should use.
To help your users find the data that’s trusted and recommended for their type of analysis,
you can certify the data that complies with your organisation’s data standards.
In addition to certifying published data sources, if you have a Data Management licence for
Tableau Server or Tableau Cloud:
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l

Starting in Tableau 2019.3, if Tableau Catalogue is enabled, you can certify databases and tables that are associated with your Tableau content. (For more information about Tableau Catalogue, see "About Tableau Catalog" in the Tableau Server

l

or Tableau Cloud Help.)
Starting in Tableau 2022.1, you can certify virtual connections and virtual connection
tables.

How certification helps users find trusted data
When you certify an asset, users see a green badge or green tick, depending on where the
asset is being viewed.

Certified data sources rank higher in search results and are added to recommended data
sources.
In addition, you can provide notes about the certification status, which appear when users
click on the badge or in a tooltip when they hover over the data source icon in web authoring
or Tableau Desktop. The information also shows who certified the data source.
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For more information, see the How to certify data steps below.

Create guidelines for selecting data to certify
As with most Tableau functionality, certification is flexible. You can define for your organisation the criteria you use to determine when to certify a data source (or database or table).
As you do this, you might want to document and share your guidelines. As new data sources
are published, the guidelines can help you and other administrators or project leaders to be
consistent with your certification choices. They can also help users understand what certification means.
Whether you use the same certification criteria across all projects, or define unique criteria
for each project, the important thing is to be clear about what certification means in your environment.

Who can certify data
To certify a data source, you must
l

be a Server or Site Administrator, or

l

have a site role of Explorer (Can Publish) or Creator and be the project owner or have
the Project Leader capability for the project containing the data you want to certify.

To certify virtual connections and virtual connection tables, you must have a Data Management licence in your environment, and you must
l

be a Server or Site Administrator, or

l

have a site role of Explorer (Can Publish) or Creator and be the project owner or have
the Project Leader capability for the project containing the data you want to certify.

Tableau Software

669

Tableau Cloud Help
To certify databases or tables, you must have Tableau Catalogue enabled in your environment, and you must
l
l

be a Server or Site Administrator, or
have the Set permissions capability on the database to certify that database or any
tables within that database.

How to certify data
The data you can certify depends on whether you have a Data Management licence and, if
you do, whether you have Tableau Catalogue enabled in your environment.
l

All users with the right permissions can certify data sources.

l

If you have a Data Management licence, users with the right permissions can also cer-

l

tify virtual connections and virtual connection tables.
If Tableau Catalogue is enabled, users with the right permissions can also certify databases, tables and files.

Take the following steps to certify the data.
1. Sign in to Tableau Cloud.
2. This step depends on the type of asset you want to certify:
l Data source or virtual connection – on the Explore page, select All Data
l

Sources or All Virtual Connections.
Virtual connection table – on the Explore page, select All Virtual Connections, and select the virtual connection that contains the virtual connection
table you want to certify. Then select the virtual connection table.

l

Database or table – on the External Assets page, select Databases and

Files or Tables.
3. On the page, select the More actions menu (...) next to the asset name you want to
certify.
4. Select Edit Certification and then do the following:
l Tick the This data is certified box.
l Add a note that gives users context for the certification status, intended use for
the data, or other helpful information, and then click Save.

670

Tableau Software

Tableau Cloud Help

Information you add to the Note section appears in the certification badge or
tooltip, mentioned earlier in How certification helps users find trusted data.

Notify Owners When Extract Refreshes Fail
A scheduled extract refresh can fail to complete for a variety of reasons, such as outdated
embedded credentials or file path. For scheduled refreshes that run directly from Tableau
Cloud, after a refresh has failed five consecutive times, Tableau Cloud suspends the schedule until a site admin or the data source owner takes an action to address the cause.
A site admin can enable Tableau Cloud to send email to the owner of a data source when its
scheduled extract refresh does not complete successfully. The data source owner can then
opt out individually in their account settings.
The email contains the following information:
l

Extract or workbook name.

l

The date and time of the last successful refresh. Or, if the last refresh was longer than
14 days ago, the email shows “not in the last N days”.

l

The number of consecutive times the refresh has failed.

l

A suggested action to take to address the cause of the failure, such as updating
embedded credentials or a file path, and a link to Tableau Cloud to take the action.
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When receiving email about data sources refreshed by Tableau Bridge, there will be some
differences. For more information, see Differences for Tableau Bridge refresheslater in this
topic.

Enable refresh failure emails
As a site admin, you have the ability to enable (or disable) refresh failure emails for your site
using the procedure below. If you opt in, each user can potentially opt out from receiving
refresh failure emails from his or her individual account.
1. Sign in to Tableau Cloud as a site admin and click Settings.
2. Under Manage Notifications, select or clear the tick boxes to allow or disable notifications for all your site users.

Differences for Tableau Bridge refreshes
For data sources that are refreshed through Tableau Bridge, notifications will vary. For
more information, see Manage Email Alerts for Bridge.

Refresh Data on Tableau Cloud
You can manually refresh data, as well as schedule data refreshes.

Schedule Refreshes on Tableau Cloud
You can schedule refresh tasks directly on Tableau Cloud for extracts of cloud-hosted data.
This can include extracts of the following types of data:
l
l

Salesforce.com or Google Analytics.
Google BigQuery or Amazon Redshift, if you do not want to use a live connection. For
on-premises Redshift, you must use Tableau Bridge.

l

SQL-based or other data hosted on cloud platforms, such as Amazon RDS,
Microsoft Azure, or Google Cloud Platform, if you do not want to use a live
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connection, or if live connection isn’t supported for that data source.
For a list of supported data sources, see Allow Direct Connections to Data Hosted on
a Cloud Platform.
Schedules are also available when creating extract refresh with Tableau Bridge. For more
information see, Set Up a Bridge Refresh Schedule.
Notes:
l

When a refresh is performed on extracts created in Tableau 10.4 and earlier (that is, a
.tde extract), the extract is upgraded to a .hyper extract automatically. While there are
many benefits of upgrading to a .hyper extract, you won't be able to open the extract
with earlier versions of Tableau Desktop. For more information, see Extract Upgrade

l

to .hyper Format.
For information about refreshing extracts of Microsoft Excel, SQL Server or other data
Tableau Cloud cannot reach directly, see Connectivity with Bridge.

l

Your Tableau Cloud site comes with capacity to support all your users’ analytic needs.
A site’s capacity includes capacity for storage and tasks that need to be performed on
the site includes extracts. For more information, see Tableau Cloud Site Capacity.

Create a refresh schedule
Important!
l

Run Now option is no longer available in Create an Extract Refresh dialog box.

l

Run Now option is now listed in the Actions drop down menu.
You cannot configure tasks to run sequentially (aka serially). Instead, you might want
to stagger your start time for the extract refreshes, so the tasks run one after the other.

l

If you migrate your existing tasks to custom schedules, please note that unless you
change your start times for these tasks, they will run in parallel, which may not be
desired.
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1. When you’re signed in to Tableau Cloud, select Explore from the left navigation pane,
and then, depending on the type of content you want to refresh, select All Workbooks
or All Data Sources from the drop-down menu.
2. Tick the box for the workbook or data source you want to refresh, and then select
Actions > Refresh Extracts.
3. In the Refresh Extracts dialog, select Schedule a Refresh, and complete the following steps:
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l

Refresh Type: Select the type of refresh you want. A full refresh is performed
by default. Incremental refresh is available only if you configured for it in
Tableau Desktop before publishing the extract. If you select one of more workbook or data source that has been set to do full refreshes, then the option to
select incremental refresh is disabled. For more information, see Refreshing

Extracts in the Tableau Help.
l

Refresh Frequency: Setup the frequency for the extract refreshes to run. You
can set the frequency to run hourly, daily, weekly or monthly. The time and day
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intervals depend on the repeat frequency that you select as described below:
l

Hourly: The available frequency is every hour from a specific time to a
specific time. This means that the task will run every hour during the specified time.

l

Daily: The available frequencies are every two, four, six, eight or twelve
hours, or just once a day. You can also choose one or more days of the
week, in addition to start and end times. This means you can run a task
on all or certain days of the week at specific hourly intervals or once a
day.

l

Weekly: The available frequency is one or more days of the week at a
specific time. This means you can run the task on certain days of the
week, once a week at a certain time.

l

Monthly: You can set this up in two different ways:
1. You can select Day as the frequency interval which then allows
you to select specific dates of the month. For example you can
select the task to run on the 2nd, 15th and 28th of every month at
2:45 pm.
2. You can also choose the first, second, third, fourth, fifth and the
last day of the week at a specific time. For example you can
choose to run the task every second Wednesday of the month at
2:45 pm.

Update an Existing Schedule
When making changes to an existing schedule, you will no longer choose from a list of existing schedules, but directly change the recurrence in the schedule.

676

Tableau Software

Tableau Cloud Help

Time limit for extract refreshes
To ensure that long running refresh tasks don't take up all system resources and don't prevent refreshes of other extracts on your site, Tableau Cloud enforces a time limit, also known
as a timeout limit, of 7200 seconds (120 minutes or two hours) for refresh tasks. The timeout
limit is the longest allowable time for a single extract to complete a refresh before it's cancelled. The timeout limit is not configurable.
Staying within the timeout limit

Although reaching the timeout limit is not common, if you're working in an extract-heavy environment, there are few modifications you can make to your extracts to help avoid reaching the
timeout limit.
l

Upgrade extracts to the .hyper format

l

Set up incremental refreshes

l

Decrease the size of extracts

l

Use an alternative method for refreshing extracts

l

Schedule refreshes at a different time

Upgrade extracts to the .hyper format

Beginning with Tableau 10.5, the format of new extracts changed from .tde to .hyper. Along
with a number of optimisations, refreshing large extracts in the .hyper format can be faster. If
you're working with .tde extracts, consider upgrading your .tde extracts to the .hyper format.
For more information, see Extract Upgrade to .hyper Format.
Set up incremental refreshes

Consider configuring your extracts to be incrementally refreshed instead of fully refreshed
each time a refresh task is performed.
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By default, extracts are set up to fully refresh. Although a full refresh gives you an exact
copy of the data, a full refresh can take a long time to complete. To reduce the time it takes
to refresh an extract, consider setting up incremental refreshes of your extracts instead. For
more information, see Configure an incremental extract refresh in the Tableau Help.

Note: You must set up the incremental refresh before publishing the extract to Tableau
Cloud. After publishing, you will then be able to select Incremental Refresh option in the
Create Extract Refresh dialog.

Decrease the size of extracts

You can help refresh tasks complete faster by decreasing the size of your extracts.
There are two common methods for decreasing the size of extracts: hide all unused fields
and use data source filters.
l

Hide all unused fields: Fields that you hide in your data source are excluded when
the extract is created. To hide fields while creating the extract, see Create an extract
in the Tableau Help.

l

Add data source filters: You can reduce the number of rows in your extract by
adding a data source filter. For more information, see Filter Data from Data Sources
in the Tableau Help.

Note: You must hide all unused fields or add data source filters before publishing the
extract to Tableau Cloud.

Use an alternative method for refreshing extracts

If possible, consider refreshing your extracts outside of Tableau Cloud.
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l

Tableau Desktop: You can manually refresh published extracts from Tableau
Desktop. For more information, see Refresh Published Extracts from Tableau
Desktop.

l

Tableau Bridge: Depending on the data source, you can use Tableau Bridge to set
up and refresh published extracts on a schedule. For more information, see Use
Bridge to Keep Data Fresh.

l

Tableau Data Extract Command-Line utility: Depending on the data source, you
can use the command-line utility that comes with Tableau Desktop to programmatically refresh published extracts. For more information, see Automate Extract
Refresh Tasks from the Command Line.

Schedule refreshes at a different time

Consider changing when the refresh tasks occur. For more information, see Manage
Refresh Tasks.
Errors when refresh tasks reach timeout limit

If a refresh task reaches the timeout limit, you or others might see one of the errors listed
below. If you published the extract or are the extract owner, you might see one of these
errors in an email notification. If you're a site administrator, you might see one of these errors
in the administrative view about Background Tasks for Extracts.
l
l
l

The query time resource limit (7200 seconds) was exceeded.
com.tableau.nativeapi.dll.TableauCancelException: Operation cancelled.
The query time resource limit (8100 seconds) was exceeded.

To help resolve and avoid these errors in the future, see the section above, Staying within
the timeout limit.

Refresh Data Using Saved Credentials
To keep data fresh for Salesforce, Google Analytics, Google BigQuery, OneDrive, Dropbox,
Quickbooks Online, Anaplan, Oracle Eloqua and ServiceNow ITSM, you must do the
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following:
1. Embed credentials into the data connection. The steps are described in this topic
2. If your data source or workbook contains an extract, you can add the extract to a
refresh schedule. For the steps to schedule a refresh, see Schedule Refreshes on
Tableau Cloud.
If your data source or workbook contains a direct (live) connection to the data, then
the data is always fresh, and you don't need to create a scheduled task to refresh it.

Embed credentials into the data connection
You can embed credentials for your connection by following these steps.
1. Sign in to Tableau Cloud and navigate to Data Sources page.
2. Select the data source with the connection you want to refresh, and on the Actions
menu, select Edit Connection.
3. The options in the Edit Connection dialog box will vary depending on the data source
you selected. Review the options available to you and select the one that meets your
needs.
If you select Prompt user for <connector name> credentials, you will need to
refresh data manually. You can do this by asking users to republish the data source
from Tableau Desktop or by initiating a refresh task on Tableau Cloud.

Connector-specific credential information
Use OAuth credentials

Secure data connections are made using OAuth access tokens for data connections to
Google Analytics, Google BigQuery, Google Sheets, OneDrive, Dropbox, Salesforce and
QuickBooks Online. You create access tokens by signing in to the data from Tableau Cloud
and approving Tableau Cloud access to the data as long as the credentials exist (or you
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manually revoke access). When you add a new account, the sign-in page appears. When
you sign in, you create a new access token for the credentials you submit.

Note: Dropbox uses OAuth credentials, however Tableau doesn't currently support
authenticating to Dropbox using a Google account.

You can embed shared credentials, as you might do if you use a dedicated database account
for a group of users. Or you can embed an individual user’s credentials. The account you use
to create the access token must allow a level of access for running the refresh task.
Use other credentials

Anaplan, Oracle Eloqua, and ServiceNow ITSM each support using saved credentials (for
example, user name and password) to connect to the data.
Use Salesforce security tokens

If you embed standard Salesforce credentials, Salesforce might require a security token for
you to access a data. For example, if you want to access the Salesforce connection from an
IP address that is not included in your organisation's trusted IP list. This security token must
be appended to the password used in the data connection.
The security token can expire. When Tableau is unable to refresh a Salesforce connection
because the security token has expired, Tableau displays an alert to the following users:
l

Authors of the relevant workbooks and data sources.

l

Authors of workbooks that connect to the relevant data sources.

l

Site administrators.

You can renew an expired security token by editing the data connection on the server.
For more information about Salesforce authentication and security tokens see Security and
the API in the Salesforce.com SOAP API Developer's Guide.
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Start a Refresh Task Manually
You can refresh extracts of data hosted with most cloud data providers directly on Tableau
Cloud. You can run a refresh from Tableau Bridge for data sources you’ve set up there.
If a data source has scheduled refreshes, running a manual refresh does not affect the
schedule.

Before you start a refresh task
When an extract refresh is performed on extracts created in Tableau 10.4 and earlier (that
is, a .tde extract), the extract is upgraded to .hyper extract automatically. While there are
many benefits of upgrading to a .hyper extract, you will be unable to open the extract with
previous versions of Tableau Desktop. For more information, see What's new to extracts.

Run a refresh on Tableau Cloud
1. Sign in to the Tableau Cloud site to which the data source is published.
2. On the Data Sources page, select the More actions icon (…) next to the data source
you want to refresh, and then select Refresh Extracts from the menu.
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3. Under Refresh Now, select Full Refresh.

Note: For data sources that have scheduled refreshes, site administrators can initiate a
refresh also from the Actions menu on the Tasks > Extract Refreshes page.

Run a refresh in the Tableau Bridge client
l

Open Tableau Bridge from the Windows system tray, and select the Run now icon (
) for the data source.
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Note: When an extract refresh is performed on extracts created in Tableau 10.4 and
earlier (that is, a .tde extract), the extract is upgraded to .hyper extract automatically.
While there are many benefits of upgrading to a .hyper extract, you won't be able
open the extract with earlier versions of Tableau Desktop. For more information, see
Extract Upgrade to .hyper Format.

Manage Refresh Tasks
Administrators can manually refresh extracts or delete their schedules.
1. Sign in to the site that has the schedules you want to manage, and then click Tasks.
2. Select one or more scheduled extract refreshes.
3. From the Actions menu, do any of the following:
l

Select Change Schedule, and choose a new schedule from the list.

l

Select Run Now to refresh manually.
Note: If an extract does not have a scheduled refresh, you can refresh it on
demand from the Data Connections page.

l

Select Delete to completely remove the schedule for the selected data
sources.

See also
Notify Owners When Extract Refreshes Fail

Automatically Suspend Extract Refreshes for Inactive Workbooks
To save resources, Tableau can automatically suspend extract refresh tasks for inactive
workbooks. This feature applies to full extract refreshes only, not to incremental extract
refreshes. This feature only applies to refresh tasks that run more frequently than weekly,

684

Tableau Software

Tableau Cloud Help
not to weekly or less frequent refresh tasks. This feature only applies to extracts that are
embedded in workbooks and not to published data sources.
If any of these events occur, the workbook inactivity countdown timer is reset.
l

Viewing the workbook sheets

l

Having any data-driven alert or subscription set up on the workbook

l

Downloading the workbook

l

Moving the workbook's location or changing the owner

This feature is only configurable on Tableau Server. On Tableau Cloud, this feature is not
configurable and the number of days that a workbook can be inactive before extract refresh
tasks are suspended is 32 days.

Notifications
An email notification is sent three days before the extract refresh schedule is suspended.
Another email notification is sent when the extract refresh schedule is suspended.

Resume suspended extract refreshes
Suspended extract refreshes won't resume automatically if someone uses the workbook. It
must be done manually.
To view and resume extract refreshes that were suspended:
1. Sign in to the site and click Tasks.
2. Click the Extract Refreshes tab.
3. Select one or more items.
4. From the Actions menu, select Resume.

Use Tableau Bridge
Get Started
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l
l
l
l
l

Use Bridge to Keep Data Fresh
Install Bridge
Set Up a Bridge Refresh Schedule
Use Bridge for Private Cloud Data
Tableau Bridge FAQ

Quick Reference for Site Admins
l
l
l
l

About the Bridge Client
Configure the Bridge Client Pool
Manage the Bridge Client Pool
Change the Bridge Client Settings

Quick Reference for Publishers
l
l
l
l
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Publish a Bridge Data Source with a Live Connection
Stop Keeping Data Fresh Through Bridge
Manage Email Alerts for Bridge
Troubleshoot Issues with Bridge
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Enterprise
l
l
l
l

Plan Your Bridge Deployment
Monitor Bridge Extracts Activity
Monitor Traffic to Bridge Connected Data Sources
Monitor Bridge Refresh Jobs

Connectivity
l
l

Connectivity with Bridge
Update Bridge Connection Information

Security
l

Bridge Security

Use Bridge to Keep Data Fresh
For data sources or virtual connections data that Tableau Cloud can't reach directly, you can
use Tableau Bridge to keep data fresh. For example, use Bridge when your data source connects to data hosted behind a firewall.
Note: If a data source connects to underlying data hosted in the cloud accessible from the
public internet, live and extract connections run from Tableau Cloud directly.
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What is Bridge
Tableau Bridge is client software that runs on a machine in your network. The client works
in conjunction with Tableau Cloud to keep data sources that connect to private network
data, which Tableau Cloud can't reach directly, up to date. Private network data includes
on-premises data and virtual cloud data.

How does it work
Tableau Bridge functions like a conduit between private network data, such as Excel files
and SQL Server data, and Tableau Cloud. The client communicates with Tableau Cloud
through an outbound encrypted connection to enable connectivity between data behind a
firewall and your Tableau Cloud site.

For more information about how Bridge communicates with Tableau Cloud, see Tableau
Bridge Security.

Who can use it
Although any authorised user of Tableau Cloud can use Bridge, Bridge is optimised for
users that perform the following functions in an organisation: site admins and data source
owners.
Site admins, or users who have the Site Administrator or Site Administrator Creator role
on Tableau Cloud, install and manage Bridge clients. For more information, see Plan Your
Bridge Deployment.
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Content owners, or users who have the Creator or Explorer (can publish) role on Tableau
Cloud, typically publish and manage their own content. Content owners use Bridge to facilitate the live and extract connections between Tableau Cloud and private network data.
l

For live connections, Bridge is detected automatically as part of the data source or
virtual connection publishing process. Support for live connections are enabled
through pooling.
More about data sources: Users see the option to publish the data source with a
live connection during the publishing process. This option is available when live connections are supported for relational or cloud databases accessible only from inside
the network.
After the user publishes the data source, an available client in the pool facilitates the
live queries. That’s all there is to it.
To get started, users publish a data source to Tableau Cloud and select the option to
maintain a live connection. Or, publish a workbook, and select the option to publish the
data source separately, and then specify a live connection. For more information
about publishing data sources, see Publish a Bridge Data Source with a Live Connection.
Note: If publishing a data source that connects to a private cloud database, follow the
steps described at Publish private cloud-based data sources to ensure Bridge is used
to facilitate the data freshness tasks.

l

For extract connections, users can set up refresh schedules for data sources or virtual connections.
More about data sources: Users need to publish the data source separately,
whether he or she goes through the publishing data source or workbook process. For
more information, see Set Up a Bridge Refresh Schedule.
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Note: If publishing a data source that connects to a private cloud database, follow the
steps described at Set up schedules for private cloud-based data sources to use
Bridge facilitated refresh schedules.

Tableau Bridge FAQ
Find answers to frequently asked questions about Tableau Bridge.

Bridge Basics
What is Tableau Bridge?

Tableau Bridge is a proxy client that runs on a machine in your network and is used to connect your private network data to Tableau Cloud. Bridge is installed behind your organisation's firewall. It can access on-premises and virtual cloud (isolated private cloud hosted
within a public cloud) data through an established and secure outbound connection from
your data to Tableau Cloud.
See Tableau Bridge Quick Start (video) and Use Tableau Bridge.
What is Tableau Bridge used for?

If some or all of your data on premises or in a virtual cloud is behind the firewall, you can use
Bridge to securely access and connect data to Tableau Cloud. The data can range from
.csv files on your private network or stored in a data warehouse.
Bridge also keeps your data current. If you have a viz that needs to be refreshed as the data
is modified, Bridge can keep data fresh in Tableau Cloud, either by automatically refreshing
extracts or by passing live queries to your on-premises data sources.
What's the cost of Tableau Bridge?

Tableau Bridge is a free, supported client that is used in conjunction with Tableau Cloud.
What are the supported operating systems?

Currently, Bridge is supported on Windows 64-bit machines
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Do we need a separate Tableau Bridge installation for each Tableau Cloud site?

Yes. Tableau Bridge can only connect to one Tableau Cloud site at any given time.
Can I use Bridge even if I can connect to the data directly from Tableau Cloud?

You don’t need to use Bridge if Tableau Cloud can access the data directly. Bridge acts as a
proxy, and depending on throughput, it’s possible that Bridge will be slower than a direct connection to the data source.
How do I install Bridge?

Download the installer from the Product Downloads and Release Notes page and follow the
Install Bridge instructions.
See Recommended software and hardware

Security
How does Bridge keep data secure?

All traffic between Bridge and Tableau Cloud is secured using TLS. Bridge makes outbound
connections only; all communication is initiated from behind a firewall using ports 80 and 443.
Data in transit, to and from Tableau Bridge, is encrypted. Bridge uses the following protocols
depending on the connection type used by the content:
l

For live connections and extract refreshes that use Online schedules, secure
WebSockets (wss://).

l

For extract refreshes that use Bridge (legacy) schedules, HTTP Secure (https://).

To ensure that your data is transmitted to Tableau Cloud only, you can implement domainbased filtering on outbound connections (forward proxy filtering) from the Bridge client.
See Bridge Security.
Are there other ways to secure data?

You can use whitelisting to identify sites that are allowed access to your data and exclude
sites that aren’t included in the list. Some data sources are always “cloud-native”, such as
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Amazon Athena, Redshift, Azure SQL Database and Google Cloud SQL. In these cases,
Tableau Cloud expects to connect directly through IP whitelisting by default when the native
connector is used.
It’s possible to configure Tableau Bridge to work with “cloud-native” data sources if the data
is isolated from the Internet in a private subnet (and therefore IP whitelisting isn’t an option).
What permissions do I need?
l

You need access to the Tableau Cloud account used to log in to Tableau Bridge client

l

and the site associated with the data.
To assign the Bridge client to a pool (either default pool or a named pool), you need
either the Site Administrator Creator or Site Administrator Explorer role.

l

To run refresh extracts:
l For Online Schedules, the user needs Creator or Explorer (can publish). The
l

Bridge client must be set up correctly by site admin.
For Legacy Schedules, because the schedule needs to be assigned to a particular Bridge client, the user either needs to be the owner of that Bridge client
(if the customer only has Creator or Explorer (can publish) permission) or be a

l

site administrator.
The Creator or Explorer (can publish) role and the Data Management licence is

l

required to publish virtual connections and refresh data with Bridge.
The Windows account that is running Bridge needs to have access to all data sources

l

that are being connected to.
The Windows user account must be a member of the local admin group to run the client in service mode. If the user isn’t a local admin, they can run the Bridge client in
Application mode, but they must remain logged in to the Windows machine.

What credentials are used when accessing data?

For extracts with Legacy Schedules, access information must be embedded in the Bridge client. The Bridge client owner must log in to the Windows machine and manually enter the
credentials. This process results in database credentials being stored on the computer
using Windows credentials manager.
For Online Schedules, the credentials can be embedded for the published data source in
Tableau Cloud.
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For data sources accessed via Windows Authentication, there are no credentials to embed,
but the Windows account that Bridge is running under must have access to the source database.
Tableau Bridge supports OAuth when connecting to private data that uses OAuth and public
data that uses OAuth when it’s joined to private data. Both saved credentials or managed
keychain connectors are supported by OAuth: The type of functionality is dependent on the
connector that you use. Bridge supports both live and extract refreshes for data sources with
OAuth authentication.
Tableau Bridge doesn't support connections that use Kerberos authentication.
What are the multi-factor authentication requirements?

If multi-factor authentication (MFA) is enabled with Tableau authentication, Bridge clients
must be running Bridge version 2021.1 and later. The connected client option must be
enabled for the site to allow Bridge clients to run unattended and, if enabled, support multifactor authentication with Tableau authentication. If connected clients are disabled for the
site, Bridge can only support Tableau username and password authentication.
See Access Sites from Connected Clients.

Connections
What types of connectors and connection types does Bridge support?

Bridge supports live and extracted data to keep data fresh.
These data sources don’t support live queries:
l
l
l
l

Cubes
Extract-only data sources (for example, web data connectors),
File-based data sources (for example, excel, .csv)
Data sources embedded directly in workbooks

See Connectivity with Bridge.
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Can Bridge be set up to run continuously?

Bridge can run in two different modes: Application mode and Service mode. By default, the
client runs as an Application. This means the Windows user must be logged on to the computer where the client is running in order for scheduled refreshes to be completed. After
sign-in, the Bridge client opens from the system tray. If your client is set up to run in Service
mode, you don’t need to be logged on to the computer running the client, but your computer
must be on.
See Application versus Service mode.
Can I connect to a data source embedded in a workbook?

Bridge can only be used against published data sources, and it can't be used against data
sources embedded in a workbook. The workaround is to download the embedded data
source and republish as a published data source.

Load Balancing and Pooling
How can I load balance data refreshes with Bridge?

You can configure a pool to distribute data refresh tasks among the available Bridge clients.
Pools map to domains, allowing you to dedicate pools to keeping specific data fresh and
maintaining security by restricting access to protected domains in your private network.
See Configure the Bridge Client Pool.

Scaling and Deployment
How can I scale with Bridge?

As a starting point, we recommend initially configuring at least two Tableau Bridge clients
for redundancy, and in many Bridge deployments, more than one Bridge client is necessary
to support data freshness needs.
Bridge can support up to 10 concurrent extract refreshes. Determine how many extracts
are necessary in the available time window. In many situations, there are several
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concentrated time blocks when extracts need to occur. You will need enough Bridge clients
to complete all required extract refreshes this time window. For example, if you have 7 hours
of extract refreshes to run, and a 4-hour window to run them in, then 2 Bridge clients would
be a reasonable number to use.
Bridge supports 16 live queries per client. Determine the number of concurrent users. Site
admins can monitor traffic to data sources with live connections using a built-in administrative
view in Tableau Cloud. This gives a high-level view into how often particular data sources
with live connections are being accessed.
As part of your pilot and roll-out, you should monitor usage over time.
See Plan Your Bridge Deployment.

Monitoring
How can I monitor Bridge?

You can use the Traffic to Bridge Connected Data Sources admin view to see usage of data
sources with live connections. This view can help you determine which data sources are
most heavily used and those that are used less often.
The Bridge Extracts admin view captures the last 30-days' worth of refresh activity by
Tableau Bridge. Only jobs that have been successfully started by the Bridge client have a
record in the Bridge Extract admin view.

Install Bridge
Tableau Bridge is software that you can install and use in conjunction with Tableau Cloud.
Always install the latest version of Bridge to take advantage of the latest security and feature
updates.

Before installing Bridge
Before you install the Bridge client, review the minimum requirements and general information that you need to know to help ensure a successful start to using Bridge.
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System recommendations

Bridge is available for the Windows operating system. You can also install the client on a virtual machine. For more information about which versions of Windows are supported and
other recommendations, review the Recommended software and hardware.
Licence requirements

You do not need a product key to use Bridge. Use of Bridge is subject to your End User
Licence Agreement (EULA). Users of Bridge must be authorised users of Tableau Cloud.
Network access

Because Bridge facilitates connections between your private network data and Tableau
Cloud, it requires the ability to make outbound connections through the internet. Bridge
does not require the ability to make inbound connections, which means that it typically does
not require a network administrator to make firewall or network changes to work.
Required ports

Tableau Bridge uses port 443 to make outbound internet requests to Tableau Cloud and
port 80 for certificate validation.
Tableau with MFA

If multi-factor authentication (MFA) is enabled with Tableau authentication, Bridge clients
must be running Tableau Bridge version 2021.1 and later. For more information about
Tableau with MFA, see About multi-factor authentication and Tableau Cloud.
Database drivers

Bridge uses Tableau connectors to connect to different databases to maintain data freshness. Some of those connectors require drivers to communicate with the databases.
By default, the following drivers are installed with the client:
l
l
l
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To get drivers for other connectors that the client supports, go to the Driver Download page
on the Tableau website. Make sure to filter the list on the Windows operating system and use
the instructions listed for the latest version of Tableau Desktop.

Install Bridge
Follow the procedure below to install a Bridge client. You do not need a Tableau product key
to install or use the client.
1. Download the installer from the Product Downloads and Release Notes page on the
Tableau website. We recommend downloading the latest version listed on the page to
take advantage of the latest security and feature updates.
2. Run the installer. You can install the client using a shared Windows service account.
3. When prompted, accept the licence agreement to continue.
4. (Optional) Customise the installation by clicking Customise. You can change any of
the following options:
l
l

l

l

Install location: You can specify a different location to install the client.
Create a desktop shortcut: Untick the box if you don't want to automatically
create a desktop shortcut for Bridge.
Create a Start menu shortcut: Untick the box if you don't want to automatically add a shortcut for Bridge to the Start menu
Enable error reporting: If Bridge has a problem and closes unexpectedly,
crash dump files and logs are generated and sent to Tableau. To turn off this
option, clear this check box during installation. You can also turn this option off
(or back on) in the client after installation. For more information, see Error

l

reports.
Install database drivers: Clear the check box if you don't want to automatically install the default database drivers.

5. Click Install to begin the client installation.
After the client is installed, you can start the client by double-clicking the Bridge shortcut on
your desktop or from Tableau Desktop (if it's installed on the same machine as Bridge).
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About My Tableau Bridge Repository

As part of the Bridge installation, a folder called My Tableau Bridge Repository is created
on the machine where the client is installed. This repository folder contains critical subfolders, such as Logs and Configuration, that Bridge needs in order to operate properly.
The repository folder is created under the Documents
folder: \Users\<user>\Documents\My Tableau Bridge Repository.
Important: We strongly recommend that you do not change the folder that Bridge uses as
its repository.

Upgrade Bridge
Staying in sync with the latest version of Bridge ensures that you can take advantage of the
latest features and fixes included with each new version of the Bridge client.
To upgrade the client, follow the procedure below.
Important:
l

If multi-factor authentication (MFA) is enabled with Tableau authentication, Bridge clients must be running Tableau Bridge version 2021.1 and later. For more information
about Tableau with MFA, see About multi-factor authentication and Tableau Cloud.

l

Check out Existing Bridge deployment for information about the latest release.

1. Log on to the machine where the client is installed.
2. If you're running the client in Service mode, in the lower-left corner of the client, next
to Mode, select Application. Changing to Application mode ensures that the
Tableau Bridge service stops completely before the upgrade.
3. Select Settings > Exit.
4. Follow the steps listed in the Install Bridge section to install the client and complete
the upgrade.
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After installation is complete, the client will start as normal. If the client was running in Service
mode prior to the upgrade process, switch back to Service mode.

Error reports
You can help improve Bridge by automatically sending error reports to Tableau. Error
reports are comprised of crash dump files that are sent to Tableau when the Bridge client
has to close unexpectedly (crash). These files are used by Tableau to identify and address
issues that can cause the client to close unexpectedly.
Important: Turn off this option if your data is subject to any privacy regulations.
What's in an error report

The encrypted package is made up of the following files: crash/core dump files and manifest
files related to the crash.
The files can contain data that include:
l

Machine-specific information. For example: hardware, operating system, domain, etc.

l

Snapshot of the memory contents at the time of the crash. For example: which data
sources had extracts refreshed, which data sources had live queries, etc.

l

Information that Bridge was processing at the time of crash, including customer-identifiable information that might be used to correct the error. For example: who is using
Bridge with which site, the name of the client that the user is signed in to, etc.

For more information about how Tableau treats sensitive information, see the Tableau privacy policy on the Tableau website.
Configure automatic error reporting

You can configure Bridge to send error reports automatically in one of two places: during the
client installation process or after installation directly in the client.
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Enable the automatic error reporting option during client installation

During installation, the option to automatically send error reports from the client is selected
by default. However, you can remove the selection.

Disable the automatic error reporting option in the client

If you decided to use the default setting during the installation process and decide later on
that you don't want to allow error reports to be sent automatically, you can modify the option
from the client menu.
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Install Bridge from the command line
You can install the Bridge client from command line if you're a local administrator on the
machine.
General command line syntax

The syntax for running the Bridge installer from the command line is the following:
tableauBridge<installer_name>.exe /option1 /option2
PROPERTY1 PROPERTY2
A few notes about the syntax:
l

The tableau<installer_name>.exe file is the client installer for the product

l

and version you're installing.
The options specify how the installation process should run. For example, whether it

l

should display output while installing and whether it should create log files.
The properties settings specify configuration settings that the installer should make
during the installation process.

Example installer command

The following example shows an installer command with some options and property settings.
tableauBridge-64bit-2018-2-0.exe /quiet /passive
ACCEPTEULA=1 DATABASEDRIVERS=1
You must run the command from the directory where the .exe file is located or specify a full
path to the location of the .exe file on the machine. Do not run the installer from a shared directory on your network. Instead, download the .exe file to a directory on the machine where
you want to install the client.
Installer options and properties

You can specify one or more options in the command line for the installer.
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Installer options

A couple of notes about the options:
l
l

Each option is prefixed with a slash (/).
Options must come before properties.

Option

Description

quiet

Run the installer without messages (status or installation progress)
and without requiring user interaction. The client doesn't launch
after installation is complete.

passive

Run the installer and display dialog boxes and installation status.
Does not prompt the user for input. The client launches after installation is complete.

norestart

Suppress any attempts to restart. By default, the installer will
prompt you before restart unless you run the installer in quiet
mode.

log "log-

Log installation information to the specified path and file. Specify

file.txt"

the path and file name, such as /log "c:\-

logs\logfile.txt". The default log file is the system %TEMP%
directory.

repair

Run the installer to repair an existing installation of Bridge.

h

Help – lists options and properties for the installer.

Installer properties

You can also include one or more properties in the command line for the installer.
Some notes about the properties:
l

All of these properties can be used for the initial installation of client. They can't be

l

used to update any settings after initial installation.
Property names are case sensitive.
There are no spaces on either side of the equal sign.

l
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l
l

Each property set is delimited with a space.
Properties must go after options.

Property

Description

Value

ACCEPTEULA

Accept the End User

1=Accept

Licence Agreement

0=Don't accept (default)

(EULA). If you don't set
this option to 1, Bridge cannot be installed using quiet
mode.

CRASHDUMP

You can set this option to

1=Yes (default)

"1" to help improve Bridge

0=No

by sending error reports to
Tableau automatically
when the client crashes.
For more information, see

Error reports.
DATABASEDRIVERS

Install the default set of

1=Yes (default)

database drivers that you

0=No

might connect to from
Tableau Bridge. For more
information, see Database

drivers.
To download other database drivers, see the
Driver Download page on
the Tableau website. You
must distribute other
drivers using whatever
asset management tools
you use for software
deployment in your organ-
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isation.
DESKTOPSHORTCUT

Create a desktop shortcut.

1=Yes (default)
0=No

DRIVERDIR

Specify an installation dir-

A path such as

ectory (other than the

D:\Drivers

default) for the database
drivers. This option creates the directory and creates an entry in the HKEY_
LOCAL_MACHINE\
registry. The default location for drivers is C:\Program
Files\Tableau\Drivers.

DRIVER_MSSQL

Disable the Microsoft SQL

1=Install (default)

Server driver from

0=Don't install

installing automatically during Tableau Bridge installation.
DRIVER_POSTGRES

Disable the PostgreSQL

1=Install (default)

driver from installing auto-

0=Don't install

matically during Tableau
Bridge installation.
DRIVER_REDSHIFT

Disable the Amazon Red-

1=Install (default)

shift driver from installing

0=Don't install

automatically during
Tableau Bridge installation.
INSTALLDIR
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ectory other than the

ware\Tableau

default.

Bridge.

If you specify a custom directory for the installation
location and plan to install
future releases to this
same location, you need
to specify a version specific sub-folder to install to.
Otherwise you will need to
uninstall the previous version first.
Side-by-side installations
of multiple versions in the
same sub-directory is not
supported.
SKIPAPPLICATIONLAUNCH

You can set this option to

1=Yes

‘1’ to prevent the new

0=No (default)

application from opening
automatically when the
installation process is complete. This option applies
to manual. This option
doesn't apply to quiet
installations because
Tableau Bridge doesn't
open automatically when
using that option.

STARTMENUSHORTCUT

Tableau Software

Create a Tableau Bridge

1=Yes (default)

entry on the Windows

0=No
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Start menu.

Uninstall Bridge
Although it's not necessary to uninstall previous versions of the Bridge client when installing
a newer version, you can uninstall Bridge 2018.2 and later if you no longer need it on your
machine.
The primary method for uninstalling the client is through the Windows Control Panel.
Alternatively, you can use the following procedure to uninstall Bridge from the command
line.
1. Open the Command Prompt as an administrator.
2. In the location where the .exe was installed, run the following command:
tableau<installer_name>.exe /uninstall /quiet

Set Up a Bridge Refresh Schedule
This topic describes how a Tableau data source owner can set up and update refresh schedules for data sources that connect to private network data. Refresh schedules for data
sources that connect to private network data rely on Tableau Bridge. The tasks described in
this topic assume Bridge has been set up and is being maintained by your site admin. Exceptions are noted.
This topic does not cover setting up refresh schedules for virtual connections. For more
information about virtual connections, see Schedule Extract Refreshes for a Virtual Connection.
Notes:
l

Bridge keeps data fresh for published data sources only, i.e. data sources published
separately from workbooks. Bridge can't keep data fresh in data sources embedded
in workbooks.

706

Tableau Software

Tableau Cloud Help
l

To set up and configure refresh schedules for private cloud-based data sources, see

Use Bridge for Private Cloud Data.

Online schedules versus Bridge (legacy) schedules
For data sources that are set up to use extract connections, Bridge uses refresh schedules to
keep data fresh.
There are two types of refresh schedules that you can configure for Bridge to use:
l
l

Refresh schedules in Online
Bridge (legacy)

Note: Bridge (legacy) schedules do not support refreshes for virtual connections.
The schedule you use can depend on a couple of factors, including the version the original
schedule was created on and the type of underlying data that the data source connects to. In
summary, Online schedules are designed to leave client management tasks to the site admin
and enable you to perform all your data source management tasks directly on Tableau
Cloud.
Version

Beginning with Bridge 2021.4.3, extract refreshes for file-based data sources can use Online
schedules. Online schedules for file-based data sources require that at least one Bridge
2021.4.3 (or later) client be set up and added to the client pool by your site admin.
By default, schedules created for file-based data sources that were created prior to Bridge
2021.4.3 use Bridge (legacy) schedules. Bridge (legacy) schedules can be converted to
Online schedules.
Compare schedules

The following table delineates the primary differences between Online and Bridge (legacy)
schedules for keeping private network data fresh.

Supported
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Online Schedule

Bridge (Legacy) Schedule

Relational data

Relational data
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data types

File data

File data

Private cloud data
Content man- Data source page
agement
Virtual connection

Data source page + designated client

page
Scheduling

Integrated with

Can be configured to refresh data sources in as

Tableau Cloud sched-

frequent as 15 and 30 minute increments

ules

REST API

Run Extract Refresh

Not supported

Now option
Update Data Source
Now option

Manage schedules
Though the scheduling tasks are exactly the same, there are two primary entry points for setting up an Online schedule for a data source that connects to private network data. The first
entry point is during the data source publishing process, from Tableau Desktop. The second
entry point is at any time after the data source publishing process.
Note: Online schedules that use Bridge support the same scheduling frequency options as
Online schedules that do not use Bridge.
Set up a schedule

In most cases, you will set up a schedule as you publish your data source from Tableau
Desktop.
1. In Tableau Desktop, create your data source.
2. Select Server > Publish Data Source to begin the publishing process. If you

708

Tableau Software

Tableau Cloud Help
haven't already signed in to Tableau Cloud, you will be prompted to.
3. In the Publish Data Source to Tableau Cloud dialog box, configure the various options
for your data source, and then click the Publish button. This opens a browser window
to Tableau Cloud.
Note: Depending on the data that the data source is connected to or how you've configured the data source, the dialog will default to publishing an extract or will give you
the option to publish an extract. If you are provided options, select the option to publish
an extract.
4. In the Publishing Complete dialog box, click the Schedule Extract Refresh button.

5. In the Create Extract Refresh dialog box, configure a schedule for the refresh. For
more information about how to configure the schedule, see Schedule Refreshes on
Tableau Cloud.
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6. Click the Create button.
Add or update an existing schedule

For whatever reason you are unable to schedule a refresh during the data source publishing process, you can update or add a new schedule any time after.
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Extract Refreshes tab.
3. Do one of the following:
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a. To set up a new schedule, click the New Extract Refresh button and configure
a schedule for your refresh.
b. To update an existing schedule, select the tick box next to the schedule, click on
the Actions menu, and then select Change Frequency to reconfigure the
schedule for the refresh.
4. Click the Create button.

Alternative: Manage Bridge (legacy) schedules
Optionally, you can use the Bridge (legacy) schedule to keep your data fresh.
Notes:
l

Important: Support for Bridge (legacy) schedules will be removed in a future release.
To ensure a smooth transition, we recommend you use Online refresh schedules.

l

Bridge (legacy) schedules can only complete successfully if you embed your database
credentials in the connection through the Bridge client. For more information, see

l

Embed or update database credentials for Bridge (legacy).
When you use a Bridge (legacy) schedule, the time that shows on the client and the
time that shows on Tableau Cloud correspond to the time zone of the machine from
which the client is running.

Set up a Bridge (legacy) schedule

Just like with Online schedules workflow, in most cases, you will set up a Bridge (legacy)
schedule as you publish your data source from Tableau Desktop.
1. In Tableau Desktop, create your data source.
2. Select Server > Publish Data Source to begin the publishing process. If you haven't
already signed in to Tableau Cloud, you will be prompted.
3. In the Publish Data Source to Tableau Cloud dialog box, configure the various options
for your data source, and then click the Publish button. This opens a browser window
to Tableau Cloud.
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4. In the Publishing Complete dialog box, click the Schedule Extract Refresh button.
The Create Extract Refresh dialog box, where you configure the Bridge (legacy)
schedule, displays.
5. In the Create Extract Refresh dialog box, follow each step to configure the schedule.

Notes:
l

To refresh during a specific time period on selected days: Select
Hourly, specify the time range during the day using the From and To dropdown lists, and then select the days of the week.
To optimise performance on the server, refresh tasks are distributed within a
range of up to five minutes of the time of day you specify. For example, if you
set an hourly schedule, the occurrence set to run at 1:00 AM could run any time
between 1:00 and 1:05 AM.

l

Full or incremental refresh: If available, you specify whether you want a full
or incremental refresh. By default, Tableau Cloud runs a full refresh. Incremental refresh is available only if you configured the data source for an
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incremental refresh in Tableau Desktop before publishing. For information, see
Refreshing Extracts in the Tableau Help.
6. Click the Create button.
Add a new or update an existing Bridge (legacy) schedule

If you're unable to schedule a refresh during the data source publishing process, you can add
a new or update a Bridge (legacy) schedule anytime after. New (for sites that have been
migrated)
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Extract Refreshes tab.
3. Do one of the following:
a. To set up a new Bridge (legacy) schedule, in the data source's actions menu,
select Schedule with Bridge (Legacy), configure the schedule and then click
the Schedule Refresh button.

b. To update an existing Bridge (legacy) schedule, select the tick box next to the
existing schedule, click on the data source's actions menu and then select
Change Schedule. In this workflow, you can't change the client that performs
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the refresh. If you need to change the client that performs the refresh, see
Change the client that performs the Bridge (legacy) schedule. When finished,
click the Change Schedule button.
Other Bridge (legacy) schedule management tasks
Add a new or update an existing schedule from the client

If you, not your site admin, are managing the "named" clients, you can add a new or update
an existing Bridge (legacy) schedule directly from the Bridge client.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. Hover over the data source and click the Schedule icon. This opens a browser window to the data source page in Tableau Cloud.
3. Repeat steps 2–3 from the above Add a new or update an existing Bridge (legacy)
schedule section to set up the schedule.
Add a new computer (client) to perform a scheduled refresh

As part of the scheduling process, in the scheduling dialog, you must specify a machine.
The machine you specify is the Bridge client that performs the refresh.
The Bridge (legacy) schedule displays the clients that you signed into.

If the client you want to select is not available from the drop-down list, it can be one of a few
reasons:
l
l

You're not signed in to the client.
The client is not properly registered or connected to the site. Go to and open the client
and make sure that it has a green or "Connected" status.
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l

Your site admin manages all clients in your organisation. When using Bridge (legacy)
schedules, the data source owner and the user signed into the client must be the
same. If your site admin is signed into the client, he or she must reassign ownership of
the data source to him or herself in order to schedule a refresh.

Cancel an in-progress refresh

In some cases, you might need to cancel an in-progress refresh. You can cancel a refresh for
a data source that uses the Bridge (legacy) schedule only.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. Click the Cancel Refresh button. This action will cancel the in-progress refresh.

Note: A client can perform one Bridge (legacy) refresh at a time. If you need to run more
than one Bridge (legacy) refresh at the same time, discuss with your site admin about setting
up additional clients on different machines to perform the extract refreshes.
Change the client that performs the Bridge (legacy) schedule

If you're working with a Bridge (legacy) schedule and want to change the location or machine
that performs the refresh, you must set up a new refresh schedule. You can only schedule a
refresh using a client that you are signed in to.
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To set up a new Bridge (legacy) schedule, see Set up a Bridge (legacy) schedule. When
you're done setting up a new refresh schedule, make sure that you delete the previous
schedule identical to the new schedule.
Important: If the data source requires database credentials to access the underlying data,
you must go back to the client and edit the connection information to re-embed the database
credentials. You can use the Test Connection option in the client to check whether the
data source can access the underlying data.
Remove a client from a site

After you change the client that performs the Bridge (legacy) schedule, consider permanently removing the client from the site if it's no longer being used for any other data
freshness tasks.
1. Sign in to Tableau Cloud.
2. In the upper-right corner of the browser, click your profile image or initials and select
My Account Settings.
3. Under Connected clients, click Delete next to the client you want to remove from the
site.

Verify a previous or upcoming refresh
You can check when a previous refresh took place or find out when the next refresh will
occur.
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Extract Refreshes tab.
3. Next to the schedule, review Last update and Next update columns.

Migrate from Bridge (legacy) to Online schedules
Refresh schedules for file-based data sources that were created before Bridge 2021.4.3
use Bridge (legacy) schedules by default. You can migrate Bridge (legacy) schedules to use
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Online schedules to keep your data fresh. Online schedules run on Bridge clients managed
by your site admin and take advantage of pools of available clients to perform the refreshes.
When you migrate a Bridge (legacy) schedule to use an Online schedule, the previous schedule is deleted and can't be recovered. If you change your mind after migrating the schedule,
you must create the previous schedule using the Bridge (legacy) schedules workflow
described in the Set up a Bridge (legacy) schedule section above.
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Extract Refreshes tab.
3. Click the New Extract Refresh button.
4. Configure the schedule and click the Create button. The original Bridge (legacy)
schedule will be deleted.
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Note: Online schedules for file-based data sources require Bridge 2021.4 clients. If no clients have been set up or are available at the time of the scheduled refresh, the refresh will
fail.

Delete a refresh schedule
1. Sign in to Tableau Cloud and navigate to the data source whose refresh schedule
you want to delete.
2. On the data source page, click on the Extract Refreshes tab.
3. Select the tick box next to the schedule that you want to delete and select Actions >
Delete.

Use Bridge for Private Cloud Data
This topic describes how a data source owner can publish a data source that connects to
cloud data, such as Amazon Redshift and Snowflake, that can only be accessed from a
private network.
Data sources that connect to private cloud data rely on Tableau Bridge to keep data fresh.
In most cases, Tableau Cloud will automatically detect that Bridge is required as part of the
publishing process. However, in some cases, you might need to manually configure your
connection to ensure that Bridge is used.
The tasks described in this topic assume Bridge has already been set up and is being maintained by your site admin.
Notes:
l

Bridge keeps data fresh for published data sources only, i.e. data sources published
separately from workbooks. Bridge can't keep data fresh in data sources embedded
in workbooks.

l

No additional steps are required to use Bridge when publishing virtual connections
that connect to cloud data.
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Set up schedules for private cloud-based data sources
Use the following procedure to ensure that Bridge schedules are used to keep extracts of
your private cloud-based data sources up to date.
1. Follow steps 1-7 in the Publish a Data Source topic in the Tableau User Help.
2. If not already signed in to Tableau Cloud, sign in and navigate to your data source.
3. From the data source page, click the Connections tab and tick the box next to the connection.
4. From the Actions drop-down menu next to the connection, select Edit Connection.
5. In the dialog box next to Network type, select the Private Network radio button and
click Save.

About switching network types
Changing the network type does not change the network type used by existing schedules for the data source.
If you change the network type for a data source that has an existing schedule associated with it, you must create a new schedule. This also means, if you created a
refresh schedule prior to changing the network type, you must delete it before using
the Run Now option. For more information about deleting a refresh schedule, see
Delete a refresh schedule.

Tableau Software

719

Tableau Cloud Help
You can proceed to the next step so that a previous Online refresh schedule is automatically deleted when you create a new Bridge-dependent refresh schedule.
6. Follow one of the steps below depending on the schedule you need to configure:
l

For an Online refresh (formerly called Recommended) schedule, follow the
steps described here: Add or update an existing schedule.

l

For a Bridge (legacy) schedule, follow the steps described here: Add a new or
update an existing Bridge (legacy) schedule.

Note: If you had previously set up a Tableau Cloud refresh schedule, it will be
deleted automatically when you save the Bridge-dependent schedule.
7. Click the Schedule Refresh button.

Publish private cloud-based data sources that use live connections
Use the following procedure to ensure that Bridge live queries are used to keep private
cloud-based data sources up to data.
1. In Tableau Desktop, create your data source.
2. Select Server > Publish Data Source to begin the publishing process. If you
haven't already signed in to Tableau Cloud, you will be prompted to.
3. In the Publish Data Source to Tableau Cloud dialog box, configure the various
options for your data source and ensure you do the following:
l
l

Under Authentication, click Edit and select Embedded password.
Depending on the data that the data source is connected to or how you've configured the data source, the dialog can default to publishing a live connection or
give you the option to publish a live connection or extract. If you are provided
with options, select Maintain a live connection.

4. Click the Publish button. This opens a dialog box.
5. In the dialog box, click the Publish with Bridge button. This opens a browser
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window to Tableau Cloud.

6. In the Publishing Complete dialog box, click the Done button.
7. From the data source page, click the Connections tab and tick the box next to the connection.
8. In the dialog box next to Network type, if not selected automatically, select the Private
Network radio button and click Save.

Publish OAuth enabled private cloud-based data sources
Tableau Bridge supports OAuth when connecting to private data that uses OAuth and public
data that uses OAuth when it’s joined to private data. Bridge currently supports these connectors when using OAuth: Snowflake, Google BigQuery, Google Drive, Salesforce and
OneDrive. For most data sources, live connections and extracted data are supported.
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Both saved credentials and managed keychain connectors are supported by OAuth. The
type of functionality is dependent on the connector that you use.
1. In Tableau Desktop, connect to your data housed in a private cloud database.
2. Depending on the connector, you may be prompted to choose the authentication
type. If you are provided with options, select Sign in using OAuth.

3. The Data Source page opens so that you can prepare the data for analysis and
begin building your view.
4. Choose whether to publish as a live connection or an extract. Some data sources,
such as Salesforce, don’t support live connections.
5. For extracts, click on the Sheet tab to create and save the extract.
6. Select Server > Publish Data Source to begin the publishing process. If you
haven't already signed in to Tableau Cloud, you will be prompted to.
7. Under Authentication, click select the authentication type. The options displayed
are dependent on the data source. In most cases, Saved Credentials are recommended. For more information, see Refresh Data Using Saved Credentials.
l If you have saved credentials for data source in My Account Settings, select

l

Embed <data source name>.
For extracted data, choose whether to allow refresh access. When you allow
refresh access for extracts, you are prompted to set up a schedule. To schedule for a refresh, you must use embedded credentials.

8. When Bridge is required, your connection will be detected as Private during the publish operation. To change your network connection status, click on the Actions
menu, and select Edit Connection.

About the Bridge Client
This topic describes the Bridge client and requirements for running and using it. In most
cases, the site admin is responsible for installing and managing the client.

Client overview
The client is required to enable connectivity between Tableau Cloud and private network
data. When the client is running, it's accessible from the Windows system tray on the
machine where it is installed.

722

Tableau Software

Tableau Cloud Help

The client is comprised of the following parts:
1. Client name, which is also the name of the machine where the client is installed.
2. Connection status indicates whether the client is connected to Tableau Cloud.
3. Site: The Tableau Cloud site that the client is registered to.
4. Settings menu, which contains options to disable error reports and unlink the client
from a site.
5. Data sources: By default, this area displays a list of live queries that are being loadbalanced (or pooled) by clients across the site. This list can also contain data sources
that have been assigned to this specific client using Bridge (legacy) schedules.
Note: This list does not show data sources or virtual connections that are refreshed
with the Online schedules. To see data sources or virtual connections refreshed with
Online schedules, go to the Jobs page and filter on Bridge Refreshes.
6. Pooling status: This shows whether the data source is part of the client pool.
l Live: A Live status indicates the data source has a live connection and is part of
the pool of clients. Note: Virtual connections with live connections do not appear
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l

in this list.
Blank: A blank status indicates the client is not part of the pool. This is because
the data source is using Bridge (legacy) schedules.

7. Legacy options: These options display on hover to edit or view connection information, go to the schedule, and run a manual refresh on hover for data sources that
use Bridge (legacy) schedules.
8. Client mode indicates if the client is running as a Windows application or service.
For more information, see the section below.
Application versus Service mode

A client can operate in one of two modes: Application or Service.
The mode the client can run depends on the Windows user account it's running under, the
Tableau Cloud site settings that the client is registered to and general data freshness
needs.
l

Application: When the client is set to run in Application mode, it runs as a Windows
application.
In this mode, the client can facilitate live queries and scheduled refreshes for content
that connects to private network data while the dedicated user is logged on to Windows. If the dedicated user logs off Windows, the client cannot maintain live queries
and refresh extracts on a schedule. Client versions 2020.1 and earlier run in this
mode by default.

l

Service: When the client is set to run in Service mode, it runs as a Windows service.
In this mode, the client runs continuously even if the user is logged out of Windows.
The Windows user account must be a member of the local Administrators group to
run the client in service mode. This mode is recommended for pooled clients that load
balance live queries and scheduled refreshes. Service mode is the default mode
beginning with Bridge 2020.2 clients.

Mode guidelines
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Extract connection with

Live connection

scheduled refresh
Application mode

Service mode

l

Quickly set up and validate that the client is keeping

l

content up to date.
Have more control over when the client is performing

l

data freshness tasks.
Doesn't require the user to be a local admin on the

l

machine.
Requires the user to be logged on to Windows.

l

Set up the client once – if the machine has to restart,
the client reconnects to Tableau Cloud automatically.

l

Requires the Windows user account to be a member
of the local Administrators group on the machine. In
addition, to refresh file-based data sources, the
account must have domain access to the network

l

shared drive where the file data is hosted.
Doesn't require the user to be logged on to Windows.

Recommended for load bal-

Recommended for load bal-

ancing refreshes. For more

ancing live queries. For

information, see Configure

more information, see Con-

the Bridge Client Pool.

figure the Bridge Client Pool.

Client requirements
In order to run and use the client, a certain set of requirements must be met as well as some
additional requirements that are unique to the data freshness task.
Core requirements
l

Client can only run on 64-bit version of Windows.

l

Only one client can be installed on a machine.
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l

The machine on which the client is running must be on the same Windows domain
and have access to the underlying database specified in the data source or virtual connection.

l

Both the machine and the Windows user must have access to the underlying data
specified in the data source or virtual connection.

l

The appropriate database drivers must be installed on the machine where the client
is running.

l

Tableau Cloud's connected clients option must remain enabled to allow the client to
run unattended and, if enabled, support multi-factor authentication with Tableau
authentication. For more information about the connected clients option, see Connected client requirement for Tableau Bridge.

l

If multi-factor authentication (MFA) is enabled with Tableau authentication, Bridge clients must be running Tableau Bridge version 2021.1 and later. For more information
about Tableau with MFA, see About multi-factor authentication and Tableau Cloud.

For more information, see Recommended software and hardware.
Additional requirements for Service mode
l

To run the client in Service mode, the Windows user account running Bridge must be
a member of the local Administrators group on the machine. The user doesn't need to
be logged on to Windows, but the machine must be powered on with Windows running.

l

When using the client in Service mode and connecting to file data hosted on a network shared drive, it's required that the account have domain access to the network
shared drive.

Additional requirements for extract connections

To refresh extracts, the client can run as a Windows service or as an application. In addition
to the core requirements above, the following requirements must be met:
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l

The user signed in to Tableau Cloud from the client must have a Creator, Explorer
(Can Publish), or one of the two types of site admin role: Site Administrator
Creator or Site Administrator Explorer.
If the user is not a site admin, he or she must be the content owner.

l

If the client is set to run as an application, it completes refreshes only when the
machine is powered on, and the Windows user is logged on and running Bridge.
If the machine is turned off, if the user logs out of Windows or if the user exits the client,
updates for the data sources or virtual connections running on that client (either
through the pool or manually) will not be able to reach Tableau Cloud, and the data
sources or virtual connections won't get refreshed until the user signs in again. During
this time, the content owner will receive refresh failure notification emails from Tableau
Cloud. For more information, see Stop Keeping Data Fresh Through Bridge.

l

To ensure refreshes of file-based data sources complete without any issues, a client
that has been set up to run as a service must reference the full UNC path of the source
file and not the mapped drive path. For example, use "\\filesrv\Data\file.csv" instead of
"C:\Data\file.csv".
For a client that has been set up to run as an application, we strongly recommend that
the client also references the full UNC path. For more information, see Change the file
path for a data source.

Additional requirements for live connections

To run live queries, the client can run as a Windows service or as a Windows application. In
addition to the core requirements above, the following requirements must be met:
l

The user signed in to Tableau Cloud from the client must have one of the two types of
site admin roles: Site Administrator Creator or Site Administrator Explorer.

l

Each Tableau Cloud site can have multiple clients that maintain live connections.
Those clients can also be used to refresh extracts.
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l

If the client is set up to run as an application, live queries can only occur when the computer is on and the Windows user is logged on and running Bridge.
If the computer is turned off, if the user logs out of Windows or if the user exits the client, updates to the data sources or virtual connections will not be able to reach
Tableau Cloud, and the content can't be kept up to date.

l

To maintain live connections, the databases that the Tableau content connects to
can't be accessible from the public internet.

Repair a client running in Service mode
Occasionally, something causes content connections to stop functioning normally. When
this happens, an alert appears, and it usually provides information that direct you toward the
cause of the problem. However, if Tableau Cloud cannot provide troubleshooting information in the alert, and if you run Tableau Bridge as a service, you can use the Repair command to try to reset connections.
To help repair a client in Service mode, in the Windows system tray, right-click the Bridge
icon and select Repair. This stops and restarts the service, which can be enough to resolve
the issue.

Configure the Bridge Client Pool
This topic describes how site admins can configure and manage pooling for Bridge clients.
Pooling allows clients across the site to load balance data freshness tasks for data sources
or virtual connections that connect to private network data.

Configure pooling
The purpose of a pool is to distribute (or load balance) data freshness tasks among the available clients in a pool whose access is scoped to a domain within your private network. Pools
map to domains, giving you the ability to dedicate pools to keeping specific data fresh and
maintaining security by restricting access to protected domains in your private network.
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Although the client in the pool that performs the data freshness task is chosen at random, if
for whatever reason a client can no longer perform the task, the task is automatically
rerouted to another available client in the pool to handle the task. There is no additional intervention required from you or your users to support or manage the pool of clients.
Pooling is optimised for keeping data sources or virtual connections that connect to data on
one or more private networks fresh. Pooling support does not extend to data sources that
use Bridge (legacy) schedules.
In general, pooling is optimised for the following situations:
l

Bridge is used as a critical service. If your organisation requires that live query
and scheduled refresh support must be available even if a client becomes unavailable.

l

Client is at capacity. If your existing site traffic exceeds the current capacity of the client.

l

Tableau Cloud-managed schedules for file-based data sources. Beginning with
Bridge client version 2021.4.3, Bridge pools enable Online schedules for file-based
data sources. Note: file-based data sources

l

l

Keeping data fresh on multiple private networks.
Virtual connections. (Requires Data Management) Bridge is required to refresh
data in virtual connections that connect to private network data. For more information
about virtual connections, see About Virtual Connections and Data Policies.

Before configuring the pool

Before you can configure a client pool for your site, review the following:
l

Clients must be installed and running. For more information about software and hardware, see Recommended software and hardware.

l

Clients are configured to run as a service. For more information, see Application

l

versus Service mode.
The user authenticated into a client is a Tableau Cloud site admin. For more information about deploying Bridge, see Plan Your Bridge Deployment.

Tableau Software

729

Tableau Cloud Help
l

l

To keep virtual connections fresh, ensure all clients in the pool are running Bridge
2021.4 (or later).
To load balance file-based data sources, ensure the following:
l All clients in the pool are running Bridge 2021.4.3 (or later).
l References to file data must use the full UNC path that includes the server

l

name or hostname. For more information, see About the Bridge Client.
File-based data sources are extract only.

Note about user roles

Only site admins, or users with either the Site Administrator or Site Administrator Creator
role, can configure and maintain pooled clients. Regardless of the type of user authenticated into the client, only site admins can add new pools, add clients to a pool, remove clients from a pool and monitor clients in a pool.
Note about refresh jobs

The Jobs page can show you all the completed, in-progress, pending, cancelled and suspended Bridge refresh jobs that use Online schedules. This includes refreshes for filebased and non-file-based data sources. For more information, see About Bridge Refresh
jobs. For more information about various ways you can monitor Bridge activity, see Monitor
data freshness tasks.

Step 1: Ensure clients can connect to the site

In order for Bridge to work with your site, you must allow clients to authenticate to the site.
1. Sign in to Tableau Cloud using your site admin credentials and go to the Settings
page.
2. Click on the Authentication tab and validate that the Let clients automatically connect to this Tableau Cloud site tick box under the Connected Clients heading is
selected. For more information about this check box, see Access Sites from Connected Clients.
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Note: If enabled, the connected clients option must be enabled to support multi-factor
authentication with Tableau authentication. If connected clients are disabled for your
site, Bridge can only support Tableau username and password authentication.
Step 2: Configure a pool

Pools, which require Bridge 2021.4 (or later) clients, help route live query and extract refresh
jobs to the appropriate private network. Use pools to access data distributed across multiple
private networks, enable extract refreshes for file-based data sources and to support data
freshness tasks for virtual connections.
1. On the Bridge tab, under Pooling, click the Add New Pool button.
2. In the dialog box, enter a new pool name in the Pool text box and click Save.
After you have at least one pool configured, as part of the publishing process, Tableau Cloud
associates certain data sources or virtual connections with Bridge and client pools automatically.
Step 3: Specify a domain for a pool

Each new pool requires a domain to be specified through the Private Network Allowlist.
This information is required to enable Bridge access to data in the private network on behalf
of Tableau Cloud.
Using the allowlist, you must specify the domain names or IP addresses of the private network where you want to enable client access.
Domain names

The domain names that you specify in the allowlist are the server names used in the data
source connection or virtual connection. In some cases, you can find the server name listed
in the Connections tab of the data source page in Tableau Cloud.
For example, to keep data sources like “Starbucks” up to date, you might specify “mssql.myco.lan”, “oracle.myco.lan” or “*.myco.lan” in the allowlist.
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To keep data sources like "Fitness Challenge" up to date, specify "fitness-challenge" in the
allowlist.

In other cases, the Connections tab might not list the server name. When the server name
is not listed, consider working with the content owner to identify where the data is hosted
and specify the server name in the allowlist when you have that information. As a temporary
alternative, you can skip to Step 4: Add clients to a pool to assign clients to use the Default
Pool instead.
IP addresses

Instead of domain names, you can specify IPv4 addresses in the allowlist. We recommend
that you specify IPv4 addresses in the allowlist if IPv4 addresses are used in the data
source connections or virtual connections. Consider working with your content owners to
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get this information. If you don’t have that information, as a temporary alternative, you can
skip to Step 4: Add clients to a pool to assign clients to use the Default Pool instead.
Notes:
l

For security purposes, the allowlist is empty by default to prevent Tableau access. This

l

ensures that site admins specify what data can be sent to Tableau Cloud using Bridge.
You can assign one or more domains to a pool.

l

If your site was set up to use pooling prior to Tableau 2021.4, the Default Pool
remains for backwards compatibility purposes but can't be configured to access a specific private network. To reduce the scope of access of this pool and to enable more
advanced scheduling capabilities, we recommend that you create new pools and map
them to specific domains.

To map a domain to a pool, do the following:
1. While on the Bridge tab, under the Private Network Allowlist, click the Add New
Domain button.
2. In the Domain text box, enter the URI of the domain using the information described
in Allowlist registry rules.
3. Under Domain permissions, ensure the Allow radio button is selected.
4. Under Pool, select the pool whose scope of access should be limited to the URI you
specified in step 2.
5. Repeat steps 1-4 for each additional domain.
6. When finished, click Save.
Allowlist registry rules

Use the following rules when specifying the domains that you want to enable Bridge access
to. This allows Bridge, on behalf of Tableau Cloud, to access the data on your private network to perform data freshness tasks. A domain enables Bridge to connect to both databases and file data hosted in that domain.
Notes:
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l

Domains are not verified when added to the allowlist, when data sources or virtual con-

l

nections are published or when refresh schedules are configured.
Duplication due to the same domain being added to the allowlist as both the domain
name and its IP address are not verified. In this scenario, if one pool maps to the
domain name and another pool maps to the IP address, the format specified in the
data source connection or virtual connection determines which pool keeps the data

l

fresh.
Domains must be accessible by Bridge. This means, all clients in the pool must have

l

access to the specified domain.
If no domains are specified, Bridge is unable to run data freshness tasks for data
sources or virtual connections configured for Online schedules. Note: Data sources
configured for Bridge (legacy) schedules will continue to run in the same way.

Scenario

Description

Example

Exact

Can either be a FQDN or PQDN.

myco.com

domain

Port numbers are not allowed.

marketing.myco.com

name

oracle.myco.com

Range of

Use an optional leading wildcard

domain

(*) to include all subdomains.

names

*.myco.com

The * must be followed directly
by a dot(.).

Exact IPv4 Use an IPv4 literal (abbreviations

255.255.0.1

address

192.168.0.0

are not allowed). IPv6 addresses
are not allowed.

Range of

Use a subnet mask to include a

IPv4

range of IPv4 addresses.

255.255.0.1/16

addresses
Block

Block Bridge connectivity to

When adding or editing a

domains

hosts in this domain.

domain in the private network
allowlist, select the Block radio
button option.
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Allowlist registry examples

Example 1 - database data
Suppose you want Bridge to do the following:
l

Perform data freshness tasks for data located in data.lan and sqlserver.myco.lan.

l

Prevent data freshness tasks for data located in oracle.myco.lan.

To enable Bridge to support these scenarios, you can map the domains to two pools (A and
B) and block the third domain.
If you specify...

and map

...data is

to

refreshed in loc-

pool...

ations

*.lan

Pool A

data.lan

sqlserver.myco.lan

Pool B

sqlserver.myco.lan

*.myco.lan

(Blocked) -

Note: Although this domain range blocks data
freshness tasks on oracle.myco.lan, a blocked
domain range can unblock a specific domain
within it if the domain is explicitly allowed, such
as sqlserver.myco.lan.
Example 2 - file data
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Suppose you have file data, C:\Shared\employees.csv, located on fileserv.myco.lan. To
enable Bridge access to this data, map the domain of the machine to a pool. You can specify one of the following domains to a pool:
l
l
l

Option #1: *.lan
Option #2: *.myco.lan
Option #3: fileserv.myco.lan

Note: The host machine must allow network access to the "Shared" folder.
Step 4: Add clients to a pool

Follow the procedure below to assign clients not already assigned to a pool.
Note: To support data freshness tasks for all data, ensure clients in the pool are running
Bridge 2021.4 (or later).
1. On the Bridge tab in the Unassigned Clients table, navigate to the client you want to
assign to a pool and click Assign.

2. In the Pool drop-down menu, select the pool you want to associate with the client.
3. Repeat step 2 for each unassigned client you want to assign to a pool.

Troubleshoot pooling
Bridge Refresh jobs fail with one of the errors listed below.
The following errors can be seen on the Jobs page and the Background Tasks for Non
Extracts admin view.
l

"errorID=NO_POOLED_AGENTS_ASSIGNED"
This issue can occur for one of two reasons:
l

When the server address or IP address of a data source does not match a
domain specified in the Private Network Allowlist. This causes refresh jobs
to be sent to the Default Pool where there are no assigned clients.
To resolve this issue, make sure 1) the allowlist contains the domains (server
addresses or IP addresses) used by the data sources, and 2) at least one pool
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is associated with those domains (sever addresses or IP addresses). For more
information, see Step 3: Specify a domain for a pool.
l

When there are no clients in the pool. To resolve this issue, add at least one
Bridge 2020.2 (or later) client to the pool. For more information, see Step 4: Add

clients to a pool.
l

"errorID=NO_POOLED_AGENTS_ASSIGNED_NAMED_POOL"
This issue can occur when there are no clients in the pool. To resolve this issue, add at
least one Bridge 2021.4 (or later) client to the pool. For more information, see Step 4:
Add clients to a pool.

l

"errorID=NO_AGENT_IN_POOL_SUPPORTS_REMOTE_EXTRACT_
REFRESH"
This issue can occur when a refresh job tries to run without at least one Bridge 2020.2
(or later) client in the pool. To resolve this issue, add at least one Bridge 2020.2 (or
later) client to the pool. For more information, see Step 3: Specify a domain for a pool.

l

"errorID=NO_POOLED_AGENTS_CONNECTED"
This issue can occur when none of the clients in the pool are available to run data freshness tasks. For more information, see the Configure the Bridge Client Pool section
above.

l

"errorID=REMOTE_EXTRACT_REFRESH_ALL_AGENTS_BUSY" or
"errorMessage: Maximum concurrency reached" in the client
These issues can occur if the number of refresh jobs running at a given time exceeds
the capacity of your client pool. To help resolve this issue, you can do the following:
l

Add additional clients to the pool. For more information, see Step 4: Add clients

l

to a pool.
Increase the size of the connectionPool setting on each client. For more
information, see Manage the size of the Bridge pool.

l

"errorID= AGENTS_IN_POOL_REQUIRE_UPGRADE"
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Beginning with Tableau 2021.4, this issue can occur when the clients in the pool need
to be upgraded to Bridge 2021.4 (or later) in order to run data freshness tasks. For
more information about upgrading clients, see Install Bridge.
Bridge clients are being signed out
This issue can happen if you deploy a large number of clients under the same Windows services account. When there are more than 10 clients running under one Windows services
account, account security measures can cause clients to be logged out. For more information, see Windows services account.
Other potential pooling issues
When trying to diagnose issues related to pooling, consider reviewing the following log files
for a client on the Bridge client machine: tabbridgeclijob_<process_id>, jprotocolserver_
<process_id>, stdout_jprotocolserver_<process_id>. For more information, see Manage
Bridge log files.

Manage the Bridge Client Pool
There are a few ways you can manage your pooled Bridge clients.

Monitor data freshness tasks
You can monitor client activity using a combination of the Jobs page and built-in admin
views.
Live queries

To monitor live query activity, you can use the Traffic to Bridge Connected Data Sources
admin view.
Refresh jobs

To monitor refresh jobs, you can use the following resources:
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l

Jobs page: The Jobs page can show you the completed, in progress, pending, cancelled and suspended Bridge refresh jobs that use Online schedules. For more information, see About Bridge Refresh jobs.

l

Background Tasks for Non Extracts admin view: After filtering on Refresh
Extracts Via Bridge, this admin view shows Bridge refresh jobs that use Online
schedules. For more information, see Background Tasks for Non Extracts.

l

Bridge Extracts admin view: This admin view shows Bridge refresh jobs that use
both Online schedules and Bridge (legacy) schedules. For more information about this
view, see Bridge Extracts.

l

Create a data source or view using client logs: Using JSON log files generated
by a client, create your own data sources and views to monitor refresh jobs. For more
information, see the Refresh jobs by client section below.

Refresh jobs by client

As an alternative to monitoring refresh jobs using the admin views listed above, consider creating your own data sources and views to monitor refreshes performed by a Bridge client.
You can do this by using Tableau Desktop to connect to a client’s JSON log files on the
machine where the client is running.
Note: A client's JSON log files do not capture refreshes for virtual connections.
The JSON log files are comprised of objects, “k” and “v”. The “k” objects capture refresh jobs
and “v” objects capture refresh details. The refreshes and their details include:
l
l
l
l

Schedule type - Online or Bridge (legacy)
Data source type and name
Refresh start and end time, duration, time to upload and publish
Errors

Step 1: Before you begin

If you want to build a view from the data of one log file, you can skip to Step 2.
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If the data for a client is in multiple log files, you’ll need to union the files. You can create a
script to union the log files locally or use Tableau Desktop to perform the union as described
in the procedure below.
Notes:
l

The procedure described below assumes you are running Tableau Desktop on the

l

same machine as the client.
If you are working with multiple log files from different clients in a pool, in addition to
unioning multiple logs files for a client, you can join the log files from multiple clients to

l

monitor refreshes in a pool.
Connecting to JSON files directly from Tableau Cloud web authoring is currently not
supported. For more information, see Creators: Connect to data on the web.

Step 2: Connect to JSON logs

To build a data source and view, connect to a client’s log files using Tableau Desktop.
1. Start Tableau Desktop and under Connect, select JSON file. Do the following:
a. In the Select Schema Levels dialog box, select the top level schema to include
“k” object details and optionally, select the "v"-level schema to include "v" object
details and then click OK.
b. Navigate to the log file you want to connect to (for example, C:\Users\jsmith\Documents\My Tableau Bridge Repository\Logs), select it and then
click Open.

2. (Optional) On the data source page, right-click the log files and click Convert to
Union to set up a union. Do the following:
a. Select Wildcard (automatic) tab.
b. Next to Search In, verify the path shows the client’s Log folder.
c. Under Matching pattern, enter ExtractRefreshMetrics_* and click OK.
3. Select the sheet tab to start your analysis and build your view.
4. When finished, publish the data source and view to Tableau Cloud separately. To
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ensure that your data source is kept up to date, you can set up a Bridge (legacy) schedule for the data source after publishing.
Be aware that the data sources and views you create can change without warning because
new log files can be generated and old log files can be deleted after certain log-specific limits
are met. For more information about these limits and how to adjust them, see Change the
Bridge Client Settings.

Manage pools and clients
Under the Pooling section, you can see up to five tables of pooling- and client-related information in your Bridge deployment.
About pools
The first table consists of clients registered to the site organised by the pools they are
assigned to.

The second table, Unassigned Clients, shows clients that are not assigned to a pool. In
most cases, these clients need to be assigned to a pool before they can load balance live
query and extract refresh jobs. In other cases, clients in this table might be dedicated to
refreshing data sources using Bridge (legacy) schedules.
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The third table, Default Pool, shows clients in the default pool. Clients configured to use
pooling prior to Bridge 2021.4 are included in this pool by default. Because the default pool's
domain can't be configured to access a specific private network, we recommend you reduce
its scope of access by creating new pools and mapping them to specific domains.

The clients you see in the first three tables can tell you the following information:
l

Client name, also known as the computer name, is the name of the machine the client
is installed on and running from.

l

Owner name, which in most cases is a site admin. This is the user who is authenticated (signed in) to Tableau Cloud from the client.

l

Pool status, applies to the first table only, can indicate 1) whether there are assigned
clients in the pool, 2) clients are connected and available to handle data freshness
tasks or 3) pool is offline because all clients in the pool are disconnected.

l

Client version:

l

A warning icon (

) displays in this column when the client is not running the

latest version of Bridge. Although not required, we strongly recommend
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upgrading to take advantage of the latest security and feature updates. To
download the latest version of Bridge, go to the Tableau Bridge Releases page
on the Tableau website.
Note: The warning icon shows only when there is a newer client available for
download. The warning icon is not an indication that there are issues with the client or related Bridge data sources or virtual connections.
l

Connection status – for more information, see the Client connection status, below.

l

Last connected – shows the day and time Tableau Cloud was last able to reach the client.

About Private Network Allowlist

The fourth table, Allowlist Registry, contains a list of domains that pools are scoped to.

The fifth table, Allowlist Requests, shows pending domains that users have requested to
connect to when trying to create virtual connections. These domain requests should be
addressed as soon as possible to unblock users from their virtual connection workflows.
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Client connection status
Where clients are listed, the coloured squares and status labels indicate the availability of
the client to support data freshness tasks.
l

Green or ‘Connected’: A green or Connected state indicates that the client is connected and available to support live queries and extract refreshes.

l

Red or ‘Disconnected’: A red or Disconnected state can indicate one of a few conditions that have temporarily put the client in a disconnected state. The most common
scenario is if the client is not running or was unable to establish communication with
Tableau Cloud after being launched. You can hover over the status to see a tooltip
that describes the condition.
Notes: When the client is in a disconnected state, live queries might be disrupted. In
cases like this, views that depend on data sources or virtual connections with live
queries might not properly display until the issue is resolved.

The states described above reflect and correspond to the status you see in the client.

Change the Bridge Client Settings
There are several Bridge client settings that the site admin can configure to change how a
client runs. In some cases, a data source owner might be responsible for some of the tasks
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described in this topic if he or she maintains his or her own client to run Bridge (legacy) schedules.

Run Bridge as a Windows service
In order for a client to be included in a pool, the client should run as a Windows service (Service mode). By default, a client is set to run as a Windows service so that it can load balance
live queries and refreshes in the background without requiring a dedicated user to be logged
in to the machine. For a client to run as a Windows service, the Windows user account that
runs the client must be a member of the local Administrator group on the machine.
Note: If you're a data source owner and managing the client yourself, your client will not be
included in the pool. However, if you want the Bridge (legacy) schedule to run in the background even when you're not logged on to your machine, your client must be running as a
Windows service (Service mode).
1. Open the Windows system tray and click the Bridge icon to open the client.
2. From the Mode drop-down menu, select Service. A sign-in windows displays.

3. Enter your local admin credentials.
In your list of Windows services, Bridge appears as Tableau Bridge service. You
can see this in the Windows Services console or on the Services tab in the Task Manager.
Stop running Bridge as a Windows service

To stop the client from running as a service, change its mode.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. From the Mode drop-down menu, select Application.

Tableau Software

745

Tableau Cloud Help

When the client is running in Application mode, live queries and scheduled refreshes can
only run when the user is logged in to the Windows user account on the machine where the
client is running from.

Switch the site a client is associated with
When you want to use a client to keep content published to a different Tableau Cloud site
fresh, you can unlink the existing client and authenticate to the new site from the client.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. From the drop-down menu, select Unlink.

Unlink removes the list of data sources that use Bridge (legacy) schedules, schedules
and connection information from the client.
3. Open the Windows system tray and click the Bridge icon to open the client.
4. When prompted, sign in to the new site with your site admin credentials.
5. Do one or both of the following to configure the client:
l

If this client refreshes data sources associated with a specific client, ask data
source owners to reconfigure their data sources and refresh schedules.

l
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use Online schedules, ensure that the new client is part of the pool. For more
information, see Configure the Bridge Client Pool
When you unlink a client, you might also need to remove the Bridge (legacy) schedules for
the data sources that the client was refreshing. The other data sources will continue to have
data freshness tasks performed by other registered clients in the pool.
For more information, see Effects of exit and unlink.

Configure a timeout limit for refreshes
To govern the misuse of extracts or refreshes, you can enforce a time limit, also known as a
timeout limit, for refreshes performed by a client. The timeout limit is the longest allowable
time for a single extract to complete a refresh before it's cancelled by the client.

Note: For extracts of virtual connections, the default extract refresh timeout limit is 2
hours and can’t be controlled by the Bridge client. As an alternative, you can modify the
virtual connection to refresh within the default 2-hour window or switch to a published
data source.

By default, the timeout limit for a client is set to 24 hours. You can change the timeout limit for
a client through the Bridge configuration file. If an extract refresh is cancelled as a result of
reaching the timeout limit, you will see a message in the client and an email alert will be sent
to the data source owner.
The client must be restarted for any changes made to the configuration file to take effect.
1. On the machine where the client is installed, go to the Configuration folder in the My
Tableau Bridge Repository.
The default location of the Configuration folder is C:\Users\jsmith\Documents\My
Tableau Bridge Repository\Configuration.
2. Open the TabBridgeClientConfiguration.txt file.
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3. Next to extractRefreshTimeout, change the time allowed for a refresh task to
complete.
Note: If you don't see the parameter in the configuration file, you can add
"extractRefreshTimeout" : 08:00:00", to the dataSourceRefreshSettings setting like in the example below.

4. Save and close the file.
5. Exit and restart the client for the changes to take effect. The way you restart the client
depends on whether the client is running in Application or Service mode.
l

For Application mode: from the client menu, select Exit.

l

For Service mode: from the Mode drop-down menu, select Application; from
the client menu, select Exit.
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Manage Bridge log files
The client creates logs of activities as part of its normal operation. You can use these logs to
monitor refreshes, troubleshoot issues with Bridge or if Tableau Support requests logs from
you to help resolve an issue.
You can manage the size of Bridge log files or increase the time log files remain before being
deleted in the TabBridgeClientConfiguration.txt file.
Configurable options
l

maxLogFileSizeInMB: By default, the maximum size allowed for a Bridge log file
is 25 MB. When a log file exceeds the size limit, a new log file is created.

l

maxBackupLogFileCount: The default value for the maximum number of allowed
Bridge log files is 40. When the number of log files exceed the limit, the oldest log file is
deleted.

l

remoteRequestLogFileLifeSpan: For each Bridge Refresh job that is sent to
the client, a new set of log files is created: tabbridgeclijob_<process_id>, jprotocolserver_<process_id>, and stdout_jprotocolserver_<process_id>. By default, the
maximum amount of time the log files remain in the Logs folder before being deleted is
8 hours if the number of log files exceed maxBackupLogFileCount. Otherwise,
these log files remain indefinitely while the number of log files is less than or equal to
maxBackupLogFileCount.
Note: Here, <process_id> represents the Windows process ID.

Note: Log files named tabprotosrv* vary from other Bridge log files. The maximum size is 1
MB and the maximum number of allowed log files is 8,192. These values are also not configurable.
1. On the machine where the client is installed, go to the Configuration folder in the My
Tableau Bridge Repository.
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The default location of the Configuration folder is C:\Users\jsmith\Documents\My
Tableau Bridge Repository\Configuration.
2. Open the TabBridgeClientConfiguration.txt file.
3. Next to loggerSettings, you can change the values for the following parameters:
"maxLogFileSizeInMB" : 25
"maxBackupLogFileCount" : 40
"remoteRequestLogFileLifeSpan": "08:00:00"
4. Save and close the file.
5. Exit and then restart the client for the changes to take effect. The way you restart the
client depends on whether the client is running in Application or Service mode.
l

For Application mode: from the client menu, select Exit.

l

For Service mode: from the Mode drop-down menu, select Application; from
the client menu, select Exit.

Manage the size of the Bridge pool
By default, each client in a pool can load balance up to 10 refresh jobs at one time. If
the number of refresh jobs running at a given time exceeds the capacity of your client
pool or you have the hardware resources to support it, consider increasing each client's capacity.
You can manage a client's pooling capacity in the TabBridgeClientConfiguration.txt
file.
Configurable options
l

ConnectionPool: This is the absolute maximum number of concurrent
refresh jobs allowed by the client. The default value is 10, the minimum allowed
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value is 1 and the maximum allowed value is 100. Changing this value requires
unlinking the client.
l

maxRemoteJobConcurrency: This is the maximum number of concurrent
refresh jobs allowed by the client that can be used to tune or troubleshoot client
performance issues without having to change the absolute values in ConnectionPool. The default value is 10. This value must be the same or less
than the value specified for ConnnectionPool. Changing this value doesn’t
require unlinking the client.

To change ConnectionPool
Important: The procedure described below requires unlinking the client. Unlinking
removes the association between the site and the client. This means for data sources
that are refreshed using Bridge (legacy) schedules, unlinking the client removes associations to those data sources, its schedules, and any connection information from the
client. As part of modifying the size of the Bridge pool, we recommend you click the
Bridge icon in the Windows System tray and note the data sources listed (step 5) to
aid the rescheduling process (step 10).
1. On the machine where the client is installed, go to the Configuration folder in the
My Tableau Bridge Repository.
The default location of the Configuration folder is C:\Users\jsmith\Documents\My Tableau Bridge Repository\Configuration.
2. Open the TabBridgeClientConfiguration.txt file.
3. Edit the value next to ConnectionPool.
4. Save and close the file.
5. (Optional) Click the Bridge icon in the Windows System tray and note the data
sources listed and the refresh schedules that have been configured for those
data sources.
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6. Right-click the Bridge icon in the Windows System tray and select Unlink.

For more information about the Unlink option, see Effects of exit and unlink.
7. Exit the client for the changes to take effect. The way you exit the client
depends on whether the client is running in Application or Service mode.
l

For Application mode: from the client menu, select Exit.

l

For Service mode: from the client menu, select Exit. In the dialog box,
tick the Exit client and stop activities box and click Close.

8. Start Bridge again.
9. When prompted, sign in to Tableau Cloud using your site admin credentials.
10. (Optional) If you followed step 5 for data sources that use Bridge (legacy)
schedules, follow the procedure described in Add a new or update an existing

Bridge (legacy) schedule to reschedule the refreshes and effectively re-associate the data sources with the client.
To change maxRemoteJobConcurrency
1. On the machine where the client is installed, go to the Configuration folder in the My
Tableau Bridge Repository.
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The default location of the Configuration folder is C:\Users\jsmith\Documents\My
Tableau Bridge Repository\Configuration.
2. Open the TabBridgeClientConfiguration.txt file.
3. Edit the value next to maxRemoteJobConcurrency.
4. Save and close the file.
5. Exit the client for the changes to take effect. The way you exit the client depends on
whether the client is running in Application or Service mode.
l

For Application mode: from the client menu, select Exit.

l

For Service mode: from the client menu, select Exit. In the dialog box, tick the
Exit client and stop activities box and click Close.

6. Start Bridge again.
7. When prompted, sign in to Tableau Cloud using your site admin credentials.
8. (Optional) If you followed step 5 for data sources that use Bridge (legacy) schedules,
follow the procedure described in Add a new or update an existing Bridge (legacy)

schedule to reschedule the refreshes and effectively re-associate the data sources
with the client.

Publish a Bridge Data Source with a Live Connection
This topic describes how a data source owner can publish a data source that uses a live connection to private network data. Data sources that connect to private network (including
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private cloud) data rely on Tableau Bridge. The tasks described in this topic assume Bridge
has already been set up and is being maintained by your site admin.
Notes:
l

Bridge keeps data fresh for published data sources only, i.e. data sources published
separately from workbooks. Bridge can't keep data fresh in data sources embedded
in workbooks.

l

To publish a private cloud-based data source that uses a live connection, see Use

l

Bridge for Private Cloud Data.
To publish a virtual connection with a live connection, see Create a Virtual Connection.

Publish a data source
The procedure below describes how you can publish a data source that uses a live connection. To support live connections to data sources that connect to private network data,
Bridge uses functionality called live queries. To keep the data source up to date, Bridge
queries the database directly and returns the results of the query for use in the data source.
1. In Tableau Desktop, create your data source.
2. Select Server > Publish Data Source to begin the publishing process. If you
haven't already signed in to Tableau Cloud, you will be prompted to.
3. In the Publish Data Source to Tableau Cloud dialog box, configure the various
options for your data source and ensure you do the following:
l

l

Under Authentication, click Edit and select Embedded password or Server

Run As account depending on the option you see.
Depending on the data that the data source is connected to or how you've configured the data source, the dialog can default to publishing a live connection or
give you the option to publish a live connection or extract. If you are provided
with options, select Maintain a live connection.

4. Click the Publish button. This opens a browser window to Tableau Cloud.
5. In the Publishing Complete dialog box, click the Done button.
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Stop Keeping Data Fresh Through Bridge
This topic describes the ways a data source owner can stop refreshing data through Tableau
Bridge when running Bridge (legacy) schedules.
Notes:
l

If you stop using Bridge, views that depend on data sources that rely on Bridge will no

l

longer display data and produce blank pages instead.
Bridge (legacy) schedules do not support refreshes for virtual connections.

Remove a data source from a client
One way you can stop a client from refreshing a data source that uses the Bridge (Legacy)
schedule by removing the data source from the client.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. Hover over the data source name and click the Remove icon next to the data source
name.

Stop using Bridge temporarily or permanently
l

To stop using a client and temporarily suspend updates to data sources performed by
the client, open the client from the system tray, and on the settings menu in the upperright, select Exit.
When you exit, the data sources and connection settings remain intact.

l

To stop a client and permanently remove the data sources the client links to Tableau
Cloud, right-click on the Bridge icon in the system tray, and select Unlink.
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Unlinking a client also removes all connection information from the client, including
stored database credentials and Tableau Cloud account credentials.
Effects of exit and unlink

If you exit the client and the next refresh occurs while the client is temporarily stopped, the
data source owner will see an alert in Tableau Cloud and be sent an email notification.
If you unlink a client, we recommend you delete the Bridge (legacy) schedules the client
runs. For more information, see Delete the Bridge (legacy) schedule after unlinking a client,
below.
Delete the Bridge (legacy) schedule after unlinking a client

When you unlink the client, you should also delete the Bridge (legacy) refresh schedules
that the client runs. If a schedule is not deleted, the refresh will attempt to run as scheduled.
In cases like this, you might receive refresh failure notifications.
1. Sign in to Tableau Cloud and navigate to the data source.
2. On the data source page, click on the Extract Refreshes tab.
3. Tick the box next to the schedule and select Actions > Delete.

Permanently remove a client from a site
You can permanently remove a client from a site, which will make the client no longer visible
when setting up a Bridge (legacy) schedule.
1. Sign in to Tableau Cloud and navigate to your Account Settings page.
2. Under Connected Clients, click Delete next to the client you want to permanently
remove from the site.

Manage Email Alerts for Bridge
A scheduled refresh can fail for a variety of reasons. As a data source owner, it's important
to be aware of these refresh failures so that you can troubleshoot any issues and minimise
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gaps in data freshness.
If enabled by your site admin, you will receive email alerts about refresh failures for all of the
data sources that you own. When refreshes for your data sources are facilitated by Bridge
(through Online refresh (formerly called Recommended) or Bridge (legacy) schedules), the
type of alerts you receive, when you receive the alerts and the alerts that you can configure
will differ from Tableau Cloud alerts.
Note: This topic applies to Bridge data sources only. Email alerts about virtual connections
from Bridge are not currently supported.
Differences with Bridge email alerts
l

Timeout refresh failure emails are sent when the timeout limit is exceeded. Unlike
refreshes that run directly on Tableau Cloud, Bridge refreshes timeout after 24 hours
(default). However, a timeout limit for refreshes can be increased (or decreased)
through each Bridge client by a site admin. For more information, see Configure a
timeout limit for refreshes.

l

In addition to refresh failure emails, data source owners will receive email warnings for
the following two scenarios:
l

Bridge client is not running: When an upcoming scheduled refresh can't
start because the client linked to the data source is not running.

l

Incomplete refresh: When a scheduled refresh hasn't completed after a specified amount of time.

l

Data source owners and site admins will receive email failure alerts for the following
Backgrounder process runs:
l

Bridge pool at capacity: When extract refreshes can’t run because the pool is
at capacity.

l

No clients in Bridge pool: When extract refreshes can’t run because there
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are no clients in the named pool.
l

Refresh job failure: When a refresh job fails for reasons other than when
there are no clients in the named pool or when the pool is at capacity. This is a
catch-all for Backgrounder refresh jobs that fail to be sent to the Bridge client.

Note: There isn’t a daily limit to the number of failure emails you can
receive for Backgrounder failure alerts.

l

For a particular data source, Tableau Cloud sends an email about the first five consecutive refresh-related failures (i.e. refresh failures, alerts because the client is not
running or alerts because the refresh hasn't been completed yet) on the first day. If
the data source continues to have refresh issues after the first day, Tableau Cloud
sends one email per day.

l

A data source owner can receive up to 10 emails, one email per data source with active and consecutive refresh issues, in one day. The time period of one day is 24 hours
starting at the time of the first refresh issue.

l

Data refresh-initiated Subscription emails are not supported for views or workbooks
that rely on Bridge extract data sources to keep data fresh. For more information, see
Missing subscription emails.

Configure pooling
Extract refreshes can fail because of issues with the Bridge pool and load balancing. Site
admins can configure and manage pooling for Bridge clients by adding a new pool or modifying the pooling capacity. For more information, see Configure the Bridge Client Pool and
Manage the size of the Bridge pool.

Configure incomplete refresh email alerts for legacy schedules
For data sources that use Bridge (legacy) schedules, by default, a refresh email alert is sent
24 hours after the scheduled start time for a data source with an incomplete refresh. If a
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scheduled refresh completes within 24 hours of its scheduled start time, you will not see an
email alert.
In some cases, you might want to be notified sooner than 24 hours. If a refresh is configured
to use Bridge (legacy) schedule, you can configure the email alert to send after an amount of
time that better aligns with the duration of a particular refresh.
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Extract Refreshes tab, and then click the
Select All button.
The email alert factors all the schedules for a data source when determining when to
send the email alert even if you select only one schedule.

3. From the Actions menu, select Edit Refresh Email Alert.
4. In the Refresh Email Alert dialog box, specify the hours and minutes following a sched-
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uled refresh time that the alert should be sent, and click OK.

Considerations when managing alerts
l

l

Bridge (legacy) schedules only: You can configure email alerts only for refreshes
that are configured for Bridge (legacy) schedules.
One email alert per data source: You can configure one refresh email alert for a
data source. If a data source has multiple refresh schedules, the email alert is sent
based on the next scheduled time across all schedules. Review the following two
scenarios that demonstrate how the email alert timing works.
Scenario 1
Suppose you have an extract data source with one scheduled refresh set to run daily
at 5 AM. For the purposes of this example, the refresh usually takes 30 minutes for
Bridge to complete at that time of day.
If you specify 3 hours for the email alert, you will be sent an email at around 8 AM if
the refresh hasn’t completed by that time.
Scenario 2:
Suppose you have the same data source from Scenario 1, with same time specified
for the email alert against the following three schedules:
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l
l
l

Schedule 1 - runs daily at 5 AM
Schedule 2 - runs twice a week, Tuesday and Thursday, at 1 PM
Schedule 3 - runs once a week, on Saturday, at 12 AM

For the purposes of this example, though it can take as few as 30 minutes for Bridge to
complete the refresh at 5 AM, during business hours, the refresh can take up to 3
hours to complete.
Like the first scenario, if the refresh for schedule 1 hasn’t completed by 8 AM, you will
be sent an email. Regardless of the refresh for "schedule 1" being completed or not,
you will be sent an email at around 4 PM on Tuesday if the refresh for "schedule 2"
hasn’t completed. Similarly, regardless of what happened on Tuesday, if the refresh
for "schedule 2" hasn’t completed by 4 PM on Thursday, you will be sent an email. Finally, if the refresh for "schedule 3" hasn’t completed by 3 AM, you will be sent an email.
l

Email alert time is based on the expected start time of the scheduled refresh:
The time you specify for the refresh email alert is the amount of time after the scheduled start time of the refresh. If you see email alerts too frequently or never at all, consider increasing the time to decrease email alert frequency or decrease the time to
increase email alert frequency.
The default is 24 hours.

l

Legacy schedule email alert can't be turned off: Though email alerts can't be
turned off, you can increase the time for an email alert so that the scheduled refresh
completes before the email alert can be sent.

l

Refresh failure emails must be enabled: In addition to refresh failure emails being
enabled for the site (by the site admin), as the data source owner, you must also have
refresh failure emails enabled for your account.

Stop receiving email alerts when a client is not running
By default, Tableau Cloud is configured to notify data source owners when scheduled
refreshes can't start because the Bridge client linked to the data source is not running.
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There are two primary reasons why you might be receiving this email:
l

The computer where the client is running from is not on.

l

An extract data source continues to be associated with a client that is no longer in
use.

If any of these reasons apply to your situation, consider taking a few moments to: 1) make
sure the machine where the client is installed on is on and the client itself is running and 2) if
you're a site admin, delete unused clients from the site. If you're not a site admin, you can
delete the data source from the client. For more information, see Scheduled refreshes
appear to be running outside of schedule:.

Troubleshoot Issues with Bridge
Different parts of the Tableau Bridge workflow require coordination with Tableau Desktop
and Tableau Cloud. Depending on the task you're trying to complete, the underlying data
that you're working with and the data source's connection (live or extract), and on the symptoms you're seeing, some troubleshooting steps might require you to work in one or both of
these respective products in addition to the client itself.
The issues and the steps to help resolve these issue might apply to data source owners or
site admins.

Understand common issues after upgrade
After upgrading to Bridge, you might notice some changes to your Bridge-specific workflows.
Can't configure 15 minute or 30 minute refreshes
Online schedules can only refresh as frequently as Tableau Cloud allows. If you need to
refresh your data source more frequently, consider continue using Bridge (legacy) schedules instead.

762

Tableau Software

Tableau Cloud Help
Note: When using Bridge (legacy) schedules, the data source owner must be the same user
that is signed into the client that is designated to refresh the data source. Depending on how
client management is administered in your organisation, your site admin might need to take
ownership of your data source.
Can't find the ‘Refresh this extract on’ or ‘Select where to run refreshes’ button
Beginning with Bridge 2020.2, Bridge schedules are better integrated with Tableau Cloud
schedules and can be accessed and set up directly in the same location as Tableau Cloud
schedules. For more information about Bridge schedules, see Set Up a Bridge Refresh
Schedule.
Can't find the Run Now option
The Run Now option in Tableau Cloud is not available on individual data source pages for
data sources that use Bridge (legacy) schedules. In most cases, a manual refresh of a data
source that uses a Bridge (legacy) schedule can only be performed from the client that the
data source is linked to.
Can't refresh data sources that use Relationships
Bridge 2019.4 (or earlier) does not support data sources created with Relationships in
Tableau 2020.2 (or later). To keep your private network data fresh, make sure you're running the latest version of the client. To get the latest client, see Tableau Bridge Releases.
Can't find "Schedule with Bridge Legacy" option
Because Bridge cannot refresh data sources embedded in workbooks, the Schedule with
Bridge Legacy option is not available from the workbook page on Tableau Cloud. To
refresh data sources using Bridge (legacy) (or Online) schedules, republish the workbook
with data sources published separately.
Some data sources are not listed or missing from the client
Data sources that use Online schedules or whose schedules have been migrated to use
Online schedules are not visible from the client. As a site admin, you can monitor data
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sources with Online schedules using the Jobs page. For more information, see About
Bridge Refresh jobs.
Data sources that use live queries and Bridge (legacy) schedules (which includes schedules created with Bridge 2020.1 and earlier) continue to display in the client.

Locate Bridge
If you can't find the Bridge client or the option to use Bridge, try one or more of the suggestions below.
Can't find the Bridge installer
To download the client, go to Tableau Bridge Releases page on the Tableau website and
click the download button. For more information about the Bridge installer and the installation process, see the Install Bridge topic in the Tableau Cloud Help.
Can't find Bridge on my machine
After installing the client on your machine, you can do one of the following tasks to open the
client:

l

Double-click the Bridge shortcut (

) on your desktop.

l

From your desktop, in the Windows system tray, click the Bridge icon (

l

Using Windows file explorer, search Tableau Bridge to locate the client.

l

If Tableau Desktop is installed on the same machine as the client, open Tableau

).

Desktop and select Server > Start Tableau Bridge Client.
Note: This task opens the correct client if you're using Tableau Desktop 2018.2 and
later. If you're using Tableau Desktop 2018.1 and earlier, using the Start Tableau
Bridge Client option will cause an older version of the client to open.
Can't find the Bridge option in the publishing dialog
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The reason why you might not see the Bridge option in the publishing dialog depends on
what you are publishing to Tableau Cloud: a data source or a workbook.
If you're publishing a data source:
l

The data source is file-based. Therefore, the option to use Bridge displays after you
have successful published the data source to Tableau Cloud.
After you successfully publish the data source, you see the Publishing Complete dialog, which allows you to schedule refreshes for your file-based data source using
Bridge while on Tableau Cloud. For more information about scheduling refreshes
using Bridge while on Tableau Cloud, see Set Up a Bridge Refresh Schedule.

l

The data source connects to data that Tableau Cloud can reach directly.
If Tableau Cloud can reach the data directly, you don't need to use Bridge to keep the
data fresh. For a list of connectors that Tableau can use to reach the data directly, see
Allow Direct Connections to Data Hosted on a Cloud Platform.

l

The data source connects to data that is not supported by Bridge.
For a list of connectors that Bridge can support, see Supported connectivity.

If you're publishing a workbook:
l

The workbook contains an embedded data source that must be published separately.
To publish the data source separately, in the Publish Workbook to Tableau Cloud dialog box, click Edit under Data Sources. Under the Publish Type drop-down, select
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Published separately.

Resolve installation issues
Using macOS or Linux
Bridge is not supported on macOS or the Linux operating system. To use Bridge, you must
use a Windows machine. For more information about other system requirements, see Connectivity with Bridge.
Local admin on the machine
The Windows user account you're logged in to must be a member of the local Administrators group. For more information about minimum installation requirements, see Before
installing Bridge. For more information on system requirements, see About the Bridge Client.
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Resolve sign-in issues
Working with multiple Tableau Cloud sites or Bridge is signed in to the incorrect
site
Make sure you're entering the correct username and password for the Tableau Cloud site
that the client is associated with. If you suspect that an incorrect username and password is
saved for a site or that the client is singed in to the incorrect site, use the Unlink option in the
client to remove its association with the site and to clear the password.

Identify causes for scheduled refresh issues
There are several symptoms that can indicate that scheduled refreshes are not performing
as expected. Symptoms might include, but not limited to, the following:
l

As the site admin or data source owner, you see an alert on Tableau Cloud that a

l

scheduled refresh could not complete.
As the site admin or data source owner, you receive an email notification from Tableau

l

indicating that a Bridge refresh could not complete.
As a data source owner, you receive an email notification from Tableau indicating that

l
l

a Bridge refresh could not start on schedule because the Bridge client is not running.
You see an alert in the client next to the data source whose refresh could not complete.
Outdated data in the view.

If any of the above symptoms apply to your situation, follow the procedure below. If the procedure doesn't resolve your issue, then try one or more of the tasks below the procedure to
help identify the cause of the refresh issue.
1. Open the client, click the data source, and then click the Details button to review the
error message.
2. If the error message doesn't provide enough information to resolve the refresh issue,
go to the Tableau Knowledge Base and search for the refresh issue.
Important: If you see the ‘There was a problem and the data engine could not start
properly’ error message and you're running client version 2018.2-2018.3, Tableau strongly
recommends upgrading to version 2019.1 or later. For more information, see Error "There
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was problem and the data engine could not start properly" article in the Tableau Knowledge
Base.
If the Tableau Knowledge Base doesn't address your specific issue, then try one or more of
the following tasks:
l

Validate authentication information in the client: If a data source requires
authentication, ensure that the correct database credentials are being referenced by
the client, even if the database credentials are already referenced in Tableau Cloud.
For information about embedding database credentials in the client, see Embed or

l

update database credentials for Bridge (legacy).
Upgrade the client: Upgrade to the latest version of the client. You can get the latest
version of the client from the Tableau Bridge Releases page on the Tableau website.
For more information about installation, see Install Bridge.

Note: Because of an issue that’s preventing Bridge 2018.2-2018.3 from performing
extract refreshes, Tableau strongly recommends that you upgrade to Bridge 2019.1
or later.
l

l

Make sure that the client is running: Log on to the machine where client is
installed and make sure the client is running. After you verify the client is running, you
can run a manual refresh of the data source or wait until the next scheduled refresh.
Confirm file-based data source uses UNC path: If you're working with a filebased data source using Bridge (legacy) schedules, ensure that the client references
the UNC path. For more information, see Change the file path for a data source.

l

Confirm whether Application mode or Service mode requirements are met:
If the client is set up to run in Application mode, you must be logged on to the
machine where the client is running in order for scheduled refreshes to complete. If
your client is set up to run in Service mode, you don't have to be logged on to the
machine where the client is running. However, the machine must be on.

l

Confirm that all connections in the data source are supported by Bridge:
If refreshing a multi-connection data source (that is, a data source that uses a crossdatabase join), make sure all connections in the data source are supported by Bridge.
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If one or more connections are not supported, Bridge is unable to refresh the data
source until the unsupported connection is removed. For a list of supported connectors, see Supported connectivity. To remove a connection from a data source, you
must edit the data source in Tableau Desktop. For more information, see Editing a
Published Data Source in the Tableau knowledge base.
l

Manually refresh the data source: Manually refreshing the data source can help
determine whether the issue is caused by the client or by a different part of the Bridge
workflow, such as publishing from Desktop or the data source itself.
l

From the client - To determine if the issue is isolated to the specific scheduled
refresh or all scheduled refreshes managed by the client, do a manual refresh of
the published data source from the client.
1. Open the client.
2. Hover over the data source whose schedule refresh is not working, and
click the Run Now icon (

) to manually start a refresh.

If the manual refresh is successful, you have a temporary workaround for the
refresh issue. If the refresh is unsuccessful, review the error in the client to help
resolve the issue.
l

From Tableau Desktop - To determine whether or not the issue is a client
issue or an issue with the published data source, you can do a manual refresh of
the data source from Tableau Desktop.
1. Open Tableau Desktop.
2. In the Connect pane, click Tableau Server and connect to the published
data source that is not refreshing.
3. From the Data menu, select the data source and then select Tableau
Data Server > Refresh from Source.
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If the refresh from source is successful, you have temporary workaround for
the refresh issue. If the refresh is unsuccessful with the same error that shows
in the client, contact Tableau Technical Support on the Tableau website.
l

From Tableau Desktop, create a local copy of the data source - To
determine that the issue is not with the publishing process or with Tableau
Cloud in general, first create a local copy and then manually refresh the published data source.
1. Open Tableau Desktop.
2. In the Connect pane, click Tableau Server and connect to the published
data source that is not refreshing.
3. From the Data menu, select the data source and then select Create
Local Copy.
4. From the Data menu, select the local copy of the data source and then
select Refresh.

If refreshing from a local copy of the data source is successful, you have a temporary workaround for the refresh issue. The issue is likely with the publishing
process.
l

Refresh the data source using the Tableau Extract Command-Line Utility:
Refreshing the data source using the Tableau Extract Command-Line Utility is
another method for isolating whether the issue is specific to the client or with the data
source or other part of the Bridge workflow. This method can also provide an automated or temporary way of refreshing the extract. For more information about setting
up and using the Tableau Extract Command-Line utility, see Automate Extract
Refresh Tasks from the Command Line.
If the refresh is successful through the command line utility, you have a temporary
workaround for the refresh issue. If the refresh is unsuccessful, contact Tableau Technical Support on the Tableau website.

l
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After Tableau Cloud's upgrade to 2019.2, a data source owner might receive multiple
email notifications when an upcoming scheduled refresh can't start because the client
is not running. Because a data source owner can receive up to five consecutive email
notifications per day for up to ten data sources that they own, it might appear the
scheduled refreshes are running outside of their scheduled times. As a data source
owner, you might be receiving the notifications for the following reasons:
l

The machine where the client is running from is not on. To stop notifications in this scenario, make sure the machine where the client is installed on
is on and the client itself is running before the upcoming scheduled refresh is to
occur. Alternatively, if the extract data source doesn't need to be refreshed regularly, consider removing the schedule and manually refreshing it from the client
when needed. For more information about removing a schedule, see Stop Keep-

l

ing Data Fresh Through Bridge.
Extract data sources continue to be associated with a client that is no
longer in use. To stop notifications in this scenario, as a site admin, you can
delete the client from the site. For more information, see Permanently remove a

client from a site.
If you're not a site admin, consider the following:
l If the extract data source doesn't need to be refreshed, you can remove
the data source from the client. For more information, see Remove a data

l

source from a client.
If the extract data source needs to be refreshed, albeit infrequently, you
can change the client associated with that extract data source (and its
schedule). For more information, see Change the Bridge Client Settings.

Refreshes stop responding for data sources that use JDBC-based connections
Note: Bridge provides limited support for data sources that use JDBC drivers to connect to
unsupported databases. For more information, see Limited connector support.
Refreshes for extract data sources whose connections rely on JDBC-based drivers can fail
with timeout errors or the refreshes themselves stop responding, or hang, because of CPU
or RAM spikes. In most cases, these refresh issues can occur when there are several concurrent refreshes of data sources that use JDBC-based connections being handled by a client on a machine that does not have sufficient hardware to support the resource-intensive
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JDBC-based connections. To help resolve this type of issue, review the following suggestions:
l

If you’re a site admin managing the clients in your organisation, review the
log files, jprotocolserver_<process_id> and stdout_jprotocolserver_<process_id>, in
the Logs folder in the My Tableau Bridge repository. Then, consider doing one of the
following:
l

Reduce the number of concurrent refreshes allowed by the client. For more

l

information, see Manage the size of the Bridge pool.
Consider increasing CPU cores and RAM on the machine running the Bridge client to better handle the resource intensive JDBC-based connections.

l

If you’re the data source owner, update the data sources to use a Tableau built-in
connector instead. For more information, see Supported Connectors in the Tableau
User Help.

Refresh issues after changing network type
After updating the network type associated with a data source, from Tableau Cloud to Private Network or Private Network to Tableau Cloud, existing schedules associated with
the data source must be re-created. For more information, see About switching network
types.
Refresh issues on file-based data published from Tableau Desktop on a Mac
When using 1) Tableau Desktop on a Mac, 2) publishing a file-based data source from a Windows network file share and then 3) configuring an Online schedule, the refreshes will fail. If
this file-based data source is a business-critical resource for your organisation, consider configuring a Bridge (legacy) schedule instead. For more information, see Set up a Bridge (leg-

acy) schedule.

Identify causes for live query issues
Issues around live queries are typically due to the option not being enabled or that Bridge
doesn't support the data source type.
No ‘Live’ data sources listed in the client
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A few things need to happen in order for ‘Live’ data sources to display in the client. First, the
site admin has to enable pooling for the site. Second, the site admin must also add at least
one client to the pool. Finally, the data source must be published with a live connection. All
three factors need to happen in order for ‘Live’ data sources to display in the client.
The option to publish with a live connection or the ‘Maintain connection to a live
data source’ option during publishing is missing
The option to use Bridge to support live queries for a private network data source must be
enabled by your Tableau Cloud site admin through pooling. If the option is not available to
you during publishing, consider contacting your site admin to enable the option. If you're a
site admin, see Configure the Bridge Client Pool.
You're prompted for database credentials
If the data source requires authentication by the database, the credentials must be embedded in the data source at the time of publishing. If the credentials are not embedded in the
data source at the time of publishing, the credentials can be added to the published data
source on Tableau Cloud.
1. Sign in to Tableau Cloud and navigate to the data source.
2. From the data source page, on the Connections tab, select the tick box next to the connection.
3. From the Actions menu, click Edit Connections.
4. Select the Embedded password in connection and enter the necessary database
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credentials.

You're working with a file-based or statistical file-based data source
Bridge doesn't support data sources with live connections to file-based and statistical filebased data sources. To keep data fresh for these types of data sources, you can publish
extracts and set up a refresh schedule for each data source instead. For a list of connectors
that Bridge supports, see Supported connectivity. For more information about setting up
refresh schedule, see Set Up a Bridge Refresh Schedule.
Data source doesn't display as ‘Live’ in the client:
If the data source doesn't show as ‘Live’ in the client, the data source was likely published as
an extract. To validate that the data source was published as an extract, follow the steps
below.
1. Sign in to Tableau Cloud and navigate to the data source.
2. On the data source page, check whether the data source has an ‘Extract Refreshes’
tab or an extract icon (
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an extract.

To resolve the issue, republish the data source from Tableau Desktop, ensuring that you
select the Maintain connection to a live data source option. This option tells Bridge to
maintain a live connection to your data.
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Client is running Application mode
If you're using Bridge 2018.2 and later, after the site admin has enabled pooling, live queries
are supported in both Application and Service modes. However, if the client is running
Application mode, you must be logged on to keep data fresh.
If you're using Bridge 2018.1 and earlier, even if live queries are enabled by the site admin,
Bridge can't support live queries in Application mode. The client must be running in Service
mode to support live queries.
For more information about running the client in Application mode or Service mode, see
Application versus Service mode.

Understand other common issues
Delay before list of data sources populate in client
There is a short delay, usually several seconds, populating the list of data sources in the client. This is expected behaviour. The client is contacting Tableau Cloud to get the list of data
sources before it can display that information.
‘No linked data found’ in the client
If the client shows a green indicator and ‘Connected’ status, but also shows a ‘No linked
data found’. review the suggestions below based on the type of data source you're expecting to see.
If you're expecting to see an extract data source that uses a Bridge (legacy) schedule listed
in the client, try the following:
l

Validate that the extract refresh schedule is assigned to the correct client. For more
information, see Change the Bridge Client Settings.

If you're expecting to see a data source with a live connection or an extract data source that
uses Online schedules, try one or more of the following:
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l

Validate that the data source was published with a live connection.
1. Sign in to Tableau Cloud and navigate to the data source.
2. From the data source page, check whether the data source has an ‘Extract
Refreshes’ tab or an extract icon (

). If the data source shows the tab then it

was published as an extract.

l

Make sure at least one client is part of the pool to facilitate data sources with live connections. To do this, contact your site admin. If you're the site admin, verify that you've
enabled pooling for the site and client. For more information, see Configure the Bridge
Client Pool.

Red indicator and ‘Disconnected’ status in the client
If the client shows a red indicator and ‘Disconnected’ status, try the following tasks, in the
order listed:
1. In the client menu, click Repair.
2. If step 1 doesn't resolve the issue, from the Mode drop-down menu, select Application and wait a few seconds. Switch back to Service and wait a few more seconds.
3. If step 2 doesn't resolve the issue, restart the machine. Make sure that there are no
scheduled refreshes that are in progress.
In some cases, the client shows a red indicator and ‘Disconnected’ status if the client is running on a machine that is ‘locked down’. This means that the client is restricted to connecting
to a minimum set of domains. For a list of the minimum set of domains that the client needs to
connect to in order to work, see Additional security considerations.
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Missing subscription emails
Data refresh-initiated Subscriptions are not supported for views and workbooks that rely on
Bridge to keep data fresh. This means you do not receive subscription emails when the following are true: 1) subscriptions are configured for When Data Refreshes and 2) the
views or workbooks you're subscribing to rely on extract data sources that refresh using
Bridge. To use subscriptions in this scenario, consider configuring your subscriptions to use
On Selected Schedule instead. For more information, see Troubleshoot Subscriptions.
"Test Connection" button is greyed out
When editing a connection on Tableau Cloud, the Test Connection button might be
greyed out. In some cases, this button is greyed out because the connection uses custom
SQL or initial SQL. As an alternative to testing your connection with this button, consider running a manual refresh to test the connection instead. For more information about running a
manual refresh, see Start a Refresh Task Manually.

Understand common errors
While using Bridge, you might see one of the following errors.
‘An error occurred while communicating with Tableau Server: Tableau Bridge
does not have a client configured for your site to handle live connections.’ or ‘Cannot connect to database’
This is an error that you might see when connecting to a published data source whose data
freshness is being facilitated through Bridge. To resolve these errors, try the following tasks
in the order listed.
l

Make sure the client is added to the pool. To do this, contact your site admin. If you're
a site admin, verify that you've enabled pooling for the site and at least one client. For
more information, see Configure the Bridge Client Pool.

l

Make sure the client shows a green indicator and ‘Connected’ status. If it shows a red
or ‘Disconnected’ status, see Red indicator and ‘Disconnected’ status in the client.
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‘This data source requires a correct file path’ or ‘Unable to refresh data source
because of an unsupported operation’
If you're working with a file-based or statistical file-based data source (that uses Bridge (legacy) schedules), you might see this error because the path referenced by the client is the
mapped drive path instead of the UNC path. To resolve this issue, you must update the file
location path in the client. For more information, see Change the file path for a data source.
While refreshing on Tableau Cloud, you might see the following error:
"Error: Failed to queue n tasks"
This error can occur if you've selected to use the Run Now option on multiple data sources
and one or more data sources connect to file data. The Run Now option can only be used for
data sources that use Online schedules.
Virtual connections

While trying to create a virtual connection, you might see one of the following errors:
l

INVALID_ARGUMENT:
"INVALID_ARGUMENT: Can't display the view because of Tableau Cloud site settings that affect the data source used by this view. Contact your site administrator to
connect at least one Tableau Bridge client to the site."
This error can occur when there are no Bridge 2021.4 clients in a pool to perform data
freshness tasks for virtual connections that connect private network data. To resolve
this error, contact your site admin to ensure that version 2021.4 clients are running
and in a connected state, and that the pool is mapped to the domain where the underlying data is located.

l

UNKNOWN:

Tableau Software

779

Tableau Cloud Help
"UNKNOWN: There was an unknown connection error to the database. The error
message below has additional information, but you might need to ask the database
administrator to review the database logs."
This error can occur when the domain where the underlying data of the virtual connection is located does not map to a specific Bridge pool. To resolve this error, contact your site admin to ensure that the domain where the underlying data is located is
mapped to a Bridge pool and that there is at least one Bridge 2021.4 client running, in
a connected state, and that it is assigned to a pool.

Prepare and send log files to Tableau Technical Support
If the troubleshooting steps in this article don't help isolate or solve the issue you're having
with Bridge, you can contact Tableau for help. Before you contact Tableau for help, consider following the steps below to gather and send the necessary Bridge client log files that
Tableau will needs to diagnose and help resolve the issue.
Prepare clean log files

1. On the machine, close the client:
l

If your client is running Application mode, from the client menu, select Exit.

l

If your client is running Service mode, change the client to Application mode,
and then from the client menu, select Exit.

2. Go to and open the My Tableau Bridge Repository folder.
The default location of the My Tableau Bridge Repository folder is C:\Users\jsmith\Documents\My Tableau Bridge Repository.
3. In the My Tableau Repository folder, rename the Log folder. For example, Logs_
archive. By changing the name of this folder, the client will create a new ‘Logs’ folder.
4. Open the Command Prompt as an admin.
5. Change to the Tableau Bridge bin folder. For example: C:\Program
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Files\Tableau\Tableau Bridge\bin.
6. Run the following command: TabBridgeClient.exe -DLogLevel=Debug
Note: The above command is case-sensitive. If the command is not typed exactly as
written, the log files will not capture the issue at the level of detail that is necessary to
help diagnose the issue.
After this step, the client opens automatically.
Reproduce the issue

After you prepare the client to create new log files, try to reproduce the issue you're having
with Bridge. By reproducing the issue, the new log files can capture specific details about the
issue. These details are essential for Tableau to have in order to isolate, diagnose and
resolve the problem.
Send log files

1. After the issue has been reproduced, right-click the Bridge icon in the Windows system tray and select Exit to stop Bridge. This step ensures that all errors are recorded
in the log file.
2. Using Windows file explorer, go to and open the My Tableau Bridge Repository
folder.
3. Right-click the Logs folder and select Send to > Compressed (zipped) folder.
4. Contact Tableau Technical Support on the Tableau website.
Note: If the .zip file you created in step 2 is larger than 5 MB, see Sending Large Files
in the Tableau Knowledge Base.
5. Locate and start Bridge. If the client was previously running in Service mode, ensure
that Service is selected in the client.
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Plan Your Bridge Deployment
As a site admin, if you're setting up Tableau Bridge for the first time or upgrading, there are
a set of recommendations, best practices and planning tasks to follow to optimise Bridge for
your organisation.
For an general overview of Bridge, see Use Bridge to Keep Data Fresh.

Before deploying Bridge
Before you deploy Bridge, review the following information to help you, as the site admin,
understand the different components of Bridge, how these components work together, and
how they impact your Bridge deployment.
Bridge software

Bridge is stand-alone software, provided at no additional cost, to use in conjunction with
Tableau Cloud. Bridge is a thin client that you install behind a firewall to enable connectivity
between private network data and Tableau Cloud.
In most cases, you will own the set up and management of several clients, or pools of clients, in your organisation. For more information, see Management models.
Recommended version

To take advantage of the latest security and feature updates, always install the latest version of the Bridge client from the Tableau Bridge Releases page. For more information, see
the Install Bridge topic.
Notes:
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l

Clients can only be registered to one site at a time.

l

There is no limit on how many clients that can be registered to a site.
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Database drivers

To facilitate connectivity between private network data and Tableau Cloud, Bridge requires
drivers to communicate with some databases. Some driver software is installed with the client. Other driver software must be downloaded and installed separately. For more information, see the Install Bridge section in the Install Bridge topic.
Recommended software and hardware

Bridge is designed to scale up and scale out. When configuring your Bridge deployment, consider the following:
l

For a smaller pool of clients running on higher specification machines, each client can
be scaled up to run more scheduled refresh jobs in parallel.

l

For a larger pool of clients running on lower specification machines, though each client
can run fewer refresh jobs in parallel, each client still provides high throughput and
capacity for the pool as a whole.

For more information about pooling, see Pooling capacity.
Operating systems and more
Bridge can be installed on any supported version of the Microsoft Windows operating system.
Only one Bridge client should be installed per operating system.
l
l
l

Microsoft Windows 10 or later, 64-bit
Windows Server 2012 or later
CPUs must support SSE4.2 and POPCNT instruction sets

Minimum hardware recommendations based on refresh concurrency
The following table shows hardware guidelines for virtual environments running Bridge.
These guidelines are based on the number of concurrent refreshes you need each client to
be able to run in parallel.
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Refreshes running in parallel per client
<=5

<=10

vCPU

4

8

RAM

16 GB

32 GB

NVMe SSD

150 GB

300 GB

Virtual environments
All of Tableau’s products operate in virtualised environments when they are configured with
the proper underlying Windows operating system and minimum hardware requirements.
l
l
l
l
l
l

Citrix environments (non-streaming)
Microsoft Hyper-V
Parallels
VMware
Microsoft Azure
Amazon EC2

Required accounts

There are two types of accounts that your Bridge deployment requires: a Windows service
account and a Tableau Cloud account.
Windows services account
Bridge clients can run in one of two modes: Application or Service. To run the client in Service mode, a Windows services account is required. Service mode allows the client to run
continuously without a dedicated logged on user. Service mode is recommended to support
1) data sources or virtual connections with live connections to private network data, and 2)
load balancing (pooling) of clients. For more information about each mode, see About the
Bridge Client.
Important: We recommend that no more than 10 clients run under a single Windows services account.
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Tableau Cloud account
Tableau Cloud authenticates the client by the user that is signed in to and managing the client. Therefore, a Tableau Cloud site admin account is necessary to perform certain management tasks, like adding or removing a client from a pool, both on the client and Tableau
Cloud site.
One of the following site roles is required to manage Bridge:
l
l

Site Administrator Creator
Site Administrator Explorer

The non-administrator site roles, Creator and Explorer can publish data sources, refresh
data and use Bridge to facilitate the live and extract connections between Tableau Cloud and
private network data. The Creator or Explorer role and Data Management is required to publish virtual connections and refresh data with Bridge.

Supported connectivity
When planning your deployment, as the site admin, it’s important to know what data your
users are connecting to, the type of connections they’re using and how those connection
types affect how data sources or virtual connections can be managed.
Data types

Tableau Cloud supports connectivity to data hosted on a cloud platform – data typically
accessible from the public internet or outside the firewall. For data accessible only from a
private network (inside the firewall), Bridge must be used.
Private network data that Bridge supports falls into three general categories:
l

Relational data – examples include Microsoft SQL Server, MySQL, PostgreSQL,
Oracle, Teradata or even PostgreSQL hosted in Amazon RDS

l

File data – examples include Microsoft Excel, text and statistical files
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l

Some cloud data (accessible only from a private network) – examples include Redshift, Teradata and Snowflake

After a connection to the private network data is made, the connection information is saved
with the Tableau data source or virtual connection. Bridge uses that connection information
to facilitate connectivity between the private network data and Tableau Cloud.
Data connections

Bridge supports data sources or virtual connections that use connections between private
network data and Tableau Cloud. A data source or virtual connection can use one of two
connection types:
l

Live (also known as live query): Data sources set up to use live connections
enable real-time updates of the data. This means that any changes to the underlying
data is reflected, via Bridge's live queries, in the data source (or workbook that uses
that data source) or virtual connection published to Tableau Cloud.

l

Extract: Data sources set up to use extract connections enable snapshots of the
data. These snapshots can be refreshed on a schedule, via Bridge's Online refresh
(formerly called Recommend) or Bridge (legacy) schedules, to capture any changes
to the underlying data. These snapshots are then pushed to the data source (or workbook that uses that data source) or virtual connection published to Tableau Cloud.
For more information about the schedules, see Data freshness.

Support for these connection types depends on the data that the data source or virtual connection is connected to. Bridge supports live queries for most relational data. For other data,
including file data, only extract connections are supported. For more information, see
Bridge exceptions.
Data freshness

Bridge keeps data sources or virtual connections up to date using live queries and refresh
schedules.
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For data sources or virtual connections set up to use extract connections, Bridge uses
refresh schedules. There are two types of schedules that can be created by content owners
to keep data fresh: Online and Bridge (legacy).
l

Online schedules allow content owners to manage Bridge data sources directly from
Tableau Cloud.
Beginning with Bridge 2021.4.3, file-based data sources can be refreshed using
Online schedules.

l

Bridge (legacy) schedules require a designated client to perform the refresh. A client
can be designated to perform the refresh by the data source owner. The data source
owner can only assign a Bridge (legacy) schedule to a client that he or she is already
authenticated or signed in to using his or her own Tableau Cloud credentials.

Depending on the schedule type, different refresh concurrency is supported. For more
information, see Pooling capacity.
Compare schedules

The following table delineates the primary differences between Online and Bridge (legacy)
schedules for keeping private network data fresh.

Supported

Online Schedule

Bridge (Legacy) Schedule

Relational data

Relational data

File data

File data

data types

Private cloud data
Content man- Data source owner
agement
Virtual connection owner

Site admin or data source owner

Client man-

Site admin or data source owner

agement

Site admin

(depending on who is designated to own
the client management tasks)

(depending on who is designated to own
the data source management tasks)
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Scheduling

Integrated with Tableau Cloud

Bridge-specific schedule that can be con-

schedules

figured to refresh data sources as frequently as 15 and 30 minutes

Pooling sup- Live queries

Not supported

port
Scheduled refreshes (for data
sources or virtual connections
with extract connections)
Refresh con- 10

1

currency per
client
REST API

Run Extract Refresh Now

Not supported

option
Update Data Source Now
option
Data access and authentication

The underlying data that a data source or virtual connection connects to often requires
authentication. If authentication is required, the publisher or owner can configure how the
database credentials are obtained.
For data sources
The authentication configuration options for data sources are: Prompt user or Embedded
password.
If the data source is set to prompt users, database credentials are not stored with the connection. This means, a user who opens the data source (or workbook that uses the data
source) must enter his or her own database credentials to access the data. If a data source
is set up with the password embedded, database credentials ares saved with the connection and used by anyone who accesses the data source (or workbook that uses the data
source). For more information, see Set Credentials for Accessing Your Published Data.
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For virtual connections
Database credentials are stored with a virtual connection's connection and are used by anyone who accesses the virtual connection.
Content management

In most cases, the site admin owns and manages the Bridge clients. Content owners manage the data sources or virtual connections themselves for tasks that range from publishing
to updating database credentials and refresh schedules.
Note: Regarding data sources, Bridge can only keep data fresh for published data sources,
i.e. data sources published separately from workbooks. Bridge can't keep data fresh in
embedded data sources, i.e. in data sources that are embedded in a published workbook.

Management models
Although there are no constraints on how to set up and manage Bridge in your organisation,
your Bridge deployment will likely fall into one of two common management models. The
management model you use, as the site admin, depends on the type of schedules that your
Bridge deployment needs to support.
Centralised management

A centralised management model supports pooling of clients and is optimised for keeping
data, in multiple private networks, fresh. Because of pooling, live queries and refresh jobs
happen in parallel across available clients.
For example, if you have 20 refreshes and have five clients that are running and available,
you can expect each client to be allocated to run four refresh jobs each.
Using this model means:
l

As the site admin, you can set up and take down Bridge clients as needed.

l

For content owners, this means they can 1) have uninterrupted publishing workflows
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that detect whether Bridge is needed, 2) edit or update database credentials from
Tableau Cloud directly and 3) schedule refreshes from Tableau Cloud directly.
Mixed management

A mixed management model is an option if Bridge facilitates connectivity for data sources
that use Bridge (legacy) schedules. With this model, in addition to the benefits of the centralised management model, ‘named’ or designated clients must be managed separately.
With this model, the owner of the data source and the user authenticated into and managing
the client must be the same. Therefore, the owner of the client can be one of two types of
users: data source owner or site admin.
l

Data source owner: The data source owner should be the client owner if you want
him or her to perform data source management tasks on his or her own. Data source
management tasks include updating refresh schedules and updating database credentials that are saved with the client.

l

Site admin owner: You must be the client owner if you want to retain all client management responsibilities. This means, you must assign ownership of the data source
to yourself, effectively making you the new data source owner. You are then responsible for all data source management tasks associated with owning data sources.

Note: Bridge (legacy) schedules do not support refreshes for virtual connections.
Using this model means:
l

When scheduling refreshes, data sources need to be assigned to a specific client.
When scheduling a refresh, the client is only visible to the data source owner if he or
she is signed in to the client itself under the same Tableau Cloud account.

l

If the data source owner maintains ownership of his or her data sources, he or she
must own the management of the client that refreshes those data sources.

l

If you, as the site admin, want to maintain ownership of the client, you must also own
the data sources that are assigned to the specified client.
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l

Only one refresh can happen at a time for data sources. If you need refreshes to happen at the same time, consider designating additional “named” clients to support
higher throughput.

Pooling capacity

By default, data freshness tasks, live queries and data sources or virtual connections that
use extract connections refreshed with Online schedules are distributed and load balanced
across available clients in a pool.
Data Freshness Task

Pooling

Concurrency Capacity

Support
Live query

Yes

16 live queries per client

Extract connection – Online refresh (formerly

Yes

10 refreshes per client

called Recommended) schedule
Extract connection - Bridge (legacy) schedule

(can be configured)
No

1 refresh per client

Scheduling capacity

Because Bridge clients can easily be connected and disconnected, you can leverage scripts
to schedule Bridge capacity (i.e. the number of running client machines) in advance of anticipated data freshness workloads.
For example, if your Bridge clients run on virtual machines on AWS, the following AWS
resources can help you get started with scheduling:
l
l
l

AWS Instance Scheduler
How do I stop and start my instances using the AWS Instance Scheduler?
How do I stop and start Amazon EC2 instances at regular intervals using Lambda?

Timeout limits

Live queries have a timeout limit of 15 minutes. This limit is not configurable. Refreshes have
a default timeout limit of 24 hours and is configurable by client. For more information, see
Configure a timeout limit for refreshes.

Tableau Software

791

Tableau Cloud Help

Bridge exceptions
There are some exceptions that you and your users should be aware of when using Bridge.
The following list summarises some of those exceptions.
l

For specific connectivity exceptions, see Unsupported connectivity.

l

For client management model exception, see Mixed management.

Deploy Bridge
The steps to install and set up Bridge are simple. However, there are a few additional things
you must do before you proceed with your deployment.
New Bridge deployment
Centralised management

To deploy Bridge using the centralised management model, do the following:
1. For each machine, log on using your Windows services account, and install the latest
client.
2. After installation, sign in to the client using your Tableau Cloud site admin credentials
to ensure that the client is running under Service mode (on by default).
3. Open a browser, sign in to Tableau Cloud using your site admin credentials and go to
the Bridge settings page to ensure:
a. Installed clients are properly linked to the site.
b. Clients are part of the client pool (on by default for clients running Bridge
2020.2 and later).
4. Monitor the Bridge live queries using Bridge Connected Data Sources admin
view, and refresh jobs from the Jobs page on Tableau Cloud.
Mixed management

To deploy Bridge using the mixed management model, do the following:
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1. For each machine, log on using your Windows services account, and install the latest
client.
2. After installation, sign in to the client using your Tableau Cloud site admin credentials
to ensure that the client is running under Service mode (on by default).
3. Open a browser, sign in to Tableau Cloud using your site admin credentials and go to
the Bridge settings page to ensure:
a. Installed clients are properly registered to the site.
b. Clients are part of the client pool (on by default for clients running Bridge 2020.2
and later).
4. To support data sources that use Bridge (legacy) schedules, do one of the following:
l

If the publisher will own and manage their own data sources, ensure that the
data source owner installs the latest client on their machine before any data
source publishing takes place.

l

If you will own and manage both the data sources and clients associated with
those data sources:
i. Set up another machine and client to designate for refreshing data
sources.
ii. Sign in to that client using your Tableau Cloud site admin credentials.
iii. Open a browser, sign in to Tableau Cloud using your site admin credentials and go to the Bridge settings page to ensure:
i. Installed clients are properly recognised and registered to the site.
ii. Clients are not part of the pool.
iv. Change ownership of the published data sources that need to be
refreshed with your Bridge client to yourself.
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v. After you change ownership of the data sources, change the client associated with the refresh.
vi. Log on to the machine running the client and open the client.
vii. For each new data source assigned to your client, enter the database
credentials that the client needs to connect and refresh the data source.
5. Monitor the Bridge live queries using Traffic to Bridge Connected Data Sources
admin view, and refresh jobs from the Jobs page on Tableau Cloud.
Next steps

After you have Bridge set up and running in your organisation, your users can start connecting to private network data, publishing data sources or virtual connections to Tableau
Cloud and keeping data fresh.
Existing Bridge deployment
Deploying Bridge 2021.4 (or later)

As with previous releases, the enterprise improvements in this release are designed to complement your existing Bridge deployment. As with other deployments, we recommend the
following steps below.
Step 1: Add new 2021.4 (or later) clients first

The latest updates to Bridge include more flexibility and control over Bridge pools, Online
schedules support for file-based data sources and private network data freshness support
for virtual connections. For more information about these changes, see the following in the
What’s New in Tableau Cloud:
l

What’s New in Tableau Cloud

Special notes about the latest release:
l

Support for Online schedules for file-based data sources is available with Bridge
2021.4.3.
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l

Sites with pooling configured before Tableau 2021.4 have clients assigned to the
Default Pool by default. The default pool's domain can’t be configured to access a
specific private network. To reduce the scope of access of this pool and to enable
more advanced scheduling capabilities, we recommend that you create new pools
and map them to specific domains. For more information, see Step 2: Configure a
pool.

l

Because Bridge pools are mapped to and refresh data from specific domains, we
strongly recommend that extract data sources that contain connections to multiple
domains be updated in one of the following ways:
l

Consolidate underlying data locations so that the connections are in the same

l

domain
Change the connection type of each connection to use live query
Convert each connection to a data source

l

l

When using 1) Tableau Desktop on a Mac, 2) publishing a file-based data source from
a Windows network file share and then 3) configuring an Online schedule, the
refreshes will fail. If this file-based data source is a business-critical resource for your
organisation, consider configuring a Bridge (legacy) schedule instead. For more
information, see Set up a Bridge (legacy) schedule.

l

Existing data sources, including all file-based data sources, that are already configured with Bridge (legacy) schedules and associated with specific clients will continue to run as expected. Important: Support for Bridge (legacy) schedules will be
removed in a future release. To ensure a smooth transition, we recommend you use
Online refresh schedules.

l

New live queries and extract data sources that use the Online schedules will default to
using 2021.4 (or later) clients and new capabilities.

Step 2: Create new pools, map domains to a pool and assign version 2021.4 clients to pools

Follow the procedures described in Step 2: Configure a pool, Step 3: Specify a domain for a
pool and Step 4: Add clients to a pool.
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Step 3: Request data source owners to convert Bridge (legacy) schedules

After Bridge 2021.4 (or later) clients have been added to and are running successfully in
your network, ask data source owners to convert their Bridge (legacy) schedules to use
Online schedules. For more information, see Migrate from Bridge (legacy) to Online schedules.
Important: We recommend that data source owners begin the process by converting
refresh schedules for extract data sources that are least critical to daily business. This is
because converting Bridge (legacy) to Online schedules will immediately delete the existing
refresh schedules.
Step 4: Upgrade existing clients to Bridge 2021.4

Upgrade all existing clients to Bridge 2021.4 (or later). For more information, see Upgrade
Bridge.
Step 5: Add existing clients to a pool

After upgrade, ensure upgraded clients are running as a Window service and then add
those clients to the pool. For more information, see Step 4: Add clients to a pool.

(Archived) Deploying Bridge 2020.2-2021.3
The latest updates to Bridge include enterprise-specific improvements to provide better
redundancy in refresh scenarios and help reduce the need for site admins to manage data
sources. For more information about the changes, see What’s New in Tableau Cloud.
Step 1: Add new 2020.2-2021.3 clients first

The latest enterprise improvements have been designed to complement your existing
Bridge deployment. Therefore, Tableau recommends that before you upgrade your existing
clients, first add new 2020.2-2021.3 clients to your environment. For more information, see
What’s New in Tableau Cloud.
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Notes:
l

New extract data sources that use the Online schedules will default to using 2020.22021.3 clients and new capabilities.

l

Existing data sources that are already configured on a schedule (Bridge (legacy)) and
associated with specific clients will continue to run as expected.

l

New clients can refresh 10 data sources in parallel by default but can be configured to
refresh up to 100 in the TabBridgeClientConfiguration.txt file. For more information,
see Change the Bridge Client Settings.

l

We recommend that no more than 10 clients run under the same Windows services
account.

Step 2: Request data source owners to convert refresh schedules

After 2020.2-2021.3 clients have been added to and are running successfully in your network, ask data source owners to convert their current refresh schedules (Bridge (legacy)) to
use Online schedules. This applies to data sources that connect to relational data only. For
more information, see Migrate from Bridge (legacy) to Online schedules.
Important:
l

We recommend that data source owners begin the process by converting refresh
schedules for extract data sources that are least critical to daily business. This is
because converting existing refresh schedules (Bridge (legacy) to Online schedules
will immediately delete the existing refresh schedules.

l

Schedules for extract data sources that connect to file data cannot be converted to use
integrated refresh schedules. Instead, those data sources will continue to use the
(Bridge (legacy)) schedule and the client that it’s linked to.

Step 3: Upgrade existing clients to Bridge 2020.2-2021.3

Upgrade all existing clients to Bridge 2020.2-2021.3. For more information, see Install
Bridge.
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Step 4: Add existing clients to a pool

After upgrade, ensure upgraded clients are running as a Window service and then add
those clients to the pool. For more information, see Configure the Bridge Client Pool.

Connectivity with Bridge
When data sources or virtual connections connect to private network data that Tableau
Cloud can't reach directly, Tableau Bridge is used to facilitate connectivity.

Supported connectivity
Bridge supports the connectivity scenarios described below.
Supported connectors
Bridge supports a combination of connectors that Tableau Desktop and Tableau Cloud supports, unless listed under Unsupported connectors below.
Supported connection types
Bridge supports both connections types, extract and live.
l

Extract connection: When data sources or virtual connections use extracts, to connect to private network data Bridge can be used to perform scheduled refreshes of
those extracts. Refreshes can be scheduled, in most cases, by the content owner as
part of the publishing process. For additional requirements to support extracts, see
Additional requirements for extract connections.

l

Live connection: Bridge supports data sources or virtual connections with live connections to private network data using a feature called live queries. If the content
owner publishes a data source or virtual connection that uses a live connection to
data which Tableau Cloud detects that it can't reach directly, live queries are automatically used to keep the content fresh. For additional requirements to support live
queries, see Additional requirements for live connections.

Supported data types
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The type of data that Bridge can support falls into one of the following categories:
l

Relational data

l

File data, including Excel, text and statistical (.sas7bdat) files.

l

Private cloud data, including Amazon Redshift, Teradata and Snowflake. For more
information, see Use Bridge for Private Cloud Data.

l

Some ODBC data

l

Some web data connector (WDC) data if the data can be accessed by entering a
standard username and password.

l

Data used in a multi-connection data source (i.e. data sources that contain a
cross-database join), when all connectors are supported by Bridge. For more information, see Refreshing Cross-Database Joined Data Sources on Tableau Bridge in the
Tableau Knowledge Base.

Limited connector support

Similar to Tableau, Bridge provides limited support for data sources that use the connector
plugins, Web Data Connector or a JDBC or ODBC driver to connect to data. For more
information about the support provided, see the following topics in the Tableau Help:
l
l
l

Web Data Connectors
Other Databases (JDBC)
Other Databases (ODBC)

If a Tableau Datasource Customisation (TDC) file is used to customise your generic JDBC
or ODBC connections, you can use the steps described in Use .tdc files for generic JDBC or
ODBC connections to ensure those customisations are used by Bridge as well.
About SAP HANA
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If you want to connect to SAP HANA using live connections, parameters and variables must
be disabled. Live connections to SAP HANA calculation views do not succeed with Bridge if
parameters and variables are used.

Unsupported connectivity
There are a few connectivity scenarios that Bridge does not support.
Unsupported connectors

l

Microsoft Analysis Services
Microsoft PowerPivot
Oracle Essbase

l

SAP NetWeaver Business Warehouse

l

Connectors (.taco) built with the Tableau Connector SDK and connectors available

l
l

through Tableau Exchange

Unsupported connection types
l
l

l
l

Live connections to file-based data
Live connections to Google Cloud SQL, OData, Progress OpenEdge and Tableau
extracts
All connections to cube-based data
Snowflake when used with virtual connections

Using Bridge for OAuth-enabled private cloud-based data sources

Tableau Bridge supports OAuth when connecting to private data that uses OAuth and public data that uses OAuth when it’s joined to private data. Bridge currently supports these connectors when using OAuth: Snowflake, Google BigQuery, Google Drive, Salesforce and
OneDrive. For most data sources, live connections and extracted data are supported.
Connecting to cloud data that Tableau Cloud can reach directly

For cloud data, setting up refresh schedules directly with Tableau Cloud is almost always a
better choice. For a list of connectors supported by Tableau Cloud, see Allow Direct Connections to Data Hosted on a Cloud Platform.
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Refreshing extracts of other cloud data

For some cloud data, you can sign in by providing a standard username and password. For
example, you might be able to connect to a MySQL database hosted on a cloud platform. In a
scenario like this, you can set up a refresh schedule for extracts that connect to this type of
data directly with Tableau Cloud. For more information, see Schedule Refreshes on Tableau
Cloud.

Update Bridge Connection Information
This topic describes how a data source owner can update the connection information for a
data source that connects to private network data.
Note: For information about connection information for virtual connections, see Create a Virtual Connection.

Embed or update database credentials
For live queries and scheduled refreshes to run as expected, data sources that require user
authentication must have the database credentials embedded with the data source.
You can embed database credentials for your data source in one of two ways: 1) during publish time from Tableau Desktop or 2) after publishing from the data source's Connection tab
in Tableau Cloud. The procedure below describes how to embed database credentials on
Tableau Cloud. For more information about embedding database credentials in Tableau
Desktop, see Set Credentials for Accessing Your Published Data.
1. Sign in to Tableau Cloud and navigate to your data source.
2. From the data source page, click the Connections tab.
3. Tick the box next to the connection, click the Actions menu, and select Edit Connection.
4. In the Edit Connection dialog box, enter the database credentials required for accessing the data, and click Save.
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Embed or update database credentials for Bridge (legacy)

If you use Bridge (legacy) schedules to refresh your data sources, you must embed the
database credentials in the connection information in the Bridge client. This task must be
done even if you embedded the database credentials at publishing time on Tableau
Desktop.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. Point to the data source, and then click the Edit icon (

) that appears.

3. In the dialog box, enter the database credentials required for accessing the data, and
then click Save.

Change the file path for a data source
If Bridge (legacy) schedule is used to refresh, saved with the data source is the location of
the file. In some cases, you might need to update the file location that the client references
under the following circumstances:
l

Source file location has changed

l

Data source was published from a mapped drive: If a client used to perform
refresh is running in Service mode and the data source was published from a
mapped drive, the file path referenced by the client must be updated to use the full
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UNC path. The Windows services account that the client is running under must also
have access to the UNC path location of the file. We strongly recommend clients running in Application mode also reference the UNC path for its file-based data sources.
When one of the above conditions is met, you can use the procedure below to change the file
path for the data source.
1. Open the Windows system tray and click the Bridge icon to open the client.
2. Point to the data source, and then click the Edit icon (

) that appears.

3. In the dialog box, enter the path location information and then click Save.

Use .tdc files for generic JDBC or ODBC connections
You can use the steps described below to ensure customisations for generic JDBC or
ODBC connections enabled through a Tableau Datasource Customisation (TDC) file are
also used by Bridge.
Step 1: Customise the generic JDBC or ODBC connection
If you aren’t already familiar with the type of customisations you can make to your JDBC and
ODBC connections and how to create a TDC file, see Customise and Tune a Connection in
the Tableau Help.
Step 2: Save the TDC file in the My Tableau Bridge Repository
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In order for Bridge to use the customisations specified for generic ODBC or JDBC connections, you must save the TDC file in the location specified by the procedure below. To
refresh JDBC or ODBC connections through Bridge pools, this step must be performed for
all clients in the pool.
1. On the machine where the client is installed, go to the Datasources folder in the My
Tableau Bridge Repository.
The default location of the folder is C:\Users\jsmith\Documents\My Tableau Bridge
Repository\Datasources.
2. Place the TDC (.tdc) file into the Datasources folder.
3. Exit and restart the client for the changes to take effect. The way you restart the client
depends on whether the client is running in Application or Service mode.
l

For Application mode – from the client menu, select Exit.

l

For Service mode – from the Mode drop-down menu, select Application; then
from the client menu, select Exit.

4. Repeat steps 1–3 for all clients in the pool.
Notes:
l

After you save the TDC file to the required location, customisations are applied to all
generic JDBC or ODBC connections to the same underlying data.

l

To validate the TDC file is being used, you can review the client log files (for example,
C:\Users\jsmith\Documents\My Tableau Bridge Repository\Logs) for either of the following log entries:
l

Found matching TDC

l

Applying customization for genericjdbc or Applying customization for genericodbc
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Change the connection type
A data source can use one of two connection types: live or extract. The connection type
determines the frequency at which the content can be updated to reflect the changes in the
underlying data. Depending on the data that is being connected to, some data sources can
have live or extract connections but other data sources can only have extract connections.
For more information, see Connectivity with Bridge.
If you want to change the connection type of a data source, you must re-publish it from
Tableau Desktop, and select the connection preference there. The publishing process will
offer you the option to use live or extract depending on the private network data that the data
source is connected to. If you switched from a live connection to extract, the workflow leads
you through setting up a refresh schedule for your data source.

Repair connections
Occasionally something causes one or more of the connections to stop functioning normally.
When this happens, an alert appears in the client, and it usually provides information that can
direct you toward the cause of the problem. However, if the alert can't provide any
troubleshooting information and your client is running in Service mode, you can use the
Repair option to try to reset the connections.
1. Open the Windows system tray and right-click the Bridge icon.
2. From the drop-down menu, select Repair. This option stops and restarts the service,
which can be enough to resolve the issue.

Bridge Security
Tableau Bridge applies the following security designs:
l

All communication is initiated from behind the private network firewall and therefore

l

does not require you to manage additional exceptions.
Data in transit, to and from Bridge, is encrypted.
Database credentials are stored on the computer using Windows credentials manager

l

if the data source or virtual connection is set up to use Bridge (legacy) schedules. For
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Online schedules, the credentials are passed on to the client that is selected to perform the refresh.

You can find more details about Bridge security in the sections below.

Transmission security
Data, to and from the Bridge client, is transmitted by a TLS 1.2 connection.

Note: Tableau Bridge uses port 443 to make outbound internet requests to Tableau
Cloud and port 80 for certificate validation.

Authentication
There are two primary authentication points for Bridge: Tableau Cloud and private network
data.
Tableau Cloud

To connect to Tableau Cloud, a user’s Tableau Cloud credentials are entered through the
Bridge client.
After 1) the credentials are entered, 2) an authorisation token is returned by Tableau Cloud.
The 3) token is stored on the computer where the client is running using the credentials manager of the Windows operating system. Bridge uses the token to perform various tasks such
as downloading the refresh schedule information for an extract.
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Private network data

To access private network data, some data sources or virtual connections require authentication using database credentials. Depending on the connection type of the content, the client handles database credentials in one of the following ways:
l

For live connections and extract connections that use Online schedules, database credentials are sent at the time of the request and use a TLS 1.2 connection.

l

For extract connections that use Bridge (legacy) schedules, if the data source
requires database credentials, these credentials must be entered in the client directly.
The database credentials are stored on the computer using the credentials manager
of the Windows operating system. The client sends the database credentials to the
database, which is also behind the private network firewall, at the scheduled refresh
time.

The client supports domain-based security (Active Directory) and username/password credentials to access private network data.

Changes to private network firewall
The Bridge client requires no changes to the private network firewall. The client achieves this
by making only outbound connections to Tableau Cloud. To allow outbound connections, the
client uses the following protocols depending on the connection type used by the content:
l

For live connections and extract connections that use Online schedules,
secure WebSockets (wss://).

l

For extract connections that use Bridge (legacy) schedules, HTTP Secure
(https://).

Access to private network data
Connections to private network data are initiated by the Bridge client on behalf of Tableau
Cloud. The process by which the connection is initiated depends on the content type and connection type.
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l

For data sources with live connections or virtual connections, the client 1)
establishes a persistent connection to a Tableau Bridge service, which is the part of
the client that resides on Tableau Cloud, using secure WebSockets (wss://). The client then waits for a response from Tableau Cloud before 2) initiating a live query to
the private network data. The client 3) passes the query to the private network data,
then 4) returns the private network data using 5) the same persistent connection.

l

For data sources with extract connections that use Online schedules, the client 1) establishes a persistent connection to a Tableau Bridge service, which is the
part of the client that resides on Tableau Cloud, using secure WebSockets (wss://).
The client then waits for a request from Tableau Cloud for new refresh schedules.
When the client receives the requests, 2) the client contacts Tableau Cloud using a
secure connection (https://) for the data source (.tds) files. 3/4) Then the client connects to the private network data using the embedded credentials that are included in
the job request. The client 5) creates an extract of the data and then 6) republishes
the extract to Tableau Cloud using the Tableau Bridge service. Steps 2-6 can be
occurring in parallel to allow multiple refresh requests to happen.
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l

For data sources with extract connections that use Bridge (legacy)
schedules, the client 1) contacts Tableau Cloud using a secure connection (https://)
for new refresh schedules and data source (.tds) files. If 2) this information is available,
at the scheduled time, 3/4) the client connects to the private network data using the
stored credentials. The client 5) creates an extract of the data and then 6) republishes
the extract to Tableau Cloud using a Tableau Bridge service. The Tableau Bridge service is a part of the client that resides on Tableau Cloud.

Additional security considerations
Optional forward proxy filtering

To ensure that your data is transmitted to Tableau Cloud only, you can implement domainbased filtering on outbound connections (forward proxy filtering) from the Bridge client.
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The following list contains the partially qualified domain names that Bridge requires for outbound connections:
l
l

l

l

*.online.tableau.com
*.compute-1.amazonaws.com, Amazon VPC's public DNS hostname, which takes
the form ec2-<public-ipv4-address>.compute-1.amazonaws.com, for the us-east-1
region
*.compute.amazonaws.com, Amazon VPC's public DNS hostname, which takes
the form ec2-<public-ipv4-address>.compute.amazonaws.com for all other regions
(outside of us-east-1)
*.salesforce.com, optionally, if multi-factor authentication (MFA) with Tableau
authentication (Tableau with MFA) is enabled for your site and your environment is
using proxies that prevent clients from accessing other necessary services

l

l
l
l
l

crash-artifacts-747369.s3.amazonaws.com, used for receiving crash dump
reports
s3-us-west-2-w.amazonaws.com, used for receiving crash dump reports
s3-w-a.us-west-2.amazonaws.com, used for receiving crash dump reports
bam.nr-data.net, used for New Relic's web analytic platforms.
js-agent.newrelic.com, sends performance data to New Relic.

Refresh Published Extracts from Tableau
Desktop
You can send updates to published extracts from Tableau Desktop. This option is best for
refreshing extracts of data you maintain on your local network.
Note: If you want to refresh an extract, make note of the file format of the extract before you
perform an extract refresh. If you perform a refresh on an .tde extract using version Current,
the extract is upgraded to .hyper extract automatically. While there are many benefits of
upgrading to a .hyper extract, you will be unable to open the extract with previous versions
of Tableau Cloud. For more information, see Extract Upgrade to .hyper Format.
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1. In Tableau Desktop, connect to the data source that is published to Tableau Cloud or
open a workbook that connects to it.
To connect to the server, use the address https://online.tableau.com.
In the Data pane, a data source published to a Tableau server shows a Tableau icon
next to its name.

2. Select Data > Tableau Data Server, and then choose one of the following options:
l

Refresh from Source
Refreshes the extract (full or incremental) using the data in the original data
source.
This command is available only for extracts that include a connection to the original data source. If you connected directly to a extract file and then published it,
the connection to the original data source is not included.

l

Append Data from Data Source
Updates the extract from another data source in the workbook.

l

Append Data from File
Updates the extract from the contents of a file if the original data source type of
the extract is the same file-based data source or extract file.
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Note: If you do not see the Tableau Data Server option, your data source may not be
published to Tableau Cloud (in which case it will not show the icon above). If you see
the Tableau Data Server option, but refresh commands are unavailable, the data
source exists on the server, but it is not an extract. For example, it is a live connection to
data hosted on the internet.

See also
Topics in the Extracting Data section in the Tableau Help.

Automate Extract Refresh Tasks from the
Command Line
You can automate extract refresh tasks using the Tableau Data Extract Command-Line Utility. This is a command-line utility that comes with Tableau Desktop, through which you can
refresh published extract data sources or append data to them from a file.
Requirements for using the Tableau Data Extract Command-Line Utility include the following:
l

It is available with Tableau Desktop on Windows and can run only on a Windows system.

l

It is not available with the trial version of Tableau Desktop.

l

You can use it for extract data sources that don't use OAuth.

l

You can use it to refresh single-connection data sources only. It does not work for
multi-connection data sources.

Important! Tableau Data Extract command-line utility will be deprecated in October 2022
with the requirement of multi-factor authentication. To refresh data sources or virtual
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connections data that Tableau Cloud can't reach directly, use Tableau Bridge instead. For
more information, see Set Up a Bridge Refresh Schedule.
To initiate refresh jobs using a script, use tabcmd refreshextracts or REST API Run Extract
Refresh Task.

Before you run the utility
When an extract refresh or append data is performed on extracts created in Tableau 10.4
and earlier (that is, a .tde extract), the extract is upgraded to .hyper extract automatically.
While there are many benefits of upgrading to a .hyper extract, you will be unable to open the
extract with previous versions of Tableau Desktop.
For more information, see Extract Upgrade to .hyper Format.

Run the utility
1. Open the Command Prompt as an administrator and change to the Tableau Desktop
bin directory. For example:
cd C:\Program Files\Tableau\Tableau Current\bin
2. Use either of the following commands, adding parameters described in the tables
below.
l

tableau refreshextract

l

tableau addfiletoextract

Note: When using the utility, always specify tableau on the command line or in
scripts, never tableau.exe.
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Note: To troubleshoot, check the logs in the tableaucom.txt file in the \My Tableau
Repository\Logs folder.

Note: In a multiple-site environment, specify the site to which the command applies.

Syntax and parameters for the tableau refreshextract command
Use tableau refreshextract to refresh an extract on Tableau Server or Tableau
Cloud. Refreshing an extract updates an existing extract with any modifications that have
been made to the data source since the last refresh.
To see help for this command, at the Windows command prompt, type the following command:

tableau help refreshextract

Using parameters
l

All options have a full form that you use with a double hyphen (for example, -server).

l

Some options also have a short form that you use with a single hyphen (for example,
-s).
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If the value for an option contains spaces, enclose it in quotation marks.

l

The source being refreshed must be the original data source, not a .tde.
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tableau refreshextract command options
Short Form

Full Form

Description

--source-

A valid user name for the data source connection.

username
<user name>

Use this option with --source-password, or use
--original-file instead of the user name and
password options.

Note: You must provide the user name and
password when refreshing a published extract,
even if the data source was originally published
with embedded credentials.

--source-

The password for the data source user.

password
"<password>"
--original-

Path and file name for the data source to be

file <path

refreshed on the server. For example: --ori-

and file

ginal-file c:\folder\file.csv

name>
To refresh a multi-file data source, pass the path to
or

a folder that contains the data files. For example: -original-file c:\folder.

--originalfile <path

If the file is on a network share, use the UNC format

and folder

for the path: \\server\path\filename.csv

name>
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If the data source is set up for incremental

full-refresh

refreshes, use this option to force a full extract
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refresh. If this option is not included, an incremental
refresh is performed. Not all data sources support
incremental refresh.
-s

--server

The URL for the Tableau server on which the data is

<server

<URL>

published.

http
For Tableau Cloud, specify https://on-

address>

line.tableau.com.
-t <site

--site

In a multiple-site environment, specifies the site to

id>

<siteid>

which the command applies. For Tableau Cloud,
use this argument if your username is associated
with more than one site. For Tableau Server, if you
do not specify a site, the default site is assumed.
The site id is independent of the site name, and it is
indicated in the URL when you view the site in a
browser. For example, if the URL for the page you
see after signing in to Tableau Cloud is
https://online.tableau.com/t/vernazza/views
the site id is vernazza.

--datasource

The name of the data source, as published to

<datasource>

Tableau Server or Tableau Cloud.

--project

The project to which the data source belongs. If this

<pro-

option is not included, the default project is

jectname>

assumed.
If the project you want to specify is a child project
nested within a project hierarchy, you must use this
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parameter along with the --parent-projectpath parameter.
--parent-pro- If a project to which the data source is published is
ject-path
not at the top level of a project hierarchy, use this
path/to/-

parameter along with the --project parameter to

project

specify the path to a nested project.
Use the forward slash character (/) to delimit project levels in the hierarchy. Use the backward slash
(\), to escape instances of forward or backward
slash characters in project names.
For example, for a project named Sandbox, in project Social, under top-level Marketing:
--project Sandbox --parent-projectpath Marketing/Social

-u <user

--username

name>

<username>

-p "<pass-

--password

The password for the specified Tableau Server or

word>"

"<password>"

Tableau Cloud user.

Valid Tableau Server or Tableau Cloud user.

--proxy-user- The user name for a proxy server.
name <username>
--proxy-pass- The password for a proxy server.
word "<password>"
-c "<path

--config-

Path and file name information for a file containing

and file

file "<path

configuration options for the command. Always
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name>"

and file

enclose the path in double quotation marks. For

name>"

more information, see Using a config file below.

Sample tableau refreshextract command
The following command refreshes an extract named CurrentYrOverYrStats that has been
published to Tableau Cloud. This command specifies the following:
l
l
l

Tableau Cloud user and password.
Tableau Cloud site and project names.
The data source, which in this case is hosted by a cloud-based data source provider
(for example, Salesforce.com), and the username and password to sign in to the hosted data source.

C:\Program Files\Tableau\Tableau Current\bin>tableau
refreshextract --server https://online.tableau.com --username email@domain.com --password "OurServerPwd" --site vernazza --project "New Animations" --datasource
"CurrentYrOverYrStats" --source-username database_user@hosted_datasource_provider.com --source-password "db_password"

To refresh an extract of file-based data source, provide the path to the original file from
which you created the extract. If the file is on a network share, use the UNC format instead
of a mapped drive.

C:\Program Files\Tableau\Tableau Current\bin>tableau
refreshextract --server https://online.tableau.com --username email@domain.com --password "OurServerPwd" --site vernazza --project "New Animations" --datasource
"CurrentYrOverYrStats" --original-file "\\server\path\filename.csv"
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Syntax for tableau addfiletoextract
Use tableau addfiletoextract to append file content to an extract that has been
published to Tableau Server or Tableau Cloud. This command combines the two files.
If you want simply to update an existing extract with the latest changes, use the refreshextract command instead. Using addfiletoextract to update an existing extract will
duplicate data instead.
To see help for this command, at the Windows command prompt, type the following command:

tableau help addfiletoextract

All options have a full form that you use with a double hyphen (for example, --server).
Some options also have a short form that you use with a single hyphen (for example, -s). If
the value for an option contains spaces, enclose it in quotation marks.

tableau addfiletoextract command options
Short Form

Full Form

Description

--file <path

Path and file name information for the data file

and file name>

containing data to append. The file can be
from Excel, Access, a Tableau data extract, or
a delimited text file. It cannot be password protected. Use UNC format if the file is on a network share. For example,
\\server\path\filename.csv

-s <server
http

--server <URL>

The URL for the Tableau server on which the
data is published.

address>
For Tableau Cloud, specify https://on-

Tableau Software

819

Tableau Cloud Help
line.tableau.com.
-t <site id>

--site <site

In a multiple-site environment, specifies the

id>

site to which the command applies. For
Tableau Cloud, you must include this argument if your username is associated with
more than one site. For Tableau Server, if you
do not specify a site, the default site is
assumed.

--datasource

The name of the data source, as published to

<datasource>

Tableau Server or Tableau Cloud.

--project <pro-

The project to which the data source belongs.

jectname>

If this option is not included, the default project
is assumed.
If the project you want to specify is a child project nested within a project hierarchy, you
must use this parameter along with the -parent-project-path parameter.

--parent-pro-

If a project to which the data source is pub-

ject-path

lished is not at the top level of a project hier-

path/to/project

archy, use this parameter along with the -project parameter to specify the path to a
nested project.
Use the forward slash character (/) to delimit
project levels in the hierarchy. Use the backward slash (\), to escape instances of forward or backward slash characters in project
names.
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For example, for a project named Sandbox, in
project Social, under top-level Marketing:
--project Sandbox --parent-project-path Marketing/Social
-u <user-

--username

name>

<username>

-p "<pass-

--password

The password for the specified Tableau

word>"

"<password>"

Server or Tableau Cloud user.

--proxy-user-

The user name for a proxy server.

Valid Tableau Server or Tableau Cloud user.

name <username>
--proxy-pass-

The password for a proxy server.

word "<password>"
-c "<path

--config-file

and file-

"<path and file- taining configuration options for the comname>"
mand. Always enclose the path in double

name>"

Path and file name information for a file con-

quotation marks. For more information, see
Using a config file below.

Sample tableau addfiletoextract command
C:\Program Files\Tableau\Tableau Current\bin>tableau addfiletoextract --server https://online.tableau.com --username email@domain.com --password "OurServerPwd" --site
vernazza --project "New Animations" --datasource "CurrentYrOverYrStats" --file "C:\Users\user2\Documents\DataUploadFiles\AprMay.csv"
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Using a config file
You can use a plain text editor, such as Notepad or Text Edit, to create a config
(configuration) file that you can use with tableau refreshextract or tableau addfiletoextract. A config file can be useful if you expect to update the same data source
regularly over time. Instead of having to type the same options each time you run a command, you specify the config file. A config file also has the advantage of not exposing user
names and passwords on the command line.

Create the config file
For example, say you created a file called config.txt and saved it to your Documents folder.
And in the file, you included the parameter information shown below.
For an extract from a hosted data source, published to Tableau Cloud, where server is
https://online.tableau.com:

server=https://online.tableau.com
site=vernazza
username=email@domain.com
password=OurPassword
project=New Animations
datasource=CurrentYrOverYrStats
source-username=database_user@hosted_datasource_provider.com
source-password=db_password

Reference the Config File from the Command Line
After you create the config file, you run the tableau refreshextract or tableau
addfiletoextract command, pointing to the config file as the only option you use on
the command line, and enclosing the config file’s path in double quotation marks. The syntax is as follows:
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tableau refreshextract --config-file "<path>"
For example, to refresh the extract specified in the sample in the Create the config file section, you would run the following command (making sure that you are working in the bin directory for your version of Tableau Desktop):

C:\Program Files\Tableau\Tableau Current\bin>tableau
refreshextract --config-file "C:\Users\user1\Documents\config.txt"

Syntax Differences for Config Files
The syntax for specifying options inside a config file differs from the syntax you use on the
command line in the following ways:
l
l
l

Option names do not begin with dashes or hyphens.
You use an equals sign (with no spaces) to separate option names from option values.
Quotation marks are not necessary (or allowed) around values, even when they
include spaces (as for the project option in the example shown earlier).

Use Windows Task Scheduler to Refresh Extracts
You can use Windows Task Scheduler, in combination with the Tableau Data Extract Command-Line Utility, to automate regular updates to Tableau Cloud data sources from within
your corporate firewall. You can configure a task to occur once per day, week, or month, or
after a specific system event. For example, run the task when the computer starts.
To learn more, see the Task Scheduler How To... page in the Microsoft TechNet library.

Set Up for Data-Driven Alerts
When data reaches important thresholds for your business, data-driven alerts automatically
send email notifications to key people that users specify. As a Tableau Cloud administrator,
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you set up data-driven alerts much like you do subscriptions. For information about how
users create and manage these alerts, see Send Data-Driven Alerts in Tableau User Help.

Manage all data-driven alerts in a site
1. At the top the browser window, click Tasks, and then click Alerts.
2. Select any alerts you want to update.
3. From the Actions menu, do any of the following:
l

Add or remove yourself as a recipient.

l

Edit alerts to change data thresholds, delivery schedules, and the full list of
recipients.

l

Change alert ownership to different users, or delete alerts.

Disable data-driven alerts for a site
Data-driven alerts are supported for all sites by default, but administrators can disable them
for specific sites.
1. While viewing a site, click Settings on the left side navigation pane.
2. Under Data-Driven Alerts, untick Let users create alerts and receive alert
emails.
3. Click Save.

Suspend data-driven alerts
Resume suspended alerts
If an alert fails enough times, you'll receive a notification email that your alert has been suspended. There are a few ways that administrators or alert owners can resume a suspended

824

Tableau Software

Tableau Cloud Help
alert:
l

From the Tasks > Alerts area of Tableau web pages, an

icon appears in the Last

checked column to indicate that the alert is suspended. Select ... > Resume Alert to
resume the alert.
l

Click Resume Alert in the notification email to resume the alert. A notification will
either allow you to resume the alert, or indicate that the view has changed and the
alert should be deleted.

l

From the Alerts panel of the affected view or workbook. To resume the alert from a
view or workbook, select Alert to open the Alerts panel. An icon appears next to the
suspended alert. Select Actions > Resume Alert on the affected alert to resume.

Alert owners will receive an email notification when the alert is working again.

Identify and fix failing alerts
As an administrator, you can proactively identify failing alerts that users may be unaware of.
To check:
1. Select Status in your site menu
2. Select Background tasks for non-extracts
3. From the Task drop-down menu, select Check if Data Alert is True
4. On the far right, click on Error to see a list of failing alerts
5. Hover over the red failure icon to display a tooltip with alert details
To determine the alert owner, look for the alert ID number in the data_alerts table of the
Tableau Cloud Repository. (In the alert management area of a site, you can also look for the
alert name following the number, but be aware that multiple different alerts may use the
same name.)
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Note: Alert owners will be automatically notified when an alert fails ten times. Administrators can customise when alert owners receive notifications.

Failing alerts are often caused by content changes on Tableau Cloud. Encourage users to
recreate alerts if changes like the following occur:
l

A workbook, view, or data field is removed or renamed.

l

Database credentials embedded in workbooks expire. (Alerts require workbooks to
use either embedded credentials, or none at all.)

l
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A data source becomes inaccessible.
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Set Up for Metrics
Metrics are a type of Tableau content that tracks the value of an aggregate measure, such as
sum of sales. Because metrics refresh frequently and display their current value in an easyto-glance format, they are useful for monitoring data. To learn more about how users work
with metrics, see Create and Troubleshoot Metrics.

Ensure that users can create metrics
When metrics are enabled for a site, all users with a Creator or Explorer (can publish) site
role can create metrics, if they have the correct permissions.
Metrics are created from existing views on a Tableau site. To ensure that users can create
metrics on a view, verify that:
l

Users have the Create/Refresh Metrics permission capability for the workbook that the

l

view belongs to. For more information, see Permissions.
The password for the data source is embedded, if it is required. For more information,
see Edit Connections on Tableau Cloud.

Disable metrics for a site
Metrics are enabled on all sites by default. You can disable metrics on a per-site basis.
1. On the site where you want to disable metrics, from the navigation panel, click Settings.
2. Under Metrics Content Type, untick Enable metrics.
3. Click Save.
When you disable the metrics content type, metrics no longer appear on the site. The data
for any existing metrics is retained, but these metrics will no longer refresh. If you re-enable
metrics, these metrics will reappear and resume refreshing.
You can also disable metrics on a specific workbook by denying the Create/Refresh Metrics
permission capability. For more information, see Permissions.
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Manage metrics
Though metrics are created from a view, they are not tied to the view like alerts or subscriptions. This means you can manage metrics similar to how you manage workbooks, by
renaming, moving, tagging, deleting or setting permissions on a metric.
Find metrics to manage either by navigating the project hierarchy or via the following paths.
l
l

To see all metrics on a site: Navigate to the Explore section, then select All Metrics.
To see metrics created from all the views in a workbook: Navigate to the workbook,
then select the Connected Metrics tab.

l

To see metrics created from a single view: Open the view, then select Watch > Met-

rics from the toolbar.

Address failing and suspended metric refreshes
Metric refreshes may fail for one of the following reasons.

l

The connected view was deleted or modified.
Permissions changed for the connected view.
The password for the data source is no longer embedded or is no longer valid.
The metric owner doesn’t have the required site role to refresh the metric. A site role

l

of Creator or Explorer (can publish) is required.
There was a temporary connectivity issue, which will resolve itself.

l
l
l

Note: If the metric refresh is suspended because the owner doesn’t have the required
site role for it to refresh, you won’t be able to resume the refresh unless you change the
owner.

For more information on why metric refreshes fail and what users can do to fix them, see Fix
failing refreshes.
Encourage users to overwrite a metric if the connected view was modified in a way that
caused the refresh to fail, but the view is still available. Users can overwrite a metric by creating a metric with the same name in the same project as the existing metric.
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Resume suspended refreshes
If the cause of the failure is fixed, for example by embedding the correct password for the
data source, you can resume the metric refresh.
1. Locate the affected metric. Metrics with suspended refreshes display the text Refresh
Suspended, instead of the time of last refresh, in grid and list view.
2. On the warning message, click Resume refresh.
Tableau attempts to perform the refresh. If this attempt succeeds, you’ll receive a confirmation, and the refresh will resume on schedule. If the attempt doesn’t succeed, the
refresh remains suspended. You or the metric owner can delete or overwrite the metric, or
keep it to reference historical data.

Monitor metric activity with administrative views
Use the administrative views for Tableau Cloud to monitor metric activity.
To monitor metric refresh activity:
1. From the navigation panel, click Site Status.
2. Select the Background Tasks for Non Extracts dashboard.
3. Filter for the tasks Find Metrics to Update or Update All Metrics on a View. For
more information, see Background Tasks for Non Extracts.

To monitor more metric events, create a custom view using Admin Insights. Connect to the
Admin Insights TS Events data source and use the Event Name dimension to see the following events: Create Metric, Delete Metric, Move Metric From, Move Metric To, and Update
Metric. For more information, see Use Admin Insights to Create Custom Views.

Troubleshoot Refresh Issues
When Tableau Cloud is unable to complete a scheduled refresh, an alert appears to indicate
that the refresh has failed. If a scheduled refresh fails five consecutive times, Tableau Cloud
suspends the refresh. When a refresh is suspended, Tableau Cloud does not try to run it
again until you take an action that attempts to correct the cause of the failure.
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To display an alert that describes the reason the refresh failed, select the notification icon (
) in the upper-right corner of the browser window.

Resolve errors and resume suspended refreshes
To help resolve refresh issues, you can take any of these actions, based on the cause indicated in the alert:
l

Errors related to access token validation or user credentials
To correct these issues, click the Connection Details link in the alert to go to the
Connection tab on the data source page for the data source whose scheduled
failed. On the Connections tab, tick the box next to the data connection, and click Edit
Connection so you can update a user name or password, or select a different
access token. After you update the connection information, Tableau Cloud restarts
the refresh schedule.

If you originally embedded the credentials or other data connection information when
you published the workbook or data source from Tableau Desktop, you can also
republish the workbook or data source. As part of the publishing process, you can
choose to set a new refresh schedule. Otherwise, Tableau Cloud restarts the existing
schedule.
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l

Errors that indicate the database was unreachable
Confirm that the underlying database is online and that you can sign in to access its
data. You can use the Try again link in the alert to restart the refresh schedule.

l

Errors related to Tableau Bridge
To troubleshoot errors related to Bridge, see Troubleshoot Issues with Bridge.

Troubleshoot Subscriptions
"The view snapshot in this email could not be properly
rendered."
If you receive a subscription with this error message, there could be several reasons:
l

Missing credentials: Some views are published with embedded credentials. You
may receive the above error if the embedded credentials are now out-of-date, or if the
view was republished without the embedded credentials.

l

Database temporarily down: If the view has a live database connection and the
database was temporarily down when the subscription was being generated, you
might receive the above error.

Can't see images in email
For images of content to display in a subscription email, users subscribed to views, in addition to View permissions, must also have Download Image/PDF permissions. For more
information, see Permissions.

Can't subscribe
If you can see a view on Tableau Server and it has a subscription icon (

) in the upper right

corner, you can subscribe to it.
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To subscribe to a view, the view you're subscribing to must either have embedded credentials for its data source or not rely on credentials at all. Examples of the latter include a
workbook that connects to an extract that isn't being refreshed, or a workbook whose data
is in a file that was included with the workbook at the time of publishing. Embedding credentials is a step that happens in Tableau Desktop (see the Tableau Help for details).

No subscription icon
It's possible to see a view but be unable to subscribe to it. This can happen :
l

The view uses a live database connection: Views with live database connections,
where you’re prompted for your database credentials when you first click the view,
aren't available for subscription. A subscription includes a view (or workbook), data,
and a schedule. To deliver the data required for the view, Tableau Server either
needs embedded database credentials or data that doesn't require credentials.
Where live database connections are concerned, Tableau Server doesn't have the
credentials, only the individual users do. This is why you can only subscribe to views
that either don’t require credentials or have them embedded.

Missing PDF attachment
You can add a PDF attachment to your subscription if your administrator has it enabled. If
the PDF attachment is missing from your subscription, it might be because the size of the
PDF exceeds the email size limit. In Tableau Cloud, each site has a maximum email size of
2 MB. For details, see Tableau Cloud Site Capacity.

Suspended Subscriptions
By default, a subscription is suspended after 5 consecutive subscription failures.

Resume suspended subscriptions
Subscription owners can resume subscriptions:
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l

from My Subscription tab in Content Settings

l

from the Subscriptions tab per workbook

When a subscription is resumed, the alert failing count goes back to zero. The next evaluation of the subscription will occur at the next scheduled evaluation time.

Can't set subscription frequency to "When Data Refreshes"
You can set subscriptions to run when an extract refreshes if the workbook uses a connection to a published extract. When creating or modifying a subscription, you might not see
a Frequency option if the workbook uses:
l
l
l

An extract refresh through Tableau Bridge
More than one extract refresh
A live data connection

Note: If a workbook's data source contains multiple connections where one connection
is to a published extract and the other connection requires Tableau Bridge, you might be
able to set the subscription frequency to When Data Refreshes. If selected, the subscription will run on the extract refresh, not the Tableau Bridge refresh.

Missing data quality warnings
Data quality warnings are included in subscription emails when:
l

Tableau Server or Tableau Cloud is licensed with Data Management. For more information, see About Data Management.

l
l

Tableau Catalogue is enabled. For more information, see Enable Tableau Catalogue.
In site settings, the tick box under Data Quality Warnings in Subscriptions is selected.

Manage Connection Information
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Edit Connections on Tableau Cloud
Administrators and data source owners can manage a published data source's connection
information. The connection information describes the data source, its owner and how to
access the data. You can embed database credentials in the connection to allow users to
access the data directly or to enable scheduled refreshes for extracts. Alternatively, you can
set the connection so that users are prompted to sign in. You can also change the server
name for cloud-based data.
The data source owner or a site administrator can manage this information directly on the
site. For example, you can update tags or change the data source owner, without having to
republish the data source.
1. On the site that has the data source you want to modify, open the Explore page, then
filter to show All Data Sources.
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If there are a large number of data sources, use filters to narrow the list.

2. Tick the box next to the data source you want to update, and on the Actions menu,
select Edit Connection.
Note: The Edit Connection option is not available for connections to extracts and
file-based data.
3. Update the connection information and click Save.
For connections that support using saved credentials to refresh the data, see Refresh
Data Using Saved Credentials.
4. Refresh the Data Connections page (press F5 or Ctrl+R) for your changes to take
effect.

OAuth Connections
An alternative to storing your sensitive database credentials with Tableau Cloud is to create

Tableau Software

835

Tableau Cloud Help
connections using the OAuth 2.0 standard. The following connectors support OAuth
authentication:

l

Anaplan
Azure Data Lake Storage Gen2, Azure SQL, Azure Synapse
Box
Esri ArcGIS Server
Databricks
Dremio
Dropbox
Google Ads, Google Analytics, Google BigQuery, Google Sheets (deprecated in

l

March 2022)
LinkedIn Sales Navigator

l
l
l
l
l
l
l

l
l
l
l
l
l
l

Marketo
OneDrive
Oracle Eloqua
QuickBooks Online
Salesforce, Salesforce CDP
ServiceNow ITSM
Snowflake

From Tableau, when users sign in to data with a connector that uses OAuth, users are redirected to the authentication provider’s sign-in page. After users provide their credentials and
authorise Tableau to access their data, the authentication provider sends Tableau an
access token that uniquely identifies Tableau and the users. This access token is used to
access data on users' behalf. For more information, see Overview of the OAuth process
below.
Using OAuth-based connections provides the following benefits:
l

Security: Your database credentials are never known to or stored in Tableau Cloud,
and the access token can be used only by Tableau on behalf of users.

l

Convenience: Instead of having to embed your data source ID and password in multiple places, you can use the token provided for a particular data provider for all published workbooks and data sources that access that data provider.
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Note: For live connections to Google BigQuery data, each workbook viewer can
have a unique access token that identifies the user, rather than sharing a single
user name and password credential.

Overview of the OAuth process
The following steps describe a workflow in the Tableau environment that calls the OAuth process.
1. A user takes an action that requires access to a cloud-based data source.
For example, you open a workbook that’s published to Tableau Cloud.
2. Tableau directs the user to the cloud data provider’s sign-in page. The information that
is sent to the data provider identifies Tableau as the requesting site.
3. When the user signs in to the data, the provider prompts the user to confirm their
authorisation for Tableau Cloud to access the data.
4. Upon the user's confirmation, the data provider sends an access token back to
Tableau Cloud.
5. Tableau Cloud presents the workbook and data to the user.

The following user workflows can use the OAuth process:
l

Creating a workbook and connecting to the data source from Tableau Desktop or from
Tableau Cloud.

l

Publishing a data source from Tableau Desktop.
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l

Signing in to a Tableau Cloud site from an approved client, such as Tableau Mobile or
Tableau Desktop.

Note: Tableau Bridge supports OAuth for the authentication of connectors:
Snowflake, Google BigQuery, Google Drive, Salesforce and OneDrive.

Default saved credential connectors
Saved credentials refers to the functionality where Tableau Cloud stores user tokens for
OAuth connections. This allows users to save their OAuth credentials to their user profile on
Tableau Cloud. After they have saved the credentials, they will not be prompted when they
subsequently publish, edit or refresh when accessing the connector.
All supported connectors are listed under Saved Credentials for Data Sources on users’
My Account Settings page on Tableau Cloud. Users manage their saved credentials for
each connector.
Access tokens for data connections

You can embed credentials based on access tokens with data connections, to enable direct
access after the initial authentication process. An access token is valid until a Tableau Cloud
user deletes it, or the data provider revokes it.
It is possible to exceed the number of access tokens your data source provider allows. If
that's the case, when a user creates a new token, the data provider uses length of time
since last access to decide which token to invalidate to make room for the new one.
Access tokens for authentication from approved clients

By default, Tableau Cloud sites allow users to access their sites directly from approved
Tableau clients, after users provide their credentials the first time they sign in. This type of
authentication also uses OAuth access tokens to store the users' credentials securely.
For more information, see Access Sites from Connected Clients.
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Default managed keychain connectors
Managed keychain refers to the functionality where OAuth tokens are generated for Tableau
Cloud by the provider and shared by all users in the same site. When a user first publishes a
data source, Tableau Server prompts the user for the data source credentials. Tableau
Cloud submits the credentials to the data source provider, which returns OAuth tokens for
Tableau Cloud to use on behalf of the user. On subsequent publishing operations, the OAuth
token stored by Tableau Cloud for the same class and username is used so that the user is
not prompted for the OAuth credentials. Should the data source password change, then the
above process is repeated and the old token is replaced by a new token on Tableau Cloud.
Additional OAuth configuration on Tableau Cloud isn't required for the default managed-keychain connectors:
l

Google Analytics, Google BigQuery and Google Sheets (deprecated in March 2022)

l

Salesforce

Configure custom OAuth
Beginning with 2021.2, as a site admin, you can configure a custom OAuth client, for each
OAuth supported data provider (connector), to override the pre-configured OAuth client settings for your site. You might consider configuring a custom OAuth client to support securely
connecting to data that requires unique OAuth clients.
When a custom OAuth client is configured, default configurations are ignored and all new
OAuth credentials created on the site use the custom OAuth client by default.
Important: Existing OAuth credentials established before the custom OAuth client is configured are temporarily usable but both site admins and users must update saved credentials
to help ensure uninterrupted data access.
Step 1: Prepare the OAuth client ID, client secret and redirect URL

Before you can configure the custom OAuth client, you need to collect the information listed
below. After you have this information, you can configure the custom OAuth client for each of
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the OAuth supported connector.
l

OAuth client ID and client secret: First register the OAuth client with the data provider (connector) to retrieve the client ID and client secret generated for Tableau
Cloud. Supported connectors include:

l

Azure Data Lake Storage Gen2, Azure SQL Database, Azure Synapse
Databricks
Dremio
Dropbox
Google Analytics, Google BigQuery, Google Sheets (deprecated in March

l

2022)
Intuit Quickbooks Online

l

Salesforce, Salesforce CDP

l
l
l
l

l

Redirect URL: Note the pod where your Tableau Cloud site is located to ensure you
enter the correct redirect URL during the registration process in Step 2 below. The
redirect URL uses the following format:
https://<your_pod>.online.tableau.com/auth/add_oauth_token
For example, https://us-west-2b.online.tableau.com/auth/add_oauth_token

Note: For more information about pods, see the Tableau Trust page.

Step 2: Register OAuth client ID and client secret

Follow the procedure described below to register the custom OAuth client to your site.
1. Sign in to Tableau Cloud using your site admin credentials and navigate to the Settings page.
2. Under OAuth Clients Registry, click the Add OAuth Client button.
3. Enter the required information, including the information from Step 1 above:
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a. For Connection Type, select a database class value that corresponds to the
connector whose custom OAuth client you want to configure.
b. For Client ID, Client Secret and Redirect URL, enter the information you prepared in Step 1 above.
c. Click the Add OAuth Client button to complete the registration process.

4. (Optional) Repeat step 3 for additional connectors.
5. Click the Save button at the bottom or top of the Settings page to save changes.
Step 3: Validate and update saved credentials

To help ensure uninterrupted data access, you (and your site users) must delete the previous saved credentials and add it again to use the custom OAuth client instead of the default
OAuth client.
1. Navigate to your My Account Settings page.
2. Under Saved Credentials for Data Sources, do the following:
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1. Click Delete next to the existing saved credentials for the connector whose custom OAuth client you configured in Step 2 above.
2. Next to the same connector, click Add and follow the prompts to 1) connect to
the custom OAuth client configured in Step 2 above and 2) save the latest credentials.
Step 4: Notify users to update their saved credentials

Make sure you notify your site users to update their saved credentials for the data provider
whose custom OAuth client you configured in Step 2 above. Site users can use the procedure described in Update saved credentials to update their saved credentials.

Set Up OAuth for Salesforce CDP
Beginning in January 2022, Tableau Cloud supports connecting to and refreshing Salesforce CDP data using the OAuth standard.
To enable OAuth connections to Salesforce CDP data from Tableau Cloud, there are a few
necessary configuration steps that need to be performed in your Salesforce CDP account
and in your Tableau Cloud site.
Requirements
Enabling OAuth for Salesforce CDP requires both a Salesforce CDP admin and Tableau
Cloud site admin.
Summary of steps
Setting up OAuth for Salesforce CDP consists of the following tasks:
1. Configure Salesforce CDP APIs to allow queries to Salesforce CDP data (egress of
data).
2. Create a Salesforce connected app to handle OAuth delegation from Tableau Cloud.
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Step 1: Configure Salesforce CDP APIs

As a Salesforce CDP admin, use the procedure described below to configure the Salesforce
CDP APIs to enable queries to Salesforce CDP data (egress of data). The procedure will
describe how to create two custom Salesforce CDP API scopes, cdpquery and cdpprofile.
1. Log in to Salesforce CDP using the Admin user role for your organisation and do the following:
a. Go to Setup, and search for and select OAuth Custom Scopes.
b. Create two custom scopes named cdpquery and cdpprofile.
2. Sign in to Tableau Cloud as a site admin and do the following:
a. From the browser's address bar, copy the first part of your Tableau Cloud URL,
including the https protocol (for example, https://us-west-2b.online.tableau.com)
b. Replace <tableau_url> in the following authorisation URL with the first part
of your Tableau Cloud that you copied in step a:
https://login.salesforce.com/services/oauth2/authorize?response_
type=token&client_id=3MVG9VeAQy5y3BQVJqaUbFmV5jfrJwz6_
K.i8UWdbF3ZMXdS_59Dz9rxW8QtgNzu3.Otq8eykxq1YJ9yBardP&redirect_urii=https://<tableau_url>/auth/add_oauth_token
For example:
https://login.salesforce.com/services/oauth2/authorize?response_
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type=token&client_id=3MVG9VeAQy5y3BQVJqaUbFmV5jfrJwz6_
K.i8UWdbF3ZMXdS_59Dz9rxW8QtgNzu3.Otq8eykxq1YJ9yBardP&redirect_uri=https://uswest-2b.online.tableau.com/auth/add_oauth_token
c. Copy your version of the authorisation URL and paste it in a web browser.
d. Click Allow when prompted.

Step 2: Create a Salesforce connected app

After creating the Salesforce CDP API scopes, as the Salesforce CDP admin, use the procedure below to create a Salesforce connected app to handle OAuth delegation from
Tableau Cloud.
Note: The following procedure documents the process in Salesforce Lightning. If you are
using the traditional Salesforce interface, the navigation might be different, but the configuration is the same.
1. Back in your Salesforce CDP account, go to Setup, and then search for and select
Connected Apps OAuth usage.
2. Click the Install button next to Salesforce CDP Tableau Prod Connection.
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3. When prompted, click Install to confirm.
4. Click Manage App Policies next to Salesforce CDP Tableau Prod Connection.

5. Scroll down to OAuth Custom Scopes and click Manage OAuth Custom Scopes
6. Select the cdpprofile and cdpquery tick boxes, and then click Save.

When configured, all new Salesforce CDP connections from a Tableau Cloud site use the
Salesforce CDP connected app by default.

Manage Saved Credentials for Data Connections
Saved credentials enable you to connect to a data source without being prompted for your
credentials. The credentials saved for your connection can be OAuth access tokens, or other
credentials, such as user name and password.
On Tableau Cloud, you can manage saved credentials on your Account Settings page.

Note: If you do not see the Saved Credentials section, consult with your site admin
about allowing saving credentials.
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Remove saved credentials
To remove Tableau access to data, delete the associated saved credentials for that data
from your account.
After you delete the credentials, you will need to sign in to the data the next time you access
it. This will create new saved credentials.
Your administrator might choose for all users to use the same shared credentials for connecting to a data source. If this is the case, the saved credential is associated with the data
connection for all users, and it does not appear under Saved Credentials on your Account
Settings page.

Note: If you're a Tableau Server user and can't delete saved credentials, ask your
administrator if they've cleared the Allow users to save data source access tokens
option in the server settings.

Test connections using saved credentials
If the connector supports test functionality, you can test the connection using saved credentials.
1. While you’re signed in to Tableau Server or Tableau Cloud, display your Account Settings page.
2. In the Saved Credentials section, click the Test link next to the stored connection that
you want to test.
This test confirms that Tableau Cloud or Tableau Server can access your account using this
corresponding saved credential. If the test succeeds, but you cannot access your data
through this managed connection, confirm that the credentials you provided for this connection can access your data.
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For example, if you accidentally created the connection using your personal Gmail account,
but you use a different account to access a Google Analytics database, you will need to
delete the saved credentials and sign in to the data using the appropriate Gmail account.

Update saved credentials
To help ensure uninterrupted data access from existing Tableau content after a custom
OAuth client has been configured for your site, we encourage you to update your saved credentials. To update saved credentials, you can delete the previous saved credentials for a
particular connector and then add them again.
When you add saved credentials again, both new and existing Tableau content will access
the data using the custom OAuth client configured by your site admin. For more information
about custom OAuth clients, see OAuth Connections.
1. Sign in to Tableau Server and navigate to your My Account Settings page.
2. Under Saved Credentials for Data Sources, do the following:
1. Click Delete next to the saved credentials for a connector.
2. Next to the same connector, click Add and follow the prompts to 1) connect to
the custom OAuth client that your site admin notified you about and 2) save the
latest credentials.

Clear all saved credentials
When you select Clear All Saved Credentials, the following items are removed from your
user account:
l

All saved credentials for connections that are stored in your account.

Caution: If any of these saved credentials are stored with published workbooks
or data sources, deleting them also removes access to the data source from those
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locations. Effectively, this is like "changing the locks" anywhere the affected
saved credentials are used.

l

Passwords you have used to access published data extracts or workbooks that connect to them.

Create and Interact with Flows on the Web
Starting in version 2020.4, you can create and interact with flows on Tableau Cloud to clean
and prepare your data. Connect to your data, build a new flow or edit an existing flow and
your work is automatically saved every few seconds as you go. Create draft flows that are
only available to you or publish your flow to make it available for others. Run your individual
flows directly from the web or run your flows automatically on a schedule using Tableau
Prep Conductor if Data Management is licensed. For more information, see Tableau Prep
on the Web.

Turn flow web authoring on or off for a site
Note: This setting is only available for Tableau Server. Web authoring is enabled for
Tableau Cloud and cannot be turned off.

1. In a web browser, sign in to the server as an administrator and go to the site in which
you want web authoring to be enabled. In that site, click Settings.
2. In the Web Authoring section, select Flows. Let users edit flows in their
browser. to enable the functionality.
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Clear the tick box to turn off web authoring for that site.
3. If you want the change to take effect immediately, restart the server. Otherwise, the
change takes effect after server session caching expires or the next time users sign in
after signing out.

Enable linked tasks
Supported in Tableau Cloud and Tableau Server version 2021.3 and later.
Use the Linked Tasks option to schedule up to 20 flows to run sequentially, one after the
other. Linked tasks can only be run on schedules with the Linked Tasks option selected. For
more information about setting up linked tasks, see Schedule linked tasks.
Starting in version 2022.1, Linked Tasks is enabled by default on the Server Settings and
for any new flow schedules that you create. In prior versions, administrators must first enable
the option.
If you have multiple sites, you can turn off Linked Tasks for individual sites by clearing the
tick boxes described below.
If the setting is turned off after linked tasks are scheduled, any tasks that are running will complete and the scheduled linked tasks are hidden and no longer show on the Scheduled
Tasks tab.
Enable Linked Tasks (version 2021.4 and earlier)
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable Linked Tasks for flows. In that site, click Settings.
2. In the Linked Tasks section, select Let users schedule linked tasks to enable
administrators to configure schedules to run linked tasks.
3. Select Let users run linked tasks manually using Run Now to enable users to
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run linked flow tasks using Run Now.

Enable flow parameters
Enable users to schedule and run flows that include parameters. Parameters enable users
to scale their flows by building them once, then changing the parameter values to accommodate different data scenarios.
Parameters can be entered in an input step for file name and path, table name or when
using custom SQL queries, in an output step for file name and path and table name, and in
any step type for filters or calculated values.
Flow parameter settings can be applied at the server level to include all sites on Tableau
Server. The settings can be disabled at the site level to include only specific sites.
For more information about using parameters in flows, see Create and Use Parameters in
Flows in the Tableau Prep help.
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable Flow Parameters. In that site, click Settings.
2. In the Flow Parameters section, select Let users run and schedule flows that
use parameters to enable the functionality.
3. Select Allow parameters that can accept any input to enable anyone running the
flow to enter any parameter value in the flow at run time.
Important: Setting this option enables any flow user to enter any value in a parameter, potentially exposing data that the user should not have access to.
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If this option is not selected, users can only select from a predefined list of parameter
values, and any flows that include parameters that accept any value cannot be run or
scheduled to run.

Enable Tableau Prep Conductor
If Data Management is licensed, enable this option to let users schedule and track flows in
Tableau Server and Tableau Cloud. For information about the additional configuration
requirements for Tableau Prep Conductor, see Tableau Prep Conductor.
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable Tableau Prep Conductor. In that site, click Settings.
2. In the Tableau Prep Conductor section, select Let users schedule and monitor
flows to enable the functionality.

Enable Run Now
Control whether users or only administrators can run flows manually using the Run Now
option. Data Management is not required to run flows manually.
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1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable Run Now for flows. In that site, click Settings.
2. In the Run Now section, select Let users run jobs manually using Run Now to
enable the functionality.

Clear the tick box if only Server Administrators can run flows manually.

Flow Subscriptions
Control whether users can receive flow notifications about scheduled tasks for successful
flow runs. Data Management is required to enable notifications.
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable flow subscriptions. In that site, click Settings.
2. In the Flow Subscriptions section, select Let users send or receive emails that
include flow output data to enable the functionality.
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Note: The option to attach either a .csv or .xlsx file type to the email is only available for on-premise environments.

Enable Tableau Prep Extensions
Supported in Tableau Server and Tableau Cloud, starting in version 2021.2.0
Set this option to control whether users can connect to Einstein Discovery to run predictive
models against data in their flow.
You can use Einstein Discovery-powered models to bulk score predictions for the data in
your flow when authoring flows on the web. Predictions can help you make better informed
decisions and take actions to improve your business outcomes.
You'll need to configure additional settings to include predictions in our flow. For more information, see Add Einstein Discovery Predictions to your flow and Configure Einstein Discovery
Integration.
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want to enable Tableau Prep Extensions. In that site, click Settings > Extensions.
2. In the Tableau Prep Extensions section, select Let users connect to Einstein
Discovery to enable the functionality.

Turn autosave off or on
Enabled by default, this feature automatically saves a user's flow work every few seconds.
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While not recommended, administrators can disable autosave on a site using the Tableau
Server REST API method "Update Site" and flowAutoSaveEnabled setting. For more
information, see Tableau Server REST API Site Methods: Update Site. For more information about autosave on the web, see Turn autosave off or on.
For more information about configuring site settings, see Site Settings Reference in the
Tableau Server help.

Tableau Prep on the Web
Internet Explorer 11 on Windows and compatibility mode for Internet Explorer is not supported.
Starting in version 2020.4, Tableau Prep supports web authoring for flows. Now you can
create flows to clean and prepare your data using Tableau Prep Builder, Tableau Server or
Tableau Cloud. You can also manually run flows on the web and the Data Management is
not required.
While most of the same Tableau Prep Builder functionality is also supported on the web,
there are a few differences when creating and working with your flows.
Important: To create and edit flows on the web you must have a Creator licence. Data Management is only required if you want to run your flows on a schedule using Tableau Prep
Conductor. For more information about configuring and using Tableau Prep Conductor,
see Tableau Prep Conductor in the Tableau Server or Tableau Cloud help.

Installation and Deployment
To enable users to create and edit flows on the web, you'll need to configure several settings on your server. For more information about each of these settings, see Create and
Interact with Flows on the Web.
l
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Web Authoring: Controls whether users can create and edit flows on Tableau
Server or Tableau Cloud.
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l

Run Now: Controls whether users or only administrators can run flows manually using
the Run Now option. The Data Management isn't required to run flows manually on
the web.

l

l

l

Tableau Prep Conductor: If Data Management is licensed, enable this option to let
users schedule and track flows.
Tableau Prep Extensions (version 2021.2.0 and later): Controls whether users can
connect to Einstein Discovery to apply and run predictive models against data in their
flow.
Autosave: Enabled by default, this feature automatically saves a user's flow work
every few seconds.

Sample data and processing limits

To maintain performance while working with flows on the web, limits are applied to the
amount of data you can include in a flow.
The following limits apply:

l

When connecting to files, the maximum file size is 1GB.
The data sampling option to include all data is not available. The default sample data

l

limit is 1 million rows.
The maximum number of rows that a user can select when using large data sets is con-

l

figured by the administrator. As a user, you can select the number of rows up to that
l

limit.
In Tableau Cloud, the number of flow runs you can perform in a day is limited by the
site administrator. For more information, see Tableau Cloud Site Capacity.

Available features on the web
When you create and edit flows on the web you may notice a few differences in navigation
and the availability of certain features. While most features are available across all platforms,
some features are limited or not yet supported in Tableau Server or Tableau Cloud. The following table identifies features where differences might apply.
Feature area

Exceptions

Tableau

Tableau

Tableau

Prep

Server

Cloud

Builder
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Connect to Data

Some connectors may not be
supported on the web. Open
the Connect pane on your
server to see supported connectors.

Build and Organise your Flow
Set your data

In Tableau Server and Tableau

sample size

Cloud, the data sample size is
subject to limits set by your
administrator

Union files and

Input unions can't be edited or

database tables

created in Tableau Server or

in the input step

Tableau Cloud. Only in
Tableau Prep Builder.

Clean and
Shape Data
Copy data grid

Available in Tableau Prep

values

Builder and Tableau Server
starting in version 2022.3 and
Tableau Cloud starting in
2022.2 (August)

Aggregate, Join
or Union Data
Use R and

Script steps can't be added

Python Scripts

when creating or editing a flow

in your Flow

in Tableau Cloud. This is currently supported only in
Tableau Prep builder and
Tableau Server.
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Create reusable
flow steps
Automatically
save your flows

Not Applicable

on the web
Automatic file
recovery

Not Applic-

Not Applic-

able

able

View flow output
in Tableau
Desktop
Create an
extract to a file
Create an
extract to a
Microsoft Excel
worksheet
Connect to a
Custom SQL
Query
Create a published data
source
Save flow output
to external databases
Add Einstein Discovery Predictions to your
Flow
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Autosave and working with drafts

When you create or edit flows on the server, your work is automatically saved as a draft
every few seconds so that in the event of a crash, or when closing a tab by accident, you
don't lose your work.
Drafts are saved to the server and project you are signed into. You can't save or publish a
draft to another server, but you can save the flow to another project on that server using the
File > Publish As menu option.

Draft content can only be seen by you until you publish it. If you publish changes and need to
revert them, you can use the Revision History dialog to view and revert to a previously
published version. For more information about saving flows on the web, see Automatically
save your flows on the web.

Publishing flows on the web
Whether you create a flow from scratch on the web or edit an existing flow, before you can
run the flow, you'll need to publish it.
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l

You can only publish draft flows to the same server you are signed into.

l

You can publish a draft to a different project using the File menu and selecting Pub-

l

lish As.
You can embed credentials for your flow's database connections to enable the flow to
run without having to manually enter the credentials when the flow runs.
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Embed credentials

Embedding credentials only applies to running flows on your server. Currently, you will manually need to enter your credentials when editing a flow connected to a database. Embedding
credentials can only be set at the flow level and not at the server or site level.
Do one of the following:
l

From the top menu, select File > Connection Credentials > Embed in Published
Flow.

l

When publishing a flow, select the Embed credentials tick box. This option shows
when you select Publish As to publish the flow to a new project for the first time or
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when you are editing a flow that was last published by someone else.

Publish a flow

When you publish your flow, it becomes the current version of the flow and can be run and
seen by others who have access to your project. Flows that are never published or flow
changes that you make to a draft can only be seen by you until you publish the flow. For
more information about flow statuses, see Automatically save your flows on the web.
To publish your flow, do one of the following:
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l

From the top menu, select File > Publish or File > Publish As

l

From the top bar, click the Publish button or click the drop arrow to select Publish
As.

Who can do this
l

Server Administrator, Site Administrator Creator and Creator allow full connecting and

l

publishing access.
Creator can perform web authoring tasks.
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Create, Interact with, and Embed
Views on the Web
You can create and interact with views on Tableau Cloud. For more information, see the following topics in the Tableau Help for users.
Using Tableau on the Web
Tour your Tableau Site
Edit Views on the Web
Join your Data
Create a Dashboard
Create a Story
Embed Views and Dashboards in Web Pages
Make Workbooks Compatible Between Versions

Alerts and subscriptions
Troubleshoot Subscriptions
Send Data-Driven Alerts from Tableau Cloud or Tableau Server
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Web Authoring and Tableau Desktop Feature
Comparison
For anyone familiar with Tableau Desktop and new to the web authoring environment in
Tableau Server and Tableau Cloud, this topic provides a summary of the web features that
you use similarly to the way you do in Tableau Desktop. It also lists some fundamental differences between the two environments.

Note: This topic summarises core authoring functionality and does not cover every difference between the desktop and web environments.

Features listed by version
For a list of the latest web editing features to be added to each release, see the web authoring sections in What's New in Tableau and What’s New in Tableau Online, or check out the
Release Navigator viz to filter and compare changes by release.

General differences in web authoring
l

Your authoring capabilities are determined by your licence level. For an overview of
what you can do with each licence level, see What can I do with a Tableau site?

l

You can access right-click menu actions on fields in the view, but not on every item in
the workspace.

l

Keyboard shortcuts for web authoring and Tableau Desktop are not the same. For a
list of web authoring keyboard shortcuts, see Shortcuts for web authoring.

Web authoring capabilities
In the web environment, you can connect to data and create workbooks from those data
sources, or data published through Tableau Desktop. You can edit views created on the web
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or published from Tableau Desktop.
Administrators can set at the site level what web authoring abilities users can have.
Explorers can edit workbooks, create new workbooks from published data sources, connect to published data sources and create and edit views, dashboards and stories. Creators
have those same capabilities, but can also create new workbooks, connect to data on the
web and use Ask Data and (in Tableau Cloud) Dashboard Starters to quickly dive into analysis.

Data management
l

Creators: Connect to data sources, upload files (text, excel, and Tableau workbooks), or use pre-built Dashboard Starter templates for certain data sources. For
more information, see Creators: Connect to Data on the Web.

l

Creators: Prepare data on the web in the Data Source page. For more information,
see Creators: Prepare Data on the Web.

Note: There is a limitation on the number of rows that
can be viewed in the Data Source page when authoring data on the web, determined by browser:
l Internet Explorer: 10,000 rows
l Other browsers: 100,000 rows
Independent of browser, the total number of records
(rows by columns) that can be viewed in the Data
Source page on the web is 3 million.

l

Run Initial SQL when connecting with some data sources

l

Relate your data to combine data from multiple tables

l

Join data from different tables in the same data source or from different databases using a multi-connection data source
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l

l

Add a join calculation

l

Union data

l

Pivot data

l

Copy values in a grid (Ctrl+C, or Command-C on a Mac)

l

Edit Data Sources

l

Clean data using the Data Interpreter

l

Create a Custom SQL query

Explorers: Connect to published data sources.
l

Blend published data sources.

l

Save a data source (embedded in a published workbook) as a separate, published data source.

l

Change aggregation of measures in the view. Change the default aggregation
of measures in the Data pane.

l

Search for fields in the schema.

l

Duplicate, hide or rename fields.

l

Change the data type of fields.

l

Convert measures to dimensions or vice versa.

l

Convert a discrete field to continuous and vice versa. This option is available for
measures and date dimensions.

l

Assign a geographic role for a field.

l

Create aliases for members of dimensions.
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l

Create and edit groups.

l

Create and edit sets (conditioned sets are not available)

l

Create, edit and remove parameters. Formatting numbers and dates, and
adding comments for the parameter are not supported on the web.

Analytics
l

Create, edit, rename, duplicate and clear sheets (views, dashboards and stories) in a
workbook.

l

Use Ask Data to automatically create views.

l

Use Explain Data to automatically create views.

l

Search for fields in the Data pane with schema search

l

Drag fields to the view, Rows, Columns and different mark types in the Marks card.

l

Use Show Me to create views. Also, from the Data pane, select and drag a field of
interest to the view area to automatically create a ‘Show Me’ view.

l

View underlying data (via tooltips).

l

Viz in Tooltip works in web views, but must be configured in Tableau Desktop. Viz in
Tooltip worksheets can be hidden, the same way you would hide worksheets used in
stories or dashboards.
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l

Actions work in web views, but must be configured in Tableau Desktop.

l

Create and edit calculated fields.

l

Create bins from continuous measures, and edit bins.

l

Create and edit table calculations, and use quick table calculations.

l

Create sets and show set controls. (Note that you cannot create sets from cube data
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sources in web authoring.)
l

Use the Analytics pane to drag reference lines, trend lines and other objects into the
view. Edit reference lines, trend lines and bands. Create and configure reference distributions on a continuous axis. Adding a cluster, and adding and modifying a forecast,
are not supported for the web.

l

Create groups by selecting marks in the view and then clicking Group Members
(paperclip) in the tooltip for that selection. You can also edit existing groups in the Data
pane.

l

Create hierarchies by dragging one dimension onto another in the Data pane. Note:
You can't create hierarchies when fields are already grouped within a folder.

l

Change options for interacting with maps, including enabling or disabling pan and
zoom, or showing map search, the view toolbar or map scale. Users can also map
units.

l

Drill up and down a continuous hierarchy in the view. In a view with a continuous hierarchy, hover near the headers on a continuous axis to display the + and - controls.
Click to drill down or up.

l

Show labels, totals and subtotals.

l

Show, hide and format mark labels

l

Show and hide titles and captions.

l

Show and hide cards for filters and highlighters.

l

Show, hide and resize headers in the view.

l

Swap X and Y axes. Resize axes in the view.

l

Change the view size.

l

Show and hide the View Toolbar for any view or dashboard.
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l

Duplicate a sheet as a crosstab view.

Filtering and sorting
l

Use data highlighting.

l

Add, edit, and remove filters, and edit filter control layouts.

Note: There is a limitation on the number of results that
can be filtered when authoring data on Tableau
Cloud or Tableau Server. Only the first 100 results
are returned to limit the performance impact one
user has when loading a large domain on the server.

l

Filter across published data sources.

l

Apply filters to multiple sheets

l

Create context filters (Add to Context option in the Filters shelf) and dependent filters (Only Relevant Values option in a filter control shown in a view).

l

Apply table calculation filters to totals in the view.

l

Show hidden fields, and exclude or remove fields from the view.

l

Sort fields in the view in ascending or descending order. Access the Sort dialog box
by right-clicking a dimension on the Rows or Columns shelf. Nested sorting on dimension values within the context of each pane.

l

Drag and drop headers to create a custom sort order within a view.

Formatting
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l

Resize the width of row headers and the height of column headers.

l

Edit workbook formatting, including formatting lines.
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l

Edit worksheet and dashboard titles.

l

Edit axes (double-click an axis in the view). Other options available: Synchronise
dual axes, clearing the axis range (Reset), and tick mark settings. Enable or disable
Dual axis in a field context menu (right-click a measure field on Rows or Columns
shelf). Logarithmic scales can be positive or symmetric (includes 0 and negative values).

l

Edit number formatting (decimal places, percentage, thousands separator, units and
currency).

l

Create, edit, move and resize point, mark, and area annotations.

l

Add and edit dashboards objects, including: horizontal and vertical layout containers,
text, images, navigation buttons, web page links and dashboard extensions.

l

Create transparent worksheet backgrounds (set background colour to None). Combine transparent worksheets with transparent filters, highlighters and parameters.

l

Change the colour palette. For categorical fields you can assign specific colours and
custom colours (using a hex code) to data items. For continuous fields, you can set custom colours for start and end colours (using a hex code).

l

Create, rearrange, and preview device-specific dashboard layouts

l

Set a dashboard item's exact size, position and spacing.

l

Add padding, borders and background colours around items in dashboards.

l

Select a background map in map views.

l

Legends per measure. If you create separate colour legends for the measures in your
view, Tableau assigns the default colour palette to each new colour legend. To
change the colour legend for each measure, click the drop-down arrow on the colour
legend to open the Edit Coloursdialog box and select the palette that you want to
use. For more details, see Legends per measure.
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Related topics
What can I do with a Tableau site?
Set a Site’s Web Authoring Access
Getting Started with Web Authoring
Creators: Connect to Data on the Web
Creators: Prepare your Data on the Web
Build Views on the Web
Grant Web Edit, Save and Download Permissions

Set a Site’s Web Authoring Access and Functions
Tableau Server administrators can specify at the site level whether to allow users to edit
published views in the web environment and configure other web authoring functionality.
By default web authoring functionality is enabled for all sites. Users with the Web Edit capability can create and edit workbooks directly on the server. Turn off web authoring if you
want users to be able to view and interact with published workbooks but not make any
changes to the core information.
The steps below describe how to set web authoring and other associated functionality for
an entire site. For more granular control over which users can use web editing, you can use
projects, groups, and permissions. See Set Web Edit, Save and Download Access on Content.
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For information about how to enable authoring for flows on the web, see Create and Interact
with Flows on the Web.

Turn web authoring on or off for a site
Note: This setting is only available for Tableau Server. Web authoring is enabled for
Tableau Cloud and cannot be turned off.

1. In a web browser, sign in to the server as an administrator and go to the site in which
you want web authoring to be enabled. In that site, click Settings.
2. In the Web Authoring section, select Workbooks. Let users edit workbooks in
their browser. to enable the functionality.
Clear the tick box to turn off web authoring for that site.

3. If your site is already in production, and you want the change to take effect immediately, restart the server.
Otherwise, the change takes effect after server session caching expires or the next
time users sign in after signing out.

Notes
l

When you enable web authoring, make sure that, on the appropriate workbooks or
views, the permission rule for a user or group allows the Web Edit capability.

l

If you turn off web authoring on a production site and do not complete the last step to
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restart the server, users might continue to have authoring access until their session
caches expire or they sign out.

See which sites allow web authoring
To confirm which sites allow web authoring, on the site-selection menu at the top, select
Manage All Sites, and then go to the Sites page.

Configure cross-database join options
To improve performance for cross-database joins, users can allow Tableau to perform the
join using the live database they are connected to instead of using Hyper. While this option
is faster, if Tableau uses the connected database to perform the join, data from the file data
source that the user is connected to is temporarily moved into temp tables in the database.
Because this moves data outside of Tableau, as an administrator you may want to restrict
access to this feature for users with web authoring permissions.
1. In a web browser, sign in to the server as an administrator and go to the site in which
you want web authoring to be enabled. In that site, click Settings.

2. In the Cross-Database Joins setting, select one of the following options:
l Use Tableau or existing databases – Select this option if you want to allow
users to choose whether they want to allow Tableau to use the live database to
perform cross database joins.
l

Use Tableau only – Select this option to restrict users to use only Hyper to
perform cross data-base joins.
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If you select Use Tableau only, the option to choose how Tableau performs
the cross-database join won't display in the canvas when the user connects to a
supported data source and supported database. For more information about
this feature, see Improve performance for cross-database joins.

Create and Edit Private Content in Personal
Space
Personal Space is a private location for all Explorers and Creators to save or edit when working in a Tableau Site. Content saved in Personal Space can’t be shared with other users but
can be moved to a project when you’re ready for others to see it. Within Personal Space, you
can create a new workbook or save a workbook to Personal Space as a separate copy. You
can also move existing content you own into Personal Space for editing, then move it back to
a project later. Explorers can download workbooks in Personal Space, including all data
included in the workbook.

Privacy in Personal Space
Content saved to your personal space is only visible to you and site administrators. Site
administrators can’t directly access any user’s Personal Space or edit content in someone
else’s Personal Space, but they can view and manage Personal Space workbooks. Personal Space workbooks appear in administrator search results and as a workbook location
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on the Explore page. In addition, the permissions menu is unavailable when a workbook is
in Personal Space because the workbook is private.

Tableau Catalogue and Personal Space
Starting in 2019.3, Tableau Catalog is available with Data Management in Tableau
Server and Tableau Cloud. For more information, see "About Tableau Catalog" in the
Tableau Server or Tableau Cloud Help.

When Tableau Catalogue is enabled in your work environment, the information about workbooks you save in your personal space is indexed by Catalogue. These workbooks are
included in lineage counts. However, only you can see the workbooks. Furthermore, users
who browse through the lineage tool see Permissions required instead of information about
workbooks in your personal space.

Collaboration tools
When a workbook is in Personal Space, some functionality is disabled, including share, metrics, comments, alerts and subscriptions. Existing alerts and subscriptions to you will continue running, but alerts and subscriptions to others will fail, since the content is now private.
Metrics can’t be created in Personal Space but will continue to work if a connected workbook is moved there.
These limitations are removed when the workbook is moved or saved to another location.
For example, if a workbook contains comments and moves to Personal Space, existing comments are hidden. Comments are restored when the workbook is moved to another location.

Extract refreshes in Personal Space
To limit resource consumption, existing extract refreshes continue to run if they’ve been
scheduled, but new extract refreshes can't be scheduled while a workbook is in Personal
Space.
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Find content in Personal Space
You can access Personal Space from the left navigation menu to see all your Personal
Space content or create a new workbook, and can save to Personal Space when creating or
editing a workbook anywhere on the site.

You can also see workbooks in Personal Space from the Explore page when All Workbooks
is selected, and can filter down to Personal Space content.
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Save a workbook to Personal Space
Personal Space works much like a private project for you to save a new or existing workbook from Tableau Cloud or Tableau Server. Workbooks can't be published directly to Personal Space from Tableau Desktop.
To save a workbook to Personal Space:
Select File > Save As.
Under Location, select Personal Space.

Note: Explorers can only save workbooks to Personal Space and may not see a location selection dialog.
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Move workbooks to Personal Space
You can move an existing workbook to Personal Space if you are the owner of the workbook
and there is room in your Personal Space. Personal Space storage limits are set by administrators.
To move a workbook to Personal Space:
l

Select a workbook, then click the Actions drop-down menu.

l

Select Move

l

Under Location, Select Personal Space.

Note: Explorers can only save workbooks to Personal Space and may not see the
Move action or location selection dialog.

For more information, see Perform actions in the Manage Web Content help topic.
When you move an existing workbook or data source to Personal Space, tools like share,
alerts and subscriptions become hidden. Existing extract refreshes continue to run if they’ve
been scheduled, but users can’t schedule new extract refreshes within their Personal Space.
Existing subscriptions and alerts also continue but can’t be edited from Personal Space and
will fail if other users are recipients. Existing connected metrics will continue to refresh, but
the connected view will not be visible to other users.

Move workbooks from Personal Space
When you move a workbook out of Personal Space, collaboration tools like share, alerts and
subscriptions become visible, and any existing comments reappear.
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Create a Tableau Data Story (English Only)
If you've ever written an executive summary of your Tableau dashboard, then you know it
can be time-consuming. It takes time to choose which insights to share, and you have to
rewrite your summaries each time the data is updated. Tableau Data Stories automatically
generates narrative insights within your dashboard, saving time and surfacing relevant
insights. As you explore the vizzes in your dashboard, the stories written by Data Stories
adjust, allowing you to dive deeper into data and identify key insights faster.
From where you're already working in Tableau, you can quickly add the Data Story object
to your dashboard. And you can customise the terms and metrics used in your story so Data
Stories speaks the language used by your business.
Today, you can create a Tableau Data Story in English in both Tableau Desktop and
Tableau Cloud. After you create your story, you can also view your Data Story in Tableau
Mobile.

Understand how Data Stories handles data
To write Data Stories, Tableau uses a cloud-hosted service. When you Add a Tableau Data
Story to a Dashboard, Tableau sends associated worksheet data to Tableau Cloud, in compliance with the security standards outlined in Security in the Cloud. Data Stories can be
written from the Tableau Desktop and Web Authoring experience, Tableau Desktop and
web-based dashboard viewing.

Manage Data Stories for your site
Tableau administrators can choose whether Tableau Data Stories are available for their
site. Data Stories are turned on by default.
1. Sign in to your Tableau site.
2. From the left pane, choose Settings.
3. From the General tab, scroll to the Availability of Data Stories section.
4. Choose whether you want to Turn on or Turn off Data Stories.
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Note: If Data Stories are turned off, turning the feature back on restores Data Stories
that were already in dashboards.

Add a Tableau Data Story to a Dashboard
After you Create a Dashboard, you can add the Data Story object to your dashboard to display insights about your viz that are written in natural language. Today, Tableau Data Stories
are available for English only. There is no data size limit when creating Data Stories.
However, story generation times out after 45 seconds if it’s trying to analyse a lot of data. We
recommend using Data Stories with visualisations that have 1,000 or fewer data points.

Note: Tableau Data Stories opens in a pop-up window, so make sure you allow popups. If you're using full screen mode, Data Stories can open in a new tab.

1. Drag the Data Story object into your Tableau dashboard. If you haven’t already, add
a sheet to your dashboard to use Tableau Data Stories.

2. In the Data Story dialog box, configure your story by first choosing the worksheet to
write about. When you click Next, Tableau sends all associated workbook data to
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Tableau Cloud.
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3. Choose the dimensions and measures to include in your story.
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4. Choose the type of story that best describes your data:

Discrete is best for qualitative values such as names or dates, such as in bar or
column charts.
Continuous is best for quantitative values over time, such as a plotted-in-a-line
chart.
Percent of Whole is best for proportions of a whole, such as a pie chart.
Scatter Plot is best for relationships between numerical values, such as a scatter
plot chart.
5. Click Done.
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To filter your Data Story by clicking different sections on your visualisation, open the menu on
your visualisation and click Use as filter.
After your story is generated, click Settings at the top of your Data Story object for a guided
experience that helps you personalise and contextualise your story. For more information,
see Configure Settings for a Tableau Data Story.

Note: If you experience a discrepancy in your Tableau Data Story (for example, if the
numbers in your story are different from your visualisation), it may be caused by way
your visualisation is set up. Try creating a new visualisation on a different sheet, and
then add a new Data Story with the Use a hidden sheet technique to uncover the underlying issue.

Choose the Right Story Type for Your Tableau Data Story
When you Add a Tableau Data Story to a Dashboard, it’s important to choose the right type
of story for your data. Do you want your story about trends over time? Or do you want your
story about two values that you’re comparing? To help you tell the right story, this topic
describes the different types of stories, including an example of each story type.

Continuous
Continuous stories are best for analysing trends or progress over time.
When you create a continuous story, it includes content for performance, segments, volatility
and trend lines. The story also includes contribution analysis and correlation for stories that
use more than one dimension. To use a continuous story, your worksheet must have:
l
l

1 dimension that has between 1–10 measures
2 dimensions and up to 3 measures

The following example is a continuous story for a line chart that has a single dimension and
multiple measures:
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Discrete
Discrete stories are best for comparing values and understanding the distribution of data in
each value. When you create a discrete story, the story includes content about the distribution and groupings or clusters across the data. And the story includes contribution analysis for worksheets that use multiple dimensions.
Consider using a discrete story when you want to:
l
l
l
l
l

Understand drivers of your key performance indicators (KPIs) in sales reports.
Identify and understand outliers quickly during data discovery.
Identify trends that aren’t easily observable in the visual when performing an audit.
Uncover complex utilisation insights instantly for geographic analysis.
Identify and call out key relationships, for example, between sales and profit.

To use a discrete story, your worksheet must have:
l
l

1 dimension that has between 1–10 measures
2 dimensions and up to 3 measures

The following example is a discrete story for a bar chart that has a single dimension and two
measures:
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Percentage of whole
Percent-of-whole stories are best for pie charts. To use a percent-of-whole story, your worksheet must have:
l
l

1 dimension
1 measure

The following example is a percent-of-whole story that uses a pie chart with a single dimension and a single measure:
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Scatter plot
Scatter plot stories are best for understanding the relationship between two measures.
When you create a scatter plot story, the story includes content about the relationship
(regression) between two measures. And the story includes content about groups (clusters)
within the data, when they exist.
Consider using a scatter plot story when you want to:
l
l
l

Call out relationships between two measures to identify impact (regression analysis).
Identify and understand outliers that are above or below defined thresholds.
Analyse how your data is distributed.

To use a scatter plot story, your worksheet must have:
l
l

1 dimension
2 or 3 measures

Note: When you create your scatter plot story, the first measure you select is treated as
the independent variable and the second measure is the dependent variable.

The following example is a scatter plot story that uses a scatter plot that has a single dimension and two measures:
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Configure Settings for a Tableau Data Story
After you Add a Tableau Data Story to a Dashboard, you can configure and edit your
Tableau Data Story, so it's tailored to your needs – use language specific to your data, specify which analytics are written about and customise how your Tableau Data Story is displayed.

Configure Tableau Data Story Settings: Analytics
Within your Tableau Data Story, you can choose which analytics to write about and when
those analytics are written about. Different types of analytics are available depending on
your story type and how many dimensions and measures your story has. However, analytics
aren't currently supported for scatter plot story types. For more information, see Choose the
Right Story Type for Your Tableau Data Story.
Configure analytics for your story

1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3. In the Data Story dialog box, click the Analytics tab.
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4. Click the switches to turn on different types of analytics.
5. For Segments and Trend line, expand Settings to set thresholds for performing
those analytics.
6. Click Save.
Understand different types of analytics
Correlation

Use Correlation to identify true statistical correlations between two series. If you have
more than two series, then all combinations are analysed for correlations. For example, you
might turn on Correlation to identify when two products are often purchased together.
Clustering

Use Clustering to identify distinct groups of data points (clusters) using a single statistical
analysis. For example, you might turn on Clustering to identify when a product is very popular in a specific geographic region.
Distribution

Use Distribution to rank data points relative to each other using non-statistical observations, such as mean, median, skew, etc. For example, you might turn on Distribution to
identify which product has the highest profit ratio.
Segments

Use Segments to highlight noteworthy changes to data points within a series. First, set the
minimum percentage of change that you want to be written about in a segment. Changes
that fall below your defined threshold aren't written about. For example, if you set your segment threshold for changes that are greater than 60%, then your story doesn't write about a
trough in a time series that features a 30% decrease.
After you’ve set your threshold, choose whether to Apply formatting, and set the minimum percentage of change that you want formatted.
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Trend line

Use Trend line to calculate a linear best fit line and identify data that falls within a defined
percentage of confidence. Data that has high variability has a lower confidence level than
data that's more consistent, and that confidence level affects whether trend lines are written
about. You can use trend lines for stories that have one dimension and one measure, or you
can use trend lines in a drilldown. For more information about drilldowns, see Configure
Tableau Data Story Settings: Narrative.
Set the minimum percentage of confidence for your trend line. If you set your threshold at
95%, but a trend line could be drawn at 90% confidence, then your story doesn't write about
trend lines. After you’ve set your threshold, choose whether to Apply formatting. Then set
the minimum percentage of change that you want formatted.
Tableau Data Stories about trend lines communicate the absolute change over a period. The
story written about your trend line varies depending on the level of verbosity you set for your
story. If your story uses high verbosity, then your story writes about the R-squared value,
which is a statistical concept that quantifies how well your data fits the trend line. For more
information about verbosity settings, see Configure Tableau Data Story Settings: Narrative.
Within the Trend line settings, you can also choose how many periods into the future for
which you want your story to write predictions. When you use predictions, your story uses
the slope and intercept of the trend line to calculate predicted values for future periods. The
confidence of the prediction adds upper and lower bounds to the confidence threshold you
set for trend lines. You can use predictions when your story has at least 30 data points that
are linear.
Volatility

Use Volatility to analyse standard deviations over time. For example, use Volatility when
you want your story to write about values that fall outside the average range for your data.
Break down how analytics are used to generate stories

At this point, you might be wondering how the analytics for different story types work. Let’s
take a look at an example for each story type and break down each sentence in the story.
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Understand analytics for discrete stories

Because continuous stories measure trends over time, Data Stories writes about performance, progression, averages, totals, streaks, volatility, segments and predictions.
The following example of a continuous story is about sales per month:

Example story
l

l

Story breakdown

Average Sales was $47,858 across

The first two sentences use average and

all 48 months.

range functions to write about the average,

The minimum value was $4,520

maximum and minimum values across the

(February 2014) and the maximum

period you’re analysing.

was $118,448 (November 2017).
l

Sales increased by 489% over the

The third sentence is about overall per-

course of the series but ended with a

formance of the measure over the period.

downward trend, decreasing in the

For example, a sentence can be about

final month.

whether sales increased, decreased or
trended differently during a specific period.

l

890

The largest single increase on a per-

The fourth sentence uses progression ana-

centage basis occurred in March

lysis. This sentence writes about the largest

2014 (+1,132%). However, the

increase and decrease based on the meas-

largest single increase on an abso-

ure during the period using both a per-

lute basis occurred in September

centage basis and an absolute basis.
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2014 (+$53,868).
l

Of the three series, the strongest

This sentence is a Correlation insight. This

relationship was between Corporate

type of analytic insight writes about notable

and Home Office, which had a mod-

correlations between different series in your

erate positive correlation, suggesting

data.

that as one (Corporate) increases,
the other (Home Office) generally
does too, or vice versa.
l

Sales experienced cyclicality, repeat-

This sentence is a Segment insight. This

ing each cycle about every 12

type of analytic insight writes about note-

months. There was also a pattern of

worthy increases and decreases over time.

smaller cycles that repeated about
every three months.
l

Sales had a significant positive

peak between October 2014
($31,453) and February 2015
($11,951), rising to $78,629 in
November 2014.
l

The overall linear trend of the

This sentence is a Trend line insight. This

series rose at $902 per month for

type of insight writes about how well trends

an absolute change of $42,394 over

fit your data with a certain percentage of

the course of the series. If this trend

confidence, and trend lines allow you to

continued for the next one month,

make predictions based on historic trends.

Sales is predicted to be about

$69,958.
Understand analytics for discrete stories

Because discrete stories allow you to compare values and understand the distribution of the
data, the story writes about distribution, averages, totals and groupings or clusters across
the data.
The following example of a discrete story is about sales by product:
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Example story
l

l

l

l

l

Story breakdown

Total Sales is $2.3 million across all

The first sentence calculates the total value

17 products.

of your measure.

The Sales of $2.3 million was driven

The second sentence writes about the

by Phones with $330,007, Chairs

dimension drivers. In this example, the

with $328,449 and Storage with

dimension drivers are the products that con-

$223,844.

tributed the most to total sales.

The distribution is positively skewed

The third and fourth sentences analyse the

as the average of $135,129 is

distribution of the data. This analyses the

greater than the median of

averages, medians, concentration of data

$114,880.
Sales is relatively concentrated with

(if any exist), and how the data is skewed.

78% of the total represented by

grouped variables are compared to one

eight of the 17 products (47%).

another.

The top two products combine for

This sentence uses Clustering to write

over a quarter (29%) of overall

about measures that can be grouped. This

Sales.

helps identify whether there are distinct

This helps identify how balanced these

groups that stand out in the data.
l

Phones ($330,007) is more than two The final sentence writes about notable outtimes bigger than the average across liers.
the 17 products.
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Understand analytics for scatter plot stories

Scatter plot story types are best used to understand the relationship between two measures,
and for that reason, scatter plot stories require 2–3 measures. The scatter plot analysis
writes about the relationship (regression) between two measures, and it writes about groups
(clusters) within the data, if they exist.
The following example of a scatter plot story is about profit and sales across a dimension:

Example story
l

l

Story breakdown

As quantity increased and profit

The first two sentences are powered by

increased, sales increased based on

regression analytics. Regression shows

the data provided. Specifically, when

how one measure affects another. Notice

quantity increased by 1, sales

that in the first sentence, the story has iden-

increased by $49.55, and when profit

tified a relationship between profit and

increased by $1.00, sales increased

sales.

by $1.20.
Few customers deviated from this
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general relationship, indicating a
good fit.
l

When organised into groups of sim-

The third sentence is derived from clus-

ilar profit, quantity and sales values,

tering. Clustering analytics tries to identify

one distinct group stands out. There

key groups or clusters across all the vari-

were 651 customers that had values

ables in the data.

of profit between -$6,626 and $1,488,
quantity between 2 and 122 and
sales between $4.83 and $5,690.
l

l

Tamara Chand, Raymond Buch and

The fourth sentence is written about outliers

Sanjit Chand, among others, were
outliers with high profit and sales values. Sean Miller stood out with a low
profit and high sales value.

– values that fall significantly above or below

The minimum value for profit is -

The remaining sentences for scatter plot

$6,626 (Cindy Stewart) and the max-

stories use range and average analysis to

imum value is $8,981 (Tamara

write insights.

the average.

Chand), a difference of $15,608. The
average profit per customer is $361
and the median is $228.
l

The minimum value for quantity is 2
(Anthony O'Donnell) and the maximum value is 150 (Jonathan

Doherty), a difference of 148. The
average quantity per customer is
l

47.76 and the median is 44.
The distribution of sales ranges from
$4.83 (Thais Sissman) to $25,043
(Sean Miller), a difference of

$25,038. The average sales per customer is $2,897 and the median is

$2,256.
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Understand analytics for percentage of whole stories

Percentage of whole story types is best for understanding what part of a whole a dimension
or measure represents.
The following example of a percentage of whole story is about sales by segment:

Example story
l

l

Story breakdown

Total SUM (Sales) is 2.3 million

The first sentence calculates the total value

across all three entities.

of your measure.

The SUM (Sales) of 2.3 million was

The second sentence writes about drivers.

driven by Consumer with 1.2 million,

In this example, the drivers are segments

Corporate with 706,146 and Home

that contributed the most to total sales.

Office with 429,653.
l

The minimum value is 429,653

The final sentence analyses the distribution

(Home Office) and the maximum is

of the data.

1.2 million (Consumer), a difference
of 731,748, averaging 765,734.

Configure Tableau Data Story Settings: Characteristics
Within your Tableau Data Story, you can configure the characteristics settings to give context to your data, so you get more insightful stories. For example, in your story, you can specify that in the context of sales, a higher number is good. But in the context of customer
complaints, a higher number is bad.
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Use dimension and measure characteristics

Your story and number formatting adjust based on what the measure is. By default, your
story writers all measure values as numbers, and your story won't perform any additional
calculations or apply any special rendering rules.
1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3. In the Data Story dialog box, click the Characteristics tab.
4. Configure your formatting, such as number type, decimal places and negative values.
5. Click Save.
Learn more about measure characteristics
Formatting

If values are formatted as Percentages, then the story writes about percentage point differences, rather than percentage changes as a story would for number values. When you
format a number as a Percentage in the Characteristics tab, the Data Story multiplies
the value of the number by 100 to create the percentage that appears in your story.
If values are formatted as Currency, then you can specify your preferred currency. You can
also specify how you want large values (numbers greater than one million) formatted, for
example $1.3 million instead of $1,300,000.00.
For both Numbers and Currency, you can specify how you want large values and negative values to be written about. If you choose to have negative values written about in brackets, you might see nested brackets in your story when the negative value is written about in
a parenthetical phrase.
When you choose Number formatting, you can also specify whether you want numbers
less than or equal to 10 to be spelled out (rather than using a numeral) in your story.
For decimal places, Dynamic is the default option. This means that the story rounds to different decimal places depending on how large or small the number is. If the percentage
value is less than 10, then the number has two decimal places. If the percentage value is
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greater than 10, then the number rounds to the nearest whole number. You can also specify
how many decimal places you want used, which is used consistently throughout your story.
Content

You can assign meaning to larger values. For example, larger values for sales are good, but
larger values for losses are bad.
In addition, you can choose how to aggregate values by sum or average. It’s a best practice
to choose the same aggregation method that you’re using in the viz. For ratio measures,
choose Average and then define the ratio by selecting the component measures of that ratio
measure. Measures that are components of a ratio must be summable.

For cumulative measures (available for continuous stories only), choose Sum and then specify that the measure is already cumulative. Continuous stories write about the total of the
measure across the series.
Sorting

To sort dimension values, click the arrow up/down icon to sort based on the oldest or newest
time values in your dimension.

Note: Sorting dimension values is available only for continuous stories.
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Configure Tableau Data Story Settings: Display
You can configure how the text in your Tableau Data Story is displayed, such as font colour
and size. You can also choose whether your story uses bulleted lists or paragraphs.
Configure the display for your story

1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3.
4.
5.
6.

In the Data Story dialog box, click on the Display tab.
Choose whether you want your story structure to be Bullets or Paragraphs.
Choose your Font Size.
Pick colours to represent good and bad changes (available for continuous stories).

7. Choose whether to use Dynamic Ordering.
8. Choose whether to use a Condensed View.
9. Click Save.
Understand when to use story display settings

To use colour, your story must be continuous. When using colour, you can choose colours
from the palette to represent good changes and bad changes. For your story to know
whether a change is good or bad, you must assign meaning to larger values in the Characteristics tab. For more information, see Configure Tableau Data Story Settings: Characteristics. After you configure your display, the styles and colours are applied in your story
based on thresholds for trend line or segment analytics.
If you turn on Dynamic Ordering, the insights for measures in a story are dynamically
ordered from the best to the worst average value. If you already have an order you want to
maintain, turn off Dynamic Ordering.
If you turn on Condensed View, additional space is removed from your story. This is helpful if you don’t have much extra space in your dashboard or when you have multiple Data
Story objects in a dashboard.
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Configure Tableau Data Story Settings: Drivers
Hypothetically, let’s say your month-over-month sales increased significantly. What drove
that increase in sales? And what might have detracted from (offset) those increased sales?
Setting up drivers in your Data Story can answer those questions.
In Data Stories, drivers contribute towards a total value. Offsetters detract from a total value.
You’ll find insights about drivers and offsetters in discrete and continuous stories. And these
insights make it easy to understand exactly what's going on in the data and why.
Set dimension drivers

1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3. In the Data Story dialog box, click the Drivers tab.
4. From the Dimension Drivers section, select the type of driver that has the greatest
impact on your analysis:
For Count, set the maximum number of contributors and offsetters.
For Individual %, set thresholds for writing about individual contributors and offsetters.
For Cumulative %, set thresholds for writing about contributors and offsetters based
on their collective value.

5. Click Save.
Understand dimension driver types
l

Count specifies the number of entities (contributors and offsetters) called out in your
story. For example, use Count to see the top three contributors and offsetters in your
data.

l

Individual % sets a threshold, and values higher than that threshold are included in
your story. For example, use Individual % to specify that you want to write about only
entities that represent more than 5% of the total value.

l

Cumulative % sets a percentage threshold of the total value that included entities collectively account for. For example, use Cumulative % to specify that you want to write
about the entities that contributed to at least 90% of that total value. In this example,

Tableau Software

899

Tableau Cloud Help
entities are written about in order of magnitude until the cumulative value of those
entities account for 90% of the total value.
Use secondary contributors

To use secondary contributors, you must have a second dimension that isn’t time. When
you use secondary contributors, each driver that is written about also has details about and
drivers for its secondary contributor. For example, if you are analysing store sales, a secondary contributor would be a class within a department. Secondary contributors allow for
deeper analysis. But secondary contributors can also contain a lot of information to fit into a
single sentence in your story.
Set metric drivers

For measures that are composed of other subcategory measures, driver analysis can
explain the impact that each measure had on the top-level value. For example, material
costs and operating costs contribute to total cost.
To use metric drivers, you must have multiple measures for metric analysis. Then, you can
specify the relationships between each measure.
1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3. In the Data Story dialog box, click the Drivers tab.
4. From the Metric Drivers section, first choose the measure that is a subcategory of
another measure.
5. Then, choose the measure that is the primary category.
6. Click Save.
Tip: The verbosity setting also applies to drivers. By changing your story’s verbosity setting,
you can adjust the way insights are written. If you use high verbosity, then you'll see more
information in brackets. If you use low verbosity, then you’ll get a more concisely written
insight about your drivers. For more information, see Configure Tableau Data Story Settings: Narrative.
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Configure Tableau Data Story Settings: Narrative
You can customise the narrative settings of your Tableau Data Story. Specifically, you can
specify the verbosity and level of analytical detail in your story, and you can add terms that
are unique to your data. These settings help you write a story that uses the right language
and speaks to the right level of detail for your dashboard.
Set verbosity

Verbosity specifies the length and analytical detail written in your story. If you choose high,
your story has longer insights, with more analytic analysis. If you choose low, your story is
more concise, with fewer details.
If you allow viewers to change verbosity, viewers of published dashboards can change the
level of verbosity in the Data Story object. This is helpful when your dashboard is used by a
broader audience with viewers who want varying levels of detail from your story.
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Set drilldowns

A drilldown includes two dimensions, and drilldowns describe figures associated with each
dimension of your dashboard.
Let's say you have a dashboard that has monthly sales by product category. Your story is
configured to write about both the Time and Category dimensions. In this case, this story
includes an insight for each Category that describes its performance in and across the Time
dimension.
By setting the maximum number of drilldowns, you can control how many insights are
included in your story. Drilldown insights are also ranked based on the meaning assigned to
the measure characteristics. As the number of drilldowns is reduced, the lowest performing
measures (measures that are assigned a Bad meaning) are eliminated.
Add dimension terms

By adding terms, you can define the way each of your measures and dimensions are
labelled and referenced in your story.
1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3. In the Data Story dialog box, click on the Narrative tab.
4. Expand the dimension to see how it will be written about in both singular and plural
form.
5. Click Add Term to add another variation for your story to use to describe your dimension.
6. Click Save.
Your story uses (at random) the terms you’ve added when writing about a dimension.
Manage measure labels

Similarly to dimensions, you can manage labels used for measures in your story.
1. From the Narrative tab, expand the measure to see its label.
2. Enter the new label that you want used for your measure.
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3. Click Save.

Configure Tableau Data Story Settings: Relationships
The Relationships setting allows you to assign relationships between measures in a
Tableau Data Story that has multiple measures. To configure Relationships, your story must
have one dimension and multiple measures. For more information, see Create Custom
Measure Relationships in Your Tableau Data Story.
There are two types of relationships:
l
l

Actual vs. Benchmark
Current/Most Recent vs. Previous Period

Use Actual vs. Benchmark when you want to know if you’re performing above or below
your performance benchmarks, for example, when performing quota reporting. This type of
relationship is also helpful for identifying data points that require additional analysis because
they’re significantly above or below your benchmark. To use Actual vs. Benchmark, the
measures you’re comparing must have the same value type.
Use Current/Most Recent vs. Previous Period when you want to see if your key performance indicators (KPIs) are increasing, decreasing or remaining consistent over time. To
use Current/Most Recent vs. Previous Period, you must use a discrete story type. For
more information, see Choose the Right Story Type for Your Tableau Data Story.
Additionally, you can use Actual vs. Benchmark and Current/Most Recent vs. Previous
Period relationships simultaneously. Measures in your viz that aren’t part of the configured
relationships are written about in separate paragraphs.
Create Actual vs. Benchmark relationship for continuous or discrete stories

Use the Actual vs. Benchmark relationship when one measure is a benchmark for other
measures. For example, you could compare actual sales to a sales target so your story
writes insights about whether you outperformed or underperformed your goal. When you
use this type of relationship, the story removes unnecessary content and focuses on what's
most important – comparing a metric to its associated benchmark.
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1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3.
4.
5.
6.

In the Data Story dialog box, click the Relationships tab.
Tick the box for Actual vs. Benchmark.
First, select the measure that is the benchmark.
Then, select the measure that you want to compare against the benchmark.

7. Click Save.
Create Current/Most Recent vs. Previous Period relationship

Use the Current/Most Recent vs. Previous Period relationship to compare the performance of two measures over a period. For example, you could compare two products to
see which product generated the most revenue over the last year.
1. Add a Tableau Data Story to a Dashboard.
2. From your dashboard, click on the Settings icon in the top-left corner of your Data
Story object.
3.
4.
5.
6.
7.
8.

In the Data Story dialog box, click the Relationships tab.
Tick the box for Current/Most Recent vs. Previous Period.
First select the measure for the previous period.
Then, select the measure for the current period.
Enter the label for the period that you’re measuring, for example, year.
Choose the number of periods to measure.

9. Click Save.

Customise Your Tableau Data Story
You can use custom language, tailored to your audience, to supplement your Tableau Data
Stories with insights specific to your business. Identify the analytics and data from the Data
Story that matters most to your audience, and use your own language to create the most
impactful story. As with the overall Tableau Data Story, data and variables used in custom
content are dynamic, adjusting along with the dashboard.
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Add your own insights
1. In your Data Story, click Edit to open the Edit dialog box.
2. Find the section you want to write about and click Add Custom Item.

3. Enter your custom text in the field that appears.
4. Click Save.

Add headers and footers
You can insert custom text at the top and bottom of your Data Story. With headers and footers, you can add your own qualitative analysis to stories, include additional explanations of
data trends or append legal and privacy disclaimers.

1. In your Data Story, click Edit to open the Edit dialog box.
2. Click the Show note switch.
3. Enter your custom note.

4. Click Save.
Your note now appears at the top or bottom of your Data Story.
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Add functions
Using a function in your Data Story is a great way to customise your story and find the
insights that are most important to you and your business.
For example, if you want to know the average sum of tourism revenue over a period, select
Average as your function and then designate the measure as SUM (Tourism Inbound). This
returns the average sum of inbound tourism.

1. In your Data Story, click Edit to open the Edit dialog box.
2. Click the menu on the right-hand side of the box and select Add Function.

3. Select a Data Story Function and fill in the required fields.

4. Click Add to Section.
5. Click Save.

The custom content now appears in your Data Story.

Add conditions
For each custom sentence you write, you can add a condition that determines whether the
sentence renders in your Data Story. If the condition is met, the custom sentence appears
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in your story. If the condition isn't met, the custom sentence doesn't appear.
You can apply multiple conditions to each custom sentence, and the conditions can be combined using the Any or All buttons within the Add a condition dialog box.
Conditional statements are most often used with numerical comparisons, but the function
also supports string matching using the equal (=) or not equal (!=) symbols.

1. In your Data Story, click Edit to open the Edit dialog box.
2. Enter your custom sentence.
3. Click the menu on the right-hand side of the box and select Add Condition.
4. Define the custom function to be used to inform the conditional logic. In this example,
the sentence "We have met our quota" appears if the Sum of Tourism Inbound is
greater than 5 trillion.

5. Click Add to Section.
6. Click Save.
The custom sentence now appears in your Data Story only if the conditions are met.

Duplicate custom content
You can easily duplicate custom content added to your Data Story, making it easier to build
different variations of a sentence. We recommend copying a fully built custom sentence
when applying thresholds, building in language variation and creating different logical variations.

1. In your Data Story, click Edit to open the Edit dialog box.
2. Create a custom sentence, complete with functions and conditions, if desired.
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3. In the completed sentence box, Click the menu in the right-hand side of the box and
select Duplicate.

4. Click into your duplicated sentence, update as desired and click Add to Section.
5. Click Save.
When you copy a sentence, all functions and conditional statements also copy over. The
copied bullet appears directly below the original bullet in the same section.

Note: Copied bullets can only be added to the section that the original bullet is in.

Add custom content in drilldown sections
For stories that have two dimensions, each section after the first section is called a drilldown
section. Drilldown sections focus on an individual primary dimension entity (i.e. The Americas in the following example).
Because the drilldown sections have the same content structure, custom content added in
the first section (i.e. Europe) is applied to each additional section (i.e. The Americas). You
can only create or edit content in the first drilldown section.

1. In your Data Story, click Edit to open the Edit dialog box.
2. In the first drilldown section, click Add Custom Item to each entity.
3. Enter your custom content.
4. Click Save.
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Custom content in drilldown sections already has a context variable called Current Category
value (dynamic). This creates a dimension value option called Current Category value
(dynamic), which always represents the section that the drilldown section is about.
Tip: To create content that only appears in a single specific drilldown section, you can use
conditional logic to ensure it only writes where appropriate.

Customise Your Tableau Data Story: Context Variables
Context variables are functions that can be referenced by other functions. In other words,
you can use context variables to nest functions within other functions.
After you define your context variable, it appears as a function that you can use when adding
new functions to your Tableau Data Story.

Note: You can have multiple context variables set for each custom sentence, but you
must define each context variable separately for each piece of custom content.
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Set a context variable

1. In your Data Story, click Edit to open the Edit dialog box.
2. Click Add Custom Item.
3. Click the menu in the right-hand side of your custom content box and select Set context.

4. Click Add context.
5. Name the context variable and click Set Function.
6. Define your custom function and choose a dimension.

7. Click Add to Section.
8. Click back into the sentence where you set your context variable.
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9. Follow the steps to Add functions.

Now your context variable is listed as an option in the Dimension Value drop-down list
when adding your function.
When to use a context variable: reference two or more measures

Let’s say that you want to refer to two or more measures in one analytical sentence in your
Data Story. Without a context variable, we can write a sentence for only one measure at a
time. But if we use a context variable, we can reference more than one measure in one sentence.
To reference two or more measures with a context variable, your Data Story must have:
l
l

1 dimension
2 or more measures

1. In your Data Story, click Edit to open the Edit dialog box.
2. Click Add Custom Item.
3. Click the menu in the right-hand side of your custom content box and select Set context.
4. Click Add context.
5. Name the context variable and click Set Function.
6. Define your custom function and choose a dimension.
7. Click Add to Section.
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8. Click back into the sentence where you set your context variable.
9. Add your first function and fill in the required fields. In this example, we selected
DimensionValueLabel, then chose Country/Region from Dimension and then
country with the highest GDP (our context variable) from Dimension Value.

10. Click Add to Section.
11. Add your second function and fill in the required fields. In this example, we selected
Value, then chose Country/Region from Dimension, SUM(Lending Interest) from
Measure and country with the highest GDP (our context variable) from Dimension
Value.

12. Click Add to Section.
13. Click Save.
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Your Data Story writes a sentence that gives us insight into a secondary measure (Lending
Interest) for the country that we're interested in (the country with the highest GDP).

When to use a context variable: period-over-period analysis

A context variable is helpful when you want to analyse performance over two different periods in your Data Story. You can create a custom sentence that writes about a measure displayed in your drilldown section and compares the measure against different periods, such
as year on year or month on month.
To set up a period-over-period analysis, your Data Story must have:
l

2 dimensions: 1 time period dimension (primary) and 1 non-time period

l

dimension (secondary)
1–3 measures

1. Create your Data Story.
2. In the Fields dialog box, make sure your time period dimension is ordered first and
click Next.

3. In the Story dialog box, select Continuous and click Done.
4. Open the Edit dialog box and select Add Custom Item in the first drilldown area.
5. Create two context variables that represent your time periods. For example, "Current
Quarter" and "Previous Quarter."
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6. Create an increased sentence by adding custom language and functions. The content of this sentence results in "[CurrentDimensionValueLabel] increased [X%] over
the quarter."
7. Type in the function followed by the word "increased" in the custom text box.
8. Add the function that returns the percentage change of your measurement during
your time period.

9. Click Add to Section.
10. Duplicate custom content and create a decreased version by replacing the word
"increased" with "decreased." The functions stay the same.
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11. Add conditions for each sentence so that only one is written, depending on the data.

12. For the increased sentence, set conditions in line with the following example:
Left Argument = Value function
Dimension = Quarter (OrderDate). Select your time period dimension
Measure = SUM (Total Orders). Select the measure you used for the calculation
Dimension Value = Current Quarter. One of the context variables
Filter Dimension Value = Current Region value (dynamic). This is the preset
context variable
Middle Argument = > (greater than)
Right Argument = Value function
Dimension = Quarter (OrderDate). Select your time period dimension
Measure = Total (Total Orders). Select the measure you used for the calculation
Dimension Value = Previous Quarter. One of the context variables
Filter Dimension Value = Current Region value (dynamic). This is the preset
context variable
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13. For the decreased sentence, set the same conditions, but replace the > (greater
than) sign with the < (less than) sign. The right and left arguments remain the same.
14. Click Save, and your Data Story writes a sentence that includes the insights from
analysing the two time periods.

Customise Your Tableau Data Story: Functions
If you’d like to customise your Tableau Data Story with a function, it helps to know what functions you can use, what each function does and what dimensions and measures you’ll need
for each function.
Learn how to Add functions to your Data Story.

Click a letter to see functions that begin with that letter. If no functions start with that letter,
the functions that start with the next letter in the alphabet are shown. You can also press
Ctrl+F (Command-F on a Mac) to open a search box that you can use to search the page
for a specific function.

ABCDEFGHIJKLMNOPQRSTUVWXYZ
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Average
Description: The average value of the given measure.
Syntax: Average(dimension, measure, filterDimensionValue)

Count
Description: The number of dimension values within a given dimension.
Syntax: Count (dimension)

Difference
Description: The difference in measure values between the two provided dimension values.
Syntax: Difference (dimension, measure, firstDimensionValue, secondDimensionValue, filterDimensionValue)

DifferenceFromMean
Description: The difference between the mean and the measure value for the given dimension value.
Syntax: DifferenceFromMean (dimension, measure, firstDimensionValue, filterDimensionValue)

Direction
Description: Language describing the direction (e.g. increase or decrease) between measure values for the two provided dimension values.
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Syntax: Direction (dimension, measure, firstDimensionValue, secondDimensionValue, filterDimensionValue, phrase)

Ending Label
Description: The name of the last period in the series.
Syntax: Label (measure)

EndingValue
Description: The value at the last period in the series for the given measure.
Syntax: EndingValue (measure, filterDimensionValue)

Label
Description: The label for the given measure.
Syntax: Label (measure)

LargestNegativeChangeDifference
Description: The value of the largest negative period-over-period difference, on an absolute
basis, in the given series.
Syntax: LargestNegativeChangeDifference (measure, filterDimensionValue)

LargestNegativeChangeEndingLabel
Description: The name of the ending period for the largest negative period-over-period difference, on an absolute basis, in the given series.
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Syntax: LargestNegativeChangeEndingLabel (measure, filterDimensionValue)

LargestNegativeChangeEndingValue
Description: The ending value of the largest negative period-over-period difference, on an
absolute basis, in the given series.
Syntax: LargestNegativeChangeEndingValue (measure, filterDimensionValue)

LargestNegativeChangePercentDifference
Description: The percentage change of the largest negative period-over-period difference,
on an absolute basis, in the given series.
Syntax: LargestNegativeChangePercentDifference (measure, filterDimensionValue)

LargestNegativeChangeStartingLabel
Description: The name of the starting period for the largest negative period-over-period difference, on an absolute basis, in the given series.
Syntax: LargestNegativeChangeStartingLabel (measure, filterDimensionValue)

LargestNegativeChangeStartingValue
Description: The starting value of the largest negative period-over-period difference, on an
absolute basis, in the given series.
Syntax: LargestNegativeChangeStartingValue (measure, filterDimensionValue)
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LargestNegativePercentChangeDifference
Description: The value of the largest negative period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestNegativePercentChangeDifference (measure, filterDimensionValue)

LargestNegativePercentChangeEndingLabel
Description: The name of the ending period for the largest negative period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestNegativePercentChangeEndingLabel (measure, filterDimensionValue)

LargestNegativePercentChangeEndingValue
Description: The ending value of the largest negative period-over-period difference, on a
percentage basis, in the given series.
Syntax: LargestNegativePercentChangeEndingValue (measure, filterDimensionValue)

LargestNegativePercentChangePercentDifference
Description: The percent change of the largest negative period-over-period difference, on a
percentage basis, in the given series.
Syntax: LargestNegativePercentChangePercentDifference (measure, filterDimensionValue)

LargestNegativePercentChangeStartingLabel
Description: The name of the starting period for the largest negative period-over-period difference, on a percentage basis, in the given series.
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Syntax: LargestNegativePercentChangeStartingLabel(measure, filterDimensionValue)

LargestNegativePercentChangeStartingValue
Description: The starting value of the largest negative period-over-period difference, on a
percentage basis, in the given series.
Syntax: LargestNegativePercentChangeStartingValue (measure, filterDimensionValue)

LargestPositiveChangeDifference
Description: The value of the largest positive period-over-period difference, on an absolute
basis, in the given series.
Syntax: LargestPositiveChangeDifference (measure, filterDimensionValue)

LargestPositiveChangeEndingLabel
Description: The name of the ending period for the largest positive period-over-period difference, on an absolute basis, in the given series.
Syntax: LargestPositiveChangeEndingLabel (measure, filterDimensionValue)

LargestPositiveChangeEndingValue
Description: The ending value of the largest positive period-over-period difference, on an
absolute basis, in the given series.
Syntax: LargestPositiveChangeEndingValue (measure, filterDimensionValue)
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LargestPositiveChangePercentDifference
Description: The percentage change of the largest positive period-over-period difference,
on an absolute basis, in the given series.
Syntax: LargestPositiveChangePercentDifference (measure, filterDimensionValue)

LargestPositiveChangeStartingLabel
Description: The name of the starting period for the largest positive period-over-period difference, on an absolute basis, in the given series.
Syntax: LargestPositiveChangeStartingLabel (measure, filterDimensionValue)

LargestPositiveChangeStartingValue
Description: The starting value of the largest positive period-over-period difference, on an
absolute basis, in the given series.
Syntax: LargestPositiveChangeStartingValue (measure, filterDimensionValue)

LargestPositivePercentChangeDifference
Description: The value of the largest positive period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestPositivePercentChangeDifference (measure, filterDimensionValue)

LargestPositivePercentChangeEndingLabel
Description: The name of the ending period for the largest positive period-over-period difference, on a percentage basis, in the given series.
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Syntax: LargestPositivePercentChangeEndingLabel (measure, filterDimensionValue)

LargestPositivePercentChangeEndingValue
Description: The ending value of the largest positive period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestPositivePercentChangeEndingValue (measure, filterDimensionValue)

LargestPositivePercentChangePercentDifference
Description: The percent change of the largest positive period-over-period difference, on a
percentage basis, in the given series.
Syntax: LargestPositivePercentChangePercentDifference (measure, filterDimensionValue)

LargestPositivePercentChangeStartingLabel
Description: The name of the starting period for the largest positive period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestPositivePercentChangeStartingLabel (measure, filterDimensionValue)

LargestPositivePercentChangeStartingValue
Description: The starting value of the largest positive period-over-period difference, on a percentage basis, in the given series.
Syntax: LargestPositivePercentChangeStartingValue (measure, filterDimensionValue)
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LongestStreakDifference
Description: The difference over the longest streak of consecutive increases or decreases
for the given series.
Syntax: LongestStreakDifference (measure, filterDimensionValue)

LongestStreakDirection
Description: The direction (positive or negative) of the longest streak of consecutive
increases or decreases for the given series.
Syntax: LongestStreakDirection (measure, filterDimensionValue)

LongestStreakEndingLabel
Description: The name of the ending period for the longest streak of consecutive increases
or decreases for the given series.
Syntax: LongestStreakEndingLabel (measure, filterDimensionValue)

LongestStreakEndingValue
Description: The ending value of the longest streak of consecutive increases or decreases
for the given series.
Syntax: LongestStreakEndingValue (measure, filterDimensionValue)

LongestStreakLength
Description: The largest number of periods of consecutive increase or decrease for the
given series.
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Syntax: LongestStreakLength (measure, filterDimensionValue)

LongestStreakPercentDifference
Description: The percent difference over the longest streak of consecutive increases or
decreases for the given series.
Syntax: LongestStreakPercentDifference (measure, filterDimensionValue)

LongestStreakStartingLabel
Description: The name of the starting period for the longest streak of consecutive increases
or decreases for the given series.
Syntax: LongestStreakStartingLabel (measure, filterDimensionValue)

LongestStreakStartingValue
Description: The starting value of the longest streak of consecutive increases or decreases
for the given series.
Syntax: LongestStreakStartingValue (measure, filterDimensionValue)

MaxLabel
Description: The name of the entity with the maximum value for the given measure.
Syntax: MaxLabel (dimension, measure, filterDimensionValue)

MaxValue
Description: The maximum value for the given measure.
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Syntax: MaxValue (measure)

Median
Description: The median value for the given measure.
Syntax: Median (dimension, measure, filterDimensionValue)

MinLabel
Description: The name of the entity with the minimum value for the given measure. Syntax:
MinLabel (dimension, measure, filterDimensionValue)

MinValue
Description: The minimum value for the given measure.
Syntax: MinValue (dimension, measure, filterDimensionValue)

PercentDifference
Description: The percentage difference in measure values between the two provided dimension values.
Syntax: PercentDifference (dimension, measure, firstDimensionValue, secondDimensionValue, filterDimensionValue)

PercentOfWhole
Description: The percentage in measure values for a given dimension value over the total
measure values for that dimension.
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Syntax: PercentOfWhole (dimension, measure, DimensionValue, filterDimensionValue)

PeriodLabel
Description: The name of the nth period in the series, starting at 1.
Syntax: PeriodLabel (index)

PeriodLabelNewest
Description: The name of the nth period in the series, starting at the newest and counting
back.
Syntax: PeriodLabelNewest (index)

PeriodValue
Description: The value of the given measure at the nth period in the series, starting at 1.
Syntax: PeriodValue (measure, index, filterDimensionValue)

PeriodValueNewest
Description: The value of the given measure at the nth period in the series, starting at the
newest and counting back.
Syntax: PeriodValueNewest (measure, index)

Range
Description: The difference between the maximum and minimum values for the given measure.
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Syntax: Range (dimension, measure, filterDimensionValue)

SortAscendingLabel
Description: The entity name of the given measure sorted in descending order at the given
rank (starting at 1).
Syntax: SortAscendingLabel (measure, rank, dimension, filterDimensionValue)

SortAscendingValue
Description: The value of the given measure sorted in ascending order at the given rank
(starting at 1).
Syntax: SortAscendingValue (measure, rank, dimension, filterDimensionValue)

SortDescendingLabel
Description: The entity name of the given measure sorted in descending order at the given
rank (starting at 1).
Syntax: SortDescendingLabel (measure, rank, dimension, filterDimensionValue)

SortDescendingValue
Description: The value of the given measure sorted in descending order at the given rank
(starting at 1).
Syntax: SortDescendingValue (measure, rank, dimension, filterDimensionValue)

StartingLabel
Description: The name of the first period in the series.
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Syntax: StartingLabel()

StartingValue
Description: The value at the first period in the series for the given measure.
Syntax: StartingValue (measure, filterDimensionValue)

StartToFinishDifference
Description: The difference between the values for the first and last periods in the given
series.
Syntax: StartToFinishDifference (measure, filterDimensionValue)

StartToFinishPercentDifference
Description: The percentage difference between the values for the first and last periods in
the given series.
Syntax: StartToFinishPercentDifference (measure, filterDimensionValue)

StdDev
Description: The standard deviation value for the given measure.
Syntax: StdDev (dimension, measure, filterDimensionValue)

Sum
Description: The sum of measure values for the two provided dimension values.
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Syntax: Sum (dimension, measure, firstDimensionValue, secondDimensionValue, filterDimensionValue)

Total
Description: The sum total value for the given measure.
Syntax: Total (dimension, measure, filterDimensionValue)

Value
Description: The metric value for a given dimension, measure and dimension value.
Syntax: Value (dimension, measure, dimension value, filterDimensionValue)

Z-Score
Description: The z-score for the given measure.
Syntax: Z-Score (dimension, measure, firstDimensionValue, filterDimensionValue)

Customise Your Tableau Data Story: Hide and Reorder Content
Customise your Tableau Data Story with the content that is most important to you and your
audience by hiding or reordering content within your story.
Hide content and sections

1. Create your Data Story and click Edit to open the Edit dialog box.
2. Set sections to show or hide by clicking the Show section switch to the on or off position.
3. Hover over the blue box to the right of each individual sentence, and click on the box
to show or hide from view.
4. Click Save.
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Now, only the sentences and sections that are set to Show appear in your Data Story.
Reorder content within a section

1. Create your Data Story and click Edit to open the Edit dialog box.
2. Hover over the left-side menu of the content you want to reorder. Your cursor turns
into a hand icon.
3. Click the item with your cursor and drag it anywhere within the same section.
4. Click Save.

Now, the sentences appear in your Data Story in the order that you set them to.
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Note: Currently, content can only be moved within the same section. Moving entire sections isn't yet supported.

Add More Data to Your Tableau Data Story
Data Stories currently supports stories with two dimensions and one measure, or one
dimension and up to 10 measures. If you'd like to write about data that you don't need to
show on your dashboard, then use a hidden sheet to simplify your dashboard. If you'd like to
add more than two dimensions to your story, then concatenate dimensions or create multiple data stories and stack them.

Use a hidden sheet
If you have data that you want to include in a Tableau Data Story and don't need to show all
the data that drove the insight, you can use a hidden sheet to bring additional measures and
dimensions into your story without cluttering the dashboard.

1. Drag the Data Story object to your dashboard to see which worksheets you can write
about in the Data Story dialog box. In this example, there are two worksheets available to write about.
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2. Bring in another data source, such as "Population", by navigating to the left-hand
menu, selecting Floating and dragging that sheet onto your dashboard.

The Data Story dialog box updates with the new available data source.
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3. Click into Layout and adjust the size to 1 x 1 to hide the sheet but keep the underlying
data in your story.

You can now configure your stories using this hidden sheet.

Note: You may need to deselect additional legend elements to keep the sheet hidden.

Concatenate dimensions
If your data contains three dimensions and one measure and is a Discrete Story, you can
concatenate (link together) two of those dimensions by creating a calculated field.

1. From the worksheet you want to use in your story, click Analysis and select Create
Calculated Field.
2. Name the calculated field and use the following formula to create your calculation,
using the + sign to join the dimensions.
[Dimension 1] + [Dimension 2]

Tip: Drag your dimensions into the Calculated Field box and place them in the formula.
3. Click OK.
4. Drag your new calculated field into the Detail pane to make it accessible in your data
story.
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Stack multiple data stories
Write about more measures and dimensions by creating multiple Data Stories and stacking
them vertically or horizontally on your dashboard.
For example, if you wanted to create a story about actual revenue vs. benchmark revenue,
you could create two different stories – one with the actual revenue and the first benchmark,
and another with the actual revenue and the second benchmark – and compare them.

Add a Pop-up Tableau Data Story to Your Dashboard
You can place a Tableau Data Story in a pop-up window that allows your users to open a
story, read it and then close it when they're done. This is a great way to save space being
used by already-established dashboards or to reduce the amount of clutter and information
on a dashboard.
1. Add a Tableau Data Story to a Dashboard.
2. Set the container to Floating by clicking on the menu and selecting Floating.
Tip: Another way to set the container to Floating is by holding the shift key while dragging
the container onto your dashboard.
3. Navigate to the Layout tab in the left-hand column and set the background colour to
white.
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4. Click on the menu that is associated with your floating container to show its settings,
and select Add Show/Hide Button. This creates an "X" icon that allows you to show
or hide your story.

Note: If your story is selected, your button is partially obscured by the sidebar options
that are part of the Data Story object. Click anywhere outside of the story to reveal the
button.

5. Hover over the "X" icon to show instructions for opening or closing the story. In this
example, you're being prompted to press the Alt key at the same time as you click on
the "X" icon.

6. Collapse the story by clicking the "X" icon at the same time as pressing the key indicated in your prompt.
The story collapses, but the menu remains on the dashboard so that the user can expand
the story when needed. You can move your collapsible, floating story around your dashboard as desired.

Create Custom Measure Relationships in Your Tableau Data
Story
You can create a relationship story in your Tableau Data Story to see how data compares to
another set of data. To build a relationship story, you must have at least two measures and
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one dimension. Data that you'd like to compare is often grouped into one column of data
named something such as "Year" or "Month", with values such as "2022" or "March".
You can Create a Simple Calculated Field to separate "2022" from "2021" (or March from
February) so that you can compare the two time periods in a relationship story.

1. Start in the sheet that you want to use in your Data Story.
2. Click Analysis and select Create a Calculated Field.
3. Create a calculated field such as "Current Period".

Tip: Follow the structure of the calculated field shown here, but substitute your own dimension or measure names (orange text).
4. Create a calculated field such as "Previous Period".

5. Drag the new measures onto the Detail mark.
6. From your dashboard, click the story and add the two new measures into your Data
Story.
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7. From your dashboard, click the Settings icon in the top-left corner of your Data Story
object.
8. In the Data Story dialog box, click the Relationships tab.
9. Set up a relationship story with the two custom measures.
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10. Click Save.
Your story now writes sentences that compare the custom measures.

Refresh Parameters in a Tableau Data Story
If you’ve added a parameter to your dashboard and are using Data Stories, you’ll notice that
clicking the parameter refreshes your visualisation, but not the story. This happens because
the parameter doesn’t refresh the underlying data like a filter does.
To refresh your Tableau Data Story with the parameter data, add a "refresh" button to your
dashboard that updates your story to align with your parameter.
1. Create a new sheet in your workbook.
2. Create a Calculated Field in the new sheet with the following info:
Name: Refresh
Contents: "refresh"

3. Click OK, and then drag the new calculated field (Refresh) onto your new sheet.
4. Right-click in the field and click Show Header to hide the header.
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5. Choose a shape for your button.

6. Return to your dashboard and drag the sheet containing the refresh button onto your
dashboard next to the parameter.
7. Hover over the button, select More Options and click Title to hide the title.
8. Hover over the button and click Use as Filter.

9. Adjust your parameter and then click on the new refresh button. The button updates
your story to align with the parameter.

Use a Table Calculation in a Tableau Data Story
You can use a Table Calculation as a measure in a Tableau Data Story in addition to the
measure that you used to create the table calculation.
1. From the Marks card, click on the right side of your field to open a menu, and click
Quick Table Calculation.
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2. After you create your table calculation, drag it to Measures in the Data pane and
rename it.
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3. Drag your original measure (e.g. Sales) back to the Rows shelf, and then drag your
new calculation (e.g. Sum of Sales) into the Tooltip. Your visualisation may remain
the same, but you now have access to the new measure.
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4. Go to your dashboard and drag the Data Story object onto the dashboard. Both measures appear when creating your story.

Add Web Images Dynamically to Worksheets
At Tableau, we know that images are a powerful tool when analysing data. Imagine that
you're looking at a viz of monthly shoe sales. The data is telling you that you sold more high
heels than wedges, but you can't picture the difference in the two types of shoe. That's
where Image Role comes in. You can dynamically add web images to your worksheets and
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use them in your headers to add visual detail.

Prepare your data source
Image Role can be assigned to discrete dimension fields that contain URLs that point to
web images. To prepare your data, be sure that your image fields meet the requirements
set by Tableau to be assigned an image role:

l

Make sure your URLs navigate to image files with .png, .jpeg or jpg extensions.
Verify that each URL begins with http or https. If a transport protocol isn’t included,

l

Tableau assumes https.
Optimise the number of images used in your data set. Usually, you can load up to 500

l

images per field.
Ensure that each image file is smaller than 128 KB.

l

Note: Depending on the complexity of your viz, Tableau may default to a server-side
render, which limits the number of images to 30 per field. To learn more about complexity settings and server-side rendering, see Configure Client-Side Rendering.

Example data set:
Product Name

Product Image URL

Product Sales

Flats

https://img.example.com/flats.png

12,118

High Heels

https://img.example.com/highheels.png

15,865

Running Shoes

https://img.example.com/runningshoes.png

14,200
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Wedges

https://img.example.com/wedges.png

8,665

Assign an image role to your URLs
After you’ve connected to your data source, you can assign an Image Role to your URLs
from either the Data Source page or on the Data pane in a worksheet.

From the Data Source page:
1. Locate the column that has image URLs.
2. Right-click (control-click on Mac) the icon on the top left of the column and select
Image Role > URL.
The icon changes to an image icon, and your images are ready to use.

From a worksheet:
1. Open a new worksheet.
2. Locate a discrete dimension field that has image URLs.
3. Right-click (control-click on Mac) the dimension field and select Image Role > URL.
The icon changes to an image icon, and your images are ready to use.
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Add images to your visualisations
From your worksheet, drag the Image Role field onto the Rows or Columns shelf. You can
now see images along with their associated data on your viz.

Share your visualisations
You can export your workbooks with images and share them. Be sure that the images used
in your vizzes are available to be viewed by everyone you share your vizzes with. For
example, if you’re using images that are hosted on an internal server behind a firewall, be
sure that everyone you share the viz with has sufficient permissions to access the images.
In this example, users who view the viz while connected to the same server shouldn’t have
any issues seeing the images. But users who export the viz to a PDF on a Tableau Cloud
server may not be able to see the images.
If you export your workbook and your viewer attempts to open it in Tableau 2022.3 or
earlier, your viewer won’t be able to see the images.
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Note: It is a best practice to always align an Image Role field with a text description to
make the content accessible for screen readers and other accessibility software.

Troubleshoot image connections
Sometimes images won't be displayed if you exceed the number of images allowed per field,
have large image files on a complex viz or are viewing the viz on a mobile device. This section helps you troubleshoot those errors.

None of the images are being displayed in my viz

There are too many images in the viz
Depending on the complexity of your viz, you can typically load 500 images per field. If you
have a complex viz, it may default to server-side rendering. With server-side rendering, you
can load 30 images per field.
If you get an error message that there are too many images in the viz, filter out images and
try again.

Tableau couldn't access the images
If you receive broken image icons instead of your images, first confirm that you have sufficient permissions to view the images (or if, for example, they're behind a firewall). Tableau
must be able to access the images, and the images can't require a separate authentication to
view them.
If you're sure that you have permission to view the images and they're within the size requirements, check that web images are enabled on your settings page.
In Tableau Desktop:
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1. From your workbook, click Help in the toolbar.
2. Select Settings and Performance > Set Dashboard Web View Security.
3. Make sure that Enable Web Page Objects and Web Images is ticked.
In Tableau Cloud:
1. From the home page, click Settings.
2. Under general, scroll down and locate Web Page Objects and Web Images.
3. Make sure that Enable Web Page Objects and Web Images is ticked.

Some of the images aren't displaying in my viz

The image file is too large
Each image file must be smaller than 128 KB to render. Check your image file size and try
again.

The image URL must begin with http or https
Each image URL must begin with either http or https. Tableau doesn't currently support
FTP/SMTP calls. Verify your URL format and try again.

The image file must be a URL
An Image Role can be assigned to only URLs that navigate to image files with .png, .jpeg or
.jpg extensions. Verify your URL format and try again.

The image file extension is not supported
An Image Role can be assigned only to URLs that navigate to image files with .png, .jpeg or
.jpg extensions. Currently, Images Role doesn't support URLs that navigate to .svg files.
Verify your URL format and try again.
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The image file contains bad characters
An Image Role can't be assigned to URLs that have the following characters:

<>&\^'

or the following character sequences:

.. \\. \r \n \t

Verify that your URL doesn't contain any of these characters or character sequences and try
again.

The images aren't being displayed outside of my worksheet

The images aren't displaying in Viz in Tooltip
Viz in Tooltip is processed with server-side rendering, which allows you to load up to 30
images per field. Verify that you have fewer than 30 images per field and try again.
For more about server and client-side rendering, see Configure Client-Side Rendering.
For more about using Viz in Tooltip, see Create Views in Tooltips (Viz in Tooltip).

The images aren't being displayed in View Thumbnail
View Thumbnail is processed with server-side rendering, which allows you to load up to 30
images per field. Verify that you have fewer than 30 images per field and try again.
For more about server and client-side rendering, see Configure Client-Side Rendering.

The images aren't being displayed when I export my
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workbook
All exports and export-related features are processed with server-side rendering, which
allows you to load up to 30 images per field. Verify that you have fewer than 30 images per
field and try again.

The images aren't being displayed on a mobile device
Mobile devices have a lower complexity threshold than computers, so the processing is completed through server-side rendering, which allows you to load up to 30 images per field.
Verify that you have fewer than 30 images per field and try again.
You can change the complexity settings on your mobile device. For more info on complexity
thresholds, see Configure the complexity threshold for computers and mobile devices.

Connect to Published Data Sources in Web
Editing
The steps below describe how to connect to published data sources when you’re signed in
to Tableau Server or Tableau Cloud. For details on how to edit workbooks and view on the
web, see Build Views on the Web and Using Tableau on the Web.
For information about how to connect to a published data source from Tableau Desktop,
see Tableau Server or Tableau Online in the Connector Example reference in this help system.

Connect to a published data source in the web editing environment
You can connect to data if you have permissions to create and edit views.
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1. While you’re signed in to your Tableau Server or Tableau Cloud site, select a view to
edit.
2. In editing mode, click the New Data Source icon

.

3. In the Connect to Data Source dialog box, select a published data source from the
list and then click Add.
You can also connect to a published data source when you're creating a new workbook directly on Tableau Server or Tableau Cloud.
1. When you’re signed in to your site, navigate to the Content page and select Data
Sources.
2. In the list of data sources, tick the box next to the one you want to use, and then click
Actions and select New Workbook.

Edit a Published Data Source
Imagine that you’ve published a data source and your team is using the data source across a
number of workbooks. This is a good start, but you have some changes in mind that will
make your data source great. Before you implement these changes, you want to see how
your proposed changes look in Tableau. And most importantly, you need to test your
changes to ensure they won’t negatively impact any existing workbooks that use the data
source.
Editing a published data source allows you to test changes and make improvements to your
data source while maintaining it as a single source of data.

Edit and test changes
Whether you’re creating a new published data source or editing an existing published data
source, you can create joins and edit the schema from the Data Source page without leaving
your browser. Then use the Scratchpad to test your changes, create folders, organise hierarchies and rename fields and aliases before publishing your data source. While editing your
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data source, you’ll have all the same features and functionality that you have when authoring in Tableau Cloud. For more information, see Web Authoring and Tableau Desktop
Feature Comparison.
To edit a published data source:
1. From the Start or Explore page, navigate to the data source you want to edit.
2. Click Edit Data Source.

3. Click the Data Source page to make joins or edit the schema.
4. Click the Scratchpad sheet.
5. From the Data pane, create folders, organise hierarchies, rename fields and their aliases or update metadata that are saved with the published data source.
6. Drag and drop fields onto the scratchpad to make sure your changes are working as
expected.
7. Click Publish.
Just like you can with workbooks, you can also Publish As if you want to make a copy of
the data source.

Note: Personal Spaces don’t support published data sources.

Roll back changes
To revert to the last version of the published data source:
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1. Navigate to the data source that you want to revert.
2. Click File.
3. Choose Revert to Published.

This reverts to the latest published version of that data source.

Understand supported connections
Editing published data sources doesn’t support:
l
l

Tableau Bridge connectors in Tableau Cloud.
Data sources that use embedded passwords in Tableau Cloud and Tableau Server.

Also, the Data Source page isn’t available for published data source connection types that
aren’t supported, including but not limited to .tde and .hyper file types. To see which connection types are supported, see Creators: Connect to Data on the Web.

Learn about permissions
To edit a published data source, you’ll need a Creator licence that has Save or Save As permissions for data sources in the respective folder. For more information, see Permissions.

Edit data sources published by a flow
If you make edits to a data source that was published by a flow, the changes will be overwritten during the next scheduled flow. Instead, edit the data source in the flow. For more
information, see Publish a Flow to Tableau Server or Tableau Cloud.
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Use Dynamic Zone Visibility
Dashboard space is valuable, especially when you want to progressively reveal insights
about data. With Dynamic Zone Visibility, you can hide or reveal zones (tiled or floating dashboard elements) based on the value of a field or parameter. As you interact, zones on your
dashboard appear or disappear. The result is a dynamic dashboard that doesn’t compromise your desired layout.
While you can show or hide objects by clicking a button on a dashboard, Dynamic Zone Visibility allows you to show and hide objects automatically. This is ideal for dashboards that
are used by different user groups. For example, you might want to show different user
groups different zones when they visit your dashboard.
And you can use Dynamic Zone Visibility with Parameter Actions. For example, when a
user clicks a mark on a viz, a previously hidden zone appears. This is ideal for complex dashboards because it allows you to choose when deeper levels of data are revealed.

Supported field types
To be used for Dynamic Zone Visibility, a field or parameter must be:
l
l
l

Boolean.
Single value.
Independent of the viz, meaning the field returns a constant value independent of the
structure of the viz, such as a fixed level of detail (LOD) calculation.

Configure a dynamic dashboard zone
The following example has two sheets that use Superstore data: the first sheet has a bar
chart with Sales by Category, and the second sheet has a bar chart with Sales by Sub-Category. By using Dynamic Zone Visibility, the second sheet is visible only after a mark is
clicked in the Sales by Category zone. This example relies on a boolean calculated field,
which is used as the source field for a parameter action. For the calculation to be used as
the source field for the parameter action, the calculation must be added to the marks card.
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1. From the Sales by Category sheet, create a parameter. In this example, the parameter
Data type must be set to Boolean.
2. From the Sales by Category sheet, create a calculated field. This example uses the following calculation: True

3. On the Sales by Category sheet, drag the calculation that you created to Details on
the marks card.
4. Create a dashboard.
5. Drag the sheet that you always want to be visible onto your dashboard. In our
example, we want Sales by Category to be visible.
6. From your dashboard, click the Sales by Category zone (dashboard object). Then,
from the Worksheet menu on your dashboard, create a parameter action. This
example uses the following Change Parameter action:
The source sheet is set to use the dashboard you created and the Category Sales
sheet.
The Target Parameter is the parameter you created.
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The Source Field is the calculation you created.

7. Drag the Sales by Sub-Category worksheet onto your dashboard.
8. Click the Sales by Category zone. From the upper right corner, click the drop-down
arrow and select Use as Filter.

9. Click the Sales by Sub-Category zone, and then click the Layout tab.
10. Check the box for Control visibility using value.
11. From the drop-down, choose the parameter you created to control zone visibility.

Note: If the option to Control visibility using value doesn’t contain the field you want to
use, be sure that the field is a supported field type.
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Now, when you click a category mark in the Sales by Category zone, the Sales by Sub-Category zone appears in your dashboard.

Explore Dashboards with Data Guide
Have you ever discovered a new Tableau dashboard and wondered what the data means or
how to use it? Or, have you ever published a new dashboard and wished that you could
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include instructions about how to use your dashboard?
Data Guide provides helpful information about a dashboard and insights about the data
behind it. Data Guide allows dashboard creators to provide more explanatory context for
end users – like descriptions and links to resources – directly in the dashboard. And Data
Guide automatically surfaces insights powered by Explain Data and Data Change Radar to
help users find outliers, identify notable data changes and learn about explanations for a
mark. Explain the Viz (powered by Explain Data) identifies outlier measures and potential
key drivers behind them. Data Change Radar (Tableau Cloud only) tracks values in your
dashboard over time and automatically flags values outside of the normal patterns as data
refreshes.
These contextually relevant details can help dashboard users navigate and use new dashboards more easily, allowing users to find insights faster, trust that they’re looking at the
right data, provide context for data and establish confidence in their understanding of the
viz.

Customise Data Guide as an author
1. From your dashboard, click the Edit button.
2. Click Data Guide in the toolbar if Data Guide doesn't open by default.
3. In the Data Guide pane, type a description to help your end users understand the purpose of your dashboard.
4. Click Add link, and enter a descriptive label for your link text and the URL.
5. Click OK.
6. Click a viz (a sheet in the dashboard). Data Guide updates automatically so you can
add a description and additional resources that are relevant to each viz in your dashboard.
7. Type a description, and add links relevant to the viz.
8. Click OK.

Explore Data Guide as a dashboard user
1. From the dashboard, click Data Guide in the toolbar if Data Guide doesn’t open by
default.
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2. Read the description of the dashboard and explore resources provided by the dashboard author.
3. Expand Data in This Dashboard and Detected Outliers to learn more about the
underlying data used in the dashboard.
4. Click into a viz (an object in the dashboard).
5. Read the description of the viz and explore resources provided by the dashboard
author.
6. Expand Data Summary and Detected Outliers to learn more about data in that viz.
7. Expand Notable Data Changes (Tableau Cloud only) to find values outside the expected range that are identified by Data Change Radar.
8. Select a mark, such as a bar on a chart or a region on a map, to see information about
Data in This Mark, Applied Filters, and Explanations for This Mark powered by
Explain Data.
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Explore Data Guide at different levels
Data Guide is closed by default, but you can always open Data Guide in the toolbar. At the
top of the Data Guide pane, you see the name of the dashboard or viz that you selected. As
a dashboard author, you can write descriptions for both the dashboard and for individual
vizzes that make up your dashboard.

Understand dashboard-level details
At the dashboard level, Data Guide:
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l

Displays the dashboard’s name, author and last published date.
Can include a description written by the dashboard author and links to related

l

resources, such as videos or wiki pages.
Lists the data sources used by the dashboard and details about the data, such as

l

which dimensions and measures are used.
Reveals detected outliers in the dashboard that are identified by Explain Data. For

l

more information, see How Explain Data Works.
Identifies values outside expected business patterns using Data Change Radar

l

(Tableau Cloud only). For more information, see Identify Outliers with Data Change

Radar.
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Understand viz-level details
When a user clicks into a specific viz (dashboard object), Data Guide:
l
l

Displays the viz’s name.
Can include a description written by the dashboard author and links to related
resources, such as videos or wiki pages.

962

Tableau Software

Tableau Cloud Help
l

Lists the data sources used by the dashboard, including the dimensions and measures

l

used.
Lists applied filters and data used in the viz, so you can identify how the data is being

l

influenced by filters that users interact with.
Has a summary of the data used in the viz, including the number of data points, sorting

l

details and prefilters that users can't interact with.
Reveals detected outliers in the viz that are identified by Explain Data. For more inform-

l

ation, see Get Started with Explain Data and How Explain Data Works.
Identifies values outside expected business patterns using Data Change Radar
(Tableau Cloud only). For more information, see Identify Notable Data Changes in a

Viz.
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Understand mark-level details
When a user clicks into a mark (such as region on a map), Data Guide:
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l

Displays the name of the mark.
Lists applied filters and data used in the viz, so you know what’s included and what’s

l

excluded.
Reveals detected outliers in the viz that are identified by Explain Data. For more inform-

l

ation, see Get Started with Explain Data and How Explain Data Works.
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Control Data Guide visibility
To choose whether you want Data Guide to be open by default:
1. From the top-right corner, click the drop-down menu next to your name.
2. Click My Account Settings.
3. Click the Settings tab.
4. Tick the box for Show Data Guide to have the Data Guide visible by default when a
workbook is opened.
5. Click Save Changes.

Auto-save Workbooks
In Tableau Cloud, Auto-save saves the edits that you make to a workbook as you work.

How does Auto-save work?
To turn on Auto-save, click Publish to save your workbook to a designated location. After
you publish for the first time, we’ll start to auto-save the changes that you make to a private
draft version of your workbook. When you’re ready to share your changes with others, use
Publish to replace the last published revision with your draft.

Note: Auto-save doesn’t automatically save every type of change, such as specific
types of assets. In these cases, you’ll see a notification that you must Publish to save
your edits.

Workbook file size
Auto-save is available for workbooks that are smaller than 5 MB. You must Publish to
manually save changes for larger workbook files.
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What if multiple users edit the same workbook?
When more than one user works on the same workbook, each user’s edits are associated
with and saved to their own private draft. When you begin to edit a workbook, you'll receive a
notification if the version you're working from has a published revision from another user.
You're then offered a choice to either discard your draft and edit the current revision or to
resume editing your private draft.
Warning: You won't receive a notification if another user publishes a revision after you've
begun your edits to your private draft. If another user publishes their draft before you publish
your version, your changes will overwrite theirs.
You can check the workbook Revision History to see when the workbook was last published. From the revision history, you can choose to Preview a revision or Restore a previous revision. For more information, see Work with Content Revisions.
If you choose to discard your draft to edit the current revision, the draft and associated asset
files that were uploaded are deleted. To retain assets and edits that you made in your private
draft, you can manually incorporate the edits of other users into your private draft. Then, publish the workbook with both sets of changes.

Permissions requirement
Auto-save is available to Creators and Explorers (can publish) with web editing capabilities
at the workbook level. If a user has web editing capabilities at the view level only, Auto-save
won’t be turned on.

Use Relationships for Multi-table Data Analysis
Tables that you drag into this canvas use relationships. Relationships are a flexible way to
combine data for multi-table analysis in Tableau.
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Think of a relationship as a contract between two tables. When you are building a viz with
fields from these tables, Tableau brings in data from these tables using that contract to build
a query with the appropriate joins.
We recommend using relationships as your first approach to combining your data because
it makes data preparation and analysis easier and more intuitive. Use joins only when you
absolutely need to. Learn more about the basics of creating relationships in this 5-minute
video.

Note: The interface for editing relationships shown in this video differs slightly from the
current release but has the same functionality.

Learn more about how relationships work in these Tableau blog posts:
l
l
l

Relationships, part 1: Introducing new data modelling in Tableau
Relationships, part 2: Tips and tricks
Relationships, part 3: Asking questions across multiple related tables

Also see video podcasts on relationships from Action Analytics, such as Why did Tableau
Invent Relationships? Click "Video Podcast" in the Library to see more.

Are you building a new data source and workbook?
Drag a table to the Data Source page canvas to start building your data source.
A data source can be made of a single table that contains all of the dimension and measure
fields you need for analysis...
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Or, you can create a multi-table data source by dragging out more tables and defining their
relationships...
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Watch this 1-minute video about getting started with using relationships.

Note: The interface for editing relationships shown in this video differs slightly from the
current release but has the same functionality.

For more information about using relationships, see Relate Your Data, How Relationships
Differ from Joins, The Tableau Data Model, and Create and define relationships.
For more information on changes to data sources and analysis in Tableau 2020.2, see
What's Changed with Data Sources and Analysis in 2020.2 and Questions about Relationships, the Data Model and Data Sources in 2020.2.

Are you opening an older workbook or data source?
When you open a pre-2020.2 workbook or data source in 2020.2, your data source will
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appear as a single logical table in the canvas, with the name "Migrated Data" or the original
table name. Your data is preserved and you can continue to use the workbook as you did
before.

To see the physical tables that make up the single logical table, double-click that logical table
to open it in the physical layer. You will see its underlying physical tables, including joins and
unions.
For more information on changes to data sources and analysis in Tableau 2020.2, see
What's Changed with Data Sources and Analysis in 2020.2 and Questions about Relationships, the Data Model and Data Sources in 2020.2.

The Tableau Data Model
Every data source that you create in Tableau has a data model. You can think of a data
model as a diagram that tells Tableau how it should query data in the connected database
tables.

Tableau Software

971

Tableau Cloud Help
The tables that you add to the canvas in the Data Source page create the structure of the
data model. A data model can be simple, such as a single table. Or it can be more complex,
with multiple tables that use different combinations of relationships, joins and unions.
The data model has two layers:
l

The default view that you first see in the Data Source page canvas is the logical layer
of the data source. You combine data in the logical layer using relationships (or
noodles). Think of this layer as the Relationships canvas in the Data Source page. For

l

more information, see Use Relationships for Multi-table Data Analysis.
The next layer is the physical layer. You combine data between tables at the physical
layer using joins and unions. Each logical table contains at least one physical table in
this layer. Think of the physical layer as the Join/Union canvas in the Data Source
page. Double-click a logical table to view or add joins and unions.
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Award, Info).

Tableau Software

Tableau Cloud Help

Logical Layer

Physical Layer

Relationships canvas in the Data Source

Join/Union canvas in the Data Source

page

page

Tables that you drag here are called

Tables that you drag here are called phys-

logical tables

ical tables

Logical tables can be related to other

Physical tables can be joined or unioned

logical tables

to other physical tables

Logical tables are like containers for

Double-click a logical table to see its phys-

physical tables

ical tables

Level of detail is at the row level of the

Level of detail is at the row level of merged

logical table

physical tables

Logical tables remain distinct (nor-

Physical tables are merged into a single,

malised), not merged in the data source

flat table that defines the logical table

Layers of the data model
The top-level view that you see of a data source is the logical layer of the data model. You
can also think of it as the Relationships canvas, because you combine tables here using relationships instead of joins.
When you combine data from multiple tables, each table that you drag to the canvas in the
logical layer must have a relationship to another table. You do not need to specify join types
for relationships; during analysis Tableau automatically selects the appropriate join types
based on the fields and context of analysis in the worksheet.
The physical layer of the data model is where you can combine data using joins and unions.
You can only use pivots in this canvas. You can think of it as the Join/Union canvas. In previous versions of Tableau, the physical layer was the only layer in the data model. Each
logical table can contain one or more physical tables.

Tableau Software

973

Tableau Cloud Help
Important: You can still create single-table data sources in Tableau that use joins and unions. The behaviour of single-table analysis in Tableau has not changed. Your upgraded
workbooks will work the same as they did before 2020.2.
Learn more: For related information on combining data using relationships, also see these
topics and blog posts:
l
l
l
l
l
l

How Relationships Differ from Joins
Use Relationships for Multi-table Data Analysis
Relate Your Data
Relationships, part 1: Introducing new data modelling in Tableau
Relationships, part 2: Tips and tricks
Relationships, part 3: Asking questions across multiple related tables

Also see video podcasts on relationships from Action Analytics, such as Why did Tableau
Invent Relationships? Click "Video Podcast" in the Library to see more.

Understanding the data model
In previous versions of Tableau, the data model had only the physical layer. In Tableau
2020.2 and later, the data model has the logical (semantic) layer and a physical layer. This
gives you more options for combining data using schemas to fit your analysis.
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In Tableau 2020.2 and later, a logical layer has been added in the data source. Each logical
table contains physical tables in a physical layer.
In previous versions of Tableau, the data model in your data source consisted of a single,
physical layer where you could specify joins and unions. Tables added to the physical layer
(joined or unioned) create a single, flattened table (denormalised) for analysis.
Previous versions

2020.2 and later

In versions of Tableau before

In 2020.2 and later, the data model has two lay-

2020.2, the data model has only the

ers: the logical layer and the physical layer

physical layer

In Tableau 2020.2, the data model in your data source includes a new semantic layer above
the physical layer – called the logical layer – where you can add multiple tables and relate
them to each other. Tables at the logical layer are not merged in the data source, they remain
distinct (normalised), and maintain their native level of detail.
Logical tables act like containers for merged physical tables. A logical table can contain a
single, physical table. Or it can contain multiple physical tables merged together through joins
or unions.

Build a new model
When you add one or more tables to the logical layer, you are essentially building the data
model for your data source. A data source can be made of a single, logical table or you can
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drag multiple tables to the canvas to create a more complex model.
l

The first table that you drag to the canvas becomes the root table for the data model

l

in your data source.
After you drag out the root table, you can drag out additional tables in any order. You
will need to consider which tables should be related to each other, and the matching

l

field pairs that you define for each relationship.
If you are creating a star schema, it can be helpful to drag the fact table out first, and

l

then relate dimension tables to that table.
Deleting a table in the canvas automatically deletes its related descendants as well. If

l

you delete the root table, all other tables in the model are also removed.
Each relationship must be made of at least one matched pair of fields. Add multiple
field pairs to create a compound relationship. Matched pairs must have the same
data type. Changing the data type in the Data Source page does not change this
requirement. Tableau will still use the data type in the underlying database for quer-

l
l

ies.
Relationships can be based on calculated fields.
You can specify how fields used in the relationships should be compared by using
operators when you define the relationship.

For more information about relationships, see Create and define relationships in Relate
Your Data.
Multi-table model
l

To create a multi-table model, drag tables to the logical layer of the Data Source page
canvas.
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Tables that you drag to the logical layer of the Data Source page canvas must be related to
each other. When you drag additional tables to the logical layer canvas, Tableau automatically attempts to create the relationship based on existing key constraints and matching
fields to define the relationship. If it can't determine the matching fields, you will need to
select them.
If no constraints are detected, a Many-to-many relationship is created and referential integrity is set to Some records match. These default settings are a safe choice and provide the
most a lot of flexibility for your data source. The default settings support full outer joins and
optimise queries by aggregating table data before forming joins during analysis. All column
and row data from each table becomes available for analysis.
You can add more data inside any logical table by double-clicking the table. This opens the
physical layer of the Data Source page canvas. If you need to use joins or unions, you can
drag the tables you want to join or union into the physical layer canvas. The physical tables
are merged in their logical table.
Follow the steps in Create and define relationships to combine multiple tables.
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Single-table model
l

To create a single-table model, drag a table into the logical layer canvas of the Data
Source page. You can then use the fields from that table in the Data pane for analysis.

Single-table model that contains other tables

You can add more data inside the single, logical table by double-clicking the table. This
opens the physical layer of the Data Source page canvas. If you need to use joins or unions,
you can drag the tables you want to join or union into the physical layer canvas. The physical
tables are merged in their logical table.
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This example shows the Book table in the Relationships canvas (logical layer) of the data
source. Double-clicking the Book logical table opens the Join/Union canvas (physical layer).
In this example, the joins merge the Award and Info tables with the Book table. In this case,
the join between Book and Award will be one-to-many, at the level of detail of awards. This
would duplicate measure values for Book and Info. To avoid duplication, you could relate
Award and Info to Book instead of joining them inside of the Book logical table.

Supported data model schemas
The data modelling capabilities introduced to Tableau in 2020.2 are designed to make analysis over common multi-table data scenarios – including star and snowflake data models –
easy. The following types of models are supported in Tableau data sources.
Single-table

Analysis over a single logical table that contains a mixture of dimensions and measures
works just as in Tableau pre-2020.2. You can build a logical table using a combination of
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joins, unions, custom SQL and so on.

Star and snowflake

In enterprise data warehouses, it is common to have data structured in star or snowflake
schemas where measures are contained in a central fact table and dimensions are stored
separately in independent dimension tables. This organisation of data supports many common analysis flows including rollup and drill down.

These models can be directly represented with relationships in the data modelling capabilities available starting with Tableau 2020.2.
Drag the fact table into the model first and then relate the dimension tables to the fact table
(in a star schema) or to other dimension tables (in a snowflake).
Typically, in a well-modelled star or snowflake schema, the relationships between the fact
table and the dimension tables will be many-to-one. If this information is encoded in your
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data warehouse, Tableau will automatically use this to set the relationship’s Performance
Options. If not, you can set this information yourself. For more information, see Optimise
Relationship Queries Using Performance Options.
In a well-modelled star or snowflake schema, every row in the fact table will have a matching
entry in each of the dimension tables. If this is true and captured in your data warehouse
integrity constraints, Tableau will automatically use this information to set the referential integrity setting in Performance Options. If some fact table rows do not have a matching row in a
dimension table (sometimes called “late-arriving dimensions” or “early-arriving facts”),
Tableau will default to retaining all rows when computing measures, but may drop values
when showing dimension headers. For more information, see Optimise Relationship Queries Using Performance Options.
Star and snowflake with measures in more than one table

In some star or snowflake schemas, all the measures for your analysis are contained in the
fact table. However, it is often true that additional measures of interest may be related to the
dimension tables in your analysis. Even if the dimension tables do not contain measures, it is
common in analysis to want to count or otherwise aggregate dimension values. In these
cases, the distinction between fact tables and dimension tables is less clear. To create clarity
when viewing your data model, we recommended adding the finest grain table to the data
source canvas first, and then relating all other tables to that first table.
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If you were to join these tables together into a single logical table, the measures in the dimension tables would be replicated, resulting in distorted aggregates unless you took precautions to deduplicate the values using LOD calculations or COUNT DISTINCT.
However, if you instead create relationships between these tables, Tableau will aggregate
measures before performing joins, avoiding the problem of unnecessary duplication. This
relieves you of the need to carefully track the level of detail of your measures.
Multi-fact analysis

Tableau’s data modelling capabilities support some forms of multi-fact analysis. Additional
fact tables (containing measures) can be added to any of the previously mentioned models
as long as they only relate to a single dimension table. For example, you can bring two or
more fact tables together to analyse a shared dimension, such as in Customer 360-like analyses. These fact tables can be at a different level of detail than the dimension table, or from
each other. They can also have a many-to-many relationship with the dimension table. In
these scenarios, Tableau will ensure that values are not replicated before aggregation.

If you don’t have a shared dimension table that relates your fact tables, you can sometimes
dynamically build one using custom SQL or by using joins or unions of other dimension
tables.
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Two fact tables can be related directly to each other on a common dimension. This type of
analysis works best when one of the fact tables contains a superset of the common dimension.

Unsupported models
l

Multiple fact tables related to multiple shared dimension tables. In some use
cases it is common to have multiple fact tables related to multiple shared dimension
tables. For example, you might have two fact tables, Store Sales and Internet Sales,
related to two common dimension tables, Date and Customer. Typically, such scenarios would require creating a circular relationship in your data model. Circular relationships are not supported in 2020.2.
You can approximate this type of model by merging some of the tables in the physical
layer. For example, you might be able to union Store Sales and Internet Sales into a
single table, which can then be related to Date and Customer. Alternatively, you might
be able to cross-join Date and Customer to create a single dimension table which can
then be related to Store Sales and Internet Sales.

l

Directly relating 3 or more fact tables on shared dimensions. While it is possible to build this model in the logical layer, you might see unwanted results, unless you
only use dimensions from a single table.

Requirements for relationships in a data model
l

When relating tables, the fields that define the relationships must have the same data
type. Changing the data type in the Data Source page does not change this require-

l
l
l

ment. Tableau will still use the data type in the underlying database for queries.
You can't define relationships based on geographic fields.
Circular relationships aren't supported in the data model.
You can't define relationships between published data sources.
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Factors that limit the benefits of using related tables
l

Dirty data in tables (i.e. tables that weren't created with a well-structured model in
mind and contain a mix of measures and dimensions in multiple tables) can make

l

l
l

multi-table analysis more complex.
Using data source filters will limit Tableau's ability to do join culling in the data. Join
culling is a term for how Tableau simplifies queries by removing unnecessary joins.
Tables with a lot of unmatched values across relationships.
Interrelating multiple fact tables with multiple dimension tables (attempting to model
shared or conformed dimensions).

How Relationships Differ from Joins
Relationships are a dynamic, flexible way to combine data from multiple tables for analysis.
You don’t define join types for relationships, so you won’t see a Venn diagram when you create them.
Think of a relationship as a contract between two tables. When you are building a viz with
fields from these tables, Tableau brings in data from these tables using that contract to build
a query with the appropriate joins.
l

No up-front join type. You only need to select matching fields to define a relationship (no join types). Tableau first attempts to create the relationship based on
existing key constraints and matching field names. You can then check to ensure they
are the fields you want to use, or add more field pairs to better define how the tables
should be related.

l

l
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Automatic and context-aware. Relationships defer joins to the time and context of
analysis. Tableau automatically selects join types based on the fields being used in
the visualisation. During analysis, Tableau adjusts join types intelligently and preserves the native level of detail in your data. You can see aggregations at the level of
detail of the fields in your viz rather than having to think about the underlying joins.
You don't need to use LOD expressions such as FIXED to deduplicate data in related
tables.
Flexible. Relationships can be many-to-many and support full outer joins. When you
combine tables using relationships, it’s like creating a custom, flexible data source for
every viz, all in a single data source for the workbook. Because Tableau queries only
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tables that are needed based on fields and filters in a viz, you can build a data source
that can be used for a variety of analytic flows.

For more information, see Relate Your Data and Don’t Be Scared of Relationships.
Joins are still available as an option for combining your data. Double-click a logical table to go
to the join canvas. For more information, see Where did joins go?
Watch a video: For an introduction to using relationships in Tableau, see this 5-minute
video.

Note: The interface for editing relationships shown in this video might differ slightly from the
current release but has the same functionality.
Also see video podcasts on relationships from Action Analytics, such as Why did Tableau
Invent Relationships? Click "Video Podcast" in the Library to see more.
For related information about how relationship queries work, see these Tableau blog posts:
l
l
l

Relationships, part 1: Introducing new data modelling in Tableau
Relationships, part 2: Tips and tricks
Relationships, part 3: Asking questions across multiple related tables

Characteristics of relationships and joins
Relationships are a dynamic, flexible way to combine data from multiple tables for analysis.
We recommend using relationships as your first approach to combining your data because it
makes data preparation and analysis easier and more intuitive. Use joins only when you
absolutely need to.
Here are some advantages to using relationships to combine tables:

l

Make your data source easier to define, change, and reuse.
Make it easier to analyse data across multiple tables at the correct level of detail

l

(LOD).
Do not require the use of LOD expressions or LOD calculations for analysis at different

l
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l

levels of detail.
Only query data from tables with fields used in the current viz.

Relationships
l
l
l
l

Are displayed as flexible noodles between logical tables
Require you to select matching fields between two logical tables
Do not require you to select join types
Make all row and column data from related tables potentially available in the data

l

source
Maintain each table's level of detail in the data source and during analysis
Create independent domains at multiple levels of detail. Tables aren't merged

l

together in the data source.
During analysis, create the appropriate joins automatically, based on the fields in use.

l

Do not duplicate aggregate values (when Performance Options are set to Many-to-

l

Many)
Keep unmatched measure values (when Performance Options are set to Some

l

Records Match)
Joins

Joins are a more static way to combine data. Joins must be defined between physical tables
up front, before analysis and can’t be changed without impacting all sheets using that data
source. Joined tables are always merged into a single table. As a result, sometimes joined
data is missing unmatched values, or duplicates aggregated values.

l

Are displayed with Venn diagram icons between physical tables
Require you to select join types and join clauses

l

Joined physical tables are merged into a single logical table with a fixed combination

l

l
l
l

of data
May drop unmatched measure values
May duplicate aggregate values when fields are at different levels of detail
Support scenarios that require a single table of data, such as extract filters and
aggregation
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Requirements for using relationships
l

When relating tables, the fields that define the relationships must have the same data
type. Changing the data type in the Data Source page does not change this require-

l
l
l

ment. Tableau will still use the data type in the underlying database for queries.
You can't define relationships based on geographic fields.
Circular relationships aren't supported in the data model.
You can't define relationships between published data sources.

Factors that limit the benefits of using related tables
l

Dirty data in tables (i.e. tables that weren't created with a well-structured model in mind
and contain a mix of measures and dimensions in multiple tables) can make multitable analysis more complex.

l

Using data source filters will limit Tableau's ability to do join culling in the data. Join cull-

l

ing is a term for how Tableau simplifies queries by removing unnecessary joins.
Tables with a lot of unmatched values across relationships.
Interrelating multiple fact tables with multiple dimension tables (attempting to model

l

shared or conformed dimensions).

Where did joins go?
You can still specify joins between tables in the physical layer of a data source. Double-click
a logical table to go to the Join/Union canvas in the physical layer and add joins or unions.
Every top-level, logical table contains at least one physical table. Open a logical table to view,
edit or create joins between its physical tables. Right-click a logical table, and then click
Open. Or, just double-click the table to open it.
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When you create a data source, it has two layers. The top-level layer is the logical layer of
the data source. You combine data between tables in the logical layer using relationships.
The next layer is the physical layer of the data source. You combine data between tables at
the physical layer using joins. For more information, see Logical and physical tables in the
data model.
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Optimise Relationship Queries Using Performance Options
Performance Options are optional settings that define the cardinality (uniqueness) and referential integrity (matching records) between the two tables in a relationship. These settings
help Tableau optimise queries during analysis.
l

l

If you aren't sure what to choose, use the recommended default settings indicated
by Tableau. Using the defaults is safe and will automatically generate correct aggregations and joins during analysis. If you don't know the cardinality or referential integrity,
you don't need to change these settings.
If you know the shape of your data, you can optionally change these settings to
represent uniqueness and matching between the records in the two tables.

In many analytical scenarios, using the default settings for a relationship will give you all of
the data you need for analysis. In some scenarios, you might want to adjust the Performance
Options settings to describe your data more accurately. For more details about using relationships to combine and analyse data, see Relate Your Data and this Tableau blog post:
Relationships, part 1: Introducing new data modelling in Tableau.
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What the Cardinality and Referential Integrity settings mean

Cardinality options

Cardinality settings determine if Tableau aggregates table data before or after automatically
joining the data during analysis.
l

Select Many if the field values aren't unique, or you don't know. Tableau will aggregate the relevant data before forming joins during analysis.

l

Select One if field values are unique. During analysis, the relevant data will be joined
before aggregation. Setting this option correctly optimises queries in the workbook
when the field values in the relationship are unique. However, selecting One when
field values aren’t unique can result in duplicate aggregate values being shown in the
view.

Note: Selecting One treats records as if each key value is unique and there is at most only
one row with a null value.
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Referential Integrity options

Referential Integrity settings determine the type of join used to get the dimension values for a
measure during analysis.
l

Select Some Records Match if some values in the field don't have a match in the
other table, or you don't know. During analysis, Tableau uses outer joins to get dimensions values for a measure. All measure values will be shown in the view, even
unmatched measures.

l

Select All Records Match if values in the field are guaranteed to have a match in the
other table. This setting generates fewer and simpler joins during analysis, and optimises queries. You might see inconsistent results during analysis (unmatched values
removed or missing in view) if there are unmatched values in this table.

Notes: Selecting All Records Match treats records as if no null values exist in the fields
used for the relationship. During analysis, Tableau will use inner joins to get dimension values for a measure. By default, Tableau will never join null keys.
For more information about Cardinality and Referential integrity as concepts, see Cardinality
and Referential Integrity.

Where did joins go?
You can still specify joins between tables in the physical layer of a data source. Double-click
a logical table to go to the join canvas.
Every top-level, logical table contains at least one physical table. Open a logical table to view,
edit or create joins between its physical tables. Right-click a logical table, and then click
Open. Or, just double-click the table to open it.
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When you create a data source, it has two layers. The top-level layer is the logical layer of
the data source. You combine data between tables in the logical layer using relationships.
The next layer is the physical layer of the data source. You combine data between tables at
the physical layer using joins. For more information, see Logical and physical tables in the
data model.
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Tips on using Performance Options
If you know the shape of your data, you can use the optional settings in Performance Options
to establish the cardinality of the tables to each other (one-to-one, one-to-many, many-tomany) and indicate referential integrity (values from one table will always have match in the
other table).
Instead of thinking of the settings in Performance Options as “yes” and “no”, think of them as
“yes” and “I don’t know”. If you are sure that a table's values are unique, select One. If you
are sure that each record in one table matches one or more records in the other table, select
All Records Match. Otherwise, leave the default settings as they are.
If you aren't sure about the shape of your data, use the default settings. When Tableau can't
detect these settings in your data, the default settings are:
l
l

Cardinality: Many-to-Many
Referential integrity: Some Records Match

If Tableau detects key relationships or referential integrity in your data, those settings will be
used and indicated as "detected".
To reapply the default settings, click Revert to Default.
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Terms defined

Cardinality refers to the uniqueness of data contained in a field (column) or combination of
fields. When the tables you want to analyse contain many rows of data, queries can be slow
(and performance of the overall data source is affected) so we recommend choosing a
method for combining data based on the cardinality of the related columns between tables.
l

Low cardinality: When related columns have a lot of repeated data. For example, a
table called Products might contain a Category column that contains three values:

l

Furniture, Office Supplies and Technology.
High cardinality: When related columns have highly unique data. For example, a table
called Orders might contain an Order ID column that contains a unique value for
every order of product.

Referential integrity means that one table will always have a matching row in the other
table. For example, a Sales table will always have a matching row in the Product Catalogue
table.

Automatically Build Views with Ask Data
Ask Data lets you type a question in common language and instantly get a response right in
Tableau. Answers come in the form of automatic data visualisations, with no need to manually drag and drop fields or understand the nuances of your data’s structure.
Ask Data lets you ask sophisticated questions naturally, with support for key analytical concepts such as time series and spatial analysis, and has an understanding of conversational
phrases such as "last year" and "most popular."
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Navigating to Ask Data lenses
Before you can query a data source with Ask Data, a Tableau author must first create a lens
that specifies the subset of data fields the lens uses.
In Tableau, here are all the places where you can access an Ask Data lens:
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l

On the All Lenses page at the top level of your Tableau Cloud or Tableau Server site.

l

On the Ask Data tab for a data source for which lenses have been created.
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l

In an Ask Data object on a dashboard.

Ask Data from a lens page or dashboard object
Navigate to a lens and learn more about its data
1. Navigate to a lens via the All Lenses page for your Tableau site, the Ask Data tab for a
data source, or an Ask Data object on a dashboard.
2. (Optional) Under Recommended Visualisations, click an entry to quickly see visualisations the lens author has created for your organisation.
If the recommendations don't address your current data analysis needs, build a query
to create your own question.
3. In the Data pane on the left, briefly hover over each field to learn more about the data it
contains.
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In a narrower dashboard object, the Data pane may be hidden, but you can see the
same information by clicking the Fields drop-down menu.
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Build queries by entering text
1. Type in the box reading Search fields or values to create a visualisation.

2. As you type, Ask Data searches data fields, functions and string values and displays
results in a drop-down list. Click items in the list to add them to your current entry,
shown above the search box. To automatically create a viz using the current entry,
press Enter at any time.
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Modifying a query by searching for fields and analytical functions
A. Current entry B. Current filters C. Search box D. Returned fields E. Returned analytical functions F. Returned field values

Build queries by adding suggested phrases
Tableau will suggest phrases based on the most common queries asked in your lens and by
others in your organisation. When you open your lens, you'll notice suggestions that will

1000

Tableau Software

Tableau Cloud Help
help you get quick answers to common questions.
You can add these suggestions to your query by clicking them. As you add phrases to your
query, the suggestions dynamically update with more relevant phrases. The view automatically builds with each selection.

Build queries by adding fields and filters
1. Click Add Field or Add Filter.
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2. Click the desired field. (To narrow down a long list, first type in the Search Fields
box.)

3. Set any sub-options, such as aggregation type for a numeric field or grouping for
string and date fields.
4. To add more fields or filters, click the plus sign.

See how elements of your query are applied
To see how elements of your query are applied, hover over them in the text box or the interpretation above it. Words that aren't used are greyed out, helping you rephrase your query
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in a way that’s clearer to Ask Data.

Rephrase your question
You can rephrase questions by clicking options, data fields and filters in the user interface.

Change the viz type
If the default viz doesn't fully reveal your data, click the menu at upper right, and choose from
these supported viz types:
l
l
l
l
l
l
l
l
l
l
l

Bar Chart
Gantt Bar
Heat Map
Histogram
Line Chart
Map
Pie Chart
Scatter
Stacked Bar Chart
Text Table
Treemap
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Note: To automatically create certain viz types, Ask Data sometimes adds fields such
as "Number of Records" to your entries.

Change fields, filters and displayed data
Ask Data gives you several ways to fine-tune how field values are displayed.
l

To switch the fields used for the vertical and horizontal axes, click the Swap Axes button

l

to the left of the viz selection menu:

To change a field, first click on it in your query entry, and then click the field name
below. (To change fields used in difference calculations, see Compare differences
over time.)
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l

To change a field's aggregation or grouping type (for example, from average to sum),
click on the field name in the text box, and then choose a different aggregation or
grouping.

l

For categorical filters, click values (for example, "exclude United States" in the
example below) to change specific values or enter wildcard parameters.
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l

To adjust a numeric range, click words such as "high" or "cheap".

l

To delete a field or filter, hover over it and click the X.

Adjust date filters
To adjust a date filter, click words such as "last" or "previous". Then click one of the following:
l
l
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Specific Dates to enter a specific time period or date value
Relative Dates to show a date range relative to the present day
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l

Range of Dates to enter specific start and end points

Specific Dates offers some unique options in the Date Detail menu:
l
l

Time Period options show a single continuous date range
Date Value options show ranges that can repeat in multiple time periods. For
example, to see combined sales performance for Q1 across multiple years, under
Date Value, you would choose Quarters.
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Compare differences over time
Ask Data lets you compare time periods with phrases such as "year over year" or "quarter
over quarter". The results appear as difference or percentage difference table calculations in
workbooks you save from Ask Data.

In the text box, click a difference calculation to choose other fields, aggregation methods and
time periods.
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Apply simple calculations
Ask Data supports simple calculations between two measures, which you can apply using
these symbols:
+ sums the measures
- produces the difference between them
* multiplies
/ divides
In workbooks you save from Ask Data, these calculations don't become calculated fields but
instead ad hoc calculations on the Columns, Rows or Marks shelves.
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Add sheets with other vizzes
To quickly create multiple different vizzes from a lens, add sheets in Ask Data.
At the bottom of the web page, do any of the following:
l

Click the Add Sheet icon to the right of named sheets.

l

Right-click a sheet name, and choose either Duplicate or Delete.

(To rename sheets from Ask Data, you need to save them in a new workbook.)

Share Ask Data vizzes via email, Slack, or a link
You can quickly share Ask Data vizzes with anyone who has access to a lens.
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1. In the upper right corner of the browser, click on the Share icon.

2. Do either of the following:
l To share the viz via email or Slack, enter specific usernames in the text box.
(Email and Slack integration must previously be configured by your Tableau
administrator.)
l To copy a URL, you can paste into custom emails and other messages, click
Copy Link.

Send feedback to the lens owner
If you have questions about the structure of a lens or how best to use it with Ask Data, you
can send feedback directly to the author. (This option is enabled by default, but lens authors
may disable it.)
1. To the left of the query box for Ask Data, click the Ask Data tips icon.

2. At the bottom of the tips dialog, click Contact the Lens Author.

Tips for successful queries
As you structure questions for Ask Data, apply these tips to get better results.
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l

Use keywords – For example, instead of "I want to see all the countries that these airports are in", try "by airport and country".

l

Use exact wording for field names and values – For example, if your lens
includes Airport Code, Airport Name, and Airport Region fields, specify those by
name.

l

See a ranked list – Ask Data maps terms such as "best" and "worst" to Top 1 and Bottom 1, respectively. If you want to see broader rankings, use "high" and "low" instead.
For example, enter "houses with low sale prices".

l

Query table calculations – In query expressions for table calculation fields, note that
you can't filter, limit or include "year over year difference".

l

Surround unusually long values with quotation marks – To analyse long field
values that contain line returns, tabs or more than ten words, surround them with quotation marks. To improve performance, Ask Data doesn't index fields of that length, or
anything beyond the first 200,000 unique field values.

Create Lenses that Focus Ask Data for Specific Audiences
Most people don’t need information from an entire data source but instead want data visualisations relevant to their job function, like sales, marketing or support. To optimise Ask Data
for different audiences like these, Tableau authors create separate Ask Data lenses, which
query a selected subset of fields. For the selected fields, authors can specify synonyms for
field names and values, reflecting terms the lens audience uses in common language (for
example, "SF" for "San Francisco"). Lens authors then customise the recommended visualisations that appear below the Ask Data query box, which provide answers to users with a
single click.

Note: Ask Data lenses can be created only for data sources published separately from a
Tableau site. Lenses can't be created for data sources embedded in workbooks or those
with a virtual connection.
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Create or configure a lens page on your Tableau site
On your Tableau site, each lens has a separate page where users can query Ask Data and
authors can configure lens fields, synonyms and suggested questions.

A lens page on a Tableau site
1. To create a lens page on your Tableau site, go to a data source page, and choose
New > Ask Data Lens.
To configure an existing lens, go to the lens page on your site. (From an Ask Data
object in a dashboard, you can click the pop-up menu in the upper corner and choose
Go to Lens Page.)
2. If you're creating a new lens, enter a name, description and project location, and then
click Publish Lens.
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3. At the top of the Fields pane at left, click the pencil icon. Then select the relevant fields
for lens users, and click Save.

4. On the left, hover over individual tables or fields, and click on the pencil icon:

Then do any of the following:
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l

Provide a more representative name by clicking on the pencil icon to the right.

l

Add common synonyms for field names and values that lens users may enter in

l

their queries.
Edit descriptions that appear when users hover over fields.

Change the list of recommended visualisations
To address common queries from lens users, you can customise the recommended visualisations that appear below the query box.
Add or replace a recommended visualisation

1. Enter a query into the text box, and press Enter or Return.
2. After the visualisation appears, from the pin icon in the toolbar, choose either Pin to
Recommended Visualisations or Replace Recommendation.

3. For a new recommendation, enter a name and choose the section in which you want
it to appear. For a replacement recommendation, choose the existing one you want to
overwrite.
Edit section titles and recommendation names, or delete recommendations
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l

To edit a section title, click the pencil icon

to the right of the title.

l

To change the name of a recommendation, hover over it and click the pencil icon

.
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To delete a recommendation, click the X.

Add an Ask Data lens to a dashboard
On a dashboard, you can add an Ask Data object that lets users query a published data
source via a lens on your Tableau site.
1. While editing a dashboard in Tableau Cloud or Tableau Server, drag the Ask Data
object to the canvas.

Note: In Tableau Desktop, you can also drag an Ask Data object to the canvas for
placement purposes. But to select a lens, you will need publish to Tableau Cloud
or Tableau Server and edit the object there.
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2.
3. Select a published data source previously connected to the workbook.
4. To use an existing lens, select it and click Use Lens.
Or, to create a new lens, do one of the following:
l
l

If there are no lenses for the data source, click Go to Data Source Page.
If lenses already exist, click the data source name at the bottom of the dialog.

5. (New lenses only) Complete the steps in Create or configure a lens page on your
Tableau site.
6. Under Toolbar Options for Lens Users, select the buttons you want available to
users.
l

Add Visualisation to Pins lets users add to the Recommended Visu-

l

alisations list, which appears just below the query box.
Publish as Workbook lets users save visualisations as workbook sheets to
their Tableau site.

l

Share Visualisation lets users share via email, Slack or a link.
In the lens, the publish (save icon), pin and share options appear in the upper
right corner:
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7. (New lenses only) After you finish creating the lens, return to the Lens object in your
dashboard and click Refresh. Then select the new lens, and click Use Lens.

Apply a different lens to an Ask Data dashboard object
1. From the pop-up menu at the top of the object, choose Configure.

2. Go to Add an Ask Data lens to a dashboard, and repeat steps 2 onward.

Change a lens name, description or project location
1. Navigate to the lens page on Tableau Cloud or Tableau Server.
2. To the right of the lens name at the top of the page, click the three dots (...), and
choose Edit Workbook.

3. Click Edit Lens Details.
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See how people use Ask Data with a lens
For data source owners and lens authors, Ask Data provides a dashboard that reveals the
most popular queries and fields, the number of visualisation results that users clicked and
other helpful information. Filters let you narrow data down to specific users and time ranges.
These stats help you further optimise a lens to increase the success of your users.

Note: If you use Tableau Server, you can access this data in the Tableau Server
Repository to create custom dashboards.

1. In Tableau Server or Tableau Cloud, navigate to a lens page.
2. To the left of the Ask Data text box, click on the "Ask Data tips" icon.

3. In the lower-left corner of the tips dialog, click Usage Analytics.

Let users email you questions about a lens
As a lens owner, you can allow users to email you with questions about data structure,
expected results and more. This option is on by default, but you can turn it off using the
steps below.
1. In Tableau Server or Tableau Cloud, navigate to a lens page.
2. To the left of the Ask Data text box, click on the "i" shown above in See how people
use Ask Data with a lens.
3. At the bottom of the tips dialog, click on the eye icon next to "Contact the Lens Author"
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to enable or disable feedback.

Permissions for publishing and viewing lenses
For Ask Data objects in dashboards, no change to permissions should be required: by
default, existing workbook authors can create lenses, and existing dashboard audiences can
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view them. But for reference, here's a detailed outline of required lens permissions for both
dashboards and direct access via a data source page.
To create and publish a lens, a user needs:

l

The Creator or Explorer user role
Lens Creation permission for the data source (inherited by default from the Connect

l

permission)
Write permission for the parent project to which the lens is published

l

To access and interact with a published lens, a user needs:

l

The Viewer role or above
Connect permission for the data source

l

View permission for the lens

l

Note: By default, lens permissions like View reflect a project's permissions for workbooks. If Tableau administrators want to change default lens permissions, they can do
so either individually for each project, or in bulk using the permissions API.

Disable or Enable Ask Data for a Site
Ask Data is enabled for sites by default, but Tableau administrators may disable it.
1. Go to the General site settings.
2. (Tableau Server only) In the Web Authoring section, select Let users edit workbooks in their browser.
3. In the Availability of Ask Data section, choose from these options:
l

Enabled enables creation of Ask Data lenses for all published data sources.

l

Disabled hides Ask Data throughout the site, while preserving information
about previously created lenses so they can be restored if Ask Data is reenabled.
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Optimise Data for Ask Data
If you manage and publish data sources, here are some tips to help make users of Ask Data
more successful. By spending a little extra time on this process, you'll open up data analysis
to a wider range of people at your organisation, helping them independently answer questions and gain deeper insights.

Optimise data in Ask Data
In the Data pane on the left of the Ask Data interface, data source owners can add synonyms
for fields and exclude irrelevant values.
Changing settings at the data source or lens level

When changing settings in the Data pane for Ask Data, pay close attention to whether you're
at the data source or lens level. (For more information, see Create Lenses that Focus Ask
Data for Specific Audiences.)
l

At the data source level, you'll see the cylindrical data source icon in the upper left
corner. Here, changes you make in the Data pane will apply by default to all subsequently created lenses.

Note: For extracts, two cylinders will appear.
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l

For an individual lens, you'll see the quotation icon in the upper left corner. Here,
changes you make in the Data pane will apply to this lens alone.
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Add synonyms for field names and values

People may not use the same terminology found in your data source, so data source owners
and Tableau administrators can add synonyms for specific data field names and values. Synonyms you enter are available throughout your organisation, making data analysis quicker
and easier for everyone.
Exclude values of specific fields from search results

To improve the usability of search results in Ask Data, you can exclude the values of specific
fields from indexing. Though Ask Data doesn't add non-indexed values to search results, the
values still appear in visualisation results when relevant. For example, if you don't index values from a "Product" field because they add unnecessary detail to search results, Ask Data
can still display values such as "iPhone 12" in resulting data visualisations. And users can
manually add non-indexed values to queries by surrounding them with quotation marks (for
example, "Sales for Product containing "iPhone 12"").

Note: This field-level setting is ignored if the value indexing setting for the data source is
set to Disabled. Field names and related synonyms are always indexed.

1. Go to the Ask Data tab for a data source or individual lens.
2. Hover over a data source field at left, and click the Edit Field Details icon (the pencil).

3. Deselect Index field values.
Either click the text box that appears to reindex the data source now, or let it reindex
based on its regular indexing schedule.
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Optimise data sources
To create the best experience for Ask Data users, optimise the original data source.

Note: Ask Data doesn't support multidimensional cube data sources, or non-relational
data sources like Google Analytics, or data sources with a virtual connection.

Optimise indexing for Ask Data

Data source owners can change how often field values are indexed for Ask Data, optimising
system performance.
1. At the top of a data source page, click the Details icon:

2. In the Ask Data section, click Edit.
3. Choose an indexing option for field values:
l

Automatic checks for changes every 24 hours and analyses the data source if
it is live, has had an extract refreshed, or has been republished. Choose this
option for a data source frequently used with Ask Data, so it will be ready
before users query it.

l

Manual analyses the data source only when Tableau creators manually trigger
indexing on the data source page. Choose this option if the data source
changes frequently but users query it with Ask Data only occasionally.
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To trigger manual indexing, go to the data source page, click the circled “i” in the
Data pane at left, and then click Reindex Data Source.

l

Disabled analyses only field names, not values.

4. Click Save
Use data extracts for faster performance

For improved performance and support for large data sets, use Ask Data with published
extracts rather than live data sources. For more information, see Create an extract.
Ensure that users can access the data source

To use Ask Data, users must have permission to connect to the individual data source. If a
data source has row-level permissions, those permissions also apply to Ask Data, which
won’t recognise secure values or make related statistical recommendations.
Be aware of unsupported data source features

Ask Data supports all Tableau data source features except the following. If your data source
contains these, Ask Data users won't be able to query related fields.
l
l
l

Sets
Combined fields
Parameters
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Anticipate user questions

Anticipate the kinds of questions your users will ask, and then optimise your data source for
those questions using these techniques:
l
l

Clean and shape data in Tableau Prep or a similar tool.

Join data to include all fields users may have questions about in one table, improving
performance.

l

Add calculated fields that answer common user questions.

l

Create bins with appropriate sizes for quantitative variables that users are likely to
want to see as a histogram or another binned form.

Simplify the data

To make data easier to understand by both users and Ask Data, simplify the data source as
much as possible during the data prep process.
1. Remove any unnecessary fields to improve performance.
2. Give each field a unique and meaningful name.
l For example, if there are five field names that start with “Sales …”, better distinguish them so Ask Data can properly interpret the term “sales”.
l Rename “Number of records” to something more meaningful. For example,
use “Number of earthquakes” in a data source where each record is an earthquake.
l Avoid field names that are numbers, dates or boolean (“true” or “false”) values.
l Avoid names which resemble analytical expressions such as “Sales in 2015” or
“Average Products Sold”.
3. Create meaningful aliases for field values, reflecting terms people would use in conversation.
Set appropriate field defaults

To help Ask Data analyse data correctly, ensure that default field settings reflect the content
of each field.
l
l
l
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Set data types for text, time, date, geographic and other values.
Assign the proper data role: dimension or measure, continuous or discrete.
For each measure, assign appropriate default settings in Tableau Desktop, such as
colour, sort order, number format (percentage, currency, etc.) and aggregation
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function. For example, SUM may be appropriate for “Sales”, but AVERAGE might be a
better default for “Test Score”.

Tip: It's particularly helpful to set a default comment for each field, because these
comments appear as informative descriptions when users hover over fields in Ask
Data.

Create hierarchies for geographic and categorical fields

For time data, Tableau automatically creates hierarchies, which let users quickly drill up and
down in vizzes (for example, from day to week to month). For geographic and categorical
data, however, we recommend that you create custom hierarchies to help Ask Data produce
visualisations that reflect the relationships between fields. Be aware that Ask Data won't
show the hierarchies in the data pane.
Ask Data doesn't index hierarchy names, only names of fields within hierarchies. For
example, if a geographic hierarchy named “Location” contains “Country” and “City” fields,
users should enter “Country” and “City” in their questions for Ask Data.

Discover Insights Faster with Explain Data
Explain Data helps you to inspect, uncover, and dig deeper into the marks in a viz as you
explore your data. You can use Explain Data to analyse dashboards, sheets or selected
marks for possible outliers and correlations in the underlying data. Explain Data builds statistical models and proposes possible explanations for individual marks in a viz, including
potentially related data from the data source that isn't used in the current view.
For information on running Explain Data and exploring explanations, see Get Started with
Explain Data.
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Note: This topic describes how Explain Data works in Tableau 2021.2 and later versions. If you have a previous version of Tableau, read this topic in version 2021.1 of
Explain Data help.

As you build different views, use Explain Data as a jumping-off point to help you explore
your data more deeply and ask better questions. For more information, see How Explain
Data helps to augment your analysis. For information on what characteristics make a data
source more interesting for use with Explain Data, see Requirements and Considerations
for Using Explain Data.

Access to Explain Data
Explain Data is enabled by default at the site level. Server administrators (Tableau Server)
and site administrators (Tableau Cloud) can control whether Explain Data is available for a
site. For more information, Disable or Enable Explain Data for a Site.
Authors who can edit workbooks and have the Run Explain Data permission capability for a
workbook can run Explain Data in editing mode. All users with the Run Explain Data capability can run Explain Data in viewing mode in Tableau Cloud and Tableau Server.
When allowed by site administrators, explanations can be shared in viewing mode via email
or Slack with other Tableau Cloud and Tableau Server users. For more information, see
Configure Tableau to allow users to share explanations via email and Slack.
Authors can use Explain Data Settings to control which explanation types are displayed in
the Explain Data pane.
For information on controlling access to Explain Data, explanation types and fields, see Control Access to Explain Data.
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How Explain Data helps to augment your analysis
Explain Data is a tool that uncovers and describes relationships in your data. It can't tell you
what is causing the relationships or how to interpret the data. You are the expert on your
data. Your domain knowledge and intuition are key in helping you decide what characteristics might be interesting to explore further using different views. For related information, see How Explain Data Works and Requirements and Considerations for Using
Explain Data.
For more information on how Explain Data works and how to use Explain Data to augment
your analysis, see these Tableau Conference presentations:
From Analyst to Statistician: Explain Data in Practice (1 hour)
Leveraging Explain Data (45 minutes)
Explain Data Internals: Automated Bayesian Modelling (35 minutes)

l
l
l

Get Started with Explain Data
Use Explain Data in your flow of analysis as you are exploring the marks in a viz. Explain
Data runs automatically when the Data Guide pane is open and updates based on the current selection (dashboard, sheet or mark).
Use Explain Data
l

l
l
l
l
l

Run Explain Data on a dashboard,
sheet or mark
Drill into explanations
View analysed fields
Get Started with Explain Data
Terms and concepts in explanations
Explanation Types

Tableau Software

Author Workbooks and Control
Access
l

Requirements and Considerations

l

for Using Explain Data
Change Explain Data Settings

l

(Authors-only)
Control Access to Explain Data
Disable or Enable Explain Data for a

l

Site
How Explain Data Works

l
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Run Explain Data on a dashboard, sheet or mark
The basic steps to run Explain Data are:
1. Open a dashboard or sheet in a workbook.
2. Click the Data Guide icon in the view toolbar to open the Data Guide pane. For more
information, see Explore Dashboards with Data Guide.
3. If you open a dashboard, Explain Data will analyse it for outliers.

If you select a sheet in the dashboard, Explain Data analyses the marks in that sheet
for outliers.
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If you select a mark in the dashboard, Explain Data specifically analyses that mark for
explanations.

The marks that are being explained are highlighted in the viz as you click on their corresponding explanations.
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Optionally, you can select a mark in a viz, hover the cursor over the mark and then click
Explain Data in the tooltip menu.

Possible explanations for the value of the analysed mark are displayed in the Data Guide
pane. Click different explanation names to expand the details and start exploring.
Explain Data permissions required for seeing explanations

If you see Detected Outliers with a note to contact the owner of the viz, it is because you
need permission to see these types of explanations. Click the owner name to go to their
Tableau content page with their email address. Contact the owner to ask them to give you
Explain Data permissions for the workbook or view.
If you are the owner of the workbook, for more information on setting permissions, see Control who can use Explain Data and what they can see.
Tips for using Explain Data
l
l

Multiple marks can't be selected for comparison with each other.
The view must contain marks that are aggregated using SUM, AVG, COUNT,
COUNTD or AGG (a calculated field).

l

When Explain Data cannot analyse the type of mark selected, a message is displayed
to indicate why. For more information, see Situations where Explain Data is not avail-

l

l

able.
The data you analyse must be drawn from a single, primary data source. Explain Data
does not work with blended or cube data sources.
For information on what characteristics make a data source more interesting for use
with Explain Data, see Requirements and Considerations for Using Explain Data.
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Drill into explanations
1. In the Data Guide pane, click an explanation name to see more details.
Click an explanation to expand or contract its details.
2. Scroll to see more explanation details.
3. Hover over charts in the explanations to see details on different data points. Click the
Open icon to see a larger version of the visualisation.
Creators or Explorers who open the view for editing can click on the Open

icon to

open the visualisation as a new worksheet and explore the data further.

Note: Creators and Explorers who have editing permissions can also control
Explain Data Settings. For more information, see Control Access to Explain Data.

4. Hover over a Help icon to see tooltip help for an explanation. Click on the Help icon
to keep the tooltip open. Click on a Learn More link to open the related help topic.

View analysed fields
1. Run Explain Data on a dashboard, sheet or mark.
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2. In the Data Guide pane, under Explore underlying values for, click a target measure name.
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3. Click on the number-of-fields link at the bottom of the pane.

Authors have the option to open Explain Data Settings to control which fields are included in
the analysis. For more information, see Change fields used for statistical analysis.

Terms and concepts in explanations
The following terms and concepts appear frequently in explanations. You may find it helpful
to become acquainted with their meaning in the context of using Explain Data.

What is a mark?
A mark is a selectable data point that summarises some underlying record values in your
data. A mark can be made of a single record or multiple records aggregated together. Marks
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in Tableau can be displayed in many different ways such as lines, shapes, bars and cell text.
Tableau gets the records that make up the mark based on the intersection of the fields in the
view.
The analysed mark refers to a mark in a dashboard or sheet that was analysed by Explain
Data.
For more information on marks, see Marks.

What does expected mean?
The expected value for a mark is the median value in the expected range of values in the
underlying data in your viz. The expected range is the range of values between the 15th and
85th percentile that the statistical model predicts for the analysed mark. Tableau determines
the expected range each time it runs a statistical analysis on a selected mark.
If an expected value summary says the mark is lower than expected or higher than expected, it means the aggregated mark value is outside the range of values that a statistical
model is predicting for the mark. If an expected value summary says the mark is slightly
lower or slightly higher than expected or within the range of natural variation, it means the
aggregated mark value is within the range of predicted mark values, but is lower or higher
than the median.
For more information, see What is an expected range?

What are dimensions and measures?
Each column name in a database is a field. For example, Product Name and Sales are both
fields. In Tableau, fields like Product Name that categorise data are called dimensions;
fields with quantifiable data like Sales are called measures. Tableau aggregates measures
by default when you drag them into a view.
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Some explanations describe how the underlying record values and the aggregations of
those values may be contributing to the value of the analysed mark. Other explanations may
mention the distribution of values across a dimension for the analysed mark.
When you run Explain Data on mark, the analysis considers dimensions and measures in the
data source that aren't represented in the view. These fields are referred to as unvisualised
dimensions and unvisualised measures.
For more information on dimensions and measures, see Dimensions and Measures.

What is an aggregate or aggregation?
An aggregate is a value that is a summary or total. Tableau automatically applies aggregations such as SUM or AVG whenever you drag a measure onto Rows, Columns, a Marks
card option or the view. For example, measures are displayed as SUM(Sales) or AVG
(Sales) to indicate how the measure is being aggregated.
To use Explain Data, your visualisation must use a measure that is aggregated with SUM,
AVG, COUNT, COUNTD or AGG.
For more information about aggregation, see Data Aggregation in Tableau.

What is a record value?
A record is a row in a database table. A row contains values that correspond to each field. In
this example, Category, Product Name and Sales are fields (or columns). Furniture, Floor
Lamp and $96 are the values.
Category

Product Name

Sales

Furniture

Floor Lamp

$96.00

What is a distribution?
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A distribution is a list of all the possible values (or intervals) of the data. It also indicates how
often each value occurs (frequency of occurrence).

Explanation Types in Explain Data
Each time you select a new mark in a viz or dashboard and run Explain Data, Tableau runs
a new statistical analysis considering that mark and the underlying data in the workbook.
Possible explanations are displayed in expandable sections for the Explain Data pane. For
information about how Explain Data analyses and evaluates explanations, see How Explain
Data Works.

Explore underlying values
This section lists explanations for each measure that can be explained (referred to as target
measures). Each explanation listed here describes a relationship with the values of the target measure that are tested on the analysed mark. Use your real-world, practical understanding of the data to determine if the relationships found by Explain Data are meaningful
and worth exploring.
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In this example, Trip Distance is the target measure

Underlying Characteristics

These explanations describe how underlying records of the marks in the view may be contributing to the aggregated value of the measure being explained. Mark attributes can include
Extreme Values, Null Values, Number of Records or the Average Value of the mark.

Note: For definitions of common terms used in explanations, see Terms and concepts in
explanations.

Extreme Values

This explanation type indicates if one or more records have values that are significantly
higher or lower than most records. If the explanation is supported by a model, it indicates the
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extreme value is affecting the target measure of the analysed mark.
When a mark has extreme values, it doesn't automatically mean it has outliers or that you
should exclude those records from the view. That choice is up to you depending on your analysis. The explanation is simply pointing out an extreme value in the mark. For example, it
could reveal a mistyped value in a record where a banana cost 10 pounds instead of 10
pence. Or, it could reveal that a particular sales person had a great quarter.

Note: This explanation must be enabled by the author to be visible in viewing mode for
a published workbook. For more information, see Control Access to Explain Data.

This explanation shows:
l

The number of underlying records in

l

the analysed mark.
The extreme value or values contributing to the value of the target

l
l

measure.
The distribution of values in the mark.
The record details that correspond to
each distribution value.

Exploration options:
l

Hover over a circle in the chart to see

l

its corresponding value.
Click the left or right arrow below the
details list to scroll through record
details.

l

l

If available, click View Full Data, and
then click the Full Data tab to see all

In this example, a single extreme

records in a table.
Click the Open icon to see a larger

value of 463 hours rented is con-

version of the visualisation.

tributing to the higher-than-expected
sum of Total Time Rented of 613
hours.
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Next steps for analysis:
l

l

If the number of records is low, exam-

A likely reason for this high value
could be that someone forgot to dock

ine these values compared to the

the bike when they returned it. In this

extreme value.
If the extreme value is significantly

case, the author might want to
exclude this value for future analysis.

higher or lower than the other record
values, exclude it and consider how it
changes the value of the analysed
l

mark.
When considering the data with and
without the extreme value, use this as
an opportunity to apply your practical
knowledge about the data.

Visualise the Difference

This section shows:
l

How the analysed mark value
changes when the extreme value is
excluded.
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Exploration options:
l

Click the Open

l

version of the visualisation.
Explore the difference with and

l

without the extreme value (or values).
Authors can open the view as a new

icon to see a larger

sheet and apply a filter to exclude the
extreme value.

Next steps for analysis:
l

If the extreme value is significantly
higher or lower than the other record

l

In this example, when the extreme

values, exclude it and see how it

value of 483 is excluded, the ana-

changes the value of the analysed

lysed mark is no longer high com-

mark.
When considering the data with and

pared to other marks in the view.

without the extreme value, use this as

author might want to explore the

an opportunity to apply your practical
knowledge about the data.

Other marks now stand out. The
other marks to consider why these
other locations have higher hours for
bike rentals.

Null Values

The Null Values explanation type calls out situations where there is a higher-than-expected
amount of missing data in a mark. It indicates the fraction of target measure values that are
null and how the null values might be contributing to the aggregate value of that measure.
This explanation shows:
l

The percentage of values that are
null in the target measure for the analysed mark (blue circle).

Exploration options:
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l

Hover over each circle in the scatter

In this example, the percentage of
null values in the target measure is

l

plot to see its details.
Scroll to see more of the chart.
Click the Open icon to see a larger

l

shown as a blue circle.

version of the visualisation.

Next steps for analysis:
l

Optionally exclude null values in the
mark for further analysis.

Number of Records

This explanation type describes when the count of the underlying records is correlated to the
sum. The analysis found a relationship between the number of records that are being aggregated in a mark and the mark's actual value.
While this might seem obvious, this explanation type helps you explore whether the mark's
value is being affected by the magnitude of the values in its records or simply because of the
number of records in the analysed mark.
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This explanation shows:
l

The number of records in the target
measure for the analysed mark (dark

l

blue bar).
The number of records in the target
measure for other marks in the
source visualisation (light blue bar).

Exploration options:
l

Hover over each bar to see its
details.

l
l

Scroll to see more of the chart.
Click the Open icon to see a larger
version of the visualisation.

Next steps for analysis:
l

Compare whether the individual values of records are low or high, or the
number of records in the analysed

l

In this example, the number of
records for Trip Distance is listed for

mark is low or high.
Authors, if you are surprised by a

each value of Ride Month, which is a

high number of records, you might

August has the highest total trip dis-

need to normalise the data.

tance value.

dimension in the original visualisation.

You might explore whether August
has the highest value for trip distance
because more rides occurred in
August, or if it has the highest trip distance because some rides were
longer.
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Average Value of Mark

This explanation type describes when the average of a measure is correlated to the sum.
Compare whether the average value is low or high, or the number of records is low or high.
This explanation shows:
l

The average of the target measure
for each value of a dimension used in
the source visualisation.

Exploration options:
l
l
l

Hover over each bar to see its details.
Scroll to see more of the chart.
Click the Open icon to see a larger
version of the visualisation.

Next steps for analysis:
l

Compare whether the average value
is low or high, or the number of
records is low or high. For example,
are profits high because you sold a
lot of items or because you sold

l

expensive items?
Try to figure out why the analysed
mark has a significantly higher or
lower average value.

In this example, the average trip distance for August is not significantly
higher or lower than most months.
This suggests that trip distance is
higher for August because there were
more rides in August, rather than from
people taking longer rides.

Tableau Software

1047

Tableau Cloud Help
Contributing Single Value

Use this explanation to understand the composition of the record values that make up the
analysed mark.
This explanation type identifies when a single value in an unvisualised dimension may be
contributing to the aggregate value of the analysed mark. An unvisualised dimension is a
dimension that exists in the data source but isn't currently being used in the view.
This explanation indicates when every underlying record of a dimension has the same
value, or when a dimension value stands out because either many or few of the records
have the same single value for the analysed mark.

Note: For definitions of common terms used in explanations, see Terms and concepts
in explanations.

1048

Tableau Software

Tableau Cloud Help
This explanation shows:
l

The percentage of the number of
records for a single value of a dimension for the analysed mark (blue
bar) versus all marks (grey bar) in

l

the source visualisation.
The percentage of the number of
records for all other values of a
dimension for the analysed mark
(blue bar) versus all marks (grey

l

bar) in the source visualisation.
The average of the target measure
for the single value of a dimension in
the analysed mark (blue bar) versus

l

all marks (grey bar).
The average of the target measure
for all other values of a dimension
for the analysed mark (blue bar)
versus all marks (grey bar) in the
source visualisation.

Exploration options:
l

Hover over each bar to see its

l

details.
Click the Open

icon to see a lar-

ger version of the visualisation.

Next steps for analysis:
l

Use this explanation to understand
the composition of the record values

l

that make up the analysed mark.
Authors might want to create a new

In this example, the statistical analysis
has exposed that many of the rides
come from the station neighbourhood
of Back Bay. Note that Station Neighbourhood is an unvisualised dimension
that has some relationship to Trip

visualisation to explore any unvisu-

Distance in the underlying data for the

alised dimension surfaced in this

source visualisation.
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explanation.

Contributing Dimensions

Use this explanation to understand the composition of the record values that make up the
analysed mark.
This explanation type shows that the distribution of an unvisualised dimension may be contributing to the aggregate value of the analysed mark. This type of explanation is used for target measure sums, counts and averages. An unvisualised dimension is a dimension that
exists in the data source but isn't currently being used in the view.

Note: For definitions of common terms used in explanations, see Terms and concepts
in explanations.
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This explanation shows:
l

The percentage of the number of
records for all values of a dimension
for the analysed mark (blue bar)
versus all values of a dimension for
all marks (grey bar) in the source visu-

l

alisation.
The average of the target measure
for all values of a dimension for the
analysed mark (blue bar) all values of
a dimension for all marks (grey bar).

Exploration options:
l
l
l

Hover over each bar to see its details.
Scroll to see more of the chart.
Click the Open icon to see a larger
version of the visualisation.

Next steps for analysis:
l

Use this explanation to understand
the composition of the record values

l

that make up the analysed mark.
Authors might want to create a new
visualisation to explore any unvisualised dimensions surfaced in this
explanation.

In this example, the statistical analysis
has exposed that more rides were
taken from South Station and MIT and
fewer rides were taken from Charles
Circle and Kendall, compared to rides
taken for marks overall.
Note that Station Name is an unvisualised dimension that has some rela-
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tionship to Trip Distance in the underlying data for the source visualisation.

Contributing Measures

This explanation type shows that the average of an unvisualised measure may be contributing to the aggregate value of the analysed mark. An unvisualised measure is a measure that exists in the data source but isn't currently being used in the view.
This explanation can reveal a linear or quadratic relationship between the unvisualised
measure and the target measure.

Note: For definitions of common terms used in explanations, see Terms and concepts
in explanations.
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This explanation shows:
l

The relationship between the sum of
the target measure and the average
of an unvisualised measure for the
analysed mark (blue circle) and all

l

marks (grey circles) in the view.
If the sum of the target measure is
high or low because the average
value of the unvisualised measure is
high or low.

Exploration options:
l

Hover over each circle to see its

l

details.
Click the Open

icon to see a larger

version of the visualisation.

Next steps for analysis:
In this example, one possible reason
l

Authors might want to create a new
visualisation to explore any unvisualised measures surfaced in this
explanation.

why trip distance is high is because
the average total time rented is also
high.

Other things to explore
This section provides possible reasons why the analysed mark is unique or unusual. These
explanations:
l
l
l

Do not explain why the value of this mark is what it is.
Are not related in any way to the value of the measures in the source visualisation.
Do not take any target measures into account.
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Other Dimensions of Interest

Use this explanation to understand the composition of the record values that make up the
analysed mark.
The distribution of an unvisualised dimension in the analysed mark is unusual compared to
the distribution of values for all other marks in the view. An unvisualised dimension is a
dimension that exists in the data source but isn't currently being used in the view.

Note: For definitions of common terms used in explanations, see Terms and concepts
in explanations.

This explanation shows:
l

The percentage of the number of
records for all values of a dimension
for the analysed mark (blue bar)
versus all values of a dimension for
all marks (grey bar) in the source
visualisation.

Exploration options:
l

Hover over each bar to see its

l

details.
Scroll to see more of the chart.
Click the Open icon to see a larger

l

version of the visualisation.

Next steps for analysis:
l

l

Use this explanation to understand

In this example, a high percentage of

the composition of the record values

records are associated with overcast

that make up the analysed mark.
Authors might want to create a new

weather. Because the data is about

visualisation to explore any unvisualised dimensions surfaced in this
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explanation.

August, we can assume that the
weather is typically warm and humid.
People might have rented bikes more
often on overcast days to avoid the
heat. It's also possible there were
more overcast days in August.

Analysed Fields in Explain Data
Explain Data runs a statistical analysis on a dashboard or sheet to find marks that are outliers, or specifically on a mark you select. The analysis also considers possibly related data
points from the data source that aren't represented in the current view.
Explain Data might not include every column from the data source in the analysis. In many
cases, certain types of fields will be automatically excluded from the analysis. For more
information, see Fields excluded by default.
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Note: Dimensions with more than 500 unique values won't be considered for analysis
(unless allowed by the author in Explain Data Settings).

All users can view information on which fields are included or excluded in the current analysis. Creators and Explorers who have editing permissions can edit the fields used by
Explain Data for statistical analysis.

View fields analysed by Explain Data
When you expand an explanation for a measure that is contributing to the value of the mark,
a link that indicates the number of fields considered in the analysis is displayed at the bottom
of the Explain Data pane.
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Click the link to see the list of fields included in or excluded from the current statistical analysis.
When a data source contains more than 1000 unvisualised dimensions or measures, you
might see an alert asking if you want Explain Data to consider more fields. Click Explain All
to run an analysis that includes more fields. The analysis may take longer to complete.
To view fields used by Explain Data for statistical analysis

1. Run Explain Data on dashboard, sheet or mark.
2. In the Explain Data pane, under Contributing to the value of, click on a measure
name.
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3. Click on the number-of-fields link at the bottom of the pane.
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Change fields used for statistical analysis
Creators and Explorers who have editing permissions can select fields to be included or
excluded from the statistical analysis in the Fields tab of the Explain Data Settings dialog box.
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When a data source contains dimensions with a large number of unique values (up to 500),
those fields won't be considered for analysis.
To edit the fields used by Explain Data for statistical analysis

Settings for analysed fields are applied at the data source level.
1. Run Explain Data on a mark when editing a view.
2. In the Explain Data pane, click the settings icon at the bottom of the Explain Data
pane. Or, click the Edit button in the Analysed Fields view (how to open analysed

fields).
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3. In the Explain Data Settings dialog box, click on the Fields tab.
4. Click a drop-down arrow next to a field name, select Automatic or Never Include,
and then click OK.
Note that fields must have less than 500 unique values to be included in the analysis.
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Fields excluded by default
Fields excluded by default

Reasons for exclusion

All unvisualised measures when there

Computing explanations for more than 1000

are more than 1,000 measures in the

unvisualised measures or dimensions can take

data source.

longer to compute, sometimes several minutes.
These fields are excluded by default for initial

All unvisualised dimensions when
there are more than 1,000 dimensions

analysis, but you can choose to include them for
further analysis.

in the data source.
In this situation, you might see an alert asking if
you want Explain Data to consider more fields.
Click the alert link to get more information. Click
Explain All to run an analysis that includes
more fields.
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Fields excluded by default

Reasons for exclusion

Fields that use geometry, latitude or

Geometry, latitude or longitude by themselves

longitude

can never be explanations. It is highly likely that
an explanation that calls out the latitude or the
longitude as an explanation is due to a spurious
correlation and not a probable explanation.

Dimensions with high cardinality

High cardinality dimensions take longer to com-

(dimensions with > 500 members)

pute. Dimensions with more than 500 unique
values will not be considered for analysis.

Groups, bins or sets

Not currently supported.

Table calculations

Table calculations cannot be analysed when
table calculations are at a different level of detail
than the view.

Unvisualised measures that can't be

Unvisualised measures that can't be averaged

averaged

include measures that are calculated fields
where the calculation expression includes
aggregations (display as AGG() fields when
added to the sheet).

Discrete measures and continuous

Not currently supported.

dimensions
Hidden fields

Not available.

Calculated fields with errors

No values present to analyse.

Requirements and Considerations for Using Explain Data
Explain Data is always available to authors in Tableau Desktop.
For Tableau Cloud and Tableau Server: When Explain Data is enabled for a site, Creators
and Explorers with the appropriate permissions can run Explain Data when editing a work-
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book. All users with the appropriate permissions can run Explain Data in viewing mode in
published workbooks. For more information, see Control Access to Explain Data.

What makes a viz a good candidate for Explain Data
Explain Data works best on visualisations that require deeper exploration and analysis,
rather than infographic-style, descriptive vizzes that communicate summarised data.
l

Row-level data is necessary for Explain Data to create models of your data and generate explanations. Vizzes with underlying, row-level data, where relationships might

l

exist in unvisualised fields are good candidates for running Explain Data.
Vizzes based on pre-aggregated data without access to row-level data are not ideal
for the statistical analysis performed by Explain Data.

What data works best for Explain Data
When you are using Explain Data in a worksheet, remember that Explain Data works with:
l

Single marks only – Explain Data analyses single marks. Multiple mark analysis is
not supported.

l

Aggregated data – The view must contain one or more measures that are aggregated using SUM, AVG, COUNT or COUNTD. At least one dimension must also be
present in the view.

l

Single data sources only –The data must be drawn from a single, primary data
source. Explain Data does not work with blended or cube data sources.

When preparing a data source for a workbook, keep the following considerations in mind if
you plan to use Explain Data during analysis.
l

Use a data source with underlying data that is sufficiently wide. An ideal data set has
at least 10-20 columns in addition to one (or more) aggregated measures to be

l
l

explained.
Give columns (fields) names that are easy to understand.
Eliminate redundant columns and data prep artifacts. For more information, see

Change fields used for statistical analysis.
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l

Don't discard unvisualised columns in the data source. Explain Data considers fields in

l

the underlying data when is analyses a mark.
Low cardinality dimensions work better. The explanation of a categorical dimension is
easier to interpret if its cardinality is not too high (< 20 categories). Dimensions with

l

more than 500 unique values will not be considered for analysis.
Don't pre-aggregate data as a general rule. But if the data source is massive, consider

l

pre-aggregating the data to an appropriate level of detail.
Use extracts over live data sources. Extracts run faster than live data sources. With live
data sources, the process of creating explanations can create many queries (roughly
one query per each candidate explanation), which can result in explanations taking
longer to be generated.

Situations where Explain Data is not available
Sometimes Explain Data will not be available for a selected mark, depending on the characteristics of the data source or the view. If Explain Data cannot analyse the selected mark,
the Explain Data icon and context menu command will not be available.
Explain Data can't be run in views

l

that use:

l
l
l

Map coordinate filters
Blended data sources
Data sources with parameters
Data sources that don't support COUNTD or
COUNT(DISTINCT ...) syntax, such as

l
l

Explain Data can't be run if you

l

select:

l
l
l
l
l

Access.
Filters on aggregate measures
Disaggregated measures
Multiple marks
Axis
Legend
Grand total
Trend line or reference line
A mark in a view that contains a very low number of marks

Explain Data can't be run when
the measure to be used for an
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Isn't aggregated using SUM, AVG, COUNT,
COUNTD
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explanation:

l
l

Explain Data can't offer explan-

l

ations for a dimension when it is:

l
l
l

Is a table calculation
Is used in measure values
A calculated field
A parameter
Used in Measure Names and Measure Values
A field with more than 500 unique values.
Dimensions with more than 500 unique values
will not be considered for analysis.

Control Access to Explain Data
Your access to Explain Data will vary depending on your site role and content permissions.
Explain Data is always available to authors in Tableau Desktop. Authors with appropriate
permissions can run Explain Data in editing mode in Tableau Cloud and Tableau Server.
Authors can also control whether Explain Data is available in viewing mode in published
workbooks and which explanation types are displayed in the Explain Data pane.
Be aware that Explain Data can surface values from dimensions and measures in the data
source that aren't represented in the view. As an author, you should run Explain Data and
test the resulting explanations to make sure that sensitive data isn't being exposed in your
published workbooks.

Who can access Explain Data
Explain Data is enabled by default at the site level. Server administrators (Tableau Server)
and site administrators (Tableau Cloud) can control whether Explain Data is available for a
site. For more information, Disable or Enable Explain Data for a Site.
Mode
Viewing mode

Who Can Access
Tableau Viewers, Explorers and Creators who have the
Run Explain Data permission capability can run and explore
Explain Data explanations in viewing mode.
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Mode
Editing mode

Who Can Access
Tableau Creators can run Explain Data when editing a view
in Tableau Desktop, Tableau Cloud or Tableau Server.
Explorers who have the Run Explain Data permission capability and editing permissions can run Explain Data when
editing a workbook in Tableau Cloud or Tableau Server.
Creators and Explorers who have editing permissions can
open new worksheets for further analysis.
They can also use Explain Data Settings to control who can
use Explain Data and what they can see.

Control who can use Explain Data and what they can see
A combination of settings must be enabled to make Explain Data available in editing mode
and viewing mode in Tableau Cloud and Tableau Server.
Editing mode

Requirements for authors to run Explain Data or edit Explain Data settings in editing mode:

l

Site setting: Availability of Explain Data set to Enable. Enabled by default.
Site role: Creator, Explorer (can publish)

l

Permissions: Run Explain Data capability set to Allowed. Unspecified by default. If

l

you open a workbook (Tableau version 2022.1 or earlier) that used this permission in
Tableau version 2022.2 or later, you will need to reset the Run Explain Data capability
to Allowed.

Note: The Download Full Data capability for a Creator or Explorer (can publish) controls whether they see the View Full Data option in Extreme Values explanations. Viewers are always denied the Download Full Data capability. However, all users can see
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record-level details when the Extreme Values explanation type is enabled in Explain
Data settings.

Creators and Explorers with editing permissions and the Run Explain Data permission capability can access Explain Data Settings, which provide options for controlling:
l

The explanation types that are displayed in the Explain Data pane.

l

The fields that are included in, or excluded from statistical analysis.

These options are set for the entire workbook and can only be set in the Explain Data Settings dialog box.
Viewing mode

Requirements for all users to run Explain Data in viewing mode:

l

Site setting: Availability of Explain Data set to Enable. Enabled by default.
Site role: Creator, Explorer or Viewer

l

Permissions: Run Explain Data capability set to Allowed. Unspecified by default. If

l

you open a workbook (Tableau version 2022.1 or earlier) that used this permission in
Tableau version 2022.2 or later, you will need to reset the Run Explain Data capability
to Allowed.

Note: To see explanations of Detected Outliers in the Data Guide, users of a viz must
have the Explain Data permission allowed for the workbook or view. The owner of the
workbook will need to open the permissions settings for this workbook in Tableau
Server or Tableau Cloud and allow the Explain Data permission to that user.

Open the Explain Data Settings dialog box

1. From the Analysis menu, select Explain Data, and then click Settings. Or, in the
Explain Data pane, click on the settings icon (bottom right).

1068

Tableau Software

Tableau Cloud Help

Include or exclude explanation types displayed by Explain Data

Creators and Explorers who have editing permissions can choose to exclude (or include)
explanation types displayed for all workbook users.
1. In the Explain Data Settings dialog box, click on the Explanation Types tab.

2. In the list of explanation types, select or clear an explanation type.
3. Click OK.
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Test the setting by saving and closing the published workbook and then opening a view
from the workbook in viewing mode. Select a mark that typically has Extreme Value explanations, and then run Explain Data to check the explanation results.
Include or exclude fields used for statistical analysis

Creators or Explorers who have editing permissions can choose to exclude (or include)
fields that are eligible for analysis.
1. In the Explain Data pane (bottom right), click on the settings icon. Or, click the Edit
button in the Analysed Fields view.

2. In the Explain Data Settings dialog box, click on the Fields tab.
3. In the list of fields under Include, click on the drop-down arrow and select Automatic
to include an eligible field every time Explain Data runs for that workbook.
Note that fields must have less than 500 unique values to be included in the analysis.
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Select Never Include to explicitly exclude the field.
Select Include None to run a statistical analysis on the data without considering fields.
Select Reset to return to the default settings.

4. Click OK.
Test the setting by saving the published workbook. Select a mark, and then run Explain Data
to check the explanation results.

Configure Tableau to allow users to share explanations via email and
Slack
Tableau administrators can control whether explanations can be shared in viewing mode via
email or Slack to other Tableau users.
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Follow these steps to allow notifications and sharing via email and Slack in Tableau Cloud
or Tableau Server:
1. Click Settings.
2. On the General tab, scroll down to Manage Notifications.
3. For Collaboration, select Share for On Tableau, Email and Slack.
To share explanations via Slack, the Tableau app must be set up for your Slack workspace.
Sharing explanations with Slack is enabled by default in Tableau Cloud.
In Tableau Server, an administrator will need to set up the Tableau app for Slack. For more
information, see Integrate Tableau with a Slack Workspace.

How Explain Data Works
Use Explain Data as an incremental, jumping-off point for further exploration of your data.
The possible explanations that it generates help you to see the different values that make up
or relate to an analysed mark in a view. It can tell you about the characteristics of the data
points in the data source, and how the data might be related (correlations) using statistical
modelling. These explanations give you another tool for inspecting your data and finding
interesting clues about what to explore next.
Note: Explain Data is a tool that uncovers and describes relationships in your data. It can't
tell you what is causing the relationships or how to interpret the data. You are the expert
on your data. Your domain knowledge and intuition is key in helping you decide what characteristics might be interesting to explore further using different views.
For related information on how Explain Data works, and how to use Explain Data to augment your analysis, see these Tableau Conference presentations:
l
l
l

From Analyst to Statistician: Explain Data in Practice (1 hour)
Leveraging Explain Data (45 minutes)
Explain Data Internals: Automated Bayesian Modelling (35 minutes)

What Explain Data is (and isn’t)
Explain Data is:
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l
l
l

A tool and a workflow that leverages your domain expertise.
A tool that surfaces relationships in your data and recommends where to look next.
A tool and a workflow that helps expedite data analysis and make data analysis more
accessible to a broader range of users.

Explain Data is not:
l
l
l

A statistical testing tool.
A tool to prove or disprove hypotheses.
A tool that is giving you an answer or telling you anything about causality in your data.

When running Explain Data on marks, keep the following points in mind:
l

Consider the shape, size and cardinality of your data. While Explain Data can
be used with smaller data sets, it requires data that is sufficiently wide and contains
enough marks (granularity) to be able to create a model.

l

Don't assume causality. Correlation is not causation. Explanations are based on
models of the data, but are not causal explanations.
A correlation means that a relationship exists between some data variables, say A and
B. You can't tell just from seeing that relationship in the data that A is causing B, or B is
causing A, or if something more complicated is actually going on. The data patterns
are exactly the same in each of those cases and an algorithm can't tell the difference
between each case. Just because two variables seem to change together doesn't
necessarily mean that one causes the other to change. A third factor could be causing
them both to change, or it may be a coincidence and there might not be any causal relationship at all.
However, you might have outside knowledge that is not in the data that helps you to
identify what's going on. A common type of outside knowledge would be a situation
where the data was gathered in an experiment. If you know that B was chosen by flipping a coin, any consistent pattern of difference in A (that isn't just random noise) must
be caused by B. For a longer, more in-depth description of these concepts, see the article Causal inference in economics and marketing by Hal Varian.
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How explanations are analysed and evaluated
Explain Data runs a statistical analysis on a dashboard or sheet to find marks that are outliers, or specifically on a mark you select. The analysis also considers possibly related data
points from the data source that aren't represented in the current view.
Explain Data first predicts the value of a mark using only the data that is present in the visualisation. Next, data that is in the data source (but not in the current view) is considered and
added to the model. The model determines the range of predicted mark values, which is
within one standard deviation of the predicted value.

What is an expected range?

The expected value for a mark is the median value in the expected range of values in the
underlying data in your viz. The expected range is the range of values between the 15th and
85th percentile that the statistical model predicts for the analysed mark. Tableau determines
the expected range each time it runs a statistical analysis on a selected mark.
Possible explanations are evaluated on their explanatory power using statistical modelling.
For each explanation, Tableau compares the expected value with the actual value.
value

Description

Higher than expec- If an expected value summary says the mark is lower than expected/Lower than
expected

ted or higher than expected, it means the aggregated mark value
is outside the range of values that a statistical model is predicting
for the mark. If an expected value summary says the mark is
slightly lower or slightly higher than expected, or within the range
of natural variation, it means the aggregated mark value is within
the range of predicted mark values, but is lower or higher than the
median.

Expected Value

If a mark has an expected value, it means its value falls within the
expected range of values that a statistical model is predicting for
the mark.
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value

Description

Random Variation

When the analysed mark has a low number of records, there may
not be enough data available for Explain Data to form a statistically significant explanation. If the mark’s value is outside of the
expected range, Explain Data can’t determine whether this unexpected value is being caused by random variation or by a meaningful difference in the underlying records.

No Explanation

When the analysed mark value is outside of the expected range
and it does not fit a statistical model used for Explain Data, no
explanations are generated.

Models used for analysis

Explain Data builds models of the data in a view to predict the value of a mark and then
determines whether a mark is higher or lower than expected given the model. Next, it considers additional information, like adding additional columns from the data source to the view,
or flagging record-level outliers, as potential explanations. For each potential explanation,
Explain Data fits a new model and evaluates how unexpected the mark is given the new
information. Explanations are scored by trading off complexity (how much information is
added from the data source) against the amount of variability that needs to be explained. Better explanations are simpler than the variation they explain.

Explanation type
Extreme values

Evaluation
Extreme values are aggregated marks that are outliers, based on
a model of the visualised marks. The selected mark is considered
to contain an extreme value if a record value is in the tails of the distribution of the expected values for the data.
An extreme value is determined by comparing the aggregate mark
with and without the extreme value. If the mark becomes less surprising by removing a value, then it receives a higher score.
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Explanation type

Evaluation
When a mark has extreme values, it doesn't automatically mean it
has outliers, or that you should exclude those records from the
view. That choice is up to you depending on your analysis. The
explanation is simply pointing out an interesting extreme value in
the mark. For example, it could reveal a mistyped value in a record
where a banana cost 10 pounds instead of 10 pence. Or, it could
reveal that a particular sales person had a great quarter.

Number of

The number of records explanation models the aggregate sum in

records

terms of the aggregate count; average value of records models it
in terms of the aggregate average. The better the model explains
the sum, the higher the score.
This explanation describes whether the sum is interesting because
the count is high or low, or because the average is high or low.

Average value of

This type of explanation is used for aggregate marks that are

the mark

sums. It explains whether the mark is consistent with the other
marks because in terms of its aggregate count or average, noting
the relation SUM(X) = COUNT(X) * AVG(X).
This explanation describes whether the sum is interesting because
the count is high or low, or because the average is high or low.

Contributing

This explanation models the target measure of the analysed mark

Dimensions

in terms of the breakdown among categories of the unvisualised
dimension. The analysis balances the complexity of the model with
how well the mark is explained.
An unvisualised dimension is a dimension that exists in the data
source but isn't currently being used in the view. This type of
explanation is used for sums, counts and averages.
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Explanation type

Evaluation
The model for unvisualised dimensions is created by splitting out
marks according to the categorical values of the explaining
column, and then building a model with the value that includes all
of the data points in the source visualisation. For each row, the
model attempts to recover each of the individual components that
made each mark. The analysis indicates whether the model predicts the mark better when components corresponding to the
unvisualised dimension are modelled and then added up, versus
using a model where the values of the unvisualised dimension are
not known.
Aggregate dimension explanations explore how well mark values
can be explained without any conditioning. Then, the model conditions on values for each column that is a potential explanation.
Conditioning on the distribution of an explanatory column should
result in a better prediction.

Contributing

This explanation models the mark in terms of this unvisualised

Measures

measure, aggregated to its mean across the visualised dimensions. An unvisualised measure is a measure that exists in the
data source but isn't currently being used in the view.
A Contributing Measures explanation can reveal a linear or quadratic relationship between the unvisualised measure and the target
measure.

Disable or Enable Explain Data for a Site
Explain Data is enabled for sites by default, but Tableau administrators may disable it.
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1. Go to the General site settings.
2. (Tableau Server only) In the Web Authoring section, select Let users edit workbooks in their browser.
3. In the Availability of Explain Data section, select from these options:
l

Enable lets Creators and Explorers with the appropriate permissions run
Explain Data in editing mode. Lets all users with appropriate permissions run
Explain Data when it is enabled for viewing mode.

l

Disable prevents all users from running Explain Data or accessing Explain
Data settings in workbooks.

Identify Notable Data Changes in a Viz (Preview)
In Tableau Cloud, Data Change Radar shows data that Tableau has detected to be outside
of expected ranges, revealing changes you may want to explore further.
Note: Data Change Radar is being made available as a preview feature included as part of
the 2022.3 release. When using this feature, you should proceed with caution until you have
validated the insights surfaced by Data Change Radar are accurate. This topic includes
information on how to use and interpret Data Change Radar. For information on how to control availability of Data Change Radar, see Disable or Enable Data Change Radar for a
Site.
You cannot change or update the historical data that is displayed in Data Change Radar,
but you can delete it. To delete the data, you can either turn off Data Change Radar by disabling it, or you can delete the workbook that contains the data from your Tableau site. The
historical data collected by Data Change Radar will be deleted within 48 hours of the workbook being deleted, or the site setting being turned off. For more information, see Remove
historical data from Data Change Radar.
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How Data Change Radar determines expected ranges
In tracked views, Tableau captures the value of each visualised measure over time. For each
visualised measure, up to 960 recent data points are captured, either at each extract refresh
for a workbook or once every four hours, whichever is less frequent. With this data, Tableau
trains an internal model to predict expected ranges for your data.
Notable data changes are available from the Home page, Recommendations page or the
Data Guide pane in Tableau Cloud.

Note: Measures from a data source that don't appear in a view are not tracked to conserve system resources.

Which views are tracked?
In addition to permission to access a view, a few other requirements are necessary for Data
Change Radar to show notable data changes to you.
l

Extracts are required for all data sources in the published workbook.

l

Row-level security cannot be present in the data source or view.

l

The view must be popular and in the top 1% most accessed on your site in the last
30 days.

See recommended views with notable data changes
Tableau automatically recommends views with notable data changes detected in the last 24
hours. To ensure that these data changes are relevant to you, Tableau recommends only
views you have favourited or accessed in the last 30 days, or that the Tableau recommendations engine thinks are important.
1. From the left pane of Tableau Cloud, click Home or Recommendations to see views
with data changes that might interest you.
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Here's how a recommended data change appears on the Home page:

2. If the Data Change icon

appears, hover over the view thumbnail to see a brief

description. If the change interests you, click the thumbnail to open the view and automatically display the notable change in the Data Guide pane.

See notable data changes in the Data Guide
If notable data changes are available for a dashboard or view, you will see them listed under
Notable Data Changes in the Data Guide.
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1. Click the Data Guide icon in the view toolbar to open it. You might need to click the plus
sign to the right of the Notable Data Changes label to see the list.
2. Click the name of a change in the list to expand its description.

Explore data changes
1. Click a thumbnail for a recommended view to open it. Or open the Data Guide pane to
see if any Notable Data Changes are available for the dashboard or view.
2. In the Data Guide pane, click the filter and select Latest to see changes from the last
24 hours, or All to see changes from the last 21 days.
3. In the list of changes, hover over a change to see its corresponding mark highlighted in
the view.
4. Click a change in the list to see how the measure values have changed over time.

5. In the graph that appears, the amber area indicates the expected data range for up to
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the last 30 days.

Do any of the following:
l

In the Zoom section, click 1D, 7D or 14D to show data from the most recent 1-,
7- or 14-day period. Or click Max to show data up to the last 21 days and 960

l
l

data points.
Hover over the graph to see values captured at each data point.
Below the graph, drag and resize the grey area to customise the displayed time

range.
6. To return to the complete list of changes, click the Back arrow at the top of the Data
Guide pane.
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Tip: If you accidentally close the Data Guide pane, to re-open it, click Data Guide
in the view toolbar or return to the Home or Recommendations section of your
site.

Disable or Enable Data Change Radar for a Site
Data Change Radar is turned on for sites by default, but Tableau site administrators may
turn it off.

Note: This feature is being made available as a preview feature included as part of the
2022.3 release. When using this feature, you should proceed with caution until you validate that the insights surfaced by Data Change Radar are accurate. For information
about using Data Change Radar, see Identify Notable Data Changes in a Viz (Preview).

1. Go to the General site settings.
2. In the Web Authoring section, select Let users edit workbooks in their browser.
3. In the Data Change Radar (Preview) section, select Monitor views on this site
for notable data changes to turn on Data Change Radar. Clear this option to turn off
Data Change Radar.

4. Click Save.

Remove historical data from Data Change Radar
You cannot change or update the historical data that is displayed in Data Change Radar, but
you can delete it.
To delete the data:
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l

Turn off Data Change Radar by disabling it. The historical data collected by Data
Change Radar will be deleted within 48 hours of the Data Change Radar site setting
being turned off.

or
l

Delete the workbook or dashboard that contains the data from your Tableau site. The
historical data collected by Data Change Radar will be deleted within 48 hours of the
workbook or dashboard being deleted.

Use Accelerators to Quickly Visualise Data
Tableau Accelerators are pre-built dashboards designed to help you get a jumpstart on data
analysis. Tailored to specific industries and enterprise applications, Accelerators are built
with sample data that you can swap out for your own data, allowing you to discover insights
with minimal setup.

Salesforce Sales Cloud Pipeline Accelerator
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Where to find Accelerators
You can access the complete set of Accelerators on the Tableau Exchange and in Tableau
Desktop. Additionally, select Accelerators are available to use when you create a workbook
in Tableau Cloud.

On the Tableau Exchange website
1. Visit the Accelerators page on the Tableau Exchange website. You can filter to find
Accelerators based on the industry they are applicable to and the type of data they connect to.
2. Sign in to the Tableau Exchange website. If you don't have an account, create one.
3. When you find an Accelerator you want to use, click Download to get the TWBX file.
Because Accelerators are simply packaged workbooks, you can open the downloaded file in Tableau Desktop or upload it to your site on Tableau Cloud or Tableau
Server. For information about uploading workbooks, see Upload Workbooks to a
Tableau Site.

In Tableau Desktop
1. On the Start Page in Tableau Desktop, click More Accelerators.

2. The Accelerators in this list are the same as those shown on the Tableau Exchange
website, with the added convenience that you can open the Accelerators without
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leaving Tableau Desktop.
3. When you find an Accelerator you want to use, click Open to start working with it.

In Tableau Cloud
Select Accelerators are available for you to use when you create a workbook Tableau
Cloud. These Accelerators connect to cloud-based data like Salesforce, ServiceNow ITSM,
LinkedIn Sales Navigator, Marketo, and Oracle Eloqua.
1. If you're a Creator in Tableau Cloud, navigate to the Home or Explore page, then click
the New button and select Workbook.

Note: Site administrators can also access Accelerators from the Home page,
under Accelerators.

2. At the top of the Connect to Data window, click Accelerator to browse the selection of
Accelerators available to connect to on Tableau Cloud.
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You can upload Accelerators from the Tableau Exchange to Tableau Cloud and use them as
you would in Tableau Desktop. However, you will need to follow the Tableau Exchange
instructions to get your data into the Accelerator instead of the Tableau Cloud instructions.

Use an accelerator from the Tableau Exchange
Follow the instructions in this section to use an Accelerator that you have downloaded from
the Tableau Exchange website or opened from within Tableau Desktop. For instructions on
using Accelerators when you create a workbook in Tableau Cloud, see Use an Accelerator
directly in Tableau Cloud.

Add your data to the Accelerator
Accelerators come with sample data that you can use to explore the concepts illustrated in
the dashboard. To get the most value from an Accelerator, replace the sample data with your
own data. There are two methods by which you can add your data to the Accelerator:
replace the data source with a new data source (method 1) or add a new connection to the
existing data source (method 2).
Method 1
Works with data sources that

Method 2
Data sources must have only one physical table.

have more than one table.
Allows you to change field

Doesn’t allow you to change field names in Tableau

names in Tableau Desktop

Desktop, which means that the field names in your data

to match the Accelerator.

source must match the fields in the Accelerator.

Doesn't preserve the folder

Preserves the folder structure defined in the Accelerator.

structure in the Accelerator.
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Method 1: Replace the data source

1. With the Accelerator open in Tableau Desktop, click Data > New Data Source.

2. Connect to the data you want to use. For more information, see Connect to Your
Data. If you are using a Salesforce Accelerator, make sure your account has API
access to your Salesforce instance.
3. On the Data Source tab, drag tables onto the canvas to build your new data source.
For more information, see Use Relationships for Multi-table Data Analysis.
4. Open any worksheet in the Accelerator, then click Data > Replace Data Source.
This option is not available on dashboard or story tabs. For more information, see
Replace Data Sources.

5. Under Replacement, select the data source you added, then click OK.
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6. In the Data pane, right-click the original data source, then click Close. For more information, see Close Data Sources.

Fix broken references

If the new data source doesn’t have the same field names as the original, parts of the Accelerator will be blank. Replace the broken references on the affected worksheets so that they
use the correct fields from your new data source. For more information, see Replace Field
References.
Method 2: Edit the data source

1. With the Accelerator open in Tableau Desktop, click the Data Source tab.

2. Next to Connections, click Add. Connect to the data you want to use. For more
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information, see Connect to Your Data.

3. On the data source canvas, double-click the logical table to open the physical table.
For information about logical and physical tables, see Layers of the data model.

4. Drag the table from the data source you added and drop it onto the existing physical
table to replace the sample data. Your data source must be only one physical table.
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5. Under connections, right-click the connection for the sample data, then select
Remove.

Use an Accelerator directly in Tableau Cloud
A limited number of Accelerators are available for you to use when you create a workbook in
Tableau Cloud. These Accelerators prompt you to connect directly to a cloud-based data
source, rather than requiring you to add data manually.
1. On Tableau Cloud, create a new workbook.
2. At the top of the Connect to Data window, click Accelerator.
3. From the list of pre-built designs, find an option that reflects the data source and business metrics you need, and click Use Dashboard.
4. To quickly see how a workbook looks with sample data, click Continue without
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signing in. Or click Continue to create a workbook with your data.
5. Specify a name and containing project for the workbook.
6. If you chose to create a workbook with your data, connect to your data source. While
Tableau prepares an extract of your data, sample data appears so you can explore
the layout.

Note: If you download an Accelerator from the Tableau Exchange with the intention of
uploading it to Tableau Online, you will need to replace the data by following the instructions under Use an accelerator from the Tableau Exchange.

Change permissions to share Accelerators with colleagues
To avoid exposure of confidential data, workbooks for Accelerators are visible only to
authors and administrators by default. To share an Accelerator with your colleagues, follow
these simple steps:
1. In Tableau Online, navigate to the workbook for the Accelerator.
2. Select the workbook, click Actions, and choose Permissions.
3. Give View permissions to any user or group you want to see the dashboard. For
more information, see Edit Permissions in Tableau Online Help.

Replace sample data with your data
If you chose to quickly load sample data in a dashboard, you can replace it with your data at
any time.
1. In Tableau Online, navigate to the workbook for the Accelerator.
2. On the Data Sources tab, select the data source. From the Actions menu, choose
Edit Connection.
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3. For authentication, select Embedded credentials in the connection, and either
choose an existing user account or add a new one. Then click Save.
4. On the Refresh Schedules tab, select the schedule. From the Actions menu, choose
Run Now.

Fix greyed-out views by replacing field names
If your organisation has customised the data structure for a cloud-based system, you may
need to match those changes in Accelerators after your data loads in them. For example, if
your organisation has renamed the Salesforce “Account” field to “Customer”, you'll need to
make a corresponding change in Accelerators to avoid greyed-out views like this:

Fortunately, the fix is pretty straightforward:
1. Above the dashboard, click Edit.
2. Navigate directly to the greyed-out sheet.
3. In the Data pane on the left, look for red exclamation points (!) next to field names,
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which indicate that your organisation uses different names.
4. Right-click each of those fields, and choose Replace References. Then select the
correct field name from the list.

Fix empty dashboards by changing default date ranges
If a dashboard looks completely empty, the likely cause is a default date range that doesn't
correspond to the dates in your source data.
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1. Download the workbook, and open it in Tableau Desktop.
2. Click the Data Source tab.
3. In the upper-left corner, click the arrow next to the data source name, and choose Edit
Connection. Then sign in.

4. Specify a date range that reflects the dates in your data, and click Connect.
5. Choose Server > Publish Data Source to update extracts of the data on Tableau
Online.

Use Dashboard Extensions
Extensions let you add unique features to dashboards or directly integrate them with applications outside Tableau. Adding extensions is easy; you incorporate them into dashboard layouts just like other dashboard objects.
Extensions expand dashboard functionality with the help of web applications created by
third-party developers. If you're a developer and want to create your own extensions, see the
Tableau Extensions API documentation on GitHub.
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Note: Tableau administrators can turn off dashboard extensions for Tableau Desktop,
Tableau Server and Tableau Cloud.

Add an extension to a dashboard
1. In a Tableau workbook, open a dashboard sheet.
2. From the Objects section, drag Extension to the dashboard.

3. In the “Add an Extension” dialog box, do either of the following:
l

Search for and select an extension.

l

Click Access Local Extensions, and navigate to a .trex file you previously
downloaded.

4. If prompted, allow or deny the dashboard extension access to data in the workbook.
For more information, see Data security, Network-enabled and Sandboxed extensions.
If you allow access, follow any on screen instructions for configuring the extension.
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Note: If you're using Tableau Server or Tableau Cloud, Extension objects will
appear blank in prints, PDFs and images of dashboards (including images in subscription emails).

Configure a dashboard extension
Some dashboard extensions provide configuration options that let you customise features.
1. Select the extension in the dashboard, and from the drop-down menu in the upperright corner, choose Configure.
2. Follow the on-screen instructions to configure the extension.

Reload a dashboard extension
If a dashboard extension becomes unresponsive, you might need to reload it, which is similar
to refreshing a web page in a browser.
1. Select the extension in the dashboard, and from the drop-down menu in the upperright corner, choose Reload.
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The dashboard extension is refreshed and set to its original state.
2. If reloading the extension fails to return it to a usable state, try removing it from the
dashboard and adding it again.

Data security, Network-enabled and Sandboxed extensions
Dashboard extensions are web applications that come in two forms:
l

l

Network-enabled extensions run on web servers located outside of your local network.
Sandboxed extensions run in a protected environment without access to any other
resource or service on the web.

Before adding a Network-enabled extension or viewing a dashboard with one, be certain
that you trust the website that hosts it. By default, dashboard extensions use the HTTPS
protocol, which guarantees an encrypted channel for sending and receiving data, and
ensures some privacy and security.
For more information about data security when using dashboard extensions, see Extension
Security - Best Practices for Deployment.

Allow or deny data access to a Network-enabled extension
Depending on how an extension is designed, it can access either visible data in a view, or
full underlying data, table and field names from data sources, and information about data
source connections. When you add an extension, or view a dashboard with one, you're
given an opportunity to allow or deny the extension to run and access this data.
If you're viewing a dashboard with an extension that requires full data access, and that
access has been denied, a message appears in place of the extension. If you trust the extension and want to use it, you can reset permissions and allow the extension to run.
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1. Select the extension in the dashboard, and from the drop-down menu in the upperright corner, choose Reset Permissions.
2. Click either Allow to let the extension run and access data, or Deny to prevent the
extension from running.

Ensure that JavaScript is enabled in Tableau Desktop
Dashboard extensions interact with data using the Tableau Extensions API library, a
JavaScript library. If you want to use extensions, be sure that JavaScript is enabled in the
dashboard security settings:
Choose Help > Settings and Performance > Set Dashboard Web View Security >
Enable JavaScript.

Ensure that extensions run on Tableau Cloud or Tableau
Server
You can add extensions to workbooks that you publish from Tableau Desktop or directly in
the web-authoring mode of Tableau Cloud and Tableau Server. A Tableau administrator
must allow extensions to run on a site and add Network-enabled extensions to a safe list.
Administrators should only allow extensions that you have tested and trust.
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If you want to use a dashboard extension on Tableau Cloud or Tableau Server, direct your
administrator to Manage Dashboard Extensions in Tableau Cloud or Manage Dashboard
Extensions in Tableau Server.

Supported web browsers for Sandboxed extensions
Sandboxed extensions run in all browsers supported by Tableau Server and Tableau Cloud
except Internet Explorer 11.

Supported versions of Tableau Server for Sandboxed extensions
You can use Sandboxed extensions in Tableau Server 2019.4 and later.

Get support for dashboard extensions
To get help for an extension, you'll need to contact the developer or company who created
it.
1. Select the extension in the dashboard, and from the drop-down menu in the upperright corner, choose About.
2. Click Get Support to go to the support page of the extension developer.
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Note: Tableau doesn't provide support for extensions or for other programs that
interface with the Extensions API. However, you can submit questions and ask
for help in the Tableau developer community.

Integrate External Actions
Note: This feature is being made available as a preview feature included as part of the
2022.3 release. When using this feature, you should proceed with caution until you have
validated that its configuration and use suits your needs. Please review the Integrate
External Actions topic in the Tableau online help for additional information about configuration, deployment and use.
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Note: External Actions in Tableau relies upon functionality provided by Salesforce
Flow. The feature sends your selected data to Salesforce Flow, which runs on separate Salesforce infrastructure. Use of Salesforce Flow and other Salesforce products
and services is subject to your agreement with Salesforce.

After seeing and understanding your data in Tableau, what’s next? Typically, taking action
from data insights involves pivoting from one application to another, often copying and pasting data and losing context along the way. With the Tableau External Actions feature, you
can create and interact with data-driven workflows directly from Tableau dashboards and
automate your next steps using Salesforce Flow.

About Salesforce Flow
If you’re not familiar with Salesforce Flow, it’s a no-code tool that provides time-saving process automations. A flow is a component of Salesforce Flow that collects data and performs
actions in your Salesforce org. There are several flow types available in Salesforce Flow,
but External Actions workflows in Tableau are only compatible with auto-launched flows.

Note: To learn more about flows, check out Build Flows with Flow Builder on Trailhead.

How External Actions work

1102

Tableau Software

Tableau Cloud Help
When an External Actions workflow is configured for a viz on a Tableau dashboard, a customised button appears on the corresponding viz in an unavailable (greyed out) state. When
you select a relevant mark on the viz (1), the button becomes available. Then, when you click
the button (2), data from the selected mark is sent directly to a flow that was built and configured in Salesforce Flow (3).
As the author of an External Actions workflow, you determine:
l
l
l

Which flow the data is sent to
Which dashboard the data comes from
The text and appearance of the dashboard button that triggers the workflow

Note: You can add multiple External Actions workflows to a dashboard, but each of the
corresponding flows must be deployed in the same Salesforce org.

Ways to use External Actions workflows
There are endless ways to use External Actions workflows to automate existing processes in
your organisation. For example, think of the effort saved by a workflow that lets accounting
team members send customer invoices directly from the same dashboard they use to track
unpaid orders. Or maybe you’re looking for ways to streamline your support team’s case
management. A workflow that lets support team members escalate cases directly from the
dashboard they use to track cases could be a significant time-saver. External Actions workflows help keep users in the flow of work, and enables your organisation to benefit from
increased efficiencies.
When you create an External Actions workflow, you’re essentially building a bridge that connects any type of data source in Tableau with a flow in Salesforce. Your data source doesn’t
need to be connected to a Salesforce database because the workflow itself creates that connection. This is particularly useful when there are multiple groups using separate data
sources to complete different steps of the same process.
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For example, think about all of the different teams and tools involved when a customer
places an order at an e-commerce site. E-commerce sales reps might use Salesforce to
track the sale while supply chain managers use a supply chain management tool to deduct
the purchased item from overall product inventory. Support teams that help the customer
troubleshoot any issues that arise when they receive their product might be logged in Salesforce or analysed in a Tableau dashboard. With an External Actions workflow, you can connect all of this data from each of these teams to streamline processes and even automate
some of the existing steps.

Best practices for External Actions workflow authors
Important: Dashboard authors using the External Actions feature to connect dashboard data with flows built in Salesforce Flow should closely collaborate with the Salesforce admins and architects who created the flows.

Flows built in Salesforce Flow are sophisticated business automation programs. Although
your organisation can greatly benefit from these automations, it’s important to understand
how flows work before deploying External Actions workflows that use them. Be sure to complete the Salesforce Flow training on Trailhead and review the Flows documentation. Consider Flow Best Practices in your design, and keep Flow Limits and Considerations in mind.

Note: There are several flow types available in Salesforce Flow, but External Actions
workflows are only compatible with auto-launched flows.

External Actions workflows must be carefully implemented to align with the architectural
constraints of flows built in Salesforce Flow. Flows are powerful, but they can also be
resource-intensive and complex. There are potential licensing, execution throttling and concurrency issues to consider, and database read/write limits that must be evaluated and
tested.
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There are also important security considerations related to flows. Users with the Manage
Flows permission can view and change all data and resources in the corresponding Salesforce org. Users with the Run Flows permission can run nearly any active flow in the Salesforce org. To restrict access to only those who require it (such as dashboard authors and
workflow users), your Salesforce admin can enable the override default behaviour setting for
a flow. For more information, see How Does Flow Security Work?
Dashboard authors who are creating External Actions workflows should communicate with
their Salesforce admins before implementing workflows to prevent undesired results.

Create a workflow
Before creating an External Actions workflow, dashboard authors should collaborate with
their Salesforce admins to find or create a flow that meets their needs. For example, if your
goal is to help your accounting team send invoices directly from an unpaid orders dashboard,
you need a flow that can retrieve the customer contact information and order details from the
dashboard and populate the invoices.
After you decide which flow to use, the next step is identifying a dashboard to connect it to.
It’s likely that your users are already interacting with an existing dashboard that would work
well. However, if necessary, you can create a new dashboard.
With the right flow and the right dashboard in mind, it’s time to think about the compatibility of
the data types in the dashboard with the flow’s required input fields (known as variables). For
example, your unpaid orders dashboard must contain a viz with all of the relevant order
details needed to send customer invoices (such as order date, customer name and contact
information, item descriptions and amounts and payment amount due).
When your dashboard contains all of the required components, add the Workflow object:
1. In a Tableau workbook, open an existing dashboard or create a new one.
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2. From the Objects section of the Dashboard pane, drag Workflow to a viz in the
dashboard.

3. When prompted, enter your log-in credentials for the Salesforce org associated with
your flow.

Note: When users access the dashboard where you set up your workflow, they
must enter their Salesforce credentials. If their Salesforce credentials expire
while viewing the dashboard, they are prompted to reauthenticate.

4. Click Configure Workflow.
5. In the Add Workflow dialog, search for a flow by flow name or flow author.
6. Select a flow to view its details, including the required inputs (Salesforce variables) it
needs from the viz. Click Back to select a different flow, or click Next to continue.

7. From the Select Sheet drop-down, select a sheet (worksheet, dashboard or story)
that contains the marks your users will select and send to the flow.

Note: Be sure to select a sheet that has marks with the encoded fields you want
to map to the flow’s required inputs. For example, if you want to map the forecast_revenue variable in the flow to the SUM(Sales) field in Tableau, you
must select a sheet with marks that are encoded with the Sum(Sales) field.
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8. Click Next.
9. For each of the flow's required inputs (Salesforce variables), select an appropriate
field from the Tableau sheet you chose in the Select Sheet step.

Note: For each input, the data type of the Salesforce variable and Tableau field
must match.

10. Click Next.
11. Configure the appearance of the button that users click to trigger the External Actions
workflow. Specify a button title, background colour and border colour. Check the preview to confirm the button's appearance.

Note: Remember that users must select a mark from the viz that you chose in the
Select Sheet step. Until a mark is selected, the button is not available. Consider
adding guiding text to the dashboard so that users know exactly what viz to interact with and what will happen when they click the button.

12. Click Done to create the workflow and add the corresponding button to the viz in the
dashboard.

Use a workflow
To get started as a workflow user, open the dashboard where your dashboard author has
added a workflow. You can confirm that a workflow is available if a workflow button displays.
The dashboard author customizes the name and format of the button, and it should clearly
indicate the action triggered when you click it (such as "Send Data" or "Update Record").
Select a relevant mark from a viz in the dashboard, and then click the button to start the workflow.
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Clicking the workflow button triggers the transmission of data, and the mark you select
determines what data is sent. For that reason, the button is unavailable (greyed out) until
you select a mark. If you’ve selected a mark but the button is still unavailable, verify that
you’ve selected a mark on a valid viz for the workflow. If you aren’t sure which vizzes are
valid, check with the dashboard author.
Depending on their configuration, some workflows might be long-running operations that do
not complete immediately. If you’re unable to determine whether the workflow you selected
is working as expected, check with the dashboard author or your Salesforce admin.

Troubleshoot a workflow
For help resolving issues with an External Actions workflow, see the following troubleshooting guidance.

Access issues
l

l
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For dashboard authors using Tableau Desktop: If the Workflow object doesn’t
appear in the Objects section of the Dashboard pane, confirm that you’re signed in to
a Tableau Server or Tableau Cloud site. If you aren’t signed in, you won’t be able to
access the Workflow extension.
For dashboard authors: If the Workflow object doesn’t appear in the Objects section of the Dashboard pane, check with your Tableau admin to ensure that the extension is turned on.
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l

For all users:
l If your Salesforce admin hasn’t created a connected app, the External Actions
feature won’t work. Ask your Salesforce admin to create a connected app in
l

Salesforce for Tableau Server.
If you’re unable to click a workflow button that displays on a dashboard, confirm
that you’ve selected a mark on a valid viz for the workflow. If you aren’t sure
which vizzes are valid, check with the dashboard author.

Authentication issues
l

l

For Tableau Cloud or Tableau Server users: Refresh the dashboard in your
browser.
For all users: Confirm that you’ve signed in to the Salesforce org where the External
Actions workflow was added. If necessary, check with your dashboard author to confirm the correct Salesforce org.

Error messages
Error Message

Explanation and Resolution

Workflow is turned off on

Your Tableau admin has turned off the Workflow dashboard

this site. For more inform-

extension for your site, so it is not available for your use.

ation, contact your

Contact your Tableau admin to discuss turning on access to

Tableau administrator.

the extension.

Workflow isn’t supported

The Workflow dashboard extension and External Actions fea-

by Tableau Reader

ture can only be used to send data to a flow using Tableau

Cloud, Tableau Desktop, or Tableau Server versions 2022.3
and later.
Flow contains one or

The selected flow requires a data type input that is not avail-

more unsupported data

able in Tableau dashboards, or is otherwise incompatible

types. Go back to select a

with External Actions workflows. Select a different flow if a

different flow, or contact

suitable alternative exists, or check with your Salesforce

your Salesforce Flow

admin for next steps.

administrator to remove
unsupported data types
from this flow.
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Error Message

Explanation and Resolution

One or more data type

The data type for one or more of the dashboard values

mismatches exist in the

mapped to the input variable fields aren’t identical.

mapping of input fields.
For example, the flow might require a numeric variable for
Revenue, but the mapped value from the dashboard was a
text string. Depending on your scenario, you have two
options to fix this. You can change the data type of the Revenue field in Tableau from a text string to a numerical value.
Or, you edit the workflow configuration to map a different field
from the dashboard that has a numerical data type.
Unable to submit data to

An unknown error occurred while the External Actions work-

Salesforce Flow.

flow attempted to send data from the dashboard to the flow.
Contact your dashboard author to troubleshoot.

Error occurred: <excep-

The flow interview (running instance of the flow) failed. Share

tion code>. Contact your

the exception code with your Salesforce admin so they can

Salesforce Flow admin-

find the corresponding error email and troubleshoot accord-

istrator.

ingly.

Workflow failed. Contact

The data from the selected mark in the dashboard was sent

your Salesforce Flow

to the flow, but there was an issue in translating that data to

administrator.

the flow. Contact your Salesforce admin to troubleshoot.

Unable to submit data to

The data from the selected mark in the dashboard was not

flow. Contact your work-

sent to the flow. Contact your dashboard author to

flow author.

troubleshoot.

Flow issues
l

Some flows run asynchronously, so you may not immediately know whether a flow
that’s part of an External Actions workflow ran successfully. At times, a flow might fail
and rollback changes without immediately providing detailed feedback. However,
when a flow fails, a detailed error email is sent to the workflow user, dashboard author
and Salesforce admin. Workflow users should contact their dashboard authors when
they receive a flow error email. Dashboard authors and Salesforce admins can then
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work together to troubleshoot and resolve the error. For more information on
troubleshooting flow issues, see Troubleshoot Flows.

Licensing issues
l

For dashboard authors: On the Tableau side, no special permissions are required
to add a workflow to a dashboard (as long as External Actions are enabled for the site).
On the Salesforce side, you’ll need the Manage Flows permission added to your Salesforce profile.

l

For workflow users: On the Tableau side, any user who can access a dashboard
with a workflow can run it. From the Salesforce side, you’ll need the Run Flows per-

mission added to your Salesforce profile.

Turn External Actions On or Off
In Tableau 2022.3 and later, the External Actions feature is turned on by default. For more
information on how Tableau admins can configure org-wide access to Tableau External
Actions, see Configure External Actions Workflow Integration.

Format Animations
Animate visualisations to better highlight changing patterns in your data, reveal spikes and
outliers and see how data points cluster and separate.
Animations visually transition between filter, sort and zoom settings, different pages and
changes to filter, parameter and set actions. As visualisations animate in response to these
changes, viewers can more clearly see how data differs, helping them make better informed
decisions.

Understanding simultaneous and sequential animations
When you author animations, you can choose between two different styles: simultaneous or
sequential. Here are examples of each type.
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Simultaneous animations
The default simultaneous animations are faster and work well when showing value changes
in simpler charts and dashboards.

Click the image above to replay the animation.

Sequential animations
Sequential animations take more time but make complex changes clearer by presenting
them step-by-step.

Click the image above to replay the animation.
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Animate visualisations in a workbook
When you create a new workbook, Tableau enables animations for your viz by default. You
can turn animations on or off at the user and workbook level.
1. Choose Format > Animations.
2. If you want to animate every sheet, under Workbook Default, click On. Then do the
following:
l

For Duration, choose a preset, or specify a custom duration of up to 10
seconds.

l

For Style, choose Simultaneous to play all animations at once or Sequential
to fade out marks, move and sort them and then fade them in.

3. To override workbook defaults for a particular sheet, change the settings under Selected Sheet.

Note: In the Selected Sheet section, “(Default)” indicates a setting that auto-
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matically reflects the related Workbook Default setting.
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To replay an animation, click the Replay button in the toolbar. From the Replay button, you
can also choose the speed at which the animation replays: actual speed, 2x speed or 1/2
speed.

Reset animation settings for a workbook
You can reset animations to return an entire workbook to the default animation settings. Be
aware that this turns animations off by default.
1. Choose Format > Animations.
2. In the middle of the Animations pane, click Reset All Sheets.

Completely disable all animations
When you create a new workbook, animations are enabled by default. If you find animations
distracting while viewing vizzes, you can completely disable them so they never play. (This
isn't a system-wide setting; each user needs to apply it separately.)
l

In Tableau Desktop, choose Help > Settings and Performance, and deselect
Enable Animations.

l

In Tableau Cloud or Tableau Server, click your profile image or initials in the top-right
corner of the browser, and choose My Account Settings. Then scroll down to the
bottom of the page, deselect Enable animations, and click Save Changes.

Note: When animations are disabled, you can still choose Format > Animations in
authoring mode and adjust settings – but they will have no effect.
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Format decimals for axes animations
If the number of decimal places for a measure is set to the default, then the number of decimals shown during the axis animation might fluctuate during the axes animation. To avoid this,
format the number of decimal places displayed for a measure. For more information, see
Format Numbers and Null Values.

Why animations won't play
Server rendering
Animations won't play if a viz is server-rendered. To ensure that vizzes render on a client
computer or mobile device, use these techniques:
l

If you're a viz author, reduce viz complexity.

l

If you're a Tableau Server administrator, increase the complexity threshold for clientside rendering.

Note: On computers with lower processing power, animations may appear choppy, but
users can continue to interact with vizzes without any delays in responsiveness.

Unsupported browsers and features
Animations are supported by all web browsers except Internet Explorer.
The following Tableau features don't animate:
l

Maps, polygons and density marks in web browsers

l

Pie and text marks

l

Headers

l

Forecasts, trends and reference lines
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l

Page history trails (If a viz includes these, turn off animations to avoid unexpected
behaviour.)

URL Actions
A URL action is a hyperlink that points to a web page, file, or other web-based resource outside of Tableau. You can use URL actions to create an email or link to additional information
about your data. To customise links based on your data, you can automatically enter field
values as parameters in URLs.
Tip: URL actions can also open in a web page object in a dashboard. See Actions and
Dashboards to learn more.

A URL action run from a tooltip menu. The link reflects the action name, not the target URL.

Open a web page with a URL action
1. On a worksheet, select Worksheet > Actions. From a dashboard, select Dashboard > Actions.
2. In the Actions dialog box, click Add Action and then select Go to URL.
3. In the next dialog box, enter a name for the action. To enter field variables in the
name, click the Insert menu to the right of the Name box.
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Note: Give the action a descriptive name, because the link text in the tooltip is the
name of the action, not the URL. For example, when linking to more product
details, a good name could be "Show More Details".

4. Use the drop-down list to select a source sheet or data source. If you select a data
source or dashboard you can select individual sheets within it.

5. Select how users will run the action.
If you

The action is run when the user...

choose this
option...
Hover

Mouses over a mark in the view. This option works best for highlight
actions within a dashboard.

Select

Clicks a mark in the view. This option works well for all types of
actions.

Menu

Right-clicks (control-clicks on Mac) a selected mark in the view, then
clicks an option in a tooltip (menu). This option works particularly well
for URL actions.

6. For URL Target, specify where the link will open:
l New Tab if No Web Page Object Exists – Ensures that the URL opens in a
browser on sheets that lack web page objects. This is a good choice when
Source Sheets is set to All or a data source.
l

New Browser Tab – Opens in the default browser.
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l

Web Page Object – (Available only for dashboards with Web Page objects)
Opens in the web page object you select.

7. Enter a URL
l The URL should start with one of the following prefixes:http, https, ftp,
mailto, news, gopher, tsc, tsl, sms, tel, file

Note: If no prefix is entered, http:// is automatically appended to the
beginning and the URL action will work in Tableau Desktop. However, if a
URL action with no prefix is published to Tableau Server or Tableau
Cloud, it will fail in the browser. Always provide a fully qualified URL for
actions if the dashboard will be published.

Note: You can specify an ftp address only if the dashboard doesn't contain
a web object. If a web object exists, the ftp address won't load.

l

Tableau Desktop also supports local paths like C:\Example folder-

\example.txt
l

To enter field and filter values as dynamic values in the URL, click the Insert
menu to the right of the URL. Be aware that any referenced fields must be used
in the view. For details, see Using field and filter values in URLs.
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Below the URL you enter is a hyperlinked example you can click for testing.
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8. (Optional) In the Data Values section, select any of the following options:
l Encode Data Values that URLs Do Not Support – Select this option if your
data contains values with characters that browsers don't allow in URLs. For
example, if one of your data values contains an ampersand, such as “Sales &
Finance”, the ampersand must be translated into characters that your browser
understands.
l

Allow Multiple Values via URL Parameters – Select this option if you are
linking to a web page that can receive lists of values via parameters in the URL.
For example, say you select several products in a view and you want to see
each product’s details hosted on a webpage. If the server can load multiple
product details based on a list of identifiers (product ID or product name), you
could use multi-select to send the list of identifiers as parameters.
When you allow multiple values, you must also define the delimiter escape
character, which is the character that separates each item in the list (for
example, a comma). You must also define the Delimiter Escape, which is used
if the delimiter character is used in a data value.

Create an email with a URL action
1. On a worksheet, select Worksheet > Actions. From a dashboard, select Dashboard > Actions.
2. In the Actions dialog box, click Add Action, and select Go to URL.
3. In the Source Sheets drop-down list, select the sheet that contains the field with the
email addresses you want to send to.
4. In the URL box, do the following:
l Type mailto:, and click the Insert menu at right to select the data field that contains email addresses.
l

Type ?subject= , and enter text for the Subject line.

l

Type &body= , and click the Insert menu at right to select the fields of information that you want to include in the body of the email.

In the example below, the “Email” field contains the email addresses, the subject is
“City Information”, and the body text of the email consists of the city and state data
that is associated with the email address.
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:
5. (Optional) Display data from your workbook in the body of your email as a vertical list
instead of the default horizontal list. For example, suppose you have a horizontal list of
cities, such as Chicago, Paris, Barcelona, which you would rather display vertically, like
this:
Chicago
Paris
Barcelona
To make the list vertical, in the Data Values section, do the following:
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l

Deselect Encode Data Values that URLs Do Not Support

l

Select Allow Multiple Values via URL Parameters.

l

Type %0a in the Value Delimiter text box to add line breaks between each
item in the list. (These are the URL-encoded characters for a line break.)

Using field and filter values in URLs
When users trigger URL actions from selected marks, Tableau can send field, filter and
parameter values as variables in the URL. For example, if a URL action links to a mapping
website, you could insert the address field to automatically open the currently selected
address on the website.
1. In the Edit URL Action dialog box, begin typing the URL for the link.
2. Place the cursor where you want to insert a field, parameter or filter value.
3. Click the Insert menu to the right of the text box and select the field, parameter, or filter you want to insert. The variable appears within angle brackets. You can continue
adding as many variables as you need.

Note: Any referenced fields must be used in the view. Otherwise, the link won't
display in the viz, even if it functions when you click Test Link.
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Including aggregated fields
The list of available fields includes only non-aggregated fields. To use aggregated field values as link parameters, first create a related calculated field, and add that field to the view. (If
you don't need the calculated field in the visualisation, drag it to Detail on the Marks card.)

Inserting parameter values
When inserting parameter values, URL actions send the Display As value by default. To
instead send the actual value, add the characters ~na after the parameter name.
For example, say you have a parameter that includes IP addresses, with Actual Value
strings such as 10.1.1.195 and Display As strings with more friendly values such as Computer A (10.1.1.195). To send the actual value, you'd revise the parameter in the
URL to look like this: http://<IPAddress~na>/page.htm.
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Create a Subscription to a View or Workbook
Subscriptions email you an image or PDF snapshot of a view or workbook at regular intervals – without requiring you to sign in to Tableau Cloud.
Note: If Tableau Catalogue is turned on for a site, administrators can determine whether
subscription emails include relevant upstream data quality warnings. Tableau Catalogue is
available as part of the Data Management offering. For more information, see About
Tableau Catalogue.

Tableau Cloud SMTP addresses
To ensure subscription emails are delivered successfully, confirm that security software and
policies in your company allow emails from @cloudmail.tableau.com and IP
addresses 54.240.86.205 and 54.240.86.204. Subscriptions that cannot be delivered may
return rejection errors to Tableau and temporarily block the recipient.

Set up a subscription for yourself or others
When you open a view in Tableau Cloud, if you see a subscription icon (

) in the toolbar,

you can subscribe to that view or to the entire workbook. You can subscribe other users
who have permission to view the content if you own a workbook, if you are a project leader
with an appropriate site role, or if you are an administrator.

Note: Data refresh-initiated subscription emails are not supported for views or workbooks that rely on data sources that use Bridge to keep data fresh.

1. From the Explore section of your site, select All Workbooks or All Views, or open
the project that contains the view you want to subscribe to.
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2. Open a view either directly, or after opening the containing workbook.
3. On the view toolbar, select Watch > Subscriptions.

4. Add the Tableau users or groups you want to receive the subscription. To receive a
subscription, users must have the View and Download Image/PDF permissions.
If you own the workbook, select Subscribe me.

Tableau Software

1127

Tableau Cloud Help
Note: When you subscribe a group, each user is added individually at the time
the subscription is created. If more users are added to the group later, you must
re-subscribe the group for those new users to receive the subscription. Likewise,
users later removed from the group will not have their subscriptions removed
automatically unless their permissions to the subscribed view are removed.

5. Choose whether subscription emails include the current view or the entire workbook.
If the view contains data only when high-priority information exists, select Don't send
if view is empty.
6. Choose the format for your snapshot: as a PNG image, a PDF attachment or both.
l

If PDFs, choose the paper size and orientation you'd like to receive.

7. To clarify subscription emails, customise the subject line and add a message.
8. When the workbook uses one data extract on a published connection, you can pick a
frequency:
l

l

When Data Refreshes: Sends only when data in the view or workbook is
refreshed by running refresh schedules.
On Selected Schedule: Pick a schedule for the subscription.

9. If frequency is not set to When Data Refreshes, click the drop-down arrow to the left
of the current settings to pick a schedule:
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Then specify a custom schedule that sends subscription emails whenever you wish.
(The precise delivery time may vary if server load is high.)

To change the time zone, click the Time Zone link it to go to your account settings
page.
10. Click Subscribe.
When you receive a subscription email, you can select the image (or the link in the message
body for PDF subscriptions) to be taken to the view or workbook in Tableau Cloud.

Update or unsubscribe from a subscription
You can unsubscribe from an existing subscription, or make changes to a subscription’s
format, schedule, subject or empty view mode.
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1. Access your Tableau Cloud account settings by doing one of the following:
l

Click Manage my subscriptions at the bottom of a subscription email.

l

Sign in to Tableau Cloud. At the top of the page, select your user icon, and
then select My Content.

2. Click Subscriptions.
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3. Tick the box next to the view you want to unsubscribe from, click Actions, and then
click Unsubscribe, or select the subscription option you'd like to change.

Resume or delete suspended subscriptions
Sometimes, subscriptions fail because of an issue with the workbook or a problem loading
the view. If a subscription fails more than five times, you'll receive a notification email that
your subscription has been suspended. There are a few ways to resume a suspended subscription if you're a subscription owner or administrator:
l

From the My Content area of Tableau web pages, an icon appears in the Last update
column to indicate that the subscription is suspended. Select ... > Resume Subscription to resume.

l

From the Subscriptions tab of the affected workbook, an icon appears in the last
update column to indicate that the subscription is suspended. Select ... > Resume
Subscription to resume.

You'll receive an email notification when the subscription is working again.

See also
Change subscription settings in the Tableau Desktop and Web Authoring Help.
Project-level administration in the Tableau Cloud Help, to learn which site roles allow full Project Leader capabilities.

View Acceleration
Workbook owners who have creator or explorer licences can accelerate workbooks. Administrators can suspend individual views or turn off acceleration for their site. View Acceleration
loads views faster by pre-computing and fetching the workbook's data in a background process. There are two potential bottlenecks when loading a view:
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1. Querying (fetching data from the data source).
2. Rendering (creating the visuals, such as drawing shapes or rendering a map).
The time it takes to load a workbook depends on the combined time it takes to do these two
steps. However, not all views can be accelerated. View Acceleration improves the performance of the query step, so a workbook performance won’t improve significantly if its
query step is already fast and there isn’t a performance bottleneck on load.
In addition, View Acceleration relies on pre-computation. The following factors impact the
effectiveness of View Acceleration:
l
l

A view uses transient functions, such as now() or today().
A view relies on user-based functions to provide different results for different users.
Even though Tableau Server could pre-compute results for all users, doing so sig-

l

nificantly increases CPU, memory and storage usage.
A view has an extract refresh schedule that exceeds the daily limit. Accelerated views
are regenerated when the extract is refreshed. To limit resource consumption, we

l

limit the maximum number of jobs that can be run (12 per day).
A view’s owner is inactive. Acceleration jobs run on behalf of the view owner. If the

l

owner is inactive, the job fails.
A view can’t be loaded because the embedded credentials expired or the data source
was deleted.

When users create custom views on top of an existing view and accelerate the custom view,
both the original view and the custom view are accelerated. However, if a custom view
hasn’t been accessed in the last 14 days, the custom view can’t be accelerated. Finally, in
addition to the original view, up to 10 custom views can be accelerated for each original
view.

Note: View Acceleration isn’t available in Tableau Desktop.

Accelerate your view
1. Sign in to a site on Tableau Cloud or Tableau Server.
2. From the Home or Explore page, navigate to the view you want to accelerate.
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3. Click on the Accelerate icon, and click the switch to Accelerate.

You can also accelerate views from the workbook page:

Understand why View Acceleration is unavailable
There are a few reasons that acceleration isn’t available for a view. Acceleration pre-computes long-running queries, so accelerated workbooks load faster. But if the view is already
loading as fast as it can, acceleration isn’t available because it won’t significantly improve the
performance of the view.
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Similarly, if you use a data freshness policy that is less than 4 hours, acceleration isn’t available because the cost is high for accelerating the views that are refreshed so frequently,
and Tableau doesn’t want to overload your site performance. For more information, see Set
a Data Freshness Policy.
If your administrator has suspended acceleration for your view, contact your Tableau administrator to activate acceleration for your view. Similarly, if the site has reached the limit for
the number of views that can be accelerated for your site, contact your Tableau administrator.
To pre-compute the data, Tableau needs to connect to the data source in the background
without requiring user interaction. Therefore, View Acceleration is only supported for workbooks with embedded connection credentials.

Manage View Acceleration on your site
By default, View Acceleration is allowed.
1. Sign in to your site on Tableau Cloud.
2. From the left pane, choose Settings.
3. From the General tab, scroll to the View Acceleration section.
4. Select the tick box to allow creators and explorers to accelerate views in their
workbooks. Clear the tick box to turn off View Acceleration for the site.

Automatically suspend acceleration to save resources
To conserve resources, administrators can automatically suspend acceleration for views
that are consistently failing. Administrators can set a threshold for the number of times an
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acceleration task can fail per day, week or month before the acceleration is automatically suspended.
1. Sign in to your Tableau site.
2. From the left pane, choose Settings.
3. From the General tab, scroll to the View Acceleration section.
4. Set the maximum number of failures allowed per day, week or month.
5. Click Save.

View and manage accelerated workbooks
1. Sign in to your Tableau site.
2. From the left pane, choose Tasks.
3. Click on the Accelerated Views tab.
4. Choose the Actions menu (...) to Resume or Suspend Acceleration for the selected
view or views.

Manage View Acceleration notifications
Administrators can manage whether to receive notifications for views that are automatically
suspended.
1. Sign in to your Tableau site.
2. From the left pane, choose Settings.
3. From the General tab, scroll to the Manage Notifications section.
4. To receive notifications for views that are automatically suspended, tick the box for
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View Acceleration.
5. Click Save.
When views are automatically suspended, notifications are sent to site and server administrators. The notification includes information about why the view was suspended and the
time that the view was suspended. Click the notification to go to the Accelerated Views tab
of the Tasks page. From this page, administrators can filter the Acceleration Status to find
views that were automatically suspended.

Understand user context for Precomputation
Precomputation for accelerated workbooks is performed with the user context of only one
user. This user is either:
l

The owner of the workbook (if there are no user filters in the workbook or data source,
or if there are user filters on the data source but the data source is a published data
source).

l

-orThe user that was selected for thumbnail generation the last time the workbook was
published (if there are user filters on the workbook and the data source isn't a published data source).

Publish Views to Salesforce (Limited Preview)
Bring your views from Tableau Cloud right to your Salesforce ecosystem by publishing
views to a CRM Analytics app or Salesforce Lightning page.
Tip: Publishing to Salesforce is available exclusively to customers participating in a limited
preview.

Prerequisites
1. You must have an Explorer (can publish) role.
2. An administrator must update the Integrations site settings to allow users to publish
views to Salesforce.
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Publish a view to Salesforce
Select one or more views, including dashboards, sheets and stories. Then, choose a destination from a list of CRM Analytics apps to which you have access to edit or manage.
1. Select the view that you want to publish to Salesforce.

Note: You can select a maximum of 25 views at a time to publish to Salesforce.

2. For Actions, select Publish to Salesforce.
3. Select the Salesforce credentials that you want to use for publishing.
4. Select the destination app that you want to publish to. You can only see apps that you
can edit or manage with the signed-in Salesforce user.

5. Click Publish.
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Connected app session timeout
By default, the timeout value for the connected app is 1 hour. If you want to publish views to
Salesforce after your initial session expires, you must re-authenticate.
You can choose to extend the timeout value for your connected apps to a maximum of 24
hours.
1. First, update the session policy Timeout Value for the connected app. For instructions, see Manage Session Policies for a Connected App.

2. Then, configure the session security timeout settings. Update the Timeout Value to
match the value that you entered for the connected app session policy. For instructions, see the Configure Session Timeout Settings section of Modify Session

Security Settings.

Who can see the published view in Salesforce?
When you publish a view to Salesforce, anyone with access to the selected CRM Analytics
app or Lightning page can see that the content exists. However, only those signed in with
existing Tableau permissions can see the view.

Interact with Data in Tableau
This tutorial walks you through some of the basics of viewing and interacting with data visualisations, or views, in Tableau Server.
Tableau is a tool that lets you interact with published visualisations to explore insights, ask
questions and stay on top of your data. Here’s how to get started.

Go ahead. It’s safe to click around
Tableau is built for interaction. What you do to a visualisation changes how it looks for you,
just for now.
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Others will still see the visualisation as it originally appeared. And the data used to build it
stays the same, too.

1: What is a Tableau Site?
A Tableau Site is a place for your team to share data and data visualisations with each other.
You can explore what they’ve published and made available to you.
When you sign in to your Tableau site, you’ll land on the home page.

2: Search for a viz
Tableau calls visualisations on a site Views. Use search to find views or workbooks (a package of views in a single file).
Search results will show all the different content types relevant to your query.
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You can select See All for all search results if the views in the quick search aren’t what you
were looking for, or use the Explore page to browse. There you’ll see all the different types
of content a Tableau site can host.
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3: Interact with Content
A published view is a canvas for you to interact and understand your data. Remember, you
won’t hurt or change the underlying data, or change what others see.
Here are some of the tools in your toolbox to find data insights.

See Details and Sort Data
Now that you know you can click on the data, let’s check it out.
As you move the mouse across a view, you might see tooltips that reveal details about each
data point, or mark. You can also select multiple marks.

Sort tables alphabetically or numerically by hovering over a column header and clicking the
sort icon.
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Filter Data
Trim or limit the visible data to a specific area, date or category.
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Undo/Revert
Maybe you didn’t mean to exclude everything but one area. Click Undo to remove the last
change, or use Revert to undo all your selections.

4: Keep up
This view can automatically update with new data, so you don’t need to go searching for new
charts to get the latest information. Keep it handy by clicking the star icon to add it to your
favourites.

All favourites are added to the Favourites page in the navigation panel. And any recent dashboard or view you explored also appears in the Home page, waiting for you next time.
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There’s a lot you can do in Tableau Server, and this just explored some of the basics. For
more information, see What Can I Do with a Tableau Web View?
Happy exploring!

Create and Troubleshoot Metrics
Metrics provide a fast way to stay informed about your data. Because metrics update automatically and display their current value in the grid and list view of your content, you can
check all the key numbers you care about in seconds.
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At their most basic level, metrics show the value of an aggregate measure, like the sum of
sales. More complex metrics can include timelines, comparisons and statuses that provide
an easy-to-understand indicator of how you’re performing relative to a prior point in time or a
value you have defined.
If you have a set of dashboards that you regularly check, create metrics for the numbers that
you want to monitor then track them in one place by adding them to your favourites or a collection, or by creating them in the same project. That way, you don’t need to load and filter
the dashboards unless you want to dig deeper into your data.

Find metrics on your site
There are a few ways to find metrics on your Tableau site. To browse all the metrics that you
have permission to view, navigate to the Explore page, then select All Metrics from the content type menu.
If you’re looking for metrics related to a particular view or workbook, check the connected
metrics for that content. To see connected metrics for a view, open the view, then click
Watch > Metrics in the view toolbar. The metrics displayed are ordered from the newest creation date to the oldest.
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To see connected metrics for all the views in a workbook, navigate to the workbook, then
click the Connected Metrics tab. You can sort these metrics using the Sort By menu.
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Components of a metric
The only data required to define a metric is an aggregate measure. Metrics are created from
a mark in a view, and the measure associated with that mark defines the metric. The measure must be aggregated because an unaggregated mark will not change over time. For
information about dimensions and measures in Tableau, see Dimensions and Measures,
Blue and Green.
A metric can optionally be defined by a date dimension, and you can configure a comparison
and a status for your metric. Each of these components will add context to the data presented on the metric card.
Metrics that have only a measure defining them will appear as a single number. This number
will update when the data updates, but there will be no timeline on the card.
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Timeline
When you select a mark to define a metric, if the mark has a date dimension associated with
it, that dimension becomes part of the metric definition. Metrics with a date dimension show
a timeline, and you can configure the historical comparison for the metric. By default, the historical comparison is to the previous mark.
When you open a metric’s details page, the timeline shows the value of the measure based
on the granularity of the date dimension, for example, daily sales or monthly users. Hover
over the points on the timeline to see historical values.
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Comparison
There are two types of comparisons that you can configure for metrics: historical comparisons and constant comparisons. You can configure a historical comparison only if a metric has a date dimension associated with it, but constant comparisons can be added for any
type of metric.
A historical comparison is a relative comparison between the current value and a specified
number of hours, days or other unit of time previous. For example, you could set a comparison between the current value for monthly sales and the value from 12 months ago.
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Every time data is added to a metric, the historical comparison will adjust relative to the date
or time of the new data.

Constant comparisons are to a single value that doesn’t change as new data is added. You
might set a comparison to represent a threshold to stay above, for example, if you need to
maintain a 90% on-time delivery rate. Or you might define a cumulative goal you are working towards, for example, a monthly sales target.
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Status
For metrics with a constant comparison, you can define whether being above, below or at
the comparison value is good, bad or neutral. A metric with a “good” status will display a tick
next to the comparison value, and the metric card will have a green band at the top. A metric
with a “bad” status will display an X next to the comparison value, and the metric card will
have a red band at the top. Metrics with a “neutral” status appear the same as metrics
without a status indicator; there is no icon or colour applied to the card.
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Create a metric from a view
If you have a site role of Creator or Explorer (can publish), and you have the Create/Refresh Metric capability on the relevant workbook, you can create metrics on Tableau Cloud
or Tableau Server.
Before you create a metric, check the connected metrics for the view to make sure that the
metric you are planning to create doesn’t already exist. Instead of creating a duplicate metric, open the existing metric and add it as a favourite.

Select the mark to define your metric
1. Navigate to the view that you want to create a metric from.
2. On the view toolbar, select Watch > Metrics.

The metrics pane opens.
3. If the pane shows connected metrics, select the Create button to enter authoring
mode.
4. Select a mark. If you encounter an error, see When you can’t create a metric.
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The measure associated with this mark defines your metric. Any filters you apply to the
mark are applied to your metric. If this mark has a date dimension associated with it,
that date dimension also defines your metric, and your metric will display a timeline.
The metrics pane shows a preview of your metric. The value in the preview is the most
recent value for the metric, which may differ from the value of the mark you selected if
it was not the most recent in the time series. The preview updates as you try different
configurations.

Describe and configure your metric
The options available to configure your metric depend on the mark you select and on the type
of comparison you choose.
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1. The Name field is pre-populated based on the mark you select. You can give the metric a different name. A metric must have a unique name within the project it belongs
to.
2. Under Description, enter an optional message to help others understand your metric. For example, describe filters applied to the metric or indicate the data source used
by the metric.
3. For the Date Range (only for metrics with a date dimension), select one of the
default options, or set a custom range. If your metric has a large number of marks, limiting the date range can make it easier to read the timeline.
4. Select the Comparison Type for the metric: historical or constant.
5. For Historical comparisons:
l

Enter how far prior you want to compare against. The unit of time for the comparison is the same as the granularity of your data, such as hours or months.

l

Select Show Comparison Line to include a second line for the comparison
period on the timeline.

6. For Constant comparisons:
l

Enter the value to compare against. Don’t include commas or symbols in this
field. To enter a percentage, simply type the number without the percent sign,
for example, enter 25 instead of 0.25 for a target of 25%. When you enter a
valid target value, the preview updates to show how far above or below the target the current value is.

l

Set the Status for the comparison to indicate whether being above, at or below
the value is good, bad or neutral. By default, the status is set to neutral. Check
the metric preview to see how different statuses affect your metric.

7. Under Definition > Measure, select the measure to use for your definition from the
drop-down. This option appears only if the mark you select has more than one measure associated with it.
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Finalise your metric
1. Under Project, select Change Location to choose a different project for the metric.
By default, your metric will be added to the same project that the view belongs to.
Every metric in a project must have a unique name. Because a metric’s name and project are initially set based on the mark you select, you might run into a conflict when
you try to save your metric, if another user has already created a metric from that
mark. Either choose a different project or name for your metric or, if you want to overwrite the existing metric, see Overwrite a metric.
2. Click the Create button.
A message appears with a link to the metric in the project you added it to.

3. Verify that the permissions for your metric are correct, following the guidance in Set
permissions.
By default, a metric inherits the permissions of the project it is created in. Anyone with
access to your metric will be able to see the metric's data, even if they don’t have permission to access the connected view or data source.
Now that you’ve created a metric, you can manage the metric the same way you manage
other independent pieces of content on your Tableau site. Though metrics are created from
a view, they exist independently of that view, unlike data driven alerts or subscriptions. You
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can move the metric to a different project without moving the connected view. For information about managing content on your Tableau site, see Manage Web Content.

Overwrite a metric
Once a metric is created, you can change the name, description and configuration of the
metric, but you can’t change how the metric is defined. If you want to change the data that
the metric uses, you must overwrite it. In order to overwrite a metric, you need to be the metric owner or be granted the correct permission capability.
1. To overwrite a metric, create a metric with the same name in the same project as the
metric you want to overwrite.
The Overwrite Metric dialog appears.
2. Click the Overwrite button.
When you overwrite a metric, the metric continues to appear for those who have added it to
their favourites, and any changes made to permissions for the previous metric will apply to
the new metric.

When you can’t create a metric
If you select a mark on a chart that doesn’t support metrics, you’ll get an error message
explaining why you can’t create a metric. The table below summarises these scenarios.
Reason
You don’t have the correct

Scenarios
l

permissions.

The workbook owner or an administrator has
denied the Create/Refresh Metric capability. For
more information, see Permissions.

You can’t access the com-

l

plete data.

Row level security or user filters limit the data you
can see. For more information, see Restrict

Access at the Data Row Level.
The password for the workbook’s data source is not
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l

The workbook prompts for a password. For more
information, see Set Credentials for Accessing
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Reason

Scenarios

embedded or is no longer

Your Published Data.

valid.
The data isn’t at the correct

l

level of granularity.

The data in the chart isn't aggregated. Metrics use
aggregations, such as sum or average. For more

l

information, see Data Aggregation in Tableau.
There are multiple values per cell of data – a result
of data blending. For more information, see

Troubleshoot Data Blending.
The date dimension is not

l

supported.

The chart includes both date parts and date values. For more information, see Change Date

l

Levels.
The date dimension uses the ISO 8601 calendar
rather than the standard Gregorian calendar. For
more information, see ISO-8601 Week-Based Cal-

l

endar.
The date dimension is aggregated at the custom
level of Month / Year or Month / Day / Year. For
more information, see Custom Dates.

Edit a metric's configuration
Starting in 2022.2, you can change the configuration for a metric. A metric's configuration
includes the comparison, date range and status indicator. The configuration options available depend on the type of metric. Metrics with a timeline allow you to set a historical comparison or a constant comparison. Single-number metrics support only a constant
comparison.
A metric's configuration does not include the metric definition (the measure and date dimension that generate the metric value). If you want to change the definition, overwrite the metric
with a new metric.
To edit a metric's configuration, you must have the overwrite capability for the metric.
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1. Open the metric details page for the metric you want to edit.
2. Mouse over the configuration section. Click anywhere on the section to enter editing
mode.

3. For a timeline metric, set the date range to be displayed on the metric card and
details.
4. Select the comparison type. For a constant comparison, set a comparison value and
status. For a historical comparison, set how far prior you want to compare against and
choose whether to show a comparison line on the timeline.
5. Click Save. Your configuration changes will appear to anyone who views the metric.

How metrics refresh
When a metric refreshes, it checks the connected view (the view the metric was created
from) for new data. A refresh doesn’t necessarily update the value of a metric, because
there may be no changes to the data.
Metrics refresh at a frequency either based on an extract’s refresh schedule or, for live data,
every 60 minutes. The time of the last refresh is displayed on the metric.

Fix failing refreshes
If a metric isn’t able to access the connected view or its underlying data, the refresh will fail.
If the refresh for your metric fails, you’ll receive a notification, which notes the time of the
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failure and the affected metric.
Metric refreshes may fail for one of the following reasons.

l

The connected view was deleted or modified.
Permissions changed for the connected view.
The password for the data source is no longer embedded or is no longer valid.
The metric owner doesn’t have the required site role to refresh the metric. A site role of

l

Creator or Explorer (can publish) is required.
There was a temporary connectivity issue, which will resolve itself.

l
l
l

To identify the cause of the failure, look at the metric details. Make sure that the metric owner
has the required site role to refresh the metric. Then inspect the Connected View.
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If the connected view is still listed
Open the view to investigate the cause of the failure.
If the view loads, check that the measure and (optional) date dimension that define the metric are still present in the view.
l

If the view appears to be unchanged, you might no longer have permission to refresh
metrics from it. The content owner or a Tableau administrator can change the
Create/Refresh Metric permission capability. For more information, see Permissions.

l

If the measure is no longer present, the view has been modified so the metric can't
connect to the data needed to refresh. The content owner or a Tableau administrator
can check the revision history and restore previous versions. For more information,
see View Revision History.

If the view doesn’t load, but instead prompts for a password or displays an error when connecting to the data source, the password for the data source is not embedded or is no
longer valid. The content owner or a Tableau administrator can edit the data source connection to embed the password. For more information, see Edit Connections.

If there is no connected view listed
The view was deleted or you no longer have permission to access the view. Contact your
Tableau administrator for assistance.

Resume suspended refreshes
If a refresh fails enough times, the refresh is suspended. You’ll receive a notification if the
refresh for your metric is suspended.
When a metric refresh is suspended, Tableau no longer attempts to get new data for the
metric. Metrics with suspended refreshes continue to present historical data.
If the cause of the failure is fixed, you can resume the refresh.
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1. Open the affected metric.
2. On the warning message, click Resume refresh.
Tableau attempts to perform the refresh. If this attempt succeeds, you’ll receive a notification, and the refresh will resume on schedule. If the attempt doesn’t succeed, your
refresh remains suspended.
Try overwriting the metric if the connected view is still available. For more information, see
Overwrite a metric. Otherwise, you can keep the metric to reference past data or delete the
metric.

Note: If the metric refresh is suspended because you don’t have the required site role
for it to refresh, you won’t be able to resume the refresh or delete the metric.

Metrics appear in Tableau Catalogue
Starting in 2019.3, Tableau Catalog is available with Data Management in Tableau
Cloud and Tableau Server. When the Tableau Catalogue is enabled in your environment, you can see metrics in the Catalogue lineage tool, and metrics affected by data
quality warnings display those warnings. For more information about Tableau Catalogue, see "About Tableau Catalog" in the Tableau Server or Tableau Cloud Help.

When you have metrics defined for the numbers you want to monitor, it's important to know if
the data that the metrics rely on are impacted in any way. You can use Catalogue in a couple
of ways to know this. First, data quality warnings set on the data your metric is based on
show on the metric. These warnings appear when you open a metric in Tableau Mobile and
in Tableau Server and Tableau Cloud when you hover over a metric in grid view and on the
metric details page, as shown below:
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For more information, see "Set a Data Quality Warning" in the Tableau Server or Tableau
Cloud Help.
You can also use the lineage tool in Tableau Catalogue to see the upstream sources that
your metric relies on. When doing an impact analysis, you can see which metrics are
affected if a certain column or a table is changed or deprecated, or if certain workbooks are
removed. Including metrics in the lineage means that Catalogue gives a full picture of the
impact changes can have on the assets in your environment.
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For more information, see "Use Lineage for Impact Analysis" in the Tableau Server or
Tableau Cloud Help.

Set a Data Freshness Policy
Understand data performance and freshness
You’ve built your workbook, and your team loves it. But sometimes, people need to click the
Refresh button for the most up-to-date data to appear in the viz. You built the workbook
using a live connection, so why does the data need to be refreshed? The answer is performance.
To improve performance, Tableau caches data so subsequent visits can reuse and return
that cached data faster. You can click the Refresh button to retrieve updated data, but this
can add to potential performance costs.
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To balance data performance and freshness, set a data freshness policy for your workbook.
When you set a data freshness policy, your data is refreshed at the time you specify.
Tableau won’t visualise cached data that doesn’t meet the freshness policy you’ve set.

Choose what’s best for your workbook
Some people might not want caching so that they always have the freshest data, while
other people might want large caches to reduce overhead and improve workbook performance. The first step in setting a data freshness policy is to decide what’s right for your
business.
Tableau Cloud refreshes cached data every 12 hours by default, and workbook owners can
set data freshness policies at the workbook level.
In Tableau Server, server administrators can set a default caching policy for all sites on the
server, and workbook owners can set data freshness policies at the workbook level.

Note: Data freshness policies aren’t available in Tableau Desktop or for workbooks
that use file-based data sources.

Edit a workbook data freshness policy
To edit a workbook data freshness policy, you must be the workbook owner, and the workbook must have a live connection to the data source.
1. Sign in to a site on Tableau Cloud or Tableau Server.
2. From the Home or Explore page, navigate to the workbook you want to set a policy
for.
3. Click the details icon

.

4. From the Workbook Details dialog, click Edit Data Freshness Policy.
5. Choose one of the following options:
Site default (12 hours)
Always live (Tableau will always get the latest data)
Ensure data is fresh every
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Ensure data is fresh at

6. Click OK.

Site default refreshes your data every 12 hours, which is a great option if your audience regularly uses your dashboard, but doesn’t need up-to-the-minute data freshness.
Always live provides the freshest data at all times, which can increase loading time.
Ensure data is fresh every... allows you to specify how often data is refreshed with the
granularity of minutes, hours, days or weeks.
Ensure data is fresh at... allows you to schedule the time and day for data refreshes. If you
have an important meeting every Monday, Wednesday and Friday at 09:00 AM Pacific time,
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then you can set your data refresh to occur at 08:45 AM every Monday, Wednesday and Friday, so you have the freshest data when your meeting starts.

Workbook Optimiser
The Workbook Optimiser is a tool that identifies whether a workbook follows certain performance best practices. These guidelines are limited to what can be parsed from the workbook’s metadata and evaluated by a rules engine algorithm. Not all of its recommendations
are applicable to or appropriate for every workbook. There are many aspects of performance that aren’t captured by the Optimiser, some of which can offer easy wins. For
more information, refer to Streamline your workbook and the whitepaper Designing Efficient Production Workbooks.

Run the Workbook Optimiser
1. From the File menu, select Publish or Publish As. Alternatively, click the dropdown next to Publish.
2. Click Run Optimiser. This opens a new dialog for the Workbook Optimiser.
3. The workbook is automatically evaluated against the guidelines, and results display in
one of three categories: Take action, Needs review or Passed (or Passed and
ignored).
l You may see fewer than three categories. If no guidelines fall into a category, it
isn’t displayed.
l Expand each category to see the guidelines. You can also expand each
guideline for more information about why it's a recommendation. Some have
additional information specific to your workbook.
l You can choose to address any or none of the guidelines. As running the Optimiser is a voluntary step in the publishing process, it doesn’t prevent you from
being able to publish.
4. To close the dialog and go back to the workbook, click Close.
5. To close the dialog and go back to (or open) the publishing dialog, click Publish.
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Optimiser categories
The Optimiser breaks down its guidelines into three categories: take action, needs review
and passed.
Take action indicates that updating the workbook to follow these best practices has minimal
to no impact on the functionality of the workbook. There’s probably no reason to avoid making these changes.
Needs review indicates that following these best practices may involve modifying the workbook in more involved ways, such as restructuring a data source or simplifying a dashboard.
l

For these guidelines, use your best judgement to determine what is possible or prac-

l

tical to address.
Some recommendations may involve a lot of effort for minimal performance gain and

l
l

aren't worth it.
It may be useful to use the Performance Recorder to get a performance benchmark.
Some may be deliberate choices you’ve made.

As the author, you’re the final authority on what makes a workbook as efficient as possible.
Remember that some best practices should be broken to effectively deliver content. Always
weigh the goal of the workbook against changes to improve performance.
Passed indicates the guidelines are met and the workbook is already following best practices in that area. But remember, there are many aspects of performance that aren’t captured by the Optimiser. This category is renamed Passed and ignored if any guidelines are
ignored for the workbook.

Ignore a guideline
Guidelines aren’t always applicable to your situation. Perhaps you're publishing a template
workbook for others to use and need to preserve unused fields and data sources. You don't
want the optimiser to continue to notify you about those guidelines.
It's possible to ignore a guideline for a workbook.
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1. From a specific guideline, click the Ignore button.
l The guideline is muted and moves to the Passed and ignored section. Even if
you run the optimiser again, that guideline won't appear in the Take action or
Needs review section.
2. To resume evaluating the guideline, find its row in the Passed and ignored section
and click the Ignore button again.
l The optimiser runs again and the guideline is evaluated. It continues to be
checked each time the optimiser runs.

Autofix a guideline
Some suggestions from the workbook optimiser can be implemented without user input.
For these guidelines, there’s a button to autofix the rule. If the button doesn’t appear you
must manually address the issue.
From a specific guideline, click the Autofix button.
l

The recommended action (such as closing an unused data source) is taken behind
the scenes and the guideline moves to the Passed section.

l

If the autofix fails for any reason, you'll be notified and prompted to resolve the issue
manually.

l

If the button isn't available, that guideline cannot be autofixed and must be addressed
manually.

The guidelines
Every guideline contains a “consider" statement that suggests a potential way to address
the performance impact. These are necessarily general and may not apply in every situation. These suggestions are a starting point only; always frame your decisions in the context of your environment and the goals of your workbook.

Note: Not all suggestions are possible to perform in the browser and may require editing in Tableau Desktop instead.
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Navigate to a guideline by letter: A . B . C . D . E . F . G . H . I . J . K . L . M . N . O . P . Q . R . S
.T.U.V.W.X.Y.Z

Calculation length
From the Workbook Optimiser

Sample output message: The calculation My calculation is 600 characters long
Computing the results of complex calculations can impact performance.
Consider breaking the calculation apart and moving whatever is possible to the database, or
using Tableau Prep to create the calculations prior to analysis.
Additional information

Complex and long calculations can either be written in a single calculation or nested (with
some components written as stand-alone calculations that are used in the larger calculation).
Building a calculation with nested components may make it easier to troubleshoot and maintain, but it can add complications and additional processing. If possible, pushing these components back to the data source may aid performance.
Comments in calculations count against the length, so this guideline may be triggered by a
long comment rather than a long and complex calculation.

Calculation uses multiple data sources
From the Workbook Optimiser

Sample output message: The data source Supply Chain includes 17 calculations using
fields from another data source.
When calculations use fields from multiple data sources, Tableau can’t use any optimisations
and must compute the calculation locally.
Consider using Tableau Prep to create the calculation and using an extract.
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Additional information

By moving the cross-database calculation to the data layer, the processing can be performed before the user even requests the dashboard. See Join your data (Prep) and
Create level of detail and rank calculations for more information.
Under some conditions, a parameter may trigger this guideline. If a calculation is indicated
that doesn’t use multiple data sources, check to see if it has a parameter and if that parameter can be simplified.

Dashboard size not fixed
From the Workbook Optimiser

Sample output message: The dashboard Q3 analytics isn’t fixed-size.
Fixed-sized dashboards can be cached because they’re a predictable size. Using automatic
dashboard sizing means the results depend on the user’s screen, and therefore the dashboard must be rendered every time. Rendering dashboards more often comes with a performance hit.
Consider using fixed dashboard sizing.
Additional information

Although responsive elements are a best practice in web design, letting your dashboard resize can distort the layout of the content in addition to the performance impact of re-rendering. For Tableau visualisations, it’s best to use a fixed dashboard size and use devicespecific dashboards to support different devices and screen sizes.

Filter uses conditional logic
From the Workbook Optimiser

Sample output message: The filter Sample Type uses conditional logic.
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Dimension filtering can be done in various ways, such as on a list of values, by wildcard
matching or using conditional logic. Conditional logic can be slow.
Consider changing the filter to not use conditional logic. If necessary, make sure your logic
tests for the most frequent outcome first and use ELSEIF or CASE when possible.
Additional information

For more information on filtering, see Filter Your Data.

Filter uses "Only Relevant Values"
From the Workbook Optimiser

Sample output message: The filter Sample Type uses “Only Relevant Values”.
When a filter uses “Only Relevant Values”, the interactive filter control only shows options
that are applicable given the current state of the view. Every time a change is made to other
filters, the list of values to be displayed must be requeried, which has a performance impact.
Consider using dashboard filter actions instead. If the end-user benefit is valuable enough
that this feature should be used, consider extracting the data and optimising the extract.
Additional information

There are situations where using “Only Relevant Values” is necessary to avoid an unwieldy
filter list. Instead of using interactive filters in that situation, try using action filters. For
example, consider a dashboard that has cascading filters for Category, Sub-Category and
Product ID, where Product ID is set to show "Only Relevant Values". Removing that restriction would expand the list of products significantly. Rather than using filters, you can build
simple visualisations (such as a bar chart of Category and Sub-Category) and use it as a filter. The user clicks on a bar and the action filter is applied to the rest of the visualisations on
the dashboard. For more information, see Dashboard Actions.
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Live data connections
From the Workbook Optimiser

Sample output message: The data source Supply Chain isn’t an extract.
Tableau extracts are designed to be as efficient as possible for use with analytics. Using
extracts is one of the easiest ways to improve performance due to the data source. Extracts
also have many native features for optimisation.
Consider extracting the data source.
Additional information

In some instances, taking an extract may put undesirable strain on the Tableau Server or
Tableau Site's resources. Work with your Tableau administrator to determine the best
course of action.
The whitepaper Designing Efficient Workbooks has extensive information about extracts
and how to use them for performance. (You may need to sign in to access the whitepaper.)

Multiple connections in a data source
From the Workbook Optimiser

Sample output message: The data source Supply chain uses multiple data connections.
Data sources that include multiple connections can’t be computed locally.
Consider combining the data sources in Tableau Prep and using an extract for analysis.
Additional information

See Join your data (Prep) for more information.
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Nested calculations
From the Workbook Optimiser

Sample output message: The calculation My Calculation references another calculation.
Nesting calculations can add complications and additional processing, especially with IF
statements and other performance-intensive functions.
Consider pushing the calculations to the data source or materialise them in an extract.
Additional information

This rule may be triggered for a calculation that isn’t in the viz itself but is referenced by a calculation in the viz. For example, imagine four fields:
1.
2.
3.
4.

Points earned (a field in the data source)
Quiz score = [Points earned]*10
Curved grade = [Quiz score]*1.05
Letter grade = IF [Curved grade] >= 90 THEN "A" ELSEIF [ Curved
grade] >= 80 THEN "B" ELSEIF [Curved grade] >=70 THEN "C"
ELSEIF [Curved grade] >=60 THEN "D" ELSE "F" END

Quiz score is a non-nested calculation that only references a field. Both Curved grade and
Letter grade are nested calculations because they contain references to other calculations.
Even if only Letter grade is used in the viz, Curved grade also triggers the nested calculation rule because it's in use inside Letter grade.
For more information on materialising calculations in an extract (Compute Calculations
Now), see Materialise Calculations in Your Extracts.
For more information about building calculations in Tableau Prep, see Calculations in
Tableau Prep.
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Non-materialised calculations
From the Workbook Optimiser

Sample output message: The data source Supply Chain hasn’t been pre-computed.
Computing the results of a calculation can impact performance.
Consider pushing calculations to the data source when possible. If using an extract, materialise calculations to pre-compute their results.
Additional information

Pre-compute the data and calculations either in an extract or your back-end data source. By
moving this additional processing to the data layer, the processing is completed before the
user even requests the dashboard.
Taking an extract of your data often boosts performance, though there are trade-offs in data
freshness and some functionality. See Extract Your Data for more information about
options for extracts and Materialise Calculations in Your Extracts for more information on
materialising calculations.
Extract your data: Right-click on the data source’s name at the top of the Data pane and
select Extract Data. In the configuration dialog, choose Compute Calculations Now.

Number of data sources
From the Workbook Optimiser

Sample output message: The workbook contains 17 data sources.
Each data source contributes to the amount of time Tableau spends loading and rendering
a workbook.
Consider combining data sources if possible, especially when the level of granularity is the
same or they support the same analysis.
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Additional information

See Relate Your Data for more information on combining data sources, or consider using
Tableau Prep.
However, be wary of over-combining data sources. Workbooks perform best when each
type of analysis is built off a well-designed data source. If it’s hard to combine your data
sources, this could be a sign that the analysis should be split into multiple workbooks, each
with a more targeted purpose.
To split your analysis across multiple workbooks, try one of these methods:
l

Save a copy of the workbook and delete unnecessary sheets, dashboards and data

l

sources from each one. See Streamline your workbook for more information.
Copy specific sheets into a new workbook. This may be more efficient because copying a dashboard into a new workbook carries over only what is needed for that dashboard. However, not all formatting options are transferred. See Copying Information

Between Workbooks for more information.

Number of filters
From the Workbook Optimiser

Sample output message: The sheet Classroom Distribution contains 17 filters.
Excessive filters on a view create a more complex query.
Consider reducing the number of filters and using filter actions wherever possible. Not all
types and formats of filters are created equal in terms of performance, so consider optimising
necessary filters.
Additional information

The whitepaper Designing Efficient Production Workbooks has an entire section on filters
that goes into much more detail. In brief:
l
l

Reduce the overall number of filters
Filters applied to multiple worksheets trigger multiple queries with every change
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l

Limit use of Show only relevant values. Using an extract helps optimise this feature

l

if it’s needed.
Avoid high cardinality include/exclude filters

l
l
l
l

Use the Apply button to prevent multiple refreshes as the user interacts with the filter
Filter on fields that are present in the view
Use continuous date filters rather than discrete date filters
Context filters shouldn’t be used purely to boost performance

Filter actions are an efficient way to guide the user through a dashboard. See Filter Actions
for more information.

Number of layout containers
From the Workbook Optimiser

Sample output message: The dashboard Q3 analytics contains 42 layout containers.
Layout containers can complicate dashboard rendering.
Consider removing unnecessary layout containers and simplifying the dashboard design.
Additional information

For more information about layout containers and the Layout pane, see Group items using
layout containers.

Number of LOD calculations
From the Workbook Optimiser

Sample output message: The workbook contains 42 LOD calculations.
Computing the results of complex calculations can impact performance. Often, LODs are
used on the fly to address issues of granularity in the data source that could be handled prior
to analysis.
Consider tailoring the data source to the analysis to avoid the need for as many LODs.
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Additional information

Level of Detail calculations are powerful tools, but they’re expensive. Make sure you’re only
using them when necessary.
Production databases are designed to handle significant query loads and are a great option
for moving processing out of Tableau. FIXED LOD calculations can sometimes be performed by the database. Tableau Prep also supports FIXED LOD calculations. See Create
level of detail and rank calculations for more information.

Number of views in a dashboard
From the Workbook Optimiser

Sample output message: Dashboard Q3 analytics contains 17 views
A dashboard must load all elements before it can be displayed. The more views a dashboard
contains, the longer it takes to load. Although it often involves a redesign, reducing the number of views in a dashboard is often the best way to boost its efficiency.
Consider streamlining the dashboard to be as effective and simple as possible by reducing
the number of views, filters and other elements. Start with anything that can be removed
immediately. See Streamline your workbook for other ways to reduce clutter in your dashboard
Additional information

If a more substantial redesign is needed, remember that not all views have an equal impact
on performance. Focus on sheets with the most marks, filters or other complexity. A good
strategy can be to limit the initial dashboard to summary information and only provide more
details when the user requests them. There are many strategies for this sort of guided drilldown, including:
l
l

Use action filters. See Filter Actions for more information.
Hide detailed views in a container using a layout container with a show/hide button.
See Show and hide objects by clicking a button for more information.
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l

Break the dashboard into multiple dashboards and use navigation buttons. See

Detailed options for Navigation and Download objects for more information

Number of workbook sheets
From the Workbook Optimiser

Sample output message: The workbook contains 42 visible sheets
The overall size of a workbook impacts how long it takes to be processed and displayed. All
visible sheets must be loaded before Tableau can display a workbook or view. Reducing the
number of sheets can help speed up load time.
Consider reducing the number of sheets in the workbook by closing unneeded sheets, hiding sheets that are used in a dashboard or splitting the analysis into multiple workbooks.
Additional information

Delete sheets that aren’t necessary for the analysis: right-click on the sheet tab along
the bottom of the workbook and select Delete.
Hide sheets in use: Worksheets used in a dashboard or story can’t be deleted, but they
can be hidden. See Manage Sheets in Dashboards and Stories for more information.
l

Hide all a dashboard's sheets: Right-click the dashboard tab at the bottom of the workbook and select Hide All Sheets.

l

Hide a specific sheet: Right-click the sheet tab at the bottom of the workbook and
select Hide.

If all sheets are needed, decide if the analysis can be split into multiple workbooks, each
with a more targeted purpose.
l

Save a copy of the workbook and delete unnecessary sheets, dashboards and data

l

sources from each one. See Streamline your workbook for more information.
Copy specific sheets into a new workbook. This may be more efficient because copying a dashboard into a new workbook carries over only what is needed for that dash-
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board. However, not all formatting options are transferred. See Copying Information

Between Workbooks for more information.

Unused data sources
From the Workbook Optimiser

Sample output message: The data source Supply Chain isn't used in the workbook.
Each data source contributes to the amount of time Tableau spends loading and rendering a
workbook.
Consider closing data sources that aren’t in use.
Additional information

If any data sources aren’t being used, close them: right-click on the data source’s name at
the top of the Data pane and select Close.

Unused fields
From the Workbook Optimiser

Sample output message: The data source Supply Chain contains 42 fields that aren't being
used.
Hiding unused fields prevents them from being unnecessarily queried and reduces the size
of extracts.
Consider hiding any fields that aren’t being used, regardless of whether the data source is an
extract.
Additional information

Hide unused fields
l

In Tableau Desktop: open the drop-down menu at the top of the Data pane and select

Hide All Unused Fields.
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l

In web authoring: right-click on an unused field and select Hide. There’s no way to
bulk hide unused fields in web authoring. If hiding fields individually is prohibitive, consider editing in Tableau Desktop instead of working in the browser.

Uses data blending
From the Workbook Optimiser

Sample output message: The sheet Classroom Distribution uses data blending.
Data blending performance is driven by the number of unique members in the linking fields.
Consider using relationships when possible. If a blend is required, try to use low cardinality
linking fields.
Additional information

There are several ways to combine data from multiple sources. Data blending sends two
separate queries to two separate data sources and displays the results together in the viz.
These queries are at the level of the linking fields and the results are merged in memory in
Tableau. Large query results require more processing to generate the final viz.
Tip: If you’re not using data blending but the Workbook Optimiser failed this rule, check if
the workbook is using cross data source filtering. Filtering across data sources suffers from
similar performance issues around field cardinality.

Uses date calculations
From the Workbook Optimiser

Sample output message: The data source Supply Chain contains 17 date calculations.
Date logic can be complicated. Minimise the number of date calculations and conversions
you have to do in Tableau.
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Consider using DATEPARSE and MAKEDATE before other methods, and try to use built-in
functions like DATEDIFF() when possible. If filtering on a date, use relative date filters or a
continuous date filter instead of a discrete filter.
Additional information

Computing calculations in Tableau can have a significant performance impact, especially
date functions. Consider taking an extract and materialising calculations, or pushing calculations to your data source. For more information about building calculations in Tableau
Prep, see Create Calculations in Tableau Prep.

Note: If a date calculation is nested in another calculation, the optimiser flags the nested
date calculation, even if the parent calculation is the field used in the viz.

Uses grouping
From the Workbook Optimiser

Sample output message: The data source Supply Chain uses 17 grouped fields
Tableau’s native grouping functionality loads the entire domain of the field, which can have a
performance impact.
Consider using a calculated field with a CASE statement or sets instead of groups.
Additional information

In the testing performed for the Designing Efficient Workbooks whitepaper, grouping with
CASE and sets performed better than the native group functionality.
The CASE function can be used to create groups. Imagine a scenario where the data
involved a deck of cards. There’s a field for the card value (2–10, J, Q, K, A) but the analysis
should compare face cards to number cards. The case statement to make that grouping
could be
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CASE [Value]
WHEN "J" THEN "Face card"
WHEN "Q" THEN "Face card"
WHEN "K" THEN "Face card"
ELSE "Number card"
END
Sets have the added benefit of set actions, which make sets more powerful and flexible than
traditional grouping. For more information, see Create Sets and Set Actions.

1182

Tableau Software

Tableau Cloud Help

Developer Resources
The Developer Portal on the Tableau Community is the place to go for everything related to
extending and automating Tableau. There you can get access to the following:
l

JavaScript API – Integrate Tableau views into your own web applications.

l

REST API – Manage provisioning, permissions and publishing on Tableau Server or
Tableau Cloud via HTTP. The REST API gives you access to the functionality behind
the data sources, projects, workbooks, site users and sites. You can use this access to
create custom applications or to script interactions with server resources.

l

Tableau SDK – Use C, C++, Java, or Python to create extracts from any data and
then to publish your extracts.

l

Tableau Metadata API – Using GraphQL, you can discover and query Tableau content and related external assets and metadata. For more information, see Tableau
Metadata API.

l

Web Data Connector – Create a Tableau connection in JavaScript to almost any
data that's accessible over HTTP. This can include internal web services, JSON data,
XML data, REST APIs and many other sources.

l

ODBC connector – Create a connection using ODBC (Open Database Connectivity), which is a data-access protocol that's supported by a wide array of data
sources. In Tableau Desktop, you can connect to any ODBC-compliant source using
the built-in ODBC connector.

In addition to these resources, you can get complete documentation and examples, and collaborate with the Tableau developer community.
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Notes for Tableau Cloud users
o

When you make REST API calls to Tableau Cloud, you need to use the URL for the
instance on which your site exists. For example, https://10ay.online.tableau.com/
For information, see Specifying Resources for Tableau Cloud under Using URIs
to Specify Resources.

o

Not all of the methods provided in the Tableau REST API are applicable to Tableau
Cloud. For information, see the API listing by category in the API Reference.

Go to the Developer Portal
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About Data Management
Data Management is a collection of features and functionalites that helps customers manage
Tableau content and data assets in their Tableau Server or Tableau Cloud environment.
Starting in Tableau Server 2019.1, Tableau Prep Conductor is available for on-premise
Tableau Server deployments, and in version 2019.3, Tableau Prep Conductor is available
for Tableau Cloud deployments. You can use Tableau Prep Conductor to schedule and monitor flows.
Starting in Tableau 2019.3, Tableau Catalogue is included in Data Management, making a
variety of additional features available to you in the data management space. You can use
Tableau Catalogue to discover data, curate data assets, communicate data quality, perform
impact analysis and trace the lineage of data used in Tableau content.
Starting in Tableau 2021.4, more governance and security features were added to Data Management: virtual connections and data policies. Using the virtual connection editor, you can
create:
l
l

Virtual connections that provide a sharable central access point to data.
Data policies to apply row-level security at the connection level.

Tableau Catalogue, Tableau Prep Conductor, virtual connections and data policies are
licensed through Data Management. For more information about licensing, see Licence
Data Management.
To purchase Data Management, contact your account manager.

Data Management Features
The following table lists the features for Data Management, which includes:
l
l

Tableau Catalogue
Tableau Prep Conductor
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l
l

Virtual connections
Data policies

Tableau Catalogue
These features require Data Management with Tableau Catalog enabled.
Feature

Description

Permissions Tableau Catalogue enables you to control who can see and manage
external assets and what metadata is shown through lineage by setting
on
permissions.
metadata
Expanded

Whether you author in the web or in Tableau Desktop, you can now

connect

search for and connect to the specific databases and tables used by pub-

experience

lished data sources and workbooks on your Tableau Server or Tableau

– data dis-

Cloud site.

covery

Expanded

Tableau Catalogue expands search to include results based on columns,

search

databases and tables.

Tag

You can categorise items on Tableau Server and Tableau Cloud with

external

tags, helping users to filter external assets (databases, files, tables and

assets

columns).

Certify data-

Help users find trusted data that meets the standards you set by certifying

bases and

databases and tables.

tables
Set data

You can set warnings to alert users to data quality issues, such as stale or

quality warn- deprecated data.
ings
Lineage and

The Lineage tool traces the source of your data. You can use it to analyse

impact ana-

the impact of changes to your data, identify which users might be

lysis

impacted, and email owners of a workbook, data source or flow, or contacts for a database or table, about data-related updates.
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Feature

Description

Data Details Enable users to better understand a published visualisation by seeing
information about the data used.
Add descrip- Help users find the data they're looking for by adding descriptions to databases, tables and columns.
tions to
assets
Developer

Tableau REST API -

Programmatically add, update and remove

resources

metadata methods

external assets; and add additional
metadata to Tableau content and external
assets like descriptions.

Tableau Metadata API

Programmatically query metadata from the
content published to Tableau Server or
Tableau Cloud. Programmatically update
certain metadata using the metadata meth-

ods in the Tableau Server REST API.
Note: The Metadata API does not require
Data Management.
GraphiQL

Explore and test queries against the
Metadata API schema using an interactive
in-browser tool called GraphiQL.

Note: GraphiQL does not require Data
Management.

Tableau Prep Conductor
These features require Data Management with Tableau Prep Conductor enabled on
Tableau Server or Tableau Cloud.
Feature

Description

Schedule Flow

You can create scheduled flow tasks to run a flow at a specific time

Tasks

or on a recurring basis.
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Feature

Description

Monitor Flow

Set up email notifications at the site or server level when flows fail,

Health and Per-

view and resume suspended flow tasks and view errors and alerts.

formance
Administrative

Use Administrative Views to monitor the activities related to flows,

Views for Flows

performance history and the disk space used at the server or site
level.

Tableau REST API

Programmatically schedule flows.

- flow methods

Virtual connections and data policies
These features require Data Management.
Feature

Description

Create a Virtual Con-

A Tableau content type that enables you to create a shareable

nection

re-usable connection to curated data.

Create a Data Policy

Use the virtual connection editor to create data policies with

for Row-Level Secur-

policy conditions that apply row-level security to the data at the

ity

connection level.

Test Row-Level

Test the data policy with Preview as user to ensure that users

Security with Preview

can see only their data.

as User
Schedule Extract

Create an extract refresh schedule for the tables in your con-

Refreshes for a Vir-

nection, ensuring that the data is fresh for any content that uses

tual Connection

that virtual connection.
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Licence Data Management
Data Management includes Tableau Catalogue, Tableau Prep Conductor, virtual connections and data policies. Contact your account manager (or go to the Tableau pricing
page) to purchase Data Management.

Tableau Prep Conductor
After you purchase and license Data Management, you must enable Prep Conductor on
Tableau Cloud. For more information, see Enable Tableau Prep Conductor on Your
Tableau Cloud Site.
l

At least one resource block is required to use Tableau Prep Conductor in Tableau

l

Cloud. To learn more about resource blocks, see Resource Blocks.
When Data Management is active and enabled, you can schedule flows in Tableau

l

Server or Tableau Cloud and monitor flows.
When Data Management is removed or deactivated, or if the Data Management

l

licence expires, then the ability to schedule flows is disabled.
If your Tableau Server or Tableau Cloud licence is still active and valid, you can download the flows using the Tableau Server REST API. For more information, see Flow

Methods.

Tableau Catalogue
After you purchase and license Data Management for Tableau Cloud, Catalog is automatically enabled.
l

When Data Management is active and enabled, you can use Tableau Catalog to discover data, curate data assets, perform impact analysis and trace the lineage of data

l

used in Tableau content.
When Data Management is removed or deactivated, or the licence expires, the information remains on the server. The Tableau Catalogue-specific information is then only
accessible using the Tableau Metadata API; it no longer appears in the product. For

l

more information, see the Metadata API.
When Data Management is removed or deactivated, or the licence expires, the write
APIs for all new Tableau Catalog information (for example, table descriptions, data
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quality warnings, column descriptions) are disabled. You can still read information
using the Metadata API, however permissions on tables and databases can’t be explicitly managed in the product.

Virtual connections and data policies
After you purchase and license Data Management for Tableau, virtual connections and
data policies are automatically enabled.
l

When Data Management is active and enabled, you can use virtual connections to
create sharable resources that provide a central access point to data. You can also
create data policies that enable you to filter data for users using centralised row-level
security.

l

When Data Management is removed or deactivated, or the licence expires, the inform-

l

ation remains on the server but is not accessible.
When Data Management is reactivated, the information is restored on the server and
becomes accessible.

Resource Blocks
Resource Blocks are units of compute capacity in Tableau Cloud. Resource Blocks run
Tableau Prep Conductor flows. Each Resource Block can run one flow at a time so the number of flows you can run concurrently is equal to the number of Resource Blocks that you
have.
When you license Data Management for Tableau Cloud, you must purchase at least one
Resource Block. To purchase more Resource Blocks, contact your account manager (or go
to the Tableau pricing page for more information).

Tableau Prep Conductor
Tableau Prep Conductor enables you to leverage the scheduling and tracking functionality
available in Tableau Cloud to run your flows automatically to update the flow output.
Tableau Prep Conductor is part of Data Management introduced in Tableau Cloud version
2019.1 and must be enabled to schedule your flows to run.
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Note: Starting in version 2020.4, the Data Management is only required if you plan to
run flows on a schedule or set up email notifications. You no longer need the Data Management to publish flows and manually run them on the web and, as a Creator, to create
and edit flows directly on your server.

Flows created in Tableau Prep Builder must be published to Tableau Cloud before they can
be scheduled to run. Publishing flows is similar to publishing data sources and workbooks.
You can package files with the flow or specify a direct connection to data sources to update
the flow input as data changes. If your flow connects to databases, specify the authentication
type and set credentials to access the data.
You can also publish a flow to share it with others or to continue editing it on the web. For
example, publish an incomplete flow to Tableau Cloud and then open the flow on the web in
Edit mode to continue working on it. You could also create a flow with only Input steps (that
are properly configured) and share it with colleagues, who can then download the flow to
their computers and create and publish their own flows.
For flows to run, they must include output steps and have no errors or incompatible features.
For more information about publishing a flow, see Publish a Flow to Tableau Server or
Tableau Cloud. For more information about incompatibility, see Version Compatibility with
Tableau Prep.
The following table shows the flow management features that are available with and without
the Data Management and Tableau Prep Conductor enabled.
Data Management with Tableau Prep Conductor No Data Management
enabled
l

View and monitor the details about your flow,

l

View the details about your

including recent activity in the Content pages.

flow, including recent activ-

l

Edit your flow (starting in version 2020.4).

ity in the Content pages.

l

View the results of the flow runs and any
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errors in the Run History tab.
l

Use Administrative Views to monitor server

version 2020.4).
l

View and edit your con-

and site activity, including a new view that

nections on the Con-

tracks flow performance history.

nections tab.

l

View detailed alerts for failed flow runs.

l

Set up email notification alerts to send emails
to flow owners notifying them when the flow
failed to run and why.
For more information about setting up alerts,
see Monitor Flow Health and Performance.

Enabling Tableau Prep Conductor on Tableau Cloud
After you purchase and licence Data Management, you must enable Prep Conductor on
Tableau Cloud. For more information, see Enable Tableau Prep Conductor on your
Tableau Cloud Site and Licence Data Management

About the Flow Workspace
After you publish your flow, you can schedule tasks or linked tasks (version 2021.3 and
later) in Tableau Cloud to automatically run your flows on a regular basis to keep your output data fresh. You can also run your flows manually at any time (no Data Management
required).
Tableau Prep Conductor leverages much of the same functionality for managing flows that
you might see when managing workbooks or data sources from Tableau Desktop in
Tableau Cloud. For example, just like extract refreshes, scheduled flow tasks and ondemand flow runs are queued as background tasks. But when it comes to working with
flows, there are a few differences.
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Flow Overview page
The flow Overview page is the main landing page where you can view data about your flow
and schedule, monitor and maintain the flow. If you don't have the Data Management, you
will have different options.
Open the flow Overview page by clicking on a flow in your list. You can navigate there from
Content > Explore > All Flows or by opening the project that contains your flows.

A. The header lists the name of the flow, the flow owner and the date that the flow was
last modified. Starting in version 2020.4, click Edit to edit existing flows.
Add a flow to your favourites or from the More actions

menu, you can also edit,

run, download the flow, set permissions, change the flow owner, restore previous flow
versions and more.
B. View and edit the flow description and set tags to help others find the flows they are
looking for.
C. View the output steps for a flow along with any parameters applied to the flow (version
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2021.4 and later), the status of the last update, any schedule the output is assigned to
and any errors from the last flow run. You can also click the Run

button to run all

output steps or individual output steps on-demand.

Note: If the flow includes parameters, the parameter value last run in the flow is
shown and you can see all generated outputs in the Output column. When the
flow is run, you'll be prompted to enter the parameter values. For more information about using parameters in flows, see Create and Use Parameters in Flows
in the Tableau Prep help.

If the flow has errors, the flow run will fail. Connectivity errors can be resolved directly
by navigating to the Connections tab for the flow and editing the input connections.
To resolve any other flow errors, edit the flow then republish it and try running the
flow again. If you are using an earlier version of Tableau Prep Builder, from the More
actions

menu, you can also download and open the flow in Tableau Prep Builder,

then republish it and try running the flow again.
After a flow has run successfully, outputs that are data sources become links that you
can click to open the Data Source page to view more information about the data
source or edit the flow input connection.
In the Schedule field, view the scheduled tasks that the output step is assigned to. A
flow output can be assigned to one or more tasks.
If no schedule has been assigned yet, click Create new task to add the output step
to a schedule. To immediately run the flow to update a specific output step, click the
Run

button on the left-hand side of the row.

D. View an image of the flow.
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Flow Overview page without the Data Management

If you don't have the Data Management installed on your server, you can still publish flows to
Tableau Cloud, but you will see fewer options to manage your flow.

Flow Connections page
View both the input and output locations for a flow, connection types, authentication settings,
input and output steps and any connectivity errors. You can set authentication settings when
publishing a flow. For more information, see Publish a Flow.
For database input types, click the More actions

menu for an input connection to edit the

connection and change the server name, port, username and password.
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Flow Scheduled Tasks page (Data Management required)
View any schedules that the flow is assigned to, the outputs that are included in those schedules and any parameters applied to the flow (version 2021.4 and later). As an administrator,
you can click the schedule link to open the Schedules page and see a list of flows that are
assigned to that schedule. For more information about assigning flows to a schedule, see
Schedule Flow Tasks.
To view the outputs on a schedule or the tasks assigned to a linked task (version 2021.3 and
later), click the links in the Schedule type column.
You can also add new tasks or manage existing ones from this page. To take action on an
existing task, select the tick box on a task card then click the Actions drop-down menu to
run, edit or delete the task.
If a flow task fails to run after 5 consecutive attempts, the flow is automatically suspended.
You can see that status on the Overview tab as well as this tab. You can resume suspended tasks from this menu.
For more information about suspended flow tasks, see View and resolve errors.

Note: The Scheduled Tasks page for flows was redesigned in version 2021.3. Your
view may look different depending on your server version.
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Schedules page
On the Schedules page, you can view the flows assigned to a schedule and the details
about the flow runs. If the schedule includes linked tasks (version 2021.3 and later) the number of flows included in the linked tasks is shown.
You can run the schedule on-demand and run all flows assigned to it. You can also select
one or more flows, then use the Actions menu to change the flow schedule or priority,
delete selected flows from the schedule or resume suspended flows.
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Flow Run History (Data Management required)
See, search and sort through a list of historical runs for a flow. This page also includes
details about the flow run such as run type, parameter values applied to flows included in
each flow run (version 2021.4 and later), duration and number of rows that were generated.
If the flow output has an error, hover over the error to view the messages. If applicable, click
the Go to Connections link in the error message to navigate to the Connections page to
fix connectivity errors. You can also edit the flow directly to fix any errors, or click Download
the flow to download and fix flow errors in Tableau Prep Builder, then republish the flow to
continue to manage it using Tableau Prep Conductor.

Note: The run history for a flow will persist unless the flow is deleted.

Flow Revision History
If you need to revert a flow to a previous version, from the More actions

menu for the

flow, select Revision History. On the Revision History dialog, select the flow version
from the list that you want to revert to.
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Who can do this
Server Administrators can activate Data Management licence keys.
Server administrators can enable Tableau Prep Conductor.
Creators can create, edit and run flows manually. If the Data Management is installed, creators can run flows on a schedule.

Enable Tableau Prep Conductor on your Tableau Cloud Site
Prep Conductor is automatically enabled on your Tableau Online site after you purchase
Data Management. For information on how to purchase Data Management, contact your
account manager.

Verify Tableau Prep Conductor is enabled
1. Sign into the server through the Server->Sign In menu.
2. Open any of your flows.
3. Verify if there is a Scheduled Tasks tab. If the tab is there, then Prep Conductor is
enabled.
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Schedule Flow Tasks
Note: Starting in version 2020.4.1, you no longer need the Data Management to publish flows to the web. As a Creator, you can also create and edit flows directly on your
server. If you want to schedule flows to run on your server, the Data Management is
required. For more information authoring flows on the web, see Tableau Prep on the
Web.

To schedule flows to run at a specific time or on a recurring basis you can create scheduled
tasks. Scheduled tasks rely on pre-configured schedules.
To assign a flow to a schedule, select one of the pre-defined schedules provided with
Tableau Prep Conductor. New schedules cannot be created in Tableau Cloud.
Starting in version 2021.3, you can link flow runs together when scheduling tasks to run
flows one after the other. For more information, see Schedule linked tasks in this topic.
Starting in version 2022.1, you can also run linked tasks via the REST API using the new
flow methods Query Linked Tasks, Query Single Linked Tasks and Run Linked Task
Now. For more information, see Flow Methods in the Tableau REST API help.
Running flows that include parameters
Starting in version 2021.4, you can include parameters in your flows to make flows more
dynamic. When the flow runs, you are prompted to enter your parameter values. When setting up flows on a schedule, you specify parameter values at that time.
You must specify the parameter values for any required parameters. For optional parameters, you can enter those values as well, or accept the current (default) value for the parameter. For more information about running flows with parameters, see Run flows on a
schedule in the Tableau Prep help.
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Note: Your administrator must enable the Flow Parameter server and site settings on
your server before you can run flows that include parameters in Tableau Server or
Tableau Cloud. For more information, see Create and Interact with Flows on the
Web in the Tableau Server or Tableau Cloud help.

Schedule a flow task
1. Do one of the following:
l

(version 2022.1 and later) From the Explore page, in List view, in the Actions
menu, select Schedule Flow > Single Task. If you select a flow in the list, you
can also use the top Actions menu.

l

From the Overview page for the flow, Scheduled Tasks tab, click New Task
or click on the drop-down and select Single Task.
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If the output step isn't assigned to a task, you can also create a new task from
the Overview page. On that page, in the Schedules field, click Create new
task.
2. In the New Task dialog, on the Single Task (New Task in prior releases) tab, select
a schedule from the drop-down list.

3. Select one of the following options:
l

Automatically include all output steps for this flow:(default) Select this
option to include all current and future output steps for this flow in the scheduled task. As new output steps are added to the flow over time, they are automatically included in the schedule when it runs.

l

Select the output steps to include in this task: Select this option and
manually select the output steps to include in this scheduled task.
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To include all output steps in the flow task, tick the box next to Output Steps.
This area can't be edited if the Automatically include all output steps for
this flow radio button is selected. Select the other radio button to enable this
section.

4. (version 2020.2.1 and later) Select a Refresh Type. For more information about
these settings, see Refresh Flow Data Using Incremental Refresh.

Note: Starting in version 2020.2.1 and later, if one input is configured to use incremental refresh and it is associated with multiple outputs, those outputs must be
run together and must use the same refresh type. Otherwise the flow will fail.

l

Full refresh (default): Refresh all data and create or append data to your table
based on the flow output setting.

l

Incremental refresh: Refresh only the new rows and create or append data to
your table based on the flow output setting. The incremental refresh option is
only available when the flow is configured to use this refresh type.
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Note: Tableau Prep Conductor runs a full refresh for all outputs regardless of the run option you select if no existing output is found. Subsequent
flow runs will use the incremental refresh process and retrieve and process only your new rows unless incremental refresh configuration data is
missing or the existing output is removed.

5. (optional) If you are the flow owner, select Send email when done to notify users
when the flow is successful. For more information about how to send email notifications on flow runs, see Notify Users of Successful Flow Runs.

6. (version 2021.4 and later) If your flows include parameters, enter any required or
optional parameter values. You must enter required values for the flow to run.
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7. Click Create Task to create the scheduled task.

Schedule linked tasks
Supported in Tableau Server and Tableau Cloud version 2021.3.0 and later.

Note: Starting in version 2022.1, Linked tasks functionality is enabled by default. Server
and Site Administrators can turn off this functionality on the Settings page and on flow
schedules in the Schedules dialog. In previous versions, Server Administrators must
first enable this functionality to use and manage it.

Use the Linked Tasks option to schedule up to 20 flows to run sequentially, one after the
other. Easily set up your flow list by selecting your schedule, then select downstream flows to
run in the order you choose.
In Tableau Cloud, the duration of each individual linked task is counted towards the total flow
runtime limit. If the runtime limit is reached when a flow task is run, the flow task will time out,
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the linked task will fail and any downstream flows won't be run. For more information, see
Job Runtime capacity in the Tableau Cloud help.
Flows run in the order specified in the list. Use the menu to move flows around in your list or
add new upstream or downstream flows to the list at any time.
Select the outputs that you want to include in the flow run and configure the settings to tell
Tableau what to do with remaining flows in the schedule when the previous flow run fails.

1. Do one of the following:
l

(version 2022.1 and later) From the Explore page, in List view in the Actions
menu, select Schedule Flow > Linked Task. If you select multiple flows in the
list, you can also use the top Actions menu.
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l

From the Overview page for the flow, Scheduled Tasks tab, click New Task
and select the Linked Task tab, or click on the drop-down and select Linked
Task.

If the output step isn't assigned to a task, you can also create a new task from
the Overview page. On that page, in the Schedules field, click Create new
task.
2. In the New Task dialog, on the Linked Tasks tab, select a schedule from the dropdown list. Only schedules that are enabled for linked tasks are shown.
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3. Click the Select output steps drop-down to select the flow outputs to run. By
default, all flow outputs are included. To select specific outputs, clear the Include all
current and future output steps for this flow tick box.
The flow where the task is initiated is automatically set as the first flow to run, but you
can use the menu to change the run order after you add other flows to your list.
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4. Select your refresh type from the following options:

Note: If one input is configured to use incremental refresh and it is associated with
multiple outputs, those outputs must be run together and must use the same
refresh type. Otherwise, the flow will fail.

l

Full refresh (default): Refresh all data and create or append data to your table
based on the flow output setting.

l

Incremental refresh: Refresh only the new rows and create or append data to
your table based on the flow output setting. The incremental refresh option is
only available when the flow is configured to use this refresh type. For more
information, see Refresh Flow Data Using Incremental Refresh.

Tableau Software

1209

Tableau Cloud Help
Note: Tableau Prep Conductor runs a full refresh for all outputs regardless of the run option you select if no existing output is found. Subsequent
flow runs will use the incremental refresh process and retrieve and process only your new rows unless incremental refresh configuration data is
missing or the existing output is removed.

5. (optional) If you are the flow owner, select Send email when done to notify users
when the flow is successful. For more information about how to send email notifications on flow runs, see Notify Users of Successful Flow Runs.
6. Set your flow failure options:
l

Add data quality warning: Select the tick box to set a warning message on
the flow so that users of the data are aware of issues. The message remains
until the flow runs successfully. If the flow already has a data quality warning,
this option shows as selected and can't be turned off.

Note: In version 2021.4 and earlier, click on the Flow run monitoring
icon
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to open the Data Quality Warning dialog.
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l

Stop remaining tasks: Select this option to prevent the downstream tasks in
the list from being queued to run.

l

Email me: Email notifications are automatically sent to the flow owner when the
flow fails, is suspended or is cancelled.

7. (version 2021.4 and later) If your flows include parameters, enter any required or
optional parameter values. You must enter required values for the flow to run.
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8. Click on the drop-down for the 2nd task to add your next flow. Flows that use the previous flow's outputs are shown automatically, or click View all flows to see all available flows.
Select one or more flows and click Add or click Add Next Task to add more flow run
tasks to your list.

If you don't have permission to run the flow, you must contact the flow owner to grant
permissions before adding the flow to your list.
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9. Repeat steps 3–5 to configure your flow run options.

Note: In version 2021.4 and earlier, click on the Edit icon

next to your new

flow to expand the Options pane.

10. (Optional) Click on the drop-down next to any numbered task to open the menu to
change the order of your flow tasks or insert new tasks between existing tasks.

11. Click Create Tasks to create the scheduled linked tasks.
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Who can do this
l

The Server administrator can do this on all sites on the server. The Site administrator
can do this on sites they have access to if the site settings to allow users to publish

l

and schedule tasks is enabled.
For linked tasks, the Server administrator can do this on all sites where the server settings to allow users to schedule linked tasks is enabled. The Site administrator can do
this on sites they have access to if the site settings to allow users to schedule linked

l

tasks is enabled.
Flow owners and project leaders can create flow tasks for flows or projects that they
own respectively.

For more information, review the following articles:
l

Windows: Set Users' Site Roles and Content Permissions and Ownership

l

Linux: Set Users’ Site Roles and Content Permissions and Ownership

Site administrators, flow owners, project leaders, can create flow tasks for the flows and projects that they own respectively.
For more information, see Set Users' Site Roles and Content Ownership and Permissions

Notify Users of Successful Flow Runs
Supported in Tableau Prep Builder version 2021.4.1 and later and in Tableau Server and
Tableau Cloud version 2021.4 and later. Data Management is required to use this feature.
Flow owners can subscribe themselves, individual users and groups to email notifications
for information about scheduled tasks for successful flow runs. The email includes links to
data within the Tableau environment, or you can optionally include the details of the flow run
in attached Excel and CSV files.
Flow subscriptions are added to scheduled tasks for flows. You can add flow subscriptions
to an existing flow task or when you create a new flow task. Email notifications are sent
when the scheduled task is completed successfully.
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Configure the site settings for flow subscriptions
By default, the Flow Subscriptions site setting for sending and receiving email notifications
is enabled.

l

The Let users send or receive emails that include flow output data option
allows the flow owner to receive and subscribe users and groups to successful flow run
notifications. From the notification email, users can access the full data source or view
the flow details from within Tableau.

l

(Not recommended) The Attach .csv and .xlsx flow output files option lets the flow
owner attach files to notification emails. The email recipients must be added to the
Tableau server or site, however, the files contain the data source and can be exposed
outside of the Tableau system. This option is available only for on-premise environments.

Publish the Flow
Publish the flow output as either a file, database table or data source. Consider the following
when saving the flow:
l

(On-premise only) When publishing you can save the output as a file or as a database
table and choose to attach either a .csv or .xlsx file type to the email.

l

When publishing and saving the output as a published data source, the email notification provides a link to the flow in Tableau. Files cannot be attached to the email.

l

When choosing to save as a file output, you must use a network share and the output
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and input location must be included in a safe list. For more information, see Step 4:
Safe list Input and Output locations.
l

Flow subscriptions are supported on Windows and Linux. The following restrictions
apply to flow subscriptions on Linux:

l

l

File outputs must be output to a Windows server.

l

For flows that output to a file, use the UNC format for the path: \\server\path\file-

l

name. Do not use a local drive letter.
The mounted path must be safe-listed.

When attaching files to an email, the file limit is approximately 25 MB for Tableau
Cloud. When using an on-premise Tableau Server, you configure the size of attachment files.

Add a flow subscription
1. As the owner of the flow, select a published flow in Tableau Server or Tableau Cloud
that you want to add subscriptions to for email notifications.
2. You can add subscriptions to a new or existing task:
l If you are adding a subscription to a new task:
1. Click Scheduled Tasks > New Task.
2. In the New Task dialog, select a schedule to run the flow from the Select
a schedule drop-down list.
3. Enable Send email when done
l

If you are adding a subscription to an existing task:

1. Click Subscriptions > Subscribe.
2. In the Add Flow Subscriptions dialog, select a schedule from the Frequency drop-down list.
3. In the Send to field, start typing the name of the user or group to populate the field.
Select the users and groups that you want to send a notification to.
Users and groups must be added to the Tableau environment by the administrator.

1216

Tableau Software

Tableau Cloud Help
4. (Optional) To be included in the notification, check the Send to me box.
5. (Optional) In the Subject field, customise the default email subject line for the flow run
notification.
6. (Optional) Add information about the flow run in the Email message text box.
7. Click Include output data and select the type of output that you want to include in the
email.
l

If you published your flow as a file or database table output, you can choose to
attach .csv or .xlsx files containing the data source to the email. This is not
recommended because data can be exposed outside of the Tableau system.

l

If you published your flow as a data source, you can choose to include the link to
the data source. Attaching files to the email is not supported.

8. If you are adding a subscription to an existing task, click Subscribe.

Unsubscribe from a flow subscription
To unsubscribe from notifications from the email, follow these steps.
1. Click Unsubscribe from the bottom of a subscription email.
2. As the flow owner, Sign in to Tableau Server or Tableau Cloud. At the top of the page,
click the Notifications icon.
3. Expand the … menu, then select Remove notification.
To unsubscribe and remove the subscription as the flow owner, follow these steps.
1. Click Subscriptions.
2. Open the published flow in Tableau Server or Tableau Cloud.
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3. From the list of flow subscriptions, click the selection box for the flow you want to
unsubscribe from.
4. Select Actions > Unsubscribe.

View Subscriptions
You can view your current flow subscriptions in Tableau Server or Tableau Cloud.
l

From the Subscriptions tab on the Overview page of the flow, you can see the list
of current subscriptions.

l

From the Subscriptions tab on the Tasks page, you can see the list of subscriptions
along with subscriptions to workbooks.

Resume suspended flow subscriptions
Sometimes, subscriptions fail because of an issue with the flow. If a subscription fails more
than five times, you'll receive a notification email that your scheduled flow task has been suspended.
From the flow Overview page, you can see when a scheduled flow task fails.

There are a few ways to resume a suspended flow task. If you're flow owner:
l

From the My Content area of Tableau web pages, an icon appears in the Last update
column to indicate that the subscription is suspended. Select ... > Resume Scheduled Tasks to resume.
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l

From the Scheduled Tasks page, an icon appears in the last update column to indicate
that the subscription is suspended. Select the flow, then click Actions > Resume.

Access the flow data from a notification email
Depending on how the flow notification was configured, you can access the data source and
file attachments from the notification email.
l
l

Click View Flow to open the flow in Tableau Server or Tableau Cloud.
Click the attachment file to view the flow data.
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Who can do this
l

Flow owners can create flow notification subscriptions for flows that they own.

l

To receive notifications, users and groups must be added to the Tableau environment by the administrator.

For more information, review the following articles:
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l

Windows: Set Users' Site Roles and Content Permissions and Ownership

l

Linux: Set Users’ Site Roles and Content Permissions and Ownership
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Manage a Flow
Once you publish a flow to Tableau Server or Tableau Cloud, you can manage your flows
and make changes to them as necessary. This topic describes the various actions you can
take to manage your flows.

Note: The content in this topic applies to both Tableau Server and Tableau Cloud,
exceptions are called out specifically.

Managing your flows
Following is a list of actions you can take to manage your flows:
l

Create flows: Starting in version 2020.4, as a Creator you can create flows directly
on the web. From the Home page, click Create > Flow or from the Explore page,
click New > Flow. For more information, see Tableau Prep on the Web.

l

Edit flows: Starting in version 2020.4, as a Creator you can edit flows directly on the
web. Navigate to the list of flows, select Actions and click Edit Flow, or open a flow
and click the Edit button.
When you edit a flow, your changes are moved to a draft state. When you're finished,
publish your flow to commit your changes and create a new version of the flow. For
more information, see Autosave and working with drafts.

l

Run flows: You can manually run a flow in addition to creating scheduled flow tasks
that run at a specific time.
l

Note: The Data Management is not required to manually run flows, but is
required to schedule flows to run.

l

Navigate to the list of flows, select one or more flows you want to run, select Actions
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and click Run Now.
l

Tag: Tags are keywords you can create for flows to help you find, filter and categorise content. Authors can add tags to flows when they publish it. But you can also
add tags to any workbook, view, or data source that you are allowed to access and
you can delete any tags you have added. You can add a tag to a list of flows.
Navigate to the list of flows, select one or more items you want to tag, select Actions
and click Tag. To add a tag to a specific flow you can do it from the list of flows as
described above. Open the Flow, from the Overview tab, select Actions, and click
Tag.

l

Change Owner: Administrators and flow owners can change owners but only to
themselves.

l

Permissions: You can set permissions for users and specify if they can perform edit
actions like save, download, move to a different project and delete. In addition, you
can specify who can view and run the flow.

l

Download: You can download a flow to view or modify it using Tableau Prep
Builder. To download a flow, you need download permissions. You’ll have that by
default if you are the owner, but you might need to add it for other users.

l

Revision History: When you make a change to the flow, and republish it to the
same project with the same name, a new version of the flow is created. You can view
the revision history by selecting revision history from the actions menu. Flow owners
have permissions to restore a previous version of a flow.

l

Move: You can move flows between projects. To move a flow, users need Move permission. You’ll have that by default for flows you own, but you might need to add it for
other users.

l

Rename: You can rename a flow. To rename a flow, users need the Save permission. You'll have that by default for flows you own, but you might need to add it for
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other users.
l

Delete: You can delete a flow. To delete a flow, users need the Delete permission.
You’ll have that by default for flows you own, but you might need to add it for other
users.

Who can do this

Tableau Server Administrator
Can do the following tasks across all the sites:
l

Create flows

l

Edit published flows

l

View a list of all draft flows

l

Run flows

l

Delete flows

l

Download flows

l

Change Owner

l

Change Permissions

l

Change Project

l

Add/Remove Tags

l

Change Description

l

Change Name

l

Update Flow Task

l

Delete Flow Task
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l

Create a Flow Task*

l

Version Management*

*Some additional conditions apply to these actions:
l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

l

l

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

Tableau Site Administrator
Can do the following tasks on flows published to the sites that they are site administrator for:

1224

l

Create flows

l

Edit published flows

l

View a list of all draft flows

l

Run flows

l

Delete flows

l

Download flows

l

Change Owner

l

Change Permissions
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l

Change Project

l

Add/Remove Tags

l

Change Description

l

Change Name

l

Update Flow Task

l

Delete Flow Task

l

Create a Flow Task*

l

Version Management*

Some additional conditions apply to these actions:
l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

l

l

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

Project Leader
Can do the following tasks on flows published to the projects where they have project leader permissions:
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l

Create flows

l

Edit published flows

l

Run Flows

l

Delete

l

Download

l

Change Permissions

l

Change Project

l

Add/Remove Tags

l

Change Description

l

Change Name

l

Update Flow Task

l

Delete Flow Task

l

Create a Flow Task*

l

Version Management*

*Some additional conditions apply to these actions:
l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

l

l
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l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

Project Owner
Can do the following tasks on flows published to the projects that they own:
l

Create Flows

l

Edit published flows

l

Run Flows

l

Delete

l

Download

l

Change Permissions

l

Change Project

l

Add/Remove Tags

l

Change Description

l

Change Name

l

Update Flow Task

l

Delete Flow Task

l

Create a Flow Task*

l

Version Management*

* Some additional conditions apply to these actions:
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l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

l

l

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

Flow Owner
Can do the following tasks on flows that they own:
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l

Create Flows

l

Edit Draft (flows they own) and Published Flows

l

Run flows

l

Delete flows

l

Download flows

l

Change Owner

l

Change Permissions

l

Change Project

l

Add/Remove Tags

l

Change Description

l

Change Name
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l

Update Flow Task

l

Delete Flow Task

l

Create a Flow Task*

l

Version Management*

*Some additional conditions apply to these actions:
l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a
schedule.

l
l

l

The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

User with Creator Licence
Can do the following tasks:
l

Create Flows

l

Edit Draft (flows they own) and Published Flows

l

Run Flows (with Run flow permissions)

l

Delete (with delete permissions)

l

Download (with download or Save as, and read permissions)

l

Change Permissions (with Change Permissions)
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l

Change Project (with move permissions, and write permissions on the destination
project)

l

Add/Remove Tags (with read permissions)

l

Change Description (with Save permissions)

l

Change Name (with Save permissions)

l

Update Flow task (with Execute permissions)

l

Delete Flow Task (with Execute permissions)

l

Create a Flow Task* (with Execute permissions)

l

Version Management* (with view, read, save as, download permissions)

* Some additional conditions apply to these actions:
l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.
The flow version must be compatible with the Tableau Server version.

l

l

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

User with Explorer Licence
Can do the following tasks:

Note: Starting in version 2020.4, Explorer users can no longer run flows on the server.
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l

Delete (with delete permissions)

l

Download (with download or Save as, and read permissions)

l

Change Permissions (with Change Permissions)

l

Change Project (with move permissions and write permissions on the destination project)

l

Add/Remove Tags (with read permissions)

l

Change Description (with Save permissions)

l

Change Name (with Save permissions)

l

Update Flow task (with Execute permissions)

l

Delete Flow Task (with Execute permissions)

l

Create a Flow Task* (with Execute permissions)

l

Version Management* (with view, read, save as, download permissions)

*Some additional conditions apply to these actions:
l

l

To create a flow task:
l

A flow schedule must be available. Only Server Administrators can create a

l

schedule.
The flow must have at least one output step.

l

The flow version must be compatible with the Tableau Server version.

Version management:
l

Revision history must be enabled on the site.

l

User role is allowed to publish to the project.

User with Viewer Licence
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Viewers cannot manage flows, they can however view the flow and the different versions of
the flow.
For more information about the full capabilities you can set on flows, see Permission capabilities.

Monitor Flow Health and Performance
After you publish flows and schedule them to run periodically, you want to know that they
are running as expected and resolve any issues as they occur. You will also want to monitor
and understand the performance of your flows.
This topic describes the various methods that Tableau Cloud provide to help you monitor
your flows.

Detect issues as they occur and resolve them
In Tableau Cloud, email notifications are automatically sent when flows fail. You can also
find and review errors on your server using the Alerts menu or by reviewing the flow pages
for the flows that you are interested in. This type of monitoring allows you to detect problems
as they occur.
Get notifications when a flow fails:

Email notifications are turned on by default for your site in Tableau Cloud. You can verify
this by going to Settings > General page.
View and resolve errors

Note: Starting in version 2020.4.1, you can now create and edit flows directly in
Tableau Server and Tableau Cloud. The content in this section applies to all platforms,
unless specifically noted. For more information about authoring flows on the web, see
Tableau Prep on the Web.

The following errors can happen when running a flow:
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l

Connection errors: Connection errors generally happen when Tableau Cloud is
unable to connect to one or more data inputs or is unable to make a connection in one
or more output steps.
l

For Input connection errors, use the Edit connections option on the Con-

nections tab to make changes to connection details, then run the flow again.
l

For output connection errors, check the output location for the flow output steps.
If the flow output is going to a network share, make sure the output steps are
pointing to a safe listed location. After you make any changes, republish the flow
and try running it again.

Note: To fix output connection errors for flows that output to a file or network share, download the flow to Tableau Prep Builder, then republish the
flow to your server. Flows that output to a published data source or database can be edited directly on the web.

l

Errors in the flow: If there are errors in one or more steps in the flow, you will see an
error message. You can edit the flow directly on the web and republish it. You can also
download the flow to Tableau Prep Builder, resolve the errors, republish the flow to
the server and then run the flow again.

l

Suspended flow tasks: When a scheduled flow task fails to run after a configured
number of attempts, the flow task is suspended. By default, a flow task is suspended
after 5 consecutive flow task failures.
A flow can have multiple scheduled tasks assigned to it, but only the failed tasks are
suspended. All other flow tasks will continue to run unless they have errors. To resolve
a suspended task, review and resolve the errors then run the flow on-demand or let
the flow run automatically based on the assigned schedule.

You can view errors on the following pages:
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Flow Overview page

On this page you can see the status of the most recent flow run and any errors. Hover on
the error text to review the error details. If a scheduled task is suspended, a warning icon
shows next to the schedule. Hover on the icon to view the status.
After you resolve the error that caused the flow to fail or the task to be suspended, you can
run the flow manually or let the flow run based on the assigned schedule. For suspended
flow tasks, click the Go to Scheduled Task link on the tooltip for the suspended task to navigate to the Scheduled Tasks page and click the Resume Scheduled Tasks button to
resume the suspended tasks.

Connections page

The Connections page shows the most recent status and any related connectivity errors.
To correct input errors, click the More actions

menu for an input connection to edit the

connection and change the server name, port, username and password.
To fix output connection errors, edit the flow directly or download the flow in Tableau Prep
Builder, correct the file path, then republish the flow to continue running it.
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Scheduled Tasks page

Note: The Data Management is required to see this tab.

View the scheduled tasks assigned to a flow. If a scheduled task is suspended, you can see
the status of that tasks here and you can manually resume the flow tasks from this page.
Before resuming a suspended task, resolve any errors in the flow.
Error details are not shown on this page, but you can review them on the Overview or Run
History pages. You can also click the links in the Schedule type column to view the details
of what was scheduled and to edit the tasks.
A suspended scheduled task will automatically resume when the flow is republished, if you
edit a connection for the flow or manually run the flow tasks. To manually resume a suspended tasks, on the Scheduled Tasks page, click Resume Scheduled Tasks. This
resumes all suspended tasks for the flow.
To resume individual tasks, click the More actions

menu for a scheduled task and select

Resume. You can also click Run Now to run all tasks for the flow immediately.

Tableau Software

1235

Tableau Cloud Help
Run History page

Note: The Data Management is required to see this tab.

The Run History page shows the details of all the flow runs that have either completed or
are in progress for each output. View any error details by hovering over the errors in the
Errors column. The duration column shows you the run time of the flow.

Note: Starting in version 2020.2.1, the Run Type field shows the refresh type for the
output. In prior releases this field showed whether the output was run on a schedule or
on-demand. For more information about setting up output refresh types, see Refresh
Flow Data Using Incremental Refresh.

Alerts

When a flow fails, the alerts menu is populated with the error details with the option to re-run
the flow, or download the flow to troubleshoot.

Note:Flow owners and Site Administrators can see this menu.
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Who can do this
l

l

Tableau Site Administrators:
l Set up email notifications at the site level
l View errors
l Resume suspended tasks
l View alerts
Flow owners, project leaders and any user who is granted permissions to
view the flow:
l View errors
l Resume suspended tasks
l View alerts (Flow owners)

Administrative Views for Flows
Administrative views can be used to monitor the activities related to flows, performance history and the disk space used. The Status page contains an embedded Tableau workbook
with various administrative views that can be used to monitor different types of server or site
activity.
Who can do this?

Tableau Site administrators can view and work with Administrative Views.
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Action by all users

Use this view to gather insight into how flows are being used. This includes actions like publish, download and flow runs. You can filter the view by actions, by site and by time range.
The Total Users count shows the number of users who have performed an action. This
value is not affected by any filtering. The Active user count shows the number of users who
have been active during the selected time period and performed one of the selected actions.

Action by Specific User

Use this view to gather insights about how an individual user is working with flows. You can
filter the view by username, the type of action and by time range.
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Action by Recent Users

This view shows you which users have been active on Tableau Cloud over the past 24
hours.
This can be useful if you need to do some maintenance activity on the server and want to
know which users and how many this will affect, and what they're doing.
The view shows Active, Recently Active and Idle users that are currently signed in to
Tableau Cloud.
For this view, an active user is one who took an action in the last 5 minutes, a recently active
user is one who last took an action within 30 minutes, and an idle user is one who last took an
action more than 30 minutes ago.
Select a user to see only the actions that user performed recently. Hover over an action to
see details of the action.
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Backgrounder Task Delays

This view shows the delay for extract refresh tasks, subscription and flow tasks – that is, the
amount of time between when they are scheduled to run and when they actually run. You
can use the view to help identify places you can improve server performance by distributing
your task schedules and optimising tasks.

Possible reasons for the delays and ways to reduce the delays include the following:
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l

Many tasks are scheduled for the same time.
In the example view, tasks that show long delays are clustered at the same time every
day, which creates spikes in the wait time. You can set the Timeline filter to a single
day to view task delays by hour and identify the hours of the day when many tasks are
scheduled at the same time. One solution is to distribute the tasks to off-peak hours to
reduce load on the server.

Background Tasks for Non Extracts

Background Tasks are created to run flows (scheduled and ad hoc). You can use this view to
see how many flow tasks succeeded or failed on this site. For details on a task, hover over its
icon.

Performance of Flow Runs

Use this view to see the performance history for all the flows on a site. You can filter by Flow
Name, Output Step Name, Flow Owner, Run Type (Scheduled or Ad Hoc) and the time the
flow runs were started.
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Questions you can answer using this view include:
l

What flow tasks are currently scheduled? - To do this, use the Start Time filter
and select the time frame you want to look at. For example, to see flow tasks that are
scheduled in the next 3 hours, select Hours -> Next -> and enter 3.

l

What is the duration of flow tasks? - To answer this, click on a mark in the view to
see details, including the task duration.

l

How many flows were run ad hoc, and how many were scheduled runs? - To
answer this, use the Run Type filter and select Ad hoc or Scheduled.

This view can also show you the following information:
l

Flows with the highest run frequency have the most marks.

l

To see flows that are currently running at the same time, hover over a mark that
shows “In Progress” or “Pending” and select “Keep Only” to filter all flow runs that
are currently running.

l

To see flows that are running at the same time during a specific time range, select a
range for the Start Time filter. For example, select “Next three hours” to see which
flows will be running in the next three hours.

Stats for Space Usage

Use this view to identify which flow outputs are taking up the most disk space on the server.
Disk space usage is displayed by user, project and the size of flow output, and is rounded
down to the nearest number.
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Use the Min Size filter to control which flow outputs are displayed, based on the amount of
space they take up. Use the object type filter for flows.
l

What Users Use the Most Space – This section shows the users who own flows
(when filtered for flows) that are taking up the most space. Click a username to filter
the next two graphs for that user.

l

What Projects Use the Most Space – This section shows the projects with flows
(when filtered for flows) that are using the most space.

l

What Workbooks, Data Source and Flows Use the Most Space – This section
shows the flows (when filtered for flows) that take up the most space.

Who can do this
l

l

Tableau Site Administrators:
l Set up email notifications at the site level
l View errors
l Resume suspended tasks
l View alerts
Flow owners, project leaders and any user who is granted permissions to
view the flow:
l View errors
l Resume suspended tasks
l View alerts (Flow owners)
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About Tableau Catalogue
Data is increasing in volume, formats and importance leading to more complex environments. With the rapid pace that data changes, it can be hard to keep track of that data
and how it's being used in such complex environments. At the same time, more users need
to access more of that data in more places, and it’s difficult for users to find the right data.
Ultimately, this causes a lack of trust in the data because people question whether they’re
using the right source or if the source is up to date.
Tableau Catalogue integrates features like lineage, impact analysis, data dictionary, data
quality warnings and search into your Tableau applications, helping solve these problems
differently from a stand-alone catalogue. It focuses on both IT and the end user so that
everyone using Tableau Server or Tableau Cloud has more trust in and visibility into the
data, while also enabling more discoverability. Tableau Catalogue builds a catalogue out of
the Tableau content being used by your organisation, enabling comprehensive functionality
like the following:
l

l

l

1244

Impact analysis and lineage.
l You can see the workbooks and other Tableau content that depend on particular columns or fields from tables or data sources you manage. When you
need to make changes to your data, you can notify the impacted Tableau
authors using email.
l As a workbook author, you can use lineage to trace the fields that your workbook depends on.
l As a user, when you use a Tableau visualisation, you can see where the data
came from that was used to create the view.
Curation and trust. As a data steward, you can add helpful metadata, like descriptions and certification, so that users find the right data. You can set data quality warnings, view data details on the Data Details pane, certify assets and remove assets
from the catalogue.
Data discovery. In Tableau Desktop or Tableau web authoring, you can use
Tableau Catalogue to search for databases, tables, data sources and virtual connections to analyse in Tableau and connect to them from the search results.
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Starting in 2019.3, Tableau Catalogue is available as part of the Data Management offering
for Tableau Server and Tableau Cloud. When the product key is active and enabled, the catalogue features described above are integrated into the product you're using, so you can work
with the data where you find it.

How Tableau Catalogue works
Tableau Catalogue discovers and indexes all the content on your site – workbooks, metrics,
data sources, sheets, virtual connections and flows – to gather metadata about the content.
From the metadata, databases and tables (also referred to as external assets) are identified.
Knowing the relationships between the content and the external assets enables Tableau to
display the lineage of the content and external assets. Tableau Catalog also enables users to
connect to external assets using Tableau Server or Tableau Cloud.
For information about how you can use Tableau Catalogue to support data governance in
your organisation, see Governance in Tableau in the Tableau Blueprint Help.

Key Tableau Catalogue terms
l

Metadata. Information about the data.
Tableau content. Content created in Tableau such as workbooks, data sources, virtual

l

connections and flows.
External assets. The metadata about the databases and tables used by Tableau con-

l

tent that's published to Tableau Server or Tableau Cloud.

Licence Tableau Catalogue
Tableau Catalog is licensed through Data Management. For information about how Data
Management licensing works, see Licence Data Management.

Enable Tableau Catalogue
After Tableau Server or Tableau Cloud is licensed with the Data Management, you can
enable Tableau Catalog by doing one of the following tasks:
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l

For Tableau Cloud, no action is necessary. Tableau Catalogue is on by default, configured to use derived permissions and ready to use. For more information about
derived permissions, see the Permissions on metadata topic.

l

For Tableau Server, the Server admin must first enable the Tableau Metadata API
using the tsm maintenance metadata-services command. For more
information, see Enable Tableau Catalogue.
After the Metadata API is enabled, Tableau Catalogue is on by default, configured to
use derived permissions and ready to use. For more information about derived permissions, see the Permissions on metadata topic.

Features and functionality
To learn more about the features you can use with Tableau Catalogue, see the following
Help articles:

Data discovery
l

In the Connect pane on Tableau Desktop, under Search for Data select Tableau

Server to connect to data using Tableau Server or Tableau Cloud. When Tableau
Catalog is enabled, in addition to searching for published data sources to connect to,
you can now search for and connect to the specific databases and tables used by published data sources and workbooks on your Tableau Server or your Tableau Cloud
site.
l

Search is expanded to include results based on columns, databases and tables when
Tableau Catalog is enabled.

l

If you author in the web, in addition to published data sources, you can also connect

l

to databases and tables.
If you use Tableau Prep on the web, you can create new flows based on external
assets, such as databases and tables.

Curation and trust
l
l
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Certify your data assets to help users find trusted and recommended data.
Set data quality warnings to alert users to data quality issues, such as stale or deprecated data.
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l

Categorise items on Tableau Server and Tableau Cloud using tags to help users filter
external assets.

l

Better understand published visualisations by using the Data Details tab to see information about the data used.

l

Add descriptions to databases, tables and columns to help users find the data they're
looking for.

Lineage and impact analysis
l

Use lineage to trace the source of your data and to analyse the impact of changes to
your data and identify which users might be impacted.

l

Email owners of a workbook, data source or flow or contacts for a database or table
about data-related updates.

Developer resources
You can use metadata methods in the Tableau REST API to programmatically update certain metadata. For more information about the metadata methods, see Metadata Methods in
the Tableau Server REST API.
In addition to the REST API, you can use the Tableau Metadata API to programmatically
query metadata from the content published to Tableau Server or Tableau Cloud. The
Metadata API is fast and flexible and is best when you are looking to find out specific information about the relationship between metadata and its structures. Explore and test queries
against the Metadata API using an interactive in-browser tool called GraphiQL.
Note: Data Management is not required to use the Metadata API or GraphiQL.

About Virtual Connections and Data Policies
Virtual connections are a Tableau content type, along with data sources, workbooks, metrics
and flows, to help you see and understand your data. Virtual connections provide a central
access point to data. Another key feature introduced with virtual connections is data policies,
which support row-level security at the connection level, rather than the workbook or data
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source level. Row-level security data policies are applied to any workbook, data source or
flow that uses the virtual connection.
With virtual connections, instead of having one connection per Tableau content (data
source, workbook, flow), with each connection requiring its own extract and security management, you can create one common managed connection that can access multiple tables
in the same database. You can manage extracting the data and the security in one place, at
the connection level.

For information about row-level security options, see an Overview of Row-Level Security
Options in Tableau.
Not every virtual connection has an associated data policy. You can also use a virtual connection simply as a central place to manage connection credentials.

Key terms
l
l
l

Virtual connection. A sharable resource that provides a central access point to data.
Virtual connection table. A table in a virtual connection.
Data policy. A policy that's applied to one or more tables in a virtual connection to filter
data for users. For example, use a data policy to apply row-level security to tables in a

l
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virtual connection.
Policy table. A fact or data table in a data policy that is filtered.
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l

Policy column. A column that's used to filter the data in the policy tables. A policy

l

column can be in a policy table or in an entitlement table.
Entitlement table. A table that includes both a policy column you can use to filter policy

l

tables and another column you can relate (map) to a column in a policy table.
Policy condition. An expression or calculation that is evaluated for every row at query
time. If the policy condition is TRUE, the row is shown in the query.

Licence virtual connections and data policies
Virtual connections and data policies are licensed through Data Management. For information about how Data Management licensing works, see Licence Data Management.

Enable virtual connections and data policies
Virtual connections and data policies are automatically enabled on Tableau Server and
Tableau Cloud with Data Management.

Permissions
Permissions for virtual connections work much like the permissions for other Tableau content. After you publish a virtual connection, anyone can view the connection. However, only
the connection creator and administrators can access data using the connection until the connection creator explicitly grants more permissions.
When you create a virtual connection, you must set the permissions for the Connect capability to enable other users to connect to data using the virtual connection. The Connect capability allows you to share a virtual connection and allows users to query it. With connect
permissions, a user can view the tables in a virtual connection and create content using the
tables. For more information, see Set permissions on a virtual connection.

Permissions vs. data policies
Permissions define what a person can or can't do with a piece of content in Tableau. Permissions are made up of capabilities – the ability to do things like view content, web edit,
download data sources or delete content. Permission rules define which capabilities are
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allowed or denied for a user or group on a piece of content. The interplay between licence
level, site role and potentially multiple permission rules factor into the final determination of
what a person can or can’t do – their effective permissions. See Permissions for details.
Data policies filter the data in a virtual connection, making sure that people see only the data
they're supposed to see. A data policy is applied and filters the data when it's viewed in the
Tableau content (for example, a workbook or flow). The policy condition in a data policy is a
calculation or expression that defines access to the data. User functions are often used to
limit access to users or groups. Access can be based on the user name, the group a user
belongs to, or a region value. See Create a Data Policy for Row-Level Security for details.
Both permissions and data policies govern access. Simply put, permissions determine
which content you can see, access, use or create; data policies determine which data you
can see.
How permissions and data policies work together

Tableau permissions are applied to Tableau content first. People can only do the things they
have the capabilities to do with Tableau content – data policies don't override Tableau permissions. After permissions are evaluated, the data policy is applied to determine which
data in the virtual connection the person can see based on the policy condition.
The following example describes the effects of permissions and data policies on a virtual
connection that contains salary data:
l

The virtual connection is in the HR project, which is restricted to Tableau users in the
HR group. Anyone outside the HR group can't see content in the HR project, which

l

means they can't browse to, connect to or view the virtual connection.
The virtual connection has Connect permissions granted only to members of the HR
Business Partners group. All others in the HR group can see that the virtual connection exists, but they can’t view the data it contains. When they view a workbook

l

that uses that virtual connection, they can't see any data.
The virtual connection also contains a data policy that filters the salary data based on
the individual user, so HR Business Partners can see only rows that pertain to employees in their business unit. When they view a workbook that uses that virtual connection, they see data only for their business unit.
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Features and functionality
For the manager of data, virtual connections provide:
l

l

l

l

Securely managed service accounts. If you use a ‘service account’ model, now,
instead of having to share that service account information with any user who wants to
access that data, you can give the service account credentials to the few analysts who
are empowered to create virtual connections.
Agile physical database management. You must make database changes (for
example, a field is added or table name is changed) only one time in the virtual connection, rather than in every piece of content where the data is used.
Reduced data proliferation. By centrally managing extract refresh schedules,
refreshes are scheduled once, ensuring that anyone who accesses the data from that
virtual connection is seeing fresh data.
Centralised row-level security. You can create data policies that apply row-level
security to both Tableau extracts and live queries at the connection level. The data
policies are applied to any workbook, data source or flow that uses the virtual connection.

As the user of data, you benefit from virtual connections knowing that you have:
l

l

l
l

Appropriate access to only the data you should see, because row-level security is
already applied to the data.
Flexibility to use data that's been curated and secured. The virtual connection stores
and shares the connection information. All you have to do is create a data source with
a data model specific to your needs.
Trust that data is fresh because the extract refresh schedule has already been set.
The ability to share content freely, assured that you won’t put security at risk because
data policies are always enforced.

Virtual connection editor workflow
The virtual connection editor enables you to create:
l

Virtual connections, which are a Tableau content type that provides a sharable central

l

access point to data.
Data policies that support row-level security at the connection level.
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After you create a virtual connection and its associated data policies, you can publish it and
set the permissions to share with other users. You can also schedule extract refreshes so
that all content that uses the virtual connection is accessing fresh data.
The following diagram shows the workflow to create a virtual connection. At any time during
the process, you can publish or save a draft of your connection, but the connection must be
published before you can schedule extract refreshes or use (or edit) a virtual connection.
You must also set permissions before others can use the connection.

Click on a step in the process to go to that help topic.

Next step
The first step is to Create a Virtual Connection.
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Create a Virtual Connection
A virtual connection is a Tableau content type that provides a sharable central access point
to data, and supports row-level security at the connection level. Creating a virtual connection
is a multi-step process. This topic covers connecting to the data you want to share and working in the Tables tab of the virtual connection editor.

Connect to data
To create a virtual connection in Tableau Cloud or Tableau Server:
1. From the Home or Explore page, click New > Virtual Connection.
2. In the Connect to Data dialog box, click the connector for your data.
For a list of supported connectors for virtual connections, see Creators: Connect to

Data in the Tableau Desktop and Web Authoring help.
3. Enter the information you’re prompted for.
The credentials you enter are saved in the virtual connection, so connection users
don't have to enter credentials to connect to the data.
4. Click Sign In to open the virtual connection editor.
Virtual connections support connecting to one database per connection. For more information about connectors, see Supported Connectors in the Tableau Desktop and Web Authoring help.

Note: For Tableau Cloud, virtual connections that connect to private network data use
Tableau Bridge to keep data fresh. For information about configuring Tableau Bridge,
see Configure and Manage the Bridge Client Pool. For information about supported connections, see Connectivity with Bridge.

Select tables to include in the connection
If tables aren't listed in the left pane of the editor, select a database.
1. On the left, under Tables, select the tables and click or drag them to the Tables tab on
the right. Include an entitlement table, if you're using one.
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2. (Optional) Click New Custom SQL to create a custom table schema.

Note: Virtual connections don't support tables with a spatial data type.

Select table mode: live or extract
At the top of the Tables tab, select a Table Mode. The mode you select applies to all the
tables in the virtual connection:
l
l

Live Only- Tables are queried directly from the database. (Live is the default.)
Extracts Only- Tables are extracted and saved to Tableau. Note the following:
l Click Extract Now to extract the data any time before you publish the virtual
connection. You can't edit the connection while extracts are running.
l You can schedule extract refreshes on the virtual connection page after you
publish the connection. For more information, see Schedule Extract Refreshes

for a Virtual Connection.

Set the table visibility state
Use the Visibility toggle on the Tables tab to show or hide tables and their data from users.
Users can see table data. You can create a data policy to govern which data users can
see. (Visible is the default.)
Users can’t see table data. You can use hidden tables in a data policy and as an entitlement table.

See table details
Click a table at the top of the Tables tab to see its details below. You can make simple edits
in the Table Details section, such as changing a table name, hiding or renaming a column or
changing a data type.
Switch the table information you see using these icons:
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A list of columns in the table and each column's data type.
Sample data for each column and linked keys, if available. Linked keys show which
columns link to other tables. They're visible only when databases have primary and
foreign key information.
The range of values in a histogram for each column selected.
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Who can do this
To create a virtual connection, you must
l
l

have credentials to the database that the virtual connection connects to, and
be a server or site administrator, or a Creator.

Next steps
After tables have been added and configured on the Tables tab, you can choose to Create a
Data Policy for Row-Level Security or Publish a Virtual Connection and Set Permissions.

Create a Data Policy for Row-Level Security
Use a data policy to apply row-level security to one or more tables in a virtual connection. A
data policy filters the data, ensuring that users see only the data they're supposed to see.
Data policies apply to both live and extract connections.

About data policies
A data policy has three main components:

1. The tables they apply to are called policy tables. These are the tables that are filtered.
2. The mapped columns that define the relationships between tables (for example,
between entitlement and fact tables) and between table columns and policy columns.
A policy column is the column used to filter data.
3. The policy condition, which is an expression or calculation that is evaluated for every
row at query time. If the policy condition is TRUE, the row is shown in the query.
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When you create a data policy, you need a column you can use to filter the data. This column
is called a policy column. Data is filtered by the policy condition, usually using a user function,
such as USERNAME() or FULLNAME().
If your policy table includes a column that you can filter on, then use that column as your
policy column.
When a policy table doesn't include such a column, use an entitlement table with a column
you can use to filter the data. An entitlement table is a table that includes both a policy column
you can use to filter policy tables and another column you can relate (map) to a column in a
policy table (as shown in the data policy example image above).

Filter with a policy column from a policy table
The most common way to filter data is to use a column in the table that has the data that you
want to filter on. Use that column as a policy column and then map the appropriate table
columns to the policy column.
To use a policy column to filter your data, first, add tables to the policy from the left pane. To
add a table, do one of the following:
l

Double-click on the table name.

l

Click the drop-down arrow near the table name and select Manage table with policy.

l

Or, drag the table to the right and drop it on Add as Policy Table.

After a table is added to a policy, a shield icon

appears to the right of the table name in the

left pane indicating that it's a policy table.
Next, map columns to create a relationship between the column name in the table and the
policy column name. Use the policy column name in the data policy condition to control rowlevel data access for users:
1. Click +Add Column to Map to add one or more columns you’ll use to filter data.
2. Name the policy column. You'll use this name in the policy condition.
3. For each table the policy applies to, use the drop-down menu to select the table
column that maps to the policy column.
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4. Repeat this process for as many policy columns as you want to use in the policy condition.

Tip: Instead of using the +Add Column to Map button, you can start typing the calculation in
the policy condition area and use auto-complete to choose the column name, which will
then populate the policy column information under Step 1.
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An example using a policy column from a policy table

A. The Sales table has a [Salesperson] column, and the Region table has a [SalesRep]
column. The Salesperson and SalesRep data matches the full name of Tableau users
on your site.
B. You want to filter the Sales and Region data by Salesperson, so you name the policy
column "Salesperson", and then map the Salesperson column from Sales and the
SalesRep column from Region to the Salesperson policy column.
C. Then write the policy condition to filter both tables. Use the [Salesperson] policy
column and the FULLNAME() user function so that each user can see only their own
data.

Filter with policy column from an entitlement table
Entitlement tables are used when your policy table doesn’t contain a column you can filter
on. You can use the entitlement table to map a column in the data table to a column in the
entitlement table. Note the following:
l
l

Be sure to include the entitlement table as a table in the virtual connection.
The entitlement table must be on the same database as your data tables. If it isn't,
you might be able to use Tableau Prep to write the entitlement table to the database
using a flow output. For more information, see Save flow output data to external data-

l

bases in the Tableau Prep help.
If you don't want virtual connection users to see the entitlement table, you can toggle
the setting in the Visibility column on the Tables tab to hide it.

To use an entitlement table to filter your data:
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1. Add the data tables that you want the data policy to apply to. Do one of the following:
l Double-click on the table name.
l

Click the drop-down arrow near the table name and select Manage table with

policy.
l Or, drag the table to the right and drop it on Add as Policy Table.
After
a table is added to a policy, a shield icon appears to the right of the table name
2.
in the left pane indicating that it's a policy table.
3. Select the entitlement table, then either:
l

Click the drop-down arrow and select Use as entitlement table.

Or, drag the table to the right and drop it on Add as Entitlement Table.
4. For each table that the policy applies to, click the drop-down menu and select the
l

column to map the policy table to the entitlement table.
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An example using a policy column from an entitlement table
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A. The data you want to filter has an EMP_ID column, but not an employee name column.
However, you have a second table that includes columns for both EMP_ID and the
employee's FULL NAME. And, the values in the employee FULL NAME column match
the full name of Tableau users on your site.
B. You can add Employees table to the policy as an entitlement table, and then map the
policy table column name EMP_ID to the entitlement column name EMP_ID for each
table.
C. Then use the FULLNAME() function in your policy condition to match the Tableau
Server user's full name with the entitlement table's [FULL NAME] column (which is the
policy column) so that each user can see only their own data.

Write a policy condition
The last step in creating a data policy is to write a policy condition, which is a calculation or
expression used to define row-level access. Policy conditions are often used to limit access
to users or groups through user functions.
A policy condition:
l
l
l

Is required in a data policy.
Must evaluate to true or false.
Shows rows when the policy condition is true.

Policy condition examples

Shows only rows where the Region column value is North:
[Region] = "North"
Enables a signed-in user to see the rows where the user's name matches the value in
EmployeeName:
FULLNAME() = [EmployeeName]
Enables members of the Managers group to see all rows, while users can see only the rows
where their username matches the value in the employee_name column:
ISMEMBEROF('Managers') OR USERNAME() = [employee_name]
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Note: When you close a policy tab, it doesn't discard your work.

Supported Tableau functions in policy conditions

Policy conditions support a subset of Tableau functions:
l
l
l
l
l

Logical (except null-related)
String
User
Date
Number: MIN, MID, MAX

To see which specific functions are supported, in the virtual connection editor, on the Data
Policies tab, see the Reference panel on the right.

Who can do this
To create a data policy, you must
l
l

have credentials to the database that the virtual connection connects to, and
be a server or site administrator, or a Creator.

Next steps
After you create a data policy, the next step is to verify that it works as you expect it to. See
Test Row-Level Security with Preview as User. Or, if you're ready to share the virtual connection and its data policies with others, see Publish a Virtual Connection and Set Permissions.

Resources
For detailed information about calculations, see Understanding Calculations in Tableau in
the Tableau Desktop and Web Authoring help.
For information about user functions, see User Functions in the Tableau Desktop and Web
Authoring help.
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For information about other row-level security options in Tableau, see Overview of RowLevel Security Options in Tableau in the Tableau Server help.

Test Row-Level Security with Preview as User
Use Preview as user to test your data policy. You can see the data as the user sees it and
ensure that row-level security is working as expected. This helps when the data policy keeps
you from seeing the rows in the table (for example, if only salespeople can see rows and
you’re not a salesperson).
To preview the data when the data policy is applied:
1. Select a table.
2.
3.
4.
5.

In the Table Details section, tick the With policy applied box.
Click Preview as user, select a Group (optional) and a User.
Verify that the policy shows the correct data for that user in the table details.
Repeat for other users as needed.

Tip: In Table Details, click to show the range of values for a column, including which values
appear and which are filtered out by the data policy. Select one or two columns that are good
indicators that the policy is correctly filtering the data.

Who can do this
To test a virtual connection, you must
l

have credentials to the database that the virtual connection connects to, and

l

be a server or site administrator, or a Creator.

Next step
After you test your data policy, when you're ready to share the virtual connection with others,
see Publish a Virtual Connection and Set Permissions.

Tableau Software

1265

Tableau Cloud Help

Publish a Virtual Connection and Set Permissions
When you work in the virtual connection editor, your changes are automatically saved as a
draft while you work. To share a new virtual connection with other users, you need to publish it.

Save a draft
You can manually save a draft of the connection by clicking the save icon in the toolbar or
by selecting File > Save Draft from the menu.
When editing a published virtual connection, the connection stays available to users in its
current published state. You can save your updates as a draft while you work on the connection in the editor. To share the updates to the virtual connection with other users, you
need to publish it.
Draft in progress

If you close the editor while updating a published virtual connection, the next time you open
the connection in the editor within seven days, you have the option of continuing to make
edits to the existing draft, starting a new draft or opening the connection in its current published state by clicking Cancel.

To return to a draft version of an unpublished virtual connection, you need to manually save
the URL of the draft before you close the editor. You can use the URL to open the draft in
the editor the next time you want to work on the connection within seven days. For example:
https://yourserver.test.com/published-connection-editor/?draft=d1789edc-5d9f-40ae-988d-9fc879f37a98
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Publish the connection
To publish a new connection:
1. Click the Publish button in the upper right corner of the editor or select File > Publish
from the menu.
2. In the Publish dialog box:
a. Type a name in the Name field.
b. Select a project to save the connection to.
3. Click Publish.
To publish an updated connection, click the Publish button in the upper right corner of the
editor or select File > Publish from the menu.

Set permissions on a virtual connection
After you publish a virtual connection, you need to set the permissions so that others can use
it. By default, all users can View the connection – in other words, see it listed under Virtual
Connections in Tableau – but unless you set the Connect capability to Allowed, only you
and administrators can use the virtual connection. For more information on the Connect capability, see Permissions.
To set permissions:
1. Navigate to the virtual connection.
2. Open the Actions menu (...) and click Permissions.
3. Tick the box under the Connect icon so that connect is allowed for all users.

Tableau Software

1267

Tableau Cloud Help
Tip: You can add additional rules if you want to grant the permission only to certain
users or groups.
4. Click Save.
For more information about permissions on Tableau content, see Permissions. For information on embedding passwords when you publish Tableau content such as a data source or
workbook that uses a virtual connection, see Virtual connections in the Tableau Server
help.

Who can do this
To publish a virtual connection or set permissions, you must
l
l

have credentials to the database that the virtual connection connects to, and
be a server or site administrator, or a Creator.

Next step
After you publish a virtual connection and set its permissions, you can Use a Virtual Connection.

Schedule Extract Refreshes for a Virtual Connection
One of the benefits of virtual connections is that you can reuse the same extract multiple
times, reducing data proliferation and removing redundant extract refresh jobs. To ensure
that extract data is fresh for any content that uses a virtual connection, you can create an
extract refresh schedule for the tables in your connection.

Extract tables
1. Select Extracts Only from the Table Mode drop-down menu.
2. Click Extract Now. Note that you can't edit the virtual connection while extracts are
being generated.
3. Click Extract to extract the tables.
4. Click Publish to publish the virtual connection.
5. Click File > Close to close the virtual connection editor.
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Schedule extract refreshes on Tableau Server or Tableau Cloud
1. Navigate to the virtual connection page. (From the Home or Explore page, click Virtual
Connections from the drop-down menu, then select your virtual connection.)
2. On the Tables tab, the Data is column should have Extract as the value. If it doesn't,
refresh your browser.
3. Select the Scheduled Tasks tab and click +New Task.
4. The Create Schedule Task dialog box has different options, depending on your
product:
In Tableau Server:
a. Select a schedule from the drop-down menu.
b. Select whether to keep all extract refreshes in sync (if one fails, they all fail) or
refresh independently (extracts succeed or fail individually).

c. Click Add or Edit Tables to select the tables you want to refresh. Virtual connections support only full refresh.

d. Click OK.
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e. Click Create Scheduled Task.

In Tableau Cloud:
a. Select the Refresh Frequency using the drop-down menus for Repeats, Every
and At. Select the days to refresh under On.

b. Select whether to keep all extract refreshes in sync (if one fails, they all fail) or
refresh independently (extracts succeed or fail individually).

c. Click Add or Edit Tables to select the tables you want to refresh. Virtual connections support only full refresh.

d. Click OK.
e. Click Create Scheduled Task.
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Virtual connections that connect to private network data use Tableau Bridge to
keep data fresh. For more information, see Configure and Manage the Bridge
Client Pool.

Time limit for extract refreshes
To ensure that long-running refresh tasks don't take up all system resources and don't prevent refreshes of other extracts on your site, extract refreshes for a virtual connection are subject to a two-hour time limit. For more information about the timeout limit for refresh tasks and
suggestions for resolving these errors, see Time limit for extract refreshes. However, note
that virtual connections support only full and not incremental refreshes.
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Who can do this
To publish a virtual connection or set permissions, you must
l
l

have credentials to the database that the virtual connection connects to, and
be a server or site administrator, or a Creator.

Next step
After you schedule extract refreshes for a virtual connection, you can Use a Virtual Connection

Use a Virtual Connection
After a virtual connection is published and permissions are set, it's available to users to connect to data in the same ways that users access all data in Tableau. When you must edit a
virtual connection or the data policy in the connection – for example, when the underlying
schema changes – simply open the connection in the virtual connection editor, make your
changes and either save or publish the updates. You can also replace an existing data
source in a workbook with a virtual connection.

Connect to a virtual connection
For web authoring in Tableau Cloud or Tableau Server:
1. On the Home or Explore page, click New.
2. Select the type of content you want to create: workbook, flow or published data
source.
3. In Connect to Data > On This Site > Content Type drop-down menu, select Virtual
Connections.
4. Select the name of the connection and click Connect.
For Tableau Desktop and Tableau Prep:
1. On the Connect pane, under Search for Data, click Tableau Server.
2. Enter the server name and click Connect, or click Tableau Cloud.
3. Enter the information prompted for.
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4. On the Search for Data dialog box, from the Content Type drop-down menu, select Virtual Connections.
5. Select the name of the connection and click Connect.

Note: There's no need to enter credentials when you connect using a virtual connection. The credentials to access the data are embedded in the connection.

Edit a virtual connection or data policy
When editing a published virtual connection, the connection stays available to users in its current published state. For more information, see Publish a Virtual Connection and Set Permissions.
To edit a connection, navigate to it from the Explore page. Note that even though database
credentials are embedded in the connection, only those with the database credentials can
make any changes to a virtual connection.
1. From the drop-down menu, select All Virtual Connections, then select the connection you want to edit.
2. Click Edit Virtual Connection.
3. Enter the information prompted for to connect. To edit a connection, you must enter
the credentials required to access the data.
4. Click Sign In.
5. In the virtual connection editor, make your changes and then either save a draft or publish the connection.
Respond to underlying schema changes

When the underlying schema in a virtual connection changes – for example, a table is added
or deleted, or a column is added or renamed – you must edit the virtual connection to reflect
the schema changes and then republish the connection. (If the connection has extracts,
remember to refresh the extracts.) This way, you can add or edit the tables, columns and
policies in the connection before new data is exposed to everyone.
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Work with virtual connection revision history
When you publish a virtual connection, a version is saved in the revision history for Tableau
Cloud or Tableau Server. You can revert to a previous version at any time.
To access revision history, you must have a Creator site role and the View and Overwrite
permissions.
To see the virtual connection revision history, click the actions menu (. . .) for the virtual connection, then click Revision History.

Restore or delete a virtual connection revision

To restore a virtual connection revision, select a revision and then click Open. You are then
prompted to discard the existing version of the connection. When you click Discard and
Continue, the revision you selected becomes the current version of the connection.
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To delete a revision, from the revision's actions menu (. . .), click Delete.

Replace an existing data source in a workbook with a virtual connection
For web authoring in Tableau Cloud or Tableau Server:
1. Download the workbook. For more information, see Download Views and Workbooks
in Tableau Desktop Help.
2. In Tableau Desktop, open the workbook and replace its existing data source with a virtual connection. For more information, see Replace Data Sources in Tableau Desktop
Help.
3. In Tableau Desktop, upload the workbook to your Tableau Cloud or Tableau Server
site. For more information, see Upload Workbooks to a Tableau Site in Tableau
Desktop Help.

4. In Tableau Cloud or Tableau Server, click Publish to save your changes to the server.
For Tableau Desktop:
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1. Open the workbook and replace its existing data source with a virtual connection. For
more information, see Replace Data Sources in Tableau Desktop Help.

2. Republish the workbook. For more information, see Simple Steps to Publish a Workbook in Tableau Desktop Help.
Downgrade from Tableau 2022.1 breaks virtual connections

If you upgrade to Tableau 2022.1 and then downgrade to Tableau 2021.4, the virtual connections you created in 2022.1 don't work in 2021.4 because of permissions issues. The
solution is to upgrade to 2022.1 or to recreate the virtual connections in Tableau 2021.4.

Who can do this
To use a virtual connection, you must be a server or site administrator, or Creator.
To edit a virtual connection or data policy, you must
l
l

have credentials to the database that the virtual connection connects to, and
be a server or site administrator, or a Creator.

To migrate existing content to use a virtual connection, you must
l
l

be a server or site administrator, or
be a Creator who is also the data source owner.

Tableau Help and Support
l

Get Started
Learn what Tableau Cloud can do

l

Quick Help

Get help with what you're doing now
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l

What's New Highlights

Learn what's new in Tableau Cloud

l

Training

Video training and tutorials

l

Troubleshoot

Troubleshooting and Support articles

Quick Help
Connect to Data
About the Virtual Connection Editor
Add Tables to the Connection
About Data Policies
Create and Test Data Policies
Not finding what you need?
Go online to see all Tableau help

What's New Highlights
Note: Innovations are delivered to Tableau Cloud across a worldwide infrastructure.
Access to them might occur earlier or later than announced.
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In Tableau Cloud for October 2022:
l

MFA enforcement for site admins and all new sites: Multi-factor authentication
(MFA) is enabled for site admins on existing sites and all roles for new sites.

l

Virtual Connections support cloud-based file connections:Use a cloud-based
file to connect to data you want to include in your virtual connection.

l

Virtual Connections support site encryption: When your site is set for encryption at rest, virtual connections support extracts.

l

Write Tableau Prep Flow output to CRM Analytics:Clean your data using
Tableau Prep and get better prediction results in CRM Analytics.

l

Copy values from the Tableau Prep data grid: Copy a selected set of values
from the data grid in Tableau Prep and paste them into any document.

l

Tableau External Actions (web authoring): Connect disparate data sources with
this new dashboard object. For example, run automated flows in Salesforce directly
from a Tableau viz and take action from data insights within the flow of work.

l

Subscriptions for workbooks and views: Subscription emails are sent from
@cloudmail.tableau.com and dedicated IP addresses 54.240.86.205 and
54.240.86.204.

See full list

Quick Help Overview
Delivered in the product, Quick Help shows relevant just-in-time help content based on
where you are or what you're doing in Tableau. From conceptual content to step-by-step
instructions, Quick Help provides the answers you need without ever having to leave the
product.
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To access Quick Help in Tableau:
l

Click the help button on the top right of your screen

l

Click the Help menu on the toolbar

Quick Help opens, showing the help content for your task. Move the window around or resize it so you can follow along in the product.
When you move to a new area of the page or change pages, simply click the help button
again to refresh the content, or click the related tasks at the bottom of the window to move to
a related topic.
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Click the Home button to explore all available content options such as Get Started tutorials, training videos and more.
The Quick Help content in this section is the same content that's available in the product. If
you don't find what you need in Quick Help when you're in the product or you just want to
explore topics in more depth, check out the product help online.
Note: You must have an internet connection to access Quick Help in the product. If you are
offline or don't have access to the internet, you can download PDF content for each product
help set from the Tableau Help page.

Related tasks
Connect to Data
About the Virtual Connection Editor
Add Tables to the Connection
About Data Policies
Create and Test Data Policies
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Not finding what you need?
Go online to see all Tableau help

Connect to Data
Before you can create a virtual connection, you must connect to data.
1. In the Connections pane, click .
2. Choose the connector for your data.
3. Enter the information you’re prompted for.
4. Click Sign In, and then begin creating a virtual connection.
More about Supported Connectors
Related tasks

About the Virtual Connection Editor
Not finding what you need?
Go online to see all Tableau help

About the Virtual Connection Editor
Centralise and manage data access for your organisation using these features:
l
l
l

Virtual connections – Reusable, managed data access points.
Data policies – Use to set row-level security.
Centralised extracts – Reuse the same extract multiple times.

Use the virtual connection editor to create virtual connections and data policies. The following diagram shows the process:
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To get started, select a database, if required. Then, select and drag a table to the Tables
tab.
Read full topic
Related tasks

Add Tables to the Connection
About Data Policies
Create and Test Data Policies
Not finding what you need?
Go online to see all Tableau help
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Add Tables to the Connection
On the Tables tab:

Add tables to the connection
Add tables
Choose an option:
l

On the left, under Tables, select tables and double-click or drag them to the Tables
tab on the right. Include an entitlement table, if you're using one.

l

Click

to create a custom table schema.

View and edit table details
1. Select a table in the Tables tab.
2. In the Table Details section, click a column value to make edits like hiding or renaming a column, or change the data type.

Select table mode: live or extract
In the top-right of the Tables tab, select a Table Mode. The mode applies to all tables in the
connection.

Live Only - Queried directly from the database. (Live is the default.)
Extracts Only - Extracted and saved to Tableau.
l

Click Extract Now to extract the data any time before you publish the virtual connection.
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l

Schedule extract refreshes on the virtual connection page after you publish the connection.

Read schedule extract topic

Set the table visibility state
Use the Visibility toggle to show or hide tables from users.
Users can see table data. Create a policy to govern which data users can see. (Visible
is the default.)
Users can’t see table data. You can use hidden tables in a data policy and as an entitlement table.

See table details
Click on a table at the top of the Tables tab to see its details below.
Switch the table information you see using these icons:
Data type for each column.
Sample data for each column.
Range of values in a histogram for each column selected.
Quick clip: View your table details.
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See Linked keys by clicking to see which columns link to other tables. Linked keys appear
only when databases have primary and foreign key information.

Publish the connection and set permissions
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Save a draft or publish a connection

Your connection is automatically saved as a draft while you work. Manually save the draft by
clicking .
To share a new virtual connection with other users, you need to publish it.
1. Click

in the upper right corner of the editor.

2. Type a name for the connection in the Name field.
3. Select a project to save the connection to.
4. Click
When you edit an existing connection, it remains available to users in its current published
state.
l
l

To save updates to a draft, click .
To make the updated connection available to users, click

Set permissions so others can use the connection

You've published the connection, and you're ready to let others use it. To do this, set the
Connect capability to Allowed.
1. Navigate to the virtual connection.
2. Open the Actions menu (...) and click Permissions.
3. Select the box under the Connect icon so that connect is allowed for all users.

4. Click Save.
Read publish and permissions topic
Read virtual connections topic

1286

Tableau Software

Tableau Cloud Help
Related tasks

About the Virtual Connection Editor
About Data Policies
Create and Test Data Policies
Not finding what you need?
Go online to see all Tableau help

About Data Policies
Use a data policy when you want to apply row-level security to one or more tables in the connection. Data policies apply to both live and extract connections.
A data policy has three main components:

A. The tables they apply to are called policy tables. These are the tables that are filtered.
B. The mapped columns that define the relationships between tables (for example,
between entitlement and fact tables) and between table columns and policy columns.
A policy column is the column used to filter data.
C. The policy condition, which is an expression that is evaluated for every row at query
time. When TRUE, the row is shown in the query.
To get started, click

.

Read full topic
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Related tasks

About the Virtual Connection Editor
Add Tables to the Connection
Create and Test Data Policies
Not finding what you need?
Go online to see all Tableau help

Create and Test Data Policies
Use a data policy to filter data in any view, data source or flow that uses the virtual connection. Use a column in a policy table or an entitlement table to filter the data to only what a
user should see.
l
l
l

Policy table - the tables that are filtered.
Policy column - column used to filter the data.
Entitlement table - a table that includes a column you can use to filter the data. Use
when policy tables don't include a policy column.

Add tables to the policy
To create a data policy:
1. Click
2. Click the default name on the tab to rename the policy.
3. Double-click the table name in the left pane to add tables to the data policy.
Read full topic

Map table columns
For each policy table, map a column in the policy table to either a policy column or an
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entitlement table.
Map to a policy column
to add one or more columns to use to filter data.
1. Click
2. Name the policy column. You'll use this name in the policy condition.
3. For each policy table, use the drop-down menu to select the table column that maps to
the policy column.
4. Repeat this process for as many policy columns as you want to use in the policy condition.

Quick clip: Map a table column to a policy column and write a policy condition for a data
policy that filters invoices by Salesperson.
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Read full topic
Map to an entitlement table

1. Select the entitlement table, drag it to the right and drop it on Add as Entitlement
Table.
2. For each policy table, click the drop-down menu and select the columns to map the
policy table to the entitlement table.
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Quick clip: Map an entitlement table (with EmployeeID and Full Name columns) to policy
table columns and write a policy condition for the data policy.

Read full topic

Write a policy condition
A policy condition is a calculation that often uses a user function to define row-level access.
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More about User Functions in help online.
A policy condition:
l
l
l

Is required in a data policy.
Must evaluate to true or false.
Shows rows when the policy condition is true.

Example:
FULLNAME() = [EmployeeName]
Read full topic

Test your data policy using Preview as user
Test your policy to see the data as the user sees it and ensure that your policy is working as
expected.
1. Select a table.
2. In the Table Details section, select
3. Click Preview as user, select a Group (optional) and a User.
4. Verify the policy shows the correct data for that user in the table details.
5. Repeat for other users as needed.
Read full topic

Publish the connection and set permissions
Save a draft or publish a connection

Your connection is automatically saved as a draft while you work. Manually save the draft by
clicking .
To share a new virtual connection with other users, you need to publish it.
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1. Click

in the upper right corner of the editor.

2. Type a name for the connection in the Name field.
3. Select a project to save the connection to.
4. Click
When you edit an existing connection, it remains available to users in its current published
state.
l
l

To save updates to a draft, click .
To make the updated connection available to users, click

Set permissions so others can use the connection

You've published the connection, and you're ready to let others use it. To do this, set the Connect capability to Allowed.
1. Navigate to the virtual connection.
2. Open the Actions menu (...) and click Permissions.
3. Select the box under the Connect icon so that connect is allowed for all users.

4. Click Save.
Read publish and permissions topic
Related tasks

About the Virtual Connection Editor
Add Tables to the Connection
About Data Policies
Not finding what you need?
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Go online to see all Tableau help
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About Tableau Advanced Management on Tableau Cloud
Tableau Advanced Management is a collection of features designed to provide enhanced
security, manageability and scalability capabilities for your Tableau Cloud deployment.

Advanced Management Licensing
Advanced Management is licensed on a per deployment basis.
l

Advanced Management can only be used with a Tableau Cloud deployment. For
more information on how to purchase Advanced Management for an existing Tableau
Cloud deployment, contact your account manager.

l

If Advanced Management is removed or deactivated for your deployment, you will no
longer be able to use the features associated with Advanced Management.

Feature table
The following table lists the features that are included with Advanced Management:
Feature

Description

Requirements to use the feature

Content

The Content Migration Tool provides an

Migration

easy way to copy or migrate content

Tool must be installed

Tool

between Tableau projects in your Tableau

on a version of

Cloud deployment.

Microsoft Windows that

l

The Content Migration

supports .NET 4.6.1

For more information, see About Tableau

(Windows 7 or later,

Content Migration Tool.

Windows Server
2008R2 or later).
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Feature

Description

Requirements to use the feature

Activity

The Activity Log can send log events to

Log

Amazon Simple Storage Service (S3),

l

Amazon Web Services
(AWS) account.

where you can use them to conduct further
auditing and analysis.

l

Amazon Simple Storage Service (S3)

For more information, see Activity Log.

bucket to receive data.
l

AWS Key Management Service
(KMS) key.

Admin

Admin Insights data sources retain up to

Insights

365 days of site data.

data retention

For more information, see Use Admin
Insights to Create Custom Views.

Customer-

Customer-Managed Encryption Keys give

Managed

you an extra level of security by allowing

Encryption

you to encrypt your site data extracts with a

Keys

customer-managed site-specific key. For
more information, see Customer-Managed

Encryption Keys.
Increased

With Advanced Management, you get the

Site Capa-

following capacity increases for your

city

licensed sites:
l
l
l

Storage of up to 1 Terabyte
Maximum file size of 25 Gigabytes
Up to 25 concurrent Extract
refreshes

For more information on site capacity, see
Tableau Cloud Site Capacity.
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Activity Log
If you have Tableau Cloud with Advanced Management, you can configure the Activity Log
to send log events to Amazon Simple Storage Service (S3) for further analysis and auditing.
With the Activity Log, you can:
l

View detailed event data for Tableau Cloud.

l

Capture compliance information and keep track of who is doing what on your Tableau
sites.

l

Audit permissions changes including:
l

Adding or removing users from a group.

l

Moving a piece of content from one project to another.

l

Explicitly changing the permissions on a piece of content.

You can track permissions change events that are essential for implementing a robust
book of controls on your Tableau environment. These controls are useful for compliance use cases.
Supplement the information provided by Admin Insights and Admin Views to track site
activity and usage metrics.
All events include a timestamp and the ID of the actor that performed the event. If relevant, the ID of the piece of affected content is included with the event.
You can use tools like Splunk or Amazon Cloudwatch to examine the Activity Log. You
can use these tools to query log fields and answer questions like:
l

What were the 10 actions last taken by a particular user.

l

Who last performed an event on a piece of content.

l

What was the last action taken on a piece of content.
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Set Up Activity Log
The Activity Log contains detailed events for your Tableau deployment that you can use for
compliance, monitoring and auditing. You must complete the following steps in order to use
Activity Log.
Prerequisites

To use the Activity Log, you must have the following:
l

Tableau Cloud with Advanced Management

l

Amazon Web Services (AWS) account
l

You'll need your own AWS account to complete these steps.

l

You'll also need the Tableau AWS account number (061095916136) in Step
3 below, to receive the activity log in your Amazon Simple Storage Service (S3)
bucket.

l

Amazon Simple Storage Service (S3) bucket to receive data
l

You’ll create an Amazon S3 bucket as part of the setup process. Amazon S3 is
currently the only supported data delivery option.

l

You must create the Amazon S3 bucket in the same AWS region where your
Tableau Cloud site is hosted. For more information about data locations, see
Security in the Cloud and Tableau Cloud IP addresses for data provider authorisation.

l

AWS Key Management Service (KMS) key for the Amazon S3 bucket that you create during setup.

Step 1. Create an AWS account

If you don’t already have an Amazon Web Services (AWS) account, you can sign up for an
AWS account at the AWS website.
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Step 2. Create an Amazon S3 bucket and set up permissions

1. Create an Amazon S3 bucket to receive your log data. For more information, see
Creating a bucket at the AWS website.
2. Configure the Amazon S3 bucket with the following settings:
a. Under Object Ownership, select ACLs disabled (recommended). This
ensures that the bucket owner is the owner of all objects written to it.
b. Under Bucket Versioning, select Enable. Bucket versioning must be enabled
in order to replicate objects.
c. Under Default encryption, select Enable.
d. Choose AWS Key Management Service (SSE-KMS).
e. Choose Enter AWS KMS key ARN.
f. Click the Create key button that appears to create a new AWS Key Management Service (KMS) key.
g. Select Symmetric Key type and Encrypt and decrypt Key usage.
h. Name the key with an alias and then click through until the Review page.
i. Add the following statement to the Statement list inside the Key policy to give
Tableau access to encrypt objects in the S3 bucket. Replace account-numberprovided-by-Tableau/ role-provided-by-Tableau with the account number/role
provided by Tableau, respectively.

Note: This statement allows the Tableau IAM role to encrypt the objects
placed in the Amazon S3 bucket. “kms:GenerateDataKey” is used to
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generate a data key to encrypt object replicas. “kms:Encrypt” is used to
encrypt object replicas created in the target S3 bucket. “Resource”: “*”
grants permission for the KMS key only to the replication role and doesn’t
allow the role to elevate its permissions. For more information, see Protecting data using server-side encryption with AWS Key Management Service (SSE-KMS) at the AWS website.

{
"Sid": "AllowTableauS3ReplicationSourceRoleToUseTheKey",
"Effect": "Allow",
"Principal": {
"AWS": "arn:aws:iam::account-number-provided-byTableau:role/role-provided-by-Tableau""
},
"Action": [
"kms:GenerateDataKey",
"kms:Encrypt"
],
"Resource": "*"
}
j. Click Finish to create the KMS key.
k. Click Create bucket to create the Amazon S3 bucket.
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3. Update permissions on the Amazon S3 bucket policy.
a. Open the Amazon S3 bucket and click on the Permissions tab.
b. Locate the Bucket policy section and click Edit.
c. Add the following to the Statement list in the bucket policy. Replace S3BUCKET-NAME with the name of the bucket and account-number-providedby-Tableau/role-provided-by-Tableau with the account number/role provided
by Tableau, respectively.

Note: This statement allows the Tableau IAM role to replicate objects into
the bucket. Using "*" and "<path>/*" grants access to all prefixes in the specified bucket and path in the bucket, respectively. The "s3:ReplicateObject"
and "s3:ReplicateDelete" permissions are the minimum permissions
required to successfully replicate objects and delete markers. See Granting
permissions when the source and destination buckets are owned by different AWS accounts at the AWS website.

{
"Sid": "TableauS3ReplicationRoleAccess",
"Effect": "Allow",
"Principal": {
"AWS":
"arn:aws:iam::account-number-provided-by-Tableau:role/role-provided-by-Tableau"

},

"Action": [
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"s3:ReplicateObject",
"s3:ReplicateDelete"
],
"Resource": [
"arn:aws:s3:::S3-BUCKET-NAME",
"arn:aws:s3:::S3-BUCKET-NAME/*"
]
}
d. Click Save changes.
Step 3. Gather the following AWS information to set up Activity Log
l

The AWS account number: 061095916136

l

The name of the Amazon S3 bucket created above.

l

The Amazon Resource Name (ARN) of the AWS Key Management Service (KMS)
key created above: arn:aws:iam::061095916136:role/prod-replication-rule-role.

Step 4. Configure Tableau Cloud

1. Navigate to your Tableau site.
2. On the Settings page, select the Integrations tab.
3. In the Activity Log section, select the Enable button.
4. In the Set Up Connection dialog box, enter the following information:
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a. In the AWS account number box, enter the 12-digit AWS account number.
b. In the S3 bucket name box, enter the name of the Amazon S3 bucket. This
must be a valid name according to AWS bucket name requirements.
c. In the KMS key ARN box, enter the KMS key Amazon Resource Name
(ARN). The account number in the ARN must match the provided AWS
account number and be of a valid format (i.e. arn:aws:kms:<region>:<accountid>:key/<key-id>).
5. Click Submit.
The connection status column will show as ‘In progress’ as the system attempts to replicate a text file to the target Amazon S3 bucket to test the connection.
After the file has been successfully replicated to the target Amazon S3 bucket, the connection status column will state Pending verification and display a widget to input ‘Test
file contents’. You might need to refresh the page to see updates.
Verify security file replication

1. Go to the target Amazon S3 bucket and find the folder beginning with siteLuid (the
remainder of the name is the site’s unique identifier).
2. Find the text file named SECURITY_VERIFICATION_FILE.txt.
3. Download and open the text file.
4. Copy the text content inside the file.
5. Return to the Settings page and paste the text contents into the Text file contents
input field, and then click Submit.
6. If the submitted content is correct, the connection status changes to Active. Activity
Log is now enabled, and data will begin to replicate to the target Amazon S3 bucket.
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7. If the submitted content is incorrect, an error message will be displayed. Check that
the content was copied correctly without extra characters or spaces.
Troubleshooting
Security verification file not appearing?
l

The file could take up to 15 minutes to appear in the target Amazon S3 bucket due to
Amazon S3 limitations.

If the connection status says "In progress", the file is still attempting to replicate. For
more information, see Troubleshooting replication at the AWS website.
l

A connection status of Failed means that the file was unable to replicate successfully.

Confirm that the permissions on the Amazon S3 bucket policy and the AWS Key Management Service (KMS) key policy contain the appropriate statements. For more
information, see the following topics at the AWS website:

l

Troubleshooting replication
Configuring replication when source and destination buckets are owned by dif-

l

ferent accounts
I set up replication between my buckets, but new objects aren’t replicating.

l

How can I troubleshoot this?

Audit Permissions Using the Activity Log
Any changes to content explicit permissions as well as permission default templates (such
as a project's workbook permission template) are actions that are written to the Activity Log.
These actions include:
l

Changes to explicit permissions and default permission templates via Permissions
Dialog UI.

l

Changes to explicit permissions and default permission templates via REST API (specifically, the "add" and "delete" APIs. For more information, see Permissions
Methods).
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l

System actions that indirectly result in a change in permissions. System actions that
can change explicit permissions include things such as when a piece of content is
deleted, the system will automatically delete any permissions associated with it.

Only changes to User Rules and Group Rules mentioned here are part of the Permissions
Audit History Logs and any changes to other parts of the calculation are not included. Any
changes to explicitly assigned permission rules are saved in logs. We track:
l

When the change was made.

l

The ID of the user that made the change.

l

The ID of the site that the change was made on.

l

The ID and type of the content that the change was made on.

l

What the change was (what the new capability values are).

For more information about effective versus explicit permissions, see Effective permissions.
Log format

Every action that is an explicit permission change will get a log entry. Each log entry is structured in a JSON format, with specific keys representing different parts of information. Each
log entry contains two parts: metadata about the action and what the action was. Activity Log
entries in the logs are not formatted, nor are the keys sorted in any specific order.
Metadata about the action

Metadata about the action includes information about when and where the action occurred,
as well as what user performed the action. Metadata will have the following keys:
ver: the version of the data in the message and format of the data. Starting from 1.1.0. The
first digit can be incremented if this general data schema changes, the second if the storagespecific message changes (i.e. we change only how log data is stored) and the third if there
is a non-breaking change.
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l

ts: Timestamp, UTC ISO8601, ending with Z including milliseconds.

l

tz: Local time zone of the host, like https://www.timeanddate.com/time/zones/.

l

hn: hostname of the service that emitted the event. As it is always vizportal, this is left
blank.

l

svc: product or service this log line represents (the value will be "Tableau Server").

l

status: the state the request is in: either “ATTEMPT” or “SUCCESS”.

l

k: the type of event being recorded. Possible values include:
l

CreatePermissionsAuditEvent – occurs when permissions are added via Add
Permissions REST APIs

l

UpdatePermissionsAuditEvent – occurs when changing explicit permissions
via Permission Dialog UI. This is also used when the "delete" action is selected
from the permission dialog UI.

l

UpdatePermissionTemplatesAuditEvent – occurs when changing explicit permissions templates via Permission Dialog UI. This is also used when the
"delete" action is selected from the permission dialog UI.

l

DeleteAllPermissionsAuditEvent – occurs when the system deletes permissions as a result of a different action, such as when a piece of content is
deleted, its explicit permission records are also all deleted.

l

DeletePermissionsAuditEvent – occurs when deleting permissions via Delete
Permissions REST APIs.

l

v: the specific data of the event being recorded.

Action

The action itself contains information about what piece of content had its permissions
changed, what capabilities were changed and to what values the capabilities were
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changed. The type of action falls under the k key above, and further information falls under
the v key.
The keys for this information under v are the following. Not all fields are required; some only
apply to certain values of the "k" keys.
l

p: the permissions data, this itself contains more JSON data:

l

authorizableType: the type of content that had its permissions changed. Values are
"PROJECT", "WORKBOOK", etc.

l

contentIds: a list of the content IDs that had their permissions changed.

l

templateType: this value is present when a project's content-type template is
changed. For instance, if the Values are "WORKBOOK", etc.

l

explicitPermissions: a list of JSON data containing what capabilities and for which
grantee

l

granteeType: "Group" or "User".

l

granteeId: the ID of the user or group for whom permissions were changed.

l

capability: a JSON to identify the capability that was changed

l

l

ID: the ID of the capability, maps to the IDs in the postgres table capabilities.

l

value: the name of the capability as found in the postgres table capabilities.

value: the value that the capability was changed to. Values can include "GROUP_
DISALLOW", "GROUP_ALLOW", "USER_DISALLOW" and "USER_ALLOW".

l

unspecifiedPermissions: permissions that are changed from Allow/Deny to unspecified via the Permission Dialog UI.
l

granteeType: "Group" or "User".

l

granteeId: the ID of the user or group for whom permissions were changed.
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l

capability: a JSON to identify the capability that was changed
l

ID: the ID of the capability, maps to the IDs in the postgres table capabilities.

l

value: the name of the capability as found in the postgres table capabilities.

l

value: the value that the capability was changed to. In unspecifiedPermissions,
this value is always "unspecified".

l

au: JSON data representing which authenticated user took the action.
l

siteId: ID of the site of the user.

l

userId: ID of the user that took the action. A value of 0 means that the system
made this action, not an actual user.

Activity Log Event Type Reference
The following tables describe the Activity Log event types and attributes.
Attributes common to all event types

Attribute Name

Type

Description

traceUuid

string

Auto-generated UUID identical across all the events in a
batch, such as multiple permissions changed by a
single user action

actorUserId

integer

Integer user ID of user who performed the action that initiated the event

eventTime

string

Timestamp string

impersonatedUserId

integer

Integer user ID of user who is impersonated to perform
the action that initiated the event, if impersonation
occurred
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serviceName

string

Name of service that emitted the event (e.g. vizportal,
vizqlserver, sitesaml (outside monolith))

siteLuid

string

Site LUID of Tableau site where event took place

Event types

Event Type

Attribute Name

Type

Description

delete_per-

granteeId

integer

The integer identifier of the grantee.

granteeType

string

The type of Grantee, either user or group.

permissionType

string

The permission type, either explicit or

missions_
grantee
delete_permissions_
grantee
update_permissions
update_per-

unspecified.
authorizableType

string

missions
update_per-

changed, such as project or workbook.
contentId

integer

missions
update_per-

The type of content that had its permissions

The integer ID of the content that had the
permissions updated.

capabilityId

integer

missions

The integer ID of the capability. A capability
is the ability to perform a certain action on a
particular piece of content, such as view, filter, download or delete.

update_per-

capabilityValue

string

The string describing the capability.

granteeId

integer

The integer identifier of the grantee.

granteeType

string

The type of Grantee, either user or group.

missions
update_permissions
update_permissions
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update_per-

granteeValue

string

missions
create_per-

'user allow' or 'Group allow'.
authorizableType

string

missions
create_per-

The type of content that had its permissions
changed, such as project or workbook.

contentId

integer

missions
create_per-

The updated permissions value, such as

The integer ID of the content that had the
permissions updated.

capabilityId

integer

missions

The integer ID of the capability. A capability
is the ability to perform a certain action on a
particular piece of content, such as view, filter, download or delete.

create_per-

capabilityValue

string

The string describing the capability.

granteeId

integer

The integer identifier of the grantee.

granteeType

string

The type of Grantee, either user or group.

granteeValue

string

The updated permissions value, such as

missions
create_permissions
create_permissions
create_permissions
delete_per-

'user allow' or 'Group allow'.
authorizableType

string

missions
delete_per-

changed, such as project or workbook.
contentId

integer

missions
delete_per-

The type of content that had its permissions

The integer ID of the content that had the
permissions updated.

capabilityId

integer

missions

The integer ID of the capability. A capability
is the ability to perform a certain action on a
particular piece of content, such as view, filter, download or delete.

delete_per-

capabilityValue

string

The string describing the capability.

missions
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delete_per-

granteeId

integer

The integer identifier of the grantee.

granteeType

string

The type of Grantee, either user or group.

granteeValue

string

The updated permissions value, such as

missions
delete_permissions
delete_permissions
delete_all_

'user allow' or 'Group allow'.
authorizableType

string

permissions
delete_all_

changed, such as project or workbook.
contentId

integer

permissions
update_per-

The type of content that had its permissions

The integer ID of the content that had the
permissions updated.

permissionType

string

missions_

The permission type, either explicit or
unspecified.

template
update_per-

authorizableType

string

missions_

The type of content that had its permissions
changed, such as project or workbook.

template
update_per-

templateType

string

The type of Permission Template used to

missions_

change permissions, such as workbook or

template

datasource.

update_per-

contentId

integer

missions_

The integer ID of the content that had the
permissions updated.

template
update_per-

capabilityId

integer

The integer ID of the capability. A capability

missions_

is the ability to perform a certain action on a

template

particular piece of content, such as view, filter, download or delete.

update_per-

capabilityValue

string

The string describing the capability.

missions_
template
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update_per-

granteeId

integer

The integer identifier of the grantee.

granteeType

string

The type of Grantee, either user or group.

granteeValue

string

The updated permissions value, such as

missions_
template
update_permissions_
template
update_permissions_

'user allow' or 'Group allow'.

template

Customer-Managed Encryption Keys
Customer-Managed Encryption Keys gives you an extra level of security by allowing you to
encrypt your site data extracts with a customer managed site-specific key. The Salesforce
Key Management System (KMS) instance stores the default site-specific encryption key for
anyone who enables encryption on a site.

Encryption Process
The encryption process follows a key hierarchy. First, Tableau Cloud encrypts an extract.
Next, Tableau Cloud KMS checks its key caches for a suitable data key. If a key isn’t found,
one is generated by the KMS GenerateDataKey API, using the permission granted by the
key policy that's associated with the key. AWS KMS uses the CMK to generate a data key
and returns a plaintext copy and encrypted copy to Tableau Cloud. Tableau Cloud uses the
plaintext copy of the data key to encrypt the data and stores the encrypted copy of the key
along with the encrypted data.

Enable Encryption
After you enable encryption, Tableau Cloud will create a job for every extract on your site to
get encrypted. These jobs are the lowest priority. Any previously set extract job runs before
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the encrypted extracts job. When there are extra resources, these jobs run encryption on all
extracts without needing to be refreshed.
To enable encryption complete the following steps.

1. Select the General tab.
2. Under Extract Encryption, select the tick box next to Enable encryption of extract
refreshes.
3. Read the confirmation message and select OK to continue.
4. Select Save. A confirmation message or an error message appears.

Note: To turn off extract encryption, contact your account manager.

Create a Key
Creating a key replaces and archives the current key. The new key is used for encryption in
all future data extracts on your site. You can view the details of your previous key by downloading the log.

Note: Your key is tied to your Tableau Cloud region.

To create a key complete the following steps.

1. Select the General tab.
2. Under Extract Encryption, in Actions, select Create A Key.
3. Select Create A Key or Cancel. A confirmation message appears.

Generate and Rotate a Key
You can rotate a key on your company’s schedule for extra security. Rotating a key creates a
new key based on the original key.
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Note: If there is a long refresh rate or if the extract isn’t refreshed, the extract is encrypted with the last active key instead of the new key.

To rotate a key complete the following steps.

1. Select the General tab.
2. Under Extract Encryption, in Actions, select Generate and Rotate Key.
3. Select Generate and Rotate Key or Cancel. A confirmation message appears.

Disable Encryption
You can turn off encryption by contacting your account manager. If your Advanced Management licence is inactive, your extracts remain decrypted until it’s reactivated.

Delete a Key (Non-Recoverable Data Extracts)
Warning: If you delete a key, there isn't a way to regain access to the data extracts.
Delete the key only if there’s a dire security incident. You can’t access your data extracts
after you have deleted the key. Any data extracts tied to the deleted key are permanently
unavailable.

Note: If you want to disable the encryption and keep your key, see Disable Encryption.

To delete a key complete the following steps.

1. Select the General tab.
2. Under Extract Encryption, in Actions, select Delete.
3. In the text field, enter Delete Key.
Warning: You can’t access your data extracts after you have deleted the key. Delete the
key only if there’s a dire security incident.
4. Choose Delete Encryption Key or Cancel. A confirmation or error message appears.
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Audit Logs
You can download audit logs to review operations performed on your keys, including creation, rotation, deletion, decryption and downloading logs. The audit log also includes the following information.
l
l
l
l
l
l

Date and Time
Event Type
Success or Failure
Authenticated Identity of calling service
User
Key name

Frequently Asked Questions (FAQs)
Question:
What happens if I don’t renew my Advanced Management licence?
Answer:
If you don’t renew the Advanced Management licence, the Customer-Managed Encryption
Keys feature automatically changes to a disabled state.
Question:
What happens to my key data if I stop being a Tableau Cloud customer?
Answer:
As per the Tableau Cloud data policy, there’s a 90-day waiting period before your key data
gets deleted.
Question:
What happens if I move to a different Tableau Cloud region?
Answer:
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The key data is in the Salesforce (KMS) instance that’s in the same region as your Tableau
Cloud pod. If you want to move to another region, you must turn off the feature and run your
extracts first.

About Tableau Content Migration Tool
This set of articles guides you through setting up, using and maintaining the Tableau Content Migration Tool.

What is Content Migration Tool?
The Content Migration Tool provides an easy way to copy or migrate content between projects. The Content Migration Tool user interface walks you through the steps necessary to
build a "migration plan" that you can use once or as a template for multiple migrations.

Note: If you have a Tableau Server deployment, you can migrate content between projects on a Tableau Server installation and a Tableau Cloud site. Both deployments
must have a valid Advanced Management licence.

Before migrating content, we recommend reviewing the Content Governance section in
Tableau Blueprint.

Help and Support
If you have problems that you cannot solve with this documentation, contact Tableau Technical Support.

Getting Started with Tableau Content Migration Tool
This article will help you get started with the Tableau Content Migration Tool. It contains
links to other articles about information you need to prepare before installing the Content
Migration Tool and steps to design a migration plan and upgrade existing installations.

1316

Tableau Software

Tableau Cloud Help

Pre-installation
Installation requirements

The Content Migration Tool can only be installed on Windows operating systems. Before
installing, you must be able to connect to the Tableau source site (the site you are migrating
from) and the destination site (the site you are migrating to) from the computer where Content Migration Tool is installed. Both the source and destination sites must have a valid
Advanced Management licence. For more information, see Install Tableau Content Migration Tool.
Compatibility with Tableau Cloud

Content Migration Tool versions 2022.2.1 and later support content migration for all Tableau
Cloud deployments. To download the latest installer, see the Advanced Management
release page.
Compatibility with Tableau Server

The Content Migration Tool supports content migration for Tableau Server versions 2019.3
and later.
The table lists compatible versions of Tableau Server based on the installed version of Content Migration Tool.
CMT Version

Tableau Server Version

2022.3.x

2020.4.x - 2022.3.x

2022.2.x

2020.3.x - 2022.2.x

2022.1.x

2020.2.x - 2022.1.x

2021.4.x

2020.1.x - 2021.4.x

2021.3.x

2019.4.x - 2021.3.x

2021.2.x

2019.3.x - 2021.2.x
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CMT Version

Tableau Server Version

2021.1.x

2019.3.x - 2021.1.x

2020.4.x

2019.3.x - 2020.4.x

2020.3.x

2019.3.x - 2020.3.x

2020.2.x

2019.3.x - 2020.2.x

2020.1.x

2019.3.x - 2020.1.x

2019.4.x

2019.3.x - 2019.4.x

2019.3.x

2019.3.x

Note: If you have a Tableau Server deployment, you can migrate content between projects on a Tableau Server installation and a Tableau Cloud site. Both sites must have a
valid Advanced Management licence.

Compatibility with Tableau content

The Content Migration Tool supports migrating workbooks and published data sources
saved in the eight most recent versions of Tableau. While you can migrate existing data
sources, only data sources that use the connection types in the table below can be changed
and modified during migration. For more information, see Data Source Transformations in
Migration Plans: Workbooks and Migration Plans: Published Data Sources.
Actian Matrix

Google Drive

Pivotal Greenplum Database

Actian Vectorwise

HortonWorks Hadoop Hive

PostgreSQL

Amazon Athena

HP Vertica

Progress OpenEdge

Amazon Aurora

IBM DB2

Salesforce

Amazon EMR

IBM Netezza

SAP HANA
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Amazon Redshift

Map R Hadoop Hive

SAP Sybase ASE

Apache Drill

Microsoft Access

SAP Sybase IQ

Aster Database

Microsoft Analysis Services

Snowflake

Box

Microsoft Excel

Spark SQL

Cloudera Hadoop

Microsoft Excel Direct

Statistical File

Delimited Text File

Microsoft OneDrive

Tableau Extract

EXASOL

Microsoft SQL Server

Tableau Published Data Source

Firebird

MySQL

Teradata

Google Analytics

OData

Text File

Google BigQuery

Oracle

Web Data Connector

Google Cloud SQL

Oracle Essbase

Other Databases (ODBC)

Post-installation
Limitations when migrating content

Before you start, make sure you understand the limitations when migrating content using the
Content Migration Tool. For more information, see Migration Limitations.
Create a migration plan

The Content Migration Tool walks you through migrating content across projects on a single
site, to a new site on the same Tableau Server instance and to sites that exist on different
Tableau Server instances. The plan you create can be saved and used again for future migrations. For more information, see Migration Plan Overview.
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Upgrading Content Migration Tool

For instructions on how to upgrade Content Migration Tool, see Upgrade Tableau Content
Migration Tool.

Install Tableau Content Migration Tool
Installing Tableau Content Migration Tool is straightforward and easy.

Installation requirements
The Content Migration Tool tool is run from a Windows computer and can connect to
Tableau Cloud sites and Tableau Server 19.3 and later with a valid Advanced Management
licence. For more information about compatible versions, see Getting Started with Tableau
Content Migration Tool.
The computer that you install Content Migration Tool on must meet the requirements below:
l

Microsoft Windows 8 or newer (x64)

l

Intel Core i3 or AMD Ryzen 3 (Dual Core)

l

4 GB memory or larger

l

Can connect to the source and destination sites. Both sites must have a valid
Advanced Management licence to migrate content.

l

2 GB HDD or larger. The drive where the \temp folder resides must have enough
disk space to hold a copy of all content being migrated in a single migration. All content is stored locally on the disk and deleted when the migration is complete.

l

Have enough free disk space to hold the application and its logs.

In addition, confirm that the REST API is enabled on Tableau Server (this is the default).
Use the tsm configuration get -k api.server.enabled command to confirm
this. A return value of true means the REST API is enabled. To enable the REST API,
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use the tsm configuration set command. For more information, see api.server.enabled in Tableau Server help.

Installing Content Migration Tool
To install the Content Migration Tool:
1. Download the Content Migration Tool installer (Tabcmt-64bit<version>.exe) from the Advanced Management release page.
2. Run the Content Migration Tool Setup program.

Note: Running the Content Migration Tool Setup program will overwrite the previous version.

3. After reading the EULA, select I agree to the license terms and conditions and
click Install.
4. If the User Account Control dialog opens, click Yes to allow the installer to make
changes.

Who can do this
A user with Administrator access on the machine.

Upgrade Tableau Content Migration Tool
Upgrading Tableau Content Migration Tool is straightforward and easy.
Before Upgrading
l

Running the Content Migration Tool Setup program will overwrite the previous version.

l

Content Migration Tool does not support side-by-side installation of previous versions.
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Upgrading Content Migration Tool

To upgrade Content Migration Tool:
1. Download the latest Content Migration Tool installer (Tabcmt-64bit-<version>.exe) from the Advanced Management release page.
2. Run the Content Migration Tool Setup program.
3. After reading the EULA, select I agree to the license terms and conditions and
click Install.
4. If the User Account Control dialog opens, click Yes to allow the installer to make
changes.

Who can do this
A user with Administrator access on the machine.

Using Tableau Content Migration Tool
The following steps are designed to guide you through using the Tableau Content Migration
Tool:
l

l
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l Migration Plans: Sites
l Migration Plans: Source Projects
l Migration Plans: Workbooks
l Migration Plans: Published Data Sources
l Migration Plans: Permissions and Ownership
l Migration Plans: Migration Scripts
l Migration Plans: Plan Options
Using the Tableau Content Migration Tool Console Runner
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Tableau Content Migration Tool Use Cases
Tableau Content Migration Tool as the name suggests, is primarily used for moving Tableau
Cloud content from one project to another. However, there are many features in the tool that
make it ideal for accomplishing several tasks related to content migration and maintenance.

Note: In many of the use cases, we use the term migration to describe moving content
from one environment, site or project to another. However, technically the Content
Migration Tool copies content and does not automatically delete or archive the original
or source content.

The information below describes some common use cases where you can leverage the Content Migration Tool.

Content promotion
You can use the Content Migration Tool to create content for development projects and then
perform routine migrations to promote content to staging or production projects on your site.
Use the following steps to migrate content to production projects:
1. Create a plan and select the site to use as your source. In this example, we describe
a migration between projects on the same site, so choose the same Tableau site as
your destination. For more information, see Create a Plan in Migration Plan Overview
topic.
When migrating workbooks between two projects on the same site, your sign-in credentials for the source and destination may be similar or identical. In this scenario, we
recommend using personal access tokens for a more reusable connection. For more
information, see Personal Access Tokens.
2. Select the development project with the content you want to migrate. You can
select entire projects, specific workbooks and data sources and user permissions. For
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more information, see Planning in Migration Plan Overview topic.
If you need to make any changes or transformations to the content during this
migration, you can configure that in the plan as well. This is referred to as Mapping.
3. Select Change Project from the Add Mapping menu to add a project mapping.
Select your development project as the source and production project as the destination, or click Add New to create a new project.
Other types of mapping include:
l

Changes to workbooks: Includes renaming workbooks and changing the
destination project. For a full list of workbook transformations, see Migration
Plans: Workbooks.

l

Changes to data sources: Includes replacing table or schema names, settings calculation formulas, and setting connection information. For a full list of
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data source transformations, see Migration Plans: Workbooks (embedded data
sources) and Migration Plans: Published Data Sources (published data
sources).

l

Changes to Users: Includes domain, user and group name changes in the
destination.

4. When you are ready, click Run Migration to end the Planning phase and prepare to
run your plan.
5. To schedule this to run regularly, you can script this as a job using the Content Migration Tool Runner and schedule it. For more information on using the Content Migration
Tool Runner, see Using the Tableau Content Migration Tool Console Runner.

Tailoring content for customers
When working in a consulting scenario, you can customise content for each of your customers using the Content Migration Tool. Each workbook functions as a template for your
migration plan, allowing you to apply styling (text, images, etc.) and replace data sources for
specific customers.
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In this example, we describe a migration between projects; an internal project where you
store templates and an external project you share with customers.
Use the following steps to customise content for your customers:
1. Create a plan and select the site to use as your source. Choose the same Tableau
site as your destination. For more information, see Create a Plan in Migration Plan
Overview topic.
When migrating workbooks between two projects on the same site, your sign-in credentials for the source and destination may be similar or identical. In this scenario, we
recommend using personal access tokens for a more reusable connection. For more
information, see Personal Access Tokens.
2. Select the internal project that contains the template content you want to migrate.
You can select entire projects, specific workbooks and data sources and user permissions. For more information, see Planning in the Migration Plan Overview.
If you need to make any changes or transformations to the content during this
migration, you can configure that in the plan as well. This is referred to as Mapping.
3. Select Change Project from the Add Mapping menu to add a project mapping.
Select your internal project as the source and production project as the destination, or
click Add New to create a new project.
4. In the Workbooks step of the Migration Plan, use workbook mappings and transformations to customise your content. Below are two examples of frequently used
transformations. For a full list of workbook transformations, see Migration Plans:
Workbooks.
l

To personalise content, you can use the Replace Image and Replace Text
transformations to update the workbook with a customer's company name and
logo.

l
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Name or Set Custom SQL transformations to modify content for your customer.
5. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.

Environment migration
You can use the Content Migration Tool to migrate content between Tableau Cloud and
Tableau Server environments with a valid Advanced Management licence.
Use the following steps to migrate content between Tableau deployments:
1. Create a plan and select the site you want to migrate from as your source. For more
information, see Create a Plan in Migration Plan Overview topic.
2. Select the content you want to migrate from your source site. You can select entire
projects, specific workbooks and data sources and user permissions.
3. Create user permissions mappings to customise and secure content. For more
information, see Migration Plans: Permissions and Ownership.
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4. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.
Tips
- Before you perform an environment migration, make sure you understand the Migration
Limitations when using the Content Migration Tool.
- You can migrate your content in stages, test and validate content iteratively before final
migration is complete.
- Content Migration Tool migration does not handle embedded credentials, subscriptions
and custom views. These will have to be migrated manually.

External content sharing
You can use the Content Migration Tool to share internal content with external collaborators, without allowing access to your project. This keeps your data secure and allows
you to publish only select workbooks and data sources. Once content has been shared, collaborators sign in to their Tableau Cloud site to view and make changes, without affecting
content stored on your internal project.
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Before you continue, make sure the content you are sharing is compatible between the
internal and external projects.
Use the following steps to share content externally:
1. Prepare internal content. As a best practice, we recommend separating content on
the internal project, with locked permissions and strict governance rules. Workbooks
and data sources should be clearly labeled to indicate the content is for external use.
For more information, see Use Projects to Manage Content Access.

Note: Content shared with external projects must use data extracts unless the
data source is publicly accessible. For information about creating extracts and
replacing data sources, see Extract Your Data and Replace Data Sources in
Tableau Desktop help.

If you have implemented row-level security, those data sources must be updated to
reflect user filters and other details for the external project. For more information about
row level security, see Restrict Access at the Data Row Level in Tableau Desktop
help.
2. Create a plan and select the site to use as your source. Choose the same Tableau
site as your destination. For more information, see Create a Plan in Migration Plan
Overview topic.
When migrating workbooks between two projects on the same site, your sign-in credentials for the source and destination may be similar or identical. In this scenario, we
recommend using personal access tokens for a more reusable connection. For more
information, see Personal Access Tokens.
3. Select the internal project that contains the template content you want to migrate.
You can select entire projects, specific workbooks and data sources and user permissions. For more information, see Planning in the Migration Plan Overview.
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If you need to make any changes or transformations to the content during this
migration, you can configure that in the plan as well. This is referred to as Mapping.
4. Select Change Project from the Add Mapping menu to add a project mapping.
Select your internal project as the source and external project as the destination, or
click Add New to create a new project.
5. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.

Validating database migrations
This use case is when you intend to validate content after a migration of the underlying databases. One example of database migration is moving from SQL Server to Snowflake. CMT
can help you validate the content built from both data sources is the same before you finalise your migration, but it cannot perform the actual database migration.
Use the following steps to validate database migrations:
1. Create a plan and select the site to use as your source. Choose the same Tableau
site as your destination. For more information, see Create a Plan in Migration Plan
Overview topic.
2. Select the content for which you want to change the data source or database connections.
3. Configure the migration to copy your content to a new project. Let’s call the
source project as Project A, and the new or the destination project as Project B.
l

Changes to workbooks: Create a workbook mapping to change Project A to
Project B. For a full list of workbook transformations, see Migration Plans:
Workbooks.

l
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A to Project B. For a full list of data source transformations, see Migration Plans:
Published Data Sources.
4. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.
5. Update the content in Project B with the new database connections or replace the
data sources. This needs to be done manually by authoring.
6. Test each workbook in Project A with the copy in Project B and review for any
inconsistencies in the data due to the change in data source.
7. Once you have confirmed everything is working as expected, overwrite the content
in Project A with the updated content in Project B.

Note: If the content already exists in the destination project and you do not select
the Overwrite Newer Workbooks and Overwrite Newer Data Sources publish options, the content will not be copied to the destination project.

Maintenance tasks
You can use the Content Migration Tool to perform a variety of maintenance tasks.
Tagging stale content

Using the Content Migration Tool, you can manage archiving stale content. For example,
you can build a plan that runs on a regular schedule that can automatically pick up content
tagged as Stale Content and move it to an Archive project. After a certain amount of time, the
content in this project can be purged from the system. For more information see, Migration
Plans: Workbooks.
Restoring content

You can use the Content Migration Tool to restore content removed (accidentally or purposefully) from a project with content from a backup project.
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Use the following steps to restore content from a backup project:
1. Create a plan and select the site to use as your source. Choose the same Tableau
site as your destination. For more information, see Create a Plan in Migration Plan
Overview topic.
2. Select the content you want to restore from the backup project.
3. Configure the migration to restore content from your backup project. Let’s call the
backup project Project A and the project you want to restore to Project B.
l

Changes to workbooks: Create a workbook mapping to change Project A to
Project B. For a full list of transformations, see Migration Plans: Workbooks.

l

Changes to data sources: Create a data source mapping to change Project A
to Project B. For a full list of data source transformations, see Migration Plans:
Published Data Sources.

4. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.
5. Review the content on the production site.
Partial backup

Once you have a backup project, you can use the Content Migration Tool to transfer new
content from production to the backup project.

Notes:
- Before you perform a partial backup, make sure you understand the Migration Limitations when using the Content Migration Tool.
- The Content Migration Tool shouldn't be used to back up your entire site. We recommend prioritising the content you need most.

Use the following steps to perform a partial backup of your content:
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1. Create a plan and select the site to use as your source. Choose the same Tableau
site as your destination. For more information, see Create a Plan in Migration Plan
Overview topic.
2. Select the content you want to back up from the production project. You can select
entire projects, specific workbooks and data sources and user permissions. To
migrate only new content, make sure the publish options Overwrite Newer Workbooks and Overwrite Newer Data Sources are not selected. For more information,
see Migration Plans: Workbooks.
3. Configure the migration to copy content to your backup project. Let’s call the source
project Project A and the backup project Project B.
l

Changes to workbooks: Create a workbook mapping to change Project A to
Project B. For a full list of transformations, see Migration Plans: Workbooks.

l

Changes to data sources: Create a data source mapping to change Project A to
Project B. For a full list of data source transformations, see Migration Plans:
Published Data Sources.

4. Verify and run the plan. When you are ready, click Run Migration to end the Planning phase and prepare to run your plan.
5. To schedule this to run on a regular basis, you can script this as a job using the Content Migration Tool Runner and schedule it. For more information on using the Content Migration Tool Runner, see Using the Tableau Content Migration Tool Console
Runner.

Migration Plan Overview
Tableau Content Migration Tool creates a streamlined process for migrating Tableau content between projects. The easy-to-follow plan can be audited, is repeatable, and works via a
batch process so any number of workbooks and data sources can be migrated in a simple
and efficient process.
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The Content Migration Tool will display contextual tips to walk you through creating or editing a migration plan. Once you select the source and destination sites, a summary of your
migration will be displayed at the top of the screen as follows:

Limitations when migrating content
Before you start, make sure you understand the limitations when migrating content using
the Content Migration Tool. For more information, see Migration Limitations.

Encryption keys
Each migration plan file is generated with an encryption key unique to the application that
created the plan. Encryption keys can be shared if the migration plan needs to be run
through an application that did not originally generate the file. When sharing encryption
keys, you will need to overwrite the existing key in the application to run the migration plan.
To view your encryption key, select Help > Settings.

If you will be using the Content Migration Tool Console Runner for migration plans, you
must specify the encryption key using the tabcmt-runner encryption command
before running the plan. For more information, see Using the Tableau Content Migration
Tool Console Runner.
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Migration process
Step 1: Start

The core of the migration process is creating a plan, which you can save and re-use for
future migrations or modify and update as needed. The first step is choosing whether to create a new plan, or select a previously saved plan.
To create a new plan, click Create New Plan. If you already created a migration plan and
want to use it, click Browse for a Plan.

By default, all of your saved migration plans will be stored in the Tableau Content
Migration Tool Plans folder in your My Documents folder. All migration plans are
saved with a .tcmx extension, with recently accessed plans listed separately to make them
easy to select:

You can select a recently accessed plan and duplicate it to modify the plan and save it as a
new plan. Select the plan you want to copy and click Duplicate.

Step 2: Planning

The Content Migration Tool guides you through building or editing your migration plan in six
steps.
Click on each step for detailed instructions:
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l
l
l
l
l
l
l

Migration Plans: Sites
Migration Plans: Source Projects
Migration Plans: Workbooks
Migration Plans: Published Data Sources
Migration Plans: Permissions and Ownership
Migration Plans: Migration Scripts
Migration Plans: Plan Options

Step 3: Migration

Once you have completed your plan, you are now ready to run the batch process for migration. When you reach the final step of the migration, a plan summary displays for your verification:

If you want to change any aspects of your plan, you can click on a section in the left sidebar
to go directly to that phase. When you are ready, click Run to begin your migration.
When you click Run, the migration tool will prompt you about any unsaved elements of your
plan. By default, any unsaved elements will be saved when you click Yes. Remember you
can always keep your previous plan without making any changes by duplicating it during the
Start phase of the migration process.
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Your migration plan will run and a status bar displays for the overall plan progress and each
workbook being sent to the destination server.

When the plan finishes running, you can click the tabs at the bottom of the screen for more
information about the migration.
Published workbooks

Published Workbooks details the newly published workbooks and the projects where
they were migrated.
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Published data sources

Published Data Sources details the newly published data sources and the projects where
they were migrated.
Output

The Output tab details the migration log of your plan.

You can save this log by clicking Save Log.
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Errors and warnings

The Errors and Warnings tab highlights any problems that occurred during the migration.

You can correct these and rerun your plan. When you have completed your migration and
saved your plan, click Done to finish.

Who can do this
Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing rights
for the destination site. For more information, see Permissions.

Migration Limitations
There are certain limitations to migrations when using the Tableau Content Migration Tool.
Before creating your migration plan, review the sections below to learn about version compatibility and content that will not be migrated.
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Compatibility with Tableau content

The Content Migration Tool supports migrating workbooks and published data sources
saved in the eight most recent versions of Tableau. Workbooks and published data sources
saved before version 2018.1.x are not supported by CMT. For more information, see Getting Started with Tableau Content Migration Tool.
Configurations

The following configurations are not migrated to the destination site when using the Content
Migration Tool.
l
l
l

Users
Groups
Site settings (custom logos, view recommendations, etc.)

Data connections

While you can migrate existing data sources, only data sources that use the connection
types in the table below can be changed and modified during migration. For more information, see Data Source Transformations in Migration Plans: Workbooks and Migration
Plans: Published Data Sources.
Actian Matrix

Google Drive

Pivotal Greenplum Database

Actian Vectorwise

HortonWorks Hadoop Hive

PostgreSQL

Amazon Athena

HP Vertica

Progress OpenEdge

Amazon Aurora

IBM DB2

Salesforce

Amazon EMR

IBM Netezza

SAP HANA

Amazon Redshift

Map R Hadoop Hive

SAP Sybase ASE

Apache Drill

Microsoft Access

SAP Sybase IQ

Aster Database

Microsoft Analysis Services

Snowflake
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Box

Microsoft Excel

Spark SQL

Cloudera Hadoop

Microsoft Excel Direct

Statistical File

Delimited Text File

Microsoft OneDrive

Tableau Extracts

EXASOL

Microsoft SQL Server

Tableau Server Data Sources

Firebird

MySQL

Teradata

Google Analytics

OData

Text File

Google BigQuery

Oracle

Web Data Connector

Google Cloud SQL

Oracle Essbase

Other Databases (ODBC)

Unsupported content

The following content is not migrated to the destination site when using the Content Migration Tool and will require additional configuration.
Content

Action required

Ask Data

Users must recreate Ask Data lenses on the destination site. For more

lenses

information, see Create Lenses that Focus Ask Data for Specific Audi-

ences.
Collections

Users must recreate collections on the destination site. For more information, see Collections in Tableau Desktop help.

Comments

Users must re-add comments to views on the destination site. For more
information, see Comment on Views in Tableau Desktop help.

Custom

Users must recreate custom views on the destination site. For more

views

information, see Use Custom Views in Tableau Desktop help.

Data roles

Users must recreate data roles on the destination site. For more information see Use Data Roles to Validate your Data in Tableau Prep Builder
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help.
Data source

If you have the following site roles and capabilities, you can certify data

certifications

sources on the destination site.
l

Site Administrator Creator

l

Creator or Explorer (can publish) with Project Leader capability on
the project containing the data source

For more information, see Use Certification to Help Users Find Trusted
Data.
Data-driven

Users must recreate data-driven alerts for dashboards and views on the

alerts

destination site. After data-driven alerts are created, anyone with access
to the view can add themselves to existing alerts.

For more information, see Send Data-Driven Alerts from Tableau Cloud
or Tableau Server in Tableau Desktop help.
Descriptions

If you own the content item or have the appropriate permissions, you can

for work-

edit the item's description on the destination site. For more information,

books and

see Add or edit descriptions in Tableau Desktop help.

data sources
Embedded

For security purposes, Tableau Server removes embedded credentials

credentials

from data sources during the download process. To include embedded
credentials when publishing to the destination site, use the Set Connection Info data source transformation. For more information, see Migra-

tion Plans: Published Data Sources.
External

Customised attributes for external assets are not migrated to the des-

assets

tination site. For example, tags, certifications, data quality warnings,
descriptions, permissions, user contacts, tables and columns must be
recreated. For more information, see Manage Permissions for External

Assets.
Extract
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refresh

tination sites. To refresh data on Tableau Cloud, you can run extract

schedules

refreshes manually or create new extract refresh schedules. For more
information, see Schedule Refreshes on Tableau Cloud.

Favourites

Users must reselect their favourite content on the destination site. For
more information, see Mark Favourites in Tableau Desktop help.

Flows

To run flows on a schedule, users must republish flows to the destination
site with Tableau Prep. For more information, see Publish a Flow to

Tableau Server or Tableau Cloud in Tableau Prep help.
Incremental

Incremental extract refreshes are changed to full extract refreshes on the

extract

destination site. Users must reconfigure incremental refreshes in Tableau

refreshes

Desktop and publish extracts to the destination site after migration. For
more information, see Refresh Extracts in Tableau Desktop help.

Metrics

The historical values for metrics are removed from views, and users must
recreate metrics on the destination site. For more information, see Create

and Troubleshoot Metrics.
Revision his-

To migrate previous versions of workbooks to the destination site, users

tory

must download the versions they wish to keep and republish the workbook to the destination site. For more information, see Work with Content

Revisions in Tableau Desktop help.
Subscriptions

Users must resubscribe to views and workbooks on the destination site.
For more information, see Create a Subscription to a View or Workbook.

Thumbnails

Workbooks and views that are migrated using the Content Migration Tool

for work-

will retain their original thumbnails, even if the migration plan includes

books and

transformations that result in the views being rendered differently (for

views

example, if data connections change).

To update thumbnails, edit the workbook or view on the destination site
and re-save it. For more information, see Edit Tableau Views on the Web
in Tableau Desktop help.
Virtual con-
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nections

information, see Create a Virtual Connection.

Migration Plans: Sites
The first step when creating a migration plan in the Tableau Content Migration Tool is to
sign in to the source and destination sites.
In the Sites section of the planning phase, you’ll sign in to the source and destination sites.
The permissions of the user credentials you use govern the sites and projects you see when
creating a migration plan. You can only migrate content that the user has access to.

Required permissions and licences

The user account(s) used to sign in to the source and destination sites must have an
Explorer role or higher, and the following permissions for the content you want to migrate:
l
l
l

View
Download Workbook/Save a Copy
Optional: Administrator (to select workbooks, to access a user list)

Both the source and destination sites must have a valid Advanced Management licence.
For more information, see About Tableau Advanced Management on Tableau Cloud.
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Step 1: Source

Here is the starting point of the migration. Sign in to Tableau Cloud, then select your site to
use as the source. Sites are independent silos of workbooks, data and user lists created
within Tableau to group related content for selected users. You can only migrate content
from one site at a time.
Sign in to the source site

Use the steps below to sign in to Tableau Cloud or Tableau Server.
1. Click Sign in to Tableau.
2. In the Select a Connection dialog window, select a saved connection and click
Continue.

If no connections are available, click Add or edit saved connections to add a new
connection. For more information, see Saved connections.
3. Enter your username and password, and click Sign In.
If your server is configured for SAML or Single Sign-On, you are redirected to the Identity Provider sign-in page to complete the authentication process.
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4. Select the site you want to use.

To change the source server or update your site selection, click Select a different source.
Step 2: Destination

Repeat the sign-in process for the destination site (the site you are migrating content to).
If you are migrating your workbooks between two projects on the same Tableau site, your
sign-in credentials for the source and destination site will be identical (including the server
URL and site name).
Saved connections

Using saved connections allow you to quickly sign in to the source and destination sites by
creating a reusable connection. When adding a saved connection, you must specify the preferred sign-in method for your site.
The Content Migration Tool supports the following sign-in methods:
l

Personal access tokens: Allows users to create long-lived authentication tokens
for improved security, auditing and automation of migration plans. Personal access
tokens let users sign in without requiring interactive login in the Content Migration
Tool. For more information, see Personal Access Tokens.

l

Browser-based sign-in: Users enter their credentials and complete authentication
through an embedded web browser. This option may be similar to how you usually
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authenticate to Tableau.
l

Username and password sign-in: Users authenticate through the Content Migration Tool instead of an embedded browser window. This option passes credentials to
the server using Tableau REST APIs. You can use username and password sign-in to
troubleshoot issues that prevent the use of browser-based sign-in.

Add or edit saved connections

A link to Add or edit saved connections is displayed at the bottom of the Content Migration Tool and when signing in to the source and destination sites. Clicking this link will open
the Manage Tableau Connections window.

Use the steps below to add a saved connection:
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1. On the Manage Tableau Connections window, click New Connection, or select
an existing connection to make changes.
2. Enter a Connection Name (name to describe your server) and the Server URL.
If you don't include a prefix for the Server URL, the Content Migration Tool will use
http://.
3. Select the sign-in method for your connection.
If you're using personal access tokens, see Add saved connections with personal
access tokens.
4. Click Save.
After you create a saved connection, it's listed in the Select a Connection window next time
you sign in to the source and destination sites.
Add saved connections with personal access tokens

Adding a saved connection with a personal access token requires more information than
other sign-in methods. You will need to create a new personal access token on the source
and destination sites to begin. Personal access tokens should not be shared between applications. For more information, see Personal Access Tokens.

Creating personal access tokens
1. In a web browser, sign in to your Tableau site.
2. At the top of the page, click your profile image or initials, and then select My Account
Settings.
3. Under Personal Access Tokens, enter a descriptive name for your token in the
Token Name field and then click Create new token.
4. In the resulting window, click Copy to clipboard and then close the window.
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5. Paste the token secret to a file. Store the file in a safe location.

Adding personal access tokens
1. In the Content Migration Tool, click Add or edit saved connections.
2. On the Manage Tableau Connections window, enter a Connection name and the
Server URL.
If you are connecting to Tableau Cloud, you must enter the full pod URL of your site.
For example, https://10ay.online.tableau.com. Your pod is shown in the
first portion of the site URL after signing in to Tableau Cloud.
3. Enter the Personal access token name and Personal access token secret,
obtained when creating a personal access token in the previous section.
4. In the Site name field, enter the site name as it appears in the URL, without spaces.
This is different to the friendly site name. For example, “Site A” would be “sitea” in a
browser URL.
5. Click Save.
Step 3: Continue to the next step

After successfully signing in to both source and destination sites, click Next to continue to the
Migration Plans: Source Projects section of the planning phase.
Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing rights
for the destination site. For more information, see Permissions.
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Migration Plans: Source Projects
The next step in creating a migration plan in the Tableau Content Migration Tool is to select
the source projects. Source projects are the projects the workbooks and published data
sources will be migrated from. The projects you choose determine which workbooks are
available to migrate in the next step of the migration plan.
Step 1: Select your source project

There are two options when selecting source projects, All Projects, and Specific Projects:

The All Projects option selects all projects from the source site you specified in the Servers
step. The Specific Projects option allows you to select specific projects from the source
site.

Note: Source projects must contain workbooks or data sources. Content Migration
Tool will not migrate empty projects.
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You can select each project individually or use the Select All button and then clear selections for the projects you don't want to include. If you make any changes on the source site
while on this step, you can use the Refresh button to update the projects list.

Step 2: Select project options

Once the source projects are selected, select which project options to apply for the destination location. There are options to create projects that don't exist, in addition to copying
project permissions and ownership from the source location. To assign new content ownership based on user mappings, select Apply User Mappings.

l

Create Destination Projects: Automatically create projects that don't exist in the destination location. Content Migration Tool will not create destination projects if the
source project is empty or no workbooks or data sources are selected. By default,
attempts to migrate to a non-existent project will result in a failed migration.

l

Copy Project Permissions: Copy source project permissions as closely as possible.

l

Copy Project Owner: Copy project ownership settings from the source location to
assign the project owner.

l

Apply User Mappings: Apply user mappings to assign content ownership of projects
in the destination location. Content ownership won't be applied if the destination pro-
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ject already exists. For more information, see Migration Plans: Permissions and Ownership.
Step 3: Continue to the next step

After selecting the source projects, click Next to continue to the Migration Plans: Workbooks section of the planning phase. If you are migrating workbooks between two projects
on the same Tableau site, you'll choose your destination project in the next section.
Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions for workbooks on the source site
and Publishing rights (View and Publish capabilities) for target projects on the destination
site. For more information, see Permissions.

Migration Plans: Workbooks
You have successfully signed in to your source and destination sites and selected projects.
The next step is to prepare your workbooks for migration.

Note: If your workbooks or data sources include extracts, be sure you read and understand the information in Migrating Workbooks and Data Sources that use Extracts.

Step 1: Workbook selection

All of the workbooks in the source site and selected projects appear on the Workbook
Selection screen.
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If you make any changes to the workbooks in the source site while on this step, you can click
Refresh to update the workbook listings. There are several different ways to select these
workbooks.
Specific Workbooks Selection

There are three buttons in the Specific section. Any choices from the Basic section will
immediately include the specifically selected workbook in the migration plan. Alternatively,
you can individually select specific workbooks by clicking on each one.
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Select All
This button will select or clear selection of all the workbooks in the site. If additional workbooks are added to the site after the plan is saved, they will not be automatically added the
next time the plan is used.

Display:
Thumbnails

The default view shows your workbooks in thumbnail previews to help you differentiate
each of them. In this view, hovering over the thumbnail will show previews of the other worksheets and dashboards within that workbook.
List

The list view is a more succinct listing that also provides additional information, including
Workbook Name, Project, Tableau Version and Last Modified.
Clicking on any of the column headers will sort the workbooks appropriately. Also, hovering
over any of the workbooks will also provide a floating preview of the worksheets and dashboards within that workbook. List view is particularly useful if you have a large amount of
workbooks in a site.
Rule Based Selection

You can use Rule Based selection to choose workbooks based on specific criteria. Rulebased options will create workbook selection criteria to be used when the migration plan is
run. Be aware that selecting "all" in any of the Rule Based options is different than the Specific Workbooks selection. A rule-based "all" selection will always include all workbooks,
so any newly added workbooks are included in future migrations.
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The Rule Based radio button allows you to select workbooks by using the following options:

Workbooks in projects
This menu allows you to select workbooks from specific projects.

Workbooks tagged with
This menu allows you to select workbooks by their tags.

Workbooks published by
This menu allows you to select workbooks by their author.
With each option, you can select individually or multiple by clicking on the option next to each
entry. All selected workbooks will appear in the Selection Description box.
All Workbooks Selection

The last option is to select the All Workbooks radio button, which selects all workbooks in
all projects in the site.
Using the All Workbooks radio button is different to selecting all of the workbooks using the
Specific Workbook method because it will use every workbook in the source site each time
the migration plan is used in the future.
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When you are satisfied with your workbook selections, click Next.
Step 2: Workbook mapping

You can now map your selected workbooks from the source file to the destination file. Mapping allows you to rename source workbooks as they are migrated and choose different destinations. You can also add mapping to change the project, prefix or suffix for the workbooks
as well. Projects can be added to the Destination in this section as well.
If you make no changes here, the selected workbooks will simply be migrated with the same
name and into the same project as the source. If you have not defined projects in your destination site, they will be migrated into the Default project. To add workbook mapping click
the Add Mapping button. The following options will appear in the mapping area.

Rename Workbook
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This transformation allows you to filter by the Source project and select the desired workbook(s) to rename. In the Destination field, select which project you would like the workbook to be directed to and enter the desired name.
Change Project

By default, the workbooks are migrated to the same project in the destination. This mapping
allows you to change the destination project for all workbooks from a source project.
Add Project

When renaming the workbook or changing the project, the Add New option allows you to
create a destination project without having to sign in to the destination site and create the project manually. You can create both projects and nested projects using the Add New dialog
box.
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Change Prefix

This allows you to remove or replace the prefix for workbooks from one or all source projects.
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Change Suffix

Like the prefix mapping, you can remove or replace the suffix for workbooks from one or all
source projects.
Step 3: Workbook transformations

You can change and modify your workbooks by using the Transformation step.

Transformations modify your workbooks in a specified manner. Additional transformations
can be included via plug-ins or will be added in future versions of the application. Click on the
Add Transformation drop-down menu to see the selection of Transformations currently
available.
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Selecting any of the transformations will bring up the Edit Transformation window, which
will allow you to customise it to your selected workbooks. All transformations will be completed in the order that they are listed from top to bottom.
For all of the different types of transformations, there are two basic steps. The first step is to
make your selection for the transformation. In this case, select the workbook(s) you want to
transform. The selection area is similar to the Workbook Selection section of the Planning
phase with all of the features of the Basic selection radio button: Select/Unselect All,
Refresh, Thumbnail Display and List Display. At the top of the list, you can select Select
All workbooks, which is an option to automatically select all workbooks for future transformations. You can also Refresh the workbook display window to reflect any changes or
updates to the source site.

The second step is to use the options tab to enter the specific selections for whichever transformation you select.
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Each of the workbook transformations has different values to be entered on the options tab,
and the tab will have different names depending on the transformation you're editing:
Action URL Replacement

Replace part or all of an URL action inside of the workbook using this transformation. On the
options tab, enter the text that should be matched and its replacement value.

Example:
URL: www.exampledev.com
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Match: dev
Replacement: Prod
Result: www.exampleProd.com
Set Parameter Value

Define a new parameter. On the options tab, enter the name of the Parameter, the data
type from the drop-down menu and the value.

Remove Images

Remove any images (such as a watermark) in the selected workbooks by entering in the file
name on the options tab. There is an additional tick box to receive a warning during migration if no image is found.

Remove Tooltip Commands

Remove all of the tooltip commands from the selected workbooks. There are no additional
options to define for this transformation.
Replace Images

Replace any images in the selected workbooks. On the options tab, enter the file name of
the old image and file name of the replacement image. You can use a local file path or URL
to replace images.
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Example:
File Name: C:\file\image.png
Replacement Image URL: http://www.exampledev.com/replacementImage.png
Zoom Control Visibility

Set the visibility mode from the drop-down menu: Automatic, Show on Hover, or Hide on
the options tab.

Web Page URL Replacement

Replace part or all of a web page URL used on dashboards using this transformation. On the
options tab, enter the text that should be matched and its replacement value.

Example:
URL: www.exampledev.com
Match: dev
Replacement: Prod
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Result: www.exampleProd.com
Step 4: Data source transformations

The next step in planning your workbooks for your enterprise migration are your data
source transformations. It is similar in function to the Workbook Transformations step.
These are for data sources that are packaged within the workbooks. Published data
sources are handled in a different step in the process.

Click on the Add Transformation drop-down menu and the following options will appear:

Selecting any of the data source transformations will bring up the Edit Transformation window, which will allow you to customise it to your selected data sources. All transformations
will be completed in the order that they are listed from top to bottom.
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For all of the different types of data source transformations, there are two basic steps. The
first step is to enter in the match criteria for the desired data source. Depending on which connection type you select, more fields will appear on the Match Criteria tab.

Click on the Preview Source Connections to find any connections that match the criteria
entered.
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The second step is to use the options tab to enter the specific selections for whichever transformation you select.
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Each of the data source transformations has different values to be entered on the options
tab:

Set Calculation Formula
On the options tab, you can replace the calculation for a column.
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Set Connection Info
On the New Connection Values tab, enter the authentication method and connection details
for the new data source. Depending on which connection type you select, more fields will
appear.
Select the Tableau Server (Published Data Source) connection type to change the published data source for a workbook. This can reduce the manual steps required when migrating workbooks between projects, for example, promoting content from development to
production.
To change the published data source, select a data source from the drop-down menu and
enter the Tableau Username for authentication. The user must exist on the destination site
and have the Connect capability for the published data source.
l

For file-based data sources, users will access the workbook and see data based on
the permissions of the specified Tableau user.

l

For all other data sources, users are prompted for their own database credentials
when the view or workbook loads.

If Tableau Username isn't specified, only users with the Connect capability can see data in
the workbook.

Set Custom SQL
On the New Custom SQL tab, enter the name of the custom SQL query you want to modify
for Match Query Name. The query name must match the custom SQL query name from
the physical layer of the data source. If these names don't match, the transformation will fail.
For more information about data modelling and the physical layer, see The Tableau Data
Model.
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After entering the query name, enter the desired Custom SQL in the text field. Be aware
that custom SQL can negatively impact the performance of your workbooks if improperly
used.

Remove Extract
There is no options tab for this transformation, simply enter in the Match Criteria information and the extract will be removed during migration.
In addition, on each of the transformations you can enter notes in the Comments section on
the left-hand side of the Edit Transformation window.

Apply Saved Credentials
On the options tab, enter the Tableau Username and corresponding Saved Credentials
Username for the data connection. You can only apply saved credentials for existing data
connections on the Account Settings page of your Tableau site. For more information, see
Manage Saved Credentials for Data Connections.

Step 5: Publish options

The final step in the Workbooks phase is to select publish options and create transformations
for tags, extract refresh schedules and permissions.
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Reset Dashboard Selections
This option deselects all objects on dashboards.

Overwrite Newer Workbooks
If ticked, a workbook will be migrated even if it will overwrite a workbook that has been created at the same time or more recently than the moved workbook

Copy Workbook Permissions
When selected, the migration tool will attempt to match source workbook permissions as
closely as possible.

Copy Extract Refresh Schedules
When selected, the migration tool will attempt to set the destination workbook extract
refresh schedule(s) to schedules matching the source’s name.
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Note: Extract refresh schedules cannot be created in Tableau Cloud. This option is not
available if the destination is a Tableau Cloud site. For more information, see Migration
Limitations.

Copy Workbook Owner
Copy workbook owner settings from the source location to assign the workbook owner. If
unselected, the Content Migration Tool user is given ownership of the workbook in the destination location.

Apply User Mappings
Apply user mappings to assign content ownership. Select this option if there are differences
in username syntax in the destination location. For more information, see Migration Plans:
Permissions and Ownership.
Add Option

Click on the Add Option drop-down menu for the different types of transformations you can
add:

For all of the different types of transformations, there are two basic steps. The first step is to
make your selection for the transformation. In this case, select the workbook(s) you want to
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transform. The selection area is similar to the Workbook Selection section of the Planning
phase with all of the features of the Basic selection radio button: Select/Unselect All,
Refresh, Thumbnail Display and List Display. At the top of the list, you can select
Select All workbooks, which is an option to automatically select all workbooks for future
transformations. You can also Refresh the workbook display window to reflect any
changes or updates to the source site.

The second step is to use the options tab to enter the specific selections for whichever transformation you select. Note: The options tab will have different names, depending on which
transformation you are editing.

Add Tags
This allows you to add one or more tags to the workbook. If you hover your mouse over a
previously entered tag, a blue “X” will appear to allow deletion.
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Remove Tags
This allows you to add one or more tags to the workbook. If you hover your mouse over a previously entered tag, a blue “X” will appear to allow deletion. You can also choose to remove
the tag from the source or destination workbooks.
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Apply Extract Refresh Schedules
Here you can apply destination extract refresh schedules to migrated workbooks. The list of
schedules generated are from the destination.

Note: Extract refresh schedules cannot be created in Tableau Cloud. This option is not
available if the destination is a Tableau Cloud site. For more information, see Migration
Limitations.
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Set Permissions
This transformation is to edit the permissions for the selected workbooks. Enter in a Group or
User and then click Add. Adjust the permissions as desired. The four different options are to
Allow the permission, Deny the permission, Inherit or to keep the Source Value.
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Set Generate Thumbnail As
This allows you to set the User or Group to be used for generating user-specific data in the
workbook thumbnail after being migrated. Each option has a drop down to select the
desired user or group.
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Step 6: Continue to the next step

After selecting your workbooks and preferences, click Next to continue to the Migration
Plans: Published Data Sources section of the planning phase.
Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing rights
for the destination site. For more information, see Permissions.

Migration Plans: Published Data Sources
The next step of creating a migration plan in the Tableau Content Migration Tool is to select,
map and add any transformations to your published data sources. The process is very similar
to the Workbooks step of the planning phase, particularly the data source mapping step.
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Note: If your workbooks or data sources include extracts, be sure you read and understand the information in Migrating Workbooks and Data Sources that use Extracts.

Step 1: Selection

Starting the Published Data Sources phase of the migration plan, you’ll select any data
sources you want to include in the migration plan:

The data sources will only be selected at the moment of migration. You have two methods
of selection. Use Specific Data Sources to choose one or more published data sources.
Click Refresh to reload the list of published data sources available.
The second option is All Data Sources, which selects every data source in the source site.
Step 2: Mapping

The next step is to map your source data sources to the new destination. This is similar in
functionality to mapping workbooks.

If you make no changes here, then the selected data sources will simply be deployed with
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the same name and project as the source. To add data source mapping click Add Mapping.
The following options will appear in the mapping area.

The entry has the following options:
Delete

Clicking the Delete link will delete this mapping entry.
Name

Use the Name menu to select the data source you wish to map. You can select (All Selected Data Sources) to choose all of the data sources.
Project

The Project is the project of the associated data source names.
Destination Name

By default, the Content Migration Tool will use the same Destination Name(Same As
Source), keeping the original name in the Source file, but you can type in a new name here
for the destination folder.
Destination Project

If your destination projects have already been created on your site, you can choose which
project to place your migrated workbooks in or click Add New to create a new project. You
can create different project destinations for individual data sources.
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In most situations, if multiple mapping entries exist for a single data source, a validation
error will be displayed and must be fixed to continue. There is one important exception to
this – a data source may match both a specific selection and a project-wide mapping entry.
In this instance, the more specific entry will be used.
When you have completed all of the data source mapping necessary, click Next to continue.

Step 3: Data source transformations

You can modify your data sources by using the transformation option. Click Add Transformation to see the list of transformations available.
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Selecting any of the data source transformations opens the Edit Transformation window.
Use this to customise your selected data sources. Transformations are executed in the order
they are listed, from top to bottom.
For most data source transformations, there are two basic steps. The first step is to enter in
the Match Criteria for the desired data source. Depending on which connection type you
select, more fields will appear on the Match Criteria tab.
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The second step depends on which transformation type you are adding. Each of the data
source transformations have different values to be entered on the second tab.
You can add notes in the Comments section on the left side of the Edit Transformation
window for each of the transformations you add.
Replace Table/Schema Name

On the Options tab, you can replace all or part of a table or schema name.
Set Calculation Formula

On the New Calculation Formula tab, you can replace the calculation for a column.
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Set Connection Info

On the New Connection Values tab, there will be different fields here based on the Connection Type you selected and perhaps even no fields needed at all.

Set Custom SQL

On the New Custom SQL tab, enter in any custom SQL in the text area desired. You should
be aware that custom SQL can negatively impact the performance of your workbooks if
improperly used.

Remove Extract

There is no Options tab for this transformation. Type the Match Criteria information and
the extract will be removed during migration.
Use Tableau Bridge

There is no Options tab for this transformation. Type the Match Criteria information and
data sources that are within a private network (inaccessible to the public internet) will be
allowed to refresh using Tableau Bridge.
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The destination Tableau Cloud site must have Tableau Bridge configured before migrating
data sources. For information about Tableau Bridge, see Use Tableau Bridge in Tableau
Cloud help. After the migration, data sources will need to be assigned a refresh schedule
through Tableau Cloud.
Apply Saved Credentials

On the options tab, enter the Tableau Username and corresponding Saved Credentials
Username for the data connection. You can only apply saved credentials for existing data
connections on the Account Settings page of your Tableau site. For more information, see
Manage Saved Credentials for Data Connections.

Step 4: Publish options

The final step in the Published Data Source phase is to create transformations for permissions and tags and finalise the publish options specific to the data sources.
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Overwrite Newer Data Sources
If selected, a data source will be published, even if it will overwrite a data source that has
been updated more recently.

Copy Data Source Permissions
When selected, the migration tool will attempt to match published data source permissions
as closely as possible.

Copy Extract Refresh Schedules
When selected, the migration tool will attempt to set the destination data source extract
refresh schedule to schedules matching the source’s name.

Note: Extract refresh schedules cannot be created in Tableau Cloud. This option is not
available if the destination is a Tableau Cloud site. For more information, see Migration
Limitations.

Copy Data Source Owner
Copy data source owner settings from the source location to assign the data source owner. If
unselected, the Content Migration Tool user is given ownership of the data source in the destination location.

Apply User Mappings
Apply user mappings to assign content ownership. Select this option if there are differences
in username syntax in the destination location. For more information, see Migration Plans:
Permissions and Ownership.
Add Options

Click on the Add Option drop-down menu for the different types of transformations you can
add:
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For all of the different types of transformations, there are two basic steps. The first step is to
make your selection for the transformation. In this case, select the data source(s) you want
to transform. At the top of the list, you can select Apply to all published data sources,
which is an option to automatically select all data sources for future transformations. You
can also Refresh the data source display window to reflect any changes or updates to the
source site.

The second step is to enter the specific selections for the transformation you select.
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Remove Tags

Once the data sources you would like to remove tags from are selected, enter any tags you
want to remove by entering them into the field at the bottom and click Add. From this screen,
you can also select to remove from the source or destination data sources. If you want to
remove a previously entered tag, click on it and press the delete key.

Add Tags

After selecting the data sources desired, enter any tags you want to assign by entering them
into the field at the bottom and click Add. If you want to remove a tag, click on it and press the
delete key.
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In addition, on each of the transformations you can enter notes in the Comments section
on the left-hand side of the Edit Transformation window.
Apply Extract Refresh Schedules

This transformation applies destination extract refresh schedules to migrated data sources.
The list of schedules generated are from the destination.

Note: Extract refresh schedules cannot be created in Tableau Cloud. This option is not
available if the destination is a Tableau Cloud site. For more information, see Migration
Limitations.
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Set Permissions

The last type of transformation is to edit the permissions for the selected data sources. Enter
in a Group or User and click Add. Adjust the permissions as desired. The four different
options are to Allow the permission, Deny the permission, Inherit or to keep the Source
Value.
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Step 5: Continue to the next step

When you are ready, click Next to continue to the Migration Plans: Permissions and Ownership section of the planning phase.
Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing
rights for the destination site. For more information, see Permissions.

Migration Plans: Permissions and Ownership
The Content Migration Tool allows you to replicate workbook and data source permissions
to different users. You can create user permissions mappings to customise and secure content after it has been published to the destination location. Mappings are applied if Copy
Project Permissions, Copy Workbook Permissions, or Copy Data Source Permissions have been selected earlier in the planning phase, along with Apply User Mappings.
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For more information, see Migration Plans: Source Projects, Migration Plans: Workbooks
and Migration Plans: Published Data Sources.
Mapping limitations
l

Content Migration Tool will stop the migration process if it fails to find the mapped user
or group in the destination location. Subsequent user or group permissions mappings
are not checked after the first failure, and the plan must be run again.

l

Content Migration Tool cannot replicate permissions if the source content has permissions for multiple users and groups with identical names. This only occurs when
there are duplicate user or group names sourced from separate domains.

Step 1: Add mapping

To add user permissions mapping, click Add Mapping and select whether to change the
name of a domain, user or group, or to import mappings from a comma-separated values
(CSV) file. If Content Migration Tool is unable to match a permission in the destination location, the source content will not be migrated.

Domain Mapping

Domain permissions mapping applies to all users and groups in the destination location. If
you are unsure about the source or destination domain, you can check the user and group
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pages on your Tableau site. If local user provisioning has been selected, the domain must
be specified as local.

User Mapping

User permissions mapping automatically populates a list of users from the source and destination locations using the syntax domain\user. You cannot enter and save the names of
users that don’t exist.

Note: When migrating between projects on the same site, the destination location and
list of users will be the same. You can use mappings to update content ownership from
User_A to User_B on the site.

Group Mapping

Group permissions mapping automatically populates a list of users from the source and destination locations using the syntax domain\group. You cannot enter and save the names
of groups that don’t exist.
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Import mappings from a CSV file

Starting in version 2021.4, you can import a CSV file containing domain, user and group mappings to quickly prepare your data for migration. Importing mappings can reduce the manual
steps required to run a migration plan by allowing you to create and edit your mappings in
bulk outside of Content Migration Tool. To import mappings, select Import from File from
the Add Mapping menu.
CSV file format requirements

When you create a CSV file to import mappings, make sure that the file meets the following
requirements:
l

The file does not include column headings. Tableau assumes that every line represents a mapping.

l

The file contains three comma-separated values per row: mapping type, source
domain/user/group and destination domain/user/group.

l

Include the domain for usernames and groups if the server uses Active Directory
authentication or "local" if a local identity store is used.

You must specify "domain", "user" or "group" for mapping type, as shown in the following
table. The source and destination columns provide example syntax for Active Directory and a
local identity store. Actual values in the CSV file will vary depending on your organisation.
Mapping Type
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domain

<domain>

<domain>

user

<domain>\<user name>

<domain>\<user name>

local\<user name>

local\<user name>

<domain>\<group name>

<domain>\<group name>

local\<group name>

local\<group name>

group

Import user permissions mappings

To import user permissions mappings in the Content Migration Tool:
1. Click Add Mapping and select Import from File.
2. In the dialog window, click Export CSV to export a .csv file containing all users and
groups from the source site. Edit the resulting file in a text editor to add mappings for
the destination site.
If you already have a mapping file, skip to step 3.

Note: The exported CSV file doesn’t include domains from the source site.
Domains must be added manually to the CSV to create domain mappings.

3. Click Import Mappings and select the mapping file you want to import.
Content Migration Tool will validate the mappings for errors when importing the file. If errors
are detected, you must fix each error in the CSV file and then import it again.
CSV import example

The following example shows a CSV file that contains multiple mapping types.
user,local\hwilson,companyx.lan\henry.wilson
user,local\jjohnson,companyx.lan\janna.johnson
user,local\mkim,companyx.lan\michele.kim
user,local\fsuzuki,companyx.lan\fred.suzuki
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user,local\awang,companyx.lan\alan.wang
user,local\snguyen,companyx.lan\susan.nguyen
user,local\lrodriguez,companyx.lan\laura.rodriguez
user,local\agarcia,companyx.lan\ashley.garcia
group,local\All Users,companyx.lan\All Users
group,local\Finance Team,companyx.lan\Finance Group
domain,dev.mycompany,prod.mycompany
A preview window is displayed while importing the CSV that shows mappings removed,
added or updated, unchanged and ignored. Review that the mapping changes are correct
and click Accept.
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Once the mappings are imported successfully, you can edit, delete or change the mapping
order as described in Step 2.
Step 2: Change mapping order

After a permissions mapping is created, you can change the order using the Up or Down
options to determine when it will be handled during the migration. When a domain, user, or
group is handled in a permissions mapping, any subsequent permissions mappings for the
source domain, user or group will be ignored.
In the example below, permissions for User_A are mapped to User_B. Content Migration
Tool will ignore the second permissions mapping because User_A has already been
handled.

In the example below, the first permissions mapping associates the domain for all users to
prod. Content Migration Tool will ignore the second permissions mapping because the
domain for User_A has already been handled.

Step 3: Continue to next step

When you are ready, click Next to continue to the Migration Plans: Migration Scripts section
of the planning phase.
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Who can do this

Tableau site user with a Site Administrator Explorer role or higher. To migrate content, you
must have View and Download Workbook/Save a Copy permissions on the source site and
Publishing rights for the destination site. For more information, see Permissions.

Migration Plans: Migration Scripts
The next step of creating a migration plan in the Tableau Content Migration Tool is to create
any scripts you want to run with your plan before or after migration.
Step 1: Pre-Migration

The Run Pre Migration section of the screen is dedicated to scripts that will run before the
migration.

Each field has a help icon you can get information from by moving your cursor over it. To
start with your pre-migration scripts, select Enable, which will then activate the fields below.

Working Directory
This is the working directory for the script. The default directory is the same folder as the
migration plan. Click on the browse button to select a different folder. The Reset button will
restore the current folder as the plan as the working directory.
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Run
This drop down allows you to choose either to run a custom script or an executable with parameters.

Command Executable
If you selected Executable with Parameters from the Run menu, this field will appear.
This is the file path to the command executable to run before migration. Type it in directly or
use the browse button to find the executable. This is a required field.

Command Parameters
If you selected Executable with Parameters from the Run drop-down menu, this field will
appear. Enter in command line parameters here to use with the command executable.

Script
If you selected Custom script from the Run menu, enter in your pre-migration script here.
It will be executed as a *.cmd file. This is a required field.
Step 2: Post-Migration

The Run Post Migration half of the screen is dedicated to scripts that will run after migration.
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Each field has a help icon you can get information from by moving your cursor over it. To
start with your post-migration scripts, select Enable, which will then activate the fields
below.

Working Directory
This is the working directory for the script. The default directory is the same folder as the
migration plan. Click on the browse button to select a different folder. The Reset button will
restore the current folder as the plan as the working directory.

Run
This drop down allows you to choose either to run a custom script or an executable with
parameters.

Command Executable
If you selected Executable with Parameters from the Run menu, this field will appear.
This is the file path to the command executable to run before migration. Type it in directly or
use the browse button to find the executable. This is a required field.

Command Parameters
If you selected Executable with Parameters from the Run menu, this field displays. Enter
in command line parameters here to use with the command executable.

Script
If you selected Custom script from the Run menu, enter in your post-migration script
here. It will be executed as a *.cmd file. This is a required field.
Step 3: Continue to Next Step

When you are ready, click Next.
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Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing rights
for the destination site. For more information, see Permissions.

Migration Plans: Plan Options
The last step of creating a migration plan in the Tableau Content Migration Tool is configuring the Options section.

Each option on this screen has a question mark that will provide contextual assistance for
that particular option.
Step 1: Options

There are five options.
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The Plan Name is the name of the plan as it will appear in Content Migration Tool. We
recommend using a user-friendly name for your plan name.
The following tick boxes offer the following additional options:
l

Refresh Extracts After Migration: If selected, any data extracts will be refreshed
immediately after migration if Content Migration Tooldetects that they might have
been modified during migration. Click the Filter link for more options.

l

Automatically create Extract Refresh Schedules that do not Exist: Automatically creates destination extract schedules that do not exist. If not ticked, source
schedules that do not exist on the destination site will not be copied.

l

Continue Migration if Workbook or Data Source Fails: If checked, errors migrating a workbook or data source will not cause the migration to stop. The errors will be
logged and the migration will continue. Errors during version control will always stop
the migration.

l

Continue Migration if Permission or Ownership Mapping Fails: If ticked, errors
copying permissions or ownership will not cause the migration to stop. The errors will
be logged and the migration will continue.

Exclude Extract Refreshes

By clicking on the Filter link after the Refresh Extracts After Migration option, you will be
able to choose which workbooks or published data sources will be excluded from being
refreshed.
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Use the back and forth arrow buttons to select which items you want excluded and then click
OK.
Step 2: Version Control

These options allow you to avoid losing the existing workbooks in the destination site that
might be replaced by the migrated workbooks.
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Click Enable to save your previous versions. You can choose to archive workbooks and/or
published data sources. You’ll need to select an option from the Archive To menu which
lists all of the projects in your site. We recommend creating a special archive project just to
store your versioned workbooks.
There is a refresh button at the end of the Archive To box to update any projects that have
been added to the site.
Step 3: Save Plan

Once you have completed all of your selections on the Plan Options screen, you can save
your plan for future use. Click Save Plan.

Your plan will be saved to Tableau Content Migration Tool folder in the My Documents
folder on your local machine.
Step 4: Continue to Next Step

When you are ready, click on Verify & Run to end the Planning phase of your migration
and prepare to run your plan.
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Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing rights
for the destination site. For more information, see Permissions.

Migrating Workbooks and Data Sources that use Extracts
Tableau Cloud users can publish extracts, which are copies or subsets of the original data.
These extracts may be embedded in a workbook or a data source. By default, when you use
the Tableau Content Migration Tool to migrate a workbook or data source that contains an
extract, that extract is migrated along with the workbook or data source that contains it. The
Content Migration Tool gives you a couple of options for controlling this behaviour:
l

Switching to a Live Connection
You can add the Remove Extract transformation to your migration plan to remove
the extract from your workbook or data source during migration. As always, the source
workbook or data source will not be modified. The copy of the workbook or data
source migrated to the destination project will have the extract removed from it. This
effectively switches the data connection back to a live connection.

l

Refreshing Extracts after Migration
You can enable the Refresh Extracts After Migration option in your migration plan
to have an immediate extract refresh task scheduled after the workbook or data
source is migrated.
We don't recommend using the Refresh Extracts After Migration option if your
migration plan also uses the Set Connection Info transformation to change the data
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connection to point to a different set of data (for example, a different database server
or database). When you change the connection information to point to different data
and use the Refresh Extracts After Migration option, this can unintentionally
expose data in a way that is a potential security issue.
For more information, see Option 3: Refresh Extracts After Migration.

Changing data connections that use extracts
Tableau data connections are either live connections that directly query a data source, or
they are extracts of a data source. Extracts are copies or subsets of the original data and
can be embedded in a workbook or data source. When present, the views will query data
from the extract instead of the underlying data source.
Commonly, you’ll want to modify the data source connection during the migration so that it
points to a different database in the destination project than it did in the source project.
For example, if you are migrating a workbook from your staging project to your production
project, you will likely want to update the data connections inside the workbook to connect to
your production database. You can implement this by using the Set Connection Info transformation in your migration plan. Now you have a migration plan which copies a workbook
from staging to production and updates the data connections to point to the production database.
If your workbook uses an extract, additional work is required. In this scenario, the workbook
will be migrated and the live data connection updated. However, the views will still show
data from the staging database because it still contains the staging database extract –
copied from the source (staging) project. There are a few ways to address this.

Option 1: Use Published Data Sources
You can change your workbooks so that they use published data sources instead. This way,
the extract will be managed as part of the published data source, and migrating updates to
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the workbooks that use that data source can be simplified by not having to worry about the
connection to the live database or the data extract.

Option 2: Remove the Extract During Migration
You can add a Remove Extract transformation to your migration plan. This will remove the
extract from your workbook, effectively switching the data source to a live connection.

Option 3: Refresh the Extract After Migration
You can use the Refresh Extracts After Migration option in your migration plan. This will
migrate the extract along with the workbook but will schedule an immediate extract refresh
task for that workbook after the migration is complete.
This option is usually not recommended when used in combination with a Set Connection
Info transformation because of potential security issues that it can introduce.
The issue is that the migrated workbook in your destination project will still show the old
(source) extract data for the period between the completion of migration and the completion
of the extract refresh task. If the extract refresh task fails, then the old/source extract data will
remain until the extract is refreshed.
In a scenario like we’ve outlined above, migrating from a staging to production environment,
this may be acceptable, but you should be aware that the users of your workbooks may not
be aware that the workbook is showing old/staging data due it being recently migrated and
the extract not being refreshed yet.
In other scenarios where you may be using Set Connection Info to change data connections to point to a different set of customer or client data, this could introduce serious
security issues where the workbook’s extract contains data from a different client or customer until the extract has been refreshed post-migration.
One way to mitigate this issue is to implement a 2-stage migration. This approach requires
you to create two migration plans, one for each step described below, and ensures the workbooks and data sources have an up-to-date extract before they are accessible.
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l

Stage 1: Migrate your content to a project on your destination site that only administrators have access to. This migration allows you to use the Refresh the Extract

After Migration option along with the Set Connection Info transformation to
update the data connection, because no unauthorised users will have an opportunity
to see the old data, even if the extract refresh fails.
l

Stage 2: After stage 1 is complete and you confirm there is a successful extract
refresh, run a second migration plan to migrate the content from the stage 1 destination to the final destination where it is visible to end-users.

Who can do this

Tableau site user with an Explorer role or higher. To migrate content, you must have View
and Download Workbook/Save a Copy permissions on the source site and Publishing
rights for the destination site. For more information, see Permissions.

Using the Tableau Content Migration Tool Console Runner
The Tableau Content Migration Tool includes a command-line utility for running migrations,
tabcmt-runner.exe, located in the installation folder. The default installation folder is
%PROGRAMFILES%\Tableau\Tableau Content Migration Tool.

Note: The tabcmt-runner.exe utility is not the same as the tabcmt.cmd command line utility which is used to configure the Content Migration Tool graphical application. For more information about tabcmt.cmd, see Using the Tableau Content
Migration Tool Command Line Interface.

Usage:
l
l
l
l
l
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tabcmt-runner [options] <plan_file.tcmx>
tabcmt-runner licence --remove
tabcmt-runner licence <new licence key>
tabcmt-runner licence <licence file path> [--passphrase=<licence file passphrase>]
tabcmt-runner encryption --reset
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l
l
l
l
l

tabcmt-runner encryption <new_key>
tabcmt-runner improvement [on|off]
tabcmt-runner --help
tabcmt-runner --version
tabcmt-runner script-warning [on|off]

Options:
l
l
l
l
l
l
l
l
l
l
l

--version
--help
--quiet
--info
--logfile=VALUE
--src-user=VALUE
--src-password=VALUE
--dest-user=VALUE
--dest-password=VALUE
--https=VALUE
--allow-scripts

Run Plan
Executes a migration plan immediately.
tabcmt-runner [options] <plan file>
Available options:
l
l
l
l
l
l
l

--logfile=<file name> sets the file name to log output to
--https=<secure|legacy> sets the HTTPS mode
--quiet disables logging to stdout
--src-user=<username> sets the username of the source connection
--src-password=<password> sets the password of the source connection
--dest-user=<username> sets the username of the destination connection
--dest-password=<password> sets the password of the destination connection

Exit codes:
l
l

0 indicates that the migration was successful.
1 indicates that the migration was successful but warning messages were logged.
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l

2 indicates that the migration failed. Specific errors will be included in the log output.

Show Plan Summary
Shows a summary of the migration plan and then exits.
tabcmt-runner --info <plan file>
help

Shows usage information for the command line utility.
tabcmt-runner --help
version

Shows the current application version information.
tabcmt-runner --version
encryption

Reset the encryption key, or specify a new one. You must specify the encryption key before
using the tabcmt-runner utility, even if you already done so from the Content Migration
Tool UI.
tabcmt-runner encryption <new_key> | --reset
improvement

Default value: on
Enables or disables collection of anonymous usage information by the application. This
information is completely anonymous and is sent periodically to Tableau to help us improve
Content Migration Tool.
Examples

Show whether the improvement program is enabled or disabled:
tabcmt-runner improvement
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Enable or disable the improvement program:
tabcmt-runner improvement <on|off>
licence

Deprecated in July 2022.
This command is only applicable for legacy licences. Manages a legacy application licence
for the current user. When using a legacy key, to use the tabcmt-runner utility you must
activate the licence using this command, even if you already activated it from the Content
Migration Tool UI.
Examples

Show the current licence information:
tabcmt-runner license
Set/activate a serial key or offline licence key:
tabcmt-runner license <key>
Remove/deactivate the current licence:
tabcmt-runner license --remove
Set/activate using a licence file:
tabcmt-runner license <file path> [--passphrase=<password>]
script-warning

Default value: on
Shows a warning message when running a migration plan that includes migration scripts.

Note: This command updates your selection on the Settings page. For more information, see Tableau Content Migration Tool Settings.
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Examples

Show if script warning is turned on or off.
tabcmd-runner script-warning
Turn script warning on or off
tabcmd-runner script-warning <on|off>
If turned on, you must include the option --allow-scripts to execute migration plans.
tabcmd-runner --allow-scripts <plan file>

Who can do this
To use the console runner, you must have all the following:
l
l
l
l

Administrator permissions on the Content Migration Tool machine.
Tableau site user account with an Explorer role or higher.
View and Download Workbook/Save a Copy permissions on the source site.
Publishing rights for the destination site.

Example: Scripting Migration Plans
Note: This topic includes a sample script you can use as the basis for scripting a multiplan migration that satisfies your needs and environment. This script is intended to be
used as a sample only, and not to be run as-is. For detailed instructions on using the
console runner, see Using the Tableau Content Migration Tool Console Runner.

Tableau Content Migration Tool command line utility for running migrations can be used to
automate the running of a migration plan from an external scheduler (such as Windows
Task Scheduler) or from a custom script. The console runner only runs one migration plan
(stored in a .edt file) at a time. If you have a group of migration plans you want to run as a
group, then you can use a custom script in combination with the Content Migration Tool console runner.
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The example below is written in PowerShell and uses the console runner to execute a list of
migration plans as a group.
The following example code demonstrates:

l

Running multiple migration plans as a group using the console runner.
Optionally halting deployment of the group of plans immediately when any single migra-

l

tion in the group fails.
Using the console runner’s exit code to determine whether the migration failed or

l

logged warnings.

# List of migration plans to execute as a group.
$planFiles = @(
'customer 1.tcmx',
'customer 2.tcmx'
)
# True of false whether to continue with the next plan if a
migration fails.
$continueOnFailure = $false
# Path to the CMT console runner executable
$runnerExe = 'C:\Program Files (x86)\Tableau\Tableau Content
Migration Tool\tabcmt-runner.exe'
# Store the exit code from the previously run migration plan.
$lastResult = -1
# Loop through and run each migration plan one at a time.
$planFiles | % {
$file = $_
if ($lastResult -ge 2 -and -not($continueOnFailure)) {
Write-Warning "Skipping plan because previous migration
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failed. `nSkipped plan: $file"
return
}
Write-Verbose "Running migration plan: $file"
& $runnerExe $file
$lastResult = $LASTEXITCODE
if ($lastResult -ge 2) {
Write-Error "Migration failed. See output or log file for
error details.`nPlan: $file" -ErrorAction 'Continue'
}
elseif ($lastResult -eq 1) {
Write-Warning "Migration completed with warnings. See output
or log file for warning details.`nPlan: $file"
}
}
Who can do this

To script migration plans, you must have all the following:
l
l
l
l

Administrator permissions on the Content Migration Tool machine.
Tableau site user account with an Explorer role or higher.
View and Download Workbook/Save a Copy permissions on the source site.
Publishing rights for the destination site.

Using the Tableau Content Migration Tool Command Line
Interface
The Tableau Content Migration Tool includes a command line interface, tabcmt.cmd, located in the installation folder. The default installation folder is %PROGRAMFILES%\Tableau\Tableau Content Migration Tool (32-bit Windows) or
%PROGRAMFILES(x86)%\Tableau\Tableau Content Migration Tool (64-bit
Windows).
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Note: The tabcmt.cmd utility is not the same as the Content Migration Tool console
runner, tabcmt-runner.exe. The console runner is a separate command line utility
used for running migrations from the command line. For information on using the Content Migration Tool console runner, see Using the Tableau Content Migration Tool Console Runner.

Here are the commands that can be used with the tabcmt command line:
l
l
l
l

migrate
help
update
version

migrate
Opens a migration plan file to the migrate step in the GUI:
tabcmt migrate <plan file>

help
Shows general help about the command line interface and the available commands.
Examples

Show all commands available:
tabcmt help
Show help and usage information for a specific command:
tabcmt help <command>

licence
Deprecated in July 2022.
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This command is only applicable for legacy licences. Manages the application licence for the
current user.
Examples

Show the current licence information:
tabcmt license
Remove/deactivate the current licence:
edt license remove
Set/activate a serial key or offline licence key:
tabcmt license <key>
Set/activate using a licence file:
tabcmt license <file path> [--passphrase=<password>]

update
Manages the options for application updates.
Examples

Show the current update settings:
tabcmt update
Enable or disable the automatic update notifications:
tabcmt update --disabled=<true|false>
Set the URL to detect/download updates from:
tabcmt update --url=<url>
Enable or disable showing beta updates. Set to false to only show stable release updates.
tabcmt update --beta=<true|false>
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version
Shows the current application version information.
tabcmt version

Who can do this
To use the command line interface, you must have all the following:
l
l
l
l

Administrator permissions on the Content Migration Tool machine.
Tableau site user account with an Explorer role or higher.
View and Download Workbook/Save a Copy permissions on the source site.
Publishing rights for the destination site.

Tableau Content Migration Tool Settings
The Tableau Content Migration Tool default settings work in most cases, but you can change
these if you need to, or if you are working with Tableau Support and they ask you to make
changes.
To view or update the Content Migration Tool settings:
1. Open Content Migration Tool.
2. Click Help > Settings. The Settings dialog opens:
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Diagnostics—Click Open Log Folder to open the logs location. Here you can view
the logs, and zip them up if you need to send them to Tableau. For more information,
see Tableau Content Migration Tool Log Files.
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Select Enable Network Tracing if you are working with Support and they ask you to
include a network trace in the logs. This applies until you clear the option or restart the
Content Migration Tool.
Security—The encryption key is automatically generated on installation. If you
change the encryption key, any migration plans with embedded passwords that were
created with the previous key cannot be opened. If you have multiple installations of
Tableau Content Migration Tool and want to share migration plans, you need to make
sure the encryption key used by each instance of the tool is the same.
Migration Scripts – By default, a warning is displayed when running a migration plan
that includes migration scripts or executables. Other users can edit these files, so
verify that they’re safe before running the migration. Toggling this setting on and off
will also update your warning preference for the console runner. For more information,
see Using the Tableau Content Migration Tool Console Runner.
Tuning—In almost all cases, you can leave these set to the defaults. If you are working with Support, they may ask you to change these settings.
Temporary Files—Select a location for temporary files if you want to change the
default. This is the location where content is copied during a migration. You may want
to change this if the default location does not have enough space to temporarily hold
migrated content.
Networking—Selecting Allow Legacy HTTPS Connections gives you the ability to
connect to Tableau Server installations running with older HTTPS configurations (for
example, SSL v3). This is not recommended.

Who can do this
Typically, the tasks listed above can only be done by a user with Administrator access on the
machine where Content Migration Tool is installed.
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Tableau Content Migration Tool Log Files
Tableau Content Migration Tool generates log files when you run migrations. These can be
helpful for troubleshooting problems.

Note: For information on all the Content Migration Tool settings, see Tableau Content
Migration Tool Settings.

Content Migration Tool Log File Location
To find the Content Migration Tool log files from within the Content Migration Tool:
1. Start Content Migration Tool.
2. Click Help and Settings:

3. In the Settings dialog, click Open Log Folder:
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A window opens with the log files.
If you are working with Tableau Support and they ask you to send log files, zip the files up
before you send them. For more information on sending log files to Tableau, see the Tableau
Knowledge Base.

Who can do this
Typically, the tasks listed above can only be done by a user with Administrator access on the
machine.
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